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1
Demand Planning Overview

This chapter covers the following topics:

• About Oracle Demand Planning

• Demand Planning Architecture

• Planning Cycle

• Demand Planning Roles

About Oracle Demand Planning
Oracle Demand Planning is a web-based application that enables organizations to 
produce unconstrained forecasts for future demand and generate tactical, operational, 
and strategic business plans. Demand Planning captures and processes information 
from multiple sources and consolidates demand so that it can be summarized by item, 
product line, region, time, and organization. Demand Planning uses Oracle Workflow 
and supports control mechanisms based on an event or calendar. 

Oracle Demand Planning is integrated with Oracle Inventory Optimization (IO), Oracle 
Collaborative Planning (CP), and Oracle Advanced Supply Chain Planning (ASCP) to 
ensure optimal inventory planning and supply chain management.

Key features of Oracle Demand Planning
The following list highlights features of Oracle Demand Planning:

• Supports Internet-based collaboration between users in various locations and 
departments. The collaborative capabilities ensure global visibility and provide 
tools for adjusting forecasts based on judgment.

• Incorporates a best-of-breed statistical forecasting engine: Geneva ForecastingTM 
from Roadmap Technologies. Developed specifically for demand forecasting 
applications, this engine has multiple forecasting methods (linear and non-linear 
regression, variations of exponential smoothing), efficient parameter search and 
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outlier detection algorithms, and a rule based system for automatic best fit forecasts
based on time and frequency domain analysis and predefined decision rules 
generated from cross-client studies. The statistical interface supports both novice 
and expert users.

• Accommodates flexibility in information acquisition, information management, 
information analysis, and forecast reconciliation. The system supports a variety of 
inputs including sales and opportunities forecasts, marketing intelligence, custom 
forecasts, and external data streams.

• Enables end users to define attributes of custom data streams such as sales 
forecasts, measurement type, aggregation rule, allocation rule, unit of measure, 
dependent demand, price list, and related events. 

• Provides a reporting interface that supports multiple views of the data, rotation, 
drill down, and aggregation. The ability for planners to define their own measures, 
custom aggregates, and saved selections provides further support for flexible 
modeling and analysis. 

• Enables planners and the Demand Plan Manager to use a variety of techniques to 
edit data. 

• Creates a knowledge base by maintaining planners' comments and audit trails. 
Supports reason codes for forecast modifications.

• Includes capabilities for modeling and viewing information about events such as 
product introductions, product cannibalization, and product phase outs.

• Provides feedback to planners through performance monitoring, exception 
reporting, comparative reports, and user-defined alert mechanisms. 

Demand Planning Architecture
Oracle Demand Planning has component architecture. This means that in lieu of 
working directly from data generated by other Oracle Applications, Oracle Demand 
Planning copies the data to a localized data store in a process called collection. This is 
done for two reasons:

• It allows the computational-intensive planning and forecasting calculations to be 
off-loaded to a separate Demand Planning Server, where the localized data store 
resides, to avoid excessive load on the server hosting the transactions.

• It allows Oracle Demand Planning to be deployed against multiple versions of 
Oracle Applications (versions 10.7, 11, 11iand 12). There are separate collection 
programs for each version.

The business process of demand planning requires analyzing demand along different 
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dimension levels. For example, manufacturing planners may plan and view demand at 
a product/manufacturing location level, whereas sales managers may plan and view 
demand at a product family/geographic region level. The ability to accept demand data 
input at one set of dimension levels, display it at another set of dimensional levels, and 
maintain a consistent set of underlying demand data that is independent of the levels at 
which it is displayed is covered by a technique known as Online Analytical Processing 
(OLAP). The Oracle 9i database release 2 contains Online Analytical Process. 

A representation of Oracle Demand Planning in the Oracle Database is illustrated below
shows that Relational and Online Analytic Process data are managed in a single, 
integrated instance. This integration allows for an internal movement of data when 
downloading data from the Demand Planning Server to the Demand Planning Engine 
and uploading data from the Demand Planning Engine to the Demand Planning Server.

The Oracle Database stores multidimensional data directly in the database. The 
database engine that runs the online analytical process calculations for Oracle Demand 
Planning is the OLAP option in the database known as Analytic Workspaces. The 
database engine runs within the database kernel and internally executes all 
multidimensional data calculations. Analytic Workspaces contain objects such as 
dimensions, variables, formulas, and OLAP Data Manipulation Language (DML).

All data in the Oracle Database, both relational and multidimensional, is stored in 
Oracle data files. Multidimensional data is stored in an Analytic Workspace within a 
relational schema. An Analytic Workspace is a container for collections of 
multidimensional data types and may contain one or many 'cubes'. These cubes are the 
plans created in Oracle Demand Planning. 

Oracle Demand Planning consists of two major components: the Demand Planning 
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Server and the Demand Planning Engine. The Demand Planning Server holds the 
inputs such as sales history, as well as the forecast outputs for feeding to Oracle 
Advanced Supply Chain Planning and other Oracle applications. The Demand Planning
Engine is the processing engine of Oracle Demand Planning, and is based on Analytic 
Workspaces.

Planning Cycle
The following are the steps in the planning cycle.

Collecting data
Data such as items, sales history, and inventory organizations are collected from the 
source into staging tables in the Demand Planning Server. The purpose of the staging 
tables is to provide a temporary repository that allows users to review the collected 
data, adjust the data as necessary, and clean out any irrelevant data, thus making the 
data more useful for forecasting. Note that Oracle Demand Planning does not provide 
an explicit data viewing or cleansing tool. You can use any data manipulation tool such 
as SQL for this purpose. The data are then pulled into fact tables on the Demand 
Planning Server. If the data are clean, then it can be collected directly into the fact tables.

Defining the demand plan
The administrator defines a demand plan in the Demand Planning Server. He or she 
specifies the dimensions and hierarchies within dimensions such as geography and 
sales group. The administrator also specifies one or more scenarios based on different 
histories or date ranges for forecast horizons.

The administrator also specifies what type of historical data will be used and how much
of the history to use. In addition to historical data, the administrator can select reference
data such as manufacturing data for comparing forecasts generated by Oracle Demand 
Planning based on historical data.

If the system collects data from the Bills of Material (BOM), the administrator can set up
the Demand Planning Server so that planners and the Demand Plan Manager can view 
and edit data for dependent demand and planning percentages.

Downloading data from the Demand Planning Server to the shared database
Data from the Demand Planning Server database is downloaded into a shared database 
in the Demand Planning Engine. The Demand Planning Server is a source of integrated 
data that can include the following: 

• Forecast data from Sales, Manufacturing, Supply Chain, or third party at any 
aggregate level.

• Historical data at the lowest aggregate level (e.g., SKU). 
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• Planning percentages from the Bills of Material (BOM).

• Data from external sources, such as customer data.

The Demand Planning Server defines the parameters of the source data as well as 
events, scenarios, demand plans and system setup. The downloaded data is used as a 
basis for populating measures which hold the information for data streams from the 
Demand Planning Server such as booking history or customer forecasts. The Demand 
Planning Administrator can create additional measures to be used planners and the 
Demand Plan Manager. 

Distributing data to planners
Data in the shared database are distributed to individual planners, based on 
assignments that are defined by the Demand Planning System Administrator. 
Assignments determine the dimension value combinations (measures and dimension 
values) that each planner is responsible for forecasting and submitting to the shared 
database as well as the dimension value combinations that each planner can view. In a 
collaborative planning environment, assignments establish the areas by which planners 
can collaborate. 

Creating and modifying forecasts
Individual planners generate forecasts and use worksheets to review and modify 
forecast values. Planners can adjust the data in a number of ways, select different data 
values, and copy and paste data. As planners work, they can use ad hoc reports and 
graphs to visualize data, perform what-if analyses, and look at the data in a variety of 
ways. Planners can also define custom data streams to use in analyses. Planners can 
share their most recent updates with the Demand Plan Manager and other authorized 
collaborators. 

Selecting final forecasts to submit to the shared database
When forecasting is complete, planners choose the measure that contains the forecast 
data that they want to submit to the shared database for each scenario in the demand 
plan. 

Reviewing forecasts
The Demand Plan Manager reviews the consolidated forecast in the shared database. 
He or she might make further judgmental adjustments. Optionally, he or she can 
upload the forecast to the Demand Planning Server.

Uploading data to the Demand Planning Server
If the Demand Plan Manager has not already performed this function, the Demand Plan
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Administrator uploads the consolidated forecast from the shared database to the 
Demand Planning Server.

Publishing final forecasts and renewing the planning cycle
The consolidated forecast is then used for supply chain planning and scheduling. The 
forecast can be:

• Included in a supply plan in Oracle Advanced Supply Chain Planning.

• Included along with the forecast accuracy information in an inventory plan in 
Oracle Inventory Optimization.

• Published to Oracle Collaborative Planning.

• Published from the Demand Planning Server to the source instance to integrate the 
final estimate of demand into the transaction system.

The same demand plan can also be used for the next planning cycle after adjusting the 
time horizon.

Demand Planning Roles
Oracle Demand Planning supports the following user roles:

• Demand Planning System Administrator

• Demand Plan Manager

• Demand Planner

• Demand Plan Viewer

Demand Planning System Administrator
The Demand Planning System Administrator is responsible for integrating Oracle 
Demand Planning with other products and for administering the planning cycle. The 
integration requires collecting data into Oracle Demand Planning from the source 
transaction instance, such as Oracle Applications, making sure that data is clean and 
usable, and publishing Oracle Demand Planning output back to the source for planning 
and scheduling.

The setup tasks require determining overall default settings for the demand planning 
system from a deep understanding of the business process. This includes specifying the 
forecast level, assigning data to individual demand planners, selecting and setting 
defaults for predefined reports, and invoking data consolidation after planners send 
their forecasts to the shared database. 
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The Demand Planning System Administrator should have thorough knowledge of the 
demand planning process and be familiar with Demand Planning Analytic Workspaces.

Demand Plan Manager
The Demand Plan Manager gets a view of the entire data without any restriction or 
scoping. He or she works directly in the shared database and is responsible for 
reviewing planners' consolidated forecasts.

The Demand Plan Manager is responsible for the final forecast numbers that are written
back to the Demand Planning Server. After planners submit their forecasts, the Demand
Plan Manager reviews the consolidated forecast numbers and decides whether to accept
or reject them. He or she could modify the numbers, or choose to reassign them to the 
individual planners. 

Note: If your planning group is very small, you might want to set up all
users to have the Demand Plan Manager responsibility. Note, however 
that the Demand Plan Manager works directly in the shared database. 
This means that if more than one person has this responsibility, only 
one individual at a time will be able to perform functions such as 
creating measures, editing data, and saving documents.

Demand Planner
The Demand Planner is responsible for analyzing and forecasting demand in an 
assigned data segment and for submitting demand forecasts. A Demand Planner is an 
individual forecaster. Qualifications for this role include forecasting and data analysis 
abilities and a good understanding of the business processes governing the data to be 
forecast.

Demand Plan Viewer
The Demand Plan Viewer role allows users read-only access to data in the Shared 
database. Demand plans can be viewed simultaneously by multiple users without 
creating additional Planner assignments. 

When using this role, data cannot be changed, shared or submitted, but documents 
shared by the Plan Manager or Planners are visible. Reports and graphs can be viewed, 
exported, printed and saved. In addition, the user can create and share reports, graphs, 
and saved selections. 

The document toolbar and selector are available for use in this role. Alert notifications 
can be received.
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2
Demand Planning Setup

This chapter covers the following topics:

• Setup Instances

• Setup Data Collections

• Setup Demand Planning Dimensions

• Setup Demand Planning Hierarchies

• Setup Demand Planning Levels

• Setup Demand Planning Hierarchy Levels

• Setup Profile Options

• Demand Planning Setup Procedures

Setup Instances
Oracle Advanced Planning (consisting of the modules Advanced Supply Chain 
Planning, Demand Planning, Global Order Promising, Inventory Optimization, and 
Collaborative Planning) employs a component architecture that allows transaction 
processing and planning to occur in separate database instances (source and destination
instances, respectively.) If you are deploying or intend to deploy any Oracle APS 
module using this multi-instance configuration, please note the following important 
restriction: 

• Both source and destination database instances must be on the same major release 
of the Oracle database. Either both source and destination instances must be on 
Oracle 8i, or both instances must be on Oracle 9i. The configurations (source on 8i, 
destination on 9i) and (source on 9i, destination on 8i) are not supported. 

Instances setup is required to link the source Oracle Applications instance to the 
Demand Planning Server instance.

Many companies use Demand Planning for only a few of their ASCP-enabled 
organizations. To help save time on collections, you can configure Demand Planning to 
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collect data from only those ASCP-enabled organizations that are also enabled for 
Demand Planning. 

To set up instances:
1. Choose the Demand Planning System Administrator responsibility.

2. To open the Application Instances window, select Setup > Instances in the 
Navigator.

3. Complete the fields in the Application Instances window as follows:

Field Function Legal Values

Instance Code Identifies source transaction 
instance.

VARCHAR2(3)

Instance Type Describes the type of data in
the source instance.

Discrete, Process, Discrete &
Process, Other

Version The Oracle Application 
version of the source 
instance.

10.7, 11.0, 11i, 12
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Field Function Legal Values

From Source to APS Name of database link 
defined on the Demand 
Planning Server side that 
allows collection of data 
from the source instance.

Valid database link name

From APS to Source Name of database link 
defined on the source 
instance that allows 
publishing of forecast data 
from the Demand Planning 
Server back to the source 
instance.

Valid database link name

GMT Difference A numerical offset 
indicating the difference 
between the source instance 
time zone and GMT. Not 
used by Oracle Demand 
Planning.

NUMBER

Currency Base currency of the source 
instance.

Lookup values

Assignment Set Not used by Oracle Demand
Planning.

Not applicable

4. Select Organization.

The Organization window appears.

5. Select the Enabled option for all inventory organizations in the source instance that 
contain data collected by the Demand Planning Server for demand planning 
purposes.

6. Select the Demand Planning Enabled option for those ASCP-enabled organizations 
from which you also want to retrieve Demand Planning data.

Setup Data Collections
The purpose of this setup is to collect the basic data required for initialization. It collects
names of inventory organizations and product categories from the Oracle Applications 
source instance to the Demand Planning Server. It caches data essential to the collection 
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process in Demand Planning Server so that collections can proceed.

To set up data collections:
1. Choose the Demand Planning System Administrator responsibility.

2. To open the Planning Data Collection window, select Setup > Setup Collections in 
the Navigator.

3. To open the Parameters window, select the Parameters field in the Planning Data 
Collection window.



Demand Planning Setup    2-5

4. Complete the fields in the Parameters window as follows:

Field Function and Value

Instance Select the instance from which the data is to 
be collected.

Number of Workers Specify the number of workers, between 1 
to 3. The default is 2. The greater the 
number of workers, the greater the 
computational resources devoted to the 
collection process.

Timeout (Minutes) How long before the collection process will 
abort. The default value is 30 minutes.

Purge All Previously Collected Data This field and the next determine whether 
and how previously collected data will be 
refreshed. If this is set to No, the Collection 
Method can be set to Targeted Refresh or 
Net Change. If this field is set to Yes, the 
Collection Method must be set to Complete 
Refresh.
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Field Function and Value

Collection Method The method that can be selected in this field
is determined by what you enter in the 
Purge All Previously Collected Data field. 
The Collection Methods are: 

Complete Refresh: This method clears all 
transaction data from the Planning Server 
(for the source instance being collected), 
then copies over the new data. This mode 
should be used with great caution especially
when you have also implemented 
Advanced Supply Chain Planning or 
Inventory Planning applications. However, 
it is useful to occasionally purge the 
previous snapshots to ease storage 
requirements and to improve system 
performance. 

Targeted Refresh: This method clears 
transaction data for only the user selected 
business entities from the Planning Server, 
and then copies the entity information over 
from the transaction instance. Information 
about non-selected entities remains intact 
on the Planning Server. All planning 
business entities are supported by Targeted 
Refresh collections. 

Netchange Refresh: This method copies 
only incremental changes to business 
entities to the Planning Server and is thus 
faster.

Important: Do not run setup data collection in Complete Refresh 
mode if you are using Oracle Demand Planning and Oracle 
Advanced Supply Chain Planning. Do one of the following:

• Run set up data collections in Targeted Refresh mode.

• Run Oracle Advanced Supply Chain Planning collections to 
gather entities used in Oracle Demand Planning. In this case, 
you don't need to run setup data collections Oracle Demand 
Planning.

5. Make your selections and select OK.
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The Planning Data Collection window reappears.

6. If you select the second parameters field, a window appears that allows you to 
select the Instance and Number of Workers. However, this is not required because 
from this window you are launching a concurrent collection request set and the 
parameters you selected for the first parameter field are the ones that apply.

The source instance inventory organizations from which Setup Collections retrieves
data are dictated by the organizations selected by the user in Setup Instances.

Setup Collections needs to be run each time the following changes:

• The source instance from which data is collected.

• The source instance inventory organizations from which data is collected.

• The product categories in the source inventory organizations.

• Customer or supplier information.

To purge fact data:
1. Choose the Demand Planning System Administrator responsibility.

2. In the Navigator, select Other >Purge Fact Data.

3. Enter a From Date and a To Date. 

You need to specify the purge data range in such a way that it covers the entire time
period for booked dates as well as requested date.

Choose Yes for Booking Data.

4. Select OK.

5. Submit.

Setup Demand Planning Dimensions
Simple demand data has two dimensions: product and time. With each demand, there 
is an associated item and a time bucket. Product and time are the minimum dimensions 
required by Oracle Demand Planning in any demand plan. However, in many global 
organizations, data comes from various sources. For example, sales forecasts may come 
from various parts of the world, from various sales groups and teams, from various 
business groups, and from key customers. Similarly, shipments can be made from 
various business units and distribution centers.

In this situation, typically a number of planners will be working on specific segments of 
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the data for demand analysis and forecast enhancements. Oracle Demand Planning 
facilitates this by providing the following most frequently used dimensions: ship from 
location, geography, sales channel, demand class, and sales representative besides the 
product and time dimensions. In addition, Oracle Demand Planning provides two 
user-defined dimensions. The hierarchies for user-defined dimensions need to be setup 
while they are seeded for other dimensions.

Note: This setup step is typically not needed unless user defined 
dimensions are needed. For details on user defined dimensions and 
customization of hierarchies within dimensions, see: Customizing 
Demand Planning hierarchies, page 26-1.

To set up Demand Planning dimensions:
1. Choose the Demand Planning System Administrator responsibility.

2. To open the Application Utilities: MSD_DIMENSIONS Lookups window, select 
Setup > Dimensions in the Navigator. 

3. Use this window to view the six predefined Demand Planning dimensions and to 
change the Meaning and Description names. Two user defined dimensions are also 
available.

4. Complete the fields in the Application Utilities: MSD_DIMENSIONS Lookups 
window as follows:
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Field Function Legal Values

Code Lookup code that uniquely 
identifies the Demand 
Planning Dimension

CHN, DSC, GEO, ORG, 
PRD, REP, TIM, UD1, and 
UD2.

Meaning Name of the Demand 
Planning Dimension

Default values can be 
changed by user.

Description Describes the Code as being 
a Demand Planning 
Dimension

Default values can be 
changed by user.

Setup Demand Planning Hierarchies
Each dimension may contain multiple hierarchies. For example, the product dimension 
may contain the Product Category and Product Family hierarchies. A product (an 
automobile model: the Corvette) may fit into both a Product Family (a marketing brand:
Chevrolet) and a Product Category (a vehicle style: sports car). Each hierarchy may 
need to be analyzed separately. Oracle Demand Planning provides a set of most 
frequently used hierarchies for the six dimensions:

Hierarchies are used for aggregating data, allowing one hierarchy to be used for 
allocation while others are used for reporting.

Example
Demand Class Dimension

• Demand Class Hierarchy

• Demand Class > All Demand Classes

Product Dimension

• Product Category Hierarchy

• Product > Product Category > All Products

• Product Family Hierarchy

• Product > Product Family > All Products 

• Interest Type Hierarchy

• Product > Interest Type > All Products 
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Time Dimension

• Manufacturing Calendar Hierarchy

• Day > Mfg. Week > Mfg. Period

• Gregorian Calendar Hierarchy

• Day > Month > Quarter > Year

• Fiscal Calendar Hierarchy

• Day > Fiscal Month > Fiscal Quarter > Fiscal Year

• Composite Calendar Hierarchy

• Day > Week > Month > Quarter > Year 

Geography Dimension

• Geography Hierarchy

• Ship to Location > Region > Country > Area > All Geography

• Zone Hierarchy

• Ship to Location > Customer Zone > Zone > All Geography 

• Customer Group Hierarchy

• Ship to Location > Customer > Customer Group > All Geography

Note: The customer group information is not available in 11i 
source. To support the customer group hierarchy in 11i source, 
you should modify the customer group collection source views.
For details on how to modify the source views, see: 
Customizing Demand Planning hierarchies, page 26-1.

• Customer Class Hierarchy

• Ship to Location > Customer > Customer Class > All Geography

Ship From (Organization) Dimension

• Organization Hierarchy

• Organization > Operating Units > Legal Entity > Business Group > All 
Organizations
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Sales Channel Dimension

• Sales Channel Hierarchy

• Sales Channel > All Sales Channels

Sales Representative Dimension

• Sales Representative Hierarchy

• Sales Rep > Sales Manager 1 > Sales Manager 2 > Sales Manager 3 > Sales 
Manager 4 > All Sales Rep

• Sales Group Hierarchy

• Sales Rep > Sales Group 1 > Sales Group 2 > Sales Group 3 > Sales Group 4 > All 
Sales Rep

Note: This setup step is typically not needed, unless custom hierarchies 
are needed. For details on customization of hierarchies within 
dimensions, see: Customizing Demand Planning hierarchies, page 26-
1.

To set up Demand Planning Hierarchies: 
1. Choose the Demand Planning System Administrator responsibility.

2. To open the Demand Planning Hierarchies window, select Setup > Hierarchies in 
the Navigator. 
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3. Use the Demand Planning Hierarchies window to view the preseeded hierarchies 
and their associations with a Demand Planning Dimension defined in the previous 
window.

In this example, the hierarchy name My Geo Hierarchy has been created for the 
Geography Dimension with a description of Test New Hierarchy. 

You can see in the example that multiple hierarchy names can be created for a 
dimension as in the case of Geography that has Customer Group, Geography, My 
Geo Hierarchy, and so forth.

4. Complete the fields in the Demand Planning Hierarchies window as follows:

Field Function Legal Values

Name Hierarchy Name VARCHAR2(30)

Description Detailed description for the 
hierarchy name

VARCHAR2(240). Note that 
users can change the names.

Dimension Demand Planning 
Dimension Name

List of Values. Note that 
users can changes the 
names.

One of the major implementation issues is to decide on the dimensions and hierarchies 
to be used for demand analysis. Oracle Demand Planning provides a set of six 
predefined dimensions along with their hierarchies. These preseeded hierarchies are 
designed to meet most business needs. However, it will be necessary for the users to 
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map their specific business process to these dimensions and hierarchies. 

Dimension viewer
One of the key concepts and features in Oracle Demand Planning is hierarchy levels by 
which users can view, compare and analyze demands of their products over various 
dimensions, for example, geography and organizations. It is difficult to visualize the 
complex interrelationships between hierarchy levels and dimensions where multiple 
hierarchy levels and dimensions exist. This feature enables you to see the various 
hierarchy levels and their relationships within each dimension in a user friendly 
graphical display, helping you to visualize the complex interrelationships.

Dimension viewer features include:

• The ability to view the hierarchical relationships of levels within each dimension.

• A tool to train new users on the concepts of dimensions and hierarchies.

The Dimension Viewer shows Levels, Hierarchies, and Hierarchy Levels windows.

To run the dimension viewer:
1. Choose the Demand Planning System Administrator responsibility.

2. In the Navigator, select Other > Dimension Viewer.

3. Select in the Dimension field.

The Dimensions window appears.

4. To display the hierarchies for the selected dimension, select the dimension for 
which you want to view the hierarchy.
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Setup Demand Planning Levels
Demand Planning Levels represent different ways of aggregating data within a 
Dimension.

Note: This setup step is typically not needed, unless custom hierarchies 
are needed. For details on customization of hierarchies and levels 
within dimensions, see: Customizing Demand Planning Hierarchies, 
page 26-1.

To set up Demand Planning levels:
1. Choose the Demand Planning System Administrator responsibility.

2. In the Navigator, select Setup > Levels.
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The Demand Planning Levels window appears. Use this window to view preseeded
hierarchy levels and identify the position of the level in the dimension.

3. In this example, the following level names: All Geography, Area, Country, Region, 
and Ship To Location have been defined for the Geography Dimension with 
detailed description names. The positioning of the levels in the hierarchy have also 
been defined with All Geography being the top level and Ship to Location the 
bottom level. Area, Country, and Region level names are the intermediate Levels.

If there are no level values defined for the Geography dimension in the planning 
server and the profile MSD: Customer Attribute is not set, then the Demand 
Planning Engine does not collect the Ship-to-Location values. This reduces the size 
of level values and booking shipment cube.

After data collection, you can check the collection log file to view the action taken, 
its impact, and how it can be reverted back. 

4. Complete the fields in Demand Planning Levels window as follows:

Field Function Legal Values

Name Level Name. VARCHAR2(30). Note that 
users can change the name.

Description Detailed Description for the 
Level.

VARCHAR2(240). Note that 
users can change the 
description.
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Field Function Legal Values

Dimension The Demand Planning 
Dimension to which the 
Level is associated.

Lookup Values.

Level Type Code The position of the Level in 
a Hierarchy.

Lookup Values 1: Top, 2: 
Bottom, and 3: Intermediate.

User Attributes 1-5 (This 
field is not currently 
functioning.)

The User Attribute 
associated with the Level.

VARCHAR2(240).

Setup Demand Planning Hierarchy Levels
A Hierarchy Level is created by associating a hierarchy name with a level name.

Note: This setup step is typically not needed, unless custom hierarchies 
are needed. For details about customization of hierarchies and levels 
within dimensions, see: Customizing Demand Planning hierarchies, 
page 26-1.

To set up Demand Planning Hierarchy levels: 
1. Choose the Demand Planning System Administrator responsibility.

2. To open the Demand Planning Hierarchy Levels window, select Setup > Hierarchy 
Levels in the Navigator.
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3. In this example, the level name of Area is associated with parent level name of All 
Geography, the level name of Country is associated with the parent level name of 
Area, the level name of Region is associated with the parent level name of Country, 
and the level name of Ship To Location is associated with parent level name of 
Region for the Hierarchy Name Geography. This forms one of the hierarchies in the 
Geography Dimension. For details, see: Setup Demand Plan Hierarchies, page 2-9.

In this window, you can view the associations between levels to parent levels 
through the same Hierarchy. Once the links are defined and saved, you can use 
Validate Hierarchies to verify that the levels in a Hierarchy are valid.

4. Complete the fields in the Demand Planning Hierarchy Levels window as follows:

Field Function Legal Values

Hierarchy Name Name of the hierarchy. VARCHAR2(30) [Lookup 
Values]

Level Name Name of the level. VARCHAR2(30) [Lookup 
Values]

Parent Level Name The Parent Level to which 
the level is aggregated in 
this Hierarchy.

VARCHAR2(30) [Lookup 
Values]
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Field Function Legal Values

Relationship View The view from which this 
relationship information can
be collected into the 
Planning Server.

VARCHAR2(30)

Level Value Column The column from which the 
Level Value are fetched.

VARCHAR2(30)

Parent Value Column The column from which the 
Parent Level Value are 
fetched.

VARCHAR2(30)

Setup Profile Options
Demand Planning profile options begin with three letters: MSD. The letter is an 
abbreviation for Manufacturing, Supply Chain, Demand Planning.

To set up profile options:
1. Choose the System Administrator responsibility.

2. To open an empty Personal Profile Values window, select Profile > Personal in the 
Navigator.

3. Search for MSD% to open the Profiles window with the MSD profile options.
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4. Select the profile you want to use.

5. Complete the fields in the Personal Profile Values window as follows:

Field Function

MSD: AW Tablespace This profile controls where analytic workspaces are created 
and stored. New plans are created in the specified 
tablespace; existing plans remain in the tablespace specified 
at the time of their creation. Changing the tablespace profile 
has no effect on existing data.

Note: To migrate an old plan to a new tablespace, first 
change the profile, then recreate the plan.
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Field Function

MSD: Calculate Planning 
Percentages

This profile controls planning percentage calculation 
behaviors. Valid values are:

• No, use existing planning percentages: this is the default
value that indicates the planning percentages are not to 
be calculated in Oracle Demand Planning and only the 
existing planning percentages specified in the enterprise
resource planning (ERP) source are used to explode the 
forecast. When this profile value is selected, model bills 
and planning percentages are brought into Oracle 
Demand Planning from the source ERP. Only items for 
which the forecast control flag is either Consume or 
Consume & Derive are considered.

• Yes, for Consume & Derive Options and Option Classes:
this represents the case when you calculate planning 
percentages in Oracle Demand Planning from the sales 
history of Options and Option Classes, based on the 
model bills as defined in ERP. When this profile value is 
selected, sales history of models, options, and option 
classes are brought into Oracle Demand Planning from 
the ERP source in addition to the model bills, and 
planning percentages. Only items for which the forecast 
control flag is either Consume or Consume & Derive are 
considered. 

• Yes, for Consume & Derive Options only: this value 
enables all the functionality of the preceding profile 
value except that the option classes are excluded from 
Oracle Demand Planning and treated as phantoms. The 
Bills of Material are adjusted in Oracle Demand 
Planning to roll directly from options to models. This 
allows the user to set unique planning percent 
combinations for options when their parent Option 
Class is associated to different ATO models. Only those 
items for which the forecast control flag is either 
Consume or Consume & Derive are considered. 

• Yes, for all the Options and Option Classes: this value 
enables all the functionality of the Yes, for Consume & 
Derive Options and Option Classes value. All of the 
Options and Option Classes, specified as Optional in the
Order Entry tab of Bills of Material, are brought into 
Oracle Demand Planning regardless of the forecast 
control flag, as long as the models' forecast control is set 
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Field Function

to Consume or Consume & Derive. Thus, this profile can
be used to collect the planning percentages for all the 
optional items regardless of the forecast control.

MSD: Category Set Name This profile designates the category set. The product 
categories pertaining to the selected category set are 
collected. For an 11isource system, you must select a 
category set that does not allow multiple category roll up, 
such as an item rolling up to multiple categories within the 
same category set for the same organization. Multiple 
category roll up is controlled by the attribute 
mult_item_cat_assign_flag in mtl_category_sets. If this 
source flag is set to Yes, all the items of the category set roll 
up to the Other Category Set in Oracle Demand Planning. 
For Sales Forecast Integration, you use the Sales and 
Marketing Category Set.

MSD: Conversion Type This profile determines what currency conversion rates are 
collected from the General Ledger tables.

MSD: Currency Code This profile designates the currency used as the base 
currency in Oracle Demand Planning. The amounts 
(revenues) are converted to and displayed in this base 
currency.
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Field Function

MSD: Customer Attribute This is a source profile option to selectively bring the 
customer names into Oracle Demand Planning. Selective 
inclusion of customers helps you focus on your key 
customers. It also improves system performance. 

The profile holds the descriptive flexfield column name that 
is used to indicate if a customer in the customer table will be 
brought into Oracle Demand Planning. The valid profile 
option value is one of the attribute columns (ATTRIBUTE1 to
ATTRIBUTE15) of the RA_CUSTOMERS entity. For 
example, if you use ATTRIBUTE10 to setup your key 
customers, then you need to specify ATTRIBUTE10 in this 
profile. 

If the data collections are run without setting up this profile, 
the value of the profile is set to 'None' causing all the 
customers to be disabled. You can change this profile to a 
valid descriptive flex field column name as described above. 
You can also clear the default, 'NONE' or any existing value 
to leave the field blank in which case all the customers and 
customer sites are collected regardless of the setting in the 
descriptive flex field. 

To setup key customers, go to the customer setup screen in 
Oracle e-business source and populate an available 
descriptive flexfield column. If the flexfield is set to 1 for a 
customer, that customer is enabled and will be collected into 
Oracle Demand Planning. Also, the fact data (booking 
history, shipment history, etc.) for this customer will be 
brought into Oracle Demand Planning under the same 
customer and customer site. If the flexfield is set to any other
values or left blank for a customer, that customer is disabled 
and will not be collected into Oracle Demand Planning. 
However, the fact data (booking history, shipment history, 
etc.) for this customer will be brought into Oracle Demand 
Planning under a dummy customer, 'OTHER' and customer 
site, 'OTHER'. Also, the fact data for all the disabled 
customers is grouped into the dummy customer, 'OTHER' 
and customer site, 'OTHER'.
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Field Function

MSD: Enabled 
Organization for Item 
Collections

This profile option specifies how Oracle Demand Planning 
collects Product Family and Product Category relationships. 
Valid values are:

• All Enabled Demand Planning Organizations: Product 
Family and Product Category relationships are collected
from all enabled demand planning organizations.

• Demand Planning Master Organization: Product Family 
and Product Category relationships are only collected 
from the master organization.

MSD: Master Organization This profile is used to select a master organization if there 
are multiple master organizations. The item attributes 
pertaining to the selected master organization are used in 
Oracle Demand Planning. Note that the demand is exploded 
based on the item attributes in the respective inventory 
organizations, and is not exploded based on those in the 
master organization

MSD: One Step Collection This profile controls the number of steps in the data 
collection process. If the value of the profile is selected as 
Yes, the collection programs take the data directly into the 
fact tables in a single step. However, if the value is selected 
as No (as default), then a two-step collection process is used. 
In the first step, collection programs take the data in to the 
Staging Tables where the data can be consolidated and 
cleansed by the user if required. In the second step, the pull 
programs carry the data over to the fact tables from the 
staging tables. Both sets of tables exist on the Planning Server
itself.

MSD: Two-Level Planning This profile allows you to forecast demand at product family
level on the basis of sales histories of member items. You can
collect all the product family members and their sales 
histories regardless of the forecast control as long as the 
product family forecast control is 'Consume' or 'Consume & 
Derive' and the planning method for product family as well 
as members is not set to 'Not Planned'. This is achieved by 
setting the profile value to: Collect all family members and 
their sales histories. The default profile value, Exclude family
members with forecast control 'None' enforces the existing 
behavior that is, only 'Consume' or 'Consume & Derive' 
product family members are collected. 
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For a list of all the MSD profile options, see: Demand Planning Profile Options, page C-
1.

For a complete list of all of the MSD profile options, see: the Profile Options appendix in
the Oracle Advanced Planning and Scheduling Implementation and User's Guide.

Demand Planning Setup Procedures
The typical sequence for setting up Demand Planning is as follows:

1. Customize Hierarchies (if needed): establish the way the information is aggregated 
from a lower level (for example, product) to the higher level (for example, product 
family). For details on the Dimensions, Hierarchies, Levels, and Hierarchy Levels 
setup windows, see: Setup Demand Planning Dimensions, page 2-7 and Setup 
Demand Planning Hierarchies, page 2-9. For details about customizing hierarchies, 
see: Customizing Demand Planning hierarchies, page 26-1.

2. Setup Instances: specify the source application instance from where the data is 
collected. Organizations can also be enabled while setting up instances. The data 
pertaining only to the enabled Organization is then being collected. For details on 
this setup step, see: Setup Instances, page 2-1. 

3. Customize Data Streams (if needed): define a new data stream such as Customer 
Forecast. Use this step when the preseeded data streams such as Booking History, 
Shipment History, and Manufacturing Forecast are not adequate for your demand 
planning process and you need to use more information.

4. Setup Collections: collect basic setup related data pertaining to organizations and 
product category sets. For details, see: Setup Data Collections, page 2-3.

5. Setup Profile Options: select a data collection mode (one-step and two-step), 
category set, and currency conversion. For details, see: Setup Profile Options, page 
2-18.
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3
Flexible Data Streams

This chapter covers the following topics:

• About Flexible Data Streams

• Flexible Data Stream User Procedures

• Uploading Flexible Data Streams

• Attributes of Staging and Fact tables

• Staging the data using SQL*Loader

• Impact of Custom Data Streams on Hierarchy and Fact Views

About Flexible Data Streams
Demand Planning supports flexible data streams. This means that you can define, 
import, and use arbitrary data streams, such as sales forecasts, customer forecasts, and 
supply plans. This feature makes the demand planning process more flexible and 
configurable to the specific needs of your business.

You can define a data stream and indicate its source and the type of demand data that it
will hold, the dimensions and dimension levels to which the data will be associated, 
and the ways to allocate and aggregate the data across dimension levels. These data 
streams enter Oracle Demand Planning during the plan definition phase. Inside the 
planner's or planning manager's workspace, you can view, manipulate and combine 
data streams, and then subsequently submit them as forecast scenarios. You can now 
use any kind of historical or forecast data in Oracle Demand Planning. The flexible data 
stream capability is meant to bring in the time series data only. Oracle Demand 
Planning does not support timeless or dimensionless data such as average allocation 
weights and economic performance indicators. 

You can bring a flexible data stream into Oracle Demand Planning in one of three ways:

• Use the Demand Planning collections process to collect the data from a source 
database. This process first brings the data from the source instance into the Oracle 
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Demand Planning staging tables. The data are validated and then moved to the 
Demand Planning custom fact data table using a Pull program. You need to specify 
a source database view that tells Demand Planning where to find the data on the 
source instance.

• Load custom data contained in flat files into the Oracle Demand Planning staging 
tables. The data are validated and then moved to the Oracle Demand Planning 
custom fact data table using a Pull program. 

• Access data through a Planning Server database view. In this case, the data are not 
collected into the staging table; they go directly into the Oracle Demand Planning 
custom fact data table.

A flexible data stream consists of the following:

• Flexible data stream definition: This is a set of characteristics that specifies the 
nature of the data stream. For example, the manner in which the data stream comes 
into Oracle Demand Planning.

• Column Mappings: These describe how the different data in the data stream will be 
labeled when they are presented in the Oracle Demand Planning user interface. 

There are two modes of defining data streams: basic and advanced. Basic mode allows 
you to define and import most flexible data streams into Oracle Demand Planning. 
Advanced mode provides a superset of the basic mode's functionality, at the cost of 
some exposure to the technical details of the Oracle Demand Planning data model. The 
basic mode assumes that the data stream is not chaotic; that is, the data is available only
at a fixed level in each dimension, for example: product family level in the product 
dimension, the week level in the time dimension, and the customer level in the 
geography dimension. For the basic mode, the aggregation and allocation rules are 
preseeded. 

Flexible Data Stream User Procedures
The user procedure for flexible data streams will be explained by means of an example. 
In this example, we will bring the following two customer forecasts into Oracle Demand
Planning as a flexible data stream.

Forecast Name Item Time Forecast 
Quantity

Forecast 
Dollars

Forecast for 
customer 1, 
FCC1

A Week 50, 
15Dec01

10 100
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Forecast Name Item Time Forecast 
Quantity

Forecast 
Dollars

  A Week 51, 
22Dec01

15 150

  B Week 50, 
15Dec01

20 400

  B Week 51, 
22Dec01

25 500

Forecast for 
customer 2, 
FCC2

A Week 50, 
15Dec01

30 300

  A Week 51, 
22Dec01

35 350

  B Week 50, 
15Dec01

40 800

  B Week 51, 
22Dec01

45 900

To define a customer forecast as a flexible data stream:
1. Choose the Demand Planning System Administrator responsibility.

2. To open the Select Data Definition window, select Setup > Data Streams > 
Define-Advanced in the Navigator. Or select Define-Basic if you are not familiar 
with the Oracle Demand Planning data model and architecture.

Note: As described earlier, there are two modes of defining data 
streams: Define-Basic and Define-Advanced. You should select 
only one of them. If you are not familiar with Oracle Demand 
Planning data model and architecture, you should use the 
Define-Basic, which provides only the basic functionality. The steps
in this section explain the functionality of Define-Advanced, and 
indicates anything that is similar or different for Define-Basic.

There is no difference in this window for the two modes of setup, except that the 
window name reflects the mode; that is, either Define-Basic or Define-Advanced.
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3. All the data streams on the Select Data Definition window are preseeded data 
streams (identified by Code and Name). You can add your own flexible data 
streams to the list of preseeded data streams.

Composites allow you to group types of data (columns) by dimensions and data 
patterns (levels of dimensions). Composites allow the Demand Planning Engine to 
efficiently store and manipulate sparse data. You assign the same number to each of
the data streams you want to form a Composite Group. The number is user defined.
You can leave the Composite Group field blank. This can also serve as a composite 
group. If you want to change the composite group that a data stream belongs to, 
purge the Demand Planning database.

Input data streams are organized into groups of matching dimensions and similar 
sparsity that allow Oracle Demand Planning to create multiple composites. Two 
sets of input data streams that have the same dimensionality can use completely 
different combinations of dimension values. 

The demand planning engine creates dimensional composites whenever data is 
dimensioned by more than one dimension. Except for the time dimension, which is 
not included because most data is dense along time given a certain combination of 
other dimension members. For example, when you set up a plan, dimensional 
composites are created when several data streams have the same dimensionality 
and similar sparsity patterns. 

Oracle Demand Planning automatically determines which data streams should be 
clustered together into the same composite so that overall data storage 
requirements for a demand plan can be minimized. Thus, data streams with the 
same dimensions are grouped automatically into a composite, resulting in reduced 
storage and more efficient processing. 

To set up automatic recommendation of composites:
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1. Logon as the Demand Planning System Administrator. 

2. Select Other > Requests > Submit a new request. 

3. Select the concurrent program, 'Suggest Data Composites'.

4. Select Yes or No for the parameter, 'Do you want to apply the suggested 
composites'.

Selecting Yes will populate the Composite Group fields in the Select Data 
Definition. The user will still be able to change the groups. 

The default value is No. Selecting No means that the suggested composites will 
not appear in the Select data Definition screen. 

In either case of Yes or No, the program output will be displayed from the 
concurrent log of the launched request 'Suggest Data Composites'. 

5. Now, the data streams are grouped automatically in the demand planning 
server.

Note that streams must have the same dimensions and the same read-in level 
for all dimensions. For multiple-stream streams, there must be data for only one
designator.

Once the demand plan has been built, the change in the groups will not impact the 
existing build but will take effect only for the new plan builds. 

You can find the characteristics or attributes of these data streams by selecting a 
data stream and selecting Next. 

4. Select New to define a new data stream in the Define Characteristics window.
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5. Complete the required fields in the Define Characteristics window as follows:

Field Value Description

Code Preseeded value. Name of the data stream. This is a short 
name with less than or equal to 30 
characters that Oracle Demand Planning 
uses internally to uniquely identify the 
data stream.

Name User defined. Description of the data stream. This is a 
longer description with less than or equal 
to 240 characters that you will 
henceforward use to identify the data 
stream in Oracle Demand Planning.

Source of Data Planning Server, ERP, 
Interface.

Possible values are: 

Planning Server: where data comes from 
the same instance as that of Demand 
Planning Server.

ERP: where data comes from some source 
database instance other than the Demand 
Planning Server. 

Interface: where data comes from a legacy 
system loaded as flat files into the Oracle 
Demand Planning staging tables.
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Field Value Description

Type of Data Amount, Quantity, 
Amount and Quantity, 
Amount and Price, and
Quantity and Price.

Possible values are amount, quantity, 
amount and quantity, amount and price, 
and quantity and price. The selected value 
indicates what types of data will be stored 
in the data stream.

Source View Applicability varies. Applicable when ERP is selected as the 
source of data. The Source View is a SQL 
view that defines where to find the 
quantity, amount, and price data for the 
flexible data stream. The Source View also 
defines where to find the dimension level 
values, such as product, geographic 
regions, time periods, sales channels, and 
customers to which those data are 
associated.

Collect Filter 
Condition

Applicability varies. Applicable when ERP is selected as the 
Source of Data. Enter the relevant Where 
clause that describes the data that should 
be collected into Oracle Demand Planning.
This functionality is only available in 
Define-Advanced. For details, see: 
Uploading Flexible Data Streams, page 3-
21. 
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Field Value Description

Planning Server 
View

MSD_CS_DATA_V 
(example)

This is the name of the view that Oracle 
Demand Planning accesses to populate its 
flexible data stream repository or fact table
(for example, MSD_CS_DATA). If you are 
using Interface or ERP as the Source of 
Data, select the preseeded view 
MSD_CS_DATA_V. This view sits on top 
of the Oracle Demand Planning staging 
table MSD_ST_CS_DATA, which is the 
interface table that initially gets populated 
when you bring in flexible data streams 
from flat files or from an Oracle 
Applications source. Oracle Demand 
Planning reads specifically named 
columns from MSD_CS_DATA_V into 
specific columns in its flexible data stream 
fact table (for example, MSD_CS_DATA). 
If you are using the planning server as the 
Source of Data, then you must define your 
own view and enter its name here. This 
view must bring together information 
from the planning server tables of your 
choosing, and it must have the same 
column names as MSD_CS_DATA_V. The 
column names of MSD_CS_DATA_V are 
shown in the Define Data Usage window. 

Designator View Applicability varies. This view allows users to restrict the data 
stream names that show up in various list 
of values, such as input parameter list of 
values. It is primarily meant for planning 
server based data streams, such as supply 
plan and constrained forecast, because as 
you run more and more supply plans in 
Oracle Advanced Supply Chain Planning, 
over time the list of values for these supply
plans gets very large and takes a long time 
to show up in Oracle Demand Planning.
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Field Value Description

Multiple Stream Checked or unchecked. Check this box if many different streams 
with the same characteristics will be used; 
for example, if you will be using forecasts 
from multiple customers. If not checked, 
the stream identifier row (in Step 5) does 
not appear. The default status is not 
checked. This default status is non-editable
in the Define-Basic mode.

Editable Checked or unchecked. Check this box if the data needs to be 
modified in the Demand Planning Planner 
or Manager workspace. The default status 
is checked. This default status is 
non-editable in the Define-Basic mode.

Enabled Checked or unchecked. Check this box if the data stream should be
visible to the Demand Planning Planner or 
Manager workspace. If this is not checked, 
the data stream will not be used. The 
default status is checked. 

Data at Fixed Level Checked or unchecked. Check this box if the data are not chaotic, 
that is, all the data will be at one fixed 
Dimension Level. For example, all the data
will enter Oracle Demand Planning at the 
Item level in the Product Dimension. If not
checked, the Dimension Level (in Step 4) 
and aggregation/allocation functions (in 
Step 6) cannot be selected. The default 
status is checked.
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Field Value Description

Allocation Allowed
To

Checked or unchecked.

Stream Dimension 
Level

Check this box if the data can be allocated 
down the Oracle Demand Planning 
hierarchies by the system. The default 
status is checked.

If checked, you must specify the allocation 
floor from the drop-down list. This is 
applicable only when the 'Data at fixed 
level' box is checked.

The allocation floor determines the level to
which data is allocated for a measure. The 
possible values are Stream Dimension 
level and Lowest Dimension level. 
Selecting the Lowest Dimension level 
allocates the data to the lowest levels of 
each dimension included in the demand 
plan. Selecting the Stream Dimension level
restricts the data allocation for this data 
stream to the dimension levels at which 
the data is brought into Oracle Demand 
Planning. For details, see: Input 
Parameters, page 7-15.

Aggregation 
Allowed

Checked or unchecked. Check this box if the data should be 
aggregated up the DP hierarchies by the 
system. Applicable only when the Data at 
Fixed Level checkbox is checked. The 
default status is checked.
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Field Value Description

Dependent 
Demand

Checked or unchecked.

Drop-down values: 
read or calculate

Check this box if the custom data stream is
dependent demand enabled; that is the 
data stream contains dependent demand 
data in addition to independent demand 
data. Only when this box is checked can 
this data stream be used to calculate 
planning percentages.

If Dependent Demand checkbox is 
checked, then Define Dimension and 
Levels pages automatically presets 
Product Dimension Level to Item Level.

• Selecting Read means that the data 
stream contains dependent demand 
data. This value should be selected for
sales history data streams when it 
contains the dependent sales history 
of options and option classes. 

Note that only booking history and 
shipment history can contain 
dependent demand data and are set to
read in the dependent demand by 
default. 

• Selecting Calculate means that the 
data stream does not contain 
dependent demand data. It has 
independent demand for models, 
which should be exploded to the 
options and option classes based on 
the model bills of material and 
existing planning percentages 
collected from source ERP. 

6. Select Next to open the Define Dimension and Levels window.
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7. In this window, you can select the Level, such as Item or Product Category, for each
Dimension at which the information exists in the data stream. The levels can only 
be selected if the checkbox, Data at Fixed Levels in the Define Characteristics 
window (in Step 3) is checked. Select the Enable checkbox to activate a dimension 
for the data stream.

In our example, select the Enable boxes for Geography, Product, Ship From 
Location, and Time Dimensions. You can then select a level for each of the chosen 
Dimensions.

This functionality is not applicable for chaotic data and is optional for the data at 
fixed level. If you do not select a level here, the system assumes the level to be the 
same as that of the first record that it encounters at the time of data collections.

In our example, select the following level values for the Geography, Product, Ship 
From Location, and Time dimensions respectively: Customer Level, Item Level, All 
Organization Level, and Manufacturing Week.

Oracle Demand Planning offers automatic recommendation of composites to 
automatically detect similar sparsity patterns across different data streams. 
Composites define a subregion of the total possible dimension level value 
combinations at which demand can occur. When a measure is assigned to a 
composite, it allows Oracle Demand Planning to store that measure without setting 
aside storage for every possible combination of dimension level values. 

8. Select Next.

The Define Data Usage window appears. This window tells you which columns in 
the MSD_CS_DATA table correspond to which columns in the view, 
MSD_CS_DATA_V, (or a view that you specify) used by Oracle Demand Planning 
to access the flexible data stream information. The MSD_CS_DATA table is where 
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Oracle Demand Planning stores flexible data stream information.

If the source of the flexible data stream information is Interface, then the default 
view is MSD_CS_DATA_V. It has columns displayed in Planning View Column 
that are automatically mapped to the columns of MSD_CS_DATA and displayed in 
Table Column. Note that the elements of Source View Column are not editable.

If the source of the flexible data stream information is Planning Server, then the 
planning server view provided must have the same column names as 
MSD_CS_DATA_V. The mapping between the planning server view and table 
MSD_CS_DATA is done automatically, so the Source View Column is not editable.

If the source of the flexible data stream information is ERP, then there is no 
restriction on the structure of the source view. In this case, the Planning View 
Column gets relabeled to Source View Column, and it becomes editable. Enter the 
column names in the source view that correspond to the structure of the table, 
MSD_CS_DATA, shown in the Table Column.

You must select the Column Name for quantity, date, and amount from the list of 
values. The selected names are used to label the data in the Oracle Demand 
Planning user interface. For details, see: Customizing the Display Labels for 
Amount, Quantity, and Time, page 3-20.

Several other rows appear for a dimension depending on the selection for the 
drop-down list at the top right of the window, where Dimension Level Primary Key
has been selected from the list of values. The other rows that may appear include:

• Dimension Level Value: If the level value (for example, name of the customer) 
is used for identifying the data.

• Dimension Level Primary Key: If the level primary key is used for identifying 
the data.

• Dimension Source Primary Key: If the source primary key is used for 
identifying the data.

If you select any one of these values, only the corresponding record shows up 
for each Dimension. However, when the source of data is the Demand Planning
Server, only Dimension Level Primary Key appears and the other two data 
identifiers are not applicable. These records do not show up for the Time 
Dimension. One row for Level ID appears for every selected dimension.

Note: The drop-down list selection of Dimension Level Value, 
Dimension Level Primary Key, or Dimension Source Primary 
Key affects only which subset of rows are displayed in the 
Define Data Usage window. It does not alter which planning 
server view or source view columns are mapped to which 
columns in the demand planning flexible data stream table 
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MSD_CS_DATA.

To summarize, you will see the following rows on this window:

• One row for each Type of Data, such as amount and quantity. 

• One row for the Date if Time Dimension has been selected (in Step 4).

• One row for Level ID for each Dimension Level selected (in Step 4).

• One row for Level Value, Level Primary Key, or Source Primary Key based on 
the selection.

• Instance: Note that this field is for information only and cannot be modified. 

• Stream Identifier representing the name of the stream, such as Forecast for 
Customer 1. Note that this row appears only if the checkbox Multiple Stream on
the Define Characteristics window was checked (in Step 3).

This step applies to Define-Advanced only. Scroll to the right on the Define 
Data Usage window and check the UOM Conversion checkbox for the Quantity
field.

Checking this box ensures that the units of measure are appropriately 
converted when the data are rolled up (for example, aggregated up) along 
Oracle Demand Planning hierarchies. 

The UOM Conversion checkbox can be checked only for Quantity and Amount 
and cannot be checked for any other row. Quantity numbers must be brought 
into Oracle Demand Planning in the primary units of measure of the items. 

The aggregation and allocation functions are used to aggregate and allocate the 
data along the hierarchies defined in Oracle Demand Planning. These can be 
selected only for the Quantity and Amount. The list of values include:

• Aggregation Function: Additive, Average, First, Last, Maximum, Minimum, 
and Weighted Average.

• Allocation Function: Allocation based on Weights in Another Measure, Average
Weights based on History, Even, and None.

For example, three items X, Y, and Z belong to a product category C. The 
customer forecast for the three items is 10, 20, and 30 respectively for the Week 
50 ending 15 December 2001. Then, the customer forecast for the product 
category C for Week 50 would be as shown in the following table:
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Aggregated Customer Forecast for 
Product Category C for Week 50

Aggregation Function

60 Additive.

20 Average.

10 First. Note that this is assuming that item 
X forecast is the earliest entry.

30 Last. Note that this is assuming that item 
Z forecast is the last entry.

30 Maximum.

10 Minimum.

Based on the data stream selected at the 
time of defining the Demand Plan.

Weighted Average.

Extending the scenario, let us assume that the forecast for product category C 
for the Week 50 is 60. Then the customer forecast for the three items (X, Y, and 
Z) for week 50 would be as shown in the following table:

Customer Forecast for the Three Items
for Week 50

Allocation Function

Based on the data stream selected at the 
time of defining Demand Plan.

Allocations based on weights in another 
measure.

Based on the history data stream selected 
at the time of defining the Demand Plan.

Average weights based on history.

20 for each of the items X, Y, and Z. Even.

Zero for each item. None.

For our example, select the following Aggregation and Allocation Functions 
from the lists of values:

• Additive and Allocation based on Weights in Another Measure respectively for 
Amount.
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• Additive and Even respectively for Quantity.

9. This step applies to Define-Advanced only. Select Next to open the Define Column 
Dimension Attributes window.

10. In this window you can specify different aggregation and allocation functions for 
different dimensions. For example, you may allocate the data for the product 
dimension, such as product category to items, differently than that for other 
dimensions. If an aggregation or allocation function is not selected for some 
dimension, the functions selected in the previous step apply.

For our example, the functions selected in the previous step in the Define Data 
Usage window are used as the default for all the dimensions, such as geography, 
time, or ship from location (in Step 4) except for product dimension for which the 
selections in this window apply.

11. Select Finish. 

The definition process for the flexible data stream is complete. The flexible forecast 
data stream appears on the Select Data Definition window, the first window with 
which the flexible data stream definition process started (in Step 2).

To load a customer forecast:
1. Now the data needs to be staged in the staging table, MSD_ST_CS_DATA in the 
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Demand Planning Server, as the Source of Data was selected as Interface in Define 
Characteristics window (in Step 3). For details on the format suitable for this 
staging table, see: Attributes of Staging and Fact tables, page 3-22. Generally, the 
data may not be available for all columns shown in the format and some columns 
may be empty. For the customer forecast in this example, assume that the 
information is available only for the following columns:

Data 
Stream 
Definition 
ID 
(CS_DEFI
NITION_I
D)

Data 
Stream 
Name 
(CS_NAM
E)

Instance 
Attribute

Product 
Level ID 
Attribute

Product 
Level 
Value 
Attribute

Geograph
y Level ID
Attribute

Geograph
y Level 
Value 
Attribute

21 FCC1 Legacy1 1 A 15 Customer 
1

21 FCC1 Legacy1 1 A 15 Customer 
1

21 FCC1 Legacy1 1 B 15 Customer 
1

21 FCC1 Legacy1 1 B 15 Customer 
1

21 FCC2 Legacy1 1 A 15 Customer 
2

21 FCC2 Legacy1 1 A 15 Customer 
2

21 FCC2 Legacy1 1 B 15 Customer 
2

21 FCC2 Legacy1 1 B 15 Customer 
2

The following table is a continuation of the columns of the previous table for 
customer forecast:
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Data 
Stream 
Definition 
ID 
(CS_DEFIN
ITION_ID) 
continued

Data 
Stream 
Name 
(CS_NAM
E) 
continued

Org 
Level 
ID 
Attribut
e

Organiz
ation 
Level 
Value 
Attribut
e

Time 
Level 
ID 
Attribut
e

Quantit
y 
Attribu
te

Amount
Attribut
e

Date 
Attribut
e

21 FCC1 29 All 
Organiz
ations

1 10 100 2002-12-
15 

21 FCC1 29 All 
Organiz
ations

1 15 150 2002-12-
22

21 FCC1 29 All 
Organiz
ations

1 20 400 2002-12-
15 

21 FCC1 29 All 
Organiz
ations

1 25 500 2002-12-
22

21 FCC2 29 All 
Organiz
ations

1 30 300 2002-12-
15 

21 FCC2 29 All 
Organiz
ations

1 35 350 2002-12-
22

21 FCC2 29 All 
Organiz
ations

1 40 800 2002-12-
15 

21 FCC2 29 All 
Organiz
ations

1 45 900 2002-12-
22

To find out the CS_DEFINITION_ID, choose the relevant data stream on the Select 
Data Definition window (in Step 2). From the Oracle Applications menu bar, select 
Help > Diagnostics > Examine. 

The Examine Field and Variable Values window appears.

Select DEFN_QUERY for Block and CS_DEFINITION_ID for Field. 
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The Value that appears is the Custom Data Stream definition identifier. 

Select OK.

2. The data that has been loaded in the staging tables need to be pulled in to the Fact 
Table, MSD_CS_DATA using a preseeded Pull program. To perform this, select 
Collections > Pull Data > Custom Data Stream. Select a Data Stream from the Find 
window to open the Data Stream Collection window.

• Collection Type: set to Pull. This program moves data from the staging tables to
the fact tables.

• Single Step Collection checkbox: is for information only. It appears as checked if
you have specified Yes for the profile, MSD_ONE_STEP_COLLECTION. The 
single step collection means that you want to bring the flexible data directly in 
to the Oracle Demand Planning fact tables rather than bringing the data first in 
to the staging tables and in the second step, pulling the data in to the fact tables.

• Instance: identifies which source instance to collect the data from.

• Complete Refresh checkbox: if the Complete Refresh box is checked, the 
previously collected data are deleted from the staging or fact tables, depending 
on the tables into which you brought the data.

• Validate Data checkbox: is always checked and is not editable for pulling the 
data in to the fact tables or when the single step collections are performed. The 
data are always validated at the time of pulling into the fact tables.

• Stream Name: it is possible to bring in only one individual data stream by 
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specifying the Data Stream Name, such as FCC1 for Forecast for Customer 1. If 
this field is left blank, all the data pertaining to the Customer Forecast data 
stream definitions exist.

3. Select Submit to run the data pull concurrent program.

The collection process for the flexible data stream is complete. For details, see: 
Uploading Flexible Data Streams, page 3-21.

To use a data stream in a demand plan, see: Procedure to define a Demand Plan, 
page 7-2.

Customizing the Display Labels for Amount, Quantity, and Time

To customize the labels for Amount, Quantity, and Time displayed:
1. Choose the Demand Planning Administrator responsibility.

2. To open the Column Names window, select Setup >Data Streams > Column Names 
in the Navigator. 

You can specify new column names that would then appear in the list of values for the 
Column Name in Define Data Usage window (in Step 6). New column names can be 
specified only for amount, time, and quantity columns. For example, if you want 
Amount to appear as Contract Purchases in the Oracle Demand Planning user interface,
use the values in the following table:

Name Description Type User Prompt

Contract Purchases Based on flexible 
contracts

Amount Contract Purchases

The label Contract Purchases is now displayed in place of Amount. From the Define 
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Data Usage window (in Step 6), select Contract Purchases for the Column Name.

Uploading Flexible Data Streams
The following diagram explains the process of uploading the data into Oracle Demand 
Planning after the flexible stream has been defined.

Data can be staged into the staging table, MSD_ST_CS_DATA by using SQL*Loader or 
other utilities. Once data has been staged, you must run the Custom Data Pull program.
This pull program pulls valid rows into the fact table, MSD_CS_DATA while invalid 
rows remain in MSD_ST_CS_DATA. This process was explained earlier in the User 
Procedure section (in Step 12).

Collecting data from an ERP source instance

If the source of data is an ERP Source Instance, the flexible data stream should be 
brought into the Oracle Demand Planning staging table, MSD_ST_CS_DATA by 
running a preseeded Custom Data collection program. The Demand Planning System 
Administrator can invoke the collection program.

To collect data into a flexible data stream from an ERP source instance:
1. Choose the Demand Planning System Administrator responsibility.

2. In the Navigator, select Collections > Collect Data > Custom Data Stream. 

Follow the collection process as described in the Data Collection section. 

Depending on the source of flexible data stream data, you may need to run Data 
Collection from the source instance. This brings data into the demand planning 
flexible data stream staging table. You may then need to run a Data Pull program to
move the data from the demand planning flexible data stream staging table into the 
demand planning flexible data stream fact table (in Step 12). These dependencies 
are shown in the following table:
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Source of Data Collect Data into Staging 
Table, MSD_ST_CS_DATA

Pull Data from the Staging
Table to the Fact Table, 
MSD_CS_DATA

Interface Not applicable. The data 
staged by some SQL Loader 
or other utility. 

Applicable.

Planning Server Not applicable. Not applicable.

ERP Applicable. Applicable.

The data for a data stream must be at the same level as specified for that data 
stream. The data at levels other than the data stream definition are discarded 
during the data pull process.

Attributes of Staging and Fact tables
Oracle Demand Planning holds information about flexible data streams in two 
identically structured tables: a staging table MSD_ST_CS_DATA and a fact table 
MSD_CS_DATA. If you are bringing data from an ERP source instance into Oracle 
Demand Planning, that means running the preseeded collection program to bring your 
data into the demand planning flexible data stream staging table, and then running the 
data pull program to bring the data into the demand planning flexible data stream fact 
table. Or if you are bringing data from flat files into Oracle Demand Planning, that 
means you are populating the demand planning flexible data stream staging table 
directly, perhaps via SQL*Loader. In either case, you will need to know what kind of 
flexible data stream information each staging table column is intended to hold. In the 
first case, you will need this information so that you can appropriately fill out the 
mapping between the columns of your source data view and the staging table columns 
(in Step 5). In the second case, you will need this information to know which parts of 
your flat file information to load into which staging table columns.

If you are bringing information from the Demand Planning Server into Oracle Demand 
Planning, you will need to note the default mapping between the Planning Server view 
columns and the demand planning flexible data stream fact table columns provided in 
the Define Data Usage window (in Step 5), and build your planning server view 
appropriately so that the right kind of flexible data stream information gets populated 
into each column of the flexible data stream fact table MSD_CS_DATA.

The required information about what each column in the demand planning flexible data
stream staging and fact tables is intended to hold is shown in the following table:



Flexible Data Streams    3-23

Table Column Column Identifier Comments

ATTRIBUTE_1 INSTANCE Instance that represents the 
data stream.

ATTRIBUTE_2 PRD_LEVEL_ID Level identifier for the 
Product Dimension.

ATTRIBUTE_3 PRD_SR_LEVEL_VALUE_PK Source primary key of the 
level value for the Product 
Dimension.

ATTRIBUTE_4 PRD_LEVEL_VALUE Level value for the Product 
Dimension.

ATTRIBUTE_5 PRD_LEVEL_VALUE_PK Primary key of the level value
for the Product Dimension.

ATTRIBUTE_6 GEO_LEVEL_ID Level identifier for the 
Geography Dimension.

ATTRIBUTE_7 GEO_SR_LEVEL_VALUE_PK Source primary key of the 
level value for the Geography 
Dimension.

ATTRIBUTE_8 GEO_LEVEL_VALUE Level value for the 
Geography Dimension.

ATTRIBUTE_9 GEO_LEVEL_VALUE_PK Primary key of the level value
for the Geography 
Dimension.

ATTRIBUTE_10 ORG_LEVEL_ID Level identifier for the Ship 
From Location Dimension.

ATTRIBUTE_11 ORG_SR_LEVEL_VALUE_PK Source primary key of level 
value for Ship From Location 
Dimension.

ATTRIBUTE_12 ORG_LEVEL_VALUE Level value for the Ship From 
Location Dimension.
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Table Column Column Identifier Comments

ATTRIBUTE_13 ORG_LEVEL_VALUE_PK Primary key of the level value
for the Ship From Location 
Dimension.

ATTRIBUTE_14 Not applicable. Reserved for future use.

ATTRIBUTE_15 Not applicable. Reserved for future use.

ATTRIBUTE_16 Not applicable. Reserved for future use.

ATTRIBUTE_17 Not applicable. Reserved for future use.

ATTRIBUTE_18 REP_LEVEL_ID Level identifier for the Sales 
Representative Dimension.

ATTRIBUTE_19 REP_SR_LEVEL_VALUE_PK Source primary key of level 
value for Sales Representative
Dimension.

ATTRIBUTE_20 REP_LEVEL_VALUE Level value for the Sales 
Representative Dimension.

ATTRIBUTE_21 REP_LEVEL_VALUE_PK Primary key of the level value
for the Sales Representative 
Dimension.

ATTRIBUTE_22 CHN_LEVEL_ID Level identifier for the Sales 
Channel Dimension.

ATTRIBUTE_23 CHN_SR_LEVEL_VALUE_P
K

Source primary key of the 
level value for Sales Channel 
Dimension.

ATTRIBUTE_24 CHN_LEVEL_VALUE Level value for the Sales 
Channel Dimension.

ATTRIBUTE_25 CHN_LEVEL_VALUE_PK Primary key of the level value
for the Sales Channel 
Dimension.

ATTRIBUTE_26 UD1_LEVEL_ID Level identifier for the User 
Defined Dimension 1.
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Table Column Column Identifier Comments

ATTRIBUTE_27 UD1_SR_LEVEL_VALUE_PK Source primary key of the 
level value for User Defined 
Dimension 1.

ATTRIBUTE_28 UD1_LEVEL_VALUE Level value for the User 
Defined Dimension 1.

ATTRIBUTE_29 UD1_LEVEL_VALUE_PK Primary key of the level value
for the User Defined 
Dimension 1.

ATTRIBUTE_30 UD2_LEVEL_ID Level identifier for the User 
Defined Dimension 2.

ATTRIBUTE_31 UD2_SR_LEVEL_VALUE_PK Source primary key of the 
level value for User Defined 
Dimension 2.

ATTRIBUTE_32 UD2_LEVEL_VALUE Level value for the User 
Defined Dimension 2.

ATTRIBUTE_33 UD2_LEVEL_VALUE_PK Primary key of the level value
for the User Defined 
Dimension 2.

ATTRIBUTE_34 TIME_LEVEL_ID Level identifier for Time 
Dimension; 
MSD_PERIOD_TYPE lookup.

ATTRIBUTE_35 Not applicable. Reserved for future use.

ATTRIBUTE_36 Not applicable. Reserved for future use.

ATTRIBUTE_37 Not applicable. Reserved for future use.

ATTRIBUTE_38 Not applicable. Reserved for future use.

ATTRIBUTE_39 Not applicable. Reserved for future use.

ATTRIBUTE_40 Not applicable. Reserved for future use.

ATTRIBUTE_41 QUANTITY Quantity.
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Table Column Column Identifier Comments

ATTRIBUTE_42 AMOUNT Amount.

ATTRIBUTE_43 END_DATE Date: YYYY-MM-DD.

ATTRIBUTE_44 PRICE Price.

Staging the data using SQL*Loader
If you are bringing in a flexible data stream into Oracle Demand Planning via flat files, 
the data can be loaded into the staging table MSD_ST_CS_DATA using the SQL* 
Loader utility. 

Following is a sample SQL*Loader control file, which can be used to upload data for 
any flexible data stream.

Control file stcsdata.ctl
LOAD DATA

INFILE stcsdata.csv

APPEND

INTO TABLE msd_st_cs_data

FIELDS TERMINATED BY "," OPTIONALLY ENCLOSED BY "\""

TRAILING NULLCOLS

(

CS_DEFINITION_ID INTEGER EXTERNAL,

CS_NAME CHAR "NVL( :CS_NAME, 'PRODUCTION')",

ATTRIBUTE_1 CHAR,

ATTRIBUTE_2 CHAR,

ATTRIBUTE_3 CHAR,

ATTRIBUTE_4 CHAR,

ATTRIBUTE_5 CHAR,

ATTRIBUTE_6 CHAR,

ATTRIBUTE_7 CHAR,

ATTRIBUTE_8 CHAR,
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ATTRIBUTE_9 CHAR,

ATTRIBUTE_10 CHAR,

ATTRIBUTE_11 CHAR,

ATTRIBUTE_12 CHAR,

ATTRIBUTE_13 CHAR,

ATTRIBUTE_18 CHAR,

ATTRIBUTE_19 CHAR,

ATTRIBUTE_20 CHAR,

ATTRIBUTE_21 CHAR,

ATTRIBUTE_22 CHAR,

ATTRIBUTE_23 CHAR,

ATTRIBUTE_24 CHAR,

ATTRIBUTE_25 CHAR,

ATTRIBUTE_26 CHAR,

ATTRIBUTE_27 CHAR,

ATTRIBUTE_28 CHAR,

ATTRIBUTE_29 CHAR,

ATTRIBUTE_30 CHAR,

ATTRIBUTE_31 CHAR,

ATTRIBUTE_32 CHAR,

ATTRIBUTE_33 CHAR,

ATTRIBUTE_34 CHAR,

ATTRIBUTE_41 CHAR,

ATTRIBUTE_42 CHAR,

ATTRIBUTE_43 CHAR,

ATTRIBUTE_44 CHAR,

CS_ST_DATA_ID SEQUENCE(MAX,1)

)

The following table shows a sample flat file format used by the Control File:
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Column Position Column Value

1 cs_definition_id

2 cs_name

3 instance

4 prd_level_id

5 prd_sr_level_value_pk

6 prd_level_value

7 prd_level_value_pk

8 geo_level_id

9 geo_sr_level_value_pk

10 geo_level_value

11 geo_level_value_pk

12 org_level_id

13 org_sr_level_value_pk

14 org_level_value

15 org_level_value_pk

16 rep_level_id

17 rep_sr_level_value_pk

18 rep_level_value

19 rep_level_value_pk

20 chn_level_id
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Column Position Column Value

21 chn_sr_level_value_pk

22 chn_level_value

23 chn_level_value_pk

24 ud1_level_id

25 ud1_sr_level_value_pk

26 ud1_level_value

27 ud1_level_value_pk

28 ud2_level_id

29 ud2_sr_level_value_pk

30 ud2_level_value

31 ud2_level_value_pk

32 time_level_id

33 quantity

34 amount

35 end_date

36 price

A sample flat file that follows the above format is shown following. The first row 
ending with the label price is a row of headings that is ignored by SQL*Loader. This flat
file can be created in a spreadsheet by saving the spreadsheet in a comma-delimited 
(.CSV) format.

Sample flat file
cs_definition_id, cs_name, instance, prd_level_id, prd_sr_level_value_pk, 
prd_level_value, prd_level_value_pk, geo_level_id, geo_sr_level_value_pk, 
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geo_level_value, geo_level_value_pk, org_level_id, org_sr_level_value_pk, 
org_level_value, org_level_value_pk, rep_level_id, rep_sr_level_value_pk, 
rep_level_value, rep_level_value_pk, chn_level_id, chn_sr_level_value_pk, 
chn_level_value, chn_level_value_pk, ud1_level_id, ud1_sr_level_value_pk, 
ud1_level_value, ud1_level_value_pk, ud2_level_id, ud2_sr_level_value_pk, 
ud2_level_value, ud2_level_value_pk, time_level_id, quantity, amount, end_date, price

121,GMTRIAL1,381,1,AS54888,,,,,,,,,,,,,,,,,,,,,,,,,,9,3360,1308662.6,12/5/01,

To load the data in the flat file into Oracle Demand Planning via the flexible data stream
staging table, run SQL*Loader as follows:

sqlldr user/password@dbname control = stcsdata.ctl

Pulling data from Staging Table to Fact Table
Run the pull program to pull data from staging table into the fact table. The pull 
program pulls valid data only. Erroneous records remain in MSD_ST_CS_DATA 
OR_DESC will have details of the error. This error detail is a text string, an example of 
which follows:

MSD_CS_DATALOAD_INVALID_LVLID: For ORG and PRD

MSD_CS_DATALOAD_INVALID_DIM: For GEO

MSD_CS_DATALOAD_INVALID_DATE_FORMAT

The different segments of this error detail mean the following:

• MSD_CS_DATALOAD_INVALID_LVLID: This record in MSD_ST_CS_DATA 
contains an unrecognized dimension level. For example, in the product dimension, 
the dimension level is not specified to be Product, Product Category, Product 
Family, or All Products.

• ORG,PRD: In this record, the dimensions that contain unrecognized levels are the 
Ship From Location and Product dimensions. The full list of dimension codes is as 
follows:

Dimension Code Dimension Name

CHN Sales Channel

GEO Geography

ORG Ship From Location (Organization)

PRD Product
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Dimension Code Dimension Name

REP Sales Representative

TIM Time

UD1 User Defined Dimension 1

UD2 User Defined Dimension 2

• MSD_CS_DATALOAD_INVALID_DIM: This record in MSD_ST_CS_DATA 
contains one or more invalid level values. For example, in the Geography 
dimension, the information in the record with the value of ATTRIBUTE_6, 
GEO_LEVEL_ID leads us to expect level value that is a valid Country in the source 
instance. However, the value of ATTRIBUTE_7, GEO_SR_LEVEL_VALUE_PK in 
this record is not a country that has been set up in the source instance.

• GEO: In this record, the dimension that contains unrecognized level values is 
Geography.

• MSD_CS_DATALOAD_INVALID_DATE_FORMAT: The column ATTRIBUTE_43 
(END_DATE) contains an invalid data format. The date format must be 
YYYY-MM-DD.

Collect Filter Condition
The Collect Filter Condition is an additional where clause that is applicable only to data 
streams that are based on information collected from an ERP source instance, which 
entails the creation of your own source view. To provide flexibility in what data are 
collected from a source instance, you can specify filter conditions on the Define 
Characteristics window (in Step 3). The syntax of the filter text is very similar to that of 
a SQL where clause, and is explained by means of the following examples.

Example 1 Filtering Data on the Basis of the Date Field
Booked_date between '&&DATE:MSD_FROM_DATE and '&&DATE:MSD_TO_DATE 

This example filters the source data on the basis of the demand date as specified in the 
source view:

• Booked_date is a column in the Source View. 

• && is a tag that signifies the start of the parameter. It must be followed with the 
type of parameter. Supported types are DATE, NUMBER, and CHAR. The 
parameter type must be followed by a colon (:). Following the colon, you must 
specify the name of a SQL message.
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• When you select Collections > Collect Data > Custom Data Stream from the 
Navigator (under the Demand Planning System Administrator responsibility), 
Oracle Demand Planning displays the SQL messages that you specify as parameter 
value prompts. Once you enter the requests parameter value(s), the value(s) will 
replace the parameter tags at runtime.

If you enter 01-JAN-2002 for MSD_FROM_DATE and 31-DEC-2002 for 
MSD_TO_DATE, this example will be translated at runtime as follows: 
BOOKED_DATE between 01-JAN-2002 and 31-DEC-2002.

Example 2 Filtering Data on the basis of Multiple Parameters
designator = '&&CHAR:MSD_FCST_DESIGNATOR and forecast_Date between 
'&&DATE:MSD_FROM_DATE and '&&DATE:MSD_TO_DATE 

• DESIGNATOR and FORECAST_DATE are columns in the source view of the 
definition. 

• When you select Collections > Collect Data > Custom Data Stream from the 
Navigator (under the Demand Planning System Administrator responsibility), 
Oracle Demand Planning will prompt you for values for the forecast name 
(DESIGNATOR), forecast date lower bound (MSD_FROM_DATE) and forecast date
upper bound (MSD_TO_DATE).

• If you enter 'PROD for MSD_FCST_DESIGNATOR, 01-JAN-2002 for 
MSD_FROM_DATE and 31-DEC-2002 for MSD_TO_DATE, this example will be 
translated at runtime into: DESIGNATOR = PROD AND FORECAST_DATE 
BETWEEN 01-JAN-2002 and 31-DEC-2002.

Impact of Custom Data Streams on Hierarchy and Fact Views
New Demand Planning Server views for Booking Data, Shipment Data, Manufacturing 
Forecast, and Sales Opportunities are created for the flexible data streams feature. These
have different structures than the old views. Oracle Demand Planning Server no longer 
references the old views. The list of new Demand Planning Server views for flexible 
data streams is as follows:

Stream Name Old View New View

Booking Data MSD_BOOKING_DATA_V MSD_BOOKING_DATA_CS_
V

Shipment Data MSD_SHIPMENT_DATA_V MSD_SHIPMENT_DATA_CS
_V

Input Manufacturing Forecast MSD_MFG_FCST_V MSD_MFG_FCST_CS_V
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Stream Name Old View New View

Sales Opportunity MSD_OPPORTUNITY_DAT
A_V

MSD_OPPORTUNITY_DAT
A_CS_V

If, before upgrading to when flexible data streams was introduced, you have 
customized an old planning server view to add filtering conditions, and the view still 
brings in data at the seeded lowest levels, you may simply customize in the same 
fashion the corresponding new planning server view. Examples of seeded lowest levels 
are Item, Ship to Location, and Organization. Alternatively, you may create a new 
flexible data stream to hold your data.

If you have customized a planning server view such that it brings in data at a level 
different than the seeded lowest level, you must create a new flexible data stream to 
hold your data. If you want to use multiple types of dates for the same data stream, you
need to define one flexible data stream for each type of date. For example, Booked Date,
Shipped Date, Promised Date, and Requested Date for the Booking History data stream.
This is because the flexible data stream feature supports only one date type per data 
stream. 
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4
Data Collection

This chapter covers the following topics:

• About Data Collection

• Procedure for Collecting Data

• Graphical Display of Hierarchies

• Pulling Data into Fact Tables

• Net Change

• Integrating Legacy Data

About Data Collection
Data can be brought into Oracle Demand Planning through:

• Seeded data collection programs from the Oracle ERP (10.7, 11.0, 11i) system.

• Open interface staging tables via homegrown data loading programs.

• A SQL*Loader program that collects specified flat data files into Oracle Demand 
Planning staging tables. For details, see: Integrating Legacy Data, page 4-42.

Seeded data collection programs copy data streams from the data source to the Demand
Planning server. If data source is other than Oracle Applications, then the data can be 
inserted into the Oracle Demand Planning Server staging tables using a SQL*Loader 
program. The following figure shows the data collection process:



4-2    Oracle Demand Planning Implementation and User's Guide

If the data is collected from an Oracle source, it can be optionally moved into the 
Demand Planning Server staging tables for data cleansing and then moved into the 
Demand Planning Server fact tables, or inserted directly into the Demand Planning 
Server fact tables. The next figure illustrates the process. 

The profile MSD: One Step Collection controls the number of data collection steps that 
the user should invoke to populate the data in to the fact tables. If the value of the 
profile is selected as No, a two-step collection process is used as seen in the diagram 
above. In the first step, collection programs take the data from a specified source 
instance in to the Staging Tables where the data can be consolidated and cleansed by 
the user if required. In the second step, the pull programs carry the entire data, 
regardless of source instance over to the fact tables from the staging tables. Data stored 
in the fact table is overwritten by newly collected data within specific date ranges. This 
process of pulling data from the staging table empties the staging table for the next 
cycle of data collection. Both sets of tables exist on the Planning Server itself.
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However, if the value of the profile is selected as Yes, the collection programs take the 
data directly into the fact tables without requiring the user to invoke pull programs. 
Selecting Yes means that the collected data is suitable to be used in Oracle Demand 
Planning and does not require to be cleansed in the staging tables. One Step Collection 
is only an additional user convenience, but it internally works as two step collection. 
The pull programs are launched automatically to bring the entire data for all the 
instances from staging table in to the fact tables.

Procedure for Collecting Data
There are several types of data you can collect: Shipment Data, Booking Data, Order 
Backlog, Currency Conversion, UOM Conversion, Manufacturing Forecast, Sales 
Forecast, Level Values, Time Data, Pricing Data, Custom Data Stream, BOM Collections,
or Promotional History.

Depending on what data you select, a set of parameters for collecting the data becomes 
available. You need to complete those fields to indicate how you want the data 
collected. The following sections contain the details on how to collect the various types 
of data.

A recommended approach for organizing your data collection is to first collect the 
mandatory metadata entities, such as level values, time data, and UOM conversions. 
Then collect the optional metadata entities, such as currency conversions and bills of 
material. Finally, fact data entities, such as shipment data, booking data, price list, and 
so on can be collected in any order.

To collect Shipment data or Booking data:
Shipment Data and Booking Data are normally used as the basis for statistical 
forecasting to predict future demand patterns. These are the historical sales data from 
the Oracle Order Management system for all the Models, Option Classes, and Options.

Sales order lines store up-sell, cross-sell, and substitution relationship information. This 
data call also be brought into Oracle Demand Planning using the Booking history, 
Booking history - booked items, Shipment history, or Shipment history - shipped items 
data streams. For details about up-sell, cross-sell, and substitution, see: the Oracle Order 
Management User's Guide and the Oracle Advanced Supply Chain Planning User's Guide.

The table below indicates for each data stream, where the relationship is captured: 
ordered or original item.



4-4    Oracle Demand Planning Implementation and User's Guide

1. Choose the Demand Planning System Administrator responsibility.

2. In the Navigator, select Collections > Collect from Oracle Systems > Shipment (or 
Booking) Data to open the Parameters window. 

3. Complete the fields in the Parameters window.

Field Function Legal Values

Instance The Instance where the data 
is to be moved to the staging
tables in the Demand 
Planning Server.

Lookup Values

Date From (Optional) The date from which to 
collect data.

DATE

Default = System date - 12 
months

Date To (Optional) The date to which to collect 
data.

DATE
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4. When a date range is specified in the parameters, the next time data is collected 
from the same instance, it overrides the previous data for the specified date range 
for that instance. Any data beyond the date range from the previous collection is 
added to the staging table. This is how incremental data is brought into the 
Demand Planning Server. The specified dates refer to the booked date for the 
booking data collection and the shipped date for the shipment data collection.

5. Select OK.

6. Select Submit. 

Submitting the request starts the collection process from the source instance into the
Demand Planning Server staging tables. The collection can be scheduled or can be 
set to execute immediately.

To collect Order Backlog data:
Oracle Demand Planning supports the collection of order backlog data from Oracle 
Order Management. Backlog refers to any sales order quantity that is currently booked, 
but has not yet been shipped or cancelled.

1. Choose the Demand Planning System Administrator responsibility.

2. To open the Custom Stream Collection window, select Collections > Collect from 
Oracle Systems > Order Backlog in the Navigator.
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3. In Collection Parameters, complete the following fields:

Field Function Legal Values

Collection Type This field (view only) 
indicates the type of 
collection method, and is 
view only. When the type is 
Collect, the concurrent 
program collects data from 
the source to the destination 
table. When the type is Pull, 
the program moves data 
from the staging tables to 
the fact tables. To change the
collection type, go to 
Collect/Pull Data in the 
navigation menu. 

Collect
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Field Function Legal Values

Single Step Collection It appears as checked if you 
have specified Yes for the 
profile option 
MSD_ONE_STEP_COLLEC
TION. The single step 
collection means that you 
want to bring the flexible 
data directly in to the Oracle
Demand Planning fact tables
rather than bringing the 
data first in to the staging 
tables and in the second 
step, pulling the data in to 
the fact tables.

Check

Instance Name of the source instance.
This identifies which source 
instance to collect data.

Lookup Values

Complete Refresh The previously collected 
data are deleted from the 
staging or fact tables, 
depending on the tables into
which you brought the data.

Check

Validate Data The data are always 
validated at the time of 
pulling into the fact tables. 
For details, see: Uploading 
Flexible Data Streams:, page 
3-21.

Check

Stream Designator Name of the data collected 
at the time. This is specified 
by the user to identify the 
data collected during a 
collection process.

VARCHAR



4-8    Oracle Demand Planning Implementation and User's Guide

Field Function Legal Values

Scope Indicates whether the 
collected data contains all 
the backlog sales orders, 
only the scheduled sales 
orders, or only the 
unscheduled sales orders. 

When set to All Orders, all 
the scheduled and 
unscheduled sales orders 
are collected.

When set to Scheduled 
Orders Only, only the 
scheduled sales orders are 
collected.

When set to Unscheduled 
Orders Only, only the 
unscheduled sales orders 
are collected. 

The backlog orders are 
collected based on their 
scheduled ship dates and 
ship from organizations. 

All Orders (default), 
Scheduled Orders Only, or 
Unscheduled Orders Only

Date From This date is used as a start 
date for data collection from 
source. The backlog quantity
is collected for the specified 
period. Users can specify 
both past and future dates. 
If the start and end dates are
left blank, all the order 
backlog data is collected.

DATE

Date To This date is used as an end 
date for data collection from 
source. The backlog quantity
is collected for the specified 
period. Users can specify 
both past and future dates. 
If the start and end dates are
left blank, all the order 
backlog data is collected.

DATE
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Field Function Legal Values

Restrict to Orders of Type Specify an Order Type, such
as Revenue or 
Non-Revenue. The backlog 
for only the specified type of
orders is collected. The field 
is blank by default, in which
case all the orders are 
collected regardless of the 
order type.

VARCHAR

Includes Orders on Hold Select Yes to bring sales 
orders, regardless of the 
hold status. 

Select No to exclude the 
orders on hold.

Yes or No (default)

To collect Currency Conversion or UOM Conversion data:
The Currency Conversion collection brings in the currency conversion rates from the 
general ledger rate table source data. In a multinational organization, demand planners 
may require the ability to view and analyze the forecast revenues in different currencies
using the collected currency conversions. However, Oracle Demand Planning displays 
all the amounts (revenue) in one base currency selected in the profile options. Thus, the 
collected currency conversions are not used in the present release of Oracle Demand 
Planning.

The Unit of Measure Conversion collection brings in UOM conversions data from the 
selected source. This data helps to aggregate forecasts for items at all hierarchy levels 
within a dimension in a common unit. 

1. Choose the Demand Planning System Administrator responsibility.

2. In the Navigator, select Collections > Collect from Oracle Systems > Currency 
Conversion (or UOM Conversion) Data. 

3. A Parameters window appears. For details, see: To collect Shipment data or 
Booking data:, page 4-3. 

4. Select OK.

5. Select Submit. 
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To collect Manufacturing Forecast data:
The manufacturing forecast is a useful comparison to the statistical forecast. In case of 
major discrepancies, this may lead to root cause analysis, and ultimately an enhanced 
forecast by the Demand Planner. If the entries in a manufacturing forecast/forecast set 
use more than one type of bucket (for example, day and week), all the entries are 
considered to be in the bucket of the first entry. In other words, multiple buckets are not
supported in Oracle Demand Planning.

1. Choose the Demand Planning System Administrator responsibility.

2. In the Navigator, select Collections > Collect from Oracle Systems > Manufacturing 
Forecast Data. 

3. A Parameters window appears. 

4. Select OK.

5. Select Submit. 

To collect Sales Forecast data from Oracle Sales Online to the Demand Planning Server:
Sales forecast numbers can be collected into Oracle Demand Planning from Oracle Sales
Online, but only for the highest level sales groups. Users can allocate the data down to 
the lower levels using other data streams with data at the desired levels.

1. Choose the Oracle Demand Planning System Administrator responsibility.

2. To open the Sales Forecast Collection window, select Collections > Collect from 
Oracle Systems > Sales Forecast in the Navigator.
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3. The following sales forecast data streams can be collected from this window: Sales 
forecast - best case, Sales forecast - worst case, Sales forecast - probable case, Sales 
forecast - pipeline, Sales forecast - weighted pipeline, Customer sales forecast, and 
Customer order forecast. Users need to select one or more data streams to collect 
the sales forecast amounts into Oracle Demand Planning. For details about each 
type of sales forecast, see: Input Parameters, page 7-15.

4. Complete the fields in the Sales Forecast Collection window as follows:

Field Function Legal Values

Collection Type This (view only) field 
indicates the type of 
collection method. When the
type is Collect, the 
concurrent program collects 
data from the source to the 
destination table. When the 
type is Pull, the program 
moves data from the staging
tables to the fact tables. To 
change the collection type, 
go to Navigator > 
Collect/Pull Data > Sales 
Forecast.

Collect
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Field Function Legal Values

Single Step Collection It appears as checked if you 
have specified Yes for the 
profile, 
MSD_ONE_STEP_COLLEC
TION. The single step 
collection means that you 
want to bring the flexible 
data directly in to the Oracle
Demand Planning fact tables
rather than bringing the 
data first in to the staging 
tables and in the second 
step, pulling the data in to 
the fact tables.

Check

Instance Name of the source instance.
This identifies which source 
instance to collect data from.

Lookup Values

Stream Designator Name of the data collected 
from the source instance at a
time.

The Custom Stream 
Collection program allows 
you to select a previously 
collected stream designator, 
which is based on fact tables
instead of staging tables.

VARCHAR

Start Date This date is used as a start 
date for data collection of 
sales forecast numbers.

DATE

End Date This date is used as an end 
date for data collection of 
sales forecast numbers.

DATE
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Field Function Legal Values

Forecast Category It is an Oracle Sales Online 
feature by which an interest 
type can roll up to two or 
more forecast categories. In 
such situations, you should 
specify a forecast category to
avoid double counting. 
Oracle Demand Planning 
will not provide a list of 
forecast category values, 
and you need to know and 
specify the exact forecast 
category. If this field is left 
blank, sales forecast 
numbers for all the forecast 
categories are brought over 
to Oracle Demand Planning.

VARCHAR

Bucket Type Oracle Sales Online allows 
you to submit sales forecast 
numbers at several time 
levels such as, fiscal month 
and fiscal quarter. Typically,
the business process will 
dictate the use of a bucket, 
however, you must select a 
bucket type from the list of 
fiscal calendar level values.

Fiscal Month, Fiscal Quarter,
or Fiscal Year
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Field Function Legal Values

Source of Collection There are three types of 
data:

Opportunity Worksheet: 
Sales forecasts for a 
customer summed across all
the inventory organizations, 
products, sales channels, 
and sales representatives

Product Category 
Worksheet: Sales forecasts 
for an interest type summed 
across all the inventory 
organizations, customers, 
sales channels, and sales 
representatives

Forecast Worksheet 
(submitted forecasts): Sales 
forecasts summed across all 
the inventory organizations, 
products, customers, sales 
channels, and sales 
representatives.

Opportunity Worksheet, 
Product Category 
Worksheet, or Forecast 
Worksheet

5. Select Submit.

For details about Sales Forecast, see: Using Sales Forecasts and Opportunities, page 26-
15.

To collect Level Values data:
The Level Value collection brings in level values for each dimension (except for the time
dimension that is collected separately) with its association between the level values of 
the parent-child relationship in the hierarchy. Level value data can be collected for the 
following:

• All level values

• Previously defined demand plans (Note that defining demand plans is discussed in 
a later chapter.)

• Specific dimensions
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• Specific hierarchies within a dimension

• Specific levels within a dimension

• Three relationships: Item-Organization, Sales Representative-Operating unit, and 
Ship to location-Operating unit

This filtering mechanism allows for the collection of only the level values necessary for 
demand planning, thus reducing the processing burden. Often, the forecasts do not 
include all the Customers. In such cases it is not necessary to bring all the customer 
names into Oracle Demand Planning. The Customer data is generally very huge and 
any filtering by Customers improves the system performance. To achieve this, a profile 
option, MSD_CUSTOMER_ATTRIBUTE is available in the source instance.

It is possible to customize the level value collection programs or self-service flat files to 
suit your needs. The level value collection program uses the columns specified in the 
Hierarchy Levels Form to collect level values from the source view. Thus, with the 
Demand Planning Hierarchy Levels Form, you can modify the relation view name and 
column mapping to collect level values from different source views other than the 
seeded one. 

Demand classes are also collected as a part of level values collection. 

Note: The format of the level value and level value description for 
Trading Partner Sites (Ship to Location) is as follows:

1. External Sites: customer name: customer number: location: OU 
Name.

2. Internal Sites: customer name: customer number: location: OU 
Name: Org Code (where Org Code is the Internal (Ship to) 
Organization to which the internal site belongs.)

1. Choose the Demand Planning System Administrator responsibility.

2. In the Navigator, select Collections > Collect from Oracle Systems > Level Values to 
open the Parameters window.

3. Complete the fields in the Parameters window.
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Field Function Legal Values

Instance The Instance where the data 
is to be moved to the staging
tables in the Demand 
Planning Server.

Lookup Values

Collection Type Type of collection choices 
are: All, Demand Plan, 
Dimension, Hierarchy, or 
Level.

All, Demand Plan, 
Dimension, Hierarchy, or 
Level

Collection Value List of Data Collection 
names based on the 
Collection Type. 

Lookup Values

4. Select OK.

5. Select Submit. 

Once you have collected the level values data, you can tailor the display of your data. 
The descriptions for items and organizations are read and displayed by Oracle Demand 
Planning. You can choose to display short, medium, long or automatic names.

To collect Calendars (Time Data):
Oracle Demand Planning supports the collection of manufacturing and fiscal calendars 
via the collect time data functionality.

Time data collection brings in data for all the specified time hierarchy levels, such as 
manufacturing week. Each Time hierarchy (Manufacturing Calendar and Fiscal 
Calendar) is collected separately, and the demand is rolled up or down accordingly. For
example, demand of a car model can be rolled from a daily forecast amount to monthly 
to quarterly to yearly in the Fiscal Calendar. 

The appropriate selection of calendar type depends on the availability of source data in 
these calendars. The Gregorian calendar is built within Oracle Demand Planning while 
the manufacturing and fiscal calendars are collected from the source applications. The 
period types in the fiscal calendar should match the seeded Oracle Demand Planning 
levels (for example, month, quarter, and year) for the calendar to be usable in Oracle 
Demand Planning. You do not need to set up a new set of books or calendar but need to
add the required fiscal periods from GL setups. For details of setting up fiscal (for 
example, Accounting) calendar, see: Oracle General Ledger User Guide.

If the existing time hierarchies (types of calendars) are not adequate, then load the 
calendars in a new time hierarchy called Composite Calendar. Composite calendars can 
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be loaded via flat files. The composite calendars should be validated in Oracle Demand 
Planning to ensure that the various level values align properly. 

Oracle Demand Planning does not support multiple instances. Users can inadvertently 
use two calendars of the same name. If multiple calendars of the same name that belong
to different instances appear in Oracle Demand Planning, Oracle Demand Planning 
does not differentiate among them. 

1. Choose the Demand Planning System Administrator responsibility.

2. In the Navigator, select Collections > Collect from Oracle Systems > Time Data to 
open the Parameters window.

3. Complete the fields in the Parameters window.

Field Function Legal Values

Instance The Instance from where the
data is to be moved to the 
staging tables in the 
Demand Planning Server.

Lookup Values

Calendar Type Two types of Calendars. 
When no manufacturing 
calendar is specified in the 
collections parameter, then 
all manufacturing calendars 
associated to the valid 
Demand Planning 
organizations are collected. 

Fiscal Calendar or 
Manufacturing Calendar

Calendar Code List of Calendar names 
based on the Calendar Type.
If the user specifies a code, 
only the specified calendar 
is collected.

Lookup Values
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Field Function Legal Values

Date From (Optional) The start date of the 
calendar.

DATE

Date To (Optional) The end date of the 
calendar.

DATE

4. Select OK.

5. Select Submit.

To collect Calendars associated to Organizations:
1. Choose the Demand Planning System Administrator responsibility. 

2. In the Navigator, select Collections > Collect from Oracle Systems > Time Data.

3. A Parameters window appears. To collect the calendars for all the enabled 
organizations, the user selects the Manufacturing Calendar as the Calendar Type 
and leaves the Calendar Code blank in the parameters window.

4. Select OK.

5. Select Submit. 

This collection program retrieves and stores the Calendar-Organization association 
that is used to populate the seeded data stream, Workday Allocation Weights. For 
details about Workday Allocation Weights, see: Lowest Time Levels for the demand
plan, page 7-7. The program ends in error if the organizations have not been 
enabled in Oracle Demand Planning.

To collect Pricing data:
The Pricing data collection is used to bring in price lists. Once a price list and the source 
instance are selected, the price list is brought into Oracle Demand Planning on time and 
product dimensions. The item prices and their effective dates are collected from the 
source ERP applications. 

You can edit the pricing data in the Oracle Demand Planning staging table to reflect 
prices at any dimension level, such as product category level in the product dimension 
or customer level in the geography dimension. The specified price is applicable for all 
the child level values. In the same staging table, you can also specify the priority to 
manipulate price applicability. Higher priority prices, where 1 is higher than 2, are 
applied in case of a conflict. When the priorities are the same for conflicting prices, the 
prices are applied in the order in which they appear in the price list. For example, if 
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conflicting item and product category level prices appear in a price list with the product
category level price appearing last, the product category level price is applied.

There is no user interface to do such editing, and the editing should be done by a 
technical user. Qualifiers, modifiers, attributes, rounding factors, and other related 
functions of the Oracle Advanced Pricing application are not supported in Oracle 
Demand Planning.

Precedence is supported by Oracle Demand Planning. The standard price functionality 
allows prices to be supplied at any level of a hierarchy. If you supply data for a detailed 
cell that has multiple 'ancestor' prices available, then Oracle Demand Planning uses the 
price with the highest priority. If all eligible prices have equal priority, the price that is 
closest to the item level is used for the product dimension. For other dimensions, the 
last one physically loaded into the database is used. For example, if the price for an item
has a lower precedence number (indicating higher priority) than that used by the 
product category, the item price is used for that item. The product category price is 
used for all the other items of the product category. 

When forecasting, you can load all prices at the aggregate geography level for each 
group of similar products. These prices are given a default priority. However, you 
might make exceptions for specific countries or products. For example:

• In an emerging market where a third party is the local distributor, it might be 
necessary to use lower prices than used the rest of the business. 

• Products whose price varies significantly within a family group such as products 
sold with a full accessory kit versus the base product.

These exceptional prices can be given higher priority in order to ensure that they are 
applied instead of the default prices.

You must be careful when applying different prices at lower product levels such as item
if the business is also supplying prices at both the high and low geography levels. In 
those circumstances, they must specify the lower-level product prices for both the high 
and low geography levels. 

The following table provides a scenario where results vary dependent on the geography
and product levels, and the price priority:

Geography 
Level

Product Level Relative to 
Default

Actual Value Price 
Example 1

Price 
Example 2

High High Default 215 300 300

High Intermediate Default-1 214 300 (inherited
price)

300 (inherited
price)
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High Item (bottom 
level)

Default-2 213 235 235

Low High Default-5 210 280 280

Low Intermediate Default-6 209 280 (inherited
price)

280 (inherited
price)

Low Item (bottom 
level)

Default-7 208 280 (inherited
price)

235

In the above example, a typical product is 300 EUR for a high geography level (priority 
215), 280 EUR for a low geography level (priority 210), and 235 EUR when on sale. If the
promotion price is only supplied for the high geography level (priority 213), then it is 
ignored by the low geography level because the 280 EUR price has a greater priority 
(210). An override price must also be supplied for this item in the low geography level 
(priority 208).

It is possible to have multiple price lines for the same item and for the same effective 
dates but with different units of measure. In such a scenario, you select a price line with 
a unit of measure that matches the item's unit of measure. If none of the price line units 
of measure match the item's units of measure, select a price line that has the primary 
unit of measure flag checked. If none of the price lines have the primary unit of measure
flag checked, select the highest precedence (low value) price list and convert it into the 
item's primary unit of measure. Then apply a currency conversion to convert your price
list currency to the demand planning currency.

Note: New price information is loaded into Oracle Demand Planning 
when a full download process is run. New price data is used to 
determine the amount based on the quantity. Revised prices, however, 
are not applied to existing data until the price list is reapplied by 
running the populate measures. Instead, modifications to existing data 
use the original price and updated quantity to compute the amount. 
There is an exception to this rule: typing an "NA" in a worksheet will 
access the new price data for that product.

If you are using the Oracle Advanced Pricing application, Oracle Demand Planning will
by default use only those price lists for which Source System is specified as Oracle 
Advanced Pricing. To use price lists pertaining to other source systems, you need to 
specify the appropriate mapping from the Request Type MSD to the source system. 

In Oracle Advance Pricing, the user can select an item price unit of measure (UOM), 
which could be different from the primary unit of measure for that item. The price unit 
of measure is supported in Oracle Demand Planning by converting the prices from the 
price unit of measure to the primary unit of measure. Multiple currencies can be used in
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Oracle Advanced Pricing. Oracle Demand Planning reads the price currency and 
converts it to the demand planning currency. 

For details on pricing, see: the Oracle Advanced Pricing User's Guide.

1. Choose the Demand Planning System Administrator responsibility.

2. In the Navigator, select Collections > Collect from Oracle Systems > Pricing Data.

3. A Parameters window appears.

4. Select OK.

5. Select Submit.

Once you have collected the pricing data, you can select the desired price list(s) when 
creating your forecast.

To collect Custom Stream data:
Custom Stream collection is used to collect data streams that are defined by you and are
not seeded. For details, see: About Flexible Data Streams, page 3-1.

1. Choose the Demand Planning System Administrator responsibility.

2. In the Navigator, select Collections > Collect from Oracle Systems > Custom Stream 
Collection Data.



4-22    Oracle Demand Planning Implementation and User's Guide

3. A Parameters window appears. Select a data stream name. To complete, see:

To collect Order Backlog data:, page 4-5.

4. Select OK.

5. Select Submit.

To collect BOM data:
BOM data is used for dependent demand forecasting of various optional components 
used in a product model.

1. Choose the Demand Planning System Administrator responsibility.

2. To open the Planning Data Collection window, select Collections > Collect from 
Oracle Systems > BOM Collections in the Navigator.

3. Now, click in the Parameters field. You can indicate from where and how you want 
to the data collected.
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4. Complete the fields in the Parameters window:

Field Function Legal 
Values

Instance The Instance where the data is to be moved to the 
Staging tables in the Demand Planning Server.

Lookup 
Values

Number of Workers One or greater. This allows you to specify the 
number of workers for the data pull. Increase this 
number to increase the amount of computational 
resources to devoted to the data pull process. 

NUMBER

Timeout (Minutes) The maximum amount of time you would like to 
allocate to the data pull process. If this process has 
not completed within this amount of time, it will be 
terminated with an error.

NUMBER

Purge All Previously
Collected Data

Setting this to Yes removes all data in the planning 
server associated with the selected source instance 
as the first step in the collections process. If you set 
this to Yes, the only allowable collection method is 
Complete Refresh. If you set this to No, the 
allowable collection methods are Targeted 
Replacement and Net Change.

Yes or No
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Field Function Legal 
Values

Collection Method Whether Oracle Advanced Supply Chain Planning 
is installed with Oracle Demand Planning affects 
the options a System Administrator should select 
when performing Demand Planning BOM 
Collections. 

If Oracle Advanced Supply Chain Planning is 
installed and collections have been run, then the 
demand planning system administrator does not 
need to purge the previously collected data, and can
simply perform net change refresh. 

If Oracle Advanced Supply Chain Planning is not 
installed, then the demand planning system 
administrator would perform the collections with 
these options, except when the snapshots grow 
excessive and need to be purged. In this case, the 
demand planning system administrator can select 
the Purge all Previously Collected Data option and 
wipe out the data. All necessary demand planning 
data will be collected.

The demand planning system administrator should 
note that whenever Yes is set for Purge all 
Previously Collected Data, then Oracle Advanced 
Supply Chain Planning collections data will be 
wiped out and will need to be run again. This could 
render existing plans useless. 

The following collection methods exist:

• The Net Change Refresh method copies only 
incremental changes for items and BOMs to the
planning server, and thus, is faster.

• The Targeted Refresh method deletes the 
previously collected data pertaining only to 
items and BOM. 

Net Change 
Refresh, 
Targeted 
Refresh

5. Select OK.

6. Select Submit. 

The Demand Planning BOM Data Collection program runs. This program is a 
two-step concurrent report set. In the first step, the program collects the BOM data 
from the source instance into the MSC_ST_BOM and 
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MSC_ST_BOM_COMPONENTS tables in the staging area of the ASCP component. 

In the second step, the Demand Planning BOM Data Pull program takes the data 
and populates the MSD BOM Data Model, if the MSD: Calculate Planning 
Percentages Profile Option is set to Yes, Exclude Option Classes, but include 
Components. For details about the MSD: Calculate Planning Percentages profile, 
see: Demand Planning Profile Options, page C-1.

Since both the steps run automatically, you only need to select Submit once. 

To collect Material Usage History for Unplanned Maintenance:
The material usage history - unplanned maintenance data stream is used to collect the 
historical material consumption associated with non-routine maintenance in Oracle 
Complex Material, Repair and Overhaul. In other words, this data stream collects the 
materials that are used historically at your facility for unplanned maintenance. This 
data stream is used in Oracle Demand Planning to forecast the material requirements 
anticipated for future non-routine maintenance. 

1. Choose the Demand Planning System Administrator responsibility.

2. To open the Custom Stream Collection window, select Collections > Collect from 
Oracle Systems > Material Usage History - Unplanned Maintenance in the 
Navigator.
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3. In this window, the Data Stream Name and Source of Data are automatically 
populated.

4. In the Collection Parameters section of the window, the Collection Type and 
checkboxes are automatically populated. 

5. Select the Instance from the list of values.

6. Enter your desired historical material data collection Start and End Dates.

7. Select Submit. Or select Submit and Schedule. The completed quantity is collected.

To collect Material Requirements for Scheduled Visits:
The material requirements - scheduled visits data stream is used to collect the material 
tied to scheduled visits as forward looking firm demand. In other words, this data 
stream collects the scheduled visits with the associated place and time data that has 
been designated as firm demand. This data stream is used in Oracle Demand Planning 
as a reference forecast. 

1. Choose the Demand Planning System Administrator responsibility.

2. In the Navigator, select Collections > Collect from Oracle Systems > Material 
Requirements - Scheduled Visits.

The Custom Stream Collection window appears.
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3. In this window, the Data Stream Name and Source of Data are automatically 
populated.

4. In the Collection Parameters section of the window, the Collection Type and check 
boxes are automatically populated. 

5. Select the Instance from the list of values.

6. Enter the desired Start and End Dates.

7. Select Submit. Or select Submit and Schedule.

To collect Material Requirements for Planned Maintenance:
The material requirements - planned maintenance data stream is used to collect all the 
material associated with a unit maintenance plan as a forecast data stream. The unit 
maintenance plan is the forecast of the required routine maintenance generated in 
Oracle Complex Maintenance, Repair and Overhaul. This data stream is used in Oracle 
Demand Planning as the forecast of service parts for the planned maintenance.

1. Choose the Demand Planning System Administrator responsibility.

2. In the Navigator, select Collections > Collect from Oracle Systems > Material 
Requirements - Planned Maintenance.

The Custom Stream Collection window appears.

3. In this window, the Data Stream Name and Source of Data are automatically 
populated.

4. In the Collection Parameters section of the window, the Collection Type and check 
boxes are automatically populated. 

5. Select the Instance from the list of values.

6. Enter your desired Start and End Dates.

7. Select Submit. Or select Submit and Schedule. 

To collect Material Usage History for Planned Maintenance:
The material usage history - planned maintenance data stream is used to collect the 
historical material consumption associated with routine maintenance in Oracle 
Complex Material, Repair and Overhaul. In other words, this data stream collects the 
materials that are used historically at your facility for planned maintenance. 

1. Choose the Demand Planning System Administrator responsibility.
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2. In the Navigator, select Collections > Collect from Oracle Systems > Material Usage 
History - Planned Maintenance.

The Custom Stream Collection window appears. The data collection windows for 
all four CMRP streams are similar.

3. In this window, the Data Stream Name and Source of Data are automatically 
populated.

4. In the Collection Parameters section of the window, the Collection Type and check 
boxes are automatically populated. 

5. Select the Instance from the list of values.

6. Enter your desired historical material data collection Start and End Dates.

7. Select Submit. Or select Submit and Schedule.

To collect Service Parts Usage History:
The service parts usage history data stream is used to collect service parts consumption.
For details on service parts data, service parts usage transactions in debriefs, and usage 
forecasting, see: Forecasting for Service Parts, page 26-23.

1. Choose the Demand Planning System Administrator responsibility.

2. To open the Custom Stream Collection window, select Collections > Collect from 
Oracle Systems > Service Parts Usage History in the Navigator.
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3. In this window, the Data Stream Name and Source of Data are automatically 
populated.

4. In Collection Parameters, complete the following fields:

Field Function Legal Values

Collection Type This field (view only) 
indicates the type of 
collection method, and is 
view only. When the type is 
Collect, the concurrent 
program collects data from 
the source to the destination 
table. When the type is Pull, 
the program moves data 
from the staging tables to 
the fact tables. To change the
collection type, go to 
Collect/Pull Data in the 
navigation menu. 

Collect
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Field Function Legal Values

Single Step Collection It appears as checked if you 
have specified Yes for the 
profile option 
MSD_ONE_STEP_COLLEC
TION. The single step 
collection means that you 
want to bring the flexible 
data directly in to the Oracle
Demand Planning fact tables
rather than bringing the 
data first in to the staging 
tables and in the second 
step, pulling the data in to 
the fact tables.

Check (default)

Instance Name of the source instance.
This identifies which source 
instance to collect data.

Lookup Values

Complete Refresh The previously collected 
data are deleted from the 
staging or fact tables, 
depending on the tables into
which you brought the data.

Check (default)

Validate Data The data are always 
validated at the time of 
pulling into the fact tables.

Check (default)

Stream Designator Name of the data collected 
at the time. This is specified 
by the user to identify the 
data collected during a 
collection process.

VARCHAR

Date From This date is used as a start 
date for data collection from 
source. The backlog quantity
is collected for the specified 
period. Users can specify 
both past and future dates. 
If the start and end dates are
left blank, all the order 
backlog data is collected.

DATE
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Field Function Legal Values

Date To This date is used as an end 
date for data collection from 
source. The backlog quantity
is collected for the specified 
period. Users can specify 
both past and future dates. 
If the start and end dates are
left blank, all the order 
backlog data is collected.

DATE

Geography Dimension Level You can select a level in the 
Geography Dimension for 
data analysis and display in 
Oracle Demand Planning. 
The selected level becomes 
the allocation floor in 
geography dimension for 
service part history data 
stream. Data is available at 
the level higher than the 
selected level in hierarchy of
the selected level. 

Customer (default), Zone, 
and All Geography

Source This is the application from 
where you are collecting the 
data. The Field Service value
collects only field service 
usage transactions that are 
done via debrief process in 
Oracle Spares Management. 
The Depot Repair value 
collects the material 
requirements for repair jobs.
Repair jobs are 
non-standard discrete jobs 
created in work-in-progress 
based on a repair order in 
Oracle Depot Repair. 
Material requirements from 
JTF tasks are also collected.

Field service and Depot 
Repair (default), Field 
Service, Depot Repair
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Field Function Legal Values

Restrict to Install Base 
Trackable Items

Yes means that the usage 
history of only those service 
parts is collected for which 
the Install Base Tracking 
item attribute (service 
attribute group in item 
master) is enabled in Oracle 
Inventory.

Yes/No

5. Select Submit. Or select Submit and Schedule.

To collect Service Parts Returns History:
The service parts returns history data stream is used to collect the returned service 
parts. For details on service parts data, service parts usage transactions in debriefs, and 
usage forecasting, see: Forecasting for Service Parts, page 26-23.

Note: Service parts return history can be used in Oracle Demand 
Planning to create a forecast of service part returns. However, the 
return forecast cannot be used outside of Oracle Demand Planning. The
forecast cannot be published to Oracle Advanced Supply Chain 
Planning or a source ERP application. 

1. Choose the Demand Planning System Administrator responsibility.

2. To open the Custom Stream Collection window, select Collections > Collect from 
Oracle Systems > Service Parts Returns History in the Navigator.

The Service Parts Returns History Custom Data Collection window has the same 
fields as the service parts usage history custom data collection window, except for 
the Source field. See the table above for details on how to complete these fields.
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3. Select Submit. Or select Submit and Schedule.

To collect Return History:
The return history data stream is used to collect the product returns. 

1. Choose the Demand Planning System Administrator responsibility.

2. To open the Custom Stream Collection window, select Collections > Collect from 
Oracle Systems > Return History in the Navigator.
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3. In Collection Parameters, complete the following fields:

Field Function Legal Values

Collection Type This field (view only) 
indicates the type of 
collection method, and is 
view only. When the type is 
Collect, the concurrent 
program collects data from 
the source to the destination 
table. When the type is Pull, 
the program moves data 
from the staging tables to 
the fact tables. To change the
collection type, go to 
Collect/Pull Data in the 
navigation menu. 

Collect
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Field Function Legal Values

Single Step Collection It appears as checked if you 
have specified Yes for the 
profile option 
MSD_ONE_STEP_COLLEC
TION. The single step 
collection means that you 
want to bring the flexible 
data directly in to the Oracle
Demand Planning fact tables
rather than bringing the 
data first in to the staging 
tables and in the second 
step, pulling the data in to 
the fact tables.

Check (default)

Instance Name of the source instance.
This identifies which source 
instance to collect data.

Lookup Values

Complete Refresh The previously collected 
data are deleted from the 
staging or fact tables, 
depending on the tables into
which you brought the data.

Check (default)

Validate Data The data are always 
validated at the time of 
pulling into the fact tables.

Check (default)

Date From This date is used as a start 
date for data collection from 
source. The backlog quantity
is collected for the specified 
period. Users can specify 
both past and future dates. 
If the start and end dates are
left blank, all the order 
backlog data is collected.

DATE
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Field Function Legal Values

Date To This date is used as an end 
date for data collection from 
source. The backlog quantity
is collected for the specified 
period. Users can specify 
both past and future dates. 
If the start and end dates are
left blank, all the order 
backlog data is collected.

DATE

Include RMA Type RMA (return material 
authorization) Type is a 
filter to restrict the collection
of product returns to 
specific type of product 
returns such as 'advanced 
exchange' or 'repair and 
return'. By default, all the 
returns are collected.

Lookup Values

4. Select Submit. Or select Submit and Schedule. 

To collect Promotional History:
The promotional history data stream is used to collect promotional sales history. 
Promotional sales history is the quantity of any sales order line for which a pricing 
modifier has been applied.

1. Choose the Demand Planning System Administrator responsibility.

2. To open the Custom Stream Collection window, select Collections > Collect from 
Oracle Systems > Promotional History in the Navigator.
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3. In Collection Parameters, complete the following fields:

Field Function Legal Values

Collection Type This field (view only) 
indicates the type of 
collection method, and is 
view only. When the type is 
Collect, the concurrent 
program collects data from 
the source to the destination 
table. When the type is Pull, 
the program moves data 
from the staging tables to 
the fact tables. To change the
collection type, go to 
Collect/Pull Data in the 
navigation menu. 

Collect
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Field Function Legal Values

Single Step Collection It appears as checked if you 
have specified Yes for the 
profile option 
MSD_ONE_STEP_COLLEC
TION. The single step 
collection means that you 
want to bring the flexible 
data directly in to the Oracle
Demand Planning fact tables
rather than bringing the 
data first in to the staging 
tables and in the second 
step, pulling the data in to 
the fact tables.

Check (default)

Instance Name of the source instance.
This identifies which source 
instance to collect data.

Lookup values

Complete Refresh The previously collected 
data are deleted from the 
staging or fact tables, 
depending on the tables into
which you brought the data.

Check (default)

Validate Data The data are always 
validated at the time of 
pulling into the fact tables.

Check (default)

Date From This date is used as a start 
date for promotional history
collection from source.

DATE

Date To This date is used as an end 
date for promotional history
collection from source.

DATE

Stream Designator The name by which the data
collected in a collection run 
will be identified.

VARCHAR
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Field Function Legal Values

Scope The scope parameters for 
data collection should be 
selected depending on 
which sales history (total 
sales) will drive the 
forecasting:

• Booking History: 
Collect promotional 
history for all booked 
orders.

• Shipment History: 
Collect promotional 
history for all shipped 
orders or all scheduled 
orders depending on 
your analytic needs.

All Booked Orders, All 
Shipped Orders, or All 
Scheduled Orders

4. Select Submit. Or select Submit and Schedule. 

The collection program collects only the promotional quantities (units) and not the 
dollar amounts.

Submit and Schedule
If you selected Submit and Schedule, then a Note appears with the schedule.

Select OK. Then the Requests window appears, which shows the status of the 
concurrent request.
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Graphical Display of Hierarchies
It is important that the aggregation relationships for a specific level and its subordinate 
level in the hierarchy are properly established. Otherwise, inaccurate information is 
produced at the time of aggregation. For example, in a geographic area such as 
Asia-Pacific, if the countries are not correctly set up in the database, the Asia-Pacific 
level forecasts will not be accurate. Furthermore, due to dynamic business environment,
relationships can change. This feature enables you to review and validate these level 
values within a dimension after the data collection. For example, if you want to find out
the names of the product categories (product category hierarchy) within the product 
dimension, you can select the both the product dimension and the product category 
hierarchy from the menu, and then the system displays all the product category names 
from collected data on the window.

Hierarchy Level Values Viewer features include:

• Names of all level values for the selected hierarchy are displayed for each 
dimension.

• Level values and their associations can be modified to reflect business changes.

To run the hierarchy viewer:
1. Choose the Demand Planning System Administrator responsibility. 

2. In the Navigator, select Dimension Values > Level Values. 

3. To open the Level Values window, select the values for the Dimension, Hierarchy, 
and Level fields and select Find.

4. Select View Hierarchy.

The Hierarchy Viewer appears.

5. Choose the Dimension and Hierarchy from the list of the values in these fields to 
open the Hierarchy Viewer window.
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Pulling Data into Fact Tables
The following pull programs, which correspond with the types of data you can collect, 
are available in Oracle Demand Planning: Shipment Data, Book Data, Order Backlog, 
Currency Conversion, UOM Conversion, Manufacturing Forecast, Sales Forecast, Level 
Values, Time Data, Pricing Data, and Custom Data Stream. For details about these types
of data, see: Procedure for Collecting Data, page 4-3.

The Pull Level Value concurrent program has an Incremental Upload option that allows
you to specify if you want to bring only new level values and associations. Level Values
collection will not delete level values and associations that are not loaded in this 
collection. The one-step level values collection always happens in the Complete Refresh 
Mode. For technical details about the data pull, see: Pulling data from Staging Table to 
Fact Table, page 3-30. 

Net Change
The data are collected into Oracle Demand Planning in a net change fashion. Net 
change refers to collection of only that data which have changed since the last 
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collection. 

For building new demand plans, the Demand Planning Engine downloads fact data. 
For rebuilding demand plans, the Demand Planning Engine uses two dynamic SQL 
queries to download new or modified Level Values from the level value fact table by 
comparing the last_refresh_num column with the demand plan build date. The level 
values contain the newly inserted and modified (since the previous Demand Plan build)
fact data.

The Net Change Refresh method collects fact data, reduces the downloading of 
unnecessary data from Demand Planning Server to Demand Planning Engine, and 
improves the overall performance of Demand Plan build. The Net Change Refresh 
method works as follows: a Refresh Number is generated at the beginning of collection 
that is used to track which records were created or deleted by a collection. Data from 
staging is inserted into the fact table. Each row stores the LAST_REFRESH_NUM and 
CREATED_BY_REFRESH_NUM to represent which collection sequence created this 
row. The ACTION_FLAG column holds the last action performed on the record. Fact 
data is marked deleted for overlapping period. The LAST_REFRESH_NUM column 
tells the refresh number that deleted the row, and ACTION_FLAG is set to Delete. 

Integrating Legacy Data
Oracle Demand Planning provides the ability to collect data from legacy, (non-Oracle) 
systems via flat files. This feature enables the integration of hybrid system data sources. 
You can use planning data in Oracle Demand Planning, even when the source 
transaction system is not Oracle Enterprise Resource Planning. The flat files, provided 
as templates, are flexible enough to load all the data needed to run a demand plan. The 
flat files can be stored on the file system of the Demand Planning server or on a local 
hard drive. 

There are several key processes that utilize concurrent programs to complete the legacy 
integration process. First, data is collected from source legacy systems by specifying the 
data file names and locations, and importing those data files into the Oracle Demand 
Planning Server staging tables. The users can then choose to manually clean the data 
within Oracle Demand Planning. Lastly, through the Pull Data process, the staging 
table data is pulled into the Oracle Demand Planning server fact tables, from where the 
data is sent to the Oracle Demand Planning engine.

Types of data collected include mandatory setup and level values data, fact data for 
seeded data streams, and custom data for custom data streams. There are two options 
for data collection that are discussed next: loading data files into Oracle Demand 
Planning staging tables or loading data files using the Self Service Interface. 

Creating Data Files (option 1)
In this option, you collect flat file data by creating data files. You map the Oracle 
Demand Planning staging table control files to the legacy tables. Then you create scripts
to extract data from the legacy system in the format prescribed by the control files. 
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Finally, extract the legacy data to the data files using created scripts.

Once the data files are created, you can load the data files into Oracle Demand 
Planning. You need to specify the location of the control and the data files. Then you 
will run the concurrent SQL loader program to load and preprocess the flat files. 

Note that if the Level Value flat files contain records pertaining to level id of Item, 
Product category, Product Family, Organization, Ship-to-location, or Customer, the 
collections will error out. To insert the corresponding level values pertaining to these 
levels into DP staging tables, the following flat files should be used:

• Item and Product family from MSC System Items

• Product category from MSC Item Categories

• Organization and Customer from MSC Trading partner

• Ship-to-location from MSC Trading Partner Sites

To load data files into Oracle Demand Planning staging tables:
1. Choose the Demand Planning System Administrator responsibility.

2. To open the Planning Data Collection window, select Collections > Collect from 
Legacy Systems > Collect Flat File Data in the Navigator.
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3. In the Planning Data Collection window, select the Parameters field for the Flat File 
Loader program. Note that the Planning Data Collection window represents the 
concurrent request set, as detailed at the end of this section.

4. Specify the data file names.

5. Enter OK.

6. Select the Parameters field for the Flat File Loader or DP Pre-Processor program to 
open the Parameters window for the Flat File Loader program. 
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7. For the DP Pre-Processor program, another Parameters window opens.
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8. Select Yes for the entities corresponding to the data files specified in the Flat File 
Loader program parameters.

The details of the legacy integration concurrent programs are as follows:
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Concurrent Program Description Input/Output

Flat File Loader Program Upload the data from flat 
file into the Oracle Demand 
Planning (and Oracle 
Advanced Supply Chain 
Planning) staging tables. It 
will have parameter to 
upload Item/Product 
Family, Trading Partner for 
Customer and Org, Trading 
Partner sites, Calendars, 
Booking data, Shipment 
data, Manufacturing 
forecast, Sales forecast, Sales
Opportunity data, Currency 
conversions, UOM 
conversions, Level Values, 
Level Associations, Events, 
Event products, Price List, 
Item list price, and custom 
Data Stream.

Input: Flat files and Control 
File.

Output: Records in staging 
tables from the data file.

Pre-Processor for Oracle 
Demand Planning

Pre-processing legacy data 
includes automatic 
generation of source 
primary keys IDs for the 
records in the staging tables,
sequential data loading in 
the order required, and data 
validation. This is the main 
program for DP legacy 
integration.

If the id exists in LID tables, 
for example, 
msc_local_id_xxx and 
msd_local_id_setup, then 
the program will use the 
same ids to populate the 
staging tables. 

Validates some primary 
foreign key and entity 
attributes.

Input: Staging table records, 
LID table records, and user 
input for processing entities.

Output: Records in staging 
table with source pk, records
in LID tables if it comes first 
time, and records in error 
table.

9. Enter OK. 
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10. Submit the concurrent request.

Creating data files using self service user interface (option 2)
For this option, you need to create data files by downloading the templates and 
specifying the data in the templates. 

Next, you load data files into Oracle Demand Planning by specifying the location of 
control and data files.

To load data files using Self Service user interface:
1. Select the Demand Planning System Administrator responsibility.

2. In the Navigator, select Collections > Collect from Legacy Systems > Collect Flat File
Data - Self Service.

The Self Service page appears.

3. If needed, select Download link to download the templates zip file.

4. Select Browse to select the data file to upload. 

5. Submit the concurrent request for DP Purge Program.

6. Select Start Load Now to load the data file in Oracle Demand Planning.

For details about the legacy integration control file formats, see: Oracle Advanced 
Planning and Scheduling Implementation and User's Guide.
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5
Data Validation

This chapter covers the following topics:

• About Data Validation

• Overview of Data Validation Programs

• Audit Fact

• Level Value Audit

• Setting Up the Audit Query

About Data Validation
The demand planning process involves analysis of historical and forecast data from a 
number of sources.
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Historical data is used to analyze the sales or shipment patterns in the past to predict 
the future demands, usually using a statistical technique. Demand planners then use 
reference data such as sales forecasts, customer forecasts, and manufacturing forecasts 
to compare, validate, and update the forecast based on the historical data. Relationship 
data allows demand planners to analyze data by various ways such as by geographical 
areas of sales, by organizations, and by product types to identify specific pattern and 
trends so that adjustments can be made to the forecast, and at the same time alert 
organizations involved in demand and supply management.

The data from all the sources need to be accurate, and also organized in proper way to 
provide the needed outputs such as reliable forecasts of future demands and 
appropriate alerts and exchange of information with demand and supply management.

Data from the sources can be corrupted due to many reasons including bad 
transactions, missing transactions, human errors, computational errors, and improper 
format. Therefore, it is very important that a validity check on the data is performed to 
ensure the no errors are present in the data used by the demand planning process.

Overview of Data Validation Programs
Oracle Demand Planning provides tools to validate the various types of data needed for
demand planning. There are two programs that can be used to validate the collected 
data:

• Audit Fact

• Level Value Audit

Audit Fact is used to validate fact data, such as:
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• Shipping Data

• Booking Data

• Manufacturing Forecast

• Unit of Measurement (UOM) Data

• Pricing Data

• Custom Data Streams

Level Values Audit provides the tool to check that all the relationship data have been 
collected correctly.

Both programs check for validity and provide summary and detailed reports to the 
users. Oracle Demand Planning also provides a lookup or view program to review the 
rules used for each of the above fact and level value validation program. This is called 
Audit Statement and is described later in this section.

Audit Fact
Once data such as Shipping Data, Booking Data, Currency Conversion, UOM 
Conversion, Manufacturing Forecast, and Sales Opportunity have been collected from 
the source, the Audit Fact allows users to verify nonexistent dimension values in the 
fact data.

In Audit Fact, preseeded queries handle fact validation, such as correct item, item 
references in interclass unit of measure conversions, and item references in price list 
data. Whenever there is a discrepancy between a fact data and corresponding level 
value data, then a highlighted flag appears in the Audit Fact report. The audit report 
presents the consolidated output of the auditing process reflecting the mismatched 
data. Audit Fact Data Report audits data for seeded as well as custom data streams, 
price lists, and unit of measure conversion data. It returns results in an output file.

For example, the booking history data has an organization named ABC Org. for the 
Organization Dimension with a corresponding identifier of Primary Key 229. However, 
in the level values, there is no such value corresponding to Primary Key 229. The report 
highlights this fact. Primary Keys are system-generated keys used for identification and 
cross-referencing of data elements from different tables.

The Audit Fact report also shows a consolidated display of the erroneous data by data 
streams lists. The report lists the data records reflecting the non-existent level values. 

To run Audit Fact:
1. Choose the Demand Planning System Administrator responsibility.

2. In the Navigator, select Audit Fact to open the Parameters window, which appears 
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on top of the Pull_Utility window.

3. You can select either Yes or No in the Detailed Error Report field. If you select No, 
you will get a summary report. To get a detailed error report, choose Yes, then 
select OK to open the Pull_Utility window.

The Pull_Utility window contains the Fact Validation in the Name field and Yes in 
the Parameters field.

4. Select Submit. A message appears confirming that the request was submitted. 
Please note the Request ID.

5. Select No to close the window. 

6. Select View > Requests from the main window menu bar.

The Find Requests window appears.
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7. Select Find to open the Requests status window.

8. Select Refresh Data if you need to see the request status under the Request ID.

9. Select View Output to see the report.

The report shows exception message for mismatches in values between collected 
booking history and levels values for the dimensions where the mismatch 
happened. It shows primary keys (identifies a data item in a table) in red for the 
missing level values for the dimensions. In the above case, the Product and 
Organization dimensions have mismatch. This is explained in the table below that 
shows a sample output report. For details, see: Setting Up the Audit Query, page 5-
10.

ROW ID Instan
ce

Item 
PK

Org 
PK

Chann
el PK

Sale
s 
Rep 
PK

Locati
on PK

Qty

AAAda1AAfAAAHGqAA
A

201 MMX3
32

03738
29

INDIR
ECT

-777 1005 10

AAAda1AAfAAAHGqAAB 201 MMX3
32

03738
29

INDIR
ECT

-777 1005 10
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ROW ID Instan
ce

Item 
PK

Org 
PK

Chann
el PK

Sale
s 
Rep 
PK

Locati
on PK

Qty

AAAda1AAfAAAHGqAAC 201 MMX3
32

03738
29

INDIR
ECT

-777 1005 10

AAAda1AAfAAAHGqAAd 201 MMX3
32

03738
29

INDIR
ECT

-777 1005 10

The following table explains the function of each column in sample output report:

Column Function

ROWID System-generated ID for the row.

Instance Name of the source instance.

Item PK Primary Key of the item for which there is no 
corresponding collected level values. The 
program looked at the Primary Key MMX332 
in the level value table and there was no value
for Primary Key MMX332 for the Product 
dimension. In other words, there is a missing 
value for Product Dimension at Item Level in 
level value table.

Org PK Primary Key of the Organization for which 
there is no corresponding value in the 
collected Organization Level value. This is 
flagged in red.

Other primary keys for the rest of the dimensions are also shown as a reference. Some 
examples of dimensions: Sales Channel, Sales Representative, and Organization. They 
indicate the primary keys that can be used to locate the records in the booking history 
table for these dimensions. 

The program checks for mismatches between the tables where data is collected and the 
tables where level values are collected. For example, it checks shipping history table, 
price conversion table, and the Unit of Measure table. Then it flags for mismatches with 
corresponding level values.

The result of any mismatch does not prevent building demand plans. A demand plan 
with missing data just does not use the data, and produces incomplete results for 
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demand planners.

As shown in the sample output report, the shipping history table does not have 
corresponding level values. To prevent this problem, you must check the values in the 
level value tables and fact tables, identify the root cause, and rectify the problem. The 
problem may have arisen due to many reasons, such as a change in an item number or 
an organization name change.

Level Value Audit
This validation program is used to verify missing level values in the hierarchies. After 
the level value data collection, you can use this feature to verify whether there are any 
missing level values from level value collections. For example, for a geography 
dimension, you can verify whether the Ship To locations roll up to regions.

Level Value Audit enables you to:

• Verify that the collected hierarchy level values are accurate and there is no missing 
data for a particular hierarchy level.

• Display the inaccurate or missing level values.

• Clean up inaccurate records before forecasting.

Validate composite calendars loaded by you.

To run the Level Value Audit:
1. Choose the Demand Planning System Administrator responsibility. 

2. To open the Find Level Values window, select Dimension Values > Level Values in 
the Navigator. 

3. Select values for the Dimension and Level fields and select Find to open the 
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completed Level Values window.

4. The View Hierarchy button is described in Graphical Display of Hierarchies, page 
4-40.

Selecting Associations enables you to find a higher level value (parent) for a 
selected lower level value (child) for a dimension. For example, for the Geography 
dimension, if a country name such as United States is selected, it shows its 
corresponding area (or parent), which is North America.

5. Select Launch Level Values Audit.

A note appears, which indicates that the request has been accepted and being 
processed.

6. Select OK to close this window.

7. Select View > Requests from the main menu.

8. Select Find to open the Requests status window.
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9. Select View Output to see the report.

The following two tables are a sample report:
Checking for level values at aggregate levels that have no children:

Level Value Level Child Level

France Region Ship to Location

Test Group Customer Class Customer

Results in two errors.

Checking for parentless level values:

Level Value Level Parent Level

AS011062 Item Product Category

PLT100 Item Product Category

SEE102 Item Product Category
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Level Value Level Parent Level

SEE103 Item Product Category

France Region Country

Results in five errors.

In the example output above, there are two situations of missing relationships 
displayed. One is childless parent and another is parentless child. For the parent France 
at the level Region there is no child record at the lower level Ship To Location. 
Similarly, in the second example, for child Item AS011062, there is no corresponding 
parent at Product Category level.

The above problem can happen due to the dynamic nature of a business. As business 
changes, hierarchical relationships may also change. For example, if a Product Category
changes, but no one changes the relationship with the Items, this type of problem can 
occur. 

If such a problem is detected, the result could be misleading in demand planning. For 
example, if there is a sales booking from a ship to location in France, Demand Plan does 
not detect the booking. 

In order to prevent this problem, you need to find out root causes for the missing 
relations and ensure that problems are corrected in data source tables (for example, 
Relationship Tables) from where these relationships are collected in the demand 
planning.

Setting Up the Audit Query
Sets of base queries have been seeded into the core application for both Audit Fact and 
Level Values Audit. You can review these query statements by following the directions 
below. Furthermore, implementation consultants, or users with limited SQL experience 
can add or modify this set of preseeded queries to provide custom detailed validation, 
or to format the output of existing audit statements.

To setup an Audit Query:
1. Choose the Demand Planning System Administrator responsibility.

2. In the Navigator, select Setup > Audit Statement.

3. From the menu bar select View > Find while the cursor is on the Name area.

A list of predefined audits appears.

4. Choose any of the Audit Statements (e.g., Booking Data), to open the Audit 
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Statements window with the list of audits.

5. The following table lists the names of the fields, their functions, and legal values 
that appear in this window:

Field Function Legal Values

(Audit Report) Name User-defined name of the 
audit report.

List of Values

Define... button Brings up FND form which 
lets you modify, create, or 
delete audit report.

Not applicable

(Audit Statement) Name System-provided name of a 
preseeded audit statement.

Not applicable
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Field Function Legal Values

Enabled check box Indicates whether to execute
the Audit Statement.

Checked or unchecked

Message Gives the FND message that
is output before the 
statement is run.

Not applicable

Error Message Name of an error message 
that is displayed when the 
audit statement query 
retrieves any errors.

Not applicable

Messages... button Allows you to define the 
specific error text that is 
displayed in the error 
message above. If the special
token &COUNT has been 
included in this error text, it 
displays as the number of 
errors retrieved.

Not applicable

Columns tab: Name column The Columns tab lists the 
columns of the query. Name
is the actual column name or
SQL expressions.

Not applicable

Columns tab: Description 
column

This field is optional. It 
refers to FND messages that 
are written as column 
headers in the report's 
output.

Not applicable

6. If you want to change the FROM and WHERE clauses of your SQL query, select the 
Query Clauses tab.

7. If you want to define a Summary Message for the fact validation or level value 
validation, select the Summary Messages tab.

Use the information in the following table to fill out the fields in this tab:
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Field Function

Show only summary message in output 
check box

When you run Validate Fact or Validate 
Level values, you have a choice of whether 
to display a detailed report or a summary 
report. Use this check box to display one or 
the other. To display a summary report, 
check this box. To display a detailed report, 
do not check this box.

Summary Message Enter the name of the Message. This text can
contain a number of user-defined token 
(variable) values.

Token Column Enter the name of the token in the message.

Value Column Enter the SQL code that will define the 
value of the token.
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6
Events

This chapter covers the following topics:

• About Events

• Business Applications

• Promotions

• New Product Introductions and Cannibalization

• Product Phase Outs

• Events Calendar

About Events
This section provides a detailed discussion on how to define and manage events. Any 
occurrence that is expected to impact the sales or demand is termed as events here. 
Some different types of events are promotions, new product introductions, 
cannibalization, phasing out products, store openings and closings, new features and 
changes in existing product, introduction of products to the new markets.

Any business needs to plan ahead for all these events and analyze their potential effect 
on future demand. The outcome of such an analysis may be in the form of a lift or 
modification factor. The positive modification factor would indicate increased sales 
while a negative modification factor would indicate cannibalization or reduced sales. 
For example, 10% reduction in the retail price of product A may result in a 15% lift in its
sales but a 3% reduction in sales for product B.

Oracle Demand Planning has a user interface to define such events and their impacts on
future sales that can vary by product, time, and market. The events so planned and 
defined are considered for calculating a demand forecast as shown in the figure below.
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Supported event types
• Promotions and other events: events for those existing products for which some 

history data is available to generate a baseline forecast and for which the impact of 
an event can be defined in terms of modification factors for base demand and price. 
Some such events are: price reductions to clear the inventory, advertising 
campaigns, a new product introduced by the competition, and a Christmas week 
sales promotion.

• New product introductions and cannibalization: events for those existing or new 
products for which history data is not available but which are expected to sell, 
similar to some existing products with known sales history or forecast. The baseline
forecast is generated on the basis of available data and can be modified by applying 
suitable modification factors. Some such events are: new product introductions or 
product introduction in new markets.

• Product phase outs: events for products nearing the end of life when the sales of 
those products is expected to become flat or reduce at some rate to zero and the 
impact of event can be defined in terms of modification factors. Some such events 
are: removing a product from a certain market, product declared unsafe, or product
replaced by the next generation.

Event modeling capability
It is possible to specify all the items that the event affects and the time period for which 
the event is effective. The expected increase or decrease in demand and price for each 
event can also be specified. Any such impact of an event could be multiplicative, 
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additive, or subtractive. The user is able to enter the absolute values or the change in 
value. For example, if the event is a promotion or introduction of a product, the impact 
could be in the form of a increase by percentage modification factor. However, such an 
event, like reduced sales, may lead to cannibalization or phase out of other products, for
which the impact could be a decrease by percentage modification factor.

Different modifications factors can be specified for different time periods. For example, 
it is possible to specify percentage increase in demand by 10% and 20% for two different
time periods within the effective period of a promotion.

Event impacts can also vary by region, market, and sales channel. To model this 
requirement, different modification factors can be defined for any dimension, such as 
geography and sales channel, supported by Oracle Demand Planning. Within the 
dimension, different modifications can also be specified for various levels, for example: 
region, country, and ship-to-location for the geography dimension. It is common to see 
a marketing campaign that does well in one market and not well in another. Such 
situations can be handled by specifying a increase in sales by 10% for western region 
and a decrease in sales by 400 for the eastern region and the direct sales channel.

Note: Events are downloaded with four user dimensions: geography, 
product, time, and organization. Collapsed dimensions like demand 
class are downloaded as a hierarchy of one of the user dimensions (like 
geography). Although the event works with the collapsed dimension, 
the collapsed dimension name is not shown as the event qualification in
the shared database.

Simulation capability
After the events have been completely defined, they can be associated with a scenario. 
Multiple events can be associated with a scenario and multiple scenarios are allowed to 
be associated with an event. This feature provides unlimited what-if events analysis 
capability. It may be recalled here that multiple scenarios can be defined within a 
demand plan in the demand planning server. For example, the optimistic forecast 
scenario may include promotions with higher estimate of increase in sales or lower 
estimate of reduction in price. The events associated with a scenario are applied on top 
of the base forecast for that scenario.

Conflict resolution
If there is a conflict when a product is covered by two events, there exists precedence 
logic to resolve it. Alternative events can be accurately modeled by assigning priority at 
the time of associating an event with the scenario. This obviates the need for multiple 
definitions of the same event just to change the priority. The priority determines the 
order in which the events are applied. 
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Business Applications
To increase the sales, clear excess inventory, expand existing markets or build new ones,
improve margins, match the competition, or improve investor or company morale, 
events are planned by most companies. Because the company may be offering many 
similar products, increases in the sales of one product may cannibalize (reduce) the 
sales of other similar product. Introducing a new product may also reduce the sale of 
another similar spatial variety and may lead to end-of- life phasing out of an existing 
product. Such events and their impacts, different for different dimensions, can be 
defined in the Demand Planning Server at Events and Product Introductions under 
Demand Planning System Administration responsibility in the navigator window. 

Sample business application
A company has two models, 00FLMA and 00FLMB, in the light motor car segment. It 
decides to introduce a new model 00FLMF on 1 June 2001. Hereinafter, these models are
respectively called A, B, and F for simplicity. F is expected to sell 20% more during 2001 
than what model A would have sold. The demand for A is expected to decrease by 50% 
due to introduction of F. The company also decides to reduce the price of model B by 
5% starting 1 April 2001 only in the United States, which is expected to increase the sale 
of B in the United States by 10% for first two months but only 5% afterwards due to 
introduction of F. The company expects to phase out model A during the year 2002 as 
follows: 

• United States only from 01/01/2002 to 03/31/2002 by 25%.

• All geography from 04/01/2002 to 06/30/2002 by 25% and afterwards to death at the 
end of the year 2002.

Procedure for defining events 
Oracle Demand Planning supports global events as well as personal events. Global 
events are defined by the Demand Planning Administrator, and are available to all the 
demand planners. Global events are universal in scope that is they may cover events 
across planners' demand scope. Personal events are defined and used by demand 
planners within each planner's own demand scope. For details, see: Events, page 9-9. 

The following procedure describes how you would define global events in the Demand 
Planning Server for the sample business application.

To define events:
1. Choose the Demand Planning Administrator responsibility.

2. In the Navigator, select Events and Product Introductions > Promotions and Other 
Events.
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3. Select Details to open the Details window.

4. Complete the fields in the Details window as follows:
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Field Value

From Date First Row: 01-APR-2001. Second Row: 
01-JUN-2001.

To Date First Row: 31-MAY-2001. Second Row: 
31-DEC-2001.

Qty. Modification Type Both Rows: Increase by Percentage.

Qty. Modification Value First Row: 10. Second Row: 5.

5. Price modification of 5% for this scenario can be specified if users scroll to the right 
and: 

• Select Decrease by Percentage as the Price Modification Type for both the rows.

• Enter 5 as the Price Modification Value for both the rows.

6. Select the Geography tab.

7. Select the following geography values:

• Geography column, first row is Country.

• Geography Value column, first row is United States.

• Geography column, second row is Country.

• Geography Value column, second row is United States.

At this point, you have modeled the following part of the scenario:

The existing forecast for B (from 1 April 2001 to 31 December 2001) in the 
United States is increased by 10% during 1 April 2001 to 31 May 2001 and by 
5% during 1 June 2001 to 31 December 2001. The revenue forecast for B in the 
United States during the period from 1 April 2001 to 31 December 2001 
decreases by 5%.

8. To open the New Product Introduction window, select Events and Product 
Introduction > New Product Introductions and Cannibalization in the Navigator.
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9. Complete the fields in the New Product Introduction window as follows:

Field Value

Name NPI New

Description Apr to Dec Campaign

Type Supersession

Forecast Basis Individual histories of base products

Product Level Item

Product 4101

Start Date -

End Date -

10. Select the Details tab to open the Details window.
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11. Complete the fields in the Details window as follows:

Field Values

From Date 01-JUN-2001

To Date 31-DEC-2001

Qty Modification Type Increase by Percentage

Qty Modification Value 20

12. Close the Details window.

The New Product Information window reappears.

13. Select Base Product to open the Base Products window.
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14. Complete the fields in the Base Products window as follows:

Field Value

Product 4102

Weight 100

History Start Date 01-JUN-2001

History End Date -

Though not required for this scenario, details for base products can also be entered. 
Also, any number of base products with varying weights (total should be 100) can 
be used to model the forecast of new product. Weight % for a base product 
determines the fraction of its forecast that is used as the forecast of the new product.

15. Close the Base Products window.

The New Product Information window reappears.

16. Select Cannibalized Products to open the Cannibalized Products window.



6-10    Oracle Demand Planning Implementation and User's Guide

17. Complete the fields in the Cannibalized Products window as follows:

Field Value

Product 00FLMA

From Date 01-JUN-2001

To Date 31-DEC-2001

Qty Modification Type Decrease by Percentage

Qty Modification Value 50

At this point, you have modeled the following part of the scenario:

The existing forecast for A from 1 June, 2001 to 31 December, 2001 is increased by 
20% and is considered as the forecast for model F during the same period. On the 
other hand, the same existing forecast for model A is decreased by 50% and is 
considered as the new forecast for A. 

18. To open the Product Phase Out window, select Events and Product Introductions > 
Product Phase Out in the Navigator.
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19. Complete the fields in the Product Phase Out window as follows:

Field Value

Name 00FLM_outA

Description 00FLMAphase out in 2002

Product Level Item

Product 00FLMA

Start Date 01-JAN-2002

End Date 31-DEC-2002

If you want to start with the reduced forecast on 01 January, 2002 due to 
cannibalization (in step 17), the Start Date should be entered here as 01 January, 
2002.

20. Select Details.

The Details window appears.

21. Complete the fields in the Details window as follows:



6-12    Oracle Demand Planning Implementation and User's Guide

Field Values

From Date First Row: 01-JAN-2002.

Second Row: 31-MAR-2002.

Third Row: 30-JUN-2002.

To Date First Row: 31-MAR-2002.

Second Row: 30-JUN-2002.

Third Row: 31-DEC-2002.

Qty Modification Type All three rows: Decrease by Percentage.

Qty Modification Value First Row: 25.

Second Row: 25.

Third Row: 100.

22. Click the Geography tab to open the Details window for Geography.
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23. Complete the fields in the Details window as follows:

Field Value

Geography First Row is Country (this row has been 
added to the screenshot).

Second Row is All Geography. 

Third Row is All Geography.

Geography Value First Row is United States (this has been 
added to the screenshot). 

Second Row is All Geography. 

Third Row is All Geography.

At this point, you have modeled the following part of the scenario:

• For United States: The forecast for A linearly decreases by 25% on 31 March 2002 
from its value on 1 January 2002 and then by another 25% on 30 June 2002 from its 
decreased value on 31 March 2002. It reduces to zero on 31 December 2002 from the 
reduced value on 30 June 2002.

• For all geography except United States: The forecast for A remains unchanged for 1 
January 2002 to 31 March 2002, and then linearly decreases by 25% on 30 June 2002 
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from its value on 31 March 2002. It reduces to zero on 31 December 2002 from the 
reduced value on 30 June 2002.

Events can be associated to either demand plans or scenarios.

1. To associate events to demand plans, use the events tab on the demand plans form 
so that the events are available for all forecast scenarios.

To associate events to scenarios, follow the instructions in Procedure to define a 
Demand Plan, page 7-2. Stop after performing the first step in Scenarios, page 7-
32. 

At the end of that step, select Events to open the Scenario Events window.

2. Associate the three defined events; promotion (in steps 2 through step 7), new 
product introduction (in steps 8 through 17), and product phase out (in steps 18 
through 23) to a scenario and specify priority for each association as shown in the 
following table:

Field Value

Scenario Default value

Event Name Select the event name

Priority Enter the priority number
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Priority indicates the order in which the events are applied. Within the same 
priority, the events are applied in the order of their creation in the system and thus 
the event priority should always be specified. When the corresponding demand 
plan is used to generate the forecasts in the Demand Planning Engine, these events 
would be included in the event forecast.

Promotions

Mandatory and optional promotions
There are two types of promotions that can be defined (in step 1) in the Events section: 
mandatory and optional. 

Note: Throughout Promotions, all references to steps refer to the steps 
in Events.

Mandatory promotion means that it is applied regardless of whether another promotion
has been applied, while the optional promotion is applies when a mandatory promotion
for the same item has not been applied. In addition to this, a priority can also be 
specified to resolve any conflicts between the two promotions of the same type. 
However, this priority is overridden by the priority specified at the time of associating a
promotion to a scenario (in step 8). Two or more promotions can also be specified in one
window, in which case the priority or the promotion type is the same for both 
promotions. In this situation, the promotions are applied in the order they are defined.

For example, if two mandatory promotions are defined during the same time period, 
first one at all product level with 10% modification factor and second for item A with 
20% modification factor, these promotions would be applied successively. The result 
would be a lift of 10% for all products except for item A, which would have a 20% lift 
on top of the 10% lift.

Types of modifications
Multiple time periods with varying modifications can be defined for any promotion as 
shown (in steps 3 and 5).For each time period and quantity modification, one price 
modification type and value can be selected.

The quantity modification types are:

• Increase by percentage, decrease by percentage, increase by quantity, decrease by 
quantity, and absolute.

The price modification types are:

• Increase by percentage, decrease by percentage, increase by quantity, decrease by 
quantity, and absolute.
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Details of promotions
While all other events can be defined for a product, the promotions can also be specified
at other levels in the product dimension; product category and product family. For each
promotion, at least one detailed entry needs to be made under Details as shown (in 
steps 3 and 5). This includes the time period (for example, From Date and To Date), type
of modifications for quantity as well as price, and corresponding modification values. 
Various dimension levels and values can also be entered for each detail as indicated (in 
step 3). The values for the From Date and To Date (in steps 3 and 5) are defaulted from 
the Start Date and End Date on the main form (in step 1). The user can modify these 
values. 

New Product Introductions and Cannibalization

Life cycle and supersession based new product introductions
The information about the existing products is used for generating forecasts for new 
products, as there are no historical data to use as a starting point. The existing products 
used in the context of modeling a new product introduction are referred to as base 
products. Any new product introduction can be modeled in two distinct ways (in steps 
7 and 8). These are:

• Life Cycle: refers to situations when the new product is expected to follow the 
demand patterns of some existing products. The historical sales data of one or more
existing products during specified time periods is considered as the forecast for the 
new product with some specified time difference.

• Supersession: refers to the replacement of the existing product(s) by a new product. 
There are two methods for modeling supersessions depending on whether the new 
sales data (as the sales come in) of the new product should or should not be used 
for forecasting purposes until the new product is matured:

1. Based on individual histories of base products: The forecasts of existing 
products are created on the basis of their individual historical sales data, 
modified by specified percentages, and added by specified weights to create the
forecast of new product. 

2. Based on combined histories of new and base products: The historical sales data
of the existing products during the specified time periods is transferred to the 
new products and then the forecast for the new products is created on the basis 
of combined history of new and existing products. 

Types of modification
Multiple time periods with varying modifications can be defined for any new product 
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introduction (in step 10). There are no price modifications allowed for new product 
introduction events. The quantity modification types are: increase by percentage, and 
decrease by percentage.

Details of new product introductions
For each new product introduction event, at least one detailed entry needs to be made. 
This includes the time period, for example, From Date and To Date, type of 
modifications for quantity only, and corresponding modification values. The values for 
the From Date and To Date (in steps 10 and 11) are defaulted from the Start Date and 
End Date on the main form (in steps 7 and 8). The user can modify these values. Various
dimension levels and values can also be entered for each detail. If no qualifications are 
specified, the event applies to all levels.

Service part supersessions can be modeled using new products. The New Product 
Introduction events can be used to enable service part supersessions in Oracle Demand 
Planning. You use combined histories of new and superseded parts to create forecast for
the new parts. 

For example, you can have the supersession of part A by part B for two consecutive 
planning cycles. 

The forecast of the new part B is based on the combined history of part A and B. 
Assume that part B supersedes part A with effect from 1 Aug 03 as a service part of Itch 
equipment company. Part A is immediately phased out with no forecast for part A after
31 Jul 03. Also, assume that no Qty Modification Type/Value is specified.

For Planning Cycle 1, on 1 Aug 03

Original histories (before applying the event):

Service 
Part

Booking 
History

Booking 
History

Booking 
History

Forecast Forecast Forecast

  May 03 Jun 03 Jul 03 Aug 03 Sep 03 Oct 03

Electrode 
A

10 15 12      

Electrode B NA NA NA      

Logic in applying the event:
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Service 
Part

Booking 
History

Booking 
History

Booking 
History

Forecast Forecast Forecast

  May 03 Jun 03 Jul 03 Aug 03 Sep 03 Oct 03

Electrode 
A

10 15 12 0 0 0

Electrode B 10 15 12 16 13 17

Actual data and display after applying event:

Service 
Part

Booking 
History

Booking 
History

Booking 
History

Forecast Forecast Forecast

  May 03 Jun 03 Jul 03 Aug 03 Sep 03 Oct 03

Electrode 
A

10 15 12 0 0 0

Electrode B NA NA NA 16 13 17

For Planning Cycle 2, on 1 Sep 03

Original histories (before applying the event):

Service 
Part

Booking 
History

Booking 
History

Booking 
History

Forecast Forecast Forecast

  Jun 03 Jul 03 Aug 03 Sep 03 Oct 03 Nov 03

Electrode 
A

15 12 5      

Electrode B NA NA 10      

Logic in applying the event:
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Service 
Part

Booking 
History

Booking 
History

Booking 
History

Forecast Forecast Forecast

  Jun 03 Jul 03 Aug 03 Sep 03 Oct 03 Nov 03

Electrode 
A

15 12 5 0 0 0

Electrode B 15 12 15 12 16 13

Actual data and display after applying event:

Service 
Part

Booking 
History

Booking 
History

Booking 
History

Forecast Forecast Forecast

  Jun 03 Jul 03 Aug 03 Sep 03 Oct 03 Nov 03

Electrode 
A

15 12 5 0 0 0

Electrode B NA NA 10 12 16 13

You can automatically update the event on the basis of supersession item relationship, 
which is defined in Oracle Inventory and collected into Oracle Demand Planning 
during level values collection. The user can effect changes as necessary, including 
changing items and specifying dates or modifications.

From the Demand Planning System Administrator responsibility, select Events and 
Product Introductions > New Product Introductions and Cannibalization to open the 
New Product Introduction screen.
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Complete the New Product Introduction window. If the Start Date is not specified, then 
the New Product Introduction event will be applied from the horizon start date of the 
forecast measure to which the event is associated. If the End Date is not specified, then 
the New Product Introduction event will be applied until the horizon end date of the 
forecast measure to which the event is associated. 

For a supersession type New Product Introduction event, the Forecast Basis is enabled. 
The list of values are Combined histories of new and base products and Individual 
histories of base products. 

• Selecting Individual histories of base products enables supersession where the 
forecasts of base products are created on the basis of their individual histories, 
modified by specified percentages, and added by specified weights to create the 
forecast of new product. 

• Selecting Combined histories of new and base products is a new functionality 
allows the transfer of the history of base products to the new product. This means 
that the history during the historical dates of the base products is transferred to the 
new products, and the forecast for the new products is created for the New Product 
Introduction Start and End Dates on the basis of combined history of new and base 
products. 

For a supersession type New Product Introduction event, when you select the Update 
button, the update event (on the basis of supersession item relationship) is generated 
using supersede item relationships. The item relationships are defined in Oracle 
Inventory and collected into Oracle Demand Planning during level value collection.

Rerunning the Update event process will refresh the event on the basis of current status 
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(in other words, as of last collection of level values) of item relationships and the 
changes, if any, after the previous run will be lost.

For a supersession type New Product Introduction event, the Automatically update 
upon new level values collection checkbox is used to automatically update the event 
with new or changed item relationships when level values are collected afresh in the 
subsequent planning cycles. Checking this box makes all the columns non-editable for 
the event. This means that item relationships then only be changed in the source 
applications only. 

Details of base products
It is possible to use historical data of a base product for any region to model a new 
product that is being introduced only in a certain region.

Additional dimension information for any base product can be entered under the Base 
Product Details. For each base product, a different level can be selected for any of the 
six dimensions and two user-defined dimensions. If more than one base products are 
used, the relative weight, such as 30% of the forecast for base product A and 70% for B, 
for each base product can be specified. If no details are specified for the base products, 
all their available history/forecast for all dimensions is used as basis for the new 
product introduction.

Service part supersessions can be modeled using base products. Select Base Products 
button to open the Base Product window.

To complete the Base Products window, you can specify any percentage of Weights for 
base products. 

If the History Start Date field is left blank, the history start date to of the forecast 
measure to which the event is associated is used. For supersession type New Product 
Introduction events, this means that the history of the base products from the History 
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Start Date are used to create the forecast for the new product. 

If the History End Date field is left blank, the history end date of the forecast measure to
which the event is associated is used. The History End Date indicates that the history of 
the base products until the History End Date is used to create the forecast for the new 
product. Specifying the history end date allows you to use New Product Introduction 
event definition as the basis of history periods for the new product and ignore the 
forecast measure's history periods. This prevents reduction in the forecast of the new 
product when the base product is phased out or cannibalized. 

The base product's forecast will not considered the History Start and End dates and is 
created based on the history periods of the forecast measure to which the event is 
associated. 

Details of cannibalized products
Introduction of a new product may reduce sales cannibalization of some existing 
products (in steps 16 and 17). Any number of products for which the sales will be 
reduced due to the respective new product introduction can be selected under 
Cannibalized Products. Time period and quantity modification can be defined for each 
cannibalized product. 

Select Cannibalized Products button to open the Cannibalized Products window.

Complete the Cannibalized Products window. If the From Date column is not specified, 
cannibalization is applied from the horizon start date of the forecast measure to which 
the event is associated. The To Date column indicates the forecast end date and the 
cannibalization end date. Thus, the forecast for the cannibalized product is created only 
until this date and the forecast after this date will be zero. If To Date column is not 
specified, cannibalization is applied until the horizon end date of the forecast measure 
to which the event is associated. 

The Qty Modification Type column has two possible values: 
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• Decrease by Percentage: Creates the forecast based on product's own history and 
decreases the forecast by the percentage specified in Qty Modification Value field. 
Thus, the specified Qty Modification Value is applied as a percentage of the 
cannibalized product's forecast. 

• Decrease by Percentage of New Product: The specified Qty Modification Value is 
applied as a percentage of the new product's forecast.

For supersession type:

• Based on combined histories of new and base products: New products's pre-lift 
forecast is used.

• Based on individual histories of new and base products: New products's 
post-lift forecast is used.

Pre-lift and post-lift forecasts refer to a separate Qty Modification Value that might 
have been applied to the new product's forecast itself. Cannibalization before an 
uplift allows you to apportion a percentage of the combined forecast to a new 
product and the remaining to the base product.

To create base product's forecast based on event's history dates, cannibalization needs 
to be specified to drive the base product's demand by percentage of new product. To do
this, complete the Cannibalized Products window. 

Product Phase Outs

Linear and nonlinear phase outs
Sales promotion or a new product introduction may not only reduce the sale of another 
similar spatial product but may also lead to end-of-life phasing out of an existing 
product. Phasing out products is a conscious decision on the part of an organization. 
Product phase out can be linear or nonlinear. Nonlinear phase out essentially means 
phase out with multiple gradients and is achieved by defining multiple time periods 
with varying modification factors. This was shown in steps 3 and 4. If multiple time 
periods with varying modification factors are not defined, the forecast is linearly 
reduced to zero at the end of the specified phase out period. 

Types of modification 
Multiple time periods with varying modifications can be defined for any phase out (in 
steps 3 and 4). There is no price modification allowed for a new product introduction 
event. The quantity modification types are decrease by percentage and decrease by 
quantity. 
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Details of product phase outs
Defining product phase outs is similar to defining promotions and new product 
introductions and can be accomplished from Product Phase Out in the main navigator 
window. Additional information for the phase out is entered under Details as shown (in
steps 3, 4, and 6). This includes the time period type of modifications for quantity only, 
and corresponding modification values. The values for the From Date and To Date (in 
steps 3 and 4) are defaulted from the Start Date and End Date on the main form (in 
steps 17 and 2). The user can modify these values. If no details are entered, the forecast 
for the product from the start date will be linearly reduced to zero at the end date. 
Various dimension levels and values can also be entered for each time period and 
modification detail. If no qualifications are specified, the event applies to all levels. If 
there is no entry to completely phase out the product, a warning is given to the user 
suggesting the necessity to enter detail whereby Modification Type is set to decrease by 
percentage and Modification Value is set to 100. For example, in the scenario described 
in the earlier section, if the following details are entered (in steps 3 and 5):

• United State: 1 January 2002 to 31 March 2002 decrease by 25% 

• All geography: 31 March 2002 to 30 June 2002 decrease by 25%

Then, everything remains the same except that after 30 June 2002 the forecast 
flattens out; that is, its value remains unchanged until 31 December 2002.

No separate set up is required for events. However, some validations are performed by 
the system as under: 

• Date validation: the From Date and To Date values on the details form should be 
between the Start Date and End Date on the main form.

• Increase by Percentage: if this has been selected as the modification type, the value 
should be zero or greater.

• Decrease by Percentage: if this has been selected as the modification type, the value 
should be between zero and 100.

Events Calendar
Demand Planners and the Demand Plan Manager can view the details of the events 
impacting the forecast. For example, if three events affect the demand forecast of a 
product, the final forecast numbers show only the overall impact of the events. 
However, the demand planner needs to know the details of these three events that have
changed the overall forecast numbers. 

The Events Calendar addresses this need for better analysis of the forecast by 
presenting the events in the form of a simple calendar. For details about the events 
calendar, see: Using the Events Calendar, page 18-20. 



Events    6-25

Applying events at aggregate time levels
The events are specified at the day level. For example, a promotion with 10% volume 
lift is planned for Item-A during the period from 1-Jan-2002 to 17-Jan-2002. The results 
would be different when the same event is applied at the day level and at an aggregate 
level. 

Applying events at aggregate time levels means applying events to the forecast or any 
other data stream for which the lowest time level is higher than a day and the data are 
not even allocated to the data level. For details on how to specify lowest time levels for 
a demand plan, see: Lowest Time Levels for the demand plan, page 7-7. Since the 
events are independent of the demand plan definition, the dates cannot be restricted 
during the event definition process. To apply events at aggregate time levels, weighted 
average lift factors are used. The weighted average would be by the days in the 
aggregate bucket.

Example
The following sales forecast at the all geography, all sales channels, and all 
organizations levels is used as the baseline forecast:

  1/27/02 1/28/02 1/29/02 1/30/02 1/31/02 2/01/02 2/02/02

Item A 100 200 100 200 300 100 100

The daily forecast numbers are aggregated to a weekly forecast of 1100, assuming an 
additive aggregation for Item A. 

Assume that the Lowest Time Level as an aggregation bucket is selected as the Week for
a manufacturing calendar and Month for the Gregorian calendar.

In this case, the seven days of the week will be truncated to two days, 31 Jan 02 and 2 
Feb 02 so that the daily forecast numbers can be properly aggregated to the week of 
1/27/02 as well as to the months of January and February 2002. For details, see: Lowest 
Time Levels for the demand plan, page 7-7.

Assume that following promotion at the all geography, all sales channels, and all 
organizations levels is applicable for Item A during this week. The following events are 
independently applied on this forecast: 

Start Date End Date Modification type Modification factor

1/27/02 1/28/02 Increase by percent 10

1/29/02 2/02/02 Absolute 50



6-26    Oracle Demand Planning Implementation and User's Guide

The weighted average lift factors for the truncated day 31-Jan-02 are:

Percent lift = 2 * 10/5 = 4%

Absolute lift = 3 * 50 = 150

Forecast, 31 Jan 02= 900 * 0.04 + 150 +900 = 1086

The weighted average lift factors for the truncated day 02-Feb-02 are:

Percent lift = 0

Absolute lift = 2 * 50 = 100

Forecast, 02 Feb 02 = 200 + 100 = 300

The total weekly forecast will now become 1386. Had the promotion been applied to the
daily forecast numbers, the weekly forecast would have been:

(100 * 0.10 + 200 * 0.10 + 250 + 1100) = 1380
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7
Defining a Demand Plan

This chapter covers the following topics:

• About defining a Demand Plan

• Procedure to define a Demand Plan

• Input Parameters

• Scenarios

• Events

• Price lists

• Options

• Scope

• Validate plan

About defining a Demand Plan
A demand plan is a group of parameters that defines both the inputs and outputs of the 
demand planning process as well as the dimensional levels along which the demand 
analysis is to occur.

Though each Demand Plan is defined for an organization, it is global and is not owned 
by that organization.

You can associate up to four User Dimensions with a Demand Plan. The remaining 
Demand Planning Dimensions can be collapsed into other User Dimensions. Although 
you cannot view more than four User Dimensions at one time, this collapsing allows 
you to toggle between them. For details about defining user dimensions, see: Flexible 
Data Stream User Procedures, page 3-2.

There may be situations where different units of measure exist for items within the 
same product family. This makes it extremely difficult to determine what the forecast 
should be at an aggregate level when there is no common unit of measure. The Base 
UOM field provides a method to change the units for all items within a higher level of 
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aggregation to a common unit of measure as determined by the Demand Planning 
Administrator.

You can prioritize demands at the scenario level. Prioritizing demands at the scenario 
level allows you to push forecast scenarios with specified demand priorities to any 
downstream application that takes output of Oracle Demand Planning as input. 

Procedure to define a Demand Plan
Each tab in the Demand Plans window will be discussed.

Dimensions
This section describes the demand plan dimensions tab.

To define the demand plan dimensions and header level information:
1. Choose the Demand Planning System Administrator responsibility.

2. In the Navigator, select Demand Plans. 

3. If you have not previously indicated, then choose an organization to open the 
Demand Plans window.
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4. Use this window to define a Demand Plan. The bottom region of this form is used 
for collapsing the various demand planning dimensions to the user dimensions 
associated with this Demand Plan.

In this example, the name and description of the Demand Plan is BIG-PLAN1. The 
base unit of measure is each. The lowest time level is Manufacturing Week for the 
Manufacturing calendar type and Gregorian Month for the Gregorian calendar 
type. Five demand planning dimensions are being collapsed into four user 
dimensions: demand class and geography are being collapsed into the geography 
user dimension. Ship from location is assigned to the ship from location user 
dimension. Note that the other user dimensions, product and time, must always be 
included in a Demand Plan, and should not be collapsed with any other dimension.

Collapsing the Demand Class dimension into the Geography dimension allows you 
to toggle between the two dimensions. However, this setup will not allow you to 
analyze the data by the Demand Class and Geography dimensions simultaneously. 
To do that, you can collapse the Demand Class dimension to the Ship From 
Location dimension, instead of the Geography dimension. This will enable analysis 
simultaneously by the Demand Class and Geography dimensions or by the Ship 
From Location and Geography dimensions.

If you want to calculate dependent demand based on organization specific model 
bills in a demand plan, it is mandatory to have a Ship From Location dimension in 
the demand plan, and no other dimension should be collapsed with it.

Note: Events are downloaded with four user dimensions: 
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geography, product, time, and organization. Collapsed dimensions 
like demand class are downloaded as a hierarchy of one of the user 
dimensions (like geography). Although the event works with the 
collapsed dimension, the collapsed dimension name is not shown 
as the event qualification in the shared database.

5. Complete the fields in the Demand Plans window as follows:

Field Function Legal Values

Name Demand plan name VARCHAR2(30)

Description Detailed description for the 
demand plan 

VARCHAR2(240)
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Field Function Legal Values

Base UOM Base UOM is the unit of 
measure used for 
aggregating at higher levels 
above the item level in the 
product dimension.

The Base UOM field 
provides a method to 
change the units for all items
within a higher level of 
aggregation to a common 
unit of measure as 
determined by the Demand 
Planning Administrator.

This is a required field. The 
demand plan validation will
fail if the Base UOM is not 
defined. 

The list of values for this 
field will be empty if you 
have not defined any UOM 
conversion. If the list of 
values is empty, create a 
UOM Conversion for your 
primary UOM in the source 
instance and recollect the 
data.

For more details on UOM 
Conversion, see Multiple 
Step UOM Conversion.

VARCHAR2(3)

Status Shows the Demand Plan 
status. For details, see: 
Validate plan, page 7-45.

Invalid or valid
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Field Function Legal Values

Calculate Dependent 
Demand

If this is checked, it activates
dependent demand forecast 
explosion process for a 
demand plan. This is a plan 
level control. Also, this is 
used to enable global 
forecasting.

If this is not checked, then 
model bills of material, 
planning percentages, and 
dependent sales histories are
not used by the Oracle 
Demand Planning Engine 
for that demand plan. 

Checked or unchecked 
(default)

Explode Demand Using If you choose Organization 
Specific Bill of Material, the 
demand plan is created for 
an organization specific 
forecast, and Demand 
Planning uses the 
organization specific model 
bills.

If you choose Global Bills of 
Material, you enable global 
forecasting. In this case, 
Oracle Demand Planning 
uses generic model bills 
from the item validation 
organization to calculate 
dependent demand for all 
the organizations in the 
demand plan. Calculating 
dependent demand based 
on global model bills is 
optional. 

Organization Specific Bill of 
Material (Default Value) or 
Global Bills of Material 
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Field Function Legal Values

Lowest Time Levels:

Gregorian, Manufacturing, 
Fiscal, Composite

Shows the lowest level of 
time you want to track for 
the four available calendar 
types. 

For details, see: Lowest 
Time Levels for the demand 
plan, page 7-7.

Lookup Values:

Gregorian: Year, Quarter, 
Month, and Day.

Manufacturing: Period, 
Week, and Day.

Fiscal: Year, Quarter, Month,
and Day.

Composite: Year, Quarter, 
Month, Week, and Day.

Dimension (tabbed region) The Dimensions associated 
with this Demand Plan.

Lookup Values

User Dimension (tabbed 
region)

The collapsed Dimensions 
available for the Demand 
Plan.

Lookup Values

Lowest Time Levels for the demand plan
There are three types of seeded calendars available in Oracle Demand Planning: 
manufacturing, fiscal, and Gregorian. You can define your own Oracle Demand 
Planning specific custom calendar by using composite calendars. User defined 
composite calendars allow you to align weeks to months so that your manufacturing 
and fiscal reporting needs can be met by one calendar.

The Composite Calendar can be loaded in a time hierarchy via flat files. Loading the 
calendars means bringing the level values for the levels, such as Day, Manufacturing 
Week, Fiscal Month, Fiscal Quarter, and Fiscal Year, of time dimension.

The user can select one time bucket per calendar type for a demand plan as the lowest 
time level.

All the calendar types for which a lowest time level has been specified are used in 
Oracle Demand Planning . However, using more number of calendars in demand 
planning effects performance. 

Note: A demand plan's default time level is higher than a day.
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To select one time bucket per calendar type for a Demand Plan:
The List of values includes the time levels pertaining to the respective calendar type and
not used.

1. Logon to the Demand Planning System Administrator responsibility. 

2. In the Navigator, select Demand Plans. 

The Demand Plans window appears. 

3. Select the calendar type. For example, select Manufacturing Week for the 
Manufacturing calendar and select Fiscal Month for the Fiscal calendar. 

If you select day for any of the calendars, the lowest time level for all the other 
calendar types should also be day.

The Output Period Type, which is the bucket at which the Demand Planning 
Engine would upload the forecasts to the Demand Planning Server, for any demand
plan scenario cannot be lower than the lowest time level selected for the demand 
plan. The list of values for Output Period Type is restricted to the calendar types for
which the lowest time level has been selected. 

The demand planning input parameters are aggregated to the selected lowest time 
levels. 

For example, assume that the input parameter, Booking History is available at the Day 
level and you select manufacturing week and fiscal month to be the lowest levels in the 
demand plan:

The manufacturing calendar time hierarchy will be displayed in the Demand Planning 
Engine as: 

Manufacturing Week - Manufacturing Period - Year

The fiscal calendar time hierarchy will be displayed in the Demand Planning Engine as:

Fiscal Month - Fiscal Quarter - Fiscal Year

Booking History data will be displayed at the lowest time levels: Manufacturing Week 
of Manufacturing Calendar, and Fiscal Month of Fiscal Calendar and at all the higher 
levels in the time hierarchies.

When lowest time levels are higher than day and multiple time hierarchies (calendars) 
are included in a demand plan, it calls for a dynamic data translation. Only those days 
are made part of the time dimension, which are the end dates of an aggregate bucket 
period. Data at a time level that is lower than an aggregate bucket level is moved to the 
end date of the aggregate bucket level. This leads to a minimal number of days at the 
lowest level. The user does not see the day level. 

Data translation from one time hierarchy to another becomes a matter of aggregation 
and allocation. When only one calendar type is selected for a demand plan, all the data 
is translated to a single day. The leftover days will not be visible to the user and will be 
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programmatically hidden. 

Example 1
Assume that the following numbers are available in the Demand Planning Server. Also, 
assume the following levels: All products, All Geography, and All Organization. 
Booking History appears as:

Date Quantity Date Quantity Date Quantity

30-Dec 200 11-Jan 200 23-Jan 200

31-Dec 300 12-Jan 200 24-Jan 200

1-Jan 200 13-Jan 200 25-Jan 200

2-Jan 300 14-Jan 200 26-Jan 200

3-Jan 300 15-Jan 200 27-Jan 200

4-Jan 100 16-Jan 200 28-Jan 200

5-Jan 200 17-Jan 200 29-Jan 200

6-Jan 200 18-Jan 200 30-Jan 200

7-Jan 200 19-Jan 200 31-Jan 200

8-Jan 200 20-Jan 200 1-Feb 200

9-Jan 200 21-Jan 200 2-Feb 100

10-Jan 200 22-Jan 200    

Assume that the lowest time level is selected as Fiscal Month for the Fiscal calendar 
type and Manufacturing Week for the Manufacturing calendar type. Also assume the 
definitions of the lowest time levels are:

Manufacturing Weeks (Manufacturing 
Calendar)

Fiscal Month (Fiscal Calendar)

Week N-1 (30 Dec 01-5 Jan 02) Dec (1 Dec 01 - 31 Dec 01)

Week N (6-12 Jan 02) Jan (1 Jan 02 - 31 Jan 02)
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Manufacturing Weeks (Manufacturing 
Calendar)

Fiscal Month (Fiscal Calendar)

Week N+1 (13-19 Jan 02) Feb (1 Feb 02 - 28 Feb 02)

Week N+2 (20-26 Jan 02)  

Week N+3 (27 Jan-02 Feb 02)  

In this scenario, the following days will be left and all other days will be removed:

Days left in the system Quantity (assuming Sum aggregation 
method)

31 Dec 01 500

5 Jan 02 1100

12 Jan 02 1400

19 Jan 02 1400

26 Jan 02 1400

31 Jan 02 1000

02 Feb 02 300

The data will be displayed in monthly buckets of the fiscal calendar: 

Fiscal Months (Fiscal Calendar) Monthly Numbers

Dec 01 500

Jan 02 6300

Feb 02 300

The data will be displayed in weekly buckets of the manufacturing calendar: 
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Manufacturing Weeks (Manufacturing 
Calendar)

Weekly Numbers (adding daily quantities)

Week N-1 (30 Dec 01-5 Jan 02) 1600

Week N (6-12 Jan 02) 1400

Week N+1 (13-19 Jan 02) 1400

Week N+2 (20-26 Jan 02) 1400

Week N+3 (27 Jan-02 Feb 02) 1300

Example 2
Now assume that the Jan 02 number (6300) is changed by the planner to 12600. This 
change will be reflected as:

Days left in the system Quantity (assuming Sum aggregation 
method)

31 Dec 01 500

5 Jan 02 12600 * 1100/6300 = 2200

12 Jan 02 12600 * 1400/6300 = 2800

19 Jan 02 12600 * 1400/6300 = 2800

26 Jan 02 12600 * 1400/6300 = 2800

31 Jan 02 12600 * 1000/6300 = 2000

02 Feb 02 300

The data will be displayed as weekly buckets of the manufacturing calendar:

Manufacturing Weeks (Manufacturing 
Calendar)

Weekly Numbers (adding daily quantities)

Week N-1 (30 Dec 01-5 Jan 02) 2700
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Manufacturing Weeks (Manufacturing 
Calendar)

Weekly Numbers (adding daily quantities)

Week N (6-12 Jan 02) 2800

Week N+1 (13-19 Jan 02) 2800

Week N+2 (20-26 Jan 02) 2800

Week N+3 (27 Jan-02 Feb 02) 2300

The user may specify different aggregation and allocation methods for different data 
streams. The aggregation method will be respected when aggregating data to a higher 
time bucket.

Example 3
In the example above, if the aggregation method had been Average the data for the 
truncated days would have been:

Days left in the system Quantity (assuming Average aggregation 
method)

31 Dec 01 250

5 Jan 02 220

12 Jan 02 200

19 Jan 02 200

26 Jan 02 200

31 Jan 02 200

02 Feb 02 150

In the case of a chaotic data stream or when aggregation or allocation is not allowed, the
data will not be aggregated or allocated. The data from the plan level lowest time 
bucket upwards would be displayed. If all the data in a chaotic data stream are in 
buckets lower than the lowest time levels, this would result in the loss of all the data for 
that stream.
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Note: For two calendars that are of the same type, the lowest level 
would be shared. It is a requirement that the lowest level be identical 
for calendars of the same type.

Now, the next step is to associate hierarchies with each dimension in the demand plan. 
At least one hierarchy needs to be assigned for each of the dimensions. For example, for 
the Product dimension, you can choose the Product Family hierarchy or the Product 
Category hierarchy or both.

Hierarchies
This section describes demand plan hierarchies.

To define Demand Plan hierarchies:
1. Choose the Demand Plan System Administrator responsibility.

2. In the Navigator, choose Demand Plans. 

The Demand Plan window appears. 

3. Select DP Hierarchies to open the Demand Plan Hierarchies window.
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4. Select hierarchy names for the dimension. Use this window to associate hierarchies 
with a Demand Plan. You can select only the hierarchies that belong to the demand 
planning dimensions that are collapsed into the user dimensions for this Demand 
Plan.

In this example, hierarchy names are being associated with the geography user 
dimension for the Demand Plan.

5. Complete the fields in the Demand Plan Hierarchies window as follows:

Field Function Legal Values

Demand Plan Demand Plan Name. VARCHAR2(30).

User Dimension The User Dimension defined
from the Demand Planning 
Dimensions for the Demand 
Plan.

From selected dimension in 
the Oracle Demand 
Planning window.

Hierarchy Name Name of the Hierarchy. List of Values.
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Field Function Legal Values

Dimension Name Demand Planning 
Dimension associated with 
the Hierarchy Name.

Populated automatically.

The time hierarchies (calendar types) for the demand plan are restricted by the selection
of lowest time levels. Multiple calendars can be selected for each calendar type. The 
system validation ensures that the definition of the lowest time level is same for all the 
selected calendars of the same type. For example, if the lowest time level for the 
manufacturing calendar type is Manufacturing Week, two calendars for the San Jose 
Organization and the Seattle Organization are selected as time hierarchies, and week 1 
in San Jose Organization calendar is 1 Jan 02 to 7 Jan 02, then week 1 in Seattle 
Organization calendar should be from 1 Jan 02 to 7 Jan 02. 

In Oracle Demand Planning, every enabled organization can have its own calendar. You
can select to allocate data by workday patterns in the organization's calendar. You can 
use the Workday Allocation Weights data stream to store daily allocation weights based
on workday patterns of organizations. For details, see: Input Parameters, page 7-15 and
To collect Calendars associated to Organizations:, page 4-18.

Input Parameters
Input Parameters determine the data that will be imported into Demand Planning 
Engine for creating and analyzing forecasts. Multiple inputs can be specified and used 
in different scenarios. The following input parameters are preseeded data streams:

Input Parameter Description

Manufacturing forecast This data stream allows you to use the manufacturing forecast as a 
reference forecast for comparing to your statistical forecast. If a 
manufacturing forecast has been defined in the source in weekly 
buckets for a date range, the data is expanded to all the weeks in 
that date range by expanding the single row of data into multiple 
rows. 

This stream has its allocation set to Stream Dimension Levels. If you 
want to change the allocation floor to the lowest dimension level to 
allocate the data to a level lower than the data read-in levels, you 
should specify some other data stream as a basis for allocation.
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Input Parameter Description

Booking history - 
booked items

This data stream captures the sales history of items, which were 
actually booked (by substitution or directly). Cross-sell, up-sell, and 
substitution relationships between items can also be collected into 
demand planning. For details, see: Oracle Advanced Supply Chain 
Planning User's Guide.

Booking history This data stream allows planners to capture the actual historical 
demand of items that were originally requested by the customer, 
regardless of whether they were substituted with another end item. 

Shipment history - 
shipped items

This data stream captures the sales history of items, which were 
actually shipped. Cross-sell, up-sell, and substitution relationships 
between items can also be collected into demand planning. For 
details, see: Oracle Advanced Supply Chain Planning User's Guide.

Shipment history This data stream allows planners to capture the actual historical 
demand of items that were originally requested by the customer, 
regardless of whether they were substituted with another end item. 

Sales opportunities This data stream shows the sales opportunity data. For details, see: 
Using Sales Forecasts and Opportunities, page 26-15.
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Input Parameter Description

Constrained forecast In conjunction with supply plan, this data stream allow users to 
compare a unconstrained forecast to a constrained forecast. The 
constrained forecast represents a total picture of the satisfied 
demand, including sales orders that represent the portion of 
predicted demand that has already been realized, the consumed 
forecast that has been constrained, and the constrained estimate of 
shipments.

The demand forecasts generated in Oracle Demand Planning are 
unconstrained, meaning the capacity constraints are not considered. 
The unconstrained demand forecasts are sent to Oracle Advanced 
Supply Chain Planning from where the resulting supply plan, 
constrained by material and resource availability, are sent back to 
Oracle Demand Planning for comparison. The comparative analysis 
feature enables planners to plan promotions and allocate demand 
across multiple organizations. 

To use this parameter, Oracle Demand Planning users must have 
access to Oracle Advanced Supply Chain Planning because the 
constrained forecasts are created there. Also, this data stream has its 
allocation set to Stream Dimension Levels. If you want to change the
allocation floor to the lowest dimension level, you should specify 
some other data stream as a basis for allocation. For details, see: 
Oracle Advanced Planning and Scheduling Implementation and User's 
Guide.

Supply plan In conjunction with constrained forecast, this data stream allows 
users to compare a unconstrained forecast to a supply plan. The 
supply plan represents the planned production to be compared to 
the forecast or planned demand. For details, see the description of 
the Constrained Forecast data stream (above).

Sales forecast - best case This data stream provides a summary sales forecast. The best case 
sales forecast considers all the sales opportunities as 100% likely to 
close. For details, see: Oracle Sales Online User's Guide and Using 
Sales Forecasts and Opportunities, page 26-15.

Sales forecast - worst 
case

This data stream provides a summary sales forecast. The worst case 
sales forecast considers only the closed opportunities. For details, 
see: Oracle Sales Online User's Guide and Using Sales Forecasts and 
Opportunities, page 26-15.
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Input Parameter Description

Sales forecast - probable
case

This data stream provides a summary sales forecast. The probable 
case sales forecast is a weighted calculation based on the open 
opportunities and their win probability. For details, see: Oracle Sales 
Online User's Guide and Using Sales , page 26-15Forecasts and 
Opportunities.

Sales forecast - pipeline This data stream provides an aggregated total opportunity forecast 
using Sales Opportunity data collected into Oracle Demand 
Planning from Oracle Sales Online. The pipeline is the sum of all 
line items for an opportunity. For details, see: Oracle Sales Online 
User's Guide and Using Sales Forecasts and Opportunities, page 26-
15.

Sales forecast - weighted
pipeline

This data stream provides an aggregated opportunity forecast using 
Sales Opportunity data collected into Oracle Demand Planning from
Oracle Sales Online. The weighted pipeline is the sum of the line 
items multiplied by the win probabilities. For details, see: Oracle 
Sales Online User's Guide and Using Sales Forecasts and 
Opportunities, page 26-15.

Sales forecast from 
customers

This data stream enables collaborative demand planning. The 
customer's sales forecasts are brought into Oracle Demand Planning 
via Oracle Collaborative Planning. Then the sales forecasts are 
compared to the Oracle Demand Planning forecasts to arrive at the 
final forecasts calculations that are used in planning operations. For 
details, see: Oracle Collaborative Planning Online Help.

Order forecast from 
customers

This data stream enables collaborative demand planning. The 
customer's order forecasts are brought into Oracle Demand 
Planning via Oracle Collaborative Planning. Then the order forecasts
are compared to the Oracle Demand Planning forecasts to arrive at 
the final forecasts calculations that are used in planning operations. 
For details, see: Oracle Collaborative Planning Online Help.

Input scenarios This data stream allows you to use the previous period forecasts 
from the same or different demand plan. It has its allocation set to 
Stream Dimension Levels. If you want to change the allocation floor 
to the lowest dimension level to allocate the data to levels lower 
than the data read-in levels, you should specify some other data 
stream as a basis for allocation.
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Input Parameter Description

Workday Allocation 
Weights

This data stream is used to specify different daily allocation weights 
for different organizations based on their workday patterns. The 
appropriate allocation weights are automatically populated in this 
data stream on the basis of the manufacturing calendars associated 
to the different organizations enabled in Oracle Demand Planning. 
For details, see: Lowest Time Levels for the demand plan, page 7-7.

Order Backlog This data stream brings in backlog sales order amount and quantity 
data at the various dimension levels. The orders can be collected in 
an additive manner from Oracle Order Management. For details, 
see: To collect Order Backlog data:, page 4-5.

Material Requirements -
Planned Maintenance

This data stream collects the material demand for routine 
maintenance from a unit maintenance plan in Oracle Complex 
Maintenance, Repair, and Overhaul. For details, see: To collect 
Material Requirements for Planned Maintenance:, page 4-27.

Material Requirements -
Scheduled Visits

This data stream provides information on materials needed for a 
scheduled maintenance visit. For details, see: To collect Material 
Requirements for Scheduled Visits:, page 4-26.

Material Usage History 
- Planned Maintenance

This data stream collects historical material consumption associated 
with routine maintenance, and is used as a reference for 
comparisons. For details, see: To collect Material Usage History for 
Planned Maintenance:, page 4-27.

Material Usage History 
- Unplanned 
Maintenance

This data stream collects historical consumption of unplanned 
material associated with non-routine maintenance, and is used to 
forecast the material requirements for future non-routine 
maintenance. For details, see: To collect Material Usage History for 
Unplanned Maintenance:, page 4-25.

Service Parts - Return 
History

This data stream collects return history of defective service parts 
from Oracle Field Service. For details, see: To collect Service Parts 
Returns History:, page 4-32.

Service Parts - Usage 
History

This data stream collects the consumption history of service parts 
from Oracle Field Service and Oracle Depot Repair. For details, see: 
To collect Service Parts Usage History:, page 4-28.

Return History This data stream collects product returns (return material 
authorizations) from Oracle Order Management. For details, see: To 
collect Return History:, page 4-33.
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Input Parameter Description

Promotional History This data stream collects the promotional sales history from Oracle 
Order Management. This allows you to separately identify and net 
the incremental promotional sales from the regular sales to get the 
baseline sales history, which is then used as a basis to create a 
baseline statistical forecast. The incremental sales forecast due to 
planned promotions is added to the baseline forecast to arrive at the 
total sales forecast. The estimation of future promotional sales is 
purely judgmental.

Promotions are set up as modifiers in Oracle Advanced Pricing. For 
details, see: the Oracle Advanced Pricing User's Guide. There are 
several types of modifiers in Oracle Advanced Pricing. Oracle 
Demand Planning brings promotional history pertaining to only the 
following modifier types:

• Discounts, such as 10% off the list price

• Price Break Headers, such as 5% discount on orders of more 
than 50 tons

• Promotional Goods, such as buy 20 of A and get 2 of B free

Oracle Demand Planning does not collect the promotions 
themselves. 

These modifiers can be applied to the sales orders as well as to the 
order lines. For details, see: the Oracle Order Management User's 
Guide. Promotional History constitutes the entire quantity of any 
sales order line for which any of the above modifiers have been 
applied.

Historical Sales from 
Customers

This data stream collects customers' historical sales data from Oracle
Collaborative Planning. At the outset of implementing a VMI 
program with your customers, and periodically thereafter, you may 
be able to receive customer sales history and use it to create the 
customer's sales forecast. This sales forecast can be published back 
to Oracle Collaborative Planning. Within Oracle Demand Planning, 
this sales forecast serves as one of the inputs to the consensus 
forecasting process.

The data is collected by ship date. The customers' sale history must 
be pre-adjusted by the customer by the replenishment lead-time. 
Oracle Demand Planning and Oracle Collaborative Planning do not 
offset the ship dates to reflect the time it takes for you to ship the 
material to the customer site.

Note that multiple dates are collected for some data streams. Specifically, Booking 
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history and Booking history - booked items collect booked, promised, request, 
scheduled arrival, and scheduled ship date. Shipment history and Shipment history - 
shipped items collect booked, promised, request, scheduled arrival, scheduled ship 
date, and shipped date. Constrained forecast collects arrival and ship date. Order 
forecast from customers collects receipt and ship date. Order backlog collects booked, 
request, scheduled arrival, and scheduled ship date. Material usage history - planned 
maintenance and Material usage history - unplanned maintenance collect request and 
schedule date. You can select which of these dates to collect in the Demand Plan Input 
Parameters tab under the Forecast by field.

In addition, users can define any custom data stream and use it as an input parameter. 
If you want to specify demand priority for your scenarios, the demand priority 
information is defined in a custom stream, and needs to be listed as an input parameter.
For details, see: About Flexible Data Streams, page 3-1.

The following table specifies the dimension levels at which the data is read-in for each 
seeded data stream. Some dimension levels in some of the data streams are kept flexible
in which case the data can be read-in at any one dimension level.

To view this information, go to Setup > Data Streams > Defined - Advanced > Define 
Dimension and Levels window.

Seeded Data Stream Dimension Level

Manufacturing forecast Geography

Product

Sales Channel

Ship from Location

Time

Ship To Location

Item

Sales Channel

Organization

Flexible

Booking history - booked 
items

Geography

Product

Sales Channel

Sales Representative 

Ship from Location

Time

Ship To Location

Item

Sales Channel

Sales Rep

Organization

Day
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Seeded Data Stream Dimension Level

Booking history - requested 
items

Geography

Product

Sales Channel

Sales Representative

Ship from Location

Time

Ship To Location

Item

Sales Channel

Sales Rep

Organization

Day

Shipment history - shipped 
items

Geography

Product

Sales Channel

Sales Representative

Ship from Location

Time

Ship To Location

Item

Sales Channel

Sales Rep

Organization

Day

Shipment history - requested 
items

Geography

Product

Sales Channel

Sales Representative

Ship from Location

Time

Ship To Location

Item

Sales Channel

Sales Rep

Organization

Day

Sales opportunities Geography

Product

Sales Channel

Sales Representative

Ship from Location

Time

Ship To Location

Item

Sales Channel

Sales Rep

Organization

Day
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Seeded Data Stream Dimension Level

Constrained forecast Geography

Product

Ship from Location 

Time

Customer

Item

Organization

Day

Supply plan Geography

Product

Ship from Location 

Time

All Geography

Item

Organization

Day

Sales forecast - best case Geography

Product

Sales Channel

Sales Representative 

Ship from Location

Time

Flexible

Flexible

All Sales Channel

All Sales Rep

All Organization

Flexible

Sales forecast - worst case Geography

Product

Sales Channel

Sales Representative 

Ship from Location

Time

Flexible

Flexible

All Sales Channel

All Sales Rep

All Organization

Flexible

Sales forecast - probable case Geography

Product

Sales Channel

Sales Representative 

Ship from Location

Time

Flexible

Flexible

All Sales Channel

All Sales Rep

All Organization

Flexible
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Seeded Data Stream Dimension Level

Sales forecast - pipeline Geography

Product

Sales Channel

Sales Representative 

Ship from Location

Time

Flexible

Flexible

All Sales Channel

All Sales Rep

All Organization

Flexible

Sales forecast - weighted 
pipeline

Geography

Product

Sales Channel

Sales Representative 

Ship from Location

Time

Flexible

Flexible

All Sales Channel

All Sales Rep

All Organization

Flexible

Customer sales forecast Geography

Product

Ship from Location 

Time

Ship To

Item

Organization

Day

Customer order forecast Geography

Product

Ship from Location 

Time

Ship To

Item

Organization

Day

Input scenarios Geography

Product

Sales Channel

Sales Representative 

Ship from Location

Time

Scenario output level

Scenario output level

Scenario output level

Scenario output level

Scenario output level

Scenario output level
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Seeded Data Stream Dimension Level

Workday Allocation Weights Ship from Location

Time

Organization

Day

Order Backlog Geography

Product

Sales Channel

Sales Representative 

Ship from Location

Time

Ship To Location

Item

Sales Channel

Sales Rep

Organization

Day

Material Requirements - 
Planned Maintenance

Product

Ship from Location

Time

Item

All Organizations

Day

Material Requirements - 
Scheduled Visits

Product

Ship from Location

Time

Item

Organization

Day

Material Usage History - 
Planned Maintenance

Product

Ship from Location

Time

Item

Organization

Day

Material Usage History - 
Unplanned Maintenance

Product

Ship from Location

Time

Item

Organization

Day

Service Parts - Return History Product

Ship from Location

Time

Geography

Item

Flexible

Flexible

Flexible: customer, zone, or all
geographies.



7-26    Oracle Demand Planning Implementation and User's Guide

Seeded Data Stream Dimension Level

Service Parts - Usage History Product

Ship from Location

Time

Geography

Item

Flexible

Flexible

Flexible: customer, zone, or all
geographies.

Return History Product

Sales Channel

Sales Representative 

Ship from Location

Time

Item

Sales Channel

Sales Rep

Organization

Day

Promotional History Demand Class

Geography

Product

Sales Channel

Sales Representative

Ship from Location

Time

Demand Class

Ship To Location

Item

Sales Channel

Sales Rep

Organization

Day

Historical Sales from 
Customers

Geography

Product

Ship from Location

Time

Ship To Location Level

Item Level

Organization Level

Day

To define Input Parameters:
1. Choose the Demand Planning System Administrator responsibility.

2. In the Navigator, choose Demand Plans. 

The Demand Plans window appears. 

3. In the Demand Plans window, select the Input Parameters tab to open the Input 
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Parameters window.

In the Input Parameters window you can specify a historical or future date range 
depending on the type of input parameter that needs to be uploaded into Demand 
Planning Engine.

4. Complete the fields in the Input Parameters window as follows:

Field Function Legal Values

Type Type of Input Parameter. List of Values show all the 
preseeded and custom data 
streams.

Name Name of the input 
parameter. For example, 
forecast name for the input 
manufacturing forecast, or 
the forecast name for the 
input scenario.

VARCHAR2(240).
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Field Function Legal Values

Forecast by If there are multiple dates in
the input parameter, select 
which one should be used. 
Specifically, the Booking 
history, Booking history - 
booked items, Shipment 
history, Shipment history - 
shipped items, Constrained 
forecast, Order forecast, 
Order backlog, Material 
usage history - planned 
maintenance, Material usage
history - unplanned 
maintenance input 
parameters collect multiple 
dates.

Different types of dates 
available for different input 
parameters. Types include: 
booked, promised, request, 
scheduled arrival, scheduled
ship, shipped, receipt, ship, 
and schedule date. 

Using arrival date gives you 
the ability to: view, analyze, 
and forecast data based on 
the scheduled arrival date. It
incorporates delivery 
performance in the planning
process. Also, it allows for 
the consumption of the 
forecast and plan supplies 
by scheduled arrival date in 
Oracle Advanced Supply 
Chain Planning.

Start Date Start Date for the Input 
Parameter.

DATE

End Date End Date for the Input 
Parameter.

DATE

Input Demand Plan Name Applicable for input 
scenarios only when a 
forecast from some other 
demand plan is fed to this 
demand plan.

The value that appears is 
based on what you select for
the parameter name.

Input Scenario Name Applicable for input 
scenarios only when a 
forecast based on some 
other scenario is fed to this 
demand plan.

The value that appears is 
based on what you select for
the parameter name.
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Field Function Legal Values

Quantity Used If there are multiple 
quantities in the input 
parameter, select which one 
should be used. This is 
especially relevant for the 
input manufacturing 
forecast. 

The list of values for the 
input manufacturing 
forecast are: 1. Original 
Quantity and 2. Current 
Quantity.

Amount Used If there are multiple 
amounts in the input 
parameter, select which one 
should be used.

If an input parameter has 
several amounts, all the 
values show up in the list of 
values. No seeded data 
stream has multiple 
amounts.

Forecast Used This is specific only to the 
Input Scenario Name. This 
field is not used any more, 
and all the forecasts are 
treated as an Overridden 
forecast.

Lookup Values: 1 = 
Overridden Forecast and 2 =
Baseline Forecast.

View Name This is an optional field for 
all the Input Parameters you
can use to write your own 
view to filter and group the 
fact data so that only the 
relevant information is 
uploaded into the Demand 
Planning Engine. However, 
the View Name that you 
enter must have view 
structure similar to 
MSD_CS_DATA_V column. 
For details about the list of 
columns for 
MSD_CS_DATA_V, see: 
Control file, page 3-26.

VARCHAR2(30). For 
custom fact views, the 
format should be similar to 
CS_DATA_V.
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Field Function Legal Values

Allocation / Aggregation 
Stream Type, Name, and 
Period

These three fields are used 
to specify some other data 
stream as a basis of 
aggregation or allocation of 
data for the input 
parameter. Period is 
applicable for Average 
Weights allocation function.

If the input parameter has 
been so specified as to base 
the allocation and 
aggregation values on 
another data stream, all the 
data streams show up in the 
list of values. For details, 
see: About Flexible Data 
Streams, page 3-1.
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Field Function Legal Values

Exclude from Rolling Cycle Differentiates static from 
dynamic input parameters. 
Dynamic input parameters 
refer to those data streams, 
which roll forward every 
cycle. Static input 
parameters refer to those 
data streams, which do not 
change from one cycle to 
another in a prespecified 
manner.

If checked, the demand plan
dates are not rolled forward 
for the corresponding input 
parameter and scenario 
based on the selected input 
parameter.

If not checked and the "Roll 
demand plan dates forward 
to the next cycle" concurrent
program is run, the 
following happens:

• Start and End date for 
input parameters are 
rolled forward by the 
specified number of 
periods.

• History and horizon 
dates for the 
corresponding 
scenarios are rolled 
forward by the 
specified number of 
periods.

The demand plan and 
scenario names are retained,
and only the forecast name 
(input scenarios is switched)
is changed to the latest 
forecast version. For details, 
see: Automating the 

Checked or unchecked 
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Field Function Legal Values

Planning Cycle, page 8-14.

5. Save the demand plan.

Scenarios
Scenarios represent forecasts with a set of forecasting assumptions, such as 5% 
economic growth, a certain set of new product introductions, or the implementation of a
promotion campaign. A Demand Plan can contain multiple scenarios for what-if 
simulations. 

The output level of the scenario should reflect the level of detail required by the 
customer of your forecast.

To define Demand Plan scenarios:
1. Choose the Demand Plan System Administrator responsibility.

2. In the Navigator, choose Demand Plans. 

The Demand Plans window appears. 

3. In the Demand Plans window, select the Scenarios tab to open the Demand Plan 
Scenarios window.
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4. Use this window to define scenarios for a Demand Plan. Specify the following:

• A scenario name,

• The time level at which the forecast needs to be published back from Demand 
Planning Engine to the Planning Server,

• The forecast horizon that is the time frame in which the forecast for this 
scenario needs to be generated,

• Information about the type of history to be used for generating the forecast, and

• The type of accuracy measure to be published with the forecast for this scenario
from the Demand Planning Engine to the Demand Planning Server.

5. Complete the fields in the Scenarios window as follows:

Field Function Legal Values

Name Scenario Name. VARCHAR2(30).

Description Detailed description for the 
Scenario.

VARCHAR2(240).
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Field Function Legal Values

Forecast Based On The input parameter used to
generate the forecast for this 
Scenario.

All the input parameters 
that have been defined 
earlier show up as list of 
values.

Forecast Period Type This is the date used to 
generate the forecast for this 
Scenario.

View only. This shows the 
date type selected for the 
input parameter selected in 
the Forecast Based On field.

Output Period Type The time at which the 
Scenario will be published 
back from the planning 
engine to the server.

This type should be the 
same as or higher than the 
lowest time level selected. 

Also, if the Publish box is 
checked, then you must 
choose Day or a 
manufacturing calendar 
bucket in output period. If 
you want to choose Fiscal 
Month or Gregorian Month 
as the output type, then you 
should first uncheck the 
Publish box.

Lookup Values, depending 
on the demand plan 
calendars and the lowest 
time levels.

History Start Date The Start Date of the 
historical data used for 
forecasting.

DATE.

History End Date The End Date of the 
historical data used for 
forecasting.

DATE.

Horizon Start The Start Date for the 
forecast for this Scenario.

DATE.

Horizon End The End Date for the 
forecast for this Scenario.

DATE.
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Field Function Legal Values

Price List Any one price list can be 
selected for a scenario. You 
can simulate future revenue 
on the basis of different 
price lists.

All the price lists that were 
brought into Oracle 
Demand Planning appear in 
the list of values.

Accuracy Measure Choose between two 
calculations of forecast 
accuracy. The calculations 
are displayed at the level 
where the forecast is 
generated in the Demand 
Planning Engine. 

Lookup Values: MAD = 
mean absolute deviation, 
MAPE = mean absolute 
percentage error, and none. 

Demand Priority Scenario If you use any downstream 
applications that use Oracle 
Demand Planning output 
for planning purposes, 
specify the demand priority 
you want associated with 
this scenario.

A custom stream must be set
up with the demand 
priorities you want to use. 
After the custom stream is 
loaded and defined as the 
Demand Priority stream, 
you add the Demand 
Priority stream as an input 
parameter. You can specify 
demand priorities for item, 
demand class (optional) and
time buckets. 

See About Flexible Data 
Streams, page 3-1 for more 
information about creating 
custom streams. 

See Input Parameters, page 
7-15 for more information 
about adding the Demand 
Priority stream as an input 
parameter.

Consume in Supply Plan Select if the forecast should 
be consumed in Oracle 
Advanced Supply Chain 
Planning.

Unchecked or checked 
(default). 
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Field Function Legal Values

Publish If checked, this option 
indicates that the scenario 
will be published back from 
the Oracle Demand 
Planning Server to the 
e-Business source instance.

Unchecked or checked 
(default). The demand plan 
is accordingly validated 
later.

Enable If checked, this option 
indicates that the scenario 
will be visible to Demand 
Planning Engine.

Unchecked or checked 
(default). This must be 
checked to see the forecast 
for this scenario in the 
Demand Planning Engine.

6. Open the Scenario Events window by selecting Events from the Demand Plan 
Scenario window.

7. Complete the fields in the Scenario Events window as follows:
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Field Function Legal Values

Scenario Scenario Name Lookup Values. This 
changes depending on what 
you selected in the Demand 
Plan Scenarios window.

Event Name Demand Planning Event Lookup Values.

Priority User assigned. It determines
the order in which the 
events are applied.

Number

8. Open the Scenario Output Levels window by selecting Output Levels from the 
Demand Plan Scenario window.

Use this window to define the various levels in the Demand Planning Dimensions 
at which the forecast for this scenario is to be published from Demand Planning 
Engine to the Planning Server, except for the time dimension.

If you want to consume your forecast by demand class in Oracle Advanced Supply 
Chain Planning, you must select Demand Class as a scenario output level for that 
scenario.
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9. In this example, Level Demand Class in the Demand Class Dimension, Level Ship 
To Location in the Geography Dimension, Level Organization in the Ship from 
Location Dimension, and Level Item in the Product Dimension will be the level of 
detail published back to the Planning Server for this scenario.

10. Complete the fields in the Scenario Output Levels window as follows:

Field Function Legal Values

Scenario Scenario Name Lookup Values. This 
changes depending on what 
you selected in the Demand 
Plan Scenarios window.

Dimension Demand Planning 
Dimension

Lookup Values.
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Field Function Legal Values

Level The Level associated to the 
Demand Planning 
Dimension at which the 
Scenario will be published 
back from the Planning 
Engine to the Server.

Lookup Values.

A scenario will be available to Oracle Advanced Supply Chain Planning only if Output 
Levels are as follows:

Dimension Mandatory Dimension Levels

Time Yes Day, Manufacturing Week, or
Manufacturing Period

Product Yes Item or Product Family

Ship From Location Yes, for Organization - for 
specific forecasts

Organization

  No, for Global Forecasts Organization or All 
organization, if included in 
demand plan

Geography No Ship To Location, Customer, 
Customer Zone, Zone, or All 
Geography

Events
Events, such as promotions, new product introductions, and product phase outs can be 
defined in the Demand Planning Server. For details, see: About Events, page 6-1. The 
events so defined can be associated with a demand plan in two ways:

• From Events in the Demand Plan window, Scenarios tab. The events associated in 
this manner are applied to the forecast of the corresponding scenario. For details, 
see: Events, page 7-40. 

• From the Events tab on the Demand Plan Window. The events so associated to a 
demand plan are not applicable for a specific forecast scenario but appear as 
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independent entities in Demand Planning Engine. A Demand Planning 
Administrator, Demand Planner, or Demand Plan Manager working in the Demand
Planning Engine may later apply one or more of these events to any measure.

To associate events with Demand Plans:
1. Choose the Demand Plan System Administrator responsibility.

2. In the Navigator, select Demand Plans. 

The Demand Plans window appears. 

3. In the Demand Plans window, select the Events tab to open the Events window.

4. Select any number of events.

Price lists
Price lists are defined in the source instance and are brought over to the Demand 
Planning Server using the collection programs that are provided in Oracle Demand 
Planning. These price lists can be associated to a demand plan in two ways:

• In the Price List field from the Scenarios tab by selecting from a list of the available 
price lists. The price list so associated is applied to the forecast of the corresponding
scenario.
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• From the Price Lists tab on the Demand Plan Window. The price lists so associated 
to a demand plan are not applicable for a specific forecast scenario but appear as 
independent entities in Demand Planning Engine. The Demand Planning 
Administrator on the Demand Planning Engine side may later apply any one of 
these price lists to any forecast.

To associate price lists with a Demand Plan:
1. Choose the Demand Plan System Administrator responsibility.

2. In the Navigator, select Demand Plans. 

The Demand Plans window appears. 

3. In the Demand Plans window, choose the Price Lists tab to open the Price lists 
window.

Note: It is mandatory to specify the Price List Name while defining 
a demand plan. You can use wildcard characters to find the Price 
List Name. 

4. Select any number of price lists.
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Options
Both quantity and amount forecast data can be uploaded from Oracle Demand Planning
to the planning server for use by other Oracle applications. Oracle Demand Planning 
provides a threshold rounding value that can be defined in the demand plan definition 
form Options tab. The Demand Planning Engine does not writeback any forecast values
that fall below the threshold rounding value.

You also specify the number of decimal places that you want the data to be rounded off 
to during the upload process. 

Your specifications serve as the default display formatting settings in the Demand 
Planning Engine. By default, the system sets the threshold value to be 0.5 and the 
decimal round off factor to be 6 decimal places. 

Oracle Demand Planing also provides the ability to accurately round fractional 
quantities to whole units. The fractional quantities, which are non-integer forecast 
numbers, are rounded by cumulating the fractional part of the demand across time 
buckets to one.

This helps in preventing under-forecasting and over-forecasting for: critical but slow 
moving service parts, low volume high cost products, and products with large units of 
measure.

After carefully considering the impact on the overall demand, you can use the rounding
rule to cumulate fractions within a level in the product dimension, such as item, 
product family, and all products: 

• Item level: fractions for an item are not carried over to other items. Thus, the 
forecast for an item may theoretically increase by 1 and if there are 5000 SKUs, the 
overall demand may theoretically increase by 5000.

• Product family level: fractions are adjusted across the member items of a product 
family and thus some demand (less than 1) may be stolen from one family member 
item to another. However, the forecast at the product family level will not increase 
by more than 1. If there are 50 product families for 5000 family members, the overall
demand may theoretically increase by 50. Units of measure are not considered for 
rounding across items and it is assumed that all the family member items have the 
same unit of measure.

• All products level: fractions are adjusted across all the items and thus some demand
(less than 1) may be stolen from one item to another regardless of their units of 
measure. Though the overall forecast will not change, this may lead to moving the 
demand of 0.5 tons as 0.5 kilograms.

For details, see:Editing Measures, page 17-61 about display formatting and Creating 
Formula Measures, page 17-57 for how to specify rounding rules for measures.
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To specify Rounding Control parameters:
1. Choose the Demand Plan System Administrator responsibility.

2. In the Navigator, choose Demand Plans. 

The Demand Plans window appears. 

3. In the Demand Plans window, select the Options tab to open the Options window.

4. Complete the following in the Output Precision section:

• From Apply the threshold to drop-down, select Quantity or Amount.

• In Do not publish numbers below the threshold field, enter the threshold value.

• Enter the decimal places value in the Quantity and/or Amount fields of the 
Number of decimal places to round outputs to.

5. Complete the following in the Rounding Rule section:

• In the Cumulate fractional quantities within a product dimension level field, 
select the product dimension level within which the fractional quantities will be
cumulated for rounding rule for the demand plan. The drop-down list of values
varies depending on the product hierarchies included in the demand plan. 

The demand plan level rounding level is applied to all the forecast scenarios 
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and to the selected input parameters.

To select input parameters to round:
1. In the Demand Plans window, select the Input Parameters Tab.

2. On the desired input parameters, check the Apply Rounding Rule box. 

The demand plan level rounding rule is applied to those input parameters for 
which the Apply Rounding Rule box is checked and by default to all the forecast 
scenarios specified under Scenarios tab.

Scope
You can specify the scope of a demand plan by restricting by the line of business. The 
demand plan is scoped by a level value in the ship from location dimension or product 
dimension. The levels and level values that available for selection are independent of 
the product or organization dimensions/hierarchies included in the demand plan.

You can also specify the scope of a demand plan by restricting to items based on the 
data stream. The demand plan is scoped by items in a data stream. The data streams 
that are available for selection are not limited to those which are included as demand 
plan input parameters.

For details about lines of business specific demand plans, see: Line of Business Specific 
Demand Plans, page 26-28.

To specify demand scope:
1. Choose the Demand Plan System Administrator responsibility.

2. In the Navigator, choose Demand Plans. 

The Demand Plans window appears. 

3. In the Demand Plans window, select the Scope tab to open the Scope window. 
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For more information about limiting the scope of a demand plan, see Line of 
Business-Specific Demand Plans, page 26-28.

Validate plan
You must validate a Demand Plan to ensure that it has been correctly defined. The plan 
validation process looks at the Dimensions, Hierarchies, Output levels, and other 
information that you have specified for the Demand Plan. Of special interest is the 
validation for the output levels, which are the levels at which the forecasts are uploaded
to the Demand Planning Server from Demand Planning Engine. If the Publishable check
box has been checked (inferring that the forecasts will ultimately be published back to 
the source instance) on the Input Parameters tab in the Demand Plans window, the 
validation process ensures the output levels to be:

• Day for the Time Dimension, if Gregorian or Fiscal Calendars are used in Oracle 
Demand Planning. This restriction does not apply to the Manufacturing Calendar, 
for which all the levels are allowed.

• Organization for the Ship From Location Dimension.

• Product or Product Family for the Product Dimension.

However, if the Publishable check box is not checked, the validation process only 
ensures that the output levels have been defined for all the Demand Plan Dimensions. It
is suggested to revalidate the demand plans after collecting fresh data.
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To validate a Demand Plan:
1. Choose the Demand Plan System Administrator responsibility.

2. In the Navigator, select Demand Plans. 

The Demand Plans window appears. 

3. In the Demand Plans window, select Validate Plan. 

A concurrent request is submitted. 

The concurrent request outcome can be checked as described in About Data Validation, 
page 5-1.
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8
Demand Planning Administration

This chapter covers the following topics:

• Building a New Demand Plan

• About the Stages in the Planning Cycle

• Downloading Data from the Planning Server (Stage 1) 

• Populating Measures (Stage 2)

• After you populate measures

• Distributing to Planners (Stage 3)

• Collecting Data from Planners (Stage 4)

• Uploading Measures to the Planning Server (Stage 5)

• Automating the Planning Cycle

• Viewing the Batch Log

• Administering OLAP Sessions

• Publishing Forecast Data Back to the Source

• Using Forecast Data for Advanced Planning

• Renewing the Forecasting Cycle

• Archiving and Restoring Demand Plans

Building a New Demand Plan
Once a demand plan has been defined in the Demand Planning Server, you build the 
demand plan in the Demand Planning Engine. 

Building a new demand plan means: 

• The Demand Planning Analytical Workspaces are created. 
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• Data for dimensions and measures specified in the Planning Server is downloaded 
from the Demand Planning Server database to the shared database. 

To build a new demand plan:
1. Log into Oracle Demand Planning.

2. Select the Demand Planning System Administrator responsibility.

3. In the Navigator, select Demand Plan Administration. A list of demand plans along 
with their description and build status appears. Build status could be 'Not built' or 
'In-progress/Built' indicating if the demand plan has already been built.

4. Select the demand plan that you want to work with. If this is new demand plan 
(where the build status is 'Not built'), you will be asked if you want to build this 
demand plan. Select Yes. 

5. Result: The Demand Planning databases are built and a download of data from the 
Demand Planning Server to these databases is initiated. A message appears on the 
screen to inform you that the download is taking place. 

You will receive a notification when the download is complete. When you next 
access the Demand Planning Administrator page, the status for Download Data 
from Planning Server will be set to COMPLETE.

About the Stages in the Planning Cycle
Once a demand plan has been built, you use Demand Plan Administration to run the 
following stages in the planning cycle:

• Download Data from Planning Server (Stage 1): For an existing demand plan, 
downloads data from the Demand Planning Server to the shared database. You can 
run a full download or a quick download. 

• Populate Measures (Stage 2): Calculates measures in the shared database. 

• Distribute to Planners (Stage 3): Distributes data in the shared database to 
authorized individuals who log in with the Demand Planner responsibility. You can
distribute all data or a subset of data.

• Collect Data from Planners (Stage 4): Collects and consolidates the forecasts that 
planners have submitted to the shared database.

• Upload Measures to Planning Server(Stage 5): Transfers data from the shared 
database to the Demand Planning Server.

If you maintain multiple demand plans, you can run stages concurrently.
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Note: If any of these processes fail while its status is perceived as 
running, the system detects the failure to complete. The failed process 
is stopped and the system is automatically set back to the last 
successfully completed process. You can resume the failed process 
without any technical intervention. 

Demand Plan Administration interface for running stages in the planning cycle
The Demand Planning Administrator page is the interface for running the stages of the 
planning cycle. 

To access the Demand Planning Administrator page:
1. Log into Oracle Demand Planning.

2. Select the Demand Planning System Administrator responsibility,

3. In the Navigator, choose Demand Plan Administration. A list of demand plans 
appears.

4. Select the demand plan that you want to work with, scroll to the bottom of the 
page, and choose Start Demand Planning. The Demand Planning Administrator 
page for the plan opens.

Demand Planning Administrator page 

Example 4 Demand Planning Administrator Page
The Demand Planning Administrator page shows the demand plan you have selected.
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Getting help
To view information that is specific to the current page, choose the Help button at the 
bottom of the page.

To access the full Oracle Demand Planning online Help system for Demand Plan 
Administration, choose the large Help (?) button at the top of the page. 

You can use your browser's print function to print Help topics.

To close an open Help window, choose the Exit (X) button at the top of the page. You 
will be returned to the current function. 

Getting version and system information
To access version and system information, choose About Demand Planning at the 
bottom left of the page.

Downloading Data from the Planning Server (Stage 1) 
After a demand plan has been built, you run the Download Data from Planning Server 
stage to initiate a new planning cycle. The download stage transfers data from the 
Demand Planning Server to the shared database in the Demand Planning Engine. You 
can choose to download all input parameters, or you can limit the download to specific 
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parameters. You can also specify whether to download only new and modified 
information, or to replace the information in the shared database with current 
information from the Demand Planning Server. 

Note: During the download process, demand plans that have multiple 
calendars will have slow performance. 

To run Download Data from Planning Server:
1. Access the Demand Planning Administrator page.

2. In the navigation list, choose the demand plan name. A list of the stages in the 
planning cycle appears in the right frame. 

3. In the Stage column, choose Download Data from Planning Server.

4. In the Download Method box, choose the method that you want to use to download
data from the Demand Planning Server to the shared database:

• Full: Downloads all information. Use this method when you know that there 
have been changes in the Demand Planning Server that extend beyond fact 
data. For example, you would run a full download to get the most recent prices,
events, level values, and so forth. 

• Quick: Downloads all or selected fact data from the Demand Planning Server. 
Use this method for routine downloads or when one or more streams have 
updated fact data needed for this cycle.

Note: When you run a full download, planners' personal 
databases are not preserved.

5. If you chose Quick in Step 4, select the input parameters to download:

• To include an input parameter in the download, check its Download box. 

• To exclude an input parameter from the download, clear its Download box.

6. To configure the download process to automatically reaggregate all measures when
a change in a hierarchy is detected, check the Reaggregate All Measures When 
Hierarchy Changes Are Detected box. For details about automatically reaggregating
hierarchies, see: Reaggregating Measures., page 8-6

7. In the Refresh Mode box, choose the method that you want to use to refresh data 
when it is downloaded from the Demand Planning Server:
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• Update: Downloads only new and modified information (incremental refresh 
based on net change). Use this method for routine downloads. 

• Complete Refresh: Replaces the information in the shared database with the 
most current information from the Demand Planning Server. For a quick 
download, use this method when you want to discard and refresh it with the 
version from the Demand Planning Server. For a full download, use this 
method when you know that there have been major changes to data in the 
Demand Planning Server and you want to replace the data in the shared 
database with the new data. 

8. Choose Apply. The task is submitted to Oracle Workflow. The Status column 
indicates when the stage is complete. For details about the associated Workflow 
process, see: Workflow Processes Within the Demand Planning Cycle, page B-2.

Note: You can use the Batch Log to view processing details. For 
details, see: Batch Log, page 9-34.

If you automate the planning cycle
If you use a concurrent request program to automate the stages in the planning cycle, 
you need only run the Download Data from Planning Server stage for the initial 
planning cycle. Thereafter, it will automatically run a full download. For details about 
automating the planning cycle, see: Automating the Planning Cycle, page 8-14.

Reaggregating Measures 
When downloading data from the Demand Planning Sever, you can choose to 
automatically reaggregate all measures in the shared database when a change in a 
hierarchy is detected. The Download automatically determines which hierarchy values 
have been modified, and then reaggregates all Shared Measures and Input Parameters 
for those values for all time periods. These changes can include: 

• Dimension values moved under a different intermediate level.

• Deleted dimension values.

This option is available for a Full or Quick Download and either the Complete Refresh 
or Update option. This allows a measure's values to reflect recent hierarchy changes 
without running a time-consuming repopulate process for the measure.

Note:  Using the Reaggregate option has performance implications, as it
causes all measures and input parameters to be reaggregated for all 
time periods wherever the hierarchy is modified. If the Populate stage 
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is run for all measures, the Reaggregate option should not be selected 
as Populate recalculates, allocates and aggregates the measures. If the 
Populate stage is only run for selected measures, then the Reaggregate 
option can be used to reflect hierarchy changes in all Input parameters 
and all measures whether selected or not.

After downloading data from the Demand Planning Server
After data has been downloaded from the Demand Planning Server to the shared 
database in the Demand Planning Engine, you can set up or modify the environment 
for planners and the Demand Plan Manager. You can perform the following tasks: 

• Create and edit measures. Measures are variables that enable planners and the 
Demand Plan Manager to forecast data, analyze data, manipulate data, share data, 
and submit and upload final forecasts. The Demand Planning Server is the source of
input parameters which are downloaded to the shared database and displayed as 
measures. You can create additional measures. You can also edit measures, delete 
measures, and specify which measures should be rebuilt in the next planning cycle. 
For details about using Demand Plan Administration to work with measures, see: 
Measures, page 9-2.

• Create and maintain events. Events are occurrences such as promotions, product 
introductions, and product phase outs that are expected to impact sales or demand 
for a product. Planners and the Demand Plan Manager can apply events to forecasts
and model their effect on demand. The Demand Planning Server is the source of 
global events that are downloaded to the shared database. You can create 
additional events. You can also edit events and delete events. For details about 
using Demand Plan Administration to work with events, see: Events, page 9-9.

• Set or change the default measure for scenarios in the demand plan. Planners will 
see the default measure when they submit their final forecasts for a scenario. The 
default measure will also be displayed as a measure property. For details about 
using Demand Plan Administration to set or change the default measure for a 
scenario, see: Scenarios, page 9-23.

• Set or modify comment reason codes. Planners and the Demand Plan Manager use 
these codes to enter comments when modifying data in worksheets. You can create 
new codes, edit codes, and delete codes. For details about using Demand Plan 
Administration to work with comment codes, see: Comment Reason Codes, page 9-
27.

• Specify how the application code will be accessed by users' browsers. Also, specify 
optional text for the Welcome screen. 

• Set defaults for predefined reports and select the predefined reports for planners 
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and the Demand Plan Manager. Predefined reports are documents that enable users
to conduct structured business analyses along a specific dimension and to estimate 
the accuracy of forecasts. For details about using Demand Plan Administration to 
work with predefined reports, see: Predefined Reports, page 9-29.

Modifying Demand Planning Server settings following a download
Once data has been downloaded from the Demand Planning Server to the shared 
database, your ability to change the settings for the plan in the Demand Planning Server
is limited as follows:

• You cannot change the set of dimensions in the plan. You cannot add dimensions, 
delete dimensions, or change the mapping between dimensions and user 
dimensions. The download will not complete.

• You cannot add or modify hierarchies in such a way that new levels would be 
added to the plan. If you do this, then the download will not complete. However, 
you can add new hierarchies and modify hierarchies if they consist of levels that are
already included in the plan. 

• If you delete a calendar from a plan, the download process will ignore the deletion 
and display a warning.

• You cannot change the lowest level setting for an existing calendar. The download 
will not complete. 

• You cannot change the definition of an existing calendar. The download will not 
complete.

• If you delete a time range, the download will ignore the deletion.

• If you delete planning percentages and data from Bills of Material, the download 
will ignore the deletion.

• Do not modify the allocation floor of an existing input parameter. This may result in
strange data behavior.

• If you change the composite group for an input parameter, the download will 
ignore the change and display a warning.

Populating Measures (Stage 2)
Run the Populate Measures stage to calculate measures and run forecasts in the shared 
database. The process also calculates measures that have been added to the shared 
database since the last time that measures were populated. 

When you do a quick download of one or more Demand Planning input parameters 
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from the Demand Planning Server, and you use the "update" refresh mode, aggregation 
calculations are performed only for those measures values that changed.

You must run the Populate Measures stage for the initial planning cycle. Thereafter, you
can run it on an "as needed" basis. For example, you might use it to update the shared 
database after running a "quick" download on an input parameter such as Booking 
History if the shared database included a "Forecast of Booking History" measure based 
on Booking History. In this case, populating measures would cause the forecast to 
reflect the changed data in the newly downloaded base measure.

To run Populate Measures:
1. Access the Demand Planning Administrator page.

2. In the navigation list, choose the demand plan name. A list of the stages in the 
planning cycle appears in the right frame. 

3. In the Stage column, choose Populate Measures.

4. Choose Apply. The task is submitted to Oracle Workflow. The Status column 
indicates when the stage is complete. For details about the associated Workflow 
process, see: Workflow Processes Within the Demand Planning Cycle, page B-2.

Note: You can use the Batch Log to view processing details. For 
details, see: Batch Log, page 9-34.

If you automate the planning cycle
If you use a concurrent request program to automate the stages in the planning cycle, 
you need only run the Populate Measures stage for the initial planning cycle. Thereafter
it will run automatically. For details about automating the planning cycle, see: 
Automating the Planning Cycle, page 8-14.

After you populate measures
If this is the initial cycle for this plan, define planner assignments after you populate 
measures. Planner assignments determine the dimension value combinations (measures
and dimension values) that each planner is responsible for forecasting, as well as the 
dimension values that each planner sees.

For details about using Demand Plan Administration to work with assignments, see: 
Planner Assignments, page 9-12.
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Distributing to Planners (Stage 3)
Run the Distribute to Planners stage to distribute data in the shared database to 
planners' personal databases. The process distributes measures that have been 
calculated in the shared database as well as any measure definitions that have been 
created or updated by the Demand Plan Manager since the last time that a distribution 
was run. You can choose to distribute all data or you can limit the distribution to 
selected measures. 

Note: If this is the first time that you are running this stage for the plan, 
ensure that you have defined measures, defined events, set up 
assignments, and performed other administrative tasks before you 
begin. If this is an update, ensure that modifications such as adding or 
changing planner assignments are complete. 

To run Distribute to Planners:
1. Access the Demand Planning Administrator page.

2. In the navigation list, choose the demand plan name. A list of stages in the planning
cycle appears in the right frame. 

3. In the Stage column, choose Distribute to Planners. 

4. Specify the distribution method that you want to use:

• Full: Distributes all available information in the shared database to planners' 
personal databases. A full distribution includes metadata, price lists, all events, 
Demand Planning Server settings, and all assigned measures. Use this method 
the first time that you run a distribution.

• Quick: Distributes selected measure definitions and data and new or modified 
event definitions that are associated with these measures. Use this method for 
routine distributions.

Note: Quick distribution will only be successful for planners 
who have existing assignment databases. For example, if you 
want to distribute data for two planner assignments (A and B) 
and assignment A already has a planner database from a 
previous distribution but assignment B does not, quick 
distribution will take place only for planner A. The planner 
database for planner B will only be created when you run a full 
distribution. 
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5. If you chose Quick, select the measures to distribute:

• To include a measure in the distribution, check its Distribute box. 

• To exclude a measure from the distribution, clear its Distribute box.

Note: The Distribute box is disabled for formula measures. If 
the stored measure on which a formula measure is based is 
marked for distribution, then the formula measure will be 
automatically distributed.

6. Choose Apply. The task is submitted to Oracle Workflow. The Status column 
indicates when the stage is complete. For details about Workflow processing, see: 
Stage 3 Workflow process: Distribute to planners on page B-6.

Note: You can use the Batch Log to view processing details. For 
details, see: Batch Log, page 9-34.

Note: If the Distribute to Planner stage does not complete 
successfully, restart the process from the beginning.

If you automate the planning cycle
If you use a concurrent request program to automate the stages in the planning cycle, 
you need only run the Distribute to Planners stage for the initial planning cycle. 
Thereafter, it will automatically run a full distribution. For details about automating the 
stages of the planning cycle, see:Automating the Planning Cycle, page 8-14.

After distributing to planners
Individual demand planners create and edit forecasts and perform what-if simulations. 
Alerts that have been defined by the Planning Manager or by demand planners monitor
forecast accuracy. If planner assignments have been set up for collaborative planning, 
users can share data updates. 

Once a demand planner is satisfied with his or her forecasts, he or she submits the 
forecasts for consolidation in the shared database. For details about submitting 
forecasts, see: Uploading Measures to the Planning Server (Stage 5), page 8-14.

Collecting Data from Planners (Stage 4)
As planners submit their final forecasts, the data is marked for inclusion in the shared 
database. Run the Collect Data from Planners stage to collect and consolidate planners' 
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data submissions. The process collects the submitted forecasts and rolls them up to 
obtain the final consolidated forecast. You can also view the status of submissions by 
assignment.

Note: If a planner has not yet submitted a forecast for a scenario, then 
Oracle Demand Planning uses the default measure for the scenario as 
the value for the planner's submission if a default measure for the 
scenario has been set. If no default measure has been set for the 
scenario, then the data collected from a planner who has not submitted 
data will be NA for that scenario.

Within the Collect Data function, you have the following options: 

• You can set a data collection deadline date. This establishes a final date on which 
data that has been submitted by planners will be collected and consolidated in the 
shared database. You can also set a parameter to generate reminder messages to 
planners. 

Workflow will run an iterative process to collect submissions up until the date that 
you specify. If you select the reminder messaging option, Workflow will generate 
reminder messages.

• If a collection process is running, you can terminate the collection. 

Workflow will run a final process to collect available submissions and consolidate 
the data. 

• You can collect available data immediately. 

Workflow will run a process, distinct from the process that runs collections, to 
collect available submissions and consolidate the data. If a collection process is 
currently running, it will continue. 

For details about how Workflow accomplishes these processes, see: Workflow Processes
Within the Demand Planning Cycle, page B-2

To run collect Data from Planners:
1. Access the Demand Planning Administrator page.

2. In the navigation list, choose the demand plan name. A list of stages in the planning
cycle appears in the right frame. 

3. In the Stage column, choose Collect Data from Planners.

4. To view the status of planners' forecast submissions, scroll down to view the 
Assignment status box. The box displays the assignment name, user ID, and 
submission status for each scenario in the demand plan.
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5. To specify a date on which to end data collection, proceed as follows:

1. In the Date to end data collection period box, click the arrow in the box and 
select a collection deadline date. This establishes the final date for collecting 
submissions from planners. 

2. If you want the system to notify planners who have not yet submitted data as 
the collection deadline approaches, check Enable reminder messaging and enter
a number in the Days in advance of collection end to begin reminder messaging
box. The number specifies the number of days before the date on which data 
collection ends that Workflow will begin to send out reminder messages to 
planners. 

6. To collect and consolidate submissions and cancel a collection process that is 
currently running, choose End collection period. 

Note: This option is only available when a collection process is 
running.

7. To collect and consolidate submissions and continue the collection process, choose 
Collect available submissions now. 

8. Choose Apply. The task is submitted to Oracle Workflow. The Status column 
indicates when the stage is complete. For details about the associated Workflow 
process, see: Workflow Processes Within the Demand Planning Cycle, page B-2.

Note: You can use the Batch Log to view processing details. 

If you automate the planning cycle
If you use a concurrent request program to automate the stages in the planning cycle, 
you need only run the Collect Data from Planners stage for the initial planning cycle. 
Thereafter, it will run automatically. For details about automating the planning cycle, 
see: Automating the Planning Cycle, page 8-14.

After collecting data from planners
At this point the Demand Plan Manager may choose to review the overall forecast and 
make revisions. He or she can use the same techniques as the planners to view, analyze, 
and edit data. If the consolidated submission measure does not contain the data that the
manager wants to transfer to the shared database, he or she can edit the data or select 
an alternate measure to upload.
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Uploading Measures to the Planning Server (Stage 5)
After the Demand Plan Manager has reviewed and approved the consolidated forecasts,
run Upload Measures to Planning Server to transfer data from the shared database to 
the Demand Planning Server. 

Note: The Demand Plan Manager has the option to perform the upload 
when he or she selects measures to upload for scenarios in the demand 
plan. If the manager has run the upload, then this stage will be marked 
as complete. 

Once measures have been uploaded to the Demand Planning Server, the data can be 
published back to the source Oracle Applications transaction system and used by 
Oracle Advanced Supply Chain Planning (ASCP), Oracle Collaborative Planning (CP), 
and Oracle Inventory Optimization (IO).

To run Upload Measures to Planning Server:
1. Access the Demand Planning Administrator page.

2. In the navigation list, choose the demand plan name. A list of stages appears in the 
right frame. 

3. In the Stage column, choose Upload Measures to Planning Server. 

4. Choose Apply. The task is submitted to Oracle Workflow. The Status column 
indicates when the stage is complete. For details about the associated Workflow 
process, see: Workflow Processes Within the Demand Planning Cycle, page B-2.

Note: You can use the Batch Log to view processing details. 

If you automate the planning cycle
If you use a concurrent request program to automate the stages in the planning cycle, 
you need only run Upload Measures to Planning Server stage for the initial planning 
cycle. Thereafter, it will run automatically. For details about automating the planning 
cycle, see:Automating the Planning Cycle, page 8-14.

Note: You can use the Batch Log to view detailed status information.

Automating the Planning Cycle
If your site has a predictable planning cycle, you might want to consider automating 
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batch processing. This is particularly useful for businesses that have a consistent 
demand planning cycles where the cycles repeat after fixed intervals and a new rolling 
forecast is created every cycle. 

A concurrent program, predefined as a request in the Demand Planning Server, enables 
you to automate processing through a program that runs a master Workflow process. 
Note that midcycle collections can also be performed as needed. 

You can schedule the first three planning cycle activities (Download Data from the 
Planning Server, Populate Measures, Distribute Data to Planners) as a sequence to occur
periodically at specific times. The workflow process waits there for a user specified 
interval before running the Collect Data from Planners stage. 

You can also specify the number of days to wait before running the Upload to Planning 
Server stage. This gives the Demand Plan Manager a preset time period in which to 
review forecasts that have been submitted to the shared database. When this time 
period has elapsed, Workflow uploads the data to the Demand Planning Server.

Note that the automated program runs a full distribution and a full download. If you 
want to run quick downloads and quick distributions, you can do so between cycles. 

Note: Before automating batch processing, ensure that you manually 
run all batches at least one time. The initial run of each batch sets the 
default parameters for the concurrent program.

Example 5 Automating the planning cycle
For example, you could specify the master workflow program to run every 30 days with
wait period of 5 days. In this case, the following would occur:

• Day 1: Run processes 1, 2, and 3 in sequence, where process 2 is run after process 1 
is complete.

• Wait for 5 days.

• Day 6: This is the deadline for demand planners to submit the final forecast 
numbers. Run process 4 to collect from demand planners. 

• Wait for five days while the Demand Plan Manager reviews planners' data. Then in 
sequence, run process 5.

• Day 31: Run process 1, 2, and 3.

Customizing automated processing
The concurrent program that automates batch processing includes basic functionality. 
An individual who has knowledge of Oracle Workflow and PL*SQL can customize the 
program to adapt to specific site requirements.
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Running the request to automate the planning cycle
The concurrent program that automates the planning cycle prompts for the demand 
plan name, the number of days to run the collection, and the number of days to wait 
after data is consolidated in the shared database before uploading the data to the 
Demand Planning Server. 

To run the request to automate the planning cycle:
1. Log into Oracle Demand Planning with the Demand Planning System 

Administrator responsibility.

2. In the Navigator, select Other > Requests.

3. In the Find Requests window, select Submit a New Request.

4. Select Run a Single Request.

5. In the Name list of values field, select Demand Planning Engine Master Workflow 
Process.

6. In the Parameters window, provide the following parameters for the request:

• Demand Plan Name: the name that was assigned when the plan was built.

• Number of days to run the collection period: the number of days following the 
run of the Collect Data from Planners batch that data will be consolidated in the
shared database.

• Number of days to delay upload: the number of days following the run of the 
Collect Data From Planners batch that the data will be uploaded to the Demand
Planning Server. 

7. Choose Submit to run the request.

Viewing the Workflow Process List
After you run the concurrent program, you can access the workflow process list in 
Oracle Workflow and see a visual depiction of the process. 
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Rolling demand plan dates forward
User can use the existing demand plan definition to start the next forecast cycle by 
rolling the demand plan dates forward to next cycle. Once the request set is launched 
with the appropriate parameters, the Roll demand plan dates forward concurrent 
program implements the required changes in the original plan definition, and the 
Validate Rolled Demand Plan concurrent program validates the demand plan 
definition. 

To roll demand plan dates forward to the next forecast cycle:
1. Log into Oracle Demand Planning with the Demand Planning System 

Administrator responsibility.

2. In the Navigator, select Other > Requests.

3. In the Find Requests window, select Submit a New Request.

4. Select Request Set in the Submit a New Request window.

5. In the Submit Request Set window, select the LOV in the Request Set field. Roll 
demand plan dates forward to next cycle populates into the field.
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6. Click in the Parameters field of the Demand Plan Rolling Process program.

7. Complete the following fields:

Name Description

Demand Plan Name Select at least one demand plan from the 
LOV of valid demand plans. 

Roll dates forward by period select either Day (default) or Gregorian 
Month. The demand plan dates are rolled 
forward based on the type of period 
(bucket) selected here. 
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Name Description

Roll dates forward by number of periods Enter a number from 1 to 999. The start and 
end dates for input parameters, scenario 
history period, and scenario horizon are 
rolled forward by the specified number of 
periods.

For example, if 31 days are specified, 
1-Jan-2002 will become 1-Feb-2002 and 
1-Feb-2002 will become 4-Mar-2002. If 1 
month is specified, 1-Feb-2002 will become 
1-Mar 2002.

8. Select OK. Now the Roll demand plan dates forward to the next cycle concurrent 
program rolls the dates forward. 

For details on how the dates are rolled when the Exclude from Rolling Cycle check 
box is not checked, see: Input Parameters, page 7-15.

Note: You must validate the demand plan after the dates have 
changed. The Roll demand plan dates forward to the next cycle 
program errors out if the dates rolled forward are not valid dates 
for the calendars included in the demand plan.

Viewing the Batch Log
The Batch Log displays detailed date and time information about the status of activities 
in the demand planning cycle. The log displays automatically while a batch process is 
running. You can also view the log on an ad hoc basis. 

To view the batch log:
1. Log into Oracle Demand Planning with the Demand Planning System 

Administrator responsibility.

2. In the Navigator, select Batch Log. 

3. Scroll through the log to view activity detail. 

4. To exit, select another item in the navigation list or close the page.

Example 1 Batch Log
The following illustration shows an example of events recorded in a typical batch log.
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************

05/18/2002-19:37:19 -> Begin Downloading Data from Planning Server.

05/18/2002-19:37:20 -> Generating Express metadata structures.

05/18/2002-19:37:21 -> Connecting to Planning Server.

05/18/2002-19:37:22 -> Loading specified Demand Plan information.

05/18/2002-19:37:25 -> Loading Dimension information.

05/18/2002-19:37:25 -> Loading Hierarchy and Level information.

05/18/2002-19:37:28 -> Generating DP Dimension metadata.

05/18/2002-19:37:28 -> Generating the Gregorian Time hierarchy within Express.

05/18/2002-19:37:28 -> Generating DP Hierarchy and Level metadata.

05/18/2002-19:37:29 -> Processing Attributes.

05/18/2002-19:37:29 -> Loading Time dimension values.

05/18/2002-19:37:44 -> Loading dimension values.

05/18/2002-19:39:09 -> Verify that all dimensions have values.

05/18/2002-19:39:09 -> Setting backend hierarchy information.

05/18/2002-19:39:17 -> Loading Input Parameters and Scenarios.

05/18/2002-19:39:24 -> Loading Item Unit of Measure information.

05/18/2002-19:39:31 -> Loading events.

05/18/2002-19:39:35 -> Loading data for specified Input Parameters.

05/18/2002-19:39:35 -> Loading data for the following Input Parameter: INTEGRATION.

05/18/2002-19:39:40 -> Loading Unit of Measure conversion information.

05/18/2002-19:39:45 -> Calculating conversion coefficients for Product dimension.

05/18/2002-19:40:06 -> Loading variable Product pricing information.

05/18/2002-19:40:09 -> Converting for Express Objects.

05/18/2002-19:40:11 -> Converting for OSA.

05/18/2002-19:42:04 -> Synchronizing variable names.

05/18/2002-19:42:05 -> Creating required worksheet objects.

05/18/2002-19:42:05 -> Creating required Workflow objects in the Master database.

05/18/2002-19:42:07 -> Allocating the historical data.

05/18/2002-19:42:07 -> INTEGRATION

05/18/2002-19:42:18 -> Aggregating the historical data.

05/18/2002-19:42:35 -> Setting DP system flags.
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05/18/2002-19:42:36 -> Disconnecting from Planning Server.

05/18/2002-19:43:00 -> Completed Downloading Data from Planning Server.

*************************************************************** 

***************************************************************

05/18/2002-19:46:06 -> Begin Populating Measures.

05/18/2002-19:46:06 -> Confirming database attach logic.

05/18/2002-19:46:08 -> Calling driver for Measure population.

05/18/2002-19:46:08 -> Populating Measures according to Measure definitions.

05/18/2002-19:46:09 -> Performing forecast calculations for the following measure: 
Forecast of INTEGRATION.

05/18/2002-19:46:23 -> Completed Populating Measures.

***************************************************************

***************************************************************

05/18/2002-19:47:44 -> Begin Distributing Data to Planners.

05/18/2002-19:50:16 -> Building personal database A1.

05/18/2002-20:00:03 -> Build of personal database A1 was successful.

05/18/2002-20:00:24 -> Creating Submissions Measures.

05/18/2002-20:00:28 -> Performing measure copy for the following measure: 

Submissions, Roger_fr1 (18-MAY-2002).

05/18/2002-20:00:41 -> Completed Distributing Data to Planners.

***************************************************************

***************************************************************

05/18/2002-20:10:40 -> Collect Available Data Submissions was requested and is 
initiating a collect and consolidate.

05/18/2002-20:10:40 -> Begin Collecting Data from Planners.

05/18/2002-20:10:41 -> Collecting submitted data into DATA database.

05/18/2002-20:11:27 -> Consolidating the collected data.

05/18/2002-20:11:40 -> Completed Collecting Data from Planners.

***************************************************************

***************************************************************

05/18/2002-20:21:14 -> Begin Uploading Scenarios to Planning Server.

05/18/2002-20:21:14 -> Simultaneous upload programs: 10

05/18/2002-20:21:15 -> Not writing back numbers less than 0.500000000000000
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05/18/2002-20:21:15 -> Rounding off numbers after 2 decimal places

---------------------------------------------------------------

05/18/2002-20:21:21 -> Scenario ID: Roger_fr1

05/18/2002-20:21:22 -> Dimension value counts:

05/18/2002-20:21:22 -> TIM: 59 values at level DY

05/18/2002-20:21:22 -> Writing back TIM at level DY.

05/18/2002-20:21:22 -> GEO: 2 values at level 15

05/18/2002-20:21:22 -> Writing back GEO at level 15.

05/18/2002-20:21:22 -> ORG: 2 values at level 7

05/18/2002-20:21:22 -> Writing back ORG at level 7.

05/18/2002-20:21:23 -> PRD: 4 values at level 1

05/18/2002-20:21:23 -> Writing back PRD at level 1.

05/18/2002-20:21:23 -> DP.CMP: 16 values in composite at writeback levels

05/18/2002-20:21:23 -> Writing dimensions: TIM, GEO, ORG, PRD.

05/18/2002-20:22:57 -> Roger_fr1: Number of lines written to table: 857.

05/18/2002-20:22:57 -> Roger_fr1: Number of lines skipped for zero amounts: 0.

05/18/2002-20:22:57 -> Roger_fr1: Number of lines skipped below threshold amount

: 87.

05/18/2002-20:22:59 -> Completed Uploading Scenarios to Planning Server.

***************************************************************

Administering OLAP Sessions
While working with Demand Planning, you can check the status of the current OLAP 
sessions. In particular, you can:

• View all OLAP sessions

• View OLAP sessions for a specific plan

• Terminate an inactive OLAP session without waiting for the session to timeout

To View All OLAP Sessions
1. Choose Demand Planning System Administrator responsibility. 

2. To open the Session Administration window listing all open OLAP sessions, select 
Other > Session Administration.
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The following information is provided for each OLAP session:

Field Description

Plan Name The name of the open plan.

Assignment The planner's assignment.

Responsibility The user's demand planning responsibility.

User The name of the plan owner.

Status The status of the plan. Valid values are:

• Active

• Inactive

• Killed

Delete The delete button terminates the OLAP 
session.

To View OLAP Sessions for a Specific Plan
1. Choose Demand Planning System Administrator responsibility. 

2. Select Other > Session Administration.

The Session Administration window listing all open OLAP sessions appears.

3. Enter the plan name.
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The Session Administration window shows only OLAP sessions for the specified 
plan.

To Terminate an OLAP Session
1. Choose Demand Planning System Administrator responsibility. 

2. Select Other > Session Administration.

3. Click the delete button for any hung or inactive OLAP session.

A confirmation message is displayed. 

4. Choose Yes to terminate the session. Choose No to not delete the OLAP session.

Publishing Forecast Data Back to the Source
Once the forecast data reaches the Demand Planning Server, it may be published back 
to the source Oracle Applications transaction system, where then it can optionally be 
loaded into a Master Demand Schedule for the purpose of consuming it against 
available sales orders. Publishing of forecasts back to the source is optional. For details, 
see: Defining a Demand Plan, page 7-1.

To publish forecast data from the Planning Server to an Oracle Applications source instance:
1. Choose the Demand Planning System Administrator responsibility.

2. To open the Publish Forecast window, select Collections >Publish Forecast in the 
Navigator.
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3. Complete the following fields in the Publish Forecast window:

Field Function Legal Value

Demand Plan The demand plan containing
the scenario to be published 
back to the source.

List of values.

Scenario The scenario to be published
back to the source.

List of values.

Out-of-calendar Dates If a date in the scenario to be
published falls outside the 
working days of the 
manufacturing calendar of 
the destination organization,
perform the action listed 
here.

Reject, Shift Forward, and 
Shift Backward. This is 
applicable to manufacturing 
calendars with nonworking 
days in the week.

Instance The instance code of the 
source instance to which the 
forecast will be published.

List of values.
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Field Function Legal Value

Forecast The forecast name on the 
source. If this already exists, 
the existing forecast entries 
in the source will be 
overridden. If it does not 
already exist, it will be 
created.

List of values from across 
the link (source instance).

Forecast Set The forecast set name on the
source. If this already exists, 
the existing forecast entries 
in the source will be 
overridden. If it does not 
already exist, it will be 
created.

List of values from across 
the link (source instance).

Demand Class This is the demand class to 
which you would like to 
publish the forecast. Sales 
orders that have an 
associated specific demand 
class consume the forecast 
with a matching demand 
class or the forecast without 
any demand class. Sales 
order demand without 
demand class consume the 
forecast with the 
organization's default 
demand class or the forecast 
without any demand class. 

If the forecast consumption 
process does not find 
forecasts with demand class,
then it consumes the 
forecasts without demand 
class or the forecasts with 
the demand class 'Other'.

List of values from across 
the link (source instance).

Level Select a demand planning 
level that maps to the 
demand class selected in the
previous field.

List of values.
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Field Function Legal Value

Value Value for the level specified 
in the previous field.

List of values.

Customer The customer for which you 
would like to publish the 
forecast. If publishing to a 
customer level forecast set, 
select the name of a 
customer.

List of values.

Location The customer ship to site for
which you would like to 
publish the forecast. If 
publishing to a ship to level 
forecast set, select the name 
of a customer (previous 
field) as well as the location.

List of values.

Use System Forecast Check this if you want to 
use the baseline forecast. 
This field is not used any 
more.

Check or uncheck

4. Select Publish Forecast. 

Only one scenario with one demand plan can be published at a time.

Note: If the demand class, customer or location fields are 
populated, only the elements from the scenario with demand class, 
customer and location dimension values matching the populated 
values will be published into the designated forecast.

Using Forecast Data for Advanced Planning
Optimization by selecting the scenario name in the inventory plan. For details, see: 
Oracle Inventory Optimization User's Guide.

You can bring, analyze, and forecast your customers' sales history as well as forecasts 
from Oracle Collaborative Planning into Oracle Demand Planning. Customer's sales 
history can then be used to create customer's sales forecast in Oracle Demand Planning. 
This customer's sales forecast or the one directly collected from Oracle Collaborative 
Planning serves as an input to the consensus forecasting process within Oracle Demand 
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Planning. The demand planning forecast can then be fed to Oracle Advanced Supply 
Chain Planning to drive supply planning or into Oracle Collaborative Planning to drive 
VMI replenishments. 

To bring and analyze customer's data:
You need to have your customers, customer sites, external inventory organizations, 
VMI items and replenishment controls, and blanket sales orders already defined in your
ERP system. 

1. Collect customer's sales history or forecast from Oracle Collaborative Planning into 
Oracle Demand Planning.

If Oracle Collaborative Planning is not implemented, customers' sales history or 
forecast can be loaded into Oracle Demand Planning via flat files. 

1. Choose the Advanced Planning Administrator responsibility.

2. Select Collaboration > Receive Forecast/History from Customer.

3. Click on Parameters field and specify the following: 

• Forecast/History Name: name for the data that will be collected. 

• Receive Forecast/History Type: select Historical sales to collect customer's 
sales history. Select Sales Forecast or Order Forecast to collect customer's 
forecast. 

• Organization, planner, item, customer, and customer site (available if 
customer is selected): optional filters to restrict information. 

By default all the available data is collected for all organization, planner, 
item, customer, and customer site. 

• Horizon start date: the date from which you want to bring in the history.

• Number of Horizon Days: number of days from which you want to bring in
the history beginning from horizon start date.
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2. Include the customers' data in your demand plan.

1. Choose Demand Planning System Administrator responsibility.

2. Select Demand Plans.

3. Select Input Parameters.

4. In Type of input parameter, select Historical Sales from Customers, or Sales 
Forecast from Customers, or Order Forecast from Customers to bring 
customer's sales history, sales forecast, or order forecast, respectively. 

For details, see: Input Parameters, page 7-15. For creating a forecast based on 
the customer's sales history or for analyzing the customer's data in worksheets 
and reports, see: Using Sales Forecasts and Opportunities, page 26-15.
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3. After forecasting and analysis in Oracle Demand Planning, the output consensus 
forecast can be used in two ways:

• Publish the forecast from Oracle Demand Planning to Oracle Collaborative 
Planning to drive replenishment planning. Then, as a separate process, use the 
forecast to drive supply planning in Oracle Inventory Optimization and Oracle 
Advanced Supply Chain Planning.

• Use the forecast to drive supply planning in Oracle Inventory Optimization and
Oracle Advanced Supply Chain Planning. Then publish order forecast or 
supply commits from Oracle Advanced Supply Chain Planning to Oracle 
Collaborative Planning.

To publish the forecast from Oracle Demand Planning directly to Oracle Collaborative Planning:
1. Choose Advanced Planning Administrator responsibility.

2. Select Collaboration > Publish Forecast to Customer.

3. Click on Parameters field and specify the following parameters: 
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• Forecast designator: name for the forecast data.

• Publish Forecast Type: select Sales forecast.

• Demand Plan Name: name of the demand plan.

• Scenario Name: forecast scenario name for the selected demand plan.

• Organization, planner, item, customer, and customer site (available if customer 
is selected): optional filters to restrict the history information.

• Horizon Start Date: the date from which you want to bring in the history.

• Number of Horizon Days: number of days from which you want to bring in the 
history beginning from horizon start date.

• Automatic Versioning: select Yes to maintain multiple forecast versions in 
Oracle Collaborative Planning.

To publish forecast data from Oracle Demand Planning to Oracle Process Manufacturing:
1. Select Demand Planning System Administrator responsibility.

2. Complete all the stages (1-5) of Oracle Demand Planning.

• Download Data from Planning Server (Stage 1)

• Populate Measures (Stage 2)
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• Distribute to Planners (Stage 3)

• Collect Data from Planners (Stage 4)

• Upload Measures to Planning Server (Stage 5)

3. In the Navigator, select Collections > Publish Forecast.

4. Enter details into the Publish Forecast window and select Publish Forecast.

5. Log on to the source instance.

6. Select the OPM All responsibility.

7. Run the OPM Forecast Designator (Feedback from DP) program.

The Parameters window opens. 

8. In the Forecast Designator field, select an existing Forecast Name from the list of 
values. 

The forecast names in the list include the entire Demand Planning forecast names 
published back to your OPM instance. If you select a Demand Planning forecast 
name that has the same name as an existing OPM forecast, the existing OPM 
forecast is overridden by the Demand Planning forecast data. Otherwise, a new 
OPM forecast is created. Required.

9. In the Warehouse Name field, select a warehouse from the list of values to import 
forecast data for only one warehouse. You can leave the field blank to import 
forecast data for all warehouses.

10. Click OK.

11. Click Submit.

12. Select Process Planning > Forecasting > Forecast.

13. View the forecast published from Oracle Demand Planning.

For more details, see Using Oracle Advanced Planning and Scheduling with Oracle Process 
Manufacturing User's Guide.

Renewing the Forecasting Cycle
After one cycle is complete, the Demand Planning Server holds the following data:

• Data from the previous collection and pull
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• Demand plans from previous cycle

Any data collected or imported will override the data in the tables for the date range the
data was collected. Incremental data can be imported if a non-overlapping different 
date range is specified. This is something that the Demand Planning System 
Administrator needs to consider before importing the next set of data. The issue is 
whether to add the last period incremental data from the source to the data already 
existing or refresh it completely.

Collecting data for the next forecast cycle
If additional data needs to be collected for Oracle Demand Planning, follow the 
procedure described in on page 4-2.

Once data is collected and pulled into the fact tables, the Demand Planning System 
Administrator can either define a new demand plan or choose to use the previously 
defined demand plans. Also, it is possible to copy a demand plan with a new name, 
modify it, and use it for the next forecasting cycle.

To copy a demand plan:
1. Choose the Demand Planning System Administrator responsibility.

2. In the Navigator, select Demand Plans.

3. Select the name of the demand plan to be copied. The Demand Plans window for 
the demand plan you selected appears.

4. Select Copy To from the Demand Plans window to open the Copy To window.

5. Enter a name for the new demand plan. All data fields are copied automatically 
from the demand plan you selected.

6. Select OK.
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Modifying a demand plan for the next forecast cycle
Following are modifications that would make a demand plan suitable for a subsequent 
cycle. You make these modifications in the Demand Plan window:

• In the Input Parameters tab, roll the end and possibly start dates of booking and 
shipping histories forward by one forecasting period.

• In the Scenarios tab, roll the history start, history end, horizon start and horizon end
dates for all scenarios forward by one forecasting period.

Scenario persistence
A scenario is a statement of forecast horizon and basis. The basis consists of the 
bookings and shipments. The statistical forecast so generated gets the name of the 
respective scenario. The capability for scenarios to be persistent allows the forecasts to 
be usable from one planning cycle to another despite the changes in the underlying data
between the cycles.

Example 1
Planning cycle 1; September 2002 has the following features:

• It is a statistical forecast generated for a scenario based on shipments.

• The forecast numbers for the customer sites are aggregated to the distribution 
centers that cater to the respective sites.

• Demand planners finalize the forecast which is used for operations planning.

Planning cycle 2; October 2002 has the following features:

• This is a new statistical forecast generated for the same scenario based on to date 
shipments, taken afresh from the order management or from the sales and 
distribution system.

• In between the cycles, the aggregation hierarchies have changed. Some customer 
sites do not exist any more and some other sites are now catered to by different 
distribution centers.

• The Cycle 1 forecast is required in order to compare with the Cycle 2 forecast.

Retaining old level values
After the data is collected from the source instance to the planning instance, the level 
values and the aggregation hierarchies have changed in the source instance. For 
example, the level value item A has an aggregation hierarchy where item A is rolled up 
to product category B. When the data is collected again, the old level values are retained
in the Demand Planning Server. 
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Persistent forecast scenarios
A previous cycle forecast can be used again in the next forecasting cycle for comparison 
despite the change in the underlying data. Even with in the same planning cycle, the 
aggregation hierarchies may change after generating the forecast in Oracle Demand 
Planning but before using the forecast for supply chain planning. However, demand 
planning scenarios which serve as independent demands can still be used for 
operations planning within the same cycle or later despite the changes in the 
underlying data. There is no change in setups or user procedures and the user is not 
required to do anything for this feature to take effect.

Limitations to scenario persistence
There are two limitations to scenario persistence:

• You cannot delete all the old data.

• The new data must be collected from the same source instance.

Purging data
As recent data is brought in to Oracle Demand Planning, the old data accumulates with 
time, and some of this accumulated data is not used any more. For example, if you use 
only the latest forecasts from your customers, the previous forecasts are redundant.

Oracle Demand Planning allows users to purge data, such as redundant data, for the 
preseeded as well as custom data streams. You can selectively delete unwanted data 
from a user interface for any specified time period.

Selective deletion of data
As fact and dimension data accumulates for an installation of the Demand Planning 
Server, you can purge unwanted data by selecting the fact data elements for deletion 
within an instance, such as bookings or shipments. This means that it is possible to 
delete shipment, booking, and manufacturing forecast data while keeping the 
remaining data for that instance intact. 

Some examples of selective purging of data are:

• Purge all the data for the years 1996 and 1997.

• Purge shipment data for the year 1999.

• Purge a specific price list.

• Purge a specific planning percentage, rather than just the corresponding scenario 
data.

• Purging a demand plan definition.
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Note: If you purge the dimension level values in demand planning,
you must reload/recollect all the data streams (fact data) and 
should rebuild the demand plan.

To purge data from the Demand Planning fact table:
1. Choose the Demand Planning System Administrator responsibility.

2. To open the Parameters window on top of the Purge Fact Data window, select 
Other > Purge Fact Data in the Navigator.

3. Complete the following Parameters:

• In the Instance field, select the instance from which you want to delete the data.

• Specify the From Date and To Date using the format DD-MON-YYYY.

You need to specify the purge data range in such a way that it covers the entire 
time period for booked dates as well as requested date.

• For the rest of the fields, select either Yes or No. Please note that for 
Manufacturing Forecast, Time Data, and Pricing Data, if you select Yes, you can
supply a subqualifier which are Forecast Designator, Calendar, and Price List, 
respectively. If you do not supply a subqualifier, all the data is deleted.
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• If you select Yes for Custom Data, you can supply two subqualifiers: data 
stream name and stream designator. 

• If you select Yes for Scenario Entries, you can supply three subqualifiers: 
Demand Plan, Scenario, and Revision in this order. This means that Scenario 
qualifies a Demand Plan with multiple Scenarios for a Demand Plan, and the 
Revision qualifies a Scenario with multiple Forecast revisions for a Scenario. If 
you do not supply a subqualifier at any level, all the data is deleted. For 
example, if you select Yes for Scenario Entries, but do not specify a Demand 
Plan, all the scenarios entries (forecasts) for all the demand plans will be 
purged. Since scenarios are instance independent, scenarios for all the other 
instances will also be deleted in addition to the scenarios of the specified 
instance.

Scenarios are instance independent. Thus, deleting scenario is not instance 
specific. If you delete a scenario or all scenarios when a specific instance has 
been specified, data for all the instances will be deleted. 

4. Select OK.

5. Select Submit.

To purge data from the Demand Planning staging tables:
1. Choose the Demand Planning System Administrator responsibility.

2. In the Navigator, select Collections > Purge Interface Tables to open the Parameters 
window.

Note: The interface tables are synonymous with staging tables.

3. Complete the following:

• Select the Instance Code from the LOV. This is the instance where the data is to 
be purged.

• Indicate Yes or No for Delete Rejected Records Only.

4. Select OK to open the Collection Utility window.
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5. Submit the concurrent request for Oracle Demand Planning Purge Program.

Purging demand plans
Demand plans that are no longer in active use should be purged. This saves disk space 
in the Demand Planning Server, which holds the demand entries that make up the 
output scenarios associated with a demand plan. 

You can purge a demand plan definition and the associated analytic workspace data 
(including output scenario data) at the same time. Or you can purge just the analytic 
workspace data associated with a demand plan, while retaining the demand plan 
definition and the output scenario data. You might do the latter if you can use the 
existing demand plan definition, possibly with minor modifications, for future demand 
planning activities. You would then save the effort of redefining an entire demand plan 
from scratch.

To purge a demand plan definition:
1. Choose the Demand Planning System Administrator responsibility.

2. In the Navigator, select Demand Plans.

3. In the Find Demand Plan window, choose the demand plan to be purged.

4. From the Edit menu toolbar, select Delete.

A warning message appears.
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5. Select Yes to open the Delete Plan window.

6. The Delete plan even if background Workflow processes are active checkbox causes
Oracle Demand Planning to delete the demand plan definition and the associated 
analytic workspace data, even if the Oracle Demand Planning forecasting cycle is 
currently in process and uploading the consensus forecast to the Demand Planning 
Server has not yet occurred. Do not check this box if, in this situation, you want the 
demand plan purge process to exit without deleting any demand plan data 
whatsoever. 

If you have built a cube for the plan definition, then the plan definition will only be 
deleted if the cube is purged successfully. If you have not built a cube for the plan 
definition, then the plan definition will be deleted.

7. Select OK. 

This launches a concurrent request to purge the demand plan and the associated 
analytic workspace data (including output scenario data).

To purge the Analytic Workspace data associated with a demand plan:
1. Choose the Demand Planning System Administrator responsibility.

2. In the Navigator, select Demand Plans.

3. In the Find Demand Plan window, choose the demand plan to be purged. 

4. From the Tools menu toolbar, select Purge Plan to open the Purge Plan window. 



8-40    Oracle Demand Planning Implementation and User's Guide

5. If you select Delete plan even if background Workflow processes are active, Oracle 
Demand Planning deletes the associated data in the analytic workspace even if the 
Oracle Demand Planning forecasting cycle is currently in process and uploading the
consensus forecast to the Demand Planning Server has not yet occurred. Uncheck 
this check box if in this situation you would like the demand plan purge process to 
exit without deleting any demand plan data.

6. Select OK. 

This launches a concurrent request to purge the analytic workspace data associated 
with the demand plan, but leaves the demand plan definition and associated output
scenario data intact.

Note: To delete specific output scenarios associated with a demand 
plan, use the procedure in Selective deletion of data, page 8-35.

Archiving and Restoring Demand Plans
Demand plans can be individually archived in the ODPDIR, the Demand Planning 
default directory. This feature allows you to backup active plans, and keep copies of 
plans that have been purged. Archived demand plans can be restored when required, 
and they function like a normal plan. You can schedule when specific plans are 
archived, backing them up periodically or on specific days.

Before starting the archive or restore processes, the Demand Planning system 
administrator should ensure that there is enough space before starting. The space 
required is at most as much as the demand plan occupied prior to being archived. 
When the plan is archived, it is saved with its plan ID. If the same plan is already 
archived, the old plan is overwritten. When plans are recovered, the recovered plan 
replaces the plan in Demand Planning. Archived plans that are no longer required can 
be deleted by the system administrator.

To archive a demand plan:
1. Choose the Demand Planning System Administrator responsibility.

2. In the Navigator, select Other > Requests > Submit a new request. The Submit a 
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New Request dialog box appears.

3. Specify Single Request and click OK.

4. In the Name field, select the concurrent program 'Archive demand plan'. The 
Parameters dialog box appears.

5. Select the demand plan you want to archive and click OK.

Select Submit. A message appears confirming that the request was submitted. 
Please note the Request ID. The Decision dialog box appears.

6. Select No to close the window to indicate that you do not want to archive another 
demand plan and to open the Find Requests window.

7. Choose All My Requests and click Find to open the Requests window, which lists 
the status of all the concurrent requests.
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The status of the archive demand plan is shown.

Note: The demand plan ID is listed in the parameters field, not the 
demand plan name.

The archive process writes the demand plan to a log named "arch[plan_id].log 
located in the ODPDIR, the default Demand Planning directory. The default 
directory is defined by the MSD:OLAP Directory Alias profile option. 

To recover a demand plan:
1. Choose the Demand Planning System Administrator responsibility.

2. In the Navigator, select Other > Requests > Submit a new request. The Submit a 
New Request dialog box appears.

3. Specify Single Request and click OK.

4. In the Name field, select the concurrent program 'Recover demand plan'. The 
Parameters dialog box appears.

5. Select the demand plan you want to recover and click OK.

Select Submit. A message appears confirming that the request was submitted. 
Please note the Request ID. The Decision dialog box appears.

6. Select No to close the window to indicate that you do not want to recover another 
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demand plan. The Find Requests window appears.

7. Choose All My Requests and click Find. The Requests window appear, which lists 
the status of all the concurrent requests.

The status of the recovered demand plan is shown.

Note: The demand plan ID is listed in the parameters field, not the 
demand plan name.
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9
Demand Plan Administration: Setting Up the

User Environment

This chapter covers the following topics:

• About Setting Up the User Environment

• Measures

• Calculating Dependent Demand for Input Parameters

• Events

• Planner Assignments

• Scenarios

• Comment Reason Codes

• Predefined Reports

• Workflow Settings

• Batch Log

• Collaboration History 

About Setting Up the User Environment
You use Demand Planning Administration to set up and maintain the environment for 
demand planners and the Demand Plan Manager. This includes the following 
functions:

• Measures — Define and maintain shared measures (including forecasts) for 
planners and the Demand Plan Manager.

• Scenarios — Set or change the default measure association for each scenario in the 
demand plan. Planners see this default when they submit a forecast for a scenario.
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• Events — Define and maintain factors such as promotions, product introductions, 
and product phase outs that are expected to have a quantifiable impact on demand. 

• Planner Assignments — Set up and maintain planner assignments. Assignments 
determine the dimension value combinations (measures and dimension values) that
will be visible to planners and the values that each planner is responsible for 
forecasting.

• Comment Reason Codes — Set or modify comment reason codes in the shared 
database. Planners and the Demand Plan Manager use these codes to enter 
comments when they modify data in worksheets.

• Predefined Reports — Set defaults for predefined reports and select the predefined 
reports for planners and the Demand Plan Manager.

• Workflow Settings — Set or change the number of Workflow engines to use when 
the Workflow background engines run Demand Planning deferred activities.

• Collaboration History — View a history of actions related to sharing data between 
users. 

• Batch Log — View detailed status information about stages in the forecast cycle 
that have run for the demand plan. 

Getting help
To view information that is specific to the current function, choose the Help button at 
the bottom of the page.

To access the full Oracle Demand Planning online Help system for Demand Plan 
Administration, choose the large Help button at the top of the page. 

You can use your browser's print function to print Help topics.

To close an open Help window, choose the Exit button at the top of the page. You will 
be returned to the current function. 

Accessing version and system information
To access version and system information, choose About Demand Planning at the 
bottom left of the page to access version and system information.

Measures
Input parameters such as such as Booking History and Customer Forecast are 
associated with a demand plan in the Demand Planning Server. Custom data streams 
might also be associated with the plan. When data is downloaded from the Demand 
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Planning Server these inputs are read into the shared database where they are stored as 
measures. 

You can use Demand Plan Administration to view input parameters. You can also use 
them as a basis to define new measures (including forecasts), edit measures, delete 
measures, and specify which measures should be rebuilt in the next planning cycle. 

When the Populate Measures stage runs, measures are populated in the shared database 
where they are available to the Demand Plan Manager. When a distribution runs, the 
shared measures become available to planners whose assignments include the 
measures. All assigned measures will be available to planners when a full distribution 
runs; only selected measures will be available when a quick distribution runs. Planners 
and the Demand Plan Manager use measures when they analyze data and select final 
forecasts to submit or upload. They can also use them as a basis for creating their own 
measures. 

Interface for maintaining measures as a Demand Plan Administrator
Use the main Demand Planning Administrator page to access the page for maintaining 
measures. 

To access the Demand Plan Administrator page for maintaining measures:
1. Log into Oracle Demand Planning as a Demand Planning System Administrator.

2. In the Navigator, choose Demand Plan Administration. 

Result: A list of demand plans appears; each is a link.

3. Select the plan with which you want to work by clicking the link for that plan.

Result: The Demand Planning Administrator page for the plan opens.

4. Choose Measures in the Navigation list.

Creating measures in Demand Plan Administration
You can define two types of measures: stored measures and formula measures.

Astored measure is avariable for which calculations and properties are permanently 
stored in the database. A formula measure calculates values on the fly and is not stored 
in the database.

To create a measure:
1. Access the Demand Plan Administrator page for maintaining measures. 

Result: Current measures and their source (Planning Server or Shared) are 
displayed in the grid.
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2. Choose New.

Result: The Create Measure dialog box opens.

3. Select the measure type: Stored or Formula.

Result: If you chose Stored, the Measure Wizard opens. If you chose Formula, the 
New Formula Measure dialog box opens. 

4. Define the measure using the Measure Wizard.

Editing measures in Demand Plan Administration
When you want to change some aspect of a measure, you can edit the measure 
definition. 

When the Populate Measure stage runs, modified measures are populated in the shared 
database where they are available to the Demand Plan Manager. 

When the Distribute to Planners stage runs, the modified measures become available to 
planners whose assignments include the measure. All assigned measures will be 
available to planners when a full distribution runs; only selected measures will be 
available when a quick distribution runs. 

To edit a measure: 
1. Access the Demand Plan Administrator page for maintaining measures. 

Result: Current measures and their source (Planning Server or Shared) are 
displayed in the grid.

2. Highlight the measure that you want to modify and choose Edit. 

Result: If you are editing a stored measure, a tabbed page opens. If you are editing 
a formula measure, the Edit Formula Measure dialog box opens.

3. To edit a stored measure use the tabs, the Next button, and the Back button to move
through the measure definition to make your changes. You can also change the 
measure name. 

If the measure is a stored accuracy measure or a measure from the Planning Server, 
you can only edit the measure name, specify the numeric format, and change the 
property that determines whether data for the measure will be editable in 
worksheets.

4. Choose Finish to save the measure.

5. To edit a formula measure, use the Edit Formula Measure dialog box to modify the 
formula. You can also change the measure name. 

Choose OK to save the measure. 
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Rebuilding measures in Demand Plan Administration
When you start a new planning cycle, measure definitions from the previous cycle are 
maintained in the shared database. 

A Rebuild option for each stored measure enables you to indicate whether the measure 
will be recalculated based on current data in the Demand Planning Server the next time 
that the Populate Measure stage runs. When you define a new stored measure, the 
Rebuild option is checked by default.

Note: You cannot explicitly rebuild a formula measure. However, if the 
stored measure on which the formula measure is based is rebuilt, then 
the dependent measures will also be rebuilt.

To understand the effect of rebuilding a measure, consider the case in which you define 
and distribute a measure that copies regions of data from two measures: History for Q1 
and Forecast for Q2. At the start of the next planning cycle the download process 
reloads your measure.

• If you rebuild this measure, then the measure will be recalculated using updated 
data from the measures on which the copy is based.

• If you do not rebuild the measure, then the measure will not be recalculated. The 
values for the previous cycle will persist through the next cycle.

To change the Rebuild option for a stored measure:
1. Access the Demand Planning Administrator page for maintaining measures.

Result: Current measures and their source (Planning Server or Shared) are 
displayed in the grid.

2. Identify the measure for which you want to change the Rebuild setting and take one 
of the following actions:

• To recalculate the measure in the new cycle using the updated data, check the 
Rebuild box. 

• To maintain the data values calculated for the previous cycle, clear the Rebuild 
box.

3. Choose Apply to save the current settings.

Viewing measure information in Demand Plan Administration
You can view information about measures.

For a Planning Server measure, the following properties are displayed:
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• Name — Measure name

• Transformation — None

• Source — Planning Server

• Type — Quantity, Amount, or Quantity and Amount

• Aggregate — Yes or No

• Allocate — Yes or No

• Editable — Yes or No

• Price List — None

• Events — None

• Lowest Allocation Levels — For each dimension, specifies the lowest level of each 
dimension to which data will be allocated

For a stored measure that is a forecast or a copy of one or more measures, the following 
properties are displayed: 

• Name — Measure name

• Transformation — Method used to create the measure; for example: Forecast

• Source — Shared

• Type — Quantity, Amount, or Quantity and Amount

• Aggregate — Yes or No

• Allocate — Yes or No

• Editable — Yes or No

• Price List — Price list name or None

• Events — Event names or None

• Lowest Allocation Levels — For each dimension, the lowest level to which data will
be allocated (depends on the data stream on which the forecast or copy is based) 

For a stored accuracy measure, the following properties are displayed: 

• Name — Measure name
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• Transformation Method — Accuracy 

• Source — Shared

• Accuracy Measure Type — Type of accuracy measure, for example, Mean Absolute 
Percentage Error (MAPE)

• Base Measure — Base measure for accuracy calculation 

• Comparison Measure — Comparison measure for accuracy calculation

• Editable — Yes or No

For a formula measure, the following properties are displayed:

• Name — Long name for the measure

• Transformation — Formula

• Source — Shared

To view information about a measure:
1. Access the Demand Planning Administrator page for maintaining measures.

Result: Current measures and their source (Planning Server or Shared) are 
displayed in the grid.

2. Highlight the measure for which you want to view information and choose 
Properties.

Result: Measure information is displayed.

3. Choose OK to exit.

Deleting measures in Demand Plan Administration
When you no longer want users to have access to a measure, you can delete the 
measure definition. 

The Demand Plan Manager will lose access to the measure the next time that he or she 
logs in to Oracle Demand Planning. Planners will lose access to the measure the next 
time that the Demand Plan Administrator runs a full distribution.

Note: Before you delete a measure, ensure that your user community 
does not maintain saved objects that reference the measure. Failure to 
do so can cause warning messages and errors to occur when users work
with reports, graphs, worksheets, or alerts that contain the deleted 
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measure.

To delete a measure:
1. Access the Demand Plan Administrator page for maintaining measures. 

Result: Current measures and their source (Planning Server or Shared) are 
displayed in the grid.

2. Highlight the measure that you want to delete and choose Delete.

Result:You are prompted to confirm the deletion.

3. Choose OK to delete the measure.

Calculating Dependent Demand for Input Parameters
The Demand Planning System Administrator can enable dependent demand for input 
parameters. This enables users, in both customer and manufacturing forecasts, to 
explode the independent demand of a model to the options' dependent demand.

Enabling Dependent Demand for Data Streams
If you are logged in as the Demand Planning System Administrator, you can calculate 
dependent demand for a data stream by following the procedure described below.

1. From the Navigator for the System Administrator, select Setup.

2. Select Data Streams.

3. Select Define -- Advanced.

4. In the Define Data Stream - Advanced form, choose a data stream.

5. Click Next to display the Define Characteristics form.

6. Check the Dependent Demand box.

7. Select Read or Calculate.

• Select Read when the data stream already contains dependent demand data. 
This is often appropriate for sales history data streams when they contain the 
dependent sales history of options and option classes. Booking history and 
shipment history can also contain dependent demand data. They are set to 
bring the dependent demand (Read) by default. Custom data streams can be 
used to read dependent demand data.
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• Select Calculate when the data stream does not contain dependent demand 
data. No data stream is set to calculate the dependent demand by default. 

Data streams that include only independent demand for models should be 
exploded to the options and option classes on the basis of model bills of 
material and existing planning percentages, both of which are collected from 
the source ERP. 

• The Demand Planning System Administrator must also check the Calculate 
Demand Plan box in the Demand Plans form. If these selections are not made, 
bills of materials, planning percentages, or dependent sales history will not be 
used by the Demand Planning Engine for that demand plan. 

Enabling Dependent Demand for Demand Plans
The Demand Planning System Administrator enables dependent demand calculations 
for a demand plan by checking a box on the Demand Plans form.

If this option is not selected for a particular plan, the following will be not available for 
use in the Demand Planning Engine: bills of materials, planning percentages, 
dependent sales history.

If you are logged in as the System Administrator, you can calculate dependent demand 
for a data stream by following the procedure described below.

1. From the Navigator for the System Administrator, select Demand Plans.

2. Select the appropriate organization from the LOV. 

3. Select a demand plan. 

4. In the Demand Plans form, check the Calculate Dependent Demand box. 

5. Click in the Explode Demand Using box. 

6. Select a mode of exploding the forecast, as described below.

• Organization-specific Bills of Material - This choice enables the planning 
percentage to be applied to the organization that was selected from the LOV. 

• Global Bills of material - This choice determines that the same planning 
percentages are used for all the inventory organizations. 

Events
Events are factors such as promotions, product introductions, and product phase outs 
that are expected to have a quantifiable impact on demand. 
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Global events may be associated with scenarios and demand plans in the Demand 
Planning Server. When data is downloaded from the Planning Server, these events are 
read into the shared database. You can use Demand Plan Administration to view global
events. You can also define new events, edit events, delete events, and apply event 
factors to measures.

When the Populate Measures stage runs, events are populated in the shared database 
where they are available to the Demand Plan Manager. When a distribution runs, 
events become available to planners. All events will be available when a full 
distribution runs; only events associated with distributed measures will be available 
when a quick distribution runs. Planners and the Demand Plan Manager can apply the 
events to measures and use them as a model for creating their own events.

Note: Events are downloaded with four user dimensions: geography, 
product, time, and organization. Collapsed dimensions like demand 
class are downloaded as a hierarchy of one of the user dimensions (like 
geography). Although the event works with the collapsed dimension, 
the collapsed dimension name is not shown as the event qualification in
the shared database.

Interface for maintaining events in Demand Plan Administration
Use the main Demand Planning Administrator page to access the page for maintaining 
events.

To access the Demand Plan Administrator page for maintaining events:
1. Log into Oracle Demand Planning as a Demand Planning System Administrator.

2. In the Navigator, choose Demand Plan Administration. 

Result: A list of demand plans appears.

3. Select the demand plan that you want to work with, scroll to the bottom of the 
page, and choose Start Demand Planning. 

Result: The Demand Planning Administrator page for the plan opens.

4. Choose Events in the navigation list.

The Demand Planning Administrator page for maintaining events opens. 

Creating events in Demand Plan Administration
You can define three types of events: promotions, product introductions, and product phase 
outs.

• A promotion is an event that is expected to impact demand for an existing product. 
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• A product introduction is an event for a product that does not have any historical or
forecast data, but for which you anticipate that sales will be similar to some product
or products that have a known history or forecast. 

• A product phase out is an event for an existing product for which sales are expected
to become flat or be reduced to zero. 

To create an event:
1. Access the Demand Plan Administrator page for maintaining events.

Result: Existing events and their source (Planning Server or Shared) are displayed 
in the grid.

2. Choose New.

Result: The Event Wizard -- Name page opens.

3. Use the Event Wizard to define the event.

Modifying events in Demand Plan Administration
When you want to change some aspect of an event, you can edit the event. When the 
Distribute to Planners stage runs, modified events become available to planners. All 
event modifications will be available when a full distribution runs; only modified 
events that are associated with distributed measures will be available when a quick 
distribution runs. 

To modify an event: 
1. Access the Demand Plan Administrator page for maintaining events. 

Result: Existing events and their source (Planning Server or Shared) are displayed 
in the grid.

2. Highlight the event that you want to modify and choose Edit. 

Result: A tabbed page opens. 

3. Use the tabs, the Next button, and the Back button to move through the event 
definition and make the desired changes. You can also change the event name.

Note: You cannot change the event type.

4. Choose Finish to save the event.
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Deleting events in Demand Plan Administration
When you no longer want users to have access to an event, you can delete the event.

The Demand Plan Manager will lose access to the event the next time that he or she logs
in to Oracle Demand Planning. Planners will lose access to the event the next time that a
full distribution runs.

Note: Before you delete an event, ensure that your user community 
does not maintain measures that reference the event. 

To delete an event:
1. Access the Demand Plan Administrator page for maintaining events. 

Result: Existing events and their source (Planning Server or Shared) are displayed 
in the grid.

2. Highlight the event that you want to delete and choose Delete.

Result:You are prompted to confirm the deletion.

3. Choose OK to delete the event.

Applying events to measures in Demand Plan Administration
As you define a measure, you have the option to apply one or more events, event 
groups, or a combination of events and event groups to the measure. 

If you apply an event to a measure before a distribution runs, the distributed measure 
will include the event factor. 

If you apply an event after a distribution runs, the measure will not include the event 
factor until the measure is repopulated. Similarly, if you modify an event that has been 
applied to a measure after distribution, the modification will not take effect until the 
measure is repopulated. 

Planner Assignments
Planner assignments determine the dimension value combinations (measures and 
dimension values) that each planner can forecast and view. In a collaborative planning 
environment, assignments also establish the areas in which planners can collaborate. 

When you run a distribution, the data slices defined by assignments are created in 
planners' personal databases. A full distribution distributes all data. A quick 
distribution distributes updates to selected measures.
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Note: When you choose values for planner assignments, you select 
measures as well as values from the other dimensions. If you want to 
define new measures or edit measures, do so before you set up 
assignments.

Users can collaborate on assignments
You can set up assignments so that planners are responsible for forecasting specific 
slices of the data, but yet can view the work of planners who are forecasting other 
values. You establish areas of collaboration by setting view scopes and assignment scopes. 
The view scope includes all of the combinations (measures and dimension values) that 
will be visible in the planner's personal database. The assignment scope includes all of 
the combinations (measures and dimension values) that the planner is responsible for 
forecasting and submitting to the shared database. As planners modify their forecasts, 
they can use collaboration tools to share updated values in their assignment scopes with
the Demand Plan Manager and with other planners who have the values in their view 
scopes. 

For example, you might set up assignments so that Planner A is responsible for 
forecasting one set of products, but can view data (and shared updates to that data) for 
another set of products, for which Planner B is responsible. Planner B can view Planner 
A's data (and shared updates to that data) but can only submit forecasts for products in 
his or her assignment scope. This example is a simple one; in reality, you can set up 
assignment scopes and view scopes to support your business needs. 

Note: If planners will be collaborating, ensure that you inform them 
about the extent of their scopes. Although a planner will be able to view
and modify data that is in his or her view scope, only the data in the 
assignment scope will be submitted to the shared database and shared 
with other planners. 

Cautions to observe when dependent demand is enabled
Do not break out planner assignments by geography and assign identical product sets. 
Planning percentages are not dimensioned by Geography; that is, they are not 
calculated based on the geographic level values. If planner assignments are broken out 
by geography, then every planner will be modifying the global planning percentages. 

Also take dependent demand into account when setting up assignment scopes and view
scopes in a collaborative environment. Planners who share items that are related 
through dependent demand should be able to view each other's items (view scope), but 
should only be able to submit data for their own items (assignment scope). If a planner 
is responsible for options while another is responsible for its parent model, the parent 
model should be in the view scope of the first planner and in the edit scope of the 
second planner.
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Interface for working with planner assignments as a Demand Plan Administrator
Use the main Demand Planning Administrator page to access the page for maintaining 
planner assignments.

To access the Demand Plan Administrator page for maintaining planner assignments:
1. Log into Oracle Demand Planning as a Demand Planning System Administrator.

2. In the Navigator, choose Demand Plan Administration. 

Result: A list of demand plans appears.

3. Select the demand plan that you want to work with, scroll to the bottom of the 
page, and choose Start Demand Planning. 

Result:The Demand Planning Administrator page for the plan opens.

4. Choose Demand Planner Assignments in the navigation list.

The page for maintaining planner assignments opens.

Example: Demand Plan Administrator page for maintaining planner assignments
Consider an example, where you specify the State level for the Geography dimension. 
In that case, assignments for all planners will be some set of available states. Planners 
will have access to all data below the specified level. If an assignment consists of 
multiple values, then planners will also have access to data above the specified level.
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Setting levels for assignments
Before you assign data to individual planners, you must specify the default level at 
which assignments for all planners will be created in each dimension other than Time 
and Measure. 

Before setting levels for assignments, use the Demand Plan Administration> Measures> 
Properties option to view the lowest allocation level for each measure that you intend to
include in planners' assignments. If you set the default assignment level below the 
allocation floor for a dimension, then the measure will not be distributed to planners. 

Note: Ensure that you set levels before you create planner assignments. 
If you change the level setting for a dimension after you assign data to 
planners, then you will have to re-enter all assignments.

To specify levels for planner assignments:
1. Access the Demand Planning Administrator page for maintaining planner 

assignments.

2. Choose Settings. 

Result: The System Settings dialog box opens. Each of the dimensions in your 
database, other than Time and Measure, is present in the dialog box.
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3. In each dimension box, select a level.

You can select the level that currently appears in the box for each dimension or you 
can click the arrow in each box to display a list of levels and select a level from the 
list.

4. When you have selected a level for each dimension, choose OK.

Creating assignments
When you create an assignment you choose values for the planner's assignment scope 
and view scope. The view scope includes all of the dimension value combinations 
(measures and dimension values) that will be visible in the planner's personal database. 
The assignment scope includes all of the dimension value combinations that the planner
is responsible for forecasting and submitting to the shared database. 

A planner can have more than one assignment.

To create an assignment:
1. Access the Demand Planning Administrator page for maintaining planner 

assignments.

2. Choose New.

Result: A new assignment row appears in the grid. The Name column displays an 
entry called "Untitled Assignment." Your Oracle user ID appears in the Owner 
column. 

3. In the Name column for the new assignment, enter a name up to 70 characters long. 

4. In the Owner column for the new assignment, select the user ID of the planner who 
will have the assignment. 

5. To select values for the planner's assignment scope (the values that this planner will
forecast and submit to the shared database), choose the Edit button next to the 
Assignment scope of selected item box.

Result: The Select Data dialog box opens. The Available box lists values for a 
dimension in your database. 

Note: It is not mandatory to select values for the assignment scope. 
For example, if you want an individual to be able to review but not 
submit data, then you can select values for the view scope, but 
leave the assignment scope empty.

1. Choose values for the current dimension by moving values between the 
Available box and Selected box until the Selected box displays the values that 
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you want to keep for the current dimension. 

Note: You must select one or more values for this dimension 
before you can select values for another dimension.

2. In the Select Values for box, choose another dimension and repeat the previous 
step.

3. Choose OK to save the current selections. The OK button is enabled only if the 
assignment scope includes selections for each dimension including Measure. 

Note: For Measure, you can select stored measures, forecast 
measures, and input parameters from the Demand Planning 
Server. If you do not want users to collaborate on a measure, do
not include that measure in assignment scopes. For example, 
you might exclude input parameters from planners' assignment
scopes, but make them available in planners' view scopes.

Result: You are returned to the page for maintaining planner assignments. 

A red flag to the left of an assignment indicates that the assignment scope 
includes one or more dimension value combinations that are in the assignment 
scope for another owner. 

6. To select values for the planner's view scope (the values that this planner will view),
in the View scope of selected assignment box proceed as follows:

1. If you want to make the values in the planner's view scope identical to the 
values in his or her assignment scope, choose Synchronize (this is the default 
for a new assignment). 

2. To choose values for the planner's view scope that are not identical to those in 
the user's assignment scope, choose the Edit button next to the View scope of 
selected item box. 

Result: The Select Data dialog box opens. The Available box lists values for a 
dimension in your database. 

3. Choose values for the current dimension by moving values between the 
Available box and Selected box until the Selected box displays the values that 
you want to keep for the current dimension. 

4. To change the values for another dimension, repeat Steps c and d.

Note: You might save time by initially synchronizing the view 
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scope with the assignment scope. Then add and remove values 
as desired. 

5. Choose OK to save the current selections. The OK button is enabled only if the 
view scope includes selections for each dimension including Measure. 

Automatic Assignment Maintenance
When you are working with the Assignments page of the Demand Plan Administrator 
interface, you can use chose settings for Collaboration Options. One of these options 
lets you automatically maintain assignments using dependent demand.

Automatic assignment maintenance is controlled by an option on the Demand Plan 
Administrator's Assignments page. The checkbox label says, Automatically maintain 
assignments using dependent demand.

The checkbox is only visible if dependent demand is enabled for the plan. It is on by 
default. When the System Administrator enables it, it impacts scopes assigned in the 
future, as opposed to those that have already been assigned.

Dependencies and dependent demand data are visible for a planner's assignment items.
If items in a planner's assignment or view scope are dependent on other items, the 
parent items are automatically added to the planner's view scope. 

For example, if a new item, Option2, is added to the planner's assignment scope, and 
that item is dependent on Model2, which has not been explicitly added to the 
assignment, then Model2 will automatically be added to the planner's view scope at the 
time of planner distribution, because Option2 is dependent on it.

If an item is dependent on more than one item, all the parent items will be added to the 
view scope. These relationships exist through more than one level. In other words, if an 
item is dependent on multiple levels of items, then parent values through all levels of 
dependencies are added to the assignment.

The ability of a planner to see, in the view scope, all the values that are ancestors or 
parents of the values in the assignment scope is an important factor in explaining how 
data totals are derived. This is important, for example, in aggregation.

It is important to note that the parent-child relationships remain operational for the 
purposes of deriving data even if the other collaboration option, limiting a planner to 
the assignment scope, is checked. In this case, the values in a planner's view scope that 
are related to values in the assignment scope are used in all calculations – they are just 
not visible in worksheets or in the Select Data dialog box.

How to Set Up Automatic Assignment Maintenance
Follow the procedure below to set up automatic assignment maintenance for demand 
planners.
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1. Log into Demand Planning as a System Administrator.

2. In the page for Demand Planning Administration, select the option for Demand 
Planner Assignments. This is the function that lets you set up and maintain planner
assignments by selecting the dimension value combinations that will be visible to 
planners. It also lets you select the values that each planner will be responsible for 
forecasting.

3. The Demand Planner Assignments page shows the names, owners, and scopes of 
assignments in your plan. Select the assignment with which you want to work and 
choose Settings to access the System Settings dialog box.

4. If the assignment is for a plan in which dependent demand has been set for the data
stream or measure, you can see, in the Collaboration Options frame, a checkbox 
labeled Automatically maintain assignments using dependent demand. This 
checkbox determines whether new items are automatically added to the planner's 
assignments according to dependent demand relationships.

If you choose the Automatic option, the planner's assignments are maintained 
according to the assignment selections of the administrator. 

5. If a dependent item is added to the planner's assignment scope, then an assignment 
maintenance process runs automatically when you exit the Select Data dialog box. 
That process adds the dependent item's parent item or items to the assignment 
scope. 

If a dependent item is added to the planner's view scope, then an assignment 
maintenance process runs automatically when you exit the Selector; it adds the 
dependent item's parent item or items to the view scope.

6. If assignments are created at the item level of the product dimension, dependent 
parents will be considered at that level. 

If assignments are created at a higher level of the product dimension, the 
descendants of the assigned dimension values will be considered. 

Once any dependent parents of all descendants are determined, the ancestors of 
those items at the assignment level will be automatically added to the assignment.

Assignment-Scope-Specific Planning
The Administrator's interface for demand planning assignments has a collaboration 
option that limits planners to a particular scope. If the administrator chooses the option 
of assignment-scope-specific planning, only dimension values in the assignment scope 
will be available to planners. In this case, the behavior described in the following 
paragraphs will apply.

In standard documents, such as worksheets, reports, and graphs, the planner can access
and manipulate only dimension values in the assignment scope. Dimension values that 
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are only in the planner's view scope are not displayed in these documents.

• Selecting Data: Only dimension values in the planner's assignment scope are 
available in the Select Data dialog box.

• Aggregation: Parent totals for dimensions in the assignment do not include data for 
values that are in the view-only scope or are otherwise outside the assignment 
scope.

Data for dimension value combinations that are only in the view scope will never 
aggregate above the leaf level.

• Allocation: Edits made to higher levels do not allocate down to view-only values.

• Locking: View-only dimension values are automatically locked in worksheets.

• Planning Percentages Worksheet: In the planning percentages worksheet, the planner 
has full selection and data visibility. In other words, view scope dimension values 
are visible, and dependent demand data can be calculated from view scope data.

Setting Up Assignment-Scope-Specific Planning
To transform a planner's assignment into a scope-specific assignment, you use the 
procedure outlined above in the topic Automatic Maintenance of Scopes, page 9-18.

When you have accessed the Collaboration Options frame in the System Settings 
dialog box, check the box labeled Limit planners to assignment-scope-specific 
planning.

When you leave the System Administration page, any changes that you have made in 
regards to planners' scopes will not take place until the demand plan in question is 
rebuilt and the measures are distributed.

Editing assignments
Edit an assignment when you want to change dimension values, including measures, 
that are currently in a planner's assignment scope or view scope. For example, you 
might edit assignments when you want to give planners access to a new measure that 
has been created by the Demand Plan Manager. 

Edits take effect when a distribution runs. A full distribution distributes all changes. A 
quick distribution distributes modifications to measures that have been selected for 
distribution. 

To edit an assignment: 
1. Access the Demand Planning Administrator page for maintaining planner 

assignments.

2. To change the values in a planner's assignment scope (the values that this planner 
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will forecast and submit to the shared database), choose the assignment that you 
want to change and then choose the Edit button next to the Scope of assignment 
box. 

The Select Data dialog box opens, showing the current selections for the assignment
scope for each dimension including Measure. Proceed as follows: 

1. In the Select values for box, choose the dimension for which you want to 
modify values.

2. Choose values for the dimension by moving values between the Available box 
and Selected box until the Selected box displays the values that you want to 
keep for the current dimension. 

3. To change the values for another dimension, repeat Step 2.

4. Choose OK to save the current selections. 

Note: If you add new values to the assignment scope, the same 
values will automatically appear in the view scope. You can 
then decide whether to keep or remove them.

3. To change the values in a planner's view scope (the values that this planner will 
view), choose the assignment that you want to modify. 

1. If you want to make the values in the planner's view scope identical to the 
values in his or her assignment scope, choose Synchronize. 

2. To choose values for the planner's view scope that are not identical to those in 
the user's assignment scope, choose the Edit button next to the View scope of 
selected item box. 

Result: The Select Data dialog box opens. 

3. In the Select Values for box, select a dimension for which you want to change 
value selections. 

4. Choose values for the current dimension by moving values between the 
Available box and Selected box until the Selected box displays the values that 
you want to keep for the current dimension. 

5. To change the values for another dimension, repeat Steps c and d.

6. Choose OK to save the current selections. The OK button is enabled only if the 
view scope includes selections for each dimension including Measure. 
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Changing assignment names
You can give a new name to an assignment. The change takes effect immediately. A 
distribution is not required. 

To change the name of an assignment:
1. Access the Demand Planning Administrator page for maintaining planner 

assignments.

2. Identify the assignment whose name you want to change.

3. In the Name column, enter a new name, up to 70 characters long.

Changing assignment owners
As the result of staff changes or reassignments, you might want to enable a user to 
access an assignment that is currently associated with another owner. The change takes 
effect immediately. A distribution is not required.

To change the owner of an assignment:
1. Access the Demand Planning Administrator page for maintaining planner 

assignments.

2. Identify the assignment whose owner you want to change.

3. In the Owner column, select the user ID for the planner who will have this 
assignment.

Viewing unassigned data
You can view data values that have not yet been assigned to any planner's view scope. 

To view unassigned data:
1. Access the Demand Planning Administrator page for maintaining planner 

assignments.

2. Choose Unassigned.

Result: The Unassigned Data Slices dialog box opens, displaying data slices that 
have not been associated with any planner's view scope.

Checking assignments for overlapping values
As you create assignments, you can identify check to see if there are planners who have 
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dimension value combinations in their assignment scopes that overlap with values that 
have been assigned to other planners. 

Note: Overlapping values are technically allowed, but are not 
recommended as sound business practice. This is because data values 
that are submitted to the shared database by one planner will be 
overwritten by another planner's data for those values where their 
assignment scopes intersect.

To check for overlapping values in assignments:
1. Access the Demand Planning Administrator page for maintaining planner 

assignments.

2. Choose Refresh. 

Result: A red flag appears in the column next to any assignment for which the 
assignment scope includes value combinations (dimension values and measures) 
which are the same as the values in another user's assignment scope. 

Deleting assignments
You can delete a planner's assignment. The planner who is associated with the 
assignment immediately loses access to the data slice.

To delete an assignment:
1. Access the Demand Planning Administrator page for maintaining planner 

assignments.

2. Highlight the assignment that you want to delete.

3. Choose Delete. 

Scenarios
A scenario is a repository for maintaining, archiving, and viewing the final forecasts for 
a demand plan. There are scenarios defined for each demand plan. If your organization 
requires an optimistic, a pessimistic, and a realistic forecast, for example, these scenarios
might be part of a demand plan definition. The demand plan is created by the System 
Administrator.

A planner can submit a forecast for each scenario in the demand plan. It can be a 
baseline forecast or a personal variant.

Although scenarios become a repository for the final forecasts in a demand plan, they 
are present during much of the planning cycle, and have a role in the cycle that changes 
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over time, as described below.

Default Measure Associations
The System Administrator uses the Scenarios screen in the Administrator interface to 
specify the default measure association for a scenario. The measures from which the 
selection is made are part of the plan definition. Because of the need for a default 
association value, a baseline forecast is often used. The default association, for example, 
may be "Forecast of Booking History."

• A copy of the default measure associated with the scenario is often used as the 
initial Submissions measure.

• You can think of a scenario, at the beginning of the planning process, as a 
placeholder for the forecasts that will subsequently be created. 

If a planner using this plan later decides not to submit a forecast for the scenario, the 
data will not be collected.

Scenarios and Submissions
If an input parameter such as a history, previous forecast, or custom data stream has 
been associated with a scenario in the Demand Planning Server, this association is 
downloaded to the shared database when the Download from Planning Server stage 
runs.

Note: The Demand Planning System Administrator can use the 
Scenarios function to change the default measure that planners see 
when they submit data for a scenario, or to set a default if there is no 
default. However, once a Submissions measure exists, changing the 
default measure association or its properties in the Demand Plan 
Administrator's module does NOT automatically create a new 
Submissions measure or change the existing Submissions measure.

After planners generate forecasts for their assignments, each planner selects final 
forecasts to submit to the shared database. The Planning Manager reviews the 
submission measure before the manager or the System Administrator uploads the 
consolidated forecast to the Demand Planning Server. This process is described in detail
in the chapter for "Selecting Measures to Submit or Upload." The submissions measure 
is now no longer a placeholder, but a repository of forecast data that can be maintained,
viewed, and archived.

Example: Demand Plan Administrator page for working with scenarios
The scenarios section of the Demand Plan Administrator page allows you to set or 
change the default measure for a scenario and view scenario properties.
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Setting a default measure for a scenario
Set a default measure for a scenario when you want planners to see a specific default 
when they submit data for that scenario. 

When you change the default measure for a scenario, remember that you will not 
change an existing Submissions measure.

To set the default measure for a scenario:
1. Access the Demand Planning Administrator page.

2. In the navigation list, choose Scenarios.

The Administrator's interface opens to the page for working with scenarios.

The Scenarios/Default Measure Association grid displays a row for each scenario in the
demand plan. 

• The Default Measure Association column shows the current default measure for 
each scenario in the demand plan.

• If there is no default measure for a scenario, the Default Measure Association is 
set to "None."
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3. Double-click the Default Measure Association column for the scenario for which you 
want to set a default measure.

A list of available measures appears. 

4. Select a measure from the list.

The measure that you selected is now displayed as the default measure for the 
scenario.

5. Choose Apply to save the current settings.

Scenarios and Data Collection
Demand planners submit final forecast numbers for each scenario in the demand plan. 
The data is marked for consolidation in the shared database, where it will be reviewed 
by the Planning Manager.

Planners accomplish this by using the Submit Measures dialog box, accessed from the 
Submit Measures command on the Tools submenu.

The Planning manager, after reviewing the data, uploads the submissions measure to 
transfer the data to the Planning Server.

The Planning manager accomplishes the upload by using the Upload Measures dialog 
box, accessed from the Upload Measures command on the Tools submenu.

Before the Submissions measure is uploaded, the Planning Manager can remove 
cycle-persistent locks that planners have placed on the submitted measures.

Viewing scenario properties
You can view the following information about the properties that have been associated 
with a scenario in the Demand Planning Server:

• Name 

• Horizon Range

• Accuracy Measure Type

• Upload Measure (if measure has been uploaded)

• Output levels for each dimension

To view scenario properties:
1. Access the Demand Planning Administrator page.

2. In the navigation list on the Demand Planning Administrator page, choose 
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Scenarios.

Result: The page for working with scenarios opens. The grid displays a row for each
scenario in the demand plan. 

3. Select the row for the scenario whose information you want to view and choose 
Properties. 

Alternatively, you can double-click the Scenarios column.

Result:Scenario properties are displayed.

4. Choose OK to exit.

Comment Reason Codes
As planners and the Demand Plan Manager adjust forecast data in worksheets, they can
enter free text to describe modifications that they have made to a cell or group of cells. 
Each text entry must be associated with a comment reason code, which categorizes the 
reason for the modification. Use the Comment Reason Codes function to set up and 
maintain these codes in the shared database. 

Note: Users will only be able to enter comments if you have defined 
comment reason codes. If you expect to implement commenting, you 
must define comment codes before distributing data.

Comments persist in Oracle Demand Planning across planning cycles when the 
following conditions are met:

• The measure that includes the comment is submitted for a scenario by the planner 
and the submission measure is not deleted.

• The comment is at the same level as the output level specified for the scenario in the
Planning Server Plan Definition form.

Example: Demand Plan Administrator page for maintaining comment reason codes
The Comment Reason Codes section of the Demand Plan Administrator page allows 
you use to view, define, edit, and delete comment reason codes.
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Defining a comment reason code
Define a comment reason code when you want to provide a designation that planners 
and the Demand Plan Manager can use to annotate data modifications in a worksheet. 

To define a comment reason code:
1. Access the Demand Planning Administrator page.

2. In the navigation list on the Demand Planning Administrator page, choose 
Comment Reason Codes.

Result: The page for maintaining comment reason codes opens, displaying current 
codes.

3. Choose Add.

Result: A blank row appears in the Reason area.

4. In the blank row, type the text for the code. The text can be up to 70 characters long.

5. Choose Apply to save the current settings.

Modifying a comment reason code
Modify a comment reason code when you want to change a code that planners and the 
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Demand Plan Manager use to annotate data modifications in a worksheet. 

To modify a comment reason code:
1. Access the Demand Planning Administrator page.

2. In the navigation list on the Demand Planning Administrator page, choose 
Comment Reason Codes.

Result: The page for maintaining comment reason codes opens, displaying current 
codes.

3. Select the row for the code that you want to edit and modify the text. The text can 
be up to 70 characters long

4. Choose Apply to save the current settings.

Deleting a comment reason code 
Delete a comment reason code when you no longer want planners and the Demand 
Plan Manager to use the code.

To delete a comment reason code:
1. Access the Demand Planning Administrator page.

2. In the navigation list, choose Comment Reason Codes.

Result: The page for maintaining comment reason code opens, displaying current 
codes.

3. Select the code that you want to delete and choose Delete. 

Result: The code is immediately deleted. You are not prompted to confirm the 
action. 

Predefined Reports
Predefined reports are documents that enable users to conduct structured business 
analyses along a specific dimension. Two special Forecast reports enable users to 
evaluate the accuracy of their forecasts. 

Use the Predefined Reports function to specify the settings for predefined reports and 
select the reports that you want to make available to your user community. 

You perform two functions to set up predefined reports: 

• Specify default hierarchy, measure, and dimension settings. These settings 
determine the defaults that appear in each predefined report. 
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• From among all of the predefined report types that the application provides, select 
the reports that will be available to your users. All users will have access to these 
reports.

Note: You must specify default settings before you select reports. If 
you reverse the order, the predefined reports will not function 
properly.

Specifying default settings for predefined reports
Specify default report settings to establish the defaults that planners and the Demand 
Plan Manager will initially see for predefined reports. 

To specify default settings for predefined reports:
1. Access the Demand Planning Administrator page.

2. In the navigation list, choose Predefined Reports.

3. From the submenu, choose Default Report Settings. 

Result: The page for setting defaults for predefined report opens, displaying current
default settings. 

4. In the Hierarchy box, select the time hierarchy that you want to use. 

Note: If the demand plan has a single Time hierarchy, then you 
cannot select a hierarchy.

5. In the Year Level, Quarter Level, and Month Level boxes, use the arrows to select 
the time levels that you want to use. 

You can select Year, Quarter, and Month, or, if your Time hierarchy is not 
structured precisely in terms of these levels, you can select three levels in 
descending order, such as Quarter, Month, and Week.

6. In the Base box, select the base measure for all predefined reports. This is the default 
measure that will be displayed when a document focuses on a single measure. 

7. In the Comparison box, select the comparison measure. This is the default comparison
measure that will be displayed when a document compares two measures. 

8. Choose Apply to save the current settings.
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Selecting predefined reports 
Selecting predefined reports determines the set of documents that will be available to 
planners and the Demand Plan Manager, and specifies the dimensions for which each 
document will be generated. 

Note: The documents that you select will be available to all of your 
users. You cannot select specific documents for individual users.

To select predefined reports:
1. Access the Demand Planning Administrator page.

2. In the navigation list, choose Predefined Reports.

3. From the submenu, choose Report Selection. 

Result: The page for selecting predefined reports opens. The list displays all 
document types. 

4. Check the box in the Available column beside each document that you want to 
select.

5. For each document that you select, specify the dimension or dimensions for which 
you want to generate the document by checking the box where a report and 
dimension coincide.

6. Choose Apply to save the current settings.

Note: Some documents, because of the nature of the information 
that they are set up to display, are generated with default values. 
For these documents, you cannot select the dimensions on which 
you want to base these reports.

Types of predefined reports
Following is a list of the predefined reports that you can select for your user 
community. The documents are grouped according to the name of the folder in which 
they appear in the navigation list when a user logs in with the responsibility of Demand
Planner or Demand Plan Manager.

• Comparison folder

Comparison document — Compares two dimension values for specified time 
periods. The comparison is based on a specified measure. The analysis shows 
difference and percentage difference. 
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Percentage Share document — Compares a dimension value to its aggregate for 
specified time periods. The comparison is based on a specified measure. The 
analysis shows percentage share.

• Distribution folder

Increasing/Decreasing Demand document — Identifies dimension values for 
which activity has increased or decreased by a specified percentage between two 
time periods. Activity is based on average values for a specified measure. The 
analysis shows difference and percentage difference.

• Exception folder

80/20 Rule document — Display dimension values that show a specified percentage
of activity within specified time periods, such as the top 20% of the products that 
drive 80% of the value (often identified as Category A products in ABC 
classification). Activity is based on a specified measure. The analysis shows 
cumulative percentage. 

• Forecast folder

Comparison Accuracy document — Compares two measures for specified time 
periods and quantifies the difference and percent difference between them. Includes
statistics for MAD, MAPE, RSME, S.D, AV, C.V. 

Aged Accuracydocument — Quantifies the accuracy of a specific measure over a 
specified lag or lead time range. Includes statistics for Minimum., Maximum, MAD,
AV, and MAPE.

For more information and examples of Forecast documents, see "Comparison 
Accuracy Document", page 16-3 and "Aged Accuracy Document", page 16-5

• Growth folder

Growth document — Shows the difference in a dimension value's performance 
between two time periods. Performance is based on a specified measure. The 
analysis shows amount change and percentage change. 

• Ranking folder

Ranking document — Ranks dimension values in terms of performance during 
specified time periods. Performance is based on a specified measure. The analysis 
shows the share of total. 

Top/Bottom document — Ranks a specified number of top or bottom dimension 
values for two time periods in terms of performance. Performance is based on a 
specified measure. The analysis shows difference and percentage difference. 

• Trend folder

• Moving Average/Total document — Shows moving averages and totals for 
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specified dimension values over a series of time periods. The averages and 
totals are based on a specified measure. 

• Trend document — Shows performance trends within a specified time range 
for specified dimension values. Performance is based on a specified measure.

Workflow Settings
Oracle Demand Planning uses Oracle Workflow to manage the stages of the planning 
cycle that are composed of deferred activities. When the Distribute to Planners stage 
runs, Oracle Demand Planning's default behavior is to sequentially process each 
planners' assignment. Depending on your site's environment and implementation of the
software, it may be efficient to process more than one assignment distribution 
concurrently. 

Use the Workflow Settings function to specify the number of Workflow background 
engines to use when Workflow opens a connection to Express Server to build the 
personal database for planner assignments. You can also use Workflow Settings to test 
the connection to Oracle Workflow and specify the minimum number of days that the 
system will retain alert and batch notifications in the Workflow worklist.

Note: Users can experience the workflow sticking in a deferred status 
between assignment distribution, if there are insufficient workflow 
engines selected within the demand planning system administrator 
responsibility. Basic rule is workflow engines WE = (Number of 
Assignments + 1). 

Maintaining Workflow settings
You can modify Workflow settings by changing the number of background engines to 
run when building planners' assignments, modifying the minimum number of days 
that the system will retain alert and workflow notifications, and indicating whether you
want to test the Workflow configuration each time that data is downloaded from the 
Demand Planning Server.

To maintain Workflow settings:
1. Access the Demand Planning Administrator page.

2. In the navigation list, choose Workflow Settings.

Result: The page for maintaining Workflow settings opens.

3. The Number of Workflow engines to use box displays a numeric value. The value 
specifies the number of secondary Workflow engines that will run when Workflow 
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opens Express Server sessions to build planners' personal databases, which are 
based on their assignments. To change the value, type a new number or click the 
arrow next to the box and scroll to the number that you want to use.

The default for a new installation is 1. If you retain this value, the system starts a 
Workflow process that starts a single Express session and builds the assignments 
sequentially. If you select a larger value, Workflow starts the specified number of 
secondary processes, each of which opens an Express Server session and builds one 
or more assignments concurrently. The default value will work in all circumstances.
However, building personal databases is a resource-intensive process. If there are 
many assignments and you have a lot of Express engine power, you might want to 
select a larger value. Oracle recommends that you consider the resources provided 
by your Express configuration.

4. The Ad-Hoc Role Expiration Period (in days) box, specifies the minimum number 
of days that you want the system to retain alert and workflow notifications in the 
Workflow worklist.

You can type a new number, or you can click the arrow next to the box to scroll to 
the number that you want.

5. If you want to test the Workflow configuration each time you download data from 
the Demand Planning Server, in the Workflow Test box, check the Enable 
Workflow Loop Test box.

Note:  The Workflow test runs automatically the first time that data
is downloaded from the Demand Planning Server. You might only 
need to run it again if you suspect that there is a problem.

6. Choose Apply to save the current settings.

Batch Log
The Batch Log displays detailed date and time information about the status of the batch 
processes in the planning cycle. The log documents the stages involved in building a 
new plan, downloading data from the Demand Planning Server, populating measures, 
distributing to planners, collecting data from planners, and uploading data to the 
Demand Planning Server. The log displays automatically while a stage is running. You 
can also view the log on an ad hoc basis. 

To view the batch log:
1. Access the Demand Planning Administrator page.

2. In the navigation list, choose Batch Log. 
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Result:The frame for viewing the batch log opens. 

3. Scroll through the log to view activity detail. 

4. To exit, select another item in the navigation list or close the page.

Note: If the Distribute to Planner stage does not complete successfully, 
restart the process from the beginning.

Collaboration History 
The Collaboration History log enables you to view and sort information about actions 
that are related to data sharing. 

The Collaboration History log includes the following information:

• Action - The action that occurred. 

• Send - The measure was sent.

• Receive - The measure was received.

• Download - The measure was downloaded from the Demand Planning Server.

• Distribution - The measure was distributed.

• Measure - The measure affected by the action.

• Timestamp - The date on which the action occurred.

• Assignment - For an action initiated by a planner, this is the name of the planner's 
assignment. For an action initiated by the Demand Plan Manager, this is always 
Planning Manager; for an action initiated by the Demand Planning System 
Administrator, this is always Administrator.

• User - For an action initiated by a planner or Demand Plan Manager, this is the user
ID of the user who initiated the action. For an administrator, this is always Demand 
Plan Administrator.

To view collaboration history:
1. Access the Demand Planning Administrator page.

2. In the navigation list, choose Collaboration History.
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To sort collaboration history:
Note: By default, collaboration history is sorted by date. 

With the Collaboration History page open, choose the label of the column by which you
want to sort the information. For example, to sort by assignment name, choose the 
Assignment column label. 

To clear collaboration history:
With the Collaboration History page open, choose Clear All History.
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10
Environment for Planners and Demand Plan 

Manager

This chapter covers the following topics:

• Logging In as a Planner or Demand Plan Manager

• Navigation List

• Notifications List

• Document Workspace

• Activity Log

• Getting Help

• Exiting Demand Planning

Logging In as a Planner or Demand Plan Manager
When you log in with the Demand Planner or Demand Plan Manager responsibility, 
you access the Demand Planning page.

To log into Oracle Demand Planning as a planner or Demand Plan Manager:
1. In your Web browser, enter the URL for Oracle Applications. Your system 

administrator should provide this information.

Result: The Oracle Applications login window opens.

2. Enter your user name and password and choose Connect.

Result: If you have multiple user responsibilities, a list of responsibilities appears.

3. Select a responsibility: Demand Planner or Demand Plan Manager.

Result: If there is more than one demand plan, a list of plans appears.
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4. Select the plan that you want to work with, scroll to the bottom of the page and 
choose Start Demand Planning.

Result: The Demand Planning page for the plan opens.

Login tips
Following are some guidelines for logging in: 

• Ensure that cookies are enabled for your browser.

• If the system prompts you to download files to your machine for local storage, 
accept the files. This will enable the browser to load Web files only once. 

• If you encounter errors, try clearing your browser's cache and restarting the 
browser.

• Bookmark your start page for easy access.

• Maximize your browser window. This ensures that the application will run at full 
size. 

• Change settings for optimum screen resolution.

• If you will be using a language other than English, ensure that your browser is set 
to that language. 

• Sessions have a maximum idle time that is set by an administrator. Your session 
will terminate automatically if it is idle for this time period.

Interface for Demand Planner and Demand Plan Manager
The Demand Planning page is the interface for demand planners and managers. The 
page is comprised of two frames: the document workspace in the right frame and the 
Navigation List and Notifications List in the left frame.

Navigation List
The Navigation list, located in the upper left of the Demand Planning page, enables you
to work with Demand Planning objects such as documents, measures, custom 
aggregates, saved selections, alerts, and scenarios.

Example: Navigation list
A few examples of the objects listed in the Navigation List are:

• Documents like forecasts and forecast results, forecast comparison lists, exception 
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messages, etc.

• List of measures saved selections

• Custom aggregates

• Saved scenarios

• Saved events

Navigation tools
The Navigation toolbar appears at the top of the Navigation List. The toolbar buttons 
enable you to perform the functions listed below.
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• New: Create a new document (ad hoc report, ad hoc graph, worksheet), or other 
object (measure, custom aggregate, saved selection, document folder, alert).

• Find: Search for an object by name. 

• Delete: Delete a document (ad hoc report, ad hoc graph, worksheet) or other object 
(measure, custom aggregate, saved selection, document folder, alert).

• Tools: Displays a menu which includes the following functions: 

• Activity Log — View activities for your assignment or role.

• Events Calendar — View information about events that are associated with the 
demand plan.

• Refresh Open Documents — Choose this command to refresh open reports or 
graphs to reflect changes made to data in an open worksheet.

• Advanced Locking — Selecting this command displays the Advanced Locking 
dialog box, which has options that enable you to accomplish the following 
tasks: set standard locks, set cycle persistent locks, reset locks, and reset all 
locks for an entire measure.

• Collaboration — The Collaboration command enables demand planning 
managers and demand planners to share data by sending and receiving stored 
measures. The Collaboration submenu has the following commands:

Send Measures — Accesses the Send Measures dialog box. For the Demand 
Planning manager, the Send Measures dialog box is a quick way to get data to 
the planners without having to run a Distribute to Planners batch job. 

For demand planners, this dialog box provides the means of either sharing the 
planner's entire write scope of a measure, or further limiting what portion of 
the measure to share.

Receive Measures — Accesses the Receive Measures dialog box. By using the 
Receive Measures dialog box, a planning manager can view the planners' data 
edits before the final submission.

View Collaboration History — Accesses the Collaboration History dialog box, 
which provides a view of actions that are related to sharing data. You can also 
sort the information and clear the log. Some of the information displayed 
includes the action that occurred, measure sent, measure received, measure 
downloaded from the Demand Planning Server, measure distributed to users, 
measure uploaded to the Demand Planning Server, measure affected by the 
action, and the timestamp.

• Import Data — This command enables you to import data from a flat file into 
an editable measure. You access the File to Import dialog box. You should see the
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section on importing data into a measure, , since there are format restrictions on
the data you import.

• Submit Measure — When demand planners submit final forecast numbers for 
each scenario in the demand plan, they use this command to access the Submit 
Measures dialog where the measures are selected to be submitted to the shared 
database for a scenario. You only see this command if you are logged in as a 
demand planner.

• Select Upload Measure — This is the command that the Demand Plan Manager
uses to upload submitted and reviewed measures to the Demand Planning 
Server. Only the Demand Plan Manager sees this function on the Tools menu.

• Share — Select this command to access the Share Objects dialog box, which 
enables planners and plan managers to share documents, documents, folders, 
saved dimension selections, and custom aggregates.

• Planning Percentage Worksheet — Open a worksheet that enables you to view
and edit dependent demand and planning percentages. (This option only 
appears if dependent demand has been enabled in the Demand Planning 
Server, and the fact tables hold parent-child dependency relationships from the 
Bill of Materials.)

• Arrange Documents: Enables you to manipulate your workspace when you have 
opened multiple documents. You can use one of these commands from the 
submenu: Tile Windows, Cascade Windows, Minimize All Windows.

• Exit:: Exit the application.

• Help: Display online Help for planners and the Demand Plan Manager.

Navigation List objects
The following list includes the objects that might appear in your Navigation List.

• accuracy measures

• ad hoc graphs 

• ad hoc reports

• alerts

• custom aggregates

• events
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• event groups

• folders

• formula measures

• predefined reports

• saved selections

• scenarios

• stored measures

• worksheets

Notifications List
The Notifications List displays messages that have been generated by Oracle Workflow.
You might see two types of notifications:

• When there is an alert for your attention, a notification concerning the alert is 
displayed in the Notifications List.

• If another planner or the Demand Plan Manager has sent data that is within the 
scope of your assignment, a notification that collaboration measures are ready to be 
received is displayed in the Notifications List.

Document Workspace
The Document Workspace displays open documents. 

Oracle Demand Planning enables you to work with the following types of documents:

• Worksheets — Display data in tabular format and enable you to modify data for 
editable measures.

• Planning Percentages Worksheets — Where it is possible to calculate dependent 
demand, these worksheets display planning percentages for products, models, and 
options and enable you to modify the data.

• Ad hoc reports — Display data in tabular format.

• Ad hoc graphs — Display data in graphical format.

• Predefined reports — Pre-seeded documents, set up by the Demand Plan 
Administrator, that run predefined analyses including evaluations of forecast 
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accuracy. 

Document Toolbars
When you create a new document or open an ad hoc report, graph, worksheet or 
predefined report, a set of buttons is displayed on a toolbar at the top of the document. 
These tools enable you to perform functions that are specific to the document type.

Using Multiple Documents
Oracle Demand Planning has a multi-document interface that enables you to open as 
many as 10 documents simultaneously. 

For information on how to open and use multiple documents, see the section on the 
document workspace, page 11-5 in the chapter on using worksheets.

The list below represents an arrangement that opens at least one document of each type,
with the exception shown at the end of the list.

• One worksheet

• One planning percentages worksheet

• One graph

• Up to seven ad hoc reports

• One predefined report (under the conditions described below)

You cannot have a predefined report and a worksheet of either kind open concurrently.

Activity Log
The Activity log enables you to view a list of your activities for your assignment or role.
The Activity log documents the following actions:

• Logging in and out

• Recalculating data

• Saving documents

• Submitting measures

• Creating comments

• Creating measures
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Note: Remember that the Activity log display the measure submission 
process, but not the measure uploading, which is a batch process.

Viewing the Activity log
You can view the Activity log at any time.

To view the Activity log:
1. Access the Demand Planning page as a planner or Demand Plan Manager.

2. On the Navigation list toolbar, choose the Tools button.

3. From the submenu, choose Activity Log.

Result: The Activity log opens. 

Example: Activity log
The planning engine sorts the activity log by time. The activity log window would list 
your assignment or role activities in a descending order of date and time.
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Getting Help
To view information that is page-specific, choose the Help button. 

You can also access online help for Oracle Demand Planning from the Demand 
Planning page and view version and system information. 

To access online Help from the Demand Planning page:
1. Choose the Help button, located on the Navigation toolbar.

2. Result: A menu appears.

3. Choose Demand Planning Help.

4. To print Help, use your browser's print function.

5. To exit Help, close the Help window.

To access version and system information from the Demand Planning page:
1. Click the Help button, located on the Navigation toolbar.

2. Result: A menu appears.

3. Choose About Demand Planning.

Result: The application name, release, and build number are displayed. 

4. Choose System Information.

Result: The application name, release, and build number are displayed. 

5. To save system information to a text file, choose Save As and specify the file name 
and path. 

6. To exit, choose OK.

Exiting Demand Planning
When your work is complete, you can exit Oracle Demand Planning. Exiting terminates
the application. If you have modified a document or other object, you will be prompted 
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to save it. 

To exit Oracle Demand Planning:
Choose the Close button on the Navigation toolbar.

Alternatively, you can use the browser's close button (X), located in the upper right 
corner of the screen. This exits the application and closes the browser.
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11
Using Worksheets

This chapter covers the following topics:

• About Worksheets

• Creating Worksheets

• Opening Worksheets

• Selecting Data for Worksheets

• Arranging and Viewing Data in Worksheets

• Viewing Events for Measures in Worksheets 

• Modifying Data in Worksheets

• Formatting Worksheets

• Printing Worksheets

• Saving Worksheets

• Exporting Data from Worksheets

• Closing Worksheets

• Renaming Worksheets

• Viewing Worksheet Properties

• Deleting Worksheets

About Worksheets
When you work as a Demand Planner or Demand Plan Manager, you use worksheets to
modify data and save your changes. 

Example: Worksheet
For example, you can use the worksheet if you want to update the forecasts of booking 
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history and quantities for the following items, for all organizations from January 2001 to
May 2001: 

• AS65102

• AS65103

• AS72111

• AS18947

• AS54888

• AS92689
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Toolbar for worksheets
The Document toolbar appears at the top of an open worksheet. The toolbar buttons 
enable you to perform the functions that are listed below.

• Choose Values from List - Select values from a list, access various data selection 
tools, sort selections.

• Apply Saved Selection - Replace the current values in the worksheet with a saved 
selection of values.

• Save Current Selection - Save the current values that are in status for a certain 
dimension.

• Change Layout - Change the layout of the worksheet.

• Export to Spreadsheet  - Export data and labels from the worksheet to a .CSV, .TXT,
or .HTM file.
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• Save As - Save the worksheet and its current data.

• Reset Data - Reset unsaved data in the worksheet to a previous status.

• Copy - Copy selected data and labels from the worksheet to the Windows 
clipboard; also lets you copy to a measure or product.

• Paste - Paste data from the Windows clipboard into the worksheet.

• Format Document - Specify a title, subtitle, and footnote for the worksheet; apply 
formatting such as row and column sizing and font and display specifications.

• Modify Selected Data - Use a variety of techniques to change data values in 
selected worksheet cells. You can also protect cells from future edits and enter 
comments documenting your modifications.

• Recalculate - Recalculate the data in the worksheet.

• Events Calendar  - View a calendar that displays information about events 
associated with the demand plan.

• Print  - Print the worksheet.

• Help - Display online help for planners and the Demand Plan Manager.

Creating Worksheets
You can base a worksheet on the default worksheet document. You can also use any 
saved document as the starting point for a new worksheet.

A new worksheet initially reflects the document on which the worksheet is based. You 
can customize the worksheet so that it displays exactly the data with which you want to
work. You can select layout and format options.

To create a worksheet:
Access Oracle Demand Planning as a planner or planning manager.

1. On the Navigation toolbar, choose the New button.

2. Choose New Worksheet. 

Alternatively, you can click the right mouse button on Documents in the navigation
list and choose New Worksheet from the popup menu.

3. Choose one of the following:
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• Use default — Creates a worksheet that is based on the default worksheet 
document.

• Based on — Creates a worksheet that is based on a selected document.

If there are no saved documents, then you do not have these options. The 
worksheet will automatically be based on the default worksheet document. For 
information about setting the default, see "Saving Worksheets", page 11-37.

4. Choose OK to create the worksheet.

Result: The worksheet is displayed in the workspace. A generic name, such as "
Document 1" appears above the document body.

The Multi-Document Workspace
Oracle Demand Planning has a multi-document workspace that enables you to open as 
many as 10 documents simultaneously. The main benefit of this interface is that it gives 
you the opportunity to compare data from worksheets with related reports and graphs.

The Oracle Demand Planning workspace provides virtual space that is larger than the 
visible space. If a document window extends beyond the visible boundaries of the 
desktop, then a horizontal or vertical scroll bar (or both) will appear, allowing you to 
scroll to the desired location.

You can use any of the document types listed below in the multi-document workspace,

• Worksheets — Display data in tabular format and enable you to modify data for 
editable measures.

• Planning Percentages Worksheets — For plans in which dependent demand is 
calculated, these documents display planning percentages for products, models, 
and options, and enable you to modify the data.

• Ad hoc reports — Display data in tabular format.

• Ad hoc graphs — Display data in graphical format.

• Predefined reports — Preseeded documents, set up by the Demand Plan 
Administrator, that run predefined analyses including evaluations of forecast 
accuracy.

The document windows have traditional window control buttons in the upper 
right-hand corner that enable you to accomplish the tasks listed below.

• The Maximize button maximizes the window to occupy the entire desktop area.

• The Minimize button transforms the window into a title bar icon at the bottom of the
desktop area.
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• The Close button prompts you if there are unsaved changes, and closes the window.

• The Restore button restores a maximized or minimized window.

Document Behavior in the Workspace
In the workspace, each open document is displayed as a floating window. The first 
document opened will take all available space, and then additional documents will 
overlay previously opened documents until they are resized.

The Navigator and Notifications panels are visible in the vertical toolbar section, 
although they can be minimized, in which case the active document will fill the space 
they occupied. If a Recalculation, Save or other activity is in process for a document, that 
document will remain the active document until the activity is completed.

Displaying Multiple Documents
The list below represents an arrangement that opens at least one document of each type,
with the exception of the predefined report/worksheet exclusion. Your arrangement 
may be any of many possible combinations. You could, for example, open ten reports 
and no documents of any other type.

• One worksheet

• One planning percentages worksheet

• One graph

• Up to seven ad hoc reports

• One predefined report (under the conditions described below)

You cannot have a predefined report and a worksheet of either kind open concurrently.

The only case where two worksheets may be opened at once is when one is a 
user-defined worksheet and one is a Planning Percentages worksheet.

When you have opened multiple documents, the Arrange Documents button on the 
Navigation toolbar is enabled. When clicked, it displays a submenu with the commands
shown below:

• Tile Windows – You see abbreviated versions of all documents displayed 
horizontally in the workspace.

• Cascade Windows – You see all documents displayed in a layered fashion, one atop
the other.

• Minimize All Windows – All windows are minimized.
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Refreshing Open Documents
Oracle Demand Planning enables managers and planners take advantage of the 
application's multi-document workspace by simultaneously opening several documents
that provide different views of the same data.

You might, for example, be examining a forecast in a worksheet while simultaneously 
having the same dimension values in status in an ad hoc report and an ad hoc graph. If 
you make changes to the data in the worksheet, the data is momentarily out of 
synchronization with the corresponding values in the other documents.

To remedy the situation, you can select a command from the Navigation toolbar to 
refresh the open documents so that they all display the same data.

This procedure illustrates how you could refresh all open documents:

1. While you have multiple documents open, edit the values in some cells of your 
open worksheet.

2. Click on the Tools button in the Navigation toolbar.

3. Select the Refresh Open Documents command from the Tools submenu. The result
is that, if the same dimension values that are in the worksheet are also in the other 
open documents, all the documents will be refreshed and the data in all of them 
will be synchronized.

4. You can refresh an open report or graph, without affecting the other documents, by 
choosing the Refresh button on toolbar of an individual document. The Refresh 
Open Documents option is enabled as long as documents are open. If no 
documents are open, the option is disabled. The Refresh buttons on document 
toolbars, however, are always enabled.

Opening Worksheets
Saved worksheets are displayed as objects in the Navigation list, located in the left 
frame of your browser. Depending on how a worksheet was saved, it might appear in 
the main Documents folder or in a folder that you created. 

To open a worksheet:
Access Oracle Demand Planning as a planner or planning manager.

1. In the navigation list, identify the worksheet that you want to open.

2. Double-click the document object. 

Alternatively, you can click the right mouse button on the document object and 
choose Open from the popup menu.
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Default Document Layout
When a user creates a new worksheet, report or graph, Oracle Demand Planning 
intelligently displays immediately usable, populated documents by setting status to 
dimensions where data is available.

The Purpose of a Default Layout
If you have defaults for the most important document types, you save time by not 
having to immediately populate dimension values. When creating a default document, 
Demand Planning selects a forecast measure to ensure that data exists at the forecast 
level, or a history measure if a populated forecast is not available.

How Default Worksheets and Reports are Arranged
For worksheets and ad hoc reports, the arrangement listed below is a default.

• Time is the column dimension.

• Product is the row dimension.

• Geography and Organization, if they are dimensions in the current demand plan, 
are on the page edge.

• Additional dimensions in the plan, whether they are preseeded or user-defined, are 
on the page edge.

• Measure is a page dimension.

How a Default Graph Is Arranged
the default layout for graphs is described below.

• The Time dimension is on the X axis.

• The Product dimension is on the Y axis.

• Measure and other dimensions are page dimensions.

What Default Values Are Used?
The following list describes the default values for each dimension.

• For Time, the values that are used are the most recent 6 time periods, where data 
exists, at the forecast level.

• For Product, the values that are used are the first 10 values, where data exists, at the
forecast level.

• For Geography and Organization, if they are part of the demand plan, the values 
used are the first 3 values, where data exists, at the forecast level.
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• When the current demand plan uses preseeded or user-defined dimensions, the 
top-level value for each dimension is used.

• For the Measure dimension, the default selection is the default forecast measure 
associated with the first scenario. If such a scenario does not exist, any shared 
forecast measure is used. If no forecast measure exists, a history measure from the 
Planning Server is used.

In a case where no default forecast exists, the default for the Time dimension is the first 
calendar with non-NA values for the most recent 6 weeks, or, if there are no weeks, 
months.

How to Create a Default Document
Follow the steps below to create a default document.

1. Choose the New icon on the Navigator toolbar.

2. Select New Worksheet, New Report, or New Graph.

3. In the New Document dialog box, choose the Use default option.

Selecting Data for Worksheets
When you create a new worksheet, the data reflects selections for the document on 
which the worksheet is based. When you open a saved worksheet, the data reflects 
selections that were in effect when the document was saved. 

You can select measures and dimension values so that the worksheet displays exactly the 
data with which you want to work.

1. A measure represents a variable which is a placeholder for storing data values for all
levels of all dimensions. For example Booking History, Shipment History, and Q1 
Forecast might be measures in your database. 

2. A dimension is a database object that organizes and indexes the data, similar to a key
in a relational database. For example, if you have data with values for various time 
periods, then the data has a Time dimension; that is, it is organized by time. 

3. Dimension values are the elements that make up a dimension. For example, a Time 
dimension might include values for years, quarters, months, and weeks. You can 
select any or all of the values that are available within a dimension, including 
custom aggregates and saved selections that you have defined

To select data for a worksheet:
With the worksheet open, choose the Select Data button on the Document toolbar.
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1. A list of the dimensions in your database appears. The list includes Measure.

2. Choose a dimension for which you want to select values.

Result: The Select Data dialog box opens. The dimension that you chose is displayed
in the Select Values for box.

3. Choose values for the current dimension.

For information about data selection tools and techniques, see "Selecting Data", 
page 22-1.

4. For information about special features of the Select Data tool, see Selector Undo and 
Redo, page 22-2.

5. To select values for another dimension, in the Select Values for box, choose the 
dimension and repeat your previous steps.

Applying custom aggregates and saved selections to a worksheet
In addition to using a selection list or selection tools to select data values for a 
worksheet, you can change the data that is displayed in the worksheet by applying 
saved selections and custom aggregates to the open document. For more information, 
see the following topics:

"Defining Custom Aggregates", page 19-1

"Applying Custom Aggregates to Open Documents", page 19-3

"Defining Saved Selections", page 20-1

"Applying Saved Selections to Open Documents", page 20-4

If expected rows do not display
It is possible that a row that you expect to see might not appear if NA rows are 
suppressed in the worksheet. For example, assume that you position Time on the row 
edge of the worksheet, and select three Time values: October, November, and 
December. If NA row suppression is turned on and there is no data for December, then 
the worksheet will display rows for October and November, but no row for December. 

If you think that NA or zero rows are being suppressed and you want to view these 
rows, you can use a format option to show the rows. For more information, see 
Formatting general worksheet elements, page 11-28. 
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Arranging and Viewing Data in Worksheets
You can change a worksheet so that you can view the data in the way that you want. 
The following options are available: 

1. You can change the layout by rearranging the dimensions on the page.

2. You can drill through aggregate values to expose component values. 

3. You can page through the worksheet to view data for dimensions in the page 
position.

4. You can change the size of columns or rows to enhance your view of the data.

Changing the layout of a worksheet
You can use the Change Layout button on the Document toolbar to change the layout of
a worksheet. Alternatively, you can change the layout manually by dragging and 
dropping dimension tiles.

To use the Change Layout button to change the layout of a worksheet:
With the worksheet open in the workspace, choose the Change Layout button on the 
Document toolbar.

1. The Layout box displays the current positions of the dimensions on the page. 

Dimensions for which data displays as separate pages are shown in the page 
position. 

Dimensions for which data goes across the page are shown in the row position. 

Dimensions for which data goes down the page are shown in the column position.

2. You can click a dimension and drop it on another location or drag it to a new 
location. 

Result: The dimension moves as follows:

• If you drag a dimension near another dimension and the dimension turns gray, 
this indicates that the two dimensions will exchange (swap) positions. 

• If you drag a dimension and a black bar appears, this indicates that the 
dimension will be moved to the position.

3. You can also use the controls at the top of the page to manipulate dimension 
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positions.

4. When the Layout box displays the desired settings for the dimensions, choose OK.

Result: The Change Layout dialog box closes. The elements in the document are 
moved to the locations that you specified.

To use drag and drop to change the worksheet layout:
Click a row, column, or page selector. These selectors are located beside the row, 
column, and page labels and appear similar to a stoplight.

1. Drop the selection on another location or drag it to a new location.

2. The dimension moves with the selector as follows: If you drag a dimension near 
another dimension and the dimension turns gray, this indicates that the two 
dimensions will exchange (swap) positions

3. Drop the selection on another location or drag it to a new location. 

4. If you drag a dimension and a black bar appears, this indicates that the dimension 
will be placed on the edge.

Drilling through levels of data in a worksheet
If a worksheet includes hierarchical dimension values and the drilling option has been 
turned on for the document, you can view data at various levels by drilling within 
aggregate dimension values.

For example, if the worksheet displays a geography that includes lower level values, 
you can "drill down" and expand the display to show component geographies. You can 
then "drill up" to collapse the display. 

You can drill a dimension value that is in the row or column position if a drill arrow 
appears to the left of the dimension value name. The arrow shape changes, depending 
on whether you can expand or collapse the value:

• Right pointing arrow — Located beside a value that displays a total while the 
values that contribute to that total are not visible. Clicking this arrow enables you to
drill down, causing the document to display the lower level values. 

• Down pointing arrow — Located beside a value that displays a total while the 
values that contribute to that total are visible beneath it. Clicking this arrow enables 
you to drill up, causing the document to display only the total value. 

A format option enables you to turn drilling on or off in a worksheet. For more 
information, see "Formatting general worksheet elements", page 11-28. 
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Paging through a worksheet
Worksheet data is displayed one page at a time.

You can use the page controls at the top of the document to page through a worksheet 
and display pages other that the one that is currently in view. 

For example, the current page might show data for Total Product, but you can use the 
page control to select another product from the list and see its data.

Adjusting columns and rows in a worksheet 
You can change the size of rows and columns in a worksheet so that the information is 
easier to read. You can use drag and drop to adjust column and row sizes. You can also 
use a format option. For more information about adjusting columns and rows, see 
"Sizing rows and columns in a worksheet", page 11-29. 

Viewing Events for Measures in Worksheets 
An event is an occurrence such as a promotion, new product introduction, or product 
phaseout that is expected to impact demand for a product. When you define a stored 
measure, you can associate one or more events with that measure. Events might also be 
linked to stored measures in the shared database. Thus, your ad hoc report might 
include measures that have associations with events. 

While you are using a worksheet you can access an Events Calendar which provides 
information about the events that are associated with the demand plan. 

To view events that are associated with a measure:
The following procedure describes how to use the Events Calendar to view information 
about a measure. For more information about events, see the chapter on "Working with 
Events."

1. With the document open in the workspace, choose the Events Calendar tool on the 
Document toolbar.

The Events Calendar opens. The Month tab displays events for the current month. 
The right frame displays all events that are linked to the demand plan.

2. Choose the Filter Events by Measure button.

The Choose a Measure dialog box opens. The list displays all measures that have been
defined for the demand plan.

3. Select a measure from the list and choose OK. The right panel now displays only 
those events that have been linked to the selected measure. 

The measure name appears at the bottom of the frame. 
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To view more information about the event, double-click it. The Event Wizard 
opens, where you can view (and optionally edit) the event definition.

Modifying Data in Worksheets
You can modify editable (read/write) data values in a worksheet. If your responsibility 
is Demand Planner, saving the worksheet saves the data in your personal database. If 
your responsibility is Demand Plan Manager, saving the worksheet saves the data in 
the shared database. If you do not save the worksheet, then your edits will not be saved.

What data can you modify?
In order for data to be editable, the measure that contains the data must be a stored 
measure that includes the Editable property as part of its definition. 

If you want to edit data for a measure that is not currently editable, you can modify the 
measure definition and set the Editable property to yes. Or you can create a copy of the 
measure and make the copy editable.

You cannot edit data for a formula measure. Data for a formula measure is 
automatically updated when you edit the measure on which the formula is based. 

If Oracle Demand Planning is set up to support dependent demand, you can view 
measures for dependent demand and total demand in the worksheet. However, you 
cannot edit data for these measures. 

To view product models and options and modify dependent demand and planning 
percentages, use the Planning Percentages worksheet. 

To access the Planning Percentages worksheet, click the right mouse button in a 
worksheet cell and choose Planning Percentages Worksheet from the popup menu. 
The Planning Percentages worksheet opens below the standard worksheet.

Display formats indicate status
Display formats enable you to identify non-editable cells, editable cells, cells that have 
been modified, as well as cells that have been locked or commented in the worksheet. A
setting that is specific to each worksheet enables you to turn the color and font 
indicators off and on. 

When all display formats are turned on, data in worksheet cells appears as follows: 

• Non-editable (read-only) and locked cells — dark gray background 

• Editable cells — pale gray background

• Modified cells — blue font

• Commented cells — bold font



Using Worksheets    11-15

• Standard lock — pale pink background

• Persistent lock — dark pink background

Usually, you will want to have display formats turned on to highlight your 
modifications. However, there might be circumstances in which you want to turn off 
one or more formats. For more information about turning display formats off or on, see 
the "Specifying display formats for a worksheet", page 11-31.

Note: Turning a display format off or on does not affect any data 
modifications that you have made in the worksheet; it merely changes 
the appearance of the modified cells.

More on View Scopes and Assignment Scopes
Demand planners can distinguish between dimension values in their assignment scopes
versus those in the view scopes 

When a full distribution process to planners is complete, attributes are created (or are 
updated if they already exist). An attribute named Scope is created for each dimension 
in the plan. Each dimension value in each dimension will have a value for the attribute, 
the possible values being Assignment and View. 

All cells that match the view-only attribute for any dimension will be displayed as 
non-editable. Cells that are in the view scope are locked and displayed with a dark gray
back ground. 

The System Administrator controls assignment maintenance by an option on the 
Assignments page, which is described in Demand Plan Administration: Setting Up the User
Environment. That chapter also describes a related feature that enables an Administrator
to create a situation where planners need only to see values in their Assignment scope.

When items that are in a planner's assignment or view scope are dependent on other 
items, the parent items are automatically be added to the planner's view scope. 
Dependencies and dependent demand data are also visible for assignment items.

Working with NA or zero data
You can modify editable data cells in which the current value is NA or 0 (zero). 
However, if you edit an NA at a high level a warning might appear because allocating 
the values down can impact system resources.

Note:  NA or zero rows might not initially display in a worksheet. You 
can use a format option to make them visible. For more information, 
see "Formatting general worksheet elements", page 11-28. 

When you enter a value into an empty cell, Demand Planning checks the allocation base
measure for allocation weights. If there are no allocation weights, Demand Planning 
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allocates the value to the hierarchy levels below using the First Child allocation method.
That is, the first child at each level receives an allocation.

Note: Demand Planning uses the First Child allocation method by 
default, unless you enable the MSD: Use Classic Even Allocation 
profile.

Editing data
You can edit the value in a single cell of the worksheet. Worksheet cells may contain 
either positive or negative values. You can also use block edit tools to increase data 
values, decrease data values, or fill in data values for a group of cells. In order to save 
your edits, you must save the worksheet.

You can edit different levels in a worksheet without system-forced recalculations 
between edits. When you have finished making your changes, click the Save or 
Recalculation buttons to recalculate data from the top level down in the hierarchy. Once
the worksheet is recalculated or saved, edits are enforced from the top hierarchy levels 
down, so it is possible for an edit at a higher hierarchy level to override an edit at a 
lower hierarchy level.

Note: To force recalculations between worksheet edits, enable the MSD:
Classic Worksheet profile option. This option enforces consistency 
across hierarchy levels, but may decrease performance. 

Requirements for editing data on the cell level are as follows: 

• Cells must be editable and unlocked. 

• If you select multiple cells, the cells must be at the same level. For example, you can 
increase data for Boston and San Francisco but not for Boston and California

Note: If you enter, fill, increase, or decrease a cell by a numeric 
value and the value has more decimal digits than the numbers that 
are currently displayed in the worksheet, the edited value will be 
will be rounded to the nearest decimal place.

To edit the value in a single cell:
1. With the document open in the workspace, click in the cell that contains the value 

that you want to change.

2. Type in the new value.
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To increase data values in one or more cells: 
1. With the document open in the workspace, select the cell or cells that contain the 

values that you want to increase.

Use CTRL + click to select cells that are on the same level but are not contiguous. 

• To select all cells in a column, click the highlighter under the column label. The 
cells that you select must be at the same level; otherwise the edit will fail. 

• To select all cells in a row, click the highlighter next to the row label. The cells 
that you select must be at the same level; otherwise the edit will fail.

2. Click the right mouse button or choose the Modify Selected Data button on the 
Document toolbar.

3. Choose Increase from the popup menu.

Result: The Modify Data dialog box opens.

4. In the Increase by box, enter the value by which you want to increase the data.

5. If the increase value is a percentage, select Percent. 

6. Choose OK to apply the modification.

To decrease data values in one or more cells:
1. With the document open in the workspace, select the cell or cells that contain the 

data values that you want to decrease.

Use CTRL + click to select cells that are on the same level but are not contiguous. 

• To select all cells in a column, click the highlighter under the column label. The 
cells that you select must be at the same level; otherwise the edit will fail. 

• To select all cells in a row, click the highlighter next to the row label. The cells 
that you select must be at the same level; otherwise the edit will fail.

2. Click the right mouse button or choose the Modify Selected Data button on the 
Document toolbar.

3. Choose Decrease from the popup menu.

Result: The Modify Data dialog box opens.
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4. In the Decrease by box, enter the value by which you want to decrease the data.

5. If the decrease value is a percentage, select Percent.

6. Choose OK to apply the modification.

To fill data in one or more cells: 
1. With the document open in the workspace, select the cell or cells in which you want

to replace data values.

2. Use CTRL + click to select cells that are on the same level but are not contiguous. 

• To select all cells in a column, click the highlighter under the column label. The 
cells that you select must be at the same level; otherwise the edit will fail. 

• To select all cells in a row, click the highlighter next to the row label. The cells 
that you select must be at the same level; otherwise the edit will fail.

3. Click the right mouse button or choose the Modify Selected Data button on the 
Document toolbar.

4. Choose Fill from the popup menu.

Result: The Modify Data dialog box opens.

5. In the Fill with box, enter the value with which you want to fill the cells.

6. Choose OK to apply the modification.

Forecasting data
You can run a statistical forecast for data in one or more cells. You specify the statistical 
forecasting method to use, enter the forecast time period, and select the historical 
measure on which to base the forecast. In order to save your edits, you must save the 
worksheet.

Requirements for running a statistical forecast are as follows: 

• The cell or cells should contain data for a forecast measure.

• The cell or cells must be editable and unlocked. 

• If you select multiple cells, the cells must be at the same level. For example, you can 
forecast data for Boston and San Francisco but not for Boston and California.
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To run a statistical forecast for data in one or more cells: 
1. With the document open in the workspace, select the cell or cells that you want to 

forecast. 

2. Use CTRL + click to select cells that are on the same level but are not contiguous. 

• To select all cells in a column, click the highlighter under the column label. The 
cells that you select must be at the same level; otherwise the edit will fail. 

• To select all cells in a row, click the highlighter next to the row label. The cells 
that you select must be at the same level; otherwise the edit will fail.

3. Click the right mouse button or choose the Modify Selected Data button on the 
Document toolbar.

4. Choose Statistical Forecast from the popup menu.

Result: The Statistical Forecast Measure dialog box opens.

5. Make the Forecast Method tab active and proceed as follows: 

1. In the Method box, select a forecasting method. For information about forecast 
methods, see "Forecast Methods", page A-1. 

2. For certain forecasting methods, you can set values that indicate the weight to 
give to recent changes in Mean Value, Trend, and Seasonality. For more 
information about these parameters, see "Advanced statistical parameters", 
page A-2.

6. Make the Time Range tab active. The information that you provide specifies the 
time range in the historical measure to consider when calculating the forecast. 
Proceed as follows: 

1. In the Start date box, select a start date for the historical time range. 

2. In the End date box, select an end date for the historical time range.

3. In the Historical Measure box, select the measure on which to base the forecast.

7. Choose OK to forecast data in the selected cells.

Copying and pasting data
You can copy and paste data in a worksheet as follows:
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• You can copy data to the Windows clipboard. You can choose to copy data that has 
been stripped of special formats such as thousands separators, currency signs, and 
percent symbols, or you can include these formats. You can also specify that the 
copy include row and column labels.

• You can paste data from the clipboard into another cell or cells in the worksheet. 

• You can copy data from one measure to another measure. 

• You can copy data from one product to another product. This can be useful when 
you want to quickly provide information for a new product.

In order to save your edits, you must save the worksheet.

Note: Copying to a measure or product replaces the values in the target
measure or product with new values. The copy process also applies the 
allocation percentages from the source measure or product to the target
cells. Pasting values replaces the values in the target cells with new 
values. The target cells maintain their current allocation percentages.

Requirements for copying and pasting data are as follows: 

• If you are copying multiple cells, the cells must be contiguous. 

• If you are pasting data that you have copied to the Windows clipboard or if you are 
copying data to a measure or product, the following requirements apply: 

• The target region must be editable and unlocked. 

• The target region must be at a single level. For example, you can paste data into
cells that contain data for Massachusetts and California, but not into cells that 
contain data for Massachusetts and Boston.

• The target region must have the same unit of measure (quantity or amount) as 
the source.

To copy data from a worksheet to the Windows clipboard: 
1. With the document open in the workspace, select the cell or cells that you want to 

copy.

2. To select all cells in a column, click the highlighter under the column label. 

• To select all cells in a row, click the highlighter next to the row label. 

3. Choose the Copy button on the Document toolbar.
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4. Alternatively, you can click the right mouse button and view a popup menu. 

5. Choose a copy option: 

• Copy Data to Clipboard — Copies the data but excludes formats such as 
thousands separators, currency signs, and percent symbols.

• Copy Special — Displays a submenu from which you can select one of the 
following: 

• Copy Data with Labels — Copies the data but excludes formats such as 
thousands separators, currency signs, and percent symbols. Also copies the 
row and column labels associated with the data.

• Copy Number Formatted Data — Copies the data and includes formats 
such as thousands separators, currency signs, and percent symbols.

• Copy Number Formatted Data with Labels — Copies the data and 
includes formats such as such as thousands separators, currency signs, and 
percent symbols. Also copies the row and column labels associated with the
data.

• Copy Row Labels — Copies the row labels that are associated with the 
selected cells. Does not copy the actual data.

• Copy Column Labels — Copies the column labels that are associated with 
the selected cells. Does not copy the actual data.

To paste data from the Windows clipboard into a worksheet: 
With the document open in the workspace, select the cell or block of cells into which 
you want to paste data. 

Note: The range of cells that you select must exactly match the range of 
cells that was copied to the clipboard. If the paste range does not match 
the copy range, then the system will not paste the data.

1. Choose the Paste button on the Document toolbar.

2. Alternatively, you can click the right mouse button and choose Paste from the 
popup menu.
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To copy data to a measure: 
With the document open in the workspace, select the cell or cells that contain the data 
that you want to copy.

1. Click the right mouse button or choose the Copy button on the Document toolbar.

2. Choose Copy To Measure from the popup menu.

Result: The Target Measure dialog box opens.

3. From the list of measures, select the measure to which you want to copy the data 
and choose OK.

To copy data to a product:
With the document open in the workspace, select the cell or cells that you want to copy.

1. Click the right mouse button or choose the Copy button on the Document toolbar.

2. Choose Copy To Product from the popup menu.

Result: The Target Product dialog box opens.

3. From the list of products, select the product to which you want to copy the data and
choose OK.

Locking and unlocking cells
You can lock one or more cells so that the data values in the cells cannot be edited. 
Locking protects the value in the cell as well as the values in all cells that are its 
children. For example, locking a cell for Massachusetts also protects the data for Boston.
Recalculation ignores locked cells and their children and proportionately spreads data 
to other values.

Note: If your Demand Planning system is set up for collaboration 
among planners, it is possible for a locked cell to be modified if a 
measure is received that affects the cell. Unless absolutely required, you
should avoid locking cells in the view scope or their aggregate levels in 
shared measures.

You can remove cell protection by unlocking locked cells. 

In order to retain the locked or unlocked status of a cell, you must save the worksheet.
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Requirements for locking and unlocking cells are as follows:

• In order to lock a cell, the cell must be editable.

• In order to unlock a cell, the cell must be locked.

To lock a cell: 
1. With the document open in the workspace, select the cell or cells that contain the 

data that you want to protect.

2. Use CTRL + click to select cells that are not contiguous.

3. Click the right mouse button, or choose the Modify Selected Data button on the 
Document toolbar.

4. Choose Lock Cell from the popup menu.

To unlock a cell: 
1. With the document open in the workspace, select the cell or cells that you want to 

unlock.

2. Use CTRL + click to select cells that are not contiguous.

3. Click the right mouse button, or choose the Modify Selected Data button on the 
Document toolbar.

4. Choose Unlock Cell from the popup menu.

Using comments to document modifications
As you modify data, you can document your changes by entering one or more 
comments. Comments are free text that you associate with predefined reason codes. In 
order to retain your comments, you must save the worksheet.

Requirements for entering comments are as follows:

• The cell or cells must be editable and unlocked.

• If you select multiple cells, all of the cells must be at a single level. For example, you
can enter a comment for San Francisco and Boston, but not for Boston and 
California.
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To enter a comment: 
1. With the document open in the workspace, select the cell or cells for which you 

want to enter a comment.

2. Use CTRL + click to select cells that are not contiguous but are at the same level.

3. Click the right mouse button, or choose the Modify Selected Data button on the 
Document toolbar.

4. Choose Comments from the popup menu.

Result: The Comments dialog box opens. 

5. In the Reason box, select a reason code for the comment. 

6. In the New Comment box, enter text for the comment. You can enter up to 300 
characters.

7. Choose Add to add the comment.

8. To enter another comment for the same cells, repeat Steps 4 through 6. You can use 
the same reason code or you can select an alternate code. 

9. Choose OK to return to the worksheet.

Comments in copied measures
If you copy a measure, comment that have been entered at all levels will be included in 
the copy.

Recalculating data
Recalculation computes current data values and spreads changes to appropriate cells in 
a worksheet. Recalculation is automatically triggered when you perform one of the 
following actions:

• Save the worksheet.

• Lock or unlock cells.

• Change levels while editing data.

• Increase data, decrease data, fill cells, paste data into cells, or generate a statistical 
forecast.
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When data is recalculated following a change in a value at the lowest level, the data is 
aggregated up through all parent nodes. 

For example, if Boston is at the lowest level and you increase a data value for Boston 
and the data is recalculated, then Eastern Massachusetts, and Massachusetts will reflect 
the increase. 

When data is recalculated following a change at a higher level, data is allocated down to
the lower levels, based on the allocation rule specified for the measure, and then 
aggregated upward. 

For example, if you increase a data value for Eastern Massachusetts and the data is 
recalculated, then Boston and other values that are children of Eastern Massachusetts as
well as all parent nodes will reflect the increase. 

Recalculation ignores locked cells and their children and proportionately spreads data 
to other values.

Note: If a price list has been specified for the demand plan in the 
Demand Planning Server and a value for quantity is changed, the 
system recalculates the related amount. Similarly, if a value for amount 
is changed, the system recalculates the related quantity.

Usually, recalculation occurs in the background. However, you can recalculate data 
manually as you work. 

To recalculate data manually: 
To recalculate data manually, you must choose the Recalculate button on the Document
toolbar. 

The Summary step of the Oracle Demand Planning Measure Wizard has a checkbox at 
the bottom of the screen, Recalculate this Measure Now, which enables you to force a 
recalculation, page 17-20 when you are editing a measure.

Checking this box enables you to force a recalculation without making a critical change 
to the measure. For more information on using the Summary page, see the section on 
creating measures, page 17-20 in the "Using Measures" chapter. 

Resetting data
If you have made changes to a worksheet and you decide not to keep the changes, you 
can reset the data in the worksheet. You can roll back the values to the most recent 
modification. Alternatively, you can roll back the values to the last Save action. 

I
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Note: You can only reset data before you save the worksheet. You 
cannot reset data that has been saved.

To reset data: 
1. Choose the Reset Data button on the Document toolbar. 

2. Choose a reset option:

3. Reset options include the following.

Reset Data to Last Recalculation resets the data to the results just after the last 
recalculation. 

Reset Data to Last Save resets the data to the last time that the data was saved, 
regardless of the number of modifications that have been made.

Formatting Worksheets
You can change the appearance of data in a worksheet. The following types of format 
options are available:

• General — Specify parameters for displaying indented levels, horizontal and 
vertical gridlines, and rows that contain NA (unavailable) and zero data. Also 
specify how to handle formatting conflicts and drilling. 

• Font — Specify fonts for data and labels; also specify alignment for data in the body
of the worksheet.

• Autosizing — Specify sizing options for rows and columns.

• Display— Specify how to display editable cells, non-editable cells, modified cells, 
locked cells, and cells that contain comments.

• Titles — Specify text, font, alignment, and color information for a title, subtitle, and 
footnote.

• Format Rows and Columns — Specify how numbers will be displayed in selected 
rows and columns

Displaying Item Descriptions
When you add formatting to your worksheet, you can also customize labels so that the 
labels for values in a dimension are displayed in the format that you choose. In the 
product dimension, for example, you can display item descriptions next to their part 
numbers.
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The Dimension Labels Tab
You can set item descriptions by using the Dimension Labels tab of the Format 
Document dialog box.

There is a Label Type frame that displays a table or grad for the dimensions in the 
demand plan and their current settings for the document. The Dimension column 
displays the dimensions, and the Labels column displays the label settings. 

Item Description Formats
You may choose short, medium, or long labels for each dimension, independent of the 
labels chosen for other dimensions.

You have ability to change the display form of item descriptions in a document for all of
the preseeded dimensions, such as product, geography, ship from location, and time. 

You may also choose the Automatic method, which lets the application decide for you 
which type of dimension label is appropriate for a particular situation. In general, it 
tries to use space as efficiently as possible. The default formats for ad hoc reports, for 
example, are short for column dimensions and medium for row and page dimensions. 

The list below shows sample labels that appear for a product value as the various label 
formats are selected:

• Sentinel Standard Desktop (Ea) = Automatic

• FS54888 - Sentinel Standard Desktop (Ea) = Long

• Sentinel Standard Desktop (Ea) = Medium

• FS54888 = Short

The item descriptions are populated at the time of the demand plan's download.

Changing from One Description Format to Another
You can change labels from one format to another in a document.

When you choose a label format while in a worksheet, the format you have chosen for 
that particular dimension is displayed in the Available and Selected boxes of the Select 
Data dialog box when you it to view or modify the values in status.

Procedure: Using Item Description Formats in Worksheets
Follow this procedure to set the format (length) for dimension value labels in a 
worksheet.

1. Select the Format Document button on the Worksheet toolbar. 

2. Select the Format Document command from the submenu.

3. When Demand Planning displays the Format Document dialog box, select the 
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Dimension Labels tab.

4. Click on the cell in the Labels column of the Dimension for which you want to 
format labels. The cell opens a drop-down list with the choices: Automatic, Long, 
Medium, and  Short.

5. Select the display form you want to use for the dimension. The format you choose 
will not affect any other formats that you choose for other dimensions in the current
document.

6. Choose OK in the Format Document dialog box to complete the formatting of item 
descriptions.

Formatting general worksheet elements
You can set parameters that specify how to display levels of data, gridlines, and rows 
that contain NA (unavailable) and zero data. You can also specify how to handle 
formatting conflicts and drilling.

To specify general formats for a worksheet:
With the document open in the workspace, choose the Format Document button on the 
Document toolbar.

1. Choose Format Document from the popup menu.

Result: The Format Document dialog box opens. The General tab is active.

2. The General tab displays the current settings for worksheet elements. You can 
change one or more of the following settings:

• View Rows — Specify whether to show all rows or suppress rows with zero 
values, NA values, or both NA and zero values.

• Formatting Precedence (low to high) — Specify the precedence order for 
formatting when row, column, and page conflicts occur. For example, if you use
the Format Selected Rows and Columns option and choose purple as the text 
color for a row and then choose yellow as the text color for a column that 
intersects with the row, the setting for Formatting Precedence determines 
which color will display for the intersecting cell. 

• NA Spell — Enter a character or character string to represent NA data (up to 31
characters).

• Indent by Level — For dimensions that have a hierarchical structure, specify 
whether to indent rows by level and enter the number of indent characters to 
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use. 

• Horizontal Grid Lines — Specify whether to show or hide horizontal grid 
lines.

• Vertical Grid Lines — Specify whether to show or hide vertical grid lines.

• Enable Drilling — For dimensions that have a hierarchical structure, specify 
whether you can drill down to lower levels.

3. ChooseOK to apply your selections.

Formatting fonts and text alignment for a worksheet
You can select font, font size, and text alignment for a worksheet. Font settings will be 
applied to both the data and the labels in the worksheet. Alignment settings will be 
applied only to the data.

To select fonts and alignment for a worksheet:
With the document open in the workspace, choose the Format Document button on the 
Document toolbar.

1. Choose Format Document from the popup menu.

Result: The Format Document dialog box opens. The General tab is active.

2. Select the Font tab. 

3. The Font tab displays the current settings for font name, font size, and alignment. 
You can change one or more of these selections as follows: 

• Use the Font box to select the font name.

• Use the Size box to select the font size.

• In the Alignment box, select an alignment option for data values.

4. Choose OK to apply your selections.

Sizing rows and columns in a worksheet
You can change the size of rows and columns in a worksheet so that the information is 
easier to read. You can use a format option to change row or column size. You can also 
change column or row size manually. 
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To use a format option to set row and column size:
With the document open in the workspace, choose the Format Document tool on the 
Document toolbar.

1. Choose Format Document from the popup menu. 

Result: The Format Document dialog box opens. The General tab is active. 

2. Select the Autosizing tab.

3. The Row Sizing box displays the current setting for row size. You can choose one of
the following options: 

• Autosizing by Label — Automatically sizes the rows based on the height and 
width of the row labels. 

• Equal Sizing — Sizes rows based on a height and width that you specify. The 
row height is determined by multiplying the font size of the label by the value 
that you enter.

• None — Removes automatic or equal sizing from the rows. 

4. The Column Sizing box displays the current setting for column size. You can choose
one of the following options: 

• Autosizing — Automatically sizes the columns on the current page based on 
your selection. You can choose one of the following options:

• by Label — Sizes the columns according to the size of the individual 
column labels.

• by Data — Sizes the columns according to the size of the data each column 
contains.

• by Largest Data or Label — Sizes the columns to the larger of either the 
individual column labels or the data contained in each column.

• Equal Widths by Average Character — Sizes columns based on a width that 
you specify. 

• None — Removes automatic or equal sizing from the columns.

5. Choose OK to apply your selections.
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To manually size a row or column in a worksheet:
With the document open in the workspace, position the cursor on the border of the label
of the row or column whose size you want to change.

1. When the cursor changes to a double arrow, click and move the border. 

Result: If the current setting for row or column sizing is an Autosize option or None, 
each instance of the dimension value in the selected row or column will change size 
while the other rows or columns will retain their current size. If the current setting for 
column or row sizing is Equal, all of the columns or rows will change size. 

To reapply autosizing to columns or rows in a worksheet:
Choose the Format Document button on the Document toolbar.

• Alternatively, you can click the right mouse button in the document.

• Choose one of the following options from the popup menu:

• Reapply Autosizing — Applies default autosizing to rows and columns. Does 
not override manual resizing (drag and drop). 

• Reapply Autosizing to All — Applies default autosizing to rows and columns. 
Overrides manual resizing (drag and drop).

Note: If Equal sizing or None has been selected for rows and 
columns, the options for reapplying autosizing will not appear 
when you click the right mouse button. If Autosizing has been 
selected for either column or row, the options to reapply 
autosizing will appear when you click the right mouse button, 
but will only apply to the dimension position (column or row) 
that has autosizing turned on.

Specifying display formats for a worksheet
You can specify whether special display formats will apply to read-only cells and to 
cells that have been modified, locked, or associated with a comment in a worksheet.

Usually, you will want to have display formats turned on so that you can easily identify
the status of specific cells. However, if you have made many edits, your view of the 
data might become obscured. For example, if almost all of the cells in a worksheet are 
displayed in blue as a result of data modifications, blue will lose its meaning as an 
indicator of change. When this happens, you might want to turn off the Data Change 
Flags option (the format display option that denotes how modified data is displayed). 
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You can use this option to remove display formats from cells that have been edited, 
filled, increased, decreased, or pasted into.

Note: Turning a display format off or on does not affect any edits that 
you have made in the worksheet; it merely changes the appearance of 
modified cells.

To turn a display format off or on:
1. With the document open in the workspace, choose the Format Document button on

the Document toolbar

1. and choose Format Document from the submenu.

Result: The Format Document dialog box opens. The General tab is active.

2. Select the Display tab.

3. Check the display options that you want to view in this worksheet and clear those 
that you do not want to view. Options are as follows:

• Locked Cells — Specifies whether cells that have been locked will have a 
special display format. When this option is on, cells that have been locked will 
be displayed on a red background. 

• Commented Cells — Specifies whether cells that contain comments will have a 
special display format. When this option is on, cells into which a comment has 
been entered will be displayed in a bold font. 

• Data Change Flags — Specifies whether cells that contain modified data will 
have a special display format. When this option is on, data in cells that have 
been edited, forecasted, pasted into, increased, decreased, or filled will be 
displayed in a blue font. 

• Background Colors — Specifies whether non-editable (read-only) and editable 
cells will have special display formats. When this option is on, data in 
non-editable cells will be displayed on a dark gray background; data in editable
cells will be displayed on a pale gray background.

4. Choose OK to apply the current settings.

Note: If multiple formats overlap (for example, a cell is both locked 
and commented), one format takes precedence.
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Specifying a title, subtitle, and footnote for a worksheet
You can add a title, subtitle, and footnote to a worksheet and specify whether each of 
these elements will display in the current document.

To specify a title, subtitle, or footnote for a worksheet:
With the document open in the workspace, choose the Format Document button on the 
Document toolbar.

1. Choose Format Document from the popup menu. 

Result: The Format Document dialog box opens. The General tab is active.

2. Select the Titles tab. 

3. In the Select Title Type box, choose a text element such as Title, Subtitle, or 
Footnote, and proceed as follows: 

1. In the Font Properties box, select font properties (name, size, style, color, 
background color) for the text.

2. In the Alignment box, select an alignment option for the text.

3. In the Display Options box, choose Show to display the text element in the 
current document.

4. In the Text box, enter the text for the title, subtitle, or footnote (498 characters 
maximum). 

4. Repeat Step 4 for each text element that you want to include.

5. Choose OK to apply your selections. 

Applying numeric formats to selected rows and columns
You can apply unique number formats to selected rows and columns in an open 
worksheet. 

To format numeric values in selected rows or columns in a worksheet:
1. With the document open in the workspace, select the rows or columns in which you

want to format numbers.

1. To select a column, click the highlighter under the column label. Use SHIFT + click 
or CTRL + click to select more than one column.
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• To select a row, click the highlighter next to the row label. Use SHIFT + click or 
CTRL + click to select more than one row.

2. Choose the Format Document button on the Document toolbar.

3. Alternatively, you can click the right mouse button in the document.

4. Choose Format Rows and Columns from the popup menu.

Result: The Format Rows and Columns dialog box opens. 

5. The Number tab displays the current settings for numeric values. You can change 
the following settings:

• Decimal Digits — Specifies the number of decimal places to display.

• Use Thousands Separator — Indicates whether to display (or suppress) the 
thousands separator.

• Positive Values — Specifies the format for positive numbers (Available if you 
do not choose the Currency/Percent option).

• Display Leading Zero — Indicates whether to display (or suppress) leading 
zeros.

• Negative Values — Specifies the format for negative numbers (Available if you 
do not choose the Currency/Percent option).

• Apply Currency/Percent — Activates currency/percent format options:

• Symbol — Symbol for dollars, yen, pounds, francs, or percent.

• Positive Values — Format for positive values.

• Negative Values — Format for negative values. 

• Scale Values Down By — Specifies scaling for large numbers.

As you make formatting choices, the Samples box in the lower left corner of the
Format Number dialog box shows the effect that your choices will have on the 
data. 

6. Choose OK to apply your selections.
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Clearing row and column formatting
You can clear numeric formats that have been applied to selected rows and columns. 
You can clear formats from selected rows and columns or you can clear formats from all
rows and columns.

1. With the worksheet open in the workspace, select the rows or columns from which 
you want to remove formatting.

• To select a column, click the highlighter under the column label. Use SHIFT + 
click or CTRL + click to select more than one column.

• To select a row, click the highlighter next to the row label. Use SHIFT + click or 
CTRL + click to select more than one row.

2. Choose the Format Document button on the Document toolbar.

3. Alternatively, you can click the right mouse button in the document.

4. Choose Clear Selected Row and Column Formatting from the popup menu.

To clear all row and column formats:
Follow this procedure to clear row and column formats.

1. With the worksheet open in the workspace, choose the Format Document button on
the Document toolbar. 

2. Choose Clear All Row and Column Formatting from the popup menu.

Printing Worksheets
You can print an open worksheet and specify settings that determine how the printed 
pages will look. When you save the worksheet, Oracle Demand Planning saves the print
settings for order, scaling, and page setup.

You can also print one or more saved worksheets and other documents directly from 
the navigation list. Note that when you print multiple documents, you do not have the 
same options that are available when you print an open worksheet. For example, when 
you print an open worksheet, you can specify the pages to print (all or current). When 
you print multiple documents from the navigation list, Oracle Demand Planning prints 
all pages of the selected documents.
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To print an open worksheet:
1. With the document open in the workspace, choose the Print button on the 

Document toolbar

2. Result:The Print dialog box for your browser opens.

3. You can change the print defaults for the browser. For example, you can specify 
new values for printer and number of copies.

4. Choose OK to continue. 

Result: The Print dialog box for Oracle Demand Planning opens. 

5. In the Print box, specify the pages that you want to print. You can choose one of the 
following options: 

• Current Page of Data — Prints the current page of data as indicated by the 
page label.

• All n Pagesof Data — Prints all pages of data, beginning at the first logical 
page, regardless of the current page settings. 

Note: If you choose to print all pages, the system prints all data 
for all dimension values that are in the page position in the 
document. Depending on the number of dimensions that are in 
status in the page position, printing all pages might result in 
many pages of output. 

6. In the Order box, you can specify the order in which to print the pages. You can 
choose one of the following options: 

• Across then down — Prints as many rows and columns as will fit on a physical 
page, then moves across the columns (until all are printed) and then down the 
rows (until all are printed).

• Down then across — Prints as many rows and columns as will fit on a physical 
page, then moves down the rows (until all are printed) and then across the 
columns (until all are printed).

7. In the Scaling box, you can specify how to scale the document. You can choose one 
of the following options:

• Adjust to — Scales each logical page by a percentage that you select. The 
output will span the number of physical pages that are necessary to meet the 
specified percentage.
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• Fit to — Scales each logical page to span the width and height of the number of 
pages that you select. 

8. To indicate how you want the printed pages to look, choose Page Setup. This opens
the Page Setup dialog box, where you can perform the following operations:

• Specify optional header text (up to 100 characters) for the printed page.

• Specify an optional footer for the printed page.

• Specify whether row, column, and page labels will be repeated on each printed 
page.

• Specify whether a title, subtitle, and footnote will appear on the printed pages.

• Specify margin settings for the printed pages.

9. If you want to preview the pages before printing them, choose Preview.

10. Choose OK to print the document. 

To print multiple documents from the navigation list:

1. Access Oracle Demand Planning as a Demand Planner or Demand Plan Manager.

2. In the navigation list, open the folders that contain the documents that you want to 
print. 

3. Scroll to a document, press the CTRL key and simultaneously click the document 
object.

Result:The document is highlighted.

4. Repeat Step 3 for each document that you want to print.

5. After you make your final selection, click the right mouse button and choose Print 
from the popup menu. 

Saving Worksheets
You can save a worksheet for use at another time. When you save a worksheet, Oracle 
Demand Planning performs the following functions:

• Recalculates the data.

• Saves the data.
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• Saves the worksheet with the current data selections, formatting, layout and level of
detail. If cells have been modified, locked, or commented, this is also saved. 

If your responsibility is Demand Planner, saving a worksheet saves the data in your 
personal database. If your responsibility is Demand Plan Manager, saving a worksheet 
commits the data to the shared database.

You have the following options when you save a worksheet:

• You can save the document. The saved worksheet appears as an object in the main 
Documents folder in the navigation list.

• You can save the document in a folder that you have previously created. The saved 
worksheet appears as an object in the specified folder in the navigation list.

• You can save the worksheet as the default worksheet document. When you create a 
new worksheet that is based on the default, the new worksheet will have the 
measure and dimension value selections, layout, and format characteristics of the 
default.

Note: Before you save a worksheet as the default, you might want 
to remove distinctive format elements such as a title. 

To save a worksheet:
1. With the document open in the workspace, choose the Save As button on the 

Document toolbar.

2. The Save As dialog box opens. If you are saving a new document, a generic name, 
such as "Document 1," appears in the Save Document As box. If you are saving 
modifications to an existing document, its name appears in the Save Document As 
box. 

3. Specify the name for the worksheet that you are saving as follows:

• If you are saving a new worksheet, type a name for it in the  Save Document As 
box. The name can be up to 70 characters long.

• If you are saving an existing worksheet under a new name, replace the name in 
the Save Document As box with the new name. The name can be up to 70 
characters long.

• If you want to give the worksheet the name of an another saved document 
(overwrite a document), choose the Save As box and select a name from the list 
of saved documents.

If you are saving an existing worksheet under its current name, or if you intend 
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to save the document as the default worksheet, do nothing with the information
in the Save Document As box.

4. Do one of the following: 

• In the Into Folder box, select the folder into which you want to save the 
worksheet. 

To save the worksheet into the main Documents folder, select (none) in the Into
Folder box. 

or

• If you want to save the worksheet as your default worksheet document, so that 
its structure will appear whenever you create a new worksheet, select the Save 
As Default option. 

5. Choose OK to save the document.

Result: The Save As dialog box closes. The worksheet is again visible in the 
workspace. If you saved the worksheet into a folder, then the document object 
appears within that folder in the navigation list. 

Exporting Data from Worksheets
You can export dimension labels and data values from a worksheet to files that can be 
used in Microsoft Excel and other applications. You can select one of three export 
format options (CSV, TXT, or HTM for Excel 2000+), and export data from all pages or 
from a specific page.

Note: If a worksheet contains many pages of data, you might have 
difficulty opening the file in certain applications. To avoid this 
situation, modify the data selections to reduce the number of values 
before creating the exporting file.

To export data from a worksheet:
1. With the worksheet open in the workspace, choose the Export button on the 

Document toolbar.

2. In the As Type box, select the format for the export file:

• Comma delimited (*.csv) — Exports the data in Comma Separated Value 
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format, in which labels and data values are separated by commas.

• Tab delimited (*.txt) — Exports the data in text file format, in which labels and 
data values are separated by tabs.

• Excel 2000+ (*.htm) — Exports the data in a format that can be read by a 
browser and opened in Excel version 2000 and version 2002, also known as XP.

3. In the Options box, you can choose the following options for the export file: 

• Include Number Formatting — For a CSV or TXT export, check this option to 
export the data with the current setting for number formats. Do not check this 
option if you want to export unformatted numeric data. Note that an HTM 
export automatically includes number formats.

• Repeat Group Labels — Check this option to repeat outer labels for columns 
and rows of inner, nested dimensions. Do not check this option if you want the 
export file to display labels as they appear in the screen display. 

Include Title, Subtitle, Footnote — Check this option to include the title, 
subtitle, and footnote of the document in the export file. Do not check this 
option if you want to exclude these elements.

• Create One Sheet per Page — For a multi-page HTM export, check this option 
to export the data from each logical page to a separate Excel worksheet. Do not 
check this option if you want to export the data from all pages to a single Excel 
worksheet. For more information, see "About Excel 2000+ output files", page 11-
41.

4. Choose OK to continue.

Result:If you chose CSV or TXT format, the File Download dialog box opens. If you 
chose HTM format, the Export to HTML/Excel 2000+ dialog box opens. 

5. For a CSV or TXT export, proceed as follows:

1. In the File Download box, choose Save this file to disk.

Result: The Save As dialog box opens. 

2. In the Save in box, select the output directory for the file.

3. In the File name box, enter a name for the file.

4. Choose OK to export the file.

6. For an HTM export, proceed as follows:

1. In the Save in box, select the output directory for the file.
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2. In the File name box, enter a name for the file.

3. Choose  OK to export the file.

• Result: The Export dialog box opens.

• In the Export box, choose the pages to include in the export file. You can select one 
of the following options: 

• Current Page — Exports data from the current page as indicated by the page 
label.

• All n Pages — Exports all pages of data, beginning at the first logical page, 
regardless of the current page settings. 

About Excel 2000+ output files
When you export to a single worksheet in Excel 2000+ (*.htm) format, Oracle Demand 
Planning generates a single HTML file in the directory that you specify. 

When you export to a multi-page file in Excel 2000+ format and indicate that you want 
to create one sheet per page, Oracle Demand Planning generates an HTML table of 
contents file plus a number of other files in the directory that you specified. Use the 
table of contents file to access the individual worksheets.

Closing Worksheets
When you have finished working in a worksheet, you can close it. If you have modified 
the worksheet but did not save it, you will be prompted to specify whether you want to 
save the document. 

To close a worksheet:
Choose the Close button, located in the upper right corner of the document. 

Renaming Worksheets
You can give a new name to a saved worksheet. If the document is in more than one 
folder, it will be renamed in all folders.



11-42    Oracle Demand Planning Implementation and User's Guide

To rename a worksheet:
Note: To search for a worksheet, click the right mouse button on the 
main Documents folder or a specific document folder, choose Find 
Documents, and enter a name or name fragment. Alternatively, you 
can choose the Find button on the navigation toolbar.

1. In the navigation list, identify the worksheet that you want to rename.

2. Click the right mouse button on the document object and choose Rename from the 
popup menu.

3. Enter the new name. The name can be up to 70 characters long.

Viewing Worksheet Properties
You can view the following properties of a saved worksheet:

• Name — Document name

• Date — Date created

• Modified — Date modified

• Class — Shared (from the shared database) or Personal (user-defined)

• Applied saved selections — If a saved selection has been applied, the name of the 
saved selection

To view worksheet properties:
1. In the Navigation list, identify the worksheet whose properties you want to view.

2. Click the right mouse button on the document object and choose Properties from 
the popup menu.

3. To search for a worksheet, click the right mouse button on the main Documents 
folder or a specific document folder, choose Find Documents, and enter a name or 
name fragment. Alternatively, you can choose the Find button on the navigation 
toolbar.

Deleting Worksheets
When you no longer need a saved worksheet, you can delete it. If the document exists 
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in another folder, that version will not be deleted.

You can delete an individual worksheet. You can also delete a worksheet as one of 
multiple documents.

To delete a single worksheet:
Access Oracle Demand Planning as a Demand Planner or Demand Plan Manager.

1. In the navigation list, identify the worksheet that you want to delete.

Note: To search for a worksheet, click the right mouse button on 
the main Documents folder or a specific document folder, choose 
Find Documents, and enter a name or name fragment. 
Alternatively, you can choose the Find button on the navigation 
toolbar.

2. Choose the worksheet and choose the Delete button on the navigation toolbar.

3. Alternatively, you can click the right mouse button on the document object and 
choose Delete from the popup menu.

Result: You will be prompted to confirm the deletion.

To delete multiple documents:

1. Access Oracle Demand Planning as a Demand Planner or Demand Plan Manager.

2. In the navigation list, open the folders that contain the documents that you want to 
delete.

3. Scroll to a document, press the CTRL key and simultaneously click the document 
object.

Result:The document is highlighted.

4. Repeat the previous step for each document that you want to delete.

5. After you make your final selection, click the right mouse button and choose Delete
from the popup menu. 

Result:You will be prompted to confirm the deletion.
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12
Preserving Forecast Adjustments

This chapter covers the following topics:

• Persistent Forecast Adjustments

• Why Preserve Forecast Adjustments?

• Designating Data as Cycle Persistent

• Standard Versus Persistent Locks

• Cycle-Persistent Locks and the Planning Process

• Copying Data and Locks to Another Measure

• Accessing Advanced Locking Functionality

• Making Your Data Cycle-Persistent

• Applying Persistent Locks in Worksheets

• Removing Persistent Locks in Worksheets

• Using Standard Locks in Your Worksheets

• Resolving Locking Conflicts

• Preserving Locked Data for Submission to the Planning Manager

• Applying Previous Adjustments to New Planning Cycles

• Distributing Adjusted Forecasts with Cycle-Persistent Data

Persistent Forecast Adjustments
Demand planners can lock adjustments made to a forecast, submit the forecast, and 
have their adjustments saved and reapplied during the next cycle. The process relies on 
persistent locks to carry the adjustments to the next planning cycle and beyond.

The ability to specify data as being cycle-persistent is supported and enhanced by 
advanced locking functionality in Oracle Demand Planning. The use of advanced 
locking to create cycle-persistent data makes the forecasting process faster and more 
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efficient in many business situations.

Advanced Locking is accessed via the Tools icon or via the worksheet through the 
right-click menu.

Why Preserve Forecast Adjustments?
Demand planners and managers want to be able to override a generated forecast for 
one or more planning cycles with known demand when customers have known sales 
volume, when there are promotions with known volume amount, or when special 
products have known volume amounts.

There may also be occasions when the business knowledge and experience of the 
planner or manager dictates that a forecast's modifications should be preserved from 
cycle to cycle.

Designating Data as Cycle Persistent
Planners and managers, while adjusting forecasts before submission, apply persistent 
locks to particular sets of data. Without cycle-persistent locks, after submission, the 
known demand adjustments are lost when the new forecast is generated for the next 
planning cycle.

With cycle-persistent locks, the data adjustments, locks, and comments are transferred 
to the shared database. The individual forecast Submission measure retains the locked 
values in the planning database even if the Planning Manager feels it is necessary to 
override the locked data in the consolidated measure.

In the next planning cycle, the System Administrator can reapply the previous cycle's 
preserved adjustments from the consolidated Submission measure to the new baseline 
forecast for a scenario.

Note: A planner who adds persistent locks to a measure shared with 
the Planning Manager should copy the data, locks, and comments to a 
personal copy of the measure in order to preserve the adjustments.

Note: Because formula measures are calculated when accessed, there is 
no stored value to lock. Locks can only be applied to stored measures.

Standard Versus Persistent Locks
Standard locks are set in a worksheet to prevent the values in locked cells from being 
affected when data is recalculated. You can lock single cells or blocks of cells and attach 
comments to them. Protecting the value in a cell also protects the child values.

Persistent locks are set in the worksheet to protect values from being affected when data 
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is recalculated. They also to enable the data to span planning cycles -- the modified 
values, locks, and comments are transferred to the shared database.

A cycle-persistent lock is a lock on a measure tuple (set of interconnected dimension 
values). Setting the lock simultaneously accomplishes the following tasks:

• It prevents the designated dimension values from being overwritten by worksheet 
operations during a planning cycle.

• It prevents the values from being overwritten after the measure has been submitted 
into the shared database.

• It prevents the values from being overwritten even after the measure is integrated 
into the forecast of a scenario during the next forecast cycle.

Persistent and standard locks behave identically in the planner database. However, 
during the submission process, persistent locks and comments are submitted, while 
standard locks are not.

Cycle-Persistent Locks and the Planning Process
The following list of events demonstrates the role of the preserve forecast adjustments 
feature in the overall demand planning process.

1. The System Administrator distributes the baseline forecast.

2. Planners recreate or modify the forecast and apply cycle-persistent locks to their 
modifications.

3. The Planner submits the modified forecast. Persistent locks and comments 
associated with the submitted measure are automatically submitted. The Planning 
Manager can make additional adjustments.

4. Adjustments are applied to the shared database.

5. The System Administrator creates the statistical baseline forecast for the next cycle 
and checks the Apply persistent locks and adjustments from Previous cycle for 
Scenario option in the Measure Wizard Properties tab. The persistently locked 
adjustments are applied.

6. The forecasts are distributed.

7. Demand planners receive the adjusted forecasts with their preserved adjustments 
and make modifications for the new data from the current cycle

8. The modified forecast is submitted.
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Copying Data and Locks to Another Measure
Demand planners may copy persistent data and locks from one measure to another. 
This can become necessary during a planning cycle when a quick distribution is 
performed. Normal behavior during a quick distribution is that the lock states revert to 
those that were extant when the measure was initially distributed.

A demand planner might preserve modifications to a measure by copying the 
cycle-persistent data, with its locks and comments, into a temporary measure. The data, 
locks, and comments can then be reapplied to the original measure when it has been 
redistributed.

For example:

1. The measure "Booking History Forecast" is distributed by the System 
Administrator.

2. The planner makes adjustments and modifications to his personal copy of the 
scenario default measure, "Booking History Forecast," and sets cycle-persistent 
locks on specific dimension values.

3. The Planning Manager notifies demand planners that a "quick distribution" is 
imminent. If the quick distribution includes the measure on which the planner has 
put locks, it will overwrite the planner's private copy.

4. The planner creates a new temporary measure and specifies that the new measure 
should include cycle-persistent data (with its locks and comments) from the 
measure "Booking History Forecast."

5. The quick distribution occurs. Any updated values in "Booking History Forecast" 
are overwritten, and any modifications to cycle-persistent locks are lost.

6. To restore his locks and data, the planner edits the properties of the measure 
"Booking History Forecast," and specifies that any cycle-persistent data should be 
included from the temporary measure.

7. The data, locks, and comments are copied into "Booking History Forecast."

Procedure: Creating a Temporary Measure to Preserve Cycle-Persistent Locks
One way of preserving cycle-persistent locks is to create a temporary measure.

1. On the Navigation toolbar, click the New button.

2. From the command menu, choose New Measure.

3. From the submenu, choose Stored Measure.
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4. Demand Planning displays the Measure Wizard. 

5. In the Choose Method step, name the measure by entering a name in the text box 
below the Specify a name for your new measure label.

6. Choose the Copy measure option button and go to the next step.

7. In the box below the What measure do you want to copy your data from? label, 
select, from the drop-down list, the name of the measure containing the persistent 
locks.

8. Use the Next button to navigate to the Properties step.

9. To ensure that the cycle-persistent locks are transferred to the target measure, check
the box labeled Make the measure editable in worksheets.

10. Check the box labeled Apply persistent locks and adjustments from.

11. Choose the Selected Measure option, and select the name of the name of the 
measure containing the persistent locks from the drop-down list.

12. Make sure that the Overwrite existing locked data in the target measure box is 
checked.

13. Navigate through the remaining steps of the wizard and create your measure.

Procedure: Restoring Data, Locks, and Comments After a Quick Distribution
After the quick distribution, you can then restore the data, locks, and comments in the 
measure that was overwritten.

1. The temporary measure that you created and saved is listed in the Navigation list in
the Measure folder or some subfolder within it.

2. Select the name of the temporary measure and right-click.

3. From the popup menu, choose Edit.

4. Demand Planning enables you to access the re-entrant Measure Wizard for the 
temporary measure. The re-entrant wizard has all steps as tabs on a single dialog 
box.

5. Choose the Copy measure tab and make sure that you select, from the drop-down 
list, the name of the temporary measure in the What measure do you want to copy 
your data from? box.

6. Use the Next button to navigate to the Properties step.
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7. Check the box labeled Apply persistent locks and adjustments from.

8. Choose the Selected Measure option, and select the name of the name of the 
temporary measure containing the persistent locks from the drop-down list.

9. Make sure that the Overwrite existing locked data in the target measure box is 
checked.

10. Navigate through the remaining steps of the wizard and choose Finish.

11. You have restored the data, locks, and comments in the measure that was 
overwritten by the quick distribution.

Accessing Advanced Locking Functionality
There are three ways for a demand planner or Planning Manager to access locking 
functionality in Demand Planning worksheets. These are described below.

1. You can access the Advanced Locking dialog box from the Navigation toolbar, by 
way of the Tools menu.

This is the method that offers the most efficient method of locking large numbers of 
values because it enables you to use the Selector tools.

2. You can use the Modify Selected Data menu, available from the worksheet toolbar.

3. You can modify and lock small numbers of cells in the worksheet by selecting them 
manually and using the commands on the right-click popup menu.

Description of the Advanced Locking Dialog Box
The Advanced Locking dialog box enables you to accomplish cell locking in a more 
efficient manner by using the Select Data dialog box and its full set of tools. You can do 
the following:

• Set standard locks.

• Set persistent locks.

• Assign comments and reason codes to selected values.
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Making Your Data Cycle-Persistent
There are two major steps to using cycle-persistent data. 

1. You apply persistent locks, in the Advanced Locking dialog box, to the measure to be 
submitted.

2. You submit the measure with persistent locks.

During the next planning cycle, the cycle-persistent data, with its locks and associated 
comments, will be applied by the System Administrator and distributed as part of your 
assignment. 

For more information on using persistent locks in your worksheets, refer to the 
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following topics:

• Applying Persistent Locks in Worksheets, page 12-8

• Removing Persistent Locks in Worksheets, page 12-13

Applying Persistent Locks in Worksheets
The procedures that follow describe how to apply persistent locks in several ways.

Procedure: Applying Persistent Locks with Advanced Locking
You can apply persistent locks with the Advanced Locking feature.

1. From the Navigation toolbar, click the Tools icon.

2. From the Tools menu, select Advanced Locking.

Demand Planning displays the Advanced Locking dialog box.

3. In the Action frame choose Apply Persistent Locks to Selected Dimension Values.

4. In the Dimension Value Selections frame, choose the dimension values you intend 
to lock. 

You can double-click in the Values Selected column for any dimension to access 
the Select Data dialog box, or you can choose Edit at the right of the frame.

Note: When you use the Select Data dialog box from the Advanced 
Locking dialog box, you will NOT (as a planner) see values that are 
above your assignment level. You see values at the planning value 
and below.

5. Once you are in the Select Data dialog box, you must select one or more values from 
every dimension that you can access in the Select values for box. 

Because each dimension in the plan is dimensioned by all the other dimensions, you
must create a "data cube" or "tuple" before you can lock specific values. Until you 
do this, the OK button in the Select Data dialog box is not enabled.

The Measure dimension will only include lockable stored measures, not their 
quantity and amount submeasures. You also cannot use advanced locking on 
formula measures, accuracy measures, or on planning percentages and dependent 
demand.

6. Choose OK in the Select Data dialog box. When you return to the Advanced Locking 
dialog box, the selections table is updated immediately -- your selections and the 
effects of those selections are visible.
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• If the values selected with explicit locks, plus the values that they affect, total 
more then 30,000 values, Demand Planning will display a warning. Although it 
will use significant system resources, the application will continue with the 
operation if that is your choice.

• You should be aware that, because each measure being processed may have 
different allocation floors, the calculation of the number of dimension value 
combinations that is affected may be influenced in such a way that the total is 
less than the product of all Values Affected totals.

7. Decide whether you want to enter a comment to be applied to all of the selected 
locked values, describing the reason for the locking them.

If you want to add a comment, check the Add Comments to Selected Cells box.

8. If your System Administrator has created reason codes for comments, they will be 
available from the Reason Code list box. If reason codes are not available, you can 
still enter a comment in the Comment text box.

9. Choose OK to complete the locking operation.

Procedure: Applying Persistent Locks with the Modify Selected Data Tool
You can apply persistent locks with the Modify Selected Data tool.

1. Open a new or saved worksheet.

2. Select the cells that you intend to lock. They are highlighted.

3. From the Navigation toolbar, choose Modify Selected Data.

4. From the Modify Selected Data menu, select Lock Cells.

5. From the submenu, select Persistent Locks.
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Demand Planning applies locking to the selected cell or cells, as reflected by the 
change in background color.

Note: Remember that you will not be able to apply locks to any 
values that are above your assignment level or the default level for 
the plan.

6. Adding a comment is always an optional activity, but you may be more likely to 
add one when you have locked an individual cell or a small number of cells without
resorting to advanced locking.

To add a comment explaining why you have locked cells, you must select the 
locked cells again and then select the Comments command from the Modify 
Selected Data menu to access the Comments dialog box.

1. Enter a comment in the New Comment box.

2. Select a reason code, if one is available from the Reason box.

3. Choose Add.

4. Choose OK.

Note: Whether you add comments or not, you must save the 
worksheet for your locking operation to take effect.

7. Choose Save As from the Worksheet toolbar and save the worksheet.
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Procedure: Applying Persistent Locks Manually
You can apply persistent locks manually.

1. Open a new or saved worksheet.

2. Select the cells that you intend to lock. They are highlighted.

3. Right-click to access the worksheet commands popup menu.

4. Select Lock Cells.
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5. From the Locking submenu, select Persistent Locks.

6. Demand Planning applies locking to the selected cell or cells, as reflected by the 
change in background color.

Note: Remember that you will not be able to apply locks to any 
values that are above your assignment level or the default level for 
the plan.

7. Adding a comment is always an optional activity, but you may be more likely to 
add one when you have locked an individual cell or a small number of cells without
resorting to advanced locking.

To add a comment explaining why you have locked cells, you must reselect the 
locked cells. Then, select Comments from the worksheet commands popup menu to
access the Comments dialog box.

1. Enter a comment in the New Comment box.

2. Select a reason code, if one is available from the Reason box.

3. Choose Add.

4. Choose OK.

Note: Whether you add comments or not, you must save the 
worksheet for your locking operation to take effect!

8. Choose Save As from the Worksheet toolbar and save the worksheet.
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Removing Persistent Locks in Worksheets
The procedures that follow describe how to "unlock" data to which you have applied 
cycle-persistent locks. An "unlock" or remove operation affects your last modification of
that kind (i.e., persistent versus standard).

Procedure: Removing Persistent Locks with Advanced Locking
This procedure explains how to remove persistent locks with Advanced Locking.

1. Open a worksheet containing locked cells. Cells that have cycle-persistent locks will
be dark pink in color.

2. From the Navigation toolbar, choose the Tools icon.

3. From the Tools menu, select Advanced Locking.

Demand Planning displays the Advanced Locking dialog box.
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4. In the Action frame, choose Remove Locks from Selected Dimension Values.

You will see that all of the non-measure dimensions are disabled in the Dimension 
Value Selections frame.

The contents in the grayed-out Values Selected and Values Affected columns (for 
non-measure dimensions) are set to (all).

5. Choose Edit. 

Demand Planning displays the Dimension Value Selector for the Measure dimension. 
A list of the measures in which locks can be removed is displayed.

You can select the measure from which you want to remove locks.

6. Choose OK in the Dimension Value Selector.

Demand Planning removes the locks from the selected cell or cells, as reflected by 
the change in background color.

7. Choose OK in the Advanced Locking dialog box.

8. Choose Save As from the Worksheet toolbar and save the worksheet.

Procedure: Removing Persistent Locks with the Modify Selected Data Tool
This procedure explains how to remove persistent locks by using the Modify Selected 
Data tool.

1. Open a worksheet containing locked cells. Cells that have cycle-persistent locks will
be dark pink in color.

2. Select the cells that you intend to unlock. They are highlighted.

3. From the Navigation toolbar, choose Modify Selected Data.

4. From the Modify Selected Data menu, select Unlock Cells.

5. From the submenu, select Persistent Locks.

Demand Planning removes the locks from the selected cell or cells, as reflected by 
the change in background color.

6. Choose Save As from the Worksheet toolbar and save the worksheet. 

Note: You must save the worksheet for your unlocking operation to
take effect!
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Procedure: Removing Persistent Locks Manually
This procedure explains how to remove persistent locks manually.

1. Open a worksheet containing locked cells. Cells that have cycle-persistent locks will
be dark pink in color.

2. Select the cells that you intend to unlock. They are highlighted.

3. Right-click to access the worksheet commands popup menu.

4. Select Unlock Cells.

5. From the Locking submenu, select Persistent Locks.

Demand Planning removes the locks from the selected cell or cells, as reflected by 
the change in background color.

6. Choose OK in the Advanced Locking dialog box.

7. Choose Save As from the Worksheet toolbar and save the worksheet.

Procedure: Removing All Locks
This procedure describes how to remove all locks in a measure using the Advanced 
Locking dialog box. It applies to both persistent and standard locks.

1. Open a worksheet containing locked cells. Cells that have cycle-persistent locks will
be dark pink in color. Cells with standard locks have a light pink background color. 
Cells in which the numbers are in bold font have a comment attached.

2. From the Navigation toolbar, choose the Tools icon.

3. From the Tools menu, select Advanced Locking.

Demand Planning displays theAdvanced Locking dialog box.

4. In the Action frame, choose the Remove Locks from All Dimension Values of 
Selected Measures button.

You will see that all of the non-measure dimensions are disabled in the Dimension 
Value Selections frame.

The counts in the grayed-out Values Selected and Values Affected columns are set 
to (all).

The Add Comment to Selected Cells checkbox is disabled.

5. Choose Edit.



12-16    Oracle Demand Planning Implementation and User's Guide

Demand Planning displays the Dimension Value Selector dialog box for the Measure 
dimension. A list of the measures in which locks have now been removed is 
displayed.

Demand Planning removes the locks from the selected cell or cells, as reflected by 
the change in background color.

6. Choose OK in the Advanced Locking dialog box.

7. Choose Save As from the Worksheet toolbar and save the worksheet.

Using Standard Locks in Your Worksheets
The procedures for applying standard locks in worksheets do not differ significantly 
from the procedures for applying persistent locks. Refer to the following procedures for 
these tasks:
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• Procedure: Applying Persistent Locks with Advanced Locking, page 12-8

• Procedure: Applying Persistent Locks with the Modify Selected Data Tool, page 12-
9

• Procedure: Applying Persistent Locks Manually, page 12-11

• Procedure: Removing Persistent Locks with Advanced Locking, page 12-13

• Procedure: Removing Persistent Locks with the Modify Selected Data Tool, page 12-
14

• Procedure: Removing Persistent Locks Manually, page 12-15

• Procedure: Removing All Locks, page 12-15

The most important difference between applying standard and persistent locks is that 
standard locks can be applied to any of the values displayed in a worksheet, as long as 
the measure is editable. However, when you use advanced locking, persistent locks can 
only be applied at the planner's assignment level or below. This is enforced in the Select 
Data dialog box, when you access it from the Advanced Locking dialog box. You will not 
be able to see values that are above the assignment level.

When you access the Select Data dialog box from the Advanced Locking dialog box to 
apply standard locks, you will be able to see all values for each particular dimension.

Resolving Locking Conflicts
During the process of copying persistent data, locks, and comments from one measure 
to another, a conflict may occur between the source measure and the target measure.

Conflicts tends to arise because of one of two problems: either the target measure has 
locks on the same cells that the source measure is trying to overwrite, or else the source 
and target measures have different allocation and/or aggregation methods.

Locks are copied at the highest level in order to implicitly lock the child values.

The following rules apply in cases of locking conflicts between a source and a target 
measure:

• If the target measure has an allocation floor, it must be equal to or lower than the 
allocation floor of the source.

• You cannot copy data, locks, and comments between measures that have different 
aggregation methods.

• You cannot copy data, locks, and comments between measures that have different 
allocation methods.
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• You cannot copy data, locks, and comments between measures with are 
dimensioned by different dimensions.

• You cannot copy data, locks, and comments to a measure that has its allocation set 
to None.

In the event that a source measure with cycle-persistent data is copied to a target 
measure and the source measure has a higher allocation floor, the data of the allocation 
floor level children of persistent-locked cells is copied over and allocated down.

Preserving Locked Data for Submission to the Planning Manager
When a planner places persistent locks on worksheet cells, the data is preserved across 
planning cycles. This means that the locks are submitted along with the measures to 
which they apply. The locks, data, and associated comments may be copied into the 
scenario measure which is generated for the next planning cycle (if the System 
Administrator has selected that option in the Measure Wizard).

Submitting Cycle-Persistent Data
If you work as a demand planner and select a final forecast to submit to the shared 
database, the persistent locks currently associated with the measure are automatically 
collected when the data collection stage runs. The data is marked for consolidation in 
the shared database, where it will be reviewed by the Planning Manager.

Only cycle-persistent data, locks, and comments that fall within the bounds of a 
planner's write scope are submitted, just as with adjusted planning data. 
Cycle-persistent data, locks, and comments outside of an assignment's write scope, but 
within its view scope, are not included.

Before the Submission measure is uploaded, the Planning Manager can remove 
cycle-persistent locks that planners have placed on the submitted measures.

When you work as a Demand Plan Manager and select a forecast to upload to the 
Demand Planning Server, the persistent locks associated with the measure are 
automatically uploaded when the upload stage runs.

Collecting Cycle-Persistent Data
When the System Administrator collects assignments, a process in Oracle Workflow 
reads the contents of the planners' submitted measures into the Submission measure 
specified for a particular scenario. Contents of submitted cycle-persistent locks are 
imported, both explicit and implicit locks. Comments are also imported. 

Applying Previous Adjustments to New Planning Cycles
Demand planners can apply the data of the explicitly cycle-locked cells and the child 
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values that inherit those locks from a previous scenario's default measure. The cycle 
locked data is copied with the locks intact as well as any comments associated with the 
locked tuples.

Procedure: Applying Previous Adjustments to New Planning Cycles
To copy data from a previous planning cycle, follow the steps described below:

1. On the Navigation toolbar, click New.

2. From the command menu, choose New Measure.

3. From the submenu, choose Stored Measure.

Demand Planning displays the Measure Wizard. 

4. In the Choose Method step, name your measure by entering a name in the text box 
below the Specify a name for your new measure label.

5. Choose Copy Measure and go to the next step.

6. In the box beneath the What measure do you want to copy your data from? label, 
select, from the drop-down list, the name of the measure containing the persistent 
locks.

7. Click Next to navigate to the Properties step.

8. To ensure that the cycle-persistent locks are transferred to the target measure, check
the box labeled Make the measure editable in worksheets box.

9. Check Apply persistent locks and adjustments from.

10. Choose Previous cycle for scenario.

The box to the right of the option is now enabled. If there is only one measure 
available, the name will appear in the box. 

11. If there are multiple measures, you can select one from a drop-down list.

12. Check Overwrite existing locked data in the target measure.

13. Navigate through the remaining steps of the wizard and create your measure.

Demand planners can also copy the data of explicitly cycle-locked cells and child values
from a selected measure. The Measure Wizard is the vehicle for doing this, for more 
information refer to "Creating a Temporary Measure to Preserve Cycle-Persistent 
Locks."
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Distributing Adjusted Forecasts with Cycle-Persistent Data
By using persistent locks to save forecast adjustments, the Demand Planning System 
Administrator can reapply the previous cycle's preserved adjustments to the new 
baseline forecast for a scenario.

When Distribution occurs, the previous cycle's data adjustments, locks, and comments 
are part of the distributed forecast.

The System Administrator specifies the inclusion of cycle-persistent data in the 
distribution of measures to assignments by modifying the properties of the measures 
that are distributed. The modification of measures is accomplished by using the 
procedure described in "Applying Previous Adjustments to New Planning Cycles."

The System Administrator can specify that, for any existing or newly-defined measure, 
its data can be overwritten with any cycle-persistent data found in another measure or 
the default measure of a specified scenario.
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13
Using the Planning Percentages Worksheet

This chapter covers the following topics:

• About the Planning Percentages Worksheet

• Opening the Planning Percentages Worksheet

• Setting up the Planning Percentages Worksheet

• Changing the Layout to Enhance Analysis

• Display and Calculations in the Planning Percentages Worksheet

• Calculating Dependent and Total Revenues

• Reusing Planning Percentages

• Modifying Data in the Planning Percentages Worksheet

• Displaying Parent and Child Values in the Worksheet

• Saving Data in the Planning Percentages Worksheet 

• Printing the Planning Percentages Worksheet

• Exporting Data from the Planning Percentage Worksheet

• Planning Percentage Usability Enhancements

• Closing the Planning Percentages Worksheet

About the Planning Percentages Worksheet
The Planning Percentages worksheet enables you to view and edit data for dependent 
demand and planning percentages of options. Dependent demand describes the 
relationship between the demand for models and their optional components. The 
planning percentages are the attach rates, or ratios of options to model demand. If 
global bills of materials has been chosen for dependent demand, the planning 
percentage objects shown in the worksheet aren't dimensioned by organization; instead,
the results are organized by the global bill of materials. By editing the results, you 
change the global planning percentages and affect the demand for all inventory 
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organizations.

When you work as a planner and select a final forecast to submit to the shared database,
the planning percentages currently associated with the measure are automatically 
collected when the data collection stage runs. When you work as a Demand Plan 
Manager and select a forecast to upload to the Demand Planning Server, the planning 
percentages associated with the forecast are automatically uploaded when the upload 
stage runs. Once uploaded, the planning percentages can be written back to Oracle 
Advanced Supply Chain Planning (ASCP). 

Example: Planning Percentages worksheet
Consider an example, where you want to view the following information for item 
GMXY77 (ea):

• Independent demand 

• Planning percentages

• Dependent demand

• Total demand (independent + dependent demand)

Note that all the above-mentioned information would be is based on the model product,
which, in this example, is GMXY77 (ea).
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Differences between the Planning Percentages worksheet and a standard worksheet 
Following are some differences between the Planning Percentages worksheet and a 
standard worksheet:

• The standard worksheet is typically used with four dimensions: Time, Product, 
Geography, and Organization. The Planning Percentage worksheet is not 
dependent on Geography; the planning percentages show the relationships 
between item level products for the lowest level organizations and time.

• A standard worksheet displays data based on hierarchies that have been 
established for the dimensions in the Demand Planning Server. The Planning 
Percentages worksheet displays data in terms of model > option dependencies 
based on model bills of material. 

• When you save a standard worksheet, you name it and save the layout and 
dimension value selections. When you save the Planning Percentages worksheet, 
you save the data. The most recently saved layout will appear when you next open 
the Planning Percentages worksheet from the Tools menu on the Navigation 
toolbar.
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Opening the Planning Percentages Worksheet
There are two methods for opening the Planning Percentages worksheet: 

• You can open the worksheet from the Tools menu on the Navigation toolbar. The 
Planning Percentages Worksheet opens in the full vertical document workspace. If 
the Planning Percentage worksheet has been previously saved, the format reflects 
the saved layout. 

• You can open the Planning Percentages worksheet from a cell in a standard 
worksheet. Values for Product, Ship from Location, Geography, and Time are based
on the cell from which you invoked the Planning Percentages worksheet. 

To open the Planning Percentage worksheet from the Tools menu:
1. Access Oracle Demand Planning as a Demand Planner or Demand Plan Manager.

2. On the navigation toolbar, choose the Tools button,

3. Choose Planning Percentages Worksheet.

To open the Planning Percentages worksheet from a standard worksheet:
1. With a worksheet open in the workspace, click the right mouse button in any cell in 

the document.

Result: A menu of options appears.

2. Choose Planning Percentages Worksheet.

Toolbar for Planning Percentages worksheet
The Document toolbar appears at the top of an open Planning Percentages worksheet. 
The toolbar buttons enable you to perform the functions that are listed below.

• Choose Values from List - Select dimension values and measures including 
planning percentages.

• Change Layout - Change the relative positions of the dimension tiles in the 
worksheet layout.

• Export to Spreadsheet - Export data and labels from the worksheet to a .CSV, .TXT, 
or .HTM file.
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• Save As - Save the data in the active worksheet.

• Add Parent - Select the immediate parents (models or option classes) to which an 
option is associated.

• Recalculate - Recalculate the data in the worksheet.

• Reset Data - Reset unsaved data to a previous status.

• Print - Print the worksheet.

• Help - Get online help.

Setting up the Planning Percentages Worksheet
You set up the Planning Percentages worksheet so that it displays the models and 
options that you want to work with. Proceed as follows:

• Populate the worksheet by selecting the product on which you want to focus. Also 
choose values for the other dimensions, including Measure.

• Size the columns so that you can view the data.

• Drill to view product dependencies (children).

• Add parents. 

Selecting data for the Planning Percentages worksheet
Following are considerations for selecting data for the Planning Percentages worksheet:

• For Measure: Ensure that the worksheet includes the measure on which you want 
to focus (for example, Forecast of Booking History). Also choose the related 
Dependent Demand measure (for example, Forecast of Booking History, Dependent
Demand), the related Total Demand measure (for example, Forecast of Booking 
History, Total Demand) and the associated planning percentage object for the 
measure (for example, Forecast of Booking History, Planning Percentage). 

For a forecast, you might also want to choose measures for history and dependent 
history to see how the planning percentages were calculated. Again for a forecast, 
you might want to include another planning percentage object for comparison 
purposes. For example, you might compare forecasted planning percentages with 
the existing planning percentages.

• For Product: Choose product at the item level. 

• For Time: If you want to be able to edit data for dependent demand and planning 
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percentages, take care when selecting time values. If you are using the existing 
planning percentage or a copy of the existing planning percentage, then select Time 
at the lowest level. This is either the Day level or the lowest level for every calendar 
used by the plan. If you are using a planning percentage based on forecasting or 
averaging dependent history, select the time level at which the forecast or average 
was generated. For example, if you want to view dependencies for planning 
percentages generated by forecasting at the monthly level, then you would choose 
monthly values within the time range for the forecast. 

• For Ship-to location: You view and select Ship-to-location values at the 
Organization level. 

Note: You cannot choose previously saved selections, custom 
aggregates, or formula measures. Although these are valid in other 
documents, they cannot be selected in the Planning Percentages 
worksheet.

To select data for the Planning Percentages worksheet:
1. With the worksheet open in the workspace, choose the Select Data button on the 

Document toolbar. 

2. Result: A list of the dimensions in your database appears. The list includes 
Measure.

3. Choose a dimension for which you want to select values.

Result: The Select Data dialog box opens. The dimension that you chose is displayed
in the Select Values for box.

Choose values for the current dimension, noting the special considerations for 
Planning Percentage worksheet selections that are listed at the beginning of this 
section.

4. To select values for another dimension, in the Select Values for box choose the 
dimension and repeat Step 2.

5. Repeat Steps 2 and 3 until the worksheet includes the values that you want to work 
with. 

Sizing rows and columns in the Planning Percentages worksheet
You can adjust the size of rows or columns in the Planning Percentages worksheet. 
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To size a row or column in a worksheet:
1. With the document open in the workspace, position the cursor on the border of the 

label of the row or column whose size you want to change.

2. When the cursor changes to a double arrow, click and move the border. 

Drilling in the Planning Percentages worksheet
You can drill the root product in the worksheet. This enables you to view data for 
options that have a dependent relationship to the root as defined in the Bills of Material.

To drill a product:
With the worksheet open in the workspace, click the arrow next to the item that you 
want to drill. 

• Right pointing arrow — Located next to an item that has dependencies, but the 
values are not currently visible. Click this arrow to drill down and expose the 
dependent values. 

• Down pointing arrow — Located next to an item for which you see dependencies. 
Click this arrow to drill up and hide the list of dependent values.

Note: A product with no arrow indicates that there are no 
dependent values. 

Adding parent values to the Planning Percentages worksheet
You can expose parent values for the root product in the worksheet. This enables you to
view data for products on which options are dependent, based on model> options 
relationships defined in the Bills of Material.

To add parent values:
1. With the worksheet open in the workspace, choose the cell that contains data for the

product for which you want to add parents.

2. Choose the Add Parent tool.

3. Result: The Dimension Value Selector opens, displaying the parent models for the 
selected product. If there are no parents, then the list is empty.

4. Choose one or more values from the list. 
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Changing the Layout to Enhance Analysis
The planning percentages worksheet enables you to accept the default layout or change 
the arrangement of dimensions to alter your view of the data.

The default layout puts the Time dimension on the vertical (row) edge of the planning 
percentage worksheet, after the Product dimension. Measure is the across dimension, 
and Ship to Location and Geography are page dimensions.

Moving the Time dimension from the row position to the across position and moving 
Product from the down position to the page position enables you increase the 
granularity of your view; you can focus on the data for a particular product over a 
particular time.

When organizations (Ship to Location) and Geographies are at the page level and Time 
is on the vertical edge, only one period can be viewed at a time. This leads to two 
problems:

• Planners cannot see the trend in planning percentages

• Planners have to change planning percentages one period at a time

When you move the Time and Product dimensions as described above, the planning 
percentage worksheet can display multiple levels of the dimension simultaneously.

This means that you can see a particular option for a geography and organization with 
all the time values lined up and the values for each measure going across the page. 
Values for the option can be viewed and compared across the selected time values -- for 
a whole series of weeks or months, or quarters.

You can move dimensions by using the Layout dialog box, or by dragging and 
dropping the dimension tiles.

Procedure: Moving Dimensions in the Planning Percentages Worksheet
You can use the Change Layout button on the document toolbar of the planning 
percentage worksheet to access a dialog box with which you can change the relative 
positions of the dimensions. As described in the previous section, this can be used to 
provide a different analytical view of your data.

Alternatively, you can change the layout manually by dragging and dropping 
dimension tiles. Both methods are outlined below.

Moving Dimensions with the Layout Tool
This is how you move dimensions with the layout tool.

1. With the planning percentage worksheet open in the workspace, choose the Change
Layout button on the Document toolbar.
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The Change Layout dialog box is displayed.

• The Layout frame displays the current positions of the dimensions on the page. 
Dimensions for which data displays as separate pages are shown in the Page 
position. 

• Dimensions for which data goes across the page are shown in the row position. 

• Dimensions for which data goes down the page are shown in the column 
position.

2. Move dimensions in one of these two ways:

1. You can click a dimension and drop it on another location or drag it to a new 
location.

• If you drag a dimension near another dimension and the dimension turns 
gray, this indicates that the two dimensions will exchange (swap) positions.

• If you drag a dimension and a black bar appears, this indicates that the 
dimension will be moved to the position.

2. You can also use the controls at the top of the page to manipulate dimension 
positions as follows: 

• In the Action box, choose Move or Swap. 

• In the Dimension box, select the dimension on which to perform the move 
or exchange. 

• In the Position box, on the top right, choose the target location for the move 
or the appropriate dimension or edge for the exchange. 

3. Choose Go to update the display in the Layout box to reflect the current status in 
the boxes. 

4. When the Layout box displays the desired settings for the dimensions, choose OK.

Moving Dimensions with Drag-and-Drop
This is how you move dimensions with drag-and-drop.

1. Click a row, column, or page selector. These selectors are located beside the row, 
column, and page labels and appear similar to a 'stoplight.'

2. Drop the selection on another location or drag it to a new location. 
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3. If you drag a dimension near another dimension and the dimension turns gray, this 
indicates that the two dimensions will exchange (swap) positions. 

4. If you drag a dimension and a black bar appears, this indicates that the dimension 
will be placed on the edge. 

Display and Calculations in the Planning Percentages Worksheet
The method that Oracle Demand Planning uses to calculate planning percentages 
depends on the selection that was made when the measure to which the planning 
percentage refers was created.

• If the planning percentage object was created by averaging dependent history, then 
planning percentages are calculated by dividing the history of each option by the 
history of the model.

• If the planning percentage object was created by forecasting dependent history, 
then planning percentages are calculated by dividing the forecast of each option as 
generated independently based on the history of the option, by the forecast of the 
model based on the history of the model. 

• If the planning percentage object was created by choosing the existing planning 
percentage object from the Planning Server or by copying and renaming the 
existing planning percent object, then the planning percentages reflect the numbers 
from the Bills of Materials. No calculations are applied.

Dependent demand for an item is calculated by multiplying its planning percentage by 
independent demand.

For information about generating planning percentages when creating a measure, see 
the following sections:

"Creating Forecast Measures", page 17-5

"Creating Simple Copy Measures", page 17-35

"Creating Complex Copy Measures", page 17-44

Calculating Dependent and Total Revenues
If the price of options is not rolled up in the model price, dependent and total revenues 
must be calculated in order to analyze revenues.

If we assume that the price of mandatory components is rolled up into the model's base 
price, the following will apply:

• The independent revenue is calculated by using the formula independent demand *
price.
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• The dependent revenue is calculated by using the formula dependent demand * 
price.

• The total revenue is calculated by using the formula model's independent demand *
model's base price + option's dependent demand * option's price. 

The procedure below explains how to use the Measure Wizard in Oracle Demand 
Planning to calculate dependent demand amount and total demand amount measures. 

• The dependent demand amount is calculated by applying the specified price list to 
the dependent demand quantity measure.

• The total demand amount measure is calculated by adding the independent 
demand amount and dependent demand amount measures.

• Neither the dependent demand amount measure nor total demand amount 
measure is editable.

Specifications Regarding Price Lists
The calculation that produces the dependent amount measures, will proceed with the 
understanding that these conditions are met:

• The price of all the mandatory items is rolled up into the model price. 

• One price list will contain the prices of models, as well as components. 

• The price list does not contain prices for the option classes. 

If the prices vary by territories or organizations, they will be applied for the respective 
territories and organizations. If the prices are available at All Geography and All 
Organization levels, the same prices will be applied to all the territories and 
organizations.

Notes on Revenue Calculations
Total revenue analysis (consolidated total) should be done only at the product family or
category levels, since the total amount for the model does not include the revenue for 
the options.

Adjustments to total revenues are allocated down to the options. In the above example, 
the independent revenue of a model is adjusted, which changes its independent 
demand and in turn the dependent demand of its options

Procedure: Calculating Dependent and Total Amounts:
This procedures describes how to calculate dependent and total amounts,
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1. From the Welcome screen, choose your planning role -- Demand Planning System 
Administrator, Demand Planning Manager, or Demand Planner.

2. Create a new measure or edit an existing measure. You will access the Measure 
Wizard.

3. Select the Extended Analysis step or tab. The screen is shown below.

4. The independent and dependent demand options are available for forecast, copy, 
copy region measures and input parameters.

The Calculate amounts for independent demands only button is selected by default. 

If you choose Calculate amounts for both dependent and independent demands, you 
can calculate the dependent and total amounts. 

These options are enabled only if the following options are also chosen: 

• Show Dependent Demand relationship (product to parts)

• Calculate volumes and amounts using a price list

• If the measure already contains independent or dependent amounts, they will be 
overwritten based on the new settings.

Viewing Dependent and Total Amounts
When you open a worksheet or report, you will be able to view three amount measures 
for a forecast: 

• Forecast Name, Amount is the independent amount measure, which is calculated 
by applying the price list to the independent quantity measure. You will be able to 
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edit this measure. 

• Forecast Name, Dependent Demand, Amount will not be editable. 

• Forecast Name, Total Demand, Amount will not be editable. 

Editing Independent amounts
If you make changes in the independent quantity or amount, the change will trickle 
down to all the other associated measures. 

If the independent amount is modified at the product category level, the modified 
number will be allocated down to the model amounts (independent amount at item 
level) and will be reflected in model quantities (and in other measures).

Reusing Planning Percentages
When you copy a planning percentage, as described in the previous procedure, you are 
actually taking an existing attach rate or model/options ratio and using it to "create" a 
"new" planning percentage object.

In earlier versions of Oracle Demand Planning, it was not possible for a user to copy an 
existing attach rate to a planning percentage object that had the same name as the attach
rate. It is now, however, possible to do this. In some business situations, as the 
hypothetical one described below, it could be convenient to reuse a planning percentage
object by copying it without modifying its name.

Imagine, for example, a company where the demand planners use an existing planning 
percentage ("MDS planning percentage") for their weekly planning cycles.

Every two months, there is a second planning cycle which uses a calculated planning 
percentage based on sales history for the model and option. For the sake of 
convenience, the planners use of the name of the existing planning percentage in the 
Measure Wizard.



13-14    Oracle Demand Planning Implementation and User's Guide

The advantage of doing this is that the new planning percentage takes effect for all of 
the measures with which the object "MDS planning percentages" is associated.

When you reuse a planning percentage object in this way, you simply overwrite the 
existing data and repopulate the object, which can be used again in another cycle.

Follow the procedure described below to reuse a planning percentage object.

Procedure: Repopulating a Planning Percentage Object
Follow this procedure to repopulate a planning percentage object. You must first access 
the Measure Wizard.

1. Proceed to the Extended Analysis step or tab.

2. Check the Show Dependent Demand relationship box.

3. Choose the Use Planning Percentage Object box, which is a list box that displays 
the available planning percentage objects.
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4. Select the planning percentage object that you want to repopulate.

5. Check the Copy Selected Planning Percentage box.

6. Check the Average the copied planning percentage to box, and then select a level 
that is different from the level of the existing planning percentage object.

7. Enter the name of the existing planning percentage object, displayed in the Use 
Planning Percentage Object box, in the New Planning Percentage Name box.

8. Complete your tasks in the Measure Wizard and choose Finish.

Modifying Data in the Planning Percentages Worksheet
In the Planning Percentages worksheet, you can modify editable values for independent
demand, planning percentages, and dependent demand. Note that if you edit data for a 
planning percentage object that has been associated with more than one measure, your 
edits will impact all measures to which the planning percentage object refers. In order 
for values to be editable, the measure for which you are viewing planning percentages 
and dependent demand must include the "Editable" property as part of its definition

Planning percentages are not dimensioned by Geography dimension, that is they are 
not calculated based on the geographic level values. Therefore, if you modify the 
planning percentages at a level other than the topmost level (All Geography) in 
Geography dimension, the planning percentages will be modified globally. For 
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example, changing planning percentages for a country or a region will change the 
planning percentages for all the countries or regions respectively. 

Situations in which cells are not editable when you expect them to be might result from 
the following:

• A cell represents a product/organization relationship that is not included in the Bills
of Materials.

• A cell for independent demand has been previously locked. 

Modifying calculated planning percentages
Calculated planning percentages (created by forecasting or averaging dependent 
history) are displayed at the forecasting level and at the lowest demand plan level. 
However, they are only editable at the forecasting level. For example, if the calculated 
planning percentages are 50% for January (forecasting level is month), 50% will be 
displayed for all the days in January (assuming that the lowest demand plan level is 
day). 

Effectivity dates are not respected for calculated planning percentages. The calculations 
are solely based on the sales history and are calculated at the forecasting levels, which 
will always be higher than the day level. Since planning percentages are not allocated or
aggregated, it is not possible to respect the bills' effectivity when calculating these 
planning percentages. Thus for calculated planning percentages, data will appear even 
when a bill is not effective for a certain period. However, during that period the 
corresponding numbers will be grayed out. 

Display formats indicate status
Display formats enable you to identify non-editable cells, editable cells, cells that have 
been modified, as well as cells that have been locked or commented. 

Data in worksheet cells appears as follows: 

• Non-editable (read-only) cells — dark gray background 

• Editable cells — pale gray background

• Modified cells — blue font

• Standard Locked cells — light pink background

• Persistently Locked cells — dark pink background

• Commented cells — bold font
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Impact of editing data in the Planning Percentage worksheet
When you edit data in the Planning Percentages worksheet, results are as follows:

• Editing independent demand affects the values for total demand and dependent 
demand. Planning percentages remain the same.

• Editing a planning percentage affects the value for dependent demand. 
Independent demand and total demand remain the same.

• Editing dependent demand affects the planning percentage for the same 
child/parent.

Techniques for editing data in the Planning Percentages worksheet
You can use the following techniques to edit data in editable cells:

• Change the value in an individual cell.

• Paste data values into a cell or range of cells.

• Use "Fill" functionality with the Modify Selected Data dialog box, as described in 
"Using Fill Functionality in Worksheets."

You can also enter comments that describe the changes that you have made and lock or 
protect data for independent demand.

Editing cells
You can edit values in editable, unlocked cells. 

If you have edited one cell and want to edit the value of a cell on a different level, you 
must recalculate the data before you can proceed. 

To edit a cell: 
1. With the document open in the workspace, click the cell that contains the value that

you want to change.

2. Type in the new value.

Note: If you enter a numeric value with more decimal digits than 
the numbers that are currently displayed in the worksheet, the 
edited value will be will be rounded to the nearest decimal place.
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Copying and pasting data
You can copy data from a single cell or from contiguous cells in the Planning 
Percentages worksheet to the Windows clipboard.

You can paste data from the Windows clipboard into a single cell or contiguous cells. 
The cells must be editable and unlocked. 

To copy data from the worksheet to the Windows clipboard: 
1. With the document open in the workspace, select the cell or cells that you want to 

copy. 

• To select all cells in a column, click the highlighter under the column label. 

• To select all cells in a row, click the highlighter next to the row label. 

2. Click the right mouse button and select Copy Data to Clipboard from the popup 
menu.

To paste data from the Windows clipboard into the worksheet: 
1. With the document open in the workspace, select the cell or block of cells into 

which you want to paste data. 

Note: The range of cells that you select must exactly match the 
range of cells that was copied to the clipboard. If the paste range 
does not match the copy range, then the system will not paste the 
data.

2. Click the right mouse button and select Paste from the popup menu.

Locking and unlocking cells
You can lock cells that contain data for independent demand. When you lock a cell, its 
values cannot be edited. 

You can remove cell protection by unlocking the cell.

To lock a cell: 
1. With the document open in the workspace, select the cell or cells that contain the 

data that you want to protect.

Use CTRL + click to select cells that are not contiguous.

2. Click the right mouse button and choose Lock Cell from the popup menu.
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3. Select Standard Lock or Persistent Lock.

To unlock a cell: 
1. With the document open in the workspace, select the cell that you want to unlock.

Use CTRL+click to select cells that are not contiguous.

2. Click the right mouse button and choose Unlock Cell from the popup menu.

Using comments to document modifications
As you modify data values, you can document your changes by entering one or more 
comments. Comments are free text that you associate with predefined reason codes. 

Commenting a cell for dependent demand also enters the comment into the related cell 
for planning percentage. Similarly, commenting a cell for planning percentages also 
enters the comment for the related dependent demand.

To enter a comment: 
1. With the document open in the workspace, select the cell or cells for which you 

want to enter a comment.

Use CTRL+Click to select cells that are not contiguous.

2. Click the right mouse button, and choose Comments from the popup menu.

Result: The Comments dialog box opens. 

3. In the Reason box, select a reason code for the comment. 

4. In the New Comment box, enter text for the comment. You can enter up to 300 
characters.

5. Choose Add to add the comment.

6. To enter another comment for the same cells, repeat Steps 2 through 5. You can use 
the same reason code or you can select an alternate code. 

7. Choose OK to return to the worksheet.

Deleting comments
You can delete a comment immediately after you enter it, but you cannot delete a 
comment once you have entered another comment or exited the dialog box. However, if
you have not yet saved the worksheet, you can use the Reset Data function. Resetting 
data will remove the comment, along with other changes that have been made.
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Recalculating data
Recalculation updates data values and spreads changes to appropriate cells by 
allocating and aggregating data. Recalculation is automatically triggered when you save
the Planning Percentages worksheet. You can also recalculate data manually.

To recalculate data: 
With the worksheet open in the workspace, choose the Recalculate button on the 
Document toolbar. 

Resetting data
If you have made changes to a Planning Percentages worksheet and you decide not to 
retain those changes, you can reset the data in the worksheet. You can roll back the 
values to the most recent modification. Alternatively, you can roll back the values to the
last Save action. 

I

Note: You can only reset data before you save. You cannot reset data 
that has been saved.

To reset data: 
1. With the worksheet open in the worksheet, choose the Reset Data button on the 

Document toolbar. 

2. Choose a reset option:

• Reset Data to Last Recalculation — Resets the data to the results just after the 
last recalculation.

• Reset Data to Last Save — Resets the data to the last time that the data was 
saved, regardless of the number of modifications that have been made.

Displaying Parent and Child Values in the Worksheet
In the planning percentage worksheet, each dependent demand relationship is a 
product with dependencies. You can use the Add Parents icon, displayed only in the 
toolbar of a planning percentages worksheet, to display the parents of values. The 
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Select Data dialog box enables you to view a product as a dependent of some roots, but 
not others. 

Because the time and geography dimensions can now can be rotated to the row or 
column edge, the planning percentage worksheet may display multiple levels of a 
dimension simultaneously.

You add parent values to dimension values by selecting a cell in the worksheet and then
clicking the Add Parents button on the toolbar. The context of the selected cell 
determines the product for which the parent products are retrieved.

The parent and child product values are displayed along the row edge.

Note: If the product dimension is rotated to the page dimension, it may 
be more difficult for you to determine the root context, because the 
dependent demand hierarchy is not visible. Because of this, the product
description displays additional information not visible for dimension 
values belonging to other dimensions. The new product description 
will be in the form [parent product] - [product]. You will see the 
additional descriptive information in the Dimension Value Selector 
(which you use with Add Parents), in page dimension pick lists, and in 
tooltips, when the cursor is passed over cells in the worksheet.

Saving Data in the Planning Percentages Worksheet 
You can save the Planning Percentages worksheet. When you save the worksheet, 
Oracle Demand Planning performs the following functions:

• Recalculates the data.

• Saves the data.
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• Saves the current worksheet layout. This layout will appear when you next open 
the Planning Percentages worksheet from the Tools menu on the navigation toolbar.

If your responsibility is Demand Planner, saving the worksheet saves the data in your 
personal database. If your responsibility is Demand Plan Manager, saving the 
worksheet saves the data in the shared database. 

To save the Planning Percentages worksheet:
With the document open in the workspace, choose the Save button on the Document 
toolbar. 

Printing the Planning Percentages Worksheet
You can print an open Planning Percentages worksheet and specify settings that 
determine how the printed pages will look. 

To print an open Planning Percentages worksheet:
1. With the document open in the workspace, choose the Print button on the 

Document toolbar. 

2. Result:The Print dialog box for your browser opens.

3. You can change the print defaults for the browser. For example, you can specify 
new values for printer and number of copies.

4. Choose OK to continue. 

Result: The Print dialog box for Oracle Demand Planning opens. 

5. In the Print box, specify the pages that you want to print. You can choose one of the 
following options: 

• Current Page of Data — Prints the current page of data as indicated by the 
page label.

• All n Pagesof Data — Prints all pages of data, beginning at the first logical 
page, regardless of the current page settings. 
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Note: If you choose to print all pages, the system prints all data 
for all dimension values that are in the page position in the 
document. Depending on the number of dimensions that are in 
status in the page position, printing all pages might result in 
many pages of output. 

6. In the Order box, you can specify the order in which to print the pages. You can 
choose one of the following options: 

• Across then down — Prints as many rows and columns as will fit on a physical 
page, then moves across the columns (until all are printed) and then down the 
rows (until all are printed).

• Down then across — Prints as many rows and columns as will fit on a physical 
page, then moves down the rows (until all are printed) and then across the 
columns (until all are printed).

7. In the Scaling box, you can specify how to scale the document. You can choose one 
of the following options:

• Adjust to — Scales each logical page by a percentage that you select. The 
output will span the number of physical pages that are necessary to meet the 
specified percentage.

• Fit to — Scales each logical page to span the width and height of the number of 
pages that you select. 

8. To indicate how you want the printed pages to look, choose Page Setup. This opens
the Page Setup dialog box, where you can perform the following operations:

• Specify optional header text (up to 100 characters) for the printed page.

• Specify an optional footer for the printed page.

• Specify whether row, column, and page labels will be repeated on each printed 
page.

• Specify whether a title, subtitle, and footnote will appear on the printed pages.

• Specify margin settings for the printed pages.

9. If you want to preview the pages before printing them, choose Preview.

10. Choose OK to print the worksheet. 
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Exporting Data from the Planning Percentage Worksheet
You can export dimension labels and data values from a Planning Percentage 
worksheet to files that can be used in Microsoft Excel and other applications. You can 
select one of three export format options (CSV, TXT, or HTM for Excel 2000+), and 
export data from all pages or from a specific page.

Note: If a worksheet contains many pages of data, you might have 
difficulty opening the file in certain applications. To avoid this 
situation, modify the data selections to reduce the number of values 
before creating the exporting file.

To export data from a worksheet:
1. With the worksheet open in the workspace, choose the Export button on the 

Document toolbar. 

2. Result: The Export dialog box opens.

3. In the Export box, choose the pages to include in the export file. You can select one 
of the following options: 

• Current Page — Exports data from the current page as indicated by the page 
label.

• All n Pages — Exports all pages of data, beginning at the first logical page, 
regardless of the current page settings. 

4. In the As Type box, select the format for the export file:

• Comma delimited (*.csv) — Exports the data in Comma Separated Value 
format, in which labels and data values are separated by commas.

• Tab delimited (*.txt) — Exports the data in text file format, in which labels and 
data values are separated by tabs.

• Excel 2000+ (*.htm) — Exports the data in a format that can be read by a 
browser and opened in Excel version 2000 and version 2002, also known as XP.

5. In the Options box, you can choose the following options for the export file: 

• Include Number Formatting — For a CSV or TXT export, check this option to 
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export the data with the current setting for number formats. Do not check this 
option if you want to export unformatted numeric data. Note that an HTM 
export automatically includes number formats.

• Repeat Group Labels — Check this option to repeat outer labels for columns 
and rows of inner, nested dimensions. Do not check this option if you want the 
export file to display labels as they appear in the screen display. 

Include Title, Subtitle, Footnote — Check this option to include the title, 
subtitle, and footnote of the document in the export file. Do not check this 
option if you want to exclude these elements.

• Create One Sheet per Page — For a multi-page HTM export, check this option 
to export the data from each logical page to a separate Excel worksheet. Do not 
check this option if you want to export the data from all pages to a single Excel 
worksheet. 

6. Choose OK to continue.

Result:If you chose CSV or TXT format, the File Download dialog box opens. If you 
chose HTM format, the Export to HTML/Excel 2000+ dialog box opens. 

7. For a CSV or TXT export, proceed as follows:

1. In the File Download box, choose Save this file to disk.

Result: The Save As dialog box appears. 

2. In the Save in box, select the output directory for the file.

3. In the File name box, enter a name for the file.

4. Choose OK to export the file.

8. For an HTM export, proceed as follows:

1. In the Save in box, select the output directory for the file.

2. In the File name box, enter a name for the file.

3. Choose OK to export the file.

About Excel 2000+ output files
When you export to a single worksheet in Excel 2000+ (*.htm) format, Oracle Demand 
Planning generates a single HTML file in the directory that you specify. 

When you export to a multi-page file in Excel 2000+ format and indicate that you want 
to create one sheet per page, Oracle Demand Planning generates an HTML table of 
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contents file plus a number of other files in the directory that you specified. Use the 
table of contents file to access the individual worksheets.

Planning Percentage Usability Enhancements

Viewing Product Description in Worksheets
The topic "Changing the Layout to Enhance Analysis" describes how you can use the 
layout tool in the planning percentage worksheet.

The default layout makes the Product dimension one of the dimensions on the vertical 
edge.

Moving Product from the vertical position to the page position is one of the 
modifications you can make in your worksheet to focus the analysis of data provided in
the worksheet. 

However, this view of the data obscures the dependent demand hierarchy, making it 
harder to see family (model/option) relationships. Therefore, the mini-selector for the 
product dimensions (the Dimension Value Selector dialog box) now displays additional 
information in form of a product description for each item, in the format [parent 
product] - [product].

Using Fill Functionality in Worksheets
If you have an option that has a very long time range, you may want to fill the values 
for some periods without manually modifying each cell.

You can use a Fill option that is available from the right-click popup menu.

You can insert a value into multiple cells at the same level. If you select cells from 
different levels to fill, a warning is displayed.

Procedure: Using Fill Functionality in the Planning Percentage Worksheet
This procedure explains how to use fill functionality in the planning percentages 
worksheet.

1. Open a planning percentage worksheet from an open document or by using the 
Planning Percentages command from Tools submenu.

2. In the worksheet, use the cursor to select the cells that you want to fill. 

3. Right-click to display the popup-menu of ODP commands.

4. The Modify Selected Data dialog box is displayed.

5. Enter the number with which you want to fill the cells in the Fill with text box in 
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the In the Value frame.

6. Choose OK to return to the modified worksheet.

Closing the Planning Percentages Worksheet
When you have finished working in a Planning Percentages worksheet, you can close it.
If you have modified but not yet saved the data, you will be prompted to specify 
whether you want to save.

To close the Planning Percentages worksheet:
Choose the Close button, located in the upper right corner of the document. 
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14
Using Ad Hoc Reports

This chapter covers the following topics:

• About Ad Hoc Reports

• Creating Ad Hoc Reports

• Opening Ad Hoc Reports

• Selecting Data for Ad Hoc Reports

• Arranging and Viewing Data in Ad Hoc Reports

• Creating Ranking/Exception Reports

• Viewing Events for Measures in Ad Hoc Reports

• Formatting Ad Hoc Reports

• Formatting Ad Hoc Reports Based on Data Conditions (Color Coding)

• Printing Ad Hoc Reports

• Saving Ad Hoc Reports

• Copying Data from Ad Hoc Reports

• Exporting Data from Ad Hoc Reports

• Closing Ad Hoc Reports

• Renaming Ad Hoc Reports

• Viewing Ad Hoc Report Properties

• Deleting Ad Hoc Reports

About Ad Hoc Reports
Ad hoc reports display data in tabular format. When you work as a Demand Planner or 
Demand Plan Manager you can create an ad hoc report to analyze an issue on the fly. 
You can also save an ad hoc report and run it on a regular basis. 



14-2    Oracle Demand Planning Implementation and User's Guide

Toolbar for ad hoc reports
The Document toolbar appears at the top of an open ad hoc report. The toolbar buttons 
enable you to perform the functions that are listed below.

• Choose Values from List  - Select values from a list and access tools for dimension 
value selection and manipulation.

• Apply Saved Selection  - Replace the current values in the report with a saved 
selection of values.

• Save Current Selection - Save the dimension values in status for a dimension as a 
saved selection.

• Change Layout - Change the layout of the report.

• Change View Type - Change the report to a graphical format.

• Export to Spreadsheet - Export data and labels from the report to a .CSV, ,TXT, or 
.HTM file.

• Save As  - Save the report.

• Refresh  - Refresh data in the active document.

• Copy - Copy selected data from the report to the Windows clipboard.

• Format Document  - Specify a title, subtitle, and footnote for the report. You can 
specify how dimension values are displayed. You can also apply formatting to the 
entire report and to selected rows and columns.

• Color Coding - Apply color formats based on data conditions to the report. 
Exception conditions can be highlighted.

• Ranking/Exception Reports - Displays rows that meet exception, ranking, or 
exception and ranking criteria.

• Events Calendar - View a calendar that displays information about events 
associated with the demand plan.

• Print - Print the report.

• Help - Display online Help for planners and the Demand Plan Manager.

Creating Ad Hoc Reports
You can base an ad hoc report on the default ad hoc report document. You can also use 
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any saved document as the starting point for a new report.

The data in a new report initially reflects the document on which the report is based. 
You can then customize the report so that it displays exactly the data that you want to 
work with. You can also select layout and format options.

To create an ad hoc report:
1. Access Oracle Demand Planning as a Demand Planner or Demand Plan Manager.

2. On the navigation toolbar, choose the New button, 

3. and choose New Report. 

Alternatively, you can click the right mouse button on Documents in the navigation
list and choose New Report from the popup menu.

4. Choose one of the following:

• Use default — Creates an ad hoc report that is based on the default ad hoc 
report document.

• Based on — Creates an ad hoc report that is based on a selected document.

If there are no saved documents, then you do not have these options. The report
will automatically be based on the default report document. For information 
about setting the default, see "Saving Ad Hoc Reports", page 14-34.

5. Choose OK to create the report.

Result: The report is displayed in the workspace. A generic name, such as "
Document 1," appears above the body of the document.

Displaying Multiple Documents
You can open the following documents at the same time:

• One worksheet

• One planning percentages worksheet

• One predefined report or one ad hoc graph

• Up to seven ad hoc reports

To learn more about the multi-document interface, see the section on The Document 
Workspace., page 11-5
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When you are working with one or more reports and a worksheet open, you can select a
command from the Navigation Toolbar to refresh the open documents so that they all 
display the same data. See the topic on refreshing open documents, page 11-7 in the 
worksheets chapter.

Opening Ad Hoc Reports
You can open a saved ad hoc report. Saved reports are displayed as objects in the 
navigation list, located in the left frame of your browser. Depending on how a report 
was saved, it might appear in the main Documents folder or in a folder that you 
created. 

To open an ad hoc report:
1. Access Oracle Demand Planning as a Demand Planner or Demand Plan Manager.

2. In the navigation list, identify the report that you want to open.

Note: To search for an ad hoc report in the navigation list, click the 
right mouse button on the main Documents folder or a specific 
folder and choose Find from the popup menu. Then enter a name 
or name fragment. Alternatively, you can choose the Find button on
the navigation toolbar.

3. Double-click the document object. 

Alternatively, you can click the right mouse button on the document object and 
choose Open from the popup menu.

Default Document Layout
When a user creates a new worksheet, report or graph, Oracle Demand Planning 
intelligently displays immediately usable, populated documents by setting status to 
dimensions where data is available. To see information on the default layout for reports,
see the section on the default layout, page 11-8 in the worksheet chapter.

Selecting Data for Ad Hoc Reports
When you create a new ad hoc report, the data reflects selections for the document on 
which the report is based. When you open a saved ad hoc report, the data reflects 
selections that were in effect when the document was saved. 

You can select measures and dimension values so that the report displays exactly the data 
that you want to work with. 
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• A measure represents a variable which is a placeholder for storing data values for all
levels of all dimensions. For example Booking History, Shipment History, and Q1 
Forecast might be measures in your database. 

• A dimension is a database object that organizes and indexes the data, similar to a key
in a relational database. For example, if you have data with values for various time 
periods, then the data has a Time dimension; that is, it is organized by time. 

• Dimension values are the elements that make up a dimension. For example, the 
Time dimension in your database might include values for years, quarters, months, 
and weeks. You can select any or all of the values that are available within a 
dimension, including custom aggregates that you have defined.

To select data for an ad hoc report: 
1. With the document open in the workspace, choose the Select Data button on the 

Document toolbar. 

2. Result: A list of the dimensions in your database appears. The list includes 
Measure.

3. Choose a dimension for which you want to select values.

Result: The Select Data dialog box opens. The dimension that you chose is 
displayed in the Select Values for box.

4. Choose values for the current dimension.

5. To select values for another dimension, in the Select Values for box choose the 
dimension and repeat Step 3.

6. Repeat Steps 3 and 4 until the document includes the values that you want to work 
with. 

Applying custom aggregates and saved selections to an ad hoc report
In addition to using a selection list or selection tools to select data values for an ad hoc 
report, you can change the data that is displayed in a report by applying saved 
selections and custom aggregates to the open document. For more information, see the 
following topics:

"Defining Custom Aggregates", page 19-1"Applying Custom Aggregates to Open 
Documents", page 19-3

"Defining Saved Selections", page 20-1
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"Applying Saved Selections to Open Documents", page 20-4

If expected rows do not display
It is possible that a row that you expect to see might not appear if rows that contain NA 
(unavailable) data are suppressed in the report. For example, assume that you position 
Time on the row edge of a report, and select three Time values: October, November, 
and December. If NA row suppression is turned on and there is no data for December, 
then the report will display rows for October and November, but no row for December. 

If you think that NA or zero rows are being suppressed and you want to view these 
rows, you can use a format option to display the rows. For more information, 
see"Specifying general display elements for an ad hoc report", page 14-17.

Arranging and Viewing Data in Ad Hoc Reports
You can change an ad hoc report so that the data is arranged in the way that you want. 
The following options are available: 

• You can change the layout by rearranging the dimensions on the page.

• You can display the report data in graphical format.

• You can drill through aggregate values to expose component values. 

• You can page through the report to view data for dimensions in the page position.

• You can change the size of columns or rows to enhance your view of the data.

Changing the layout of an ad hoc report
You can use the Change Layout button on the Document toolbar to change the layout of
an ad hoc report. Alternatively, you can change the layout manually, by dragging and 
dropping dimension tiles. 

To use the Change Layout button to change the report layout:
1. With the report open in the workspace, choose the Change Layout button on the 

Document toolbar.

2. Result: The Layout box displays the current positions of the dimensions on the 
page. Dimensions for which data displays as separate pages are shown in the page 
position. Dimensions for which data goes across the page are shown in the row 
position. Dimensions for which data goes down the page are shown in the column 
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position.

3. You can click a dimension and drop it on another location or drag it to a new 
location. 

Result: The dimension moves as follows:

• If you drag a dimension near another dimension and the dimension turns gray, 
this indicates that the two dimensions will exchange (swap) positions. 

• If you drag a dimension and a black bar appears, this indicates that the 
dimension will be moved to the position.

4. You can also use the controls at the top of the page to manipulate dimension 
positions as follows:

1. In the left box, select an action.

• Choose Move to move a dimension to another position. 

• Choose Swap to exchange the position of one dimension with another 
dimension.

2. In the center box, select the dimension on which to perform the move or 
exchange.

3. If you chose Move in the earlier step, use the right box to select the target 
location for the move. 

If you chose Swap in the earlier step, use the right box to select the dimension 
or edge for the exchange. 

4. Choose Go to update the display in the Layout box to reflect the current status 
of the boxes.

5. When the Layout box displays the desired settings for the dimensions, choose OK.

Result: The Change Layout dialog box closes. The elements in the document are 
moved to the locations that you specified.

To use drag and drop to change the layout:
1. Click a row, column, or page selector. These selectors are located beside the row, 

column, and page labels and appear similar to a stoplight.

2. Drop the selection on another location or drag it to a new location. 
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Result: The dimension moves with the selector as follows:

• If you drag a dimension near another dimension and the dimension turns gray, 
this indicates that the two dimensions will exchange (swap) positions. 

• If you drag a dimension and a black bar appears, this indicates that the 
dimension will be placed on the edge.

Changing the document type for an ad hoc report
You can change an ad hoc report from a tabular format into a graphical format.

To change an ad hoc report into a graph:
1. With the document open in the workspace, choose the Change Document Type 

button on the Document toolbar. 

2. Result: The Change Document dialog box opens.

3. In the Change document type to box, select Graph. 

4. In the With the following subtype box, select the type of graph you want to work 
with. 

5. Choose OK to apply the current settings.

Result: The Change Document Type dialog box closes. The current report changes 
to the type of graph that you specified. 

Drilling through levels of data in an ad hoc report
If an ad hoc report includes hierarchical dimension values and the drilling option has 
been turned on for the document, you can view data at various levels by drilling within 
aggregate values. For example, if the report displays a geography that includes lower 
level values, you can "drill down" and expand the display to show component 
geographies. You can then "drill up" to collapse the display. 

You can drill a dimension value that is in the row or column position if a drill arrow 
appears to the left of the dimension value name. The arrow shape changes, depending 
on whether you can expand or collapse the value:

• Right pointing arrow — Located beside a value that displays a total while the 
values that contribute to that total are not visible. Clicking this arrow enables you to
drill down, causing the report to display the lower level values. 
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• Down pointing arrow — Located beside a value that displays a total while the 
values that contribute to that total are visible beneath it. Clicking this arrow enables 
you to drill up, causing the report to display only the total value. 

A report format option enables you to turn drilling on or off for a report. For more 
information, see"Specifying general display elements for an ad hoc report", page 14-17.

Paging through an ad hoc report
Report data is displayed one page at a time. You can use the page controls at the top of 
the document to display pages other that the one that is currently in view. For example, 
the current page might show data for Total Product, but you can select another product 
from the list to see its data.

Adjusting columns and rows in a report
You can change the size of columns and rows in a report so that the information is 
easier to read. You can use drag and drop to adjust column and row sizes. You can also 
use a format option. For more information about sizing rows and columns, see "Sizing 
rows and columns in an ad hoc report", page 14-19.

Creating Ranking/Exception Reports
You can use an ad hoc report as a starting point and create a report that meets analyzes 
data by exception, ranking criteria, or exception-then-ranking criteria.

• Exception report — Displays data that meets criteria that you specify. 

• Ranking report — Presents data arranged in order, according to criteria that you 
specify.

• Exception then Ranking report — Analyzes data meeting criteria that you specify, 
and displays it in the order you specify.

Example: Ranking report
For example, if you want to view the shipping history and amount of the top ranking 
products for all organizations in Puerto Rico, the planning engine displays the list of the
products meeting the above mentioned criteria in a Ranking/Exception report.
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Planning your Ranking/Exception report

Identify the row dimension
Before you create a Ranking/Exception report, identify the dimension in which you 
want to rank members or specify exception criteria. This is the focus of the report and 
the dimension that you will select as the row or down dimension. For example, if you 
intend to rank geographies by units shipped for a product within a specified time 
period, you would specify Geography as the row dimension.

Identify the measure and the qualifying dimension values
Identify which measure to use as the basis for evaluating the dimension in the row 
position. Set this measure in the base report. For example, if you intend to use 
Geography as the row dimension, do you want to evaluate the geographies in terms of 
Booking History, or by another measure?

By default, Oracle Demand Planning will attempt to use the first measure displayed in 
the base report as the measure to use for exception, then ranking. You can also change 
this selection. You should also identify the measure that you want to use as the basis for
evaluating the row dimension. Then identify the other qualifying values that you intend
to apply. To continue with the previous example: for what time period and product do 
you want to look at Booking History? 

Working with Ranking/Exception reports
You can work with a Ranking/Exception report just as you would any report, with 
several exceptions:

• The row dimension determines the report's focus. Therefore, you cannot use drag 
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and drop or the Change Layout tool to place an alternate dimension in the row 
position while the ranking/exception criteria is applied. If you want to focus the 
report on a different dimension, you can create a new Ranking/Exception report. 
Alternatively, you can remove all ranking/exception criteria from the report, change
the report layout, and then reapply the criteria.

• Although you can use drag and drop or the Change Layout tool to change the 
column dimension, adding a dimension to the column position, or removing a 
dimension from the column position can change the values that are displayed.

• If you change a Ranking/Exception report to a graph, the ranking/exception settings
will be removed.

• As you page through a Ranking report, the order of the rows will change as the 
ranking criteria is re-evaluated. For example, if Geography is in the page position 
and the first page of the report ranks Sales for a group of products in New York and
another page ranks Sales for the same group of products in Boston, the products 
that are displayed on the pages may differ.

Creating a report that meets exception criteria
The following procedure describes how to apply exception criteria to a report for the 
first time. If you are modifying criteria, see "Modifying exception then ranking settings 
for an ad hoc report", page 14-15. 

To create a report that meets exception criteria:
1. With a report open in the workspace, choose the Ranking/Exception Reports button 

on the Document toolbar. 

If you see the Welcome dialog box, choose Next to continue.

To suppress the Welcome dialog when creating other Ranking/Exception reports, 
uncheck the Show this page next time box before you continue. 

Result: The Row Dimension dialog box opens.

With a report open in the workspace, choose the Ranking/Exception Reports 
button on the Document toolbar.

• In the Ranking/Exception Wizard — Row Dimension dialog box, choose the row 
dimension for the report from the drop-down list.

• In the Ranking/Exception Wizard — Row Dimension dialog box, choose members 
of the row dimension by choosing the Ellipsis button and using the Dimension 
Value Selector dialog box.

• Choose Next to go to the next step in the Wizard. 
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Result: The Ranking/Exception Wizard — Exception dialog box opens.

2. Choose the Yes option to apply exception criteria. Chose a measure by choosing the
Ellipsis button and using the Dimension Value Selector, then select a value operator 
from the drop-down list.

• Select a qualifying dimension and then choose the Dimension Values button to
select specific qualifying dimension values. 

• At this point, you can choose Finish to create an exception report.

• Choose Next to continue and create an exception-then-ranking report.

• If the report with which you are working does not have a designated row 
dimension, the Dimension Values button is not enabled.

Creating a report that meets ranking criteria
The following procedure describes how to apply ranking criteria to a report for the first 
time. If you are modifying criteria, see "Modifying exception then ranking settings for 
an ad hoc report", page 14-15.

To create a report that meets ranking criteria:
1. With a report open in the workspace, choose the Ranking/Exception Reports button 

on the Document toolbar.

If you see the Welcome dialog box, choose Next to continue. 

To suppress the Welcome dialog when creating other Ranking/Exception reports, 
uncheck the Show this page next time box before you continue.

With a report open in the workspace, choose the Ranking/Exception Reports 
button on the Document toolbar.

2. In the Ranking/Exception Wizard Row Dimension dialog box, choose the row 
dimension for the report and the member values that you want to evaluate.

3. Choose Next to navigate to the Ranking/Exception Wizard Exception dialog box.

4. Choose the No option to skip the exception criteria and move to the ranking step.

5. 5. Choose Next to access the Ranking/Exception Wizard – Step 3: Ranking page. 
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Then choose Yes to enable the Ranking Criteria frame. The ranking dimension is 
specified in the Ranking label at the top of the frame.

6. Choose the ranking criteria measure by choosing the Ellipsis button and selecting 
with the Dimension Value Selector.

7. To rank top values, enter an integer in the Top box that represents the number or 
percentage of top values to select. To indicate that the value that you entered is a 
percentage, choose Percent.

8. To rank bottom values, in the Bottom box, enter the number or percentage of 
bottom values to select. To indicate that the value that you entered is a percentage, 
choose Percent.

9. The Dimensions box displays default qualifying dimension values. There is a 
qualifying value for each dimension in the row position. You can accept the default 
value that appears in the box for a dimension, or you can select an alternate value 
for any dimension.

10. To select an alternate value for a dimension, highlight the value that you want to 
change and choose the Dimension Values button. This opens a dialog box where 
you can select an alternate value for that dimension.

If no dimension is on the Column edge, the Dimension Values button is not 
enabled.

11. Choose Finish to display the ranking report.

Example: Ranking criteria
The following example shows the dialog box for defining ranking criteria.
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Creating a report that meets exception then ranking criteria
The following procedure describes how to apply exception then ranking criteria to a 
report for the first time. If you are modifying criteria, see "Modifying exception then 
ranking settings for an ad hoc report", page 14-15.

To create a report that meets exception then ranking criteria:
1. With a report open in the workspace, choose the Ranking/Exception Reports 

button on the Document toolbar.

2. Accept or close the Welcome screen.

3. Use the Row Dimension step to choose a row dimension. 

If you convert another type of report into a ranking exception report, you should 
remember that you will not be able to use exception or ranking criteria until you 
have selected a row (down) dimension.
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4. Choose the Yes option in the Exception criteria step, and use the form as described in
the procedure on creating exception criteria, page 14-11. Then go on to the Ranking 
criteria step.

5. Choose the Yes option in the Ranking criteria step, and use the form as described in 
the procedure on creating ranking criteria, page 14-12.

6. Choose the Finish button.

Modifying exception then ranking settings for an ad hoc report
You can change the measure, cutoff or ranking values, and qualifying dimension values
for ranking then exception criteria in a report.

If you want to change the focus of the report — that is, place an alternate dimension in 
the row position, you must remove the exception/ranking settings and start again. 
Alternatively, you can create a new report.

To modify exception then ranking settings for an ad hoc report:
1. With the report open in the workspace, choose the Ranking/Exception Reports 

button on the Document toolbar.

2. When the Modify Ranking/Exception Settings dialog box opens, choose Modify 
Ranking/Exception Settings, and then choose OK. 

The ranking/exception wizard starts, with the Exception tab active. If you do not 
want to define, disable, or modify exception criteria, proceed to the Ranking tab.

3. In the Exception tab, you can modify the current exception criteria or disable the 
current exception criteria by choosing No for the "Do you want to apply exception 
criteria" prompt.

4. To modify or disable ranking criteria, choose the Ranking tab. In the Ranking tab, 
you can modify the current ranking criteria, or disable the current ranking criteria 
by choosing No for the "Do you want to apply ranking criteria" prompt.

5. You can also define ranking criteria if none currently exists by following the same 
procedure outlined in Creating A Report That Meets Ranking Criteria, page 14-12.

6. Choose Finish to display the report.

Removing exception and ranking settings from a report
You can remove exception setting, ranking settings, or exception then ranking settings 
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that have been applied to an ad hoc report.

To remove exception and ranking setting from an ad hoc report:
1. With the report open in the workspace, choose the Ranking/Exception Reports 

button on the Document toolbar.

2. Result: The Modify Ranking/Exception Settings dialog box opens. 

3. Choose Remove Ranking/Exception Settings and then choose OK.

Viewing Events for Measures in Ad Hoc Reports
An event is an occurrence such as a promotion, new product introduction, or product 
phase out that is expected to impact demand for a product. When you define a stored 
measure, you can associate one or more events with that measure. Events might also be 
linked to stored measures in the shared database. Thus, your ad hoc report might 
include measures that have associations with events. 

While you are working with reports you can access an Events Calendar which provides 
information about the events that are associated with a demand plan. 

To view events that are associated with a measure:
1. With the document open in the workspace, choose the Events Calendar tool on the 

Document toolbar.

2. Result: The Events Calendar opens. The Month tab displays events for the current 
month. The right frame displays all events that are linked to the demand plan.

3. Choose the Filter Events by Measure button.

4. Result:The Choose a Measure dialog box opens. The list displays all of the 
measures that have been defined for the demand plan.

5. Select a measure from the list and choose OK.

Result:The right panel now displays only those events that have been associated 
with the selected measure. The measure name appears at the bottom of the frame.
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6. To view more information about the event, double-click it.

Result:The Event Wizard opens, where you can view (and optionally edit) the event
definition.

7. You can move through the calendar to view the event time period. Choose Next to 
advance the month display and Previous to go back a month. Choose the Year tab 
to view events by year. 

8. Choose OK to exit the calendar.

Formatting Ad Hoc Reports
You can specify the following types of formats for a report:

• You can select format options that apply to the entire report. For example, you can 
specify display options, fonts and background colors, row and column sizing, and 
text elements such as title, subtitle, and footnote. For more information, see 
"Specifying formats that apply to the entire report", page 14-17. 

• You can select format options that apply to selected rows or columns of the report. 
For example, you can specify number formatting, borders, and fonts and colors. For
more information, see "Formatting data in selected rows and columns", page 14-22.

• You can define special format conditions that apply when the data values for a 
measure meet criteria that you specify. For more information, see "Formatting Ad 
Hoc Reports Based on Data Conditions (Color Coding)", page 14-26.

Specifying formats that apply to the entire report
You can specify the following types of format options for the entire report:

• General — Specify parameters for displaying indented levels, horizontal and 
vertical gridlines, and rows that contain NA (unavailable) and zero data. Also 
specify how to handle formatting conflicts and drilling. 

• Font — Specify fonts for data and labels; also specify color and alignment for data 
in the body of the report.

• Autosizing — Specify sizing options for rows and columns.

• Titles — Specify text, font, alignment, and color information for a title, subtitle, and 
footnote.

Specifying general display elements for an ad hoc report
You can set parameters that specify how to display levels of data, gridlines, and rows 



14-18    Oracle Demand Planning Implementation and User's Guide

that contain NA (unavailable) and zero data in a report. You can also specify how to 
handle formatting conflicts and drilling.

To specify general display elements for an ad hoc report:
1. With the document open in the workspace, choose the Format Document button on

the Document toolbar.

2. Choose Format Document from the popup menu.

Result: The Format Document dialog box opens. The General tab is active.

3. The General tab displays the current settings for report display elements. You can 
change one or more of the following settings:

• View Rows — Specify whether to show all rows or suppress rows with zero 
values, NA values, or both NA and zero values.

• Formatting Precedence (low to high) — Specify the order in which to apply 
formatting when row, column, and page conflicts occur. For example, if you use
the Format Selected Rows and Columns option and choose purple as the text 
color for a row and then choose yellow as the text color for a column that 
intersects with the row, the setting for Formatting Precedence will determine 
which color will display for the intersecting cell. 

• NA Spell — Enter a character or character string to represent NA data (up to 31
characters).

• Indent by Level — For dimensions that have a hierarchical structure, specify 
whether to indent rows by level and enter the number of indent characters to 
use. 

• Horizontal Grid Lines — Specify whether to show or hide horizontal grid 
lines.

• Vertical Grid Lines — Specify whether to show or hide vertical grid lines.

• Enable Drilling — For dimensions that have a hierarchical structure, specify 
whether you can drill down to lower levels.

4. Choose OK to apply your selections. 

Displaying Item Descriptions in Reports
When you add formatting to your report, you can also customize labels so that the 
labels for values in a dimension are displayed in the format that you choose. In the 
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product dimension, for example, you can display item descriptions next to their part 
numbers.

The process of selecting and specifying one of the four types of labels for any dimension
values in your ad hoc report is identical to the process for using the Dimension Labels 
tab , page 11-26of the Format Document dialog box for worksheets. See that topic of the 
worksheet chapter for more information.

Selecting fonts, colors, and text alignment for an ad hoc report
You can select font style, size, color and text alignment for an ad hoc report.

Font settings will be applied to both the data and the labels in the report. Color and 
alignment settings will be applied only to the data.

To select fonts, colors, and text alignment for an ad hoc report:
1. With the document open in the workspace, choose the Format Document button on

the Document toolbar.

2. Choose Format Document from the popup menu.

Result: The Format Document dialog box opens. The General tab is active.

3. Select the Font tab. 

4. The Font tab displays the current settings for font name, font size, color, and 
alignment. You can change one or more of these selections as follows: 

• Use the Font box to select the font name.

• Use the Size box to select the font size.

• In the Color box, select colors for the text and the cell background.

• In the Alignment box, select an alignment option for data values.

5. Choose OK to apply your selections.

Sizing rows and columns in an ad hoc report
You can change the size of rows and columns in a report so that the information is 
easier to read. You can use a format option. You can also change column or row size 
manually. 
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To use a format option to set row and column size:
1. With the document open in the workspace, choose the Format Document tool on 

the Document toolbar.

2. Choose Format Document from the popup menu. 

Result: The Format Document dialog box opens. The General tab is active.

3. Select the Autosizing tab.

4. The Row Sizing box displays the current setting for row size. You can choose one of
the following options: 

• Autosizing by Label — Automatically sizes the rows based on the height and 
width of the row labels. 

• Equal Sizing — Sizes rows based on a height and width that you specify. The 
row height is determined by multiplying the font size of the label by the value 
that you enter.

• None — Removes automatic or equal sizing from the rows. 

5. The Column Sizing box displays the current setting for column size. You can choose
one of the following options: 

• Autosizing — Automatically sizes the columns on the current page based on 
your selection. You can choose one of the following options:

• by Label — Sizes the columns according to the size of the individual 
column labels.

• by Data — Sizes the columns according to the size of the data each column 
contains.

• by Largest Data or Label — Sizes the columns to the larger of either the 
individual column labels or the data contained in each column.

• Equal Widths by Average Character — Sizes columns based on a width that 
you specify. 

• None — Removes automatic or equal sizing from the columns.

6. Choose OK to apply your selections.
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To manually size a row or column in an ad hoc report:
With the document open in the workspace, position the cursor on the border of the label
of the row or column whose size you want to change. When the cursor changes to a 
double arrow, click and move the border. 

Result: If the current setting for row or column sizing is an Autosize option or None, 
each instance of the dimension value in the selected row or column will change size 
while the other rows or columns will retain their current size. If the current setting for 
column or row sizing is Equal, all of the columns or rows will change size. 

To reapply autosizing to columns or rows in an ad hoc report:
1. Choose the Format Document button on the Document toolbar.

2. Alternatively, you can click the right mouse button in the document.

3. Choose one of the following options from the popup menu:

• Reapply Autosizing — Applies default autosizing to rows and columns. Does 
not override manual resizing (drag and drop). 

• Reapply Autosizing to All — Applies default autosizing to rows and columns. 
Overrides manual resizing (drag and drop).

Note: If Equal sizing or None has been selected for rows and 
columns, the options for reapplying autosizing will not appear 
when you click the right mouse button. If Autosizing has been 
selected for either column or row, the options to reapply 
autosizing will appear when you click the right mouse button, 
but will only apply to the dimension position (column or row) 
that has autosizing turned on.

Adding a title, subtitle, and footnote to an ad hoc report
You can add a title, subtitle, and footnote to an ad hoc report and specify whether each 
of these elements will display in the current document.

To specify a title, subtitle, or footnote for an ad hoc report:
1. With the document open in the workspace, choose the Format Document button on

the Document toolbar.
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2. Choose Format Document from the popup menu. 

Result: The Format Document dialog box opens. The General tab is active.

3. Select the Titles tab. 

4. In the Select Title Type box, choose a text element (Title, Subtitle, or Footnote) and 
proceed as follows: 

1. In the Font Properties box, select font properties (name, size, style, color, 
background color) for the text.

2. In the Alignment box, select an alignment option for the text.

3. In the Display Options box, choose Show to display the text element in the 
current document.

4. In the Text box, enter the text for the title, subtitle, or footnote (498 characters 
maximum). 

5. Repeat Step 4 for each text element that you want to include.

6. Choose OK to apply your selections. 

Formatting data in selected rows and columns
You can select one or more rows or columns in a report and apply formats for font, 
color, alignment and borders. You can apply these formats to data in the rows and 
columns. You can also apply these formats to the row or column labels. You can also 
specific how numeric values will be displayed. 

Formats that you apply to selected rows, columns, and labels take precedence over 
formats that apply to the entire report. 

Note: If conflicts between row and column formatting occur, Oracle 
Demand Planning uses the Formatting Precedence setting (a Format 
Document, General tab option), to determine which format will prevail.
For example, if you use the Format Selected Rows and Columns option 
and choose purple as the color for a row, and then choose yellow as the 
color for a column that intersects with the row, the Formatting 
Precedence setting determines which color will display for the 
intersecting cell. For information about the Format Precedence setting 
see "Specifying general display elements for an ad hoc report", page 14-
17.
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Applying fonts, colors, and borders selected rows or columns
You can apply fonts, colors, and border formats to selected rows or columns in an ad 
hoc report.

To apply fonts, colors, and borders to selected rows or columns in an ad hoc report:
1. With the report open in the workspace, select the rows, columns, or labels to which 

you want to apply formatting.

• To select a column, click the highlighter under the column label. Use SHIFT + 
click or CTRL + click to select more than one column.

• To select a row, click the highlighter next to the row label. Use SHIFT + click or 
CTRL + click to select more than one row.

• To select a row or column label, click the label. Use SHIFT + click or CTRL + 
click to select more than one label.

• To select all labels for a row or column, click the row or column label selector. 
The column label selector is located to the left of the first column label. The row 
label selector is located at the top of the row labels.

2. Choose the Format Document button on the Document toolbar. 

3. Choose Format Rows and Columns from the popup menu.

Result: The Format Rows and Columns dialog box opens. The Fonts and Borders 
tab is active.

4. The tab displays the current settings for font name, font size, font style, colors, 
alignment, and borders. You can change one or more of these selections as follows: 

• Use the Font box to select the font name.

• Use the Size box to select the font size.

• In the Color box, select colors for text, border, and background. 

• In the Alignment box, select alignment options for the text.

• In the Borders box, choose styles for top, left, bottom, and right borders. For a 
single solid border, choose the width.

5. Choose OK to apply your selections.
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Applying numeric formats to selected rows and columns:
You can apply unique number formats to selected rows and columns in an open ad hoc 
report. 

To format numeric values in selected rows or columns in an ad hoc report:
1. With the document open in the workspace, select the rows or columns in which you

want to format numbers.

• To select a column, click the highlighter under the column label. Use SHIFT + 
click or CTRL + click to select more than one column.

• To select a row, click the highlighter next to the row label. Use SHIFT + click or 
CTRL + click to select more than one row.

2. Choose the Format Document button on the Document toolbar.

3. Choose Format Rows and Columns from the popup menu.

Result: The Format Rows and Columns dialog box opens. The Fonts and Borders 
tab is active.

4. Select the Number tab.

5. The tab displays the current settings for numeric values. You can change the 
following settings:

• Decimal Digits — Specifies the number of decimal places to display.

• Use Thousands Separator — Indicates whether to display (or suppress) the 
thousands separator.

• Positive Values — Specifies the format for positive numbers (Available if you 
do not choose the Currency/Percent option).

• Display Leading Zeroes — Indicates whether to display (or suppress) leading 
zeros.

• Negative Values — Specifies the format for negative numbers (Available if you 
do not choose the Currency/Percent option).

• Apply Currency/Percent — Activates currency/percent format options:

• Symbol — Symbol for dollars, yen, pounds, francs, or percent.
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• Positive Values — Format for positive values.

• Negative Values — Format for negative values. 

• Scale Values Down By — Specifies scaling for large numbers.

As you make formatting choices, the Samples box in the lower left corner of the 
Format Number dialog box shows the effect that your choices will have on the 
data. 

6. Choose OK to apply your selections.

Clearing row and column formatting
You can clear formats that have been applied to rows and columns. You can clear 
formats from selected rows and columns or you can clear formats from all rows and 
columns.

To clear selected row and column formats:
1. With the report open in the workspace, select the rows, columns, or labels from 

which you want to remove formatting.

• To select a column, click the highlighter under the column label. Use SHIFT + 
click or CTRL + click to select more than one column.

• To select a row, click the highlighter next to the row label. Use SHIFT + click or 
CTRL + click to select more than one row.

• To select a row or column label, click the label. Use SHIFT + click or CTRL + 
click to select more than one label.

• To select all labels for a row or column, click the row or column label selector. 
The column label selector is located to the left of the first column label. The row 
label selector is located at the top of the row labels.

2. Choose the Format Document button on the Document toolbar. 

3. Choose Clear Selected Row and Column Formatting from the popup menu.

To clear all row and column formats:
1. With the report open in the workspace, choose the Format Document button on the 

Document toolbar. 
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2. Choose Clear All Row and Column Formatting from the popup menu.

Formatting Ad Hoc Reports Based on Data Conditions (Color Coding)
You can create conditional format rules that apply to an ad hoc report when data values
for a measure meet specified criteria. This is referred to as color coding. 

A color coding rule is composed of the following information: 

• One or more conditions that the data must meet in order to be displayed with the 
selected formats. 

• A set of formatting options that specify how the data that meets the conditions will 
look. 

Color coding rules are saved with a report. When you open a report that includes one or
more color coding rules, data that meet the criteria will have the specified formats.

Types of color coding conditions
Using color coding rules, you can implement conditions such as the following:

• When data values for a measure meet a specified condition, the data will display in 
a specified format. For example, you might define a rule that applies bold text and a
green background to cells in which the value for a measure is greater than or equal 
to 100,000. 

• When data values for a measure relate to another measure in a specified way, the 
data will display in a specified format. For example, you might define a rule that 
applies italic text and a red background to cells in which the value for one measure 
is greater than the value for another measure by 10%. 

You can also combine two conditions within a single rule and specify whether the data 
must meet either condition or both conditions. For example, you might define a rule 
that applies a green background to cells in which the value for a measure is greater than
or equal to 100,000 and greater than the value for another measure by 10%. 

Color coding format options
You can specify the following formats when you define a color coding rule: 

• Stoplight formatting — Stoplight formatting is a special type of color coding that 
highlights trends without showing values. When you apply stoplight formatting, 
data cells that meet the data conditions appear as solid blocks of color. The actual 
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value for a cell becomes visible only when you select it. 

• Font — You can specify font name, font size, and indicate whether the font is 
regular, bold or italic. If you select stoplight formatting, font options are not 
available.

• Color — You can specify the font color. If you select stoplight formatting, font color 
options are not available. 

• Background color — You can specify the background color for the cell. If you select 
stoplight formatting, the label for this option is "Cell Color."

Defining color coding rules
You can associate multiple color coding rules with a single report.

You can define one or two conditions for each rule and associate each measure in a 
report with a maximum of four rules. If the format associated with one rule conflicts 
with the format associated with another rule, the format that is associated with the most
recently defined rule takes precedence. 

To define a color coding rule for an ad hoc report:
1. With the document open in the workspace, choose the Color Coding button on the 

Document toolbar.

2. Result: If this is the first color coding rule for this report, the Color Coding Wizard 
starts. If the report has at least one color coding rule, the Color Coding dialog box 
opens, from which you can view the existing rules and choose Add to define a new 
rule. 

3. In the Color Coding Wizard -- Specify Measure dialog box, select the measure to 
which the color coding rule will apply. Choose Use Stoplight Formatting to apply 
stoplight formatting. 

For information about stoplight formatting, see "Color coding format options", page
14-26.

4. Choose Next to continue.

5. In the Color Coding Wizard -- Specify Data Condition dialog box, complete the 
Select by box as follows:

• Choose value to compare the measure with a numeric value.

or
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• Choose measure to compare the measure with another measure.

For more information, see "Types of color coding conditions", page 14-26. 

6. If you selected value in Step 4, proceed as follows:

1. In the where box, select a measure on which to base the value condition. You 
can select the default measure, or you can select an alternate measure.

2. In the is box, select an operator that specifies how the data values in the 
selected measure must compare to the value in the value box. 

3. In the value box, specify a number to which the data values in the measure will 
be compared. 

7. If you selected measure in Step 4, proceed as follows:

1. In the where measure box, select the first measure to use in the comparison. 
You can select the default measure, or you can select an alternate measure.

2. In the is box, choose the operator that specifies how the data values in the first 
measure must compare to the data values in the second measure.

3. In the measure box, specify the second measure to use in the comparison. You 
can select the default measure, or you can select an alternate measure.

4. You can specify a percentage or numeric value to include in the condition. 
Select percent if the value is a percent.

8. When the condition definition is complete, do one of the following:

• Choose Next to continue. 

• Choose Add a Second Data Condition to define a second condition for this 
rule. 

9. To add a second data condition, define the condition in the Color Coding Wizard -- 
Specify Additional Data Condition dialog box. Then choose one of the following 
options: 

• Apply when both first and second condition are met

• Apply when either first or second condition is met

10. Choose Next to continue.

11. In the Color Coding Wizard -- Specify Appearance dialog box, specify the formats 
in which data that meets the condition or conditions will display. 
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• In the Font box, select the font.

• In the Size box, select the font size.

• In the Style box, select the font style

• To select the font color, disable the Use Default box and select a color in the 
Font Color box.

• To select the background color for the cells, disable the Use Default box and 
select a color in the Background Color box.

If you selected Use Stoplight Formatting in Step 2, you can only choose the cell 
background color. 

12. Choose Next to continue.

13. In the Color Coding Wizard -- Specify Name dialog box, review the summary 
description of the data conditions. You can also enter a name for the rule. 

Note: You might want to use a name that describes the condition or
conditions.

14. Choose Finish to continue. 

Result:The Color Coding dialog box opens. It includes information regarding the 
appearance, description, and measure for the rule.

15. Choose OK to apply the current rule or rules.

Result: The report displays. If there are cells that meet the condition or conditions 
for a color coding rule, the data in these cells is formatted as specified. 

Example: Color coded ad hoc report
Consider an example, where you want to color code an ad hoc report, where the 
optimistic forecast amounts below $20000.00 would be color coded. Colored cells are 
those that meet the color coding criteria. 
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Example: Color coded ad hoc report with stoplight formatting
On the other hand, if you color-code an ad hoc report with stoplight formatting, the 
colored cells would be those that meet the color coding criteria. However, as the report 
uses stoplight formatting, the actual values do not display.
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Modifying color coding rules
You can modify a color coding rule for a report.

To modify a color coding rule for an ad hoc report:
1. With the document open in the workspace, choose the Color Coding button on the 

Document toolbar.

2. Result: The Color Coding dialog box opens, from which you can view the existing 
rules.

3. Select the rule that you want to change and choose Modify. 

Result: The color coding wizard starts. You can make new selections for measure, 
conditions, and color formats.
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Deleting color coding rules
When you no longer want to apply a color coding rule to a report, you can delete it.

To delete a color coding rule from an ad hoc report:
1. With the document open in the workspace, choose the Color Coding button on the 

Document toolbar.

2. Result: The Color Coding dialog box opens, from which you can view the existing 
rules.

3. Select the rule that you want to change and choose Delete. 

Result:The rule is deleted.

Printing Ad Hoc Reports
You can print an open ad hoc report and specify settings that determine how the 
printed pages will look. When you save the document, Oracle Demand Planning saves 
the print settings for order, scaling, and page setup.

You can also print one or more saved ad hoc reports and other documents directly from
the navigation list. Note that when you print multiple documents, you do not have the 
same options that are available when you print an open ad hoc report. For example, 
when you print an open document, you can specify the pages to print (all or current). 
When you print multiple documents from the navigation list, Oracle Demand Planning 
prints all pages of the selected documents.

To print an open ad hoc report:
1. With the document open in the workspace, choose the Print button on the 

Document toolbar. 

2. Result:The Print dialog box for your browser opens.

3. You can change the print defaults for the browser. For example, you can specify 
new values for printer and number of copies.

4. Choose OK to continue. 

Result: The Print dialog box for Oracle Demand Planning opens. 
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5. In the Print box, specify the pages that you want to print. You can choose one of the 
following options: 

• Current Page of Data — Prints the current page of data as indicated by the 
page label.

• All n Pages of Data — Prints all pages of data, beginning at the first logical 
page, regardless of the current page settings.

If you choose to print all pages, the system prints all data for all dimension 
values that are in the page position in the document. Depending on the number
of dimensions that are in status in the page position, printing all pages might 
result in many pages of output. 

6. In the Order box, you can specify the order in which to print the pages. You can 
choose one of the following options: 

• Across then down — Prints as many rows and columns as will fit on a physical 
page, then moves across the columns (until all are printed) and then down the 
rows (until all are printed).

• Down then across — Prints as many rows and columns as will fit on a physical 
page, then moves down the rows (until all are printed) and then across the 
columns (until all are printed).

7. In the Scaling box, you can specify how to scale the document. You can choose one 
of the following options:

• Adjust to — Scales each logical page by a percentage that you select. The 
output will span the number of physical pages that are necessary to meet the 
specified percentage.

• Fit to — Scales each logical page to span the width and height of the number of 
pages that you select. 

8. To indicate how you want the printed pages to look, choose Page Setup. This opens
the Page Setup dialog box, where you can perform the following operations:

• Specify optional header text (up to 100 characters) for the printed page.

• Specify an optional footer for the printed page.

• Specify whether row, column, and page labels will be repeated on each printed 
page.

• Specify whether a title, subtitle, and footnote will appear on the printed pages.

• Specify margin settings for the printed pages.
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9. If you want to preview the pages before printing them, choose Preview.

10. Choose OK to print the document. 

To print multiple documents from the navigation list:
1. Access Oracle Demand Planning as a Demand Planner or Demand Plan Manager.

2. In the navigation list, open the folders that contain the documents that you want to 
print. 

3. Scroll to a document, press the CTRL key and simultaneously click the document 
object.

Result:The document is highlighted.

4. Repeat Step 3 for each document that you want to print.

5. After you make your final selection, click the right mouse button and choose Print 
from the popup menu. 

Saving Ad Hoc Reports
When you have created or modified an ad hoc report, you can save it for use at another 
time.

Saving a report saves the view with the current measures and dimension value 
selections, formatting, and layout. Saving also preserves current specifications for 
ranking/exception, print scaling and page setup, as well as export option settings.

You have the following options when you save an ad hoc report:

• You can save the document. The saved ad hoc report appears as an object in the 
main Documents folder in the navigation list.

• You can save the document in a folder that you have previously created. The saved 
ad hoc report appears as an object in the specified folder in the navigation list. 

• You can save the report as the default ad hoc report document. When you create a 
new ad hoc report that is based on the default, the new report will have the 
measure and dimension value selections, layout, and format characteristics of the 
default.

To save an ad hoc report:
1. With the document open in the workspace, choose the Save As button on the 

Document toolbar. 
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The Save As dialog box opens. If you are saving a new document, a default name, 
such as "Document 1," appears in the Save Document As box. If you are saving 
modifications to an existing document, the document name appears in the Save 
Document As box. 

2. Specify the name for the report that you are saving, as follows: 

• If you are saving a new document, type a name for it in the Save Document As 
box. The name can be up to 70 characters long.

• If you are saving an existing document under a new name, replace the name in 
the Save Document As box with the new name. The name can be up to 70 
characters long.

• If you want to give the report the name of an existing document (overwrite the 
document), choose the Save As box and select a name from the list of saved 
documents.

If you are saving an existing report under its current name, or if you intend to 
save the document as the default ad hoc report, do nothing with the 
information in the Save Document As box.

3. Do one of the following: 

• In the Into Folder box, select the folder into which you want to save the report. 

To save the report into the main Documents folder, select (none) in the Into 
Folder box. 

or

• If you want to save the report as your default ad hoc report document, so that 
its structure will appear whenever you create a new ad hoc report, select the 
Save As Default option. 

4. Choose OK. 

Result:The Save As dialog box closes. The report that you saved is again visible in 
the workspace. If you saved the report in a folder, the document object appears 
within that folder in the navigation list. If you did not specify a folder, the report 
appears in the main Documents folder.

Copying Data from Ad Hoc Reports
You can copy data from contiguous cells in an ad hoc report to the Windows clipboard. 
You can choose to copy data that has been stripped of special formats such as 
thousands separators, currency signs, and percent symbols or you can include these 
elements. You can also copy row and column labels.
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To copy data from an ad hoc report:
1. With the document open in the workspace, select the cell or cells that you want to 

copy. 

You can select cells by using row and column selectors. You can also select cells by 
selecting a cell as a starting point, dragging the mouse pointer, and then releasing 
the mouse button at the end of the block. 

You cannot select cells that are not contiguous.

2. Choose the Copy button on the Document toolbar.

3. Alternatively, you can click the right mouse button. 

4. Choose a copy option: 

• Copy — Copies the data but excludes formats such as thousands separators, 
currency signs, and percent symbols.

• Copy Special — Presents a submenu from which you can select one of the 
following:

• Copy Data with Labels — Copies the data but excludes formats such as 
thousands separators, currency signs, and percent symbols. Also copies 
row and column labels that are associated with the selection.

• Copy Number Formatted Data — Copies the data and includes formats 
such as thousands separators, currency signs, and percent symbols.

• Copy Number Formatted Data with Labels — Copies the data and 
includes formats such as thousands separators, currency signs, and percent 
symbols. Also copies the row and column labels that are associated with the
selection.

• Copy Row Labels — Copies the row labels that are associated with the 
selected data. Does not copy the actual data.

• Copy Column Labels — Copies the column labels that are associated with 
the selected data. Does not copy the actual data.

5. If you see a dialog box requesting additional privileges, choose Grant. 

Result: The data is copied to the Windows clipboard.
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Exporting Data from Ad Hoc Reports
You can export data from an ad hoc report to files that can be used in Microsoft Excel 
and other applications. You can select one of three export format options (CSV, TXT, or 
HTM for Excel 2000+), and export data from all pages or from a specific page.

Note: If the document contains many pages of data, you might have 
difficulty opening the file in certain applications. To avoid this 
situation, modify the data selections to reduce the number of values 
before creating the export file.

To export data from an ad hoc report:
1. With the document open in the workspace, choose the Export button on the 

Document toolbar.

2. Result: The Export dialog box opens.

3. In the Export box, choose the pages to include in the export file. You can select one 
of the following options: 

• Current Page — Exports data from the current page as indicated by the page 
label.

• All n Pages — Exports all pages of data, beginning at the first logical page, 
regardless of the current page settings. 

4. In the As Type box, select the format for the export file. You can choose one of the 
following:

• Comma delimited (*.csv) — Exports the data in Comma Separated Value 
format, in which labels and data values are separated by commas.

• Tab delimited (*.txt) — Exports the data in text file format, in which labels and 
data values are separated by tabs.

• Excel 2000+ (*.htm) — Exports the data in a format that can be read by a 
browser and opened in Excel version 2000 and version 2002, also known as XP.

5. In the Options box, you can choose the following options for the export file: 

• Include Number Formatting — For a CSV or TXT export, check this option to 
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export the data with the current setting for number formats. Do not check this 
option if you want to export unformatted numeric data. Note that an HTM 
export automatically includes number formats.

• Repeat Group Labels — Check this option to repeat outer labels for columns 
and rows of inner, nested dimensions. Do not check this option if you want the 
export file to display labels as they appear in the screen display. 

Include Title, Subtitle, Footnote — Check this option to include the title, 
subtitle, and footnote of the document in the export file. Do not check this 
option if you want to exclude these elements.

• Create One Sheet per Page — For a multi-page HTM export, check this option 
to export the data from each logical page to a separate Excel worksheet. Do not 
check this option if you want to export the data from all pages to a single Excel 
worksheet. For more information, see About Excel 2000+ output files , page 14-
38.

6. Choose OK to continue.

Result:If you chose CSV or TXT format, the File Download dialog box opens. If you 
chose HTM format, the Export to HTML/Excel 2000+ dialog box opens. 

7. For a CSV or TXT export, proceed as follows:

1. In the File Download box, choose Save this file to disk.

Result: The Save As dialog box opens. 

2. In the Save in box, select the output directory for the export file.

3. In the File name box, enter a name for the export file.

4. Choose OK to export the file.

8. For an HTM export, proceed as follows:

1. In the Save in box, select the output directory for the export file.

2. In the File name box, enter a name for the export file.

3. Choose OK to export the file.

About Excel 2000+ output files
When you export to a single worksheet in Excel 2000+ (*.htm) format, Oracle Demand 
Planning generates a single HTML file in the directory that you specify. 

When you export to a multi-page file in Excel 2000+ format and indicate that you want 
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to create one sheet per page, Oracle Demand Planning generates an HTML table of 
contents file plus a number of other files in the directory that you specify. Use the table 
of contents file to access the individual worksheets.

Closing Ad Hoc Reports
When you have finished working in an open ad hoc report, you can close it. If you have 
modified the report but did not save it, you will be prompted to specify whether you 
want to save the document.

To close an ad hoc report:
Choose the Close button, located in the upper right corner of the document. 

Renaming Ad Hoc Reports
You can give a new name to a saved ad hoc report. If the report is in more than one 
folder, it will be renamed in all folders.

To rename an ad hoc report:
1. Access Oracle Demand Planning as a Demand Planner or Demand Plan Manager.

2. In the navigation list, identify the ad hoc report that you want to rename.

To search for an ad hoc report in the navigation list, click the right mouse button on 
the main Documents folder or a specific folder and choose Find from the popup 
menu. Then enter a name or name fragment. Alternatively, you can choose the Find 
button on the navigation toolbar.

3. Click the right mouse button on the document object and choose Rename from the 
popup menu.

4. Enter the new name, up to 70 characters long.

Viewing Ad Hoc Report Properties
You can view the following properties of a saved ad hoc report:

• Name 

• Created 

• Modified 
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• Class 

• Applied saved selections

To view the properties of an ad hoc report:
1. Access Oracle Demand Planning as a Demand Planner or Demand Plan Manager.

2. In the Navigation list, identify the ad hoc report whose properties you want to 
view.

3. Click the right mouse button on the document object and choose Properties from 
the popup menu.

Deleting Ad Hoc Reports
When you no longer need a saved ad hoc report, you can delete it. If the report exists in 
more than one folder, only the selected version will be deleted. 

You can delete an individual report. You can also delete a report as one of multiple 
documents.

To delete an ad hoc report:
1. Access Oracle Demand Planning page as a Demand Planner or Demand Plan 

Manager.

2. In the Navigation list, identify the ad hoc report that you want to delete.

3. Select the report and choose the Delete button on the navigation toolbar.

4. Alternatively, you can click the right mouse button on the document object and 
choose Delete from the popup menu.

Result: You will be prompted to confirm the deletion.

To delete multiple documents:
1. Access Oracle Demand Planning as a Demand Planner or Demand Plan Manager.

2. In the navigation list, open the folders that contain the documents that you want to 
delete.

3. Scroll to a document, press the CTRL key and simultaneously click the document 
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object.

Result:The document is highlighted.

4. Repeat the previous step for each document that you want to delete.

5. After you make your final selection, click the right mouse button and choose Delete
from the popup menu. 

Result:You will be prompted to confirm the deletion.
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15
Using Ad Hoc Graphs

This chapter covers the following topics:

• About Ad Hoc Graphs

• Creating Ad Hoc Graphs

• Opening Ad Hoc Graphs

• Selecting Data for Ad Hoc Graphs

• Arranging and Viewing Data in Ad Hoc Graphs

• Formatting Ad Hoc Graphs

• Printing Ad Hoc Graphs

• Saving Ad Hoc Graphs

• Exporting Data from Ad Hoc Graphs

• Closing Ad Hoc Graphs

• Renaming Ad Hoc Graphs

• Viewing Ad Hoc Graph Properties

• Deleting Ad Hoc Graphs

About Ad Hoc Graphs
Ad hoc graphs display multi-dimensional data in graphical format. When you work as 
a Demand Planner or Demand Plan Manager you can create an ad hoc graph to 
visualize an analysis on the fly. You can also save an ad hoc graph and run it on a 
regular basis. 

You can use ad hoc graphs to accomplish the following: 

• Show trends and emphasize the degree or rate of change.

• Quickly compare data associated with different dimension values.
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• Show part-to whole relationships.

• Show the relationship between two measures.

Toolbar for ad hoc graphs
The Document toolbar appears at the top of an open ad hoc graph. The toolbar buttons 
enable you to perform the functions that are listed below.

• Choose Values from List  - Select values from a list and access various data 
selection tools. Also sort selections.

• Apply Saved Selection  - Replace the current values in the graph with a saved 
selection of values.

• Save Current Selection - Save the dimension values in status for a dimension as a 
saved selection.
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• Change Layout - Change the layout of the graph by changing the relative position 
of the dimensions.

• Change View Type - Change the graph type, or change the graph to a report with 
dimension selections identical to the current ones.

• Export to Spreadsheet - Export data and labels from the graph to a .CSV, .TXT, or 
.HTM file.

• Save As  - Save the graph.

• Refresh  - Refresh the data in the open document.

• Format Document  - Specify a title, subtitle, and footnote for the report. Also apply 
formatting to the entire report and to selected rows and columns.

• Print - Print the graph.

• Help - Display online Help for planners and the Demand Plan Manager.

Types of graphs
The following table describes the types of graphs that are available.

Graph Type Description Subtypes

Bar Compares data associated 
with different dimension 
values

• Clustered

• Clustered Dual-Y

• Stacked

Line Shows trends over time and 
emphasizes rates of change

• Absolute

• Absolute Dual-Y

• Stacked

• Stacked Dual-Y

• Percentage
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Graph Type Description Subtypes

Area Shows trends and emphasizes
the degrees of change

• Absolute

• Stacked

• Percentage

3D Isometric presentation of an 
area stacked graph, 
representing the same type of 
data, but from a different 
perspective

 

Single pie Shows part to whole 
relationships

 

Scatter Dual-Y Shows relationships between 
two measures

Creating Ad Hoc Graphs
You can base an ad hoc graph on the default ad hoc graph document. Alternatively, you
can use any saved document as the starting point for a new graph. You can also change 
a tabular report display into a graph.

The data in the new graph initially reflects the document on which the graph is based. 
You can then customize the graph so that it displays exactly the data that you want to 
work with. You can also select graph type, layout, and format options.

The following procedure describes how to create a new graph. For information about 
changing a report to a graph, see "Changing the document type for an ad hoc graph", 
page 15-8.

To create an ad hoc graph:
1. Access Oracle Demand Planning as a Demand Planner or Demand Plan Manager.

2. On the navigation toolbar, choose the New button.

3. Choose New Graph. 
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Alternatively, you can click the right mouse button on Documents in the navigation
list and choose New Graph from the popup menu.

4. Choose one of the following:

• Use default — Creates an ad hoc graph that is based on the default ad hoc 
graph document. 

• Based on — Creates an ad hoc graph that is based on a selected document.

If there are no saved documents, then you do not have these options. The graph
will automatically be based on the default graph document.

5. Choose OK to create the graph.

Result: The graph is displayed in the workspace. A generic name, such as "
Document 1," appears above the body of the graph.

Displaying Multiple Documents
You can open the following documents at the same time:

• One worksheet

• One planning percentages worksheet

• One predefined report or one ad hoc graph

• Up to seven ad hoc reports

To learn more about the multi-document interface, see the section on The Document 
Workspace., page 11-5

If you are working with a graph and there is a worksheet open, you can synchronize the
data in the documents by refreshing them simultaneously. See the section on refreshing 
open documents, page 11-7 in the worksheet chapter.

Opening Ad Hoc Graphs
You can open a saved ad hoc graph.

Saved graphs are displayed as objects in the navigation list, located in the left frame of 
your browser. Depending on how a graph was saved, it might appear in the main 
Documents folder or in a folder that you created. 

To open an ad hoc graph:
1. Access Oracle Demand Planning as a Demand Planner or Demand Plan Manager.
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2. In the navigation list, identify the graph that you want to open.

3. Double-click the document object. 

Alternatively, you can click the right mouse button on the document object and 
choose Open from the popup menu.

Default Document Layout
When a user creates a new worksheet, report or graph, Oracle Demand Planning 
intelligently displays immediately usable, populated documents by setting status to 
dimensions where data is available. To see information on the default layout for graphs,
see the section on the default layout, page 11-8 in the worksheet chapter.

Selecting Data for Ad Hoc Graphs
When you create a new ad hoc graph or change a report to a graph, the data reflects 
selections that were made for the document on which the graph is based. When you 
open a saved ad hoc graph, the data reflects selections that were in effect when the 
document was saved. 

You can select measures and dimension values so that the graph displays exactly the data 
that you want to work with.

• A measure represents a variable which is a placeholder for storing data values for all
levels of all dimensions. For example Booking History, Shipment History, and Q1 
Forecast might be measures in your database. 

• A dimension is a database object that organizes and indexes the data, similar to a key
in a relational database. For example, if you have data with values for various time 
periods, then the data has a Time dimension; that is, it is organized by time. 

• Dimension values are the elements that make up a dimension. For example, a Time 
dimension might include values for years, quarters, months, and weeks. You can 
select any or all of the values that are available within a dimension, including 
custom aggregates that you have defined.

To select data for an ad hoc graph: 
1. With the document open in the workspace, choose the Select Data button on the 

Document toolbar. 

2. Result: The Select Data dialog box opens.
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3. Select the values that you want to include in the graph.

Applying custom aggregates and saved selections to an ad hoc graph
In addition to using a selection list or selection tools to select data values for a graph, 
you can change the data that is displayed by applying saved selections and custom 
aggregates to the open document. For more information, see the following topics:

"Defining Custom Aggregates", page 19-1

"Applying Custom Aggregates to Open Documents", page 19-3

"Defining Saved Selections, page 20-1

"Applying Saved Selections to Open Documents", page 20-4

Arranging and Viewing Data in Ad Hoc Graphs
You can change an ad hoc graph so that the data is arranged in the way that you want. 
The following options are available: 

• You can change the layout by rearranging the dimensions on the page.

• You can change the graph type, or display the graph data as a tabular report.

• You can drill through aggregate values to expose component values. 

• You can page through the graph to view data for dimensions in the page position.

Changing the layout of an ad hoc graph
You can change the layout of a graph by moving one of the graph's elements relative to 
another element. 

To change the layout of an ad hoc graph:
1. With the document open in the workspace, choose the Change Layout button on 

the Document toolbar. 

2. Result: The Layout box displays the current positions of the dimensions on the 
page. Dimensions for which data displays as separate pages of the graph are shown
in the Page position. Dimensions for which data is on the X-axis of the graph are 
shown in the across position. Dimensions for which data is on the Y-axis of the 
graph are shown in the series position. 
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3. You can click a dimension and drop it on another location or drag it to a new 
location. 

Result: The dimension moves as follows:

• If you drag a dimension near another dimension and the dimension turns gray, 
this indicates that the two dimensions will exchange (swap) positions. 

• If you drag a dimension and a black bar appears, this indicates that the 
dimension will be moved to the position.

4. You can also use the controls at the top of the page to manipulate dimension 
positions as follows:

1. In the left box, select an action.

• Choose Move to move a dimension to another position. 

• Choose Swap to exchange the position of one dimension with another 
dimension.

2. In the center box, select the dimension on which to perform the move or 
exchange.

3. If you chose Move, use the right box to select the target location for the 
dimension. 

If you chose Swap, use the right box to select the dimension or edge with which
to make the exchange. 

4. Choose Go to update the display in the Layout box to reflect the current status 
in the boxes.

5. When the Layout box displays the desired layout, choose OK to apply the current 
settings.

Result: The Change Layout dialog box closes. The elements in the document are 
moved to the locations that you specified.

Changing the document type for an ad hoc graph
You can change a graph to a different type of graph. You can also change the document 
from a graphical format into a tabular report format. 

To change the document type for an ad hoc graph:
1. With the document open in the workspace, choose the Change Document Type 

button on the Document toolbar. 
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2. Result:The Change Document dialog box opens.

3. In the Change document type box, do one of the following:

• To change the graph to a report, select Report.

or

• To change the type of graph, select a graph type.

For information about graph types, see Types of graphs", page 15-3.

4. Choose OK to apply the current settings. 

Result: The Change Document Type dialog box closes. The graph changes to the 
specified document type.

Drilling through levels of data in an ad hoc graph
You can view data at various levels in a graph by drilling within aggregate dimension 
values. For example, if the document displays a geography that includes lower level 
values, you can "drill down" and expand the display to show component geographies. 
You can then "drill up" to collapse the display. 

You can drill a dimension value that is on the X or Y axis if a plus (+) or minus (-) 
symbol and the words "Drill down (or up) from dimension value name" appears when 
you move the cursor over the value. 

Paging through an ad hoc graph
Graph data is displayed one page at a time. You can use the page controls at the top of 
the document to display pages other that the one that is currently in view. For example, 
the current page might show data for Total Product, but you can select another product 
from the list to see its data.

Formatting Ad Hoc Graphs
You can format a graph as follows:

• You can add text elements such as title, subtitle, and footnote. 

• You can specify properties for tick labels on the graph's X-axis. 

• You can show or hide the graph legend and specify whether its orientation is 
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horizontal or vertical. 

Displaying Item Descriptions
When you add formatting to your graph, you can also customize the display labels for 
dimensions so that the labels for all values of a dimension are displayed in the format 
that you choose. In the product dimension, for example, you can display item 
descriptions next to their part numbers. 

The tool that you use to set item descriptions is the Dimension Labels tab of the Format 
Document dialog box. There is a Label Type frame that displays a table or grid for the 
dimensions in the demand plan and their current settings for the document. The 
Dimension column displays the dimensions, and the Labels column displays the label 
settings.

The procedure for selecting appropriate forms of dimension labels in your graphs is 
described under the topic Displaying Item Descriptions, page 11-26 in the chapter on 
using worksheets. The steps are identical except that there is no submenu displayed for 
a graph when you choose the Format Document button on the graph toolbar.

Specifying title, subtitle, and footnote for an ad hoc graph
You can add a title, subtitle, and footnote to a graph and specify whether each of these 
elements will display in the current document.

To specify a title, subtitle, and footnote for an ad hoc graph:
1. With the document open in the workspace, choose the Format Document button on

the Document toolbar.

2. ChooseFormat Document from the submenu.

Result: The Format Document dialog box opens. The Titles tab is active.

3. Choose a text element (Title, Subtitle, or Footnote) and proceed as follows: 

1. Select font properties (name, size, color, bold/italic, background color) for the 
text.

2. Specify the alignment for the text.

3. In the Display Options box, choose Show to display the specified text element 
in the current document.

4. In the Text box, type the text for the title, subtitle, or footnote (498 characters 
maximum). 
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4. Repeat the previous step for each text element that you want to include.

5. Choose OK to apply the current settings. 

Formatting tick labels in an ad hoc graph
You can change the frequency and position of tick labels in an ad hoc graph.

To format tick labels in an ad hoc graph:
1. With the document open in the workspace, choose the Format Document button on

the Document toolbar, select the Format Document button.

2. Then chooseFormat Document from the submenu.

Result: The Format Document dialog box opens. The Titles tab is active.

3. Select the Tick Labels tab. 

4. To offset every other label for readability, choose Staggered.

5. If you want to skip some tick labels, select one of the following options in the Skip 
Mode box: 

• Automatic — Skips tick labels using a default interval that is set by the system. 

• Manual — Skips tick labels using interval settings that you provide. 

If you do not want to skip any tick labels, choose None.

6. If you chose Manual in the previous step, in the Skip Amount box specify the 
number of tick labels that should be skipped.

Formatting the legend in an ad hoc graph
You can change the position and orientation of the graph legend and specify the font to 
use.

To format the legend for an ad hoc graph:
1. With the graph open in the workspace, choose the Format Document button on the 

Document toolbar.
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2. Result: The Format Document dialog box opens. The Titles tab is active.

3. Select the Legend tab. 

4. Choose Show Legend to display the legend in the current document.

5. The Font Properties box displays the current font settings for the legend. You can 
change one or more of these selections as follows:

• Use the Font box to select the font.

• Use the Size box to select the font size.

• Use the Color box to select the color for the text.

6. The Legend Location box shows the current location of the legend. To change the 
location, click the desired position.

7. The Orientation box shows the current orientation of the legend. To change the 
orientation, choose Vertical or Horizontal. 

8. Choose OK to apply your selections.

Printing Ad Hoc Graphs
You can print an open ad hoc graph and specify settings that determine how the 
printed pages will look. When you save the document, Oracle Demand Planning saves 
the print settings for order, scaling, and page setup.

You can also print one or more saved ad hoc graphs and other documents directly from 
the navigation list. Note that when you print multiple documents, you do not have the 
same options that are available when you print an open graph. For example, when you 
print an open graph, you can specify the pages to print (all or current). When you print 
multiple documents from the Navigation list, Oracle Demand Planning prints all pages 
of the selected documents.

To print an open ad hoc graph:
1. With the document open in the workspace, choose the Print button on the 

Document toolbar. 

2. Result:The Print dialog box for your browser opens.

3. You can change the print defaults for the browser. For example, you can specify 
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new values for printer and number of copies.

4. Choose OK to continue. 

Result: The Print dialog box for Oracle Demand Planning opens. 

5. In the Print box, specify the pages that you want to print. You can choose one of the 
following options: 

• Current Page of Data — Prints the current page of data as indicated by the 
page label.

• All n pages of Data — Prints all pages of data, beginning at the first logical 
page, regardless of the current page settings. 

If you choose to print all pages, the system prints all data for all dimension 
values that are in the page position in the document. Depending on the number
of dimensions that are in status in the page position, printing all pages might 
result in many pages of output. 

6. In the Order box, you can specify the order in which to print the pages. You can 
choose one of the following options: 

• Across then down — Prints as many rows and columns as will fit on a physical 
page, then moves across the columns (until all are printed) and then down the 
rows (until all are printed).

• Down then across — Prints as many rows and columns as will fit on a physical 
page, then moves down the rows (until all are printed) and then across the 
columns (until all are printed).

7. To indicate how you want the printed pages to look, choose Page Setup. This opens
the Page Setup dialog box, where you can perform the following operations:

• Specify optional header text (up to 100 characters) for the printed page.

• Specify an optional footer for the printed page.

• Specify margin settings for the printed pages.

8. In the Scaling box, you can specify how to scale the graph. Choose one of the 
following options: 

• Fit to Page — Scales the graph to fit the width and height of the physical 
printed page. If you want to maintain the proportions that are presented on the 
screen, also select Maintain Proportions. 

• Actual Size — Scales the graph to fit the width and height of the physical 
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printed page.

9. If you want to preview the pages before printing them, choose Preview.

10. Choose OK to print the document. 

To print multiple documents from the Navigation List:
1. Access Oracle Demand Planning as a Demand Planner or Demand Plan Manager.

2. In the navigation list, open the folders that contain the documents that you want to 
print. 

3. Scroll to a document, press the CTRL key and simultaneously click the document 
object.

Result:The document is highlighted.

4. Repeat the previous step for each document that you want to print.

5. After you make your final selection, click the right mouse button and choose Print 
from the popup menu. 

Saving Ad Hoc Graphs
When you have created or modified an ad hoc graph, you can save it for use at another 
time.

Saving a graph saves the view with the current measures and dimension value 
selections, formatting, and layout. Saving also preserves current specifications for print 
scaling and page setup, as well as export option settings.

You have the following options when you save an ad hoc graph:

• You can save the document. The saved ad hoc graph appears as an object in the 
main Documents folder in the navigation list.

• You can save the document in a folder that you have previously created. The saved 
ad hoc graph appears as an object in the specified folder in the navigation list.

• You can save the document as the default ad hoc graph document. When you create
a new graph that is based on the default, the new graph will have the dimension 
value and measure selections, layout, and formatting characteristics of the default.

Note: Before you save a graph as the default graph, you might 
want to remove distinctive format elements such as a title.
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To save an ad hoc graph:
1. With the document open in the workspace, choose the Save As button on the 

Document toolbar. 

2. The Save As dialog box opens. If you are saving a new graph, a generic name, such 
as "Document 1," appears in the Save Document As box. If you are saving an 
existing graph, its name appears in the Save Document As box. 

3. Specify the name for the graph that you are saving, as follows: 

• If you are saving a new graph, type a name for it in the Save Document As box. 
The name can be up to 70 characters long.

• If you are saving an existing graph under a new name, replace the name in the 
Save Document As box with the new name. The name can be up to 70 
characters long.

• If you want to give the graph the name of an another saved document 
(overwrite a document), in the Save As box, select a name from the list of saved 
documents.

If you are saving an existing graph under its current name, or if you intend to 
save the graph as the default graph document, do nothing with the information 
in the Save Document As box.

4. Do one of the following: 

• In the Into Folder box, select the folder into which you want to save the graph. 

To save the graph into the main Documents folder, select (none) in the Into 
Folder box. 

or

• If you want to save the graph as your default graph document, so that its 
structure will appear whenever you create a new ad hoc graph, select the Save 
As Default option. 

• Choose OK to save the graph. 

Result:The Save As dialog box closes. The document that you saved is again 
visible in the workspace. If you saved the graph into a folder, the document 
object appears within that folder in the navigation list. 
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Exporting Data from Ad Hoc Graphs
You can export data from an ad hoc graph to files that can be used in Microsoft Excel 
and other applications. You can select one of three export format options (CSV, TXT, or 
HTM for Excel 2000+), and export data from all pages or from a specific page.

Note: If the document contains many pages of data, you might have 
difficulty opening the exported file in certain applications. To avoid this
situation, modify the data selections to reduce the number of values 
before creating the export file.

To export data from an ad hoc graph:
1. With the document open in the workspace, choose the Export button on the 

Document toolbar.

2. Result: The Export dialog box opens.

3. In the Export box, choose the pages to include in the export file. You can select one 
of the following options: 

• Current Page — Exports data from the current page as indicated by the page 
label.

• All n Pages — Exports all pages of data, beginning at the first logical page, 
regardless of the current page settings. 

4. In the As Type box, select the format for the export file:

• Comma delimited (*.csv) — Exports the data in Comma Separated Value 
format, in which labels and data values are separated by commas.

• Tab delimited (*.txt) — Exports the data in text file format, in which labels and 
data values are separated by tabs.

• Excel 2000+ (*.htm) — Exports the data in a format that can be read by a 
browser and opened in Excel version 2000 and version 2002, also known as XP.

5. In the Options box, you can choose the following options for the export file: 

• Include Number Formatting — For a CSV or TXT export, check this option to 
export the data with the current setting for number formats. Do not check this 



Using Ad Hoc Graphs    15-17

option if you want to export unformatted numeric data. Note that an HTM 
export automatically includes number formats.

• Repeat Group Labels — Check this option to repeat outer labels for inner, 
nested dimensions. Do not check this option if you want the export file to 
display labels as they appear in the screen display. 

Include Title, Subtitle, Footnote — Check this option to include the title, 
subtitle, and footnote of the document in the export. Do not check this option if 
you want to exclude these elements.

• Create One Sheet per Page — For a multi-page HTM export, check this option 
to export the data from each logical page to a separate Excel worksheet. Do not 
check this option if you want to export the data from all pages to a single Excel 
worksheet. For more information, see "About Excel 2000+ output files" , page 
15-17.

6. Choose OK to continue.

Result:If you chose CSV or TXT format, the File Download dialog box opens. If you 
chose HTM format, the Export to HTML/Excel 2000+ dialog box opens. 

7. For a CSV or TXT export, proceed as follows:

1. In the File Download box, choose Save this file to disk.

Result: The Save As dialog box opens. 

2. In the Save in box, select the output directory for the file.

3. In the File name box, enter a name for the file.

4. Choose OK to export the file.

8. For an HTM export, proceed as follows:

1. In the Save in box, select the output directory for the file.

2. In the File name box, enter a name for the file.

3. Choose OK to export the file.

About Excel 2000+ output files
When you export to a single worksheet in Excel 2000+ (*.htm) format, Oracle Demand 
Planning generates a single HTML file in the directory that you specify. 

When you export to a multi-page file in Excel 2000+ format and indicate that you want 
to create one sheet per page, Oracle Demand Planning generates an HTML table of 
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contents file plus a number of other files in the directory that you specify. Use the table 
of contents file to access the individual worksheets.

Closing Ad Hoc Graphs
When you have finished working in an ad hoc graph, you can close it. If you have 
modified the graph, you will be prompted to specify whether you want to save it.

To close an ad hoc graph:
Choose the Close button, located in the upper right corner of the document. 

Renaming Ad Hoc Graphs
You can give a new name to a saved ad hoc graph. If the graph is in more than one 
folder, it will be renamed in all folders.

To rename an ad hoc graph:
1. Access Oracle Demand Planning as a Demand Planner or Demand Plan Manager.

2. In the navigation list, identify the graph that you want to rename.

Note: To search for an ad hoc graph in the navigation list, click the 
right mouse button on the main Documents folder or a specific 
folder and choose Find from the popup menu. Then enter a name 
or name fragment. Alternatively, you can choose the Find button on
the navigation toolbar.

3. Click the right mouse button on the document object and choose Rename from the 
popup menu.

4. Enter the new name. The name can be up to 70 characters long.

Viewing Ad Hoc Graph Properties
You can view the following properties of a saved ad hoc graph:

• Name 

• Created 

• Modified 
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• Class 

• Applied saved selections

To view the properties of an ad hoc graph:
1. Access Oracle Demand Planning as a Demand Planner or Demand Plan Manager.

2. In the navigation list, identify the graph whose properties you want to view.

3. Click the right mouse button on the document object and choose Properties from 
the popup menu.

Deleting Ad Hoc Graphs
When you no longer need a saved ad hoc graph, you can delete it. If the document 
exists in more than one folder, only the selected version will be deleted. 

You can delete an individual graph. You can also delete a graph as one of multiple 
documents.

To delete an ad hoc graph:
1. Access Oracle Demand Planning as a Demand Planner or Demand Plan Manager.

2. In the navigation list, identify the graph that you want to delete.

3. Click the document object and click the Delete button on the navigation toolbar.

4. Alternatively, you can right-click the document object and choose Delete from the 
popup menu.

Result: You will be prompted to confirm the deletion.

To delete multiple documents:
1. Access Oracle Demand Planning page as a Demand Planner or Demand Plan 

Manager.

2. In the navigation list, open the folders that contain the documents that you want to 
delete.

3. Scroll to a document, press the CTRL key and simultaneously click the document 
object.
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Result:The document is highlighted.

4. Repeat the previous step for each document that you want to delete.

5. After you make your final selection, right-click and choose Delete from the popup 
menu. 

Result:You will be prompted to confirm the deletion.
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16
Using Predefined Reports

This chapter covers the following topics:

• About Predefined Reports

• Comparison Accuracy Document 

• Aged Accuracy Document 

• Other Predefined Reports

• Opening Predefined Reports

• Changing Data in Predefined Reports

• Viewing Data in Predefined Reports

• Printing Predefined Reports

• Copying Data from Predefined Reports

• Exporting Data from Predefined Reports

• Closing Predefined Reports

About Predefined Reports
Predefined reports are standardized documents. When you work as a Demand Planner 
or Demand Plan Manager, you can use predefined reports to conduct defined business 
analyses along specific dimensions. 

Predefined reports compared with ad hoc reports and graphs
The following table compares predefined reports to ad hoc reports and graphs.
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Predefined reports Ad hoc reports and graphs

The Demand Planning System Administrator 
determines the documents that will be 
available. All users have access to the same set
of documents. 

You define your own documents.

The focus of each document is predetermined,
but you can change certain default settings.

You determine the focus and content of each 
document.

You cannot make layout changes or apply 
formatting.

You can specify layout and formatting for 
each document. 

You can change most reports to graphs and 
graphs to reports.

You can change reports to graphs and graphs 
to reports. You can also select the graph type.

You cannot save documents. However, you 
can save changes in the default document 
settings.

You can save documents.

You can print documents. You can print documents.

You can export data from documents. You can export data from documents.

What documents can you run?
You might have access to all of the predefined reports that are discussed in this section, 
or you might have access to only a subset of documents. When the Demand Planning 
System Administrator sets up the user environment, he or she selects from among all of 
the predefined reports, those that will be available to planners and the Demand Plan 
Manager.

Toolbar for predefined reports
The Document toolbar appears at the top of an open predefined report. The toolbar 
buttons enable you to perform the functions that are listed below.

• Export to Spreadsheet - Export data and labels from the report to a comma 
delimited .CSV, .TXT, or .HTM file.

• Copy - For a report view, copies selected data from the document to the Windows 
clipboard.

• Print - Print the document.
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• Help - Display online Help.

Comparison Accuracy Document 
The Comparison Accuracy document enables you to evaluate the accuracy of your 
forecasts. It compares two measures over a specified time period and quantifies the 
difference and percent difference between them. For example, you might use the 
Comparison Accuracy document to compare a forecast that was submitted in a prior 
cycle to actuals.

If your installation includes the Comparison Accuracy document, the document 
appears within the Forecast folder in the Navigation list.

A comparison of accuracy measures and statistics
The Comparison Accuracy report view includes the includes the following accuracy 
measures and statistics:

• MAD (Mean Absolute Deviation) — Reflects the magnitude of the data on which 
the forecast is based. A lower value of MAD indicates that, on the average, there is 
less difference between actual sales or shipments and the forecast.

• MAPE (Mean Absolute Percentage Error) — Divides MAD by the average. This is a 
relative measure: a lower MAPE indicates a lower percentage difference between 
the actual sales or shipments than the forecast.

• RMSE (Root Mean Squared Error) — Summarizes the overall error and reflects the 
variability in the data. The individual errors are squared, added together, dividing 
by the number of individual errors, and then square rooted. A large RMSE indicates
high fluctuations in differences between actual sales or shipments to corresponding 
forecast data. 

• S.D. (Standard Deviation) — A measure of the variability of a set of numbers 
around their mean. If the numbers cluster tightly around the mean score, the SD is 
smaller than it would be with higher deviations from the mean. For the purposes of 
this report, the standard deviation uses the calculated differences between forecast 
and actual entries as the values in the formula. 

• AV (Average) — The arithmetic average (or the mean) of a set of numbers. This is a 
measure of the central tendency.

• C.V. — The ratio of the standard deviation (S.D) to the average (AV). 
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Aged Accuracy Document 
The Aged Accuracy document quantifies and presents the accuracy of a set of forecasts 
over time.

Each row of the report shows data for a previously submitted version of the forecast, for
example "Forecast Submitted in January 2003," "Forecast Submitted in February 2003," 
and so forth. Each column shows the forecast numbers and the corresponding accuracy 
measures for the given time buckets, for example "February 2003," "March 2003," and so
forth. The system generates the accuracy measures by comparing a measure (for 
example, the actual history) that you specify with the forecasts.

Each cell of the report shows the forecast numbers generated from the corresponding 
forecast version for the time bucket under consideration. Thus, one single column might
have all of the forecast numbers generated for January, 2002, from all of the previous 
monthly forecasts (January 2001 to December 2001). 

If your installation includes the Aged Accuracy document, the document appears 
within the Forecast folder in the Navigation list. 
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Setting up the Aged Accuracy document
To ensure that your Aged Accuracy document displays meaningful data, select the 
measure that represents actuals as the base measure and choose previous submitted 
versions of the forecast as measures to be compared to actuals. Note that the report 
parameters (time buckets, forecast versions, and the base measure) must all work 
together. When you make selections, also consider the availability of forecast versions, 
the granularity of the time buckets, and the availability of information for the base 
measure. 

Aged Accuracy measures and statistics
The Aged Accuracy report view includes the following accuracy measures and 
statistics:

• Min (Minimum) — The minimum (value) of a set of numbers.

• Max — (Maximum) The maximum (value) of a set of numbers.

• MAD (Mean Absolute Deviation) — Reflects the magnitude of the data on which 
the forecast is based. A lower value of MAD indicates that, on the average, there is 
less difference between actual sales or shipments and the forecast.

• AV (Average) — The arithmetic average (or the mean) of a set of numbers. This is a 
measure of the central tendency.

• MAPE (Mean Absolute Percentage Error) — Divides MAD by the average. This is a 
relative measure: a lower MAPE indicates a lower percentage difference between 
the actual sales or shipments than the forecast.

Example: Aged Accuracy (Report view)
For example, if you want to see the Aged Accuracy report for all products in all 
organizations for the year of 2004 and 2005, the report view for an Aged Accuracy 
document displays the accuracy measures and statistics of the booking history and the 
forecast information for all products across the organizations and geographies specified.

Example: Aged Accuracy (Graph view)
The planning engine also displays a graph view of the Aged Accuracy document.
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Other Predefined Reports
In addition to the Comparison Accuracy and Forecast Accuracy documents, you might 
have access to the following predefined reports:

• Comparison documents 

• Percentage Share documents 

• Increasing/Decreasing Demand documents 

• 80/20 Rule documents 

• Growth documents 

• Ranking documents

• Top/Bottom Ranking documents

• Trend documents 

• Moving Average/Total documents 

Comparison documents
Comparison documents compare data for two dimension values for specified time 
periods. The comparison is based on a specified measure. The analysis shows difference
and percentage difference.
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If your installation includes Comparison documents, the documents appear within the 
Comparison folder in the Navigation list.

Percentage Share documents
Percentage Share documents compare data for a dimension value to its aggregate for 
specified time periods. The comparison is based on a specified measure. The analysis 
shows percentage share.

If your installation includes Percentage Share documents, the documents appear within 
the Comparison folder in the Navigation list.

Increasing/Decreasing Demand documents
Increasing/Decreasing Demand documents display dimension values for which 
demand has increased or decreased by a specified percentage between two time 
periods. Demand is based on average values for a specified measure. The analysis 
shows difference and percentage difference.

If your installation includes Increasing/Decreasing Demand documents, the documents 
appear within the Distribution folder in the Navigation list.

80/20 Rule documents
80/20 Rule documents display data for dimension values that show specified percentage
of increased or decreased activity within specified time periods. Activity is based on a 
specified measure. The analysis shows cumulative percentage.

If your installation includes 80/20 Rule documents, the documents appear within the 
Exception folder in the Navigation list.

Growth documents
Growth documents contain data that highlight the difference in a dimension value's 
performance between two time periods. Performance is based on a specified measure. 
The analysis shows amount change and percentage change.

If your installation includes Growth documents, the documents appear within the 
Growth folder in the Navigation list.

Ranking documents
Ranking documents rank dimension values in terms of performance during specified 
time periods. Performance is based on a specified measure. The analysis shows the 
share of total. 

If your installation includes Ranking documents, the documents appear within the 
Ranking folder in the Navigation list.



Using Predefined Reports    16-9

Top/Bottom Ranking documents
Top/Bottom Ranking documents rank a specified number of top or bottom dimension 
values for two time periods in terms of performance. Performance is based on a 
specified measure. The analysis shows difference and percentage difference.

If your installation includes Top/Bottom Ranking documents, the documents appear 
within the Ranking folder in the Navigation list.

Trend documents
Trend documents show performance trends within a specified time range for specified 
dimension values. Performance is based on a specified measure.

If your installation includes Trend documents, the documents appear within the Trend 
folder in the Navigation list.

Moving Average/Total documents
Moving Average/Total documents show totals and moving averages for specified 
dimension values over a series of time periods. The averages and totals are based on a 
specified measure.

If your installation includes Moving Average/Total documents, the documents appear 
within the Ranking folder in the Navigation list.

Opening Predefined Reports
Predefined reports are organized into folders, by document type. The folders appear in 
the Navigation list in the main Documents folder, below any folders that you have 
created to organize your documents. If you did not create any folders, the folders for 
predefined reports appear below individual documents.

To open a predefined report:
1. Access Oracle Demand Planning as a Demand Planner or Demand Plan Manager.

2. In the Navigation list, identify the folder that contains the document that you want 
to open. 

Note: To search for a predefined report click the right mouse button
on the Documents folder in the Navigation list and choose Find 
from the popup menu. Then enter a name or name fragment. 
Alternatively, you can choose the Find button on the Navigation 
toolbar.
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3. Double-click the document object. 

Alternatively, you can click the right mouse button on the object and choose Open 
from the popup menu.

Changing Data in Predefined Reports
The data that is displayed when you open a predefined report is determined by the 
current values in the document's settings. The settings are displayed in a full sentence 
that describes the analysis that will be performed. 

If a specific setting is not relevant to your needs, you can modify it by specifying or 
selecting an alternate value. You can modify settings in two ways: 

• You can change the current settings — You can change one or more settings and 
run the document. Your change applies only while the document is open in the 
workspace. The next time that you open the document, the settings script reverts to 
its previous values. 

• You can permanently modify settings — You can change one or more settings and 
save the new settings. When you alter settings in this way, the new values that you 
choose replace the previous default selections for the settings, and the new defaults 
are used from then on in every predefined report in which the settings appear. 

Note: Defaults are used in every predefined report in which the 
settings appear. Since it is unlikely that the same defaults will be 
appropriate for all predefined documents, you might want to set 
defaults that are appropriate for the documents that you use most 
often, and then expect to make ad hoc changes as needed for other 
documents. 

To change current settings in a predefined report:
1. With the document open in the workspace, click the hypertext link for the setting 

that you want to change. 

Result: Depending on the setting that you chose, the Single Value Selector dialog 
box or a popup menu might appear. 

2. To select a single value, choose it in the Single Value Selector dialog box. 

3. To select multiple values, do one of the following:

• To select a custom set of dimension values, from the popup menu choose 
Custom Selection. This opens the Select Data dialog box, where you can select 
values from a list, choose values that meet specific criteria, and sort your 
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selections. 

• To apply a previously saved selection of dimension values, from the popup 
menu choose the saved selection by name. This option is only available if there 
is at least one saved selection for the dimension. 

To reapply the default settings, from the popup menu, choose Key Dimension 
List, where Dimension is the name of a dimension, such as Product. 

4. To change a numeric value, type a new value.

5. Choose Run to apply the new settings and redisplay the current document based 
on your changes.

Result: The document displays the values that you specified. Your choices persist 
only while the document is open in the workspace. The next time that you run the 
document, the view reverts to the default settings.

To permanently change settings in a predefined report:
1. Change one or more settings as described in "To change current settings in a 

predefined report", page 16-10. 

2. Choose the Save these settings as default for all Predefined documents option.

3. Choose Run to save the settings and redisplay the current document based on your 
changes.

The document displays the values that you specified. Your choices are saved as the 
default in all other predefined reports that includes the same settings.

You can change the value for each underlined element. 

Viewing Data in Predefined Reports
You can view the data in a predefined report as follows: 

• You can change a report view to a graph view. You can also change a graph view to
a report view.

• You can drill through aggregate values to expose component values. 

• You can page through the report to view data for dimensions in the page position.

• You can change the size of columns and rows.
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Changing a report view to a graph view
When you open a predefined report, the default view is report (tabular format). You can
change the report to a graph. You can also change back to a report.

Note: The graph view setting persists only while the document is open 
in the workspace. The next time that you open the document, it is 
displayed as a report.

To change the type of view:
1. With the document open in the workspace, locate the setting under the document 

that reads "Display as view typewhere view type is Report or Graph. 

2. Choose the view type hypertext.

Result: The setting toggles to the alternate view. For example, if you choose Report,
the setting toggles to Graph.

3. Choose Run to apply the setting and redisplay the current document based on the 
change.

Drilling through levels of data in a predefined report
You can view data at various levels by drilling within aggregate dimension values. For 
example, if the document displays a Geography dimension value that includes lower 
level values, you can "drill down" and expand the display to show component 
geographies. You can then "drill up" to collapse the display. 

You can drill a dimension value that is in the row or column position if a drill arrow 
appears to the left of the dimension value name. The arrow shape changes, depending 
on whether you can expand or collapse the value:

• Right pointing arrow — Located beside a value that displays a total while the 
values that contribute to that total are not visible. Clicking this arrow enables you to
drill down, causing the report to display the lower level values. 

• Down pointing arrow — Located beside a value that displays a total while the 
values that contribute to that total are visible beneath it. Clicking this arrow enables 
you to drill up, causing the report to display only the total value. 

Your drill selections persist only while the document is open in the workspace. The next
time that you run the document, the view reverts to the default view. 

Paging through data in a predefined report
Data in a predefined report is displayed one page at a time. You can use the page 
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controls at the top of a document to display a page other that the one that is currently in
view. For example, the current page might show data for Total Product, but you can 
select another product from the list to see its data.

Your selection persists only while the document is open in the workspace. The next 
time that you run the document, the page reverts to the default page. 

Sizing columns and rows in a predefined report
You can change the size of rows and columns in a predefined report so that the 
information is easier to read.

Note: Row and column sizing persists only while the document is open 
in the workspace. The next time that you run the document, the view 
reverts to the default. 

To size columns and rows in a predefined report:
1. With the report view open in the workspace, position the cursor on the border of a 

row or column label. 

2. When the cursor changes to a double arrow, click and move the border.

Printing Predefined Reports
You can print a predefined report and specify settings that determine how the printed 
page will look.

You can also print one or more predefined reports and other documents directly from 
the Navigation list. Note that when you print multiple documents, you do not have the 
same options that are available when you print an open predefined report. For example,
when you print an open predefined report, you can specify the pages to print (all or 
current). When you print multiple documents from the Navigation list, Oracle Demand 
Planning prints all pages of the selected documents.

To print a predefined report:
1. With the document open in the workspace, choose the Print button on the 

Document toolbar. 

2. Result:The Print dialog box for your browser opens.

3. You can change the print defaults for the browser. For example, you can specify 
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new values for printer and number of copies.

4. Choose OK to continue. 

Result: The Print dialog box for Oracle Demand Planning opens. 

5. In the Print box, specify the pages that you want to print. You can choose one of the 
following options: 

• Current Page of Data — Prints the current page of data as indicated by the 
page label.

• All n pages of Data — Prints all pages of data, beginning at the first logical 
page, regardless of the current page settings. 

Note: If you choose to print all pages, the system prints all data 
for all dimension values that are in the page position in the 
document. Depending on the number of dimensions that are in 
status in the page position, printing all pages might result in 
many pages of output. 

6. For a report view, in the Order box, you can specify the order in which to print the 
pages. You can choose one of the following options: 

• Across then down — Prints as many rows and columns as will fit on a physical 
page, then moves across the columns (until all are printed) and then down the 
rows (until all are printed).

• Down then across — Prints as many rows and columns as will fit on a physical 
page, then moves down the rows (until all are printed) and then across the 
columns (until all are printed).

7. In the Scaling box, you can specify how to scale the document. 

For a graph view, you can choose one of the following options:

• Fit to Page — Scales the graph to fit the width and height of the physical 
printed page. If you want to maintain the proportions that are presented on the 
screen, also select Maintain Proportions. 

• Actual Size — Scales the graph to fit the width and height of the physical 
printed page.

For a report view, you can choose one of the following options:

• Adjust to — Scales each logical page of the report by a percentage that you 
select. The output will span the number of physical pages that are necessary to 
meet the specified percentage.
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• Fit to — Scales each logical page to span the width and height of the number of 
pages that you select. 

8. To indicate how you want the printed pages to look, choose Page Setup. This opens
the Page Setup dialog box, where you can perform the following operations:

• Specify optional header text (up to 100 characters) for the printed page.

• Specify an optional footer for the printed page.

• For a report view, specify whether row, column, and page labels will be 
repeated on each printed page.

• For a report view, specify whether a title, subtitle, and footnote will appear on 
the printed pages.

• Specify margin settings for the printed pages.

9. If you want to preview the pages before printing them, choose Preview.

10. Choose OK to print the document. 

To print multiple documents:
1. Access Oracle Demand Planning as a Demand Planner or Demand Plan Manager.

2. For documents that are in a folder, open the folder to display the document. 

3. Scroll to a document, press the CTRL key and simultaneously click the document 
object.

Result:The document is highlighted.

4. Repeat Step 3 for each document that you want to print.

5. After you make your final selection, click the right mouse button and choose Print 
from the popup menu. 

Copying Data from Predefined Reports
You can copy data from contiguous cells in a predefined report to the Windows 
clipboard. You can choose to copy data that has been stripped of special formats such as
thousands separators, currency signs, and percent symbols or you can include these 
elements. You can also copy row and column labels.
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To copy data from a predefined report:
1. With the report view open in the workspace, select the cell or cells that you want to 

copy. 

You can select cells by using row and column selectors. You can also select cells by 
selecting a cell as a starting point, dragging the mouse pointer, and then releasing 
the mouse button at the end of the block. 

Note: You cannot copy cells that are not contiguous.

2. Choose the Copy button on the Document toolbar.

3. Alternatively, you can click the right mouse button and select a copy option from 
the popup menu. 

4. Choose a copy option: 

• Copy — Copies the data but excludes formats such as thousands separators, 
currency signs, and percent symbols.

• Copy Special — Presents a submenu from which you can select one of the 
following:

• Copy Data with Labels — Copies the data but excludes formats such as 
thousands separators, currency signs, and percent symbols. Also copies the 
row and column labels that are associated with the selected data.

• Copy Number Formatted Data — Copies the data and includes formats 
such as thousands separators, currency signs, and percent symbols.

• Copy Number Formatted Data with Labels — Copies the data and 
includes formats such as thousands separators, currency signs, and percent 
symbols. Also copies the labels that are associated with the selected data.

• Copy Row Labels — Copies the row labels that are associated with the 
selected data. Does not copy the actual data.

• Copy Column Labels — Copies the column labels that are associated with 
the selected data. Does not copy the actual data.
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Exporting Data from Predefined Reports
You can export dimension labels and data values from an open predefined report to a 
file format that can be used in a spreadsheet. You can select one of three export format 
options (CSV, TXT, or HTM for Excel 2000+), and export data from all pages or from a 
specific page.

Note: If the document contains many pages of data, you might have 
difficulty opening the file in certain applications. To avoid this 
situation, modify the data selections to reduce the number of values 
before exporting the document.

To export data from a predefined report:
1. With the document open in the workspace, click the Export button on the 

Document toolbar.

2. Result: The Export dialog box opens.

3. In the Export box, choose the pages to include in the export file. You can select one 
of the following options: 

• Current Page — Exports data from the current page as indicated by the page 
label.

• All n Pages — Exports all pages of data, beginning at the first logical page, 
regardless of the current page settings. 

4. In the As Type box, select the format for the export file:

• Comma delimited (*.csv) — Exports the data in Comma Separated Value 
format, in which labels and data values are separated by commas.

• Tab delimited (*.txt) — Exports the data in text file format, in which labels and 
data values are separated by tabs.

• Excel 2000+ (*.htm) — Exports the data in a format that can be read by a 
browser and opened in Excel version 2000 and version 2002, also known as XP. 
For more information, see "About Excel 2000+ output files", page 16-18.

5. In the Options box, you can choose the following options for the export file: 
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• Include Number Formatting — For a CSV or TXT export file, check this option 
to export the data with its current number formatting. Do not check this option 
if you want to export unformatted data. Note that an HTM export always 
includes number formatting.

• Repeat Group Labels — Check this option to repeat the outer labels for 
columns and rows of inner, nested dimensions. Do not check this option if you 
want the export file to display labels as they appear in the screen display. 

• Include Title, Subtitle, Footnote — Check this option if you want to include 
the title, subtitle, and footnote of the document as part of the export file. Do not 
check this option if you do not want to include these elements.

• Create One Sheet per Page — For an multi-page HTM export, check this option
to export the data from each logical page to a separate worksheet. Do not check 
this option if you want to export the data from all pages to a single worksheet.

6. Choose OK to proceed.

Result:If you chose CSV or TXT format, the Save As dialog box opens. If you chose 
HTM format, the Export to HTML/Excel 2000+ dialog box opens. 

7. Proceed as follows:

1. In the Save in box, select the output directory for the export file.

2. In the File name box, enter a name for the export file.

3. Choose OK to export the file.

About Excel 2000+ output files
When you export data to a single worksheet, the system generates a single HTML file in
the directory that you specify. 

When you export a multi-page file in Excel 2000+ and specify that you want to create 
one sheet per page, the system generates an HTML table of contents file plus a number 
of other files in the specified directory. Use the table of contents file to access the 
individual worksheets

Closing Predefined Reports
When you have finished working with a predefined report, you can close it. 

To close a predefined report:
Click the Close button, located in the upper right corner of the document. 
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17
Working with Measures 

This chapter covers the following topics:

• About Measures

• Types of Measures

• Creating Forecast Measures

• Creating Combination Forecast Measures

• Averaging Existing Percentages to Forecasting Levels

• Copying Planning Percentages

• Creating Simple Copy Measures

• Creating Copy Multiple Measures

• Creating Accuracy Measures

• Creating Formula Measures

• Editing Measures

• Renaming Measures

• Viewing Measure Properties

• Deleting Measures

• Importing Data into a Measure from a Flat File

About Measures
A measure is a database object, such as a history or forecast, that stores or calculates data
in Oracle Demand Planning. When you work as a demand planner or planning 
manager, you use measures to analyze, edit, share, and submit or upload data. 

Certain measures are defined in the Demand Planning Server. Additional measures 
might be defined in the shared database and distributed by the Demand Planning 
Administrator. You can view shared measures and use them in data analyses. You can 
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also define new measures, edit measure definitions, and delete measures.

This section describes how to create, modify, and delete measures.

Working with measures as a Demand Plan Manager
If your responsibility is Demand Plan Manager, you work with measures in the shared 
database. You have immediate access to any new measures that you create; planners 
will get access when the Demand Plan Administrator adds the measures to planners' 
assignments and runs a distribution. A full distribution distributes all measures; a quick
distribution distributes selected measures.

Working with measures as a Demand Planner
If your responsibility is Demand Planner, you can work with shared measures that have
been distributed to you. You can also create personal measures, to which only you have 
access. 

Types of Measures
You can define two types of measures: stored measures and formula measures. 

Stored measures
Astored measure is avariable for which calculations and properties are permanently 
stored in the database. Define a stored measure when you want to use Oracle Demand 
Planning to generate a statistical forecast, copy data from on or more measures, or 
create an estimate of statistical accuracy. You can also define a stored measure when 
you want to create a permanent variable that differs in some aspect from an existing 
measure. 

Methods for defining stored measures
You can use the following methods to define a stored measure:

• Create a forecast — Calculates a measure that forecasts data based on values in 
another measure. You might use this method to create a forecast measure based on 
Booking History. For more information, see "Creating Forecast Measures", page 17-
5.

• Create a Combination Forecast — Calculates a measure that uses different forecast 
methods for different products, and allows the demand for some products to be 
forecast statistically while the demand for other products are based on values 
copied from other measures. For more information, see "Creating Combination 
Forecast Measures", page 17-21.
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• Copy measure — Calculates a measure that is a copy of another measure. You 
might use this method to create a measure that copies all data from a measure and 
applies an event factor. Or you might create a measure that copies data from a 
measure and shifts the data backward or forward in time. For more information, see
"Creating Simple Copy Measures", page 17-35.

• Copy multiple measures  — Calculates a measure that copies selected subsets of 
data in specified dimensions at specified levels from one or more measures. For 
example, you might use this method to create a measure that copies data at the 
month level from the Sales Opportunity Forecast for January through June of a 
given year and from the Forecast of Booking History for July through December of 
the same year. For more information, see "Creating Complex Copy Measures", page
17-44.

• Create an accuracy measure — Calculates a measure that estimates the statistical 
accuracy of one measure when compared to another measure at specified levels for 
a specified time period. You can use this method to create an accuracy estimate to 
submit with a forecast. Oracle Inventory Optimization (IO) uses the forecast and its 
accuracy measure to calculate safety stocks. You might also use this method to 
statistically quantify the accuracy of any two measures. For more information, see 
"Creating Accuracy Measures", page 17-54.

Formula measures
A formula measure calculates values on the fly. You can base a formula measure on a 
stored measure or on another formula measure. A formula measure is not stored in the 
database, has no unit of measure association, and its values are never editable in 
worksheets. Because formula measures are calculated when accessed, there is no stored 
value to lock. Locks can only be applied to stored measures.

Formula measures do not impact storage or system performance. Define a formula 
measure when you want to change the value of a measure by applying a simple 
mathematical formula. For example, you might define a formula measure that lifts a 
stored measure by 5%. For more information, see "Creating Formula Measures", page 
17-57.

Important: Consider storage space when selecting measure type
To enhance system performance and conserve storage space, Oracle recommends that 
you limit the number of stored measures that you define.

It is possible to use a single stored measure as the basis for multiple formula measures. 
For example, consider a situation in which you want to view a standard forecast and an 
optimistic forecast. Rather than create two stored forecast measures, you can create a 
single forecast measure and use it as the basis for a formula measure defined as the 
stored forecast lifted by a specified percentage. 
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The Measures Folder
Demand Planning has a Measures folder underneath which there are preseeded folders 
to help you organize the measures in your demand plan. These folders ensure that 
measures can be found and identified easily. 

Oracle Demand Planning automatically assigns forecast, accuracy, and history 
measures to folders of their respective types. Any forecast or accuracy measure created 
by an administrator or distributed to a planner is assigned to the appropriate folder on 
startup.

In addition, if a planning manager or a planner creates a forecast or accuracy measure, 
the measure will immediately be assigned to the proper folder.

Measures that are not forecast, accuracy, or history measures remain under the main 
Measures folder. 

In the Navigation List display, the Measures folder appears underneath the folders for 
your documents. The preseeded folders then appear in the order Accuracy, Forecast, 
History.

If you create a measure of another type, such as a Copy or Copy Multiple measure, the 
default location for the icon and description for that measure is beneath the History 
folder. You can assign new measures, of course, to folders that you create.

Formula measures appear as individual measures under the Measures folder, unless you
assign them to specific folders.

The following important facts regarding the Measures folder and its dependent folders 
should be observed:

• The root Measures folder cannot be deleted.

• By default, planner measure folders are maintained, but the measures themselves 
are cleaned out during data download. The default folders are recreated if the 
database is rebuilt.

• A demand planner can delete one or more measure folders, although a dialog will 
appear displaying information that measures stored in the folders will be deleted.

• When a measure folder is deleted, the folder and all of its contents are removed. 
However, you cannot delete a folder when an open worksheet has unsaved data, 
unless the folder is already empty. This holds true for both regular and planning 
percentage worksheets.

Follow the procedure below to create a new folder in which to store measures.

1. On the Navigation toolbar, choose the New button. 

2. From the popup menu, choose New Folder.
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Demand Planning displays a submenu with the commands New Document Folder 
and New Measure Folder.

3. Select New Measure Folder.

4. Enter a folder name, and close the dialog box.

Creating Forecast Measures
Creating a forecast measure calculates a stored measure that is a statistical forecast 
based on data in another measure. For example, you might use this method to generate 
a forecast based on Booking History.

To create a forecast:
1. Access Oracle Demand Planning as a demand planner or planning manager.

2. On the Navigation toolbar, choose the New button. 

3. Choose New Measure from the popup menu. 

Alternatively, you can click the right mouse button on the Measures folder in the 
Navigation List. Then choose New Measure from the popup menu. 

4. In the Create Measure dialog box, choose Stored Measure.

If you see the Measure Wizard —  Introduction page, choose Next to continue. To 
suppress the display of this page in the future, clear the Show this page next time 
box before you continue. 

Result: The Measure Wizard —  Choose Method page opens.

5. Complete the Measure Wizard —  Choose Method page.

1. In the Name box, enter a name for the measure, up to 70 characters long.

2. In the Method box, choose Create Forecast. 

3. Choose Next to continue. 

Result: The Measure Wizard — Create Forecast page opens.

6. Complete the Measure Wizard —Create Forecast page. 

1. In the What measure to you want to base your forecast on? box, choose the 
measure that you want to use as the basis for the forecast. Oracle recommends 
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that you choose a true history measure such as Booking History or Shipment 
History.

2. The Dimension/Level grid displays the levels at which Oracle Demand 
Planning will generate the forecast for each dimension in your database.

To change a level setting, click the Level column for the dimension, and select 
the level that you want to use. The dimension levels that you choose should 
relate to your individual business needs and processes.

Be careful not to set levels too low, or the variations in the data might be large, 
causing decreased accuracy. Inaccuracies might be magnified at aggregate 
levels. If you set levels too high, the aggregated forecasts might pick up 
localized trends and allocate them wrongly. 

The default level setting for a dimension is the highest level for the dimension.

You can forecast at the day level for all forecast methods except Holt-Winters, 
which you can forecast at the week level. To use the Holt-Winters forecast 
method you must have at least 52 weeks of data.

Note: If you are generating a weekly forecast and want to use 
the Holt-Winters forecast method, you must specify a 
minimum of 52 weeks of historical data. Otherwise, the 
Holt-Winters forecast method is unavailable. 

3. Choose the time period on which to base the forecast.

In the From box, select the earliest time period in the time range.

The defaults for From and To are based on the values for Horizon Start Date 
and the Horizon End Date defined for the scenario in the Demand Planning 
Server, projected back by the number of periods at the level that you chose for 
forecasting the Time dimension. If the demand plan definition includes more 
than one scenario, then the default is based on the horizon for the first scenario. 

4. Choose the time period for the forecast. This is the output time period for the 
forecasted data. 

In the From box, select the earliest time period to forecast.

In the To box, select the latest time period to forecast.

The defaults for From and To are based on the values for Horizon Start Date 
and the Horizon End Date defined for the scenario in the Demand Planning 
Server.

5. Choose Next to continue.

Result:The Measure Wizard —Select Forecast Method page opens. 
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7. On the Measure Wizard — Select Forecast Method page, choose a forecast method. 

Automatic is the default method for a new measure. For more information about 
this and other forecasting methods, see "Forecast Methods", page A-1. 

After you choose a method, choose Next to continue.

Result: The Measure Wizard —Set Forecast Parameters page opens. 

8. On the Measure Wizard —Set Forecast Parameters page, you can set statistical 
parameters for the forecast method you have chosen.

If you want to view or fine-tune the available statistical parameters for your forecast
method, choose Advanced. This opens the Advanced Parameters dialog box, where 
you can view the current settings and modify values. 

1. For an exponential smoothing forecast method, you can use the slider to 
indicate how you want to weight recent changes in alpha (for the Single 
Exponential Smoothing, Double Exponential Smoothing, and Holt-Winters 
methods), beta (for the Double Exponential Smoothing and Holt-Winters 
methods), and gamma (for the Holt-Winters method). 

2. Choose OK to save your settings and return to the Measure Wizard —Set 
Forecast Parameters page. 

Note: Setting forecast parameters is optional. For the Automatic
method, the forecasting engine selects the optimal parameters 
when it runs the forecast. For all other methods, the engine 
uses default parameters. 

For information about advanced statistical forecast parameters, see "Advanced 
Statistical Parameters", page A-2.

3. Choose Next to continue.

Result: The Measure Wizard — Set Forecast Accuracy Info page opens. 

9. You can use the Set Forecast Accuracy Info page to create one or more statistical 
accuracy measures for the forecast. You can also specify that the system save 
forecast information in text measures. 

1. You can select one or more accuracy measures:

• Mean Absolute Deviation (MAD) — Calculates the mean absolute 
deviation of forecasted values from the measure on which the forecast is 
based. 

• Mean Absolute Percentage Error (MAPE) — Divides MAD by the average.
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• Root Mean Squared Error (RMSE) — Summarizes the overall error of the 
forecast and reflects the variability in the data. The individual errors are 
squared, added together, divided by the number of individual errors, and 
then square rooted. 

2. You can select one or both of the following informational text measures:

• Forecast Methods — Describes the forecast method. 

• Forecast Parameters — Describes the forecast parameters.

3. Check the Backcasted Data box to create a backcast, which will be displayed as 
a graph, opened automatically, when the forecast is run. A backcast will give 
you an idea of how closely the forecast matches the last portion of historical 
data. Backcasting is described in the section Backcast Data, page 17-16.

4. Check the Smoothed History box to generate smoothed history at the specified 
forecasting levels and for all periods in the history. If you configure your 
forecast to include smoothed history, Demand Planning creates a forecast called
[Forecast Name], Smoothed History, which you can view in reports and 
worksheets. 

5. Check the Seasonal Factors box to generate seasonal factors at the specified 
forecasting levels and for all periods in the history. If you configure your 
forecast to include seasonal factors, Demand Planning creates a forecast called 
[Forecast Name], Seasonal Factors, which you can view in reports and 
worksheets. 

6. Choose Next to continue.

Result: The Measure Wizard — Allocation page opens.

10. Use the Measure Wizard — Allocation page to select the forecast allocation method 
and the method that will be used to allocate new data. 

1. In the topmost box, choose the algorithm that will be used to allocate data 
down to lower levels from the level at which the data is forecasted. Choose one 
of the following forecast allocation methods:

• Allocate based on forecasted weights aggregated from the lowest level — 
The system uses the lowest allocation levels specified in the Demand 
Planning Server for the data stream on which the measure is based to 
allocate the results generated at the forecast levels that you chose earlier. 
Forecasts for intermediate levels (between specified and lowest available) 
are obtained by rolling up the results of the nodes after allocation. This 
method is the fastest and is the default for a new measure.
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If you are generating a forecast at the weekly (or higher) level, but need to 
allocate to the day level, the specified forecast method is not always 
appropriate for forecasting at day level. This is due to the erratic nature of 
lowest-level data, and may result in the forecast method picking unwanted 
trends.

In this case, Demand Planning uses the automatic best-fit forecast method 
instead of the specified forecast method. Demand Planning chooses the best
forecast method with which to allocate your data to the day level.

• Allocate based on a forecast at each level — The system starts at the 
forecast levels that you chose earlier for each hierarchy, goes down one 
level at a time, and uses the results of the forecast on the level below to 
allocate the results on the level above. This process continues until the 
lowest available level is reached. Forecasts for levels above the specified 
level are achieved through rollup. This method is often the most accurate, 
but might involve substantial processing time.

• Allocate based on historical weights for the last n periods — In this case n
is an integer and period is the time level for the forecast. The system uses 
the number of historical time periods that you specified to determine 
weights for allocating data to the lower aggregate levels along each 
dimension. If there is no data for the specified periods, then the system uses
the whole history. Forecasts at higher levels are achieved through rollup. 
This method does not adequately account for trends. 

• Allocate based on new data allocation settings specified below — The 
system uses the method for allocating new data that you subsequently 
choose to determine weights for allocating data to lower aggregate levels 
along each dimension. Any overrides that you specify will also apply. This 
method is useful when you are creating a measure that does not have 
adequate data at lower levels or when you want to allocate based on the 
data pattern in some other data stream. Note that this method can impact 
system performance. Also, if the forecast and history data do not match, the
system will default to even allocation.

2. If you chose Allocate based on forecasted weights aggregated from the lowest
level, Allocate based on a forecast at each level, or Allocate based on 
historical weights for the last n periods, the Override Time allocation using 
box is active. To allocate data based on the time allocation weights in another 
measure, choose the Override Time allocation using and select the measure 
that you want to use. This option is useful when you want to retain the 
historical weights for all dimensions except Time in order to allocate forecasts 
based on the workday patterns of several organizations. The weights in the 
Time dimension of the selected data stream will be used to allocate the forecast 
numbers. 
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Note: The selected data stream should have at least one other 
dimension in addition to the Time dimension.

3. In the Method box, choose the allocation method that will be used when new 
data is added to the measure. This allocation method applies when data for the 
measure is edited in worksheets. For example, if you edit an NA value at the All
Products level in a worksheet, Oracle Demand Planning uses the allocation 
method to determine how the value will be allocated down to the Item level.

You can select one of the following allocation methods:

• Weights in Another Measure — Allocates values based on ratios in another
measure. In the Base Measure box, select the measure on which to base the 
weighting. This is the default for a new measure.

• Avg Weight Based on History— Allocates values based on data in another 
measure for a specified number of time periods. In the Base Measure box, 
select the measure on which to base the weighting. In the Period box, enter 
the number of time periods to average. 

• None — Does not allocate values below the current level.

• Even Allocation— Allocates values evenly. Note that this method can have 
a negative impact on database size and performance. 

Note: Oracle recommends that unless you have a specific 
reason for selecting an alternate method, you should use 
Weights in Another Measure (the default for a new 
measure) or Avg Weight Based on History. 

If data exists at the lowest available level within the 
measure, then the allocation weights will be calculated 
using that data. If data does not exist at the lowest available
level, then the specified allocation will be used if valid 
non-NA allocation rules can be determined. If data does 
not exist at the lowest available level and the specified 
allocation method does not provide valid allocation rules 
(for example, there is no data in the base allocation 
measure), then even allocation will be used. 

4. You can choose a different allocation method for one or more dimensions of the
measure.

Note: Oracle recommends that you apply the same allocation 
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method to all dimensions of the measure. Although you 
technically have the ability to set different allocation methods 
for dimensions, doing so can have a negative impact on system 
performance.

• In the Dimension list, identify a dimension for which you want to change 
the default allocation method. In this case, the word "Default" refers to the 
allocation method that you chose earlier in this procedure.

• In the Method box, choose the method that you want to use to allocate data
for this dimension. If the method requires a base measure, select it in the 
Base Measure box. If the method requires a number of time periods, enter 
this in the Periods box.

• To override the default for another dimension, repeat the previous steps.

5. Choose Next to continue.

Result:The Measure Wizard — Aggregation page opens. 

11. Use the Measure Wizard — Aggregation page to specify how to roll data up through
parent values when data for the measure is edited in worksheets. For example, if 
you edit a value at the Item level, Oracle Demand Planning will use the aggregation
method to determine how the value will be aggregated up to the All Products level. 

1. Choose one of the following aggregation options in the Method box:

• Additive — Adds values. This is the default for a new measure.

• Average — Averages values.

• Minimum — Takes the minimum value at each child level. You might use 
this in a special case such as a population type measure.

• Maximum — Takes the maximum value at each child level. You might use 
this in a special case, such as if you were aggregating population over time.

• First — Takes the first value at each level. Recommended only for the Time 
dimension.

• Last — Takes the last value at each level. Recommended only for the Time 
dimension.

• Weighted Average — Averages values weighted by a specified measure. In
the Based on box, select the measure on which to base the weighting.
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2. You can choose a different aggregation method for one or more dimensions.

Note: Oracle recommends that you generally apply the same 
aggregation method to all dimensions of the measure. 
Although you technically have the ability to set different 
aggregation methods for dimensions, doing so can have a 
negative impact on system performance.

• In the Dimension list, identify a dimension for which you want to change 
the default aggregation method. (Default ) refers to the aggregation method 
that you chose earlier in this procedure.)

• In the Method box, choose the method that you want to use to aggregate 
data for this dimension. 

• To override the default for another dimension, repeat the previous steps.

3. Choose Next to continue.

Result:The Measure Wizard — Properties page opens. 

12. On the Measure Wizard — Properties page, you can associate one or more properties
with the measure. 

1. To enable editing for the measure's data in worksheets, check the Make the 
measure editable in worksheets box. If you will be associating a planning 
percentage with the measure, selecting this option also makes the associated 
planning percentages and dependent demand measures editable in the 
Planning Percentages worksheet.

2. To convert quantities to the base unit of measure for the plan when data is 
aggregated from the lowest available level of the Product dimension, check the 
Apply Unit of Measure (UOM) when aggregating data box. See 

For information about this parameter, see "Measure Property: Unit of Measure 
Association", page A-5

3. Check the Apply persistent locks and adjustments from box to apply locks 
from another measure. Demand Planning uses cycle-persistent locking to carry 
data adjustments, locks, and comments in a measure from one cycle to another. 
Locking features are discussed in "Preserving Forecast Adjustments.", page 12-1
There are two radio buttons below the checkbox. One -- Previous cycle for the 
scenario -- enables you to select a particular cycle for the scenario. The other -- 
Selected measure -- enables you to select a particular measure.

4. Check the Overwrite existing data in the target measure box if you want the 



Working with Measures     17-13

data in the measure from which locks and adjustments are being copied to 
overwrite cells in the target measure to which locks have been applied.

5. Choose Next to continue.

The Extended Analysis step box is displayed.

13. On the Measure Wizard —  Extended Analysis page, you can create dependent 
demand and revenue measures for a new measure, or you can revise them for an 
existing measure. This step displays components for dependent demand in the 
form's upper half and components for price lists in the lower half. Some dialog box 
components may not be displayed if certain elements, such as dependent demand, 
are missing from the data stream on which the measures is based.

If dependent demand does not exist or cannot be used for the plan and if price lists 
do not exist for the plan, the Extended Analysis tab will not appear.

1. The Show Dependent Demand Relationship box appears if dependent 
demand has been enabled in the Demand Planning Server and model bills of 
material have been brought into Demand Planning. In addition, the lowest 
allocation level for the product and time dimensions must have been set to the 
leaf level.

Check this box to calculate measures for dependent demand and planning 
percentages. Clear this box if you do not want to create planning percentages 
and measures for dependent demand.

2. If you opt to create planning percentages, choose a planning percentage option. 
The Use Object or Measure option enables you to select an existing planning 
percentage object or a history measure (booking, shipping, etc.) from your plan.

3. The Copy Selected Planning Percentage box is enabled if the Use Object or 
Measureoption is selected. It enables you to copy the planning percentage object 
selected in the  Use Object or Measurecheckbox..

4. The Average the copied planning percentages to level box is dependent on the
Copy Selected Planning Percentage box. When the Average checkbox is 
checked, the created planning percentage is averaged at the level of time 
specified by the selected item in the drop-down list. When the measure type is 
Forecast, it's possible to set the default level at which to average to be the 
forecast level; for other measure types, no default will be set.

5. When your demand plan includes data streams which the history includes 
dependent history, the Measure Wizard displays two radio buttons above the 
New Planning percentage Name box. Create Planning Percentage based on 
forecasted dependent history is available when the basis for the forecast is a 
stream such as Booking History. The default name of the planning percentage is
MeasureName, Planning Percentage, Forecast.
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6. Create Planning Percentage based on historical weights for the last n periods
calculates planning percentages based on dependent history for the base 
measure for the number of previous periods that you specify.

7. If you create a new planning percentage with the name of an existing planning 
percentage, the result will be a repopulation of the existing planning percentage
using the selected planning percentage options. You can accomplish this by 
selecting the name from the Use Object list box, or entering it in the New 
Planning Percentage Name box. If you do chose the name of an existing 
planning percentage, you see receive a warning when you choose Next or 
Finish in the measure wizard.

8. You can use the Calculate volumes and amounts using a price list box if a 
price list is associated with your demand plan in the Demand Planning Server. 
When you check this box, you create a Quantity measure and an Amount 
measure based on a price list. If a price list has been brought down from the 
Demand Planning Server, you can associate a price list with the new measure. 
(This indicates that you want to create the associated Quantity and Amount 
measures.)

9. The Price List box is enabled if you check the Calculate volumes and amounts 
box in the dialog box. You can select a price list from the drop-down list of 
those that are available. The price list will also be used during allocation 
calculations and during editing of NA cells (or any cell where the price is 
required but not otherwise available).

10. Choose the Calculate amounts for independent demands only option button 
to just calculate totals for independent variables.

11. Choose the Calculate amounts for both dependent and independent demands
option button to create the two new variables, dependent amount and total 
amount.

12. Choose the Next button to accept the selections you have made in this step and 
proceed to the next step.

Result: The Measure Wizard displays the Events page.

14. On the Measure Wizard — Events page, you can choose one or more events and 
event groups to apply to the measure. Events are factors such as promotions, 
product introductions, and product phase outs that are expected to have a 
quantifiable impact on demand. 

1. Select events as follows:

• To add a single event or group, double-click its name in the left box
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or

• Highlight it and choose the single arrow button that points to the right box.

• To add multiple nonsequential events or event groups, press and hold the 
CTRL key, select each event or event group that you want to add, and then 
choose the single arrow button that points to the right box.

• To add multiple sequential events and event groups, select the first event or
group that you want to add, press and hold the SHIFT key, select the event 
or group that you want to add, and then choose the single arrow button 
that points to the right box. You can also select the events to add by clicking
and dragging the mouse. 

• To add all events, choose the double arrow button that points to the right 
box.

2. Choose Next to continue.

Result: The Measure Wizard —Number Formatting page opens.

15. On the Measure Wizard — Number Formatting page, you can specify how data for 
the measure will be displayed in documents. 

Note: The default formats reflect settings established for the plan in
the Demand Planning Server. Your changes will not impact how 
the data is written back to the Demand Planning Server.

If you associated a price list with the current measure, then you can choose formats 
for both Quantity and Amount. If no price list has been associated with the 
measure, then you can only choose the formats that are related to the base measure: 
if the forecast is based on a quantity measure, you can choose formats for Quantity; 
if the forecast is based on an amount measure, then you can choose formats for 
Amount. 

1. You can set the following format options:

• Decimal Digits — Specifies the number of decimal places to display. You 
can choose an alternate number.

• Positive Values — Specifies the format for positive numbers. You can 
choose an alternate format.

• Negative Values — Specifies the format for negative numbers. You can 
choose an alternate format.
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• Use Thousands Separator — Indicates whether to display the thousands 
separator. Check the box to display the thousands separator. Clear the box 
to suppress the thousands separator.

• Display Leading Zero — Indicates whether to display leading zeros. Check
the box to display leading zeros. Clear the box to suppress leading zeros.

As you make formatting choices, the Samples area displays their effect.

2. The Rounding Rule checkbox is the last component in the Number Formatting 
step of the Measure Wizard for three of the four types of measures. The text 
label says Cumulate fractional quantities within product level. There is a 
drop-down list box from which you can select a level in the product dimension. 
When you check this box, Oracle Demand Planning will round the forecast 
numbers by intelligently cumulating the fractional quantities across forecast 
time periods such that the total demand remains unchanged.

3. When your format choices are complete, choose Next to continue.

Result: The Measure Wizard — -- Summary page opens, showing the choices 
that you have made.

16. Choose Finish to save the measure.

Backcast Data
Demand Planning creates a backcast by using the forecast method already selected in 
the Measure Wizard to forecast data from the first part of the history range into the last 
part of the history range.

The history ranges used are specified by the demand planner or planning manager. 
History ranges are chosen in the Set Forecast Parameters step of the Measure Wizard, 
from which you access the Advanced Parameters dialog box.

The backcast calculates the differences between the backcast data and the history, 
summarized over time. Backcast data can be viewed and stored for forecast measures. 
The backcast data, however, is non-editable, and is not allocated or aggregated.

An advanced option enables you to request that the historical data be smoothed 
internally, before calculating forecast numbers, replacing outlying values with more 
normalized ones.

By calculating the difference between the backcast data and the history, you can 
determine the accuracy of the original forecast.

The backcast shows how well the forecast model fits the history data. It validates the 
selection of the forecast method that has been made either by Oracle Demand Planning 
(through the Automatic forecast method) or by the demand planner.
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Features of the Backcast Graph
The graph of the backcast data is a preformatted graph that is displayed automatically 
after the forecast is calculated. The multi-line graph displays the forecast, history, and 
backcast variables (quantity measures), with time along the X-axis and with all other 
dimensions in the page position.

The graph's dimension selections, for all dimensions, are at the forecast level. The time 
dimension is limited to the beginning of the history range through the end of the 
forecast. 

The backcast graph is displayed even if other documents are open. You can save it or 
discard it.

Function of the Backcast Graph
When you select a combination of levels at which to forecast (for example, product 
family/customer), Oracle Demand Planning generates a time-series forecast for each 
level value combination. 

At the end of the forecasting process, when Oracle Demand Planning displays the 
backcast graph, it selects the specific forecast for the level value combinations that is 
most accurate with respect to the history in the verification window. The history, 
forecast, and backcast for that level value combination is also displayed. 

When the most accurate forecast is selected, the standard for the accuracy is based on an
accuracy metric. The accuracy metric could be any or a combination of the following: 
root mean square error (RMSE), mean absolute deviation (MAD), or mean absolute 
percentage error (MAPE).

You select accuracy metrics in the course of creating the forecast. If you select more than
one accuracy metric to display along with the forecast, then the accuracy measures are 
considered in the order RMSE, MAD, and MAPE. If you don't select any accuracy 
measure to display along with the forecast, then RMSE is used as the default.

Setting Up a Backcast
Follow the steps below to setup your backcast.

1. Use the Measure Wizard to create a forecast or edit an existing forecast. You could, 
for example, use 36 months of history, selecting January 02 to December 04 as the 
forecast range. This is done in the Create Forecast step.

2. When you get to step 4 of the Wizard, Set Forecast Parameters, choose the Advanced 
button. The Advanced Parameters dialog box is displayed.

3. Set your verification window in the Verification Window Size box of the Advanced 
Parameters dialog box. 

The verification window size, for all forecasting methods, provides a ratio that 
specifies the portion of the data used in the verification phase. This ratio is used to 
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calculate forecast accuracy statistics (MAD, MAPE, and RMSE).

The ratio is set, by default, at 1/3 of the history periods. That default would be 
appropriate for this example, since it covers a year of history.

4. Window size can be reset, as described below:

Increasing the window size means that the forecasting engine will use a larger 
portion of the most recent historical data.

Decreasing the window size means that it will use a smaller portion of the data. The
minimum value is1/26; the maximum value is 1/3.

5. Close the Advanced Parameters dialog and continue working with the wizard.

The backcast is calculated by using the time range January 02 to December 03 and 
forecasting into January 04 to December 04.

6. Make sure that the box for Backcasted Data is checked in the Set Forecast Accuracy 
Info step of the Measure Wizard.

7. In this case the accuracy statistics are calculated by calculating the accuracy 
between History (January 02 - December 03) and Backcast (January 04 – December 
04.)

Oracle Demand Planning creates the backcast quantity variables and produces a 
preformatted graph of the backcasted data when the forecast is run.

Smoothed History
You can configure the Oracle Demand Planning forecasting engine to automatically 
output smoothed history at the specified forecasting levels and for all periods in the 
history. This option is available when the Smoothed History option is enabled.

If you configure your forecast to include smoothed history, Demand Planning creates a 
measure called [Forecast Name], Smoothed History. You can view this measure at the 
forecasting level in reports and worksheets.

Setting Up Smoothed History
To include smoothed history in the forecast, check the Smoothed History box in the Set 
Forecast Accuracy Info step of the Measure Wizard.

Seasonal Factors
You can configure the Oracle Demand Planning forecasting engine to automatically 
output seasonal factors at the specified forecasting levels and for all periods in the 
history. This option is available when you select the seasonal data filter in the Advanced
Parameters window, or when you use the Automatic or Holt-Winters forecast methods. 
In both cases, the Seasonal factors checkbox must be checked on the Forecast Accuracy 
Info tab of the Measure Wizard. The measure created is [Forecast Name], Seasonal 
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Factors.

If the history has been smoothed, Demand Planning outputs smoothed seasonal factors.

If you configure your forecast to include seasonal factors, Demand Planning creates a 
measure called [Forecast Name], Seasonal Factors. You can view this measure at the 
forecasting level in reports and worksheets.

Setting Up Seasonal Factors
Follow the steps below to include seasonal factors in the forecast.

1. Make sure that the Seasonal Filters option is selected in the Data drop-down list 
box in the Set Forecast Parameters step of the Measure Wizard.

1. Make sure that the Seasonal Filters box is checked in the Set Forecast Accuracy Info 
step of the Measure Wizard.

Rounding Fractional Quantities
When fractional quantities are forecast, and data is then allocated to lower hierarchical 
levels, the result is often fractional forecast numbers. Since the products cannot be sold 
in fractions, the fractional part of the demand needs to be rounded.

There is a Rounding Rule box on the Number Formatting tab of the Measure Wizard 
which enables you to turn intelligent rounding on or off for a particular measure.

How Measures are Affected by Rounding
Demand Planning rounds fractional quantities by cumulating fractions within a 
specified product level. It rounds figures up or down: 2.4 becomes 2, for example, and 
2.6 becomes 3. Adjustments are made within the specified product level.

When the rounding rule is in effect, the numbers are rounded at any level higher than 
the allocation floor, and then aggregated up the Demand Planning hierarchies.

Note: Data loaded at the lowest level is not rounded.

After the rounding process, if a number is modified in the worksheet, the changes are 
allocated down, rounded again (at the allocation floor level) within the levels at which 
the data was modified, and then aggregated up.

To see whether intelligent rounding has been turned on for a particular measure and, if 
so, to see what that rule is, you can select the measure in the Navigation List and use the
right-click menu to view the Properties dialog box for the measure. The Intelligent 
Rounding label is at the bottom of the Properties box. If a rounding rule has been 
enabled, the label will have a product level displayed to its right; if there is no rounding
rule, the label will read None.

To specify intelligent rounding for a measure:
Follow these steps to turn intelligent rounding on or off for a particular measure. When 



17-20    Oracle Demand Planning Implementation and User's Guide

it is turned on, Oracle Demand Planning will round fractional quantities for that 
measure.

1. Create a new measure or edit an existing measure, using the Measure Wizard.

2. When you get to the Number Formatting tab, there will be several columns of format 
settings in the Quantity Format frame. In the Rounding Rule frame, check the box 
labeled Cumulate fractional quantities within product dimension level.

3. Select a level from the drop-down list to the right of the checkbox. You select from 
the levels in the hierarchy that exists in the Product dimension of your plan.

It is recommended to round fractional quantities at the product family level. The 
Rounding Rule checkbox is enabled for all types of measures with the exception of 
forecast accuracy measures.

Measure Recalculation : Using the Measure Wizard Summary Page
The Summary step of the Measure Wizard enables you to see a summary of the steps 
with which you created or edited your measure.

You can review the properties that you have assigned to the measure. If you have 
created a forecast, for example, the summary will tell you the forecast method chosen, 
whether backcasting is enabled, allocation and aggregation methods, whether the 
measure is editable, and other important information. 

The Summary step has a checkbox at the bottom of the screen, labelled Recalculate this 
Measure Now, which enables you to force a recalculation when you are editing a stored
measure. There is more information about this feature in the topic that follows this one. 

When the Recalculate this Measure Now box is checked , the message Your Measure 
will be recalculated when you click Finish will be displayed on the Summary page.

Forcing a Measure Recalculation
There are a number of situations when a demand planner may need to force a 
recalculation of a measure. For example:

• A change in booking history would require its related forecast to be recalculated.

• A change to an event would influence the measure with which that event is 
associated.

• A change to a measure that has been copied needs to be reflected in the target 
measure.

When a planner is working with a worksheet, there is a Recalculate button on the 
document toolbar. Choosing this button with a worksheet open forces a recalculation of 
all measures in the worksheet that have unsaved changes.
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There are two other methods of forcing a recalculation that don't require you to have a 
document open.

• You can select the measure in the Navigation List and select Recalculate from the 
right-click popup menu.

• You can select the Recalculate this Measure Now checkbox on the Measure Wizard
— Summary Page. Checking this box enables you to force a recalculation without 
making a critical change to the measure.

Creating Combination Forecast Measures
Creating a combination forecast calculates a measure that uses different forecast 
methods for different products, and allows the demand for some products to be forecast
statistically while the demand for other products are based on values copied from other 
measures. For example, you might use this method to handle products with demands of
different types, such as intermittent demand for some and seasonal trends for others.

When you create a combination forecast, forecast levels, accuracy measures, allocation 
and aggregation rules, properties, events, pricing considerations and dependant 
demand are designated once by the user and remain constant for all dimension values. 
Only the forecast method and parameters, history, and horizon time ranges vary by 
saved product groups. 

To create a Combination Forecast Measure:
1. Access Oracle Demand Planning as a demand planner or planning manager.

2. On the Navigation toolbar, choose the New button. 

3. Choose New Measure from the popup menu. 

Alternatively, you can click the right mouse button on the Measures folder in the 
Navigation List. Then choose New Measure from the popup menu. 

4. In the Create Measure dialog box, choose Stored Measure.

If you see the Measure Wizard —  Introduction page, choose Next to continue. To 
suppress the display of this page in the future, clear the Show this page next time 
box before you continue. 

Result: The Measure Wizard —  Choose Method page opens.

5. Complete the Measure Wizard —  Choose Method  page.

1. In the Name box, enter a name for the measure, up to 70 characters long.

2. In the Method box, choose Combination Forecast Measure.
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3. Choose Next to continue.

Result: The Measure Wizard — Create Combination Forecast page opens.

6. Complete the Measure Wizard —  Create Combination Forecast page.

1. In the What levels do you want to forecast or copy for each dimension? box, 
the Dimension/Level grid displays the levels at which Oracle Demand Planning
will generate the forecast for each dimension in your database.

To change a level setting, click the Level column for the dimension, and select 
the level that you want to use. The dimension levels that you choose should 
relate to your individual business needs and processes.

Be careful not to set levels too low, or the variations in the data might be large, 
causing decreased accuracy. Inaccuracies might be magnified at aggregate 
levels. If you set levels too high, the aggregated forecasts might pick up 
localized trends and allocate them wrongly.

Note: It is recommended that the product members of the 
Saved Selections be at the same level as the forecast dimension 
level for the product dimension. 

The default level setting for the product dimension is the item level. The default
level setting for all other dimensions is the highest level for the dimension. 
Forecast dimension levels cannot be lower than the lowest allocation floor of 
the base measures

2. For each product that you want to forecast, add a saved selection group and 
select the desired forecast parameters. Items that are not included in any saved 
selection group will not be forecast.

The actions are performed for the product saved selections in the order in 
which they appear. When the action is forecast, the source start and end date 
specify the history range. When the action is copy, the source start date 
specifies the date from which to start copying.

Calculations are performed in the order in which they are entered in the table.

1. Choose Add to add an action to the forecast.

Result: A default action appears. If you click a field for that action, a list of 
available options is displayed. 

2. In the Action column, choose either copy or forecast.

3. In the Product Selection column, choose the product group for which the 
action applies.
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4. In the Source Measure column, choose the measure that you want to use as
the basis for the forecast.

5. In the Source Start Date and Source End Date columns, choose the time 
period on which you want to base your forecast.

6. In the Target Start Date and Target End Date columns, choose the time 
period that you want to forecast.

7. In the Method column, choose the forecast method that you want to apply 
to this action.

Note: This option is only available for forecast actions.

8. If you are defining a forecast action, choose Forecast Parameters to set 
statistical parameters for the forecast method you have chosen. 

This opens the Parameters dialog box, where you can view the current 
settings and modify values. If you want to view or fine-tune the available 
statistical parameters for your forecast method, choose Show Advanced 
Parameters.

9. Choose OK to save your settings and return to the Measure Wizard —  
Create Combination Forecast page.

3. Repeat the steps above until you have all the actions required to generate the 
forecast.

4. If you have defined more than one action, choose Overlapping Values to 
generate an Overlapping Values report. 

Time periods must be overlapping in two or more rows to cause an overlap for 
an item. For example, if a product is in a group that is forecast for Jan06-Mar06 
with the Automatic Method and the same product is also in a group forecast 
with Croston's Method for the same time horizon, then that product displays in 
the Overlapping Values report. The Overlapping Values report displays 
overlapping items at the lowest product level.

7. Choose Next to continue.

Result: The Measure Wizard —  Create Combination Forecast page opens.

8. Use the Measure Wizard — Allocation page to select the forecast allocation method 
and the method that will be used to allocate new data. 

1. In the topmost box, choose the algorithm that will be used to allocate data 
down to lower levels from the level at which the data is forecasted. Choose one 
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of the following forecast allocation methods:

• Allocate based on forecasted weights aggregated from the lowest level — 
The system uses the lowest allocation levels specified in the Demand 
Planning Server for the data stream on which the measure is based to 
allocate the results generated at the forecast levels that you chose earlier. 
Forecasts for intermediate levels (between specified and lowest available) 
are obtained by rolling up the results of the nodes after allocation. This 
method is the fastest and is the default for a new measure.

If you are generating a forecast at the weekly (or higher) level, but need to 
allocate to the day level, the specified forecast method is not always 
appropriate. This is due to the erratic nature of lowest-level data, and may 
result in the forecast method picking unwanted trends.

In this case, you can use the automatic best-fit forecast method instead of 
the specified forecast method. Demand Planning chooses the best forecast 
method with which to allocate your data to the day level.

• Allocate based on a forecast at each level — The system starts at the 
forecast levels that you chose earlier for each hierarchy, goes down one 
level at a time, and uses the results of the forecast on the level below to 
allocate the results on the level above. This process continues until the 
lowest available level is reached. Forecasts for levels above the specified 
level are achieved through rollup. This method is often the most accurate, 
but might involve substantial processing time.

• Allocate based on historical weights for the last n periods — In this case n
is an integer and period is the time level for the forecast. The system uses 
the number of historical time periods that you specified to determine 
weights for allocating data to the lower aggregate levels along each 
dimension. If there is no data for the specified periods, then the system uses
the default allocation method selected in the profile MSD: Use Classic Even 
Allocation. Forecasts at higher levels are achieved through rollup. This 
method does not adequately account for trends. 

• Allocate based on new data allocation settings specified below — The 
system uses the method for allocating new data that you subsequently 
choose to determine weights for allocating data to lower aggregate levels 
along each dimension. Any overrides that you specify will also apply. This 
method is useful when you are creating a measure that does not have 
adequate data at lower levels or when you want to allocate based on the 
data pattern in some other data stream. Note that this method can impact 
system performance. Also, if the forecast and history data do not match, the
system will default to even allocation.

2. If you chose Allocate based on forecasted weights aggregated from the lowest
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level, Allocate based on a forecast at each level, or Allocate based on 
historical weights for the last n periods, the Override Time allocation using 
box is active. To allocate data based on the time allocation weights in another 
measure, choose the Override Time allocation using and select the measure 
that you want to use. This option is useful when you want to retain the 
historical weights for all dimensions except Time in order to allocate forecasts 
based on the workday patterns of several organizations. The weights in the 
Time dimension of the selected data stream will be used to allocate the forecast 
numbers. 

Note: The selected data stream should have at least one other 
dimension in addition to the Time dimension.

3. In the Method box, choose the allocation method that will be used when new 
data is added to the measure. This allocation method applies when data for the 
measure is edited in worksheets. For example, if you edit an NA value at the All
Products level in a worksheet, Oracle Demand Planning uses the allocation 
method to determine how the value will be allocated down to the Item level.

You can select one of the following allocation methods:

• Weights in Another Measure — Allocates values based on ratios in another
measure. In the Base Measure box, select the measure on which to base the 
weighting. This is the default for a new measure.

• Avg Weight Based on History— Allocates values based on data in another 
measure for a specified number of time periods. In the Base Measure box, 
select the measure on which to base the weighting. In the Period box, enter 
the number of time periods to average. 

• None — Does not allocate values below the current level.

• Even Allocation— Allocates values evenly. Note that this method can have 
a negative impact on database size and performance. 

Note: Oracle recommends that unless you have a specific 
reason for selecting an alternate method, you should use 
Weights in Another Measure (the default for a new 
measure) or Avg Weight Based on History. 

If data exists at the lowest available level within the 
measure, then the allocation weights will be calculated 
using that data. If data does not exist at the lowest available
level, then the specified allocation will be used if valid 
non-NA allocation rules can be determined. If data does 
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not exist at the lowest available level and the specified 
allocation method does not provide valid allocation rules 
(for example, there is no data in the base allocation 
measure), then even allocation will be used. 

4. You can choose a different allocation method for one or more dimensions of the
measure.

Note: Oracle recommends that you apply the same allocation 
method to all dimensions of the measure. Although you 
technically have the ability to set different allocation methods 
for dimensions, doing so can have a negative impact on system 
performance.

• In the Dimension list, identify a dimension for which you want to change 
the default allocation method. In this case, the word "Default" refers to the 
allocation method that you chose earlier in this procedure.

• In the Method box, choose the method that you want to use to allocate data
for this dimension. If the method requires a base measure, select it in the 
Base Measure box. If the method requires a number of time periods, enter 
this in the Periods box.

• To override the default for another dimension, repeat the previous steps.

5. Choose Next to continue.

Result:The Measure Wizard — Aggregation page opens. 

9. Use the Measure Wizard — Aggregation page to specify how to roll data up through
parent values when data for the measure is edited in worksheets. For example, if 
you edit a value at the Item level, Oracle Demand Planning will use the aggregation
method to determine how the value will be aggregated up to the All Products level. 

1. Choose one of the following aggregation options in the Method box:

• Additive — Adds values. This is the default for a new measure.

• Average — Averages values.

• Minimum — Takes the minimum value at each child level. You might use 
this in a special case such as a population type measure.

• Maximum — Takes the maximum value at each child level. You might use 
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this in a special case, such as if you were aggregating population over time.

• First — Takes the first value at each level. Recommended only for the Time 
dimension.

• Last — Takes the last value at each level. Recommended only for the Time 
dimension.

• Weighted Average — Averages values weighted by a specified measure. In
the Based on box, select the measure on which to base the weighting.

2. You can choose a different aggregation method for one or more dimensions.

Note: Oracle recommends that you generally apply the same 
aggregation method to all dimensions of the measure. 
Although you technically have the ability to set different 
aggregation methods for dimensions, doing so can have a 
negative impact on system performance.

• In the Dimension list, identify a dimension for which you want to change 
the default aggregation method. (Default ) refers to the aggregation method 
that you chose earlier in this procedure.)

• In the Method box, choose the method that you want to use to aggregate 
data for this dimension. 

• To override the default for another dimension, repeat the previous steps.

3. Choose Next to continue.

Result:The Measure Wizard — Properties page opens. 

10. On the Measure Wizard — Properties page, you can associate one or more properties
with the measure. 

1. To enable editing for the measure's data in worksheets, check the Make the 
measure editable in worksheets box. If you will be associating a planning 
percentage with the measure, selecting this option also makes the associated 
planning percentages and dependent demand measures editable in the 
Planning Percentages worksheet.

2. To convert quantities to the base unit of measure for the plan when data is 
aggregated from the lowest available level of the Product dimension, check the 
Apply Unit of Measure (UOM) when aggregating data box. See 

For information about this parameter, see "Measure Property: Unit of Measure 
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Association", page A-5

3. Check the Apply persistent locks and adjustments from box to apply locks 
from another measure. Demand Planning uses cycle-persistent locking to carry 
data adjustments, locks, and comments in a measure from one cycle to another. 
Locking features are discussed in "Preserving Forecast Adjustments.", page 12-1
There are two radio buttons below the checkbox. One -- Previous cycle for the 
scenario -- enables you to select a particular cycle for the scenario. The other -- 
Selected measure -- enables you to select a particular measure.

4. Check the Overwrite existing data in the target measure box if you want the 
data in the measure from which locks and adjustments are being copied to 
overwrite cells in the target measure to which locks have been applied.

5. Choose Next to continue.

The Measure Wizard — Extended Analysis page is displayed.

11. On the Measure Wizard —  Extended Analysis page, you can create dependent 
demand and revenue measures for a new measure, or you can revise them for an 
existing measure. This step displays components for dependent demand in the 
form's upper half and components for price lists in the lower half. Some dialog box 
components may not be displayed if certain elements, such as dependent demand, 
are missing from the data stream on which the measures is based.

If dependent demand does not exist or cannot be used for the plan and if price lists 
do not exist for the plan, the Extended Analysis tab will not appear.

1. The Show Dependent Demand Relationship box appears if dependent 
demand has been enabled in the Demand Planning Server and model bills of 
material have been brought into Demand Planning. In addition, the lowest 
allocation level for the product and time dimensions must have been set to the 
leaf level.

Check this box to calculate measures for dependent demand and planning 
percentages. Clear this box if you do not want to create planning percentages 
and measures for dependent demand.

2. If you opt to create planning percentages, choose a planning percentage option. 
The Use Object or Measure option enables you to select an existing planning 
percentage object or a history measure (booking, shipping, etc.) from your plan.

Note: Copying a new planning percentage object is only 
enabled if all action steps are forecast steps, and all history base
measures have dependent demand.

3. The Copy Selected Planning Percentage box is enabled if the Use Object or 
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Measureoption is selected. It enables you to copy the planning percentage object 
selected in the  Use Object or Measurecheckbox..

4. The Average the copied planning percentages to level box is dependent on the
Copy Selected Planning Percentage box. When the Average checkbox is 
checked, the created planning percentage is averaged at the level of time 
specified by the selected item in the drop-down list. When the measure type is 
Forecast, it's possible to set the default level at which to average to be the 
forecast level; for other measure types, no default will be set.

5. When your demand plan includes data streams which the history includes 
dependent history, the Measure Wizard displays two radio buttons above the 
New Planning percentage Name box. Create Planning Percentage based on 
forecasted dependent history is available when the basis for the forecast is a 
stream such as Booking History. The default name of the planning percentage is
MeasureName, Planning Percentage, Forecast.

6. Create Planning Percentage based on historical weights for the last n periods
calculates planning percentages based on dependent history for the base 
measure for the number of previous periods that you specify.

7. If you create a new planning percentage with the name of an existing planning 
percentage, the result will be a repopulation of the existing planning percentage
using the selected planning percentage options. You can accomplish this by 
selecting the name from the Use Object list box, or entering it in the New 
Planning Percentage Name box. If you do chose the name of an existing 
planning percentage, you see receive a warning when you choose Next or 
Finish in the measure wizard.

8. You can use the Calculate volumes and amounts using a price list box if a 
price list is associated with your demand plan in the Demand Planning Server. 
When you check this box, you create a Quantity measure and an Amount 
measure based on a price list. If a price list has been brought down from the 
Demand Planning Server, you can associate a price list with the new measure. 
(This indicates that you want to create the associated Quantity and Amount 
measures.)

9. The Price List box is enabled if you check the Calculate volumes and amounts 
box in the dialog box. You can select a price list from the drop-down list of 
those that are available. The price list will also be used during allocation 
calculations and during editing of NA cells (or any cell where the price is 
required but not otherwise available).

10. Choose the Calculate amounts for independent demands only option button 
to just calculate totals for independent variables.
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11. Choose the Calculate amounts for both dependent and independent demands
option button to create the two new variables, dependent amount and total 
amount.

12. Choose the Next button to accept the selections you have made in this step and 
proceed to the next step.

Result: The Measure Wizard displays the Events page.

12. On the Measure Wizard — Events page, you can choose one or more events and 
event groups to apply to the measure. Events are factors such as promotions, 
product introductions, and product phase outs that are expected to have a 
quantifiable impact on demand.

1. Select events as follows:

• To add a single event or group, double-click its name in the left box

or

• Highlight it and choose the single arrow button that points to the right box.

• To add multiple nonsequential events or event groups, press and hold the 
CTRL key, select each event or event group that you want to add, and then 
choose the single arrow button that points to the right box.

• To add multiple sequential events and event groups, select the first event or
group that you want to add, press and hold the SHIFT key, select the event 
or group that you want to add, and then choose the single arrow button 
that points to the right box. You can also select the events to add by clicking
and dragging the mouse. 

• To add all events, choose the double arrow button that points to the right 
box.

2. Choose Next to continue.

Result: The Measure Wizard —Number Formatting page opens.

13. On the Measure Wizard — Number Formatting page, you can specify how data for 
the measure will be displayed in documents. 

Note: The default formats reflect settings established for the plan in
the Demand Planning Server. Your changes will not impact how 
the data is written back to the Demand Planning Server.

If you associated a price list with the current measure, then you can choose formats 
for both Quantity and Amount. If no price list has been associated with the 
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measure, then you can only choose the formats that are related to the base measure: 
if the forecast is based on a quantity measure, you can choose formats for Quantity; 
if the forecast is based on an amount measure, then you can choose formats for 
Amount. 

1. You can set the following format options:

• Decimal Digits — Specifies the number of decimal places to display. You 
can choose an alternate number.

• Positive Values — Specifies the format for positive numbers. You can 
choose an alternate format.

• Negative Values — Specifies the format for negative numbers. You can 
choose an alternate format.

• Use Thousands Separator — Indicates whether to display the thousands 
separator. Check the box to display the thousands separator. Clear the box 
to suppress the thousands separator.

• Display Leading Zero — Indicates whether to display leading zeros. Check
the box to display leading zeros. Clear the box to suppress leading zeros.

As you make formatting choices, the Samples area displays their effect.

2. The Rounding Rule checkbox is the last component in the Number Formatting 
step of the Measure Wizard for three of the four types of measures. The text 
label says Cumulate fractional quantities within product level. There is a 
drop-down list box from which you can select a level in the product dimension. 
When you check this box, Oracle Demand Planning will round the forecast 
numbers by intelligently cumulating the fractional quantities across forecast 
time periods such that the total demand remains unchanged.

3. When your format choices are complete, choose Next to continue.

Result: The Measure Wizard — Summary page opens, showing the choices that 
you have made.

14. Choose Finish to save the measure.

Averaging Existing Percentages to Forecasting Levels
You may want to average or "smooth" a planning percentage to eliminate anomalies in 
your data resulting from seasonal factors, events, promotions, and so on. Oracle 
Demand Planning enables you to take an existing planning percentage and average it to
a specified time level.

You can create the average/forecast planning percentage by using the Measure Wizard.
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Why Average Planning Percentages?
The planning percentage brought in from your ERP and the planning percentage in 
your worksheet may have data at different levels because of the different circumstances 
in which they originate. The forecast may be at the month level, and data from the ERP 
may be at the week level.

The planning percentage of a forecast measure is only editable at the forecasting level. If
you average an existing planning percentage, you can display and edit it at the 
forecasting level.

Thus, averaging an existing planning percentage enables you to better compare it with 
the forecast planning percentage that you calculate in the planning percentage 
worksheet.

If you modify an existing planning percentage to be editable at the forecasting level, 
you will still be able to display it at the lowest time level of the demand plan.

Average Planning Percentages - An Example
For an example, imagine a particular computer (the Laptop 123AB) as the model and its
CPU and Monitor as options. The average planning percentage for the monitor for the 
first quarter might be 70 percent.

In order to see demand in greater granularity, you can either create a new measure, or 
you can copy the existing measure and average the planning percentage to the month 
level. It may then be seen that the planning percentage for monitors breaks down to 
60% in April, 80% in May, and 70% in June, due to seasonal factors and promotions 
relating to school graduations.

Use the step to create the additional dependent demand and revenue measures for your
new measure (ninth step) in the Measure Wizard to average a planning percentage.
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• There are several ways to average or smooth a planning percentage. One is to do so 
by creating a new forecast. Another method is to copy and edit an existing forecast. 
With either method, your use of the demand-plan-related components of the 
Extended Analysis step of the Measure Wizard will be the same as those described 
below.

Averaging a Planning Percentage -- Procedure (Creating a Forecast)
1. Open the Measure Wizard.

Choose the appropriate option in the Choose Method step of the Measure Wizard.

If you are copying an existing measure, it must be a forecast measure.

Whether you are creating a measure or copying a measure, you will not be able to 
use any dependent-demand related components of the Measure Wizard, unless 
dependent demand has been enabled in the Demand Planning Server and brought 
into Demand Planning.

2. Use the Measure Wizard to make your selections for forecast properties and 
characteristics such as method, parameters, allocation, aggregation, and so on.

3. In the Properties step, check the Make the measure editable in worksheets box.

4. In the Extended Analysis step, check the box labeled Show Dependent Demand 
relationship (product to parts)

5. Choose the Use Object option. This enables you to select an existing planning 
percentage object to average.

6. Select the name of the object from the Planning Percentage Object drop-down list box.
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Demand Planning will list all planning percentage objects in your personal 
database.

7. Check the box labeled Average the copied planning percentage to (time level).

8. Select a time level from the Time Level drop-down list box. In most cases, you will 
set the time to the forecasting level or to a lower level.

9. Enter a name, in the New Planning Percentage Name text box, for the planning 
percentage object you are creating.

10. Complete the remaining steps in the Measure Wizard.

Copying Planning Percentages
An existing planning percentage object, whether collected from ERP or created and 
saved by a manager or planner, can be copied and used under a different name. This is 
accomplished when creating or editing a forecast, copy, or copy multiple measure by 
using the Measure Wizard, following the steps described below.

1. Proceed to the Extended Analysis step or tab.

2. Check the Show Dependent Demand relationship box.

3. Choose the Use Planning Percentage Object box, which is a list box that displays 
the available planning percentage objects.

4. Select the planning percentage object that you want to copy.

5. Check the Copy Selected Planning Percentage box.

6. Enter a new name in the New Planning Percentage Name box.

7. Complete your tasks in the Measure Wizard and choose Finish.
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Creating Simple Copy Measures
You can create a measure that copies data from another measure. For example, you 
might use this method to create a measure that copies data in the same time period and 
applies an event factor. Or you might create a measure that copies the data and shifts it 
backward or forward in time.

To create a simple copy measure: 
1. Access Oracle Demand Planning as a Demand Planner or Demand Plan Manager.

2. On the Navigation toolbar, choose the New button.

3. Choose New Measure from the popup menu.

Alternatively, you can click the right mouse button on the Measures folder in the 
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navigation list and choose New Measure from the popup menu. 

Result: The Create Measure dialog box opens.

4. In the Create Measure dialog box, choose Stored Measure.

If you see the Measure Wizard — Introduction page, choose Next to continue.

Note: To suppress the display of this page in the future, clear the 
Show this page next time box before you continue. 

Result: The Measure Wizard — Choose Method page opens.

5. Complete the Measure — Choose Method page.

1. In the Name box, enter a name for the measure, up to 70 characters long.

2. In the Method box, choose Copy Measure. 

3. Choose Next to continue. 

Result: The Measure Wizard — Copy Measure page opens.

6. Complete the Measure Wizard — Copy Measure page.

1. In the What measure do you want to copy your data from? box, choose from 
the following options:

• Stored Measure — Create a new measure based on an existing stored 
measure.

Select the measure to copy.

• Formula Measure — Create a new measure based on an existing formula 
measure.

To modify the selected formula measure, choose Edit. To create a new 
formula measure, choose Create. For more information, see Creating 
Formula Measures, page 17-57.

2. Indicate how you want to copy the data. You can choose one of the following 
options:

• Leave data in original time — Copies the data in the same time period as 
the base measure. This is the default for a new measure.

• Shift data back by nperiods (where n is an integer and periods is a time 
level) — Copies the data in the base measure and shifts it back in time. 
Enter the number of time periods in the text box and choose the time level 
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from the drop-down list box.

• Shift data forward by nperiods (where nis an integer and periods is a time 
level) — Copies the data in the base measure and shifts it forward in time. 
Enter the number of time periods and choose the time level.

3. Choose Next to continue.

Result: The Measure Wizard — Allocation page opens.

7. Use the Measure Wizard — Allocation page to select the allocation method that will 
be used when new data is added to the measure. The selected allocation method is 
used for both the initial calculation and during the editing process. For example, if 
you edit an NA value at the All Products level in a worksheet, Oracle Demand 
Planning uses the allocation method to determine how the value will be allocated 
down to the Item level. By default, Demand Planning uses the formula measure's 
specified weighting. 

1. In the Method box, choose one of the following methods:

• Weights in Another Measure — Allocates values based on ratios in another
measure. In the Base Measure box, select the measure on which to base the 
weighting. This is the default for a new measure.

• Avg Weight Based on History— Allocates values based on data in another 
measure for a specified number of time periods. In the Base Measure box, 
select the measure on which to base the weighting. In the Period box, enter 
the number of time periods to average. 

• None — Does not allocate values below the current level. This option is 
only available if you selected Shift data back by n periods or Shift data 
forward by nperiods.

• Even Allocation— Allocates values evenly. Note that this method can have 
a negative impact on database size and performance. 

Note: Oracle recommends that unless you have a specific 
reason for selecting an alternate method, you should use 
Weights in Another Measure (the default for a new 
measure) or Avg Weight Based on History. While even 
allocation is the default behavior in situations where 
allocation needs to occur but no base can be found, Oracle 
recommends that you try to specify a base. 

If data exists at the lowest available level within the 
measure, then the allocation weights will be calculated 
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using that data.

If data does not exist at the lowest available level, then the 
specified allocation will be used if valid non-NA allocation 
rules can be determined.

If data does not exist at the lowest available level and the 
specified allocation method does not provide valid 
allocation rules (for example, there is no data in the base 
allocation measure), then even allocation will be used. 

2. You can choose a different allocation method for one or more dimensions.

Note: Oracle recommends that you usually apply the same 
allocation method to all dimensions of the measure. Although 
you technically have the ability to set different allocation 
methods for dimensions, doing so can have a negative impact 
on system performance.

3. To override the allocation method that you set for one or more dimensions, 
check the Do you want to override the default method of allocation of newly 
added data box and proceed as follows:

• In the Dimension list, identify a dimension for which you want to change 
the default allocation method. ("Default" refers to the allocation method 
that you choose.)

• In the Method box, choose the method that you want to use to allocate data
for this dimension. If the method requires a base measure, select it in the 
Base Measure box. If the method requires a number of time periods, enter 
this in the Periods box.

• To override the default for another dimension, repeat the previous steps.

4. Choose Next to continue.

Result:The Measure Wizard — Aggregation page opens. 

8. For a measure that shifts data back or forward in time, use the Measure Wizard — 
Aggregation page to specify how to roll data up through parent values when data 
for the measure is edited in worksheets. The selected aggregation method is used 
for both the initial calculation and during the editing process. For example, if you 
edit a value at the Item level, Oracle Demand Planning will use the aggregation 
method to determine how the value will be aggregated up to the All Products level. 
By default, Demand Planning uses the formula measure's specified aggregation 
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method.

Note: You cannot select an aggregation method for data that is 
copied in original time. For this type of measure, aggregation is 
additive and cannot be changed.

1. Choose one of the following aggregation options in the Method box:

• Additive — Adds values. This is the default for a new measure.

• Average — Averages values.

• Minimum — Takes the minimum value at each child level. You might use 
this in a special case such as a population type measure.

• Maximum — Takes the maximum value at each child level .

You might use this in a special case, such as if you were aggregating 
population over time.

• First — Takes the first value at each level. Recommended only for the Time 
dimension.

• Last — Takes the last value at each level. Recommended only for the Time 
dimension.

• Weighted Average — Averages values weighted by a specified measure. In
the Based on box, select the measure on which to base the weighting.

• None — Does not aggregate values. 

2. You can choose a different aggregation method for one or more dimensions.

Note: Oracle recommends that you generally apply the same 
aggregation method to all dimensions of the measure. 
Although you technically have the ability to set different 
aggregation methods for dimensions, doing so can have a 
negative impact on system performance.

To override the aggregation method that you set for one or 
more dimensions, check the Do you want to override the 
default aggregation per dimension box and proceed as 
follows:

• In the Dimension list, identify a dimension for which you want to change 
the default aggregation method. ("Default" refers to the aggregation 
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method that you chose.)

• In the Method box, choose the method that you want to use to aggregate 
data for this dimension. 

• To override the default for another dimension, repeat the previous steps.

3. Choose Next to continue.

Result:The Measure Wizard — Properties step opens. 

9. On the Measure Wizard —  Properties page, you can associate one or more 
properties with the measure. 

1. To enable editing data for the measure in worksheets, check the Make the 
measure editable in worksheets box. If you will be associating a planning 
percentage with the measure, selecting this option also makes the associated 
measures for planning percentages and dependent demand editable in the 
Planning Percentages worksheet.

2. To convert quantities to the base unit of measure for the plan when data is 
aggregated from the lowest available level of the Product dimension, check the 
Apply Unit of Measure (UOM) when aggregating data box. 

Note: This option is not available for a measure that is copied 
in original time. 

For information about this parameter, see "Measure Property: 
Unit of Measure Association", page A-5.

3. Check the Apply persistent locks and adjustments from box to apply locks 
from another measure. Demand Planning uses cycle-persistent locking to carry 
data adjustments, locks, and comments in a measure from one cycle to another. 
Locking features are discussed in "Preserving Forecast Adjustments.", page 12-1
There are two radio buttons below the checkbox. One -- Previous cycle for the 
scenario -- enables you to select a particular cycle for the scenario. The other -- 
Selected measure -- enables you to select a particular measure.

4. Check the Overwrite existing data in the target measure box if you want the 
data in the measure from which locks and adjustments are being copied to 
overwrite cells in the target measure to which locks have been applied.

5. Choose Next to continue.

The Extended Analysis step box is displayed.

10. On the Measure Wizard —  Extended Analysis step, you can create dependent 
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demand and revenue measures for a new measure, or you can revise them for an 
existing measure. This step displays components for dependent demand in the 
form's upper half and components for price lists in the lower half. Some dialog box 
components may not be displayed if certain elements, such as dependent demand, 
are missing from the data stream on which the measures is based.

If dependent demand does not exist or cannot be used for the plan and if price lists 
do not exist for the plan, the Extended Analysis tab will not appear.

1. The Show Dependent Demand Relationship box appears if dependent 
demand has been enabled in the Demand Planning Server and model bills of 
material have been brought into Demand Planning. In addition, the lowest 
allocation level for the product and time dimensions must have been set to the 
leaf level.

Check this box to calculate measures for dependent demand and planning 
percentages. Clear this box if you do not want to create planning percentages 
and measures for dependent demand.

2. If you opt to create planning percentages, choose a planning percentage option. 
The Use Object or Measure option enables you to select an existing planning 
percentage object or a history measure (booking, shipping, etc.) from your plan.

3. The Copy Selected Planning Percentage box is enabled if the Use Object or 
Measureoption is selected. It enables you to copy the planning percentage object 
selected in the  Use Object or Measurecheckbox..

4. The Average the copied planning percentages to level box is dependent on the
Copy Selected Planning Percentage box. When the Average checkbox is 
checked, the created planning percentage is averaged at the level of time 
specified by the selected item in the drop-down list. When the measure type is 
Forecast, it's possible to set the default level at which to average to be the 
forecast level; for other measure types, no default will be set.

5. When your demand plan includes data streams which the history includes 
dependent history, the Measure Wizard displays two radio buttons above the 
New Planning percentage Name box. Create Planning Percentage based on 
forecasted dependent history is available when the basis for the forecast is a 
stream such as Booking History. The default name of the planning percentage is
MeasureName, Planning Percentage, Forecast. 

6. Create Planning Percentage based on historical weights for the last n periods
calculates planning percentages based on dependent history for the base 
measure for the number of previous periods that you specify.

7. If you create a new planning percentage with the name of an existing planning 
percentage, the result will be a repopulation of the existing planning percentage
using the selected planning percentage options. You can accomplish this by 
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selecting the name from the Use Object list box, or entering it in the New 
Planning Percentage Name box. If you do chose the name of an existing 
planning percentage, you see receive a warning when you choose Next or 
Finish in the measure wizard.

8. You can use the Calculate volumes and amounts using a price list box if a 
price list is associated with your demand plan in the Demand Planning Server. 
When you check this box, you create a Quantity measure and an Amount 
measure based on a price list. If a price list has been brought down from the 
Demand Planning Server, you can associate a price list with the new measure. 
(This indicates that you want to create the associated Quantity and Amount 
measures.)

9. The Price List box is enabled if you check the Calculate volumes and amounts 
box in the dialog box. You can select a price list from the drop-down list of 
those that are available. The price list will also be used during allocation 
calculations and during editing of NA cells (or any cell where the price is 
required but not otherwise available).

10. Choose the Calculate amounts for independent demands only option button 
to just calculate totals for independent variables.

11. Choose the Calculate amounts for both dependent and independent demands
option button to create the two new variables, dependent amount and total 
amount.

12. Choose the Next button to accept the selections you have made in this step and 
proceed to the next step.

Result: The Measure Wizard displays the Events page.

11. On the Measure Wizard — Events page, you can choose one or more events and 
event groups to apply to the measure. Events are factors such as promotions, 
product introductions, and product phase outs that are expected to have a 
quantifiable impact on demand.

1. Select events as follows:

• To add a single event or group, double-click its name in the left box.

or

• Highlight it and choose the single arrow button that points to the right box.

• To add multiple nonsequential events or event groups, press and hold the 
CTRL key, choose each event or event group that you want to add, and 
then choose the single arrow button that points to the right box.
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• To add multiple sequential events and event groups, select the first event or
group that you want to add, press and hold the SHIFTkey, select the event 
or group that you want to add, and then choose the single arrow button 
that points to the right box. You can also select the events to add by clicking
and dragging the mouse. 

• To add all events, choose the double arrow button that points to the right 
box.

2. Choose Next to continue.

Result: The Measure Wizard — Number Formatting page opens.

12. On the Measure Wizard — Number Formatting page, you can specify how data for 
the measure will be displayed in documents. 

Note: The default formats reflect settings established for the plan in
the Demand Planning Server. Your changes will not impact how 
the data is written back to the Demand Planning Server.

If you associated a price list with the measure, then you can choose formats for both
Quantity and Amount. If no price list has been associated with the measure, then 
you can only choose formats that are related to the base measure: if the new 
measure is based on a quantity measure, you can choose formats for Quantity; if the
new measure is based on an amount measure, then you can choose formats for 
Amount.

1. You can set the following format options:

• Decimal Digits — Specifies the number of decimal places to display. You 
can choose an alternate number.

• Positive Values — Specifies the format for positive numbers. You can 
choose an alternate format.

• Negative Values — Specifies the format for negative numbers. You can 
choose an alternate format.

• Use Thousands Separator — Indicates whether to display the thousands 
separator. Check the box to display the thousands separator. Clear the box 
to suppress the thousands separator.

• Display Leading Zero — Indicates whether to display leading zeros. Check
the box to display leading zeros. Clear the box to suppress leading zeros.

As you make formatting choices, the Samples area displays their effect.
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• The Rounding Rule checkbox is the last component in the Number 
Formatting step of the Measure Wizard for three of the four types of 
measures. The text label says Cumulate fractional quantities within 
product level. There is a drop-down list box from which you can select a 
level in the product dimension. When you check this box, Oracle Demand 
Planning will round the forecast numbers by intelligently cumulating the 
fractional quantities across forecast time periods such that the total demand
remains unchanged.

2. When your format choices are complete, choose Next to continue.

Result: The Measure Wizard —  Summary page opens, showing the choices that 
you have made.

13. Choose Finish to save the measure.

Allocation Settings
When copying measures based on stored measures, the allocation settings will only 
apply to the allocation of data that is input into "NA" cells on a worksheet. 

When copying measures based on formula measures, Demand Planning uses the 
allocation settings when the measure is calculated from the selected formula measure, 
and when you add new data to the measure using a worksheet. 

Aggregation Settings
Aggregation settings are not available when defining measures that are copies of stored 
measures. Data is copied directly from the source measure at all levels and Demand 
Planning uses the source measure's aggregation settings for subsequent recalculations. 

If you are defining a copy measure based on a formula measure, you can specify which 
aggregation methods to include. These aggregation methods are used when calculating 
the measure from the selected formula measure, and when adding or editing measure 
data. 

Creating Copy Multiple Measures
You can create measures that copy subsets of data from more than one dimension of 
more than one measure. 

Following are some examples of when you might want to use this method:

• You might want to create a measure that copies data at the month level from the 
Sales Opportunity Forecast for January through June of a given year and from the 
Forecast of Booking History for July through December of the same year. 

• You might want to create a measure that uses a statistical forecast for mature 
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products and a "based on last submitted forecast" for products with transient 
customers. 

• You might want to create a measure that uses a statistical forecast for mature 
products for a defined customer population, a "based on last submitted forecast" for
a specific customer product combination where the demand is not expected to 
evolve at all, and last years history (with appropriate lag or lead) for a few 
customers/products where you know the demand is not expected to evolve at all.

To create a stored measure that copies a measure depending on more than one dimension:
1. Access Oracle Demand Planning as a Demand Planner or Demand Plan Manager.

2. On the Navigation toolbar, choose the New button.

3. Choose New Measure from the popup menu. 

Alternatively, you can click the right mouse button on the Measures folder in the 
Navigation list. Then choose New Measure from the popup menu. 

4. In the Create Measure dialog box, choose Stored Measure.

If you see the Measure Wizard — Introduction page, choose Next to continue.

Note: To suppress the display of this page in the future, clear the 
Show this page next time box before you continue. 

Result: The Measure Wizard — Choose Method page opens.

5. Complete the Measure Wizard — Choose Method page.

1. In the Measure Name box, enter a name for the measure, up to 70 characters 
long.

2. In the Method box, select Copy multiple measures.

Result: The Copy multiple measures page opens.

6. In the Copy multiple measures page, you must specify the levels at which to copy 
values for each dimension. Then you choose the values to copy.

1. The Dimension/Level grid displays defaults for levels in the dimension 
hierarchies. When you click on a panel in the Level column, you see a 
drop-down list of available levels. 
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Note:  Set the levels at which you want to copy the data before 
you select specific measures and dimension values. If you 
change a level after you select measures and values, you will 
have to enter your selections again.

2. Choose Add to select a measure from which to copy data.

Result:A default measure appears in the Measure column of the 
Measure/Values box. If you click that measure, a list of all the available 
measures is displayed. Choose the first measure with which you want to work.

The list of available measures changes after you select the initial data subset. 
This occurs because each measure selected for copying must have the same 
properties for Unit of Measure and aggregation method as the first measure 
that you chose. For example, a measure that only has an amount portion can 
only be combined with other amount measures.

3. Repeat the step above until you have all the measures from which you will 
copy subsets.

4. Use the command buttons to the right of the Measure/Values box to select 
dimension values for the measures you have chosen. To select values for a 
measure, highlight the measure and choose Edit.

Result: The Select Data dialog box opens. The Available box lists values for one 
dimension of this measure.

5. The Select Data dialog box displays three buttons in place of the usual Selection 
Tools toolbar. The button on the left is the Attribute tool. You can use this 
button to access the Choose Values by Attribute dialog box. Use the Attribute tool 
to select values, page 22-9 just as you would when working with the full 
Selector.

6. Use the steps below to select dimension values for your measures.

• Select values for the current dimension (displayed in the Select Values for 
box). See the procedure"Techniques for selecting values from a list", page 
22-4.

• Select values for another dimension.

• Repeat the selection process until you have selected at least one value for 
each dimension. This enables the OK button in the Select Data dialog box. 
Choose OK.

Result: You are returned to the Copy multiple measures page.
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7. Select another measure and choose dimension values for that measure. Repeat the 
process until all your subsets are complete.

Result:Each entry in the Measure column now shows a corresponding entry in the 
Values column.

8. Choose Next to continue.

Result: The Measure Wizard — Allocation page opens.

9. Use the Measure Wizard —Allocation page to select the allocation method that will 
be used when new data is added to the measure.

The allocation method applies when data for the measure is edited in worksheets. 
For example, if you edit an NA value at the All Products level in a worksheet, 
Oracle Demand Planning uses the allocation method to determine how the value 
will be allocated down to the Item level. 

1. Choose one of the following allocation methods:

• Weights in Another Measure — Allocates values based on ratios in another
measure. In the Base Measure box, select the measure on which to base the 
weighting. This is the default for a new measure.

• Avg Weight Based on History— Allocates values based on data in another 
measure for a specified number of time periods. In the Base Measure box, 
select the measure on which to base the weighting. In the Period box, enter 
the number of time periods to average.

• Even Allocation— Allocates values evenly. Note that this method can have 
a negative impact on database size and performance. 

Note: Oracle recommends that unless you have a specific 
reason for selecting an alternate method, you should use 
Weights in Another Measure (the default for a new 
measure) or Avg Weight Based on History. While even 
allocation is the default behavior in situations where 
allocation needs to occur but no base can be found, Oracle 
recommends that you try to specify a base. 

If data exists at the lowest available allocation level within 
the measure, then the allocation weights will be calculated 
using that data. If data does not exist at the lowest available
level, then the specified allocation will be used if valid 
non-NA allocation rules can be determined. 

If data does not exist at the lowest available level and the 
specified allocation method does not provide valid 
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allocation rules, even allocation will be used. 

2. You can choose a different allocation method for one or more dimensions.

Note: Oracle recommends that you usually apply the same 
allocation method to all dimensions of the measure. Although 
you technically have the ability to set different allocation 
methods for dimensions, doing so can have a negative impact 
on system performance.

To override the allocation method that you set earlier for one or
more dimensions, check the Do you want to override the 
default method of allocation of newly added data box and 
change the allocation settings.

3. Choose Next to continue. Result:The Measure Wizard — Aggregation page 
opens.

10. Use the Measure Wizard — Aggregation page to specify how to roll data up through
parent values when data for the measure is edited in worksheets. For example, if 
you edit a value at the Item level, Oracle Demand Planning will use the aggregation
method to determine how the value will be aggregated up to the All Products level. 

1. In the Method box, choose one of the following aggregation options:

• Additive — Adds values. This is the default for a new measure.

• Average — Averages values.

• Minimum — Takes the minimum value at each child level. You might use 
this in a special case such as a population type measure.

• Maximum — Takes the maximum value at each child level. You might use 
this in a special case, such as if you were aggregating population over time.

• First — Takes the first value at each level. Recommended only for the Time 
dimension.

• Last — Takes the last value at each level. Recommended only for the Time 
dimension.

• Weighted Average — Averages values weighted by a specified measure. In
the Based on box, select the measure on which to base the weighting.
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• None — Does not aggregate values. 

2. You can choose a different aggregation method for one or more dimensions.

Note: Oracle recommends that you generally apply the same 
aggregation method to all dimensions of the measure. 
Although you technically have the ability to set different 
aggregation methods for dimensions, doing so can have a 
negative impact on system performance.

To override the aggregation method that you set earlier for one 
or more dimensions, check the Do you want to override the 
default aggregation per dimension box and change the 
aggregation settings.

3. Choose Next to continue.

Result:The Measure Wizard — Properties page opens. 

11. On the Measure Wizard — Properties page, you can associate one or more properties
with the measure. 

1. To enable editing data for the measure in worksheets, check the Make the 
measure editable in worksheets box. If you will be associating a planning 
percentage with the measure, selecting this option also makes the associated 
measures for planning percentages and dependent demand editable in the 
Planning Percentages worksheet.

2. To convert quantities to the base unit of measure for the plan when data is 
aggregated from the lowest available level of the Product dimension, check the 
Apply Unit of Measure (UOM) when aggregating data box. 

For information about this parameter, see "Measure Property: Unit of Measure 
Association", page A-5.

3. Check the Apply persistent locks and adjustments from box to apply locks 
from another measure. Demand Planning uses cycle-persistent locking to carry 
data adjustments, locks, and comments in a measure from one cycle to another. 
There are radio buttons below the checkbox that enable you to select a 
particular cycle for the scenario (Previous cycle for the scenario) or a particular 
measure (Selected measure).

4. Check the Overwrite existing data in the target measure box if you want the 
data in the measure from which locks and adjustments are being copied to 
overwrite cells in the target measure to which locks have been applied.
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5. To use a price list as the basis for calculating an amount measure from a 
quantity measure or a quantity measure from an amount measure, check the 
Calculate volumes and amounts using a price list box, and select the price list 
to use for the calculation.

Note: This option only appears if a price list is associated with 
the demand plan in the Demand Planning Server. 

6. When you complete the Properties page, choose Next to continue.

Result:The Measure Wizard — Extended Analysis page opens.

12. On the Measure Wizard —- Extended Analysis step, you can create dependent 
demand and revenue measures for a new measure, or you can revise them for an 
existing measure. This step displays components for dependent demand in the 
form's upper half and components for price lists in the lower half. Some dialog box 
components may not be displayed if certain elements, such as dependent demand, 
are missing from the data stream on which the measures is based.

If dependent demand does not exist or cannot be used for the plan and if price lists 
do not exist for the plan, the Extended Analysis tab will not appear.

1. The Show Dependent Demand Relationship box appears if dependent 
demand has been enabled in the Demand Planning Server and model bills of 
material have been brought into Demand Planning. In addition, the lowest 
allocation level for the product and time dimensions must have been set to the 
leaf level.

Check this box to calculate measures for dependent demand and planning 
percentages. Clear this box if you do not want to create planning percentages 
and measures for dependent demand.

2. If you opt to create planning percentages, choose a planning percentage option. 
The Use Object or Measure option enables you to select an existing planning 
percentage object or a history measure (booking, shipping, etc.) from your plan.

3. The Copy Selected Planning Percentage box is enabled if the Use Object or 
Measureoption is selected. It enables you to copy the planning percentage object 
selected in the  Use Object or Measurecheckbox.

4. The Average the copied planning percentages to level box is dependent on the
Copy Selected Planning Percentage box. When the Average checkbox is 
checked, the created planning percentage is averaged at the level of time 
specified by the selected item in the drop-down list. When the measure type is 
Forecast, it's possible to set the default level at which to average to be the 
forecast level; for other measure types, no default will be set.



Working with Measures     17-51

5. When your demand plan includes data streams which the history includes 
dependent history, the Measure Wizard displays two radio buttons above the 
New Planning percentage Name box. Create Planning Percentage based on 
forecasted dependent history is available when the basis for the forecast is a 
stream such as Booking History. The default name of the planning percentage is
MeasureName, Planning Percentage, Forecast. 

6. Create Planning Percentage based on historical weights for the last n periods
calculates planning percentages based on dependent history for the base 
measure for the number of previous periods that you specify.

7. If you create a new planning percentage with the name of an existing planning 
percentage, the result will be a repopulation of the existing planning percentage
using the selected planning percentage options. You can accomplish this by 
selecting the name from the Use Object list box, or entering it in the New 
Planning Percentage Name box. If you do chose the name of an existing 
planning percentage, you see receive a warning when you choose Next or 
Finish in the measure wizard.

8. You can use the Calculate volumes and amounts using a price list box if a 
price list is associated with your demand plan in the Demand Planning Server. 
When you check this box, you create a Quantity measure and an Amount 
measure based on a price list. If a price list has been brought down from the 
Demand Planning Server, you can associate a price list with the new measure. 
(This indicates that you want to create the associated Quantity and Amount 
measures.)

9. The Price List box is enabled if you check the Calculate volumes and amounts 
box in the dialog box. You can select a price list from the drop-down list of 
those that are available. The price list will also be used during allocation 
calculations and during editing of NA cells (or any cell where the price is 
required but not otherwise available).

10. Choose the Calculate amounts for independent demands only option button 
to just calculate totals for independent variables.

11. Choose the Calculate amounts for both dependent and independent demands
option button to create the two new variables, dependent amount and total 
amount.

12. Choose the Next button to accept the selections you have made in this step and 
proceed to the next step.

Result: The Measure Wizard displays the Events page.

13. On the Measure Wizard — Events page, you can choose one or more events and 
event groups to apply to the measure. Events are factors such as promotions, 
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product introductions, and product phase outs that are expected to have a 
quantifiable impact on demand.

1. Select events as follows:

• To add a single event or group, double-click its name in the left box

or

• Highlight it and choose the single arrow button that points to the right box.

• To add multiple nonsequential events or event groups, press and hold the 
CTRL key, choose each event or event group that you want to add, and 
then choose the single arrow button that points to the right box.

• To add multiple sequential events and event groups, select the first event or
group that you want to add, press and hold the SHIFT key, select the event 
or group that you want to add, and then choose the single arrow button 
that points to the right box. You can also select the events to add by clicking
and dragging the mouse. 

• To add all events, choose the double arrow button that points to the right 
box.

2. Choose Next to continue.

Result:The Measure Wizard — Number Formatting page opens.

14. On the Measure Wizard —Number Formatting page, you can specify how data for 
the measure will be displayed in documents. 

Note: The default formats reflect settings established for the plan in
the Demand Planning Server. Your changes will not impact how 
the data is written back to the Demand Planning Server.

If you associated a price list with the current measure, then you can choose formats 
for both Quantity and Amount. If no price list has been associated with the 
measure, then you can only choose the formats that are related to the base measure: 
if the new measure is based on a quantity measure, you can choose formats for 
Quantity; if the new measure is based on an amount measure, then you can choose 
formats for Amount.

1. You can set the following format options:

• Decimal Digits — Specifies the number of decimal places to display. You 
can choose an alternate number.

• Positive Values — Specifies the format for positive numbers. You can select
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an alternate format.

• Negative Values — Specifies the format for negative numbers. You can 
select an alternate format.

• Use Thousands Separator — Indicates whether to display the thousands 
separator. Check the box to display the thousands separator. Clear the box 
to suppress the thousands separator.

• Display Leading Zero — Indicates whether to display leading zeros. Check
the box to display leading zeros. Clear the box to suppress leading zeros.

As you make formatting choices, the Samples area displays their effect.

2. The Rounding Rule checkbox is the last component in the Number Formatting 
step of the Measure Wizard for three of the four types of measures. The text 
label says Cumulate fractional quantities within product level. There is a 
drop-down list box from which you can select a level in the product dimension. 
When you check this box, Oracle Demand Planning will round the forecast 
numbers by intelligently cumulating the fractional quantities across forecast 
time periods such that the total demand remains unchanged 

3. When your format choices are complete, choose Next to continue.

Result: The Measure Wizard — Summary page opens, showing the choices that 
you have made.

15. Choose Finish to save the measure.

Using the Attribute Tool when Creating Copy Multiple Measures
When you are using the Measure Wizard to create copy multiple measures, you can 
access the Attribute tool to use attributes as selection criteria for a subset of dimension 
values.

• You can use attributes to select groups of products that share an attribute, such as 
color.

• You can use attributes to select only dimension values that are in your Assignment 
scope.

You use attributes in the second step of the Measure Wizard, Copy Multiple Measures, 
after choosing Copy Multiple Measures in the Choose Method step. 

Follow the steps below to use the Attribute tool in the Measure Wizard. The rest of the 
steps for creating your copy multiple measure are the same as those described in the 
procedure "Creating Copy Multiple Measures" earlier in this chapter.

1. In the Copy Multiple Measures step, use the Level column of the Dimension/Level 
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grid to set the level for each dimension from which you intend to copy a subset of 
values.

2. Choose Add to add a measure. A default measure appears in the Measure column 
of the Measure/Values box.

3. If you do not want to use the default measure, click the default measure so that a 
drop-down list of (alternate) available measures is displayed. Choose the first 
measure with which you want to work.

4. Select the Values cell and choose Edit. 

The Select Data dialog box is displayed. In place of the Selection tools toolbar, the 
Attribute tool and the Undo and Redo buttons are displayed.

5. For each dimension, you can select values from the list in the Available box, or you 
can use the Attribute tool to modify or create dimension value subsets. 

When you make a dimension selection for a dimension, the dimension name is 
enabled in the Select values for box. However, the OK button in the Select Data 
dialog box is not enabled until you have selected values from every dimension and 
created a data 'cube.'

6. Proceed to select subsets from all the dimensions for all the measures you want in 
your Copy Multiple measure. 

7. Then choose Next to go to the Allocation step and continue building your measure.

Creating Accuracy Measures
At the conclusion of a planning cycle, Oracle Demand Planning publishes the final 
forecast numbers for supply and inventory planning to other Oracle applications such 
as Advanced Supply Chain Planning (ASCP).

If Demand Planning provides a measure of forecast accuracy, Inventory Optimization 
uses the forecast and its accuracy to calculate safety stocks. You can use the Stored 
Measure option to create these accuracy measures. 

You can also use this option to quantify accuracy between any two measures at 
specified levels for a specified time period: for example, you might create an accuracy 
measure that compares a previous period forecast to new sales history. Or you might 
compare the forecast accuracy from one period to another. You can also create specific 
accuracy measures for various organization and product combinations. 

To create an ad hoc accuracy measure:
1. Access Oracle Demand Planning as a planner or planning manager.
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2. On the Navigation toolbar, choose the New button.

3. Choose New Measure.

Alternatively, you can click the right mouse button on the Measures folder in the 
Navigation list. Then choose New Measure from the popup menu. 

4. In the Create Measure dialog box, choose Stored Measure.

If you see the Measure Wizard — Introduction page, choose Next to continue.

Note: To suppress the display of this page in the future, clear the 
Show this page next time box before you continue. 

Result: The Measure Wizard —Choose Method page opens.

5. Complete the Measure Wizard — Choose Method page.

1. Enter a name for the measure, up to 70 characters long.

2. Choose Create an accuracy measure as the method for creating the measure.

3. Choose Next to continue.

Result: The Measure Wizard — Create Accuracy Measure page opens.

6. Complete the Measure Wizard — Create Accuracy Measure page.

1. Choose the type of accuracy measure that you want to create. You can choose 
one of the following:

• Mean Absolute Deviation (MAD) — Calculates the mean absolute 
deviation between the base measure and the comparison measure. 

• Mean Absolute Percentage Error (MAPE) — Divides MAD by the average.

• Root Mean Squared Error (RMSE) — Summarizes the overall error and 
reflects the variability in the data. The individual errors are squared, added 
together, divided by the number of individual errors, and then square 
rooted. 

• Cumulative Error (CE) — Provides a measure of the overall errors in a 
forecast when compared to actuals, or the difference between any two 
measures. This is calculated by summing the difference between the two 
measures.
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• Percent Bias (PB) — Provides a measure of the overall errors in a forecast 
when compared to actuals, or the difference between any two measures. 
This is calculated by summing the difference between two measures as a 
percentage of the base measure. 

2. Choose the measure on which to base the accuracy calculation. The label says, 
What type of accuracy measure do you want to create? For example, you might
choose a previous period forecast.

3. Choose the comparison measure for the calculation. The label says, What 
measure do you want to base the calculation on? For example, you might 
choose new sales history.

4. Choose a measure to compare to the base measure. The label saysWhat 
measure should be compared to the base measure? 

5. The Dimension/Level grid displays the levels at which Oracle Demand 
Planning will generate the accuracy measure for each dimension in your 
database. To change a level setting, choose the Level column for the dimension 
and select the level that you want to use. 

6. In the Start and End Date boxes, choose the time period over which to evaluate 
accuracy. 

The default time periods are based on the level selection for Time. If you want 
to choose time values at specific level, ensure that you select that level before 
you set dates. 

Note: Accuracy calculations will be performed at the selected 
dimension levels across the specified time range. If the base 
and comparison measures that you chose do not both have data
at these levels within the time range, then the resulting 
accuracy measure will not contain data (it will be NA). 

7. Choose Next to continue.

Result: The Measure Wizard — Properties page opens.

7. On the Measure Wizard — Properties page, you can specify whether data for the 
measure can be edited in worksheets. To make the measure editable, enable the 
Make the measure editable in worksheets box.

When you complete the Properties page, choose Next to continue.

Result: The Measure Wizard —Number Formatting page opens.

8. On the Measure Wizard — Number Formatting page, you can specify how data for 
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the measure will be displayed in documents. 

Note: The default formats reflect settings established for the plan in
the Demand Planning Server. Your changes will not impact how 
the data is written back to the Demand Planning Server.

1. You can specify the following format options:

• Decimal Digits — Specifies the number of decimal places to display. You 
can choose an alternate number.

• Positive Values — Specifies the format for positive numbers. You can select
an alternate format.

• Negative Values — Specifies the format for negative numbers. You can 
select an alternate format.

• Use Thousands Separator — Indicates whether to display the thousands 
separator. Check the box to display the thousands separator. Clear the box 
to suppress the thousands separator.

• Display Leading Zero — Indicates whether to display leading zeros. Check
the box to display leading zeros. Clear the box to suppress leading zeros.

As you make formatting choices, the Samples area on the left side of the 
page displays the effect of your choices.

2. Choose Next to continue.

Result: The Measure Wizard — Summary page opens, showing the choices that 
you have made.

9. Choose Finish to save the measure.

Creating Formula Measures
When you define a formula measure, you select the measure or measures on which to 
base the formula, specify the calculations to apply, and enter appropriate parameters.

To create a formula measure:
1. Access Oracle Demand Planning as a planner or planning manager.

2. On the Navigation toolbar, choose the New button.
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3. Choose New Measure.

Alternatively, you can click the right mouse button on the Measures folder in the 
navigation list. Then choose New Measure from the popup menu. 

Result: The Create Measure dialog box opens.

4. In the Create Measure dialog box, choose Formula Measure.

Result: The New Formula Measure dialog box opens.

5. In the name boxes, enter a short name and a long name for the measure. 

The short name can be up to 16 characters long. The long name can be up to 70 
characters long.

6. The Type box specifies the method and associated formula that will be used to 
calculate the measure. Choose the method that you want to use. You can select one 
of the following:

• Change — Calculates the change in a measure's value between the current time 
period and a previous time period. You select the measure and specify the time 
period. You can choose Prior Period, Year Ago, or Custom.

If you choose Custom, enter the number of time periods.

• Fiscal-Year-to-Date — Sums the value of a measure through the fiscal year to 
date. You select the measure.

• Lag — Calculates a measure that lags data for a specified time period. You 
select the measure and specify the time level and time period for the lag. You 
can choose Prior Period, Year Ago, or Custom. If you choose Custom, enter the 
number of time periods.

• Lead — Calculates a measure that leads data for a specified time period. You 
select the measure and specify the time level and time periods for the lead. You 
can choose Prior Period, Year Ago, or Custom. If you choose Custom, enter the 
number of enter the number of time periods

• Moving Average — Averages the values of a measure over time. You select the 
measure and specify the number of time periods to consider. 

• Moving Maximum — Finds the maximum value for a measure over time. You 
select the measure and specify the number of time periods to consider. 

• Moving Minimum — Finds the minimum value for a measure over time. You 
select the measure and specify the number of time periods to consider. 

• Moving Total — Sums the values of a measure over time. You select the 
measure and specify the number of time periods to consider.



Working with Measures     17-59

• Percent Change — Calculates the percentage change in a measure's value 
between the current time period and a previous time period. You select the 
measure and specify the previous time period. You can choose "Prior Period," 
"Year Ago," or "Custom." If you choose Custom, enter the number of time 
periods.

• Year-to-Date — Sums up the value of a measure through the current calendar 
year. You select the measure. 

• Difference — Subtracts the value of one measure from another. You select the 
measures.

• Multiplication — Multiplies the value of a measure by a numeric literal. You 
select the measure and specify the multiplier.

• Ratio — Divides the values of one measure by another. You select the 
measures.

• Sum — Adds the value of one or more measures and a numeric literal. You 
select the measure and specify the value to add.

• Index — Calculates the ratio between the current value for a dimension of the 
measure and a reference dimension value or level. You select the measure, the 
dimension, and the reference dimension value or level.

• Nested — Performs simple nested formula calculations. These formulas take 
the form (A ? B) ? (C ? D), where you can replace each letter with a measure and
each question mark with an arithmetic operator, qualified by a dimension 
value. You select the measures and specify the operators and the qualifying 
dimension values.

• Variance — Calculates the difference between the current value for a 
dimension of the measure and a reference dimension value or level. You select 
the measure, the dimension, and the reference dimension value or level.

Result: The components of the Definition box change depending on the type of
measure that you chose. 

7. To specify a starting period for the formula measure, proceed as follows:

1. Check the Beginning Period box.

2. Do one of the following:

• To use the current period as the start for your formula measure, choose the 
Current Period option.
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• To specify a specific starting period, click the Browse button and select one 
from the Date dialog box.

8. Complete the other fields in the Definition box. The information that you provide 
depends on the measure type. 

For example, if you are defining a Difference measure, you select the base measure 
and the measure to subtract.

9. To specify an additional calculation to include in the formula, proceed as follows:

1. In the Additional Calculations box, select an operator and enter a number. 

2. To specify that calculated values be positive, check Absolute Value.

10. To specify display formats for the data associated with this measure, choose Format
. 

Result: The Format Number dialog box opens.

11. In the Format Number dialog box, you can specify how data for the measure will be 
displayed in documents. You can specify the following format options:

• Decimal Digits — Specifies the number of decimal places to display. You can 
select an alternate number.

• Positive Values — Specifies the format for positive numbers. You can select an 
alternate format. 

• Negative Values — Specifies the format for negative numbers. You can select 
an alternate format. 

• Use Thousands Separator — Indicates whether to display the thousands 
separator. Check the box to display the thousands separator. Clear the box to 
suppress the thousands separator.

• Display Leading Zero — Indicates whether to display leading zeros. Check the 
box to display leading zeros. Clear the box to suppress leading zeros.

As you make formatting choices, the Samples box shows you the effect your 
choices will have on the data. 

12. If the Format Number dialog box is open, choose OK to close it. 

Result: You are returned to the New Formula Measure dialog box. 

13. Choose OK to save the measure.
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Editing Measures
You can edit the definition of any measure that is displayed in the navigation list.

Note: Editing a measure definition is distinct from editing the data for 
the measure. You use the Measures function to modify the measure 
definition. You use a worksheet to edit measure data. 

If your role is Demand Plan Manager, the modified definition will be made available to 
planners whose assignment includes the measure the next time a distribution runs, 
assuming that it is a full distribution or a quick distribution that includes the measure.

To edit a measure:
1. Access Oracle Demand Planning as a Demand Planner or Demand Plan Manager.

2. In the navigation list, identify the measure whose definition you want to change.

Note: To search for a measure, click the right mouse button on the 
Measures folder in the navigation list and choose Find from the 
popup menu. Then enter a name or name fragment. Alternatively, 
you can choose the Find button on the navigation toolbar.

3. Highlight the measure that you want to modify and choose Edit. 

Result:If you are editing a stored measure, a tabbed page opens. If you are editing a
formula measure, the Edit Formula Measure dialog box opens.

4. To edit a stored measure, use the tabs, the Next button, and the Back button to 
move through the measure definition to make your changes. You can also change 
the measure name. 

Note: If the measure is a stored accuracy measure or a measure 
from the Planning Server, you can only edit the measure name, 
specify the numeric format, and change the property that 
determines whether data for the measure will be editable in 
worksheets.

Choose Finish to save your changes and close the measure definition.

5. To edit a formula measure, view and change the measure attributes in the Edit 
Formula Measure dialog box. You can also change the measure name. 

Choose OK to save your changes. 
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Renaming Measures
You can give a new name to a measure in the navigation list. You can also rename a 
measure by editing it, as described in "Editing Measures", page 17-61.

To rename a measure in the navigation list:
1. Access Oracle Demand Planning as a Demand Planner or Demand Plan Manager.

2. In the navigation list, identify the measure that you want to rename.

Note: To search for a measure, click the right mouse button on the 
Measures folder in the navigation list and choose Find from the 
popup menu. Then enter a name or name fragment. Alternatively, 
you can choose the Find button on the navigation toolbar.

3. Click the right mouse button on the measure object and choose Rename from the 
popup menu.

4. Enter the new name. The name can be up to 70 characters long.

Viewing Measure Properties
You can use the Navigation list to view information about a measure.

Note: If you are viewing properties as a planner, you might see 
"Personal" as the Type for a measure. This means that you created the 
measure in your personal database (or edited a shared measure and 
saved it). Although you can work with personal measures in 
documents and submit them to the shared database, you will not be 
able share personal measures in a collaborative environment. 

For a Planning Server measure, the following properties are displayed:

• Name — Measure name

• Transformation — None

• Source — Planning Server

• Type — Quantity, Amount, or Quantity and Amount

• Aggregate — Yes or No
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• Allocate — Yes or No

• Editable — Yes or No

• Price List — None

• Events — None

• Lowest Allocation Levels — For each dimension, specifies the lowest level to which 
data will be allocated

For a stored measure that is a forecast or a copy of one or more measures, the following 
properties are displayed: 

• Name — Measure name

• Transformation — Method used to create the measure, for example: Forecast

• Source — Shared or Personal 

• Type — Quantity, Amount, or Quantity and Amount

• Aggregate — Yes or No

• Allocate — Yes or No

• Editable — Yes or No

• Price List — Price list name or None

• Events — Event names or None

• Lowest Allocation Levels — For each dimension, specifies the lowest level to which 
data will be allocated (depends on the data stream on which the forecast or copy is 
based)

For a stored accuracy measure, the following properties are displayed: 

• Name — Measure name

• Transformation Method — Accuracy 

• Source — Shared or Personal

• Accuracy Measure Type — Type of accuracy measure, for example, Mean Absolute 
Percentage Error (MAPE)

• Base Measure — Base measure for accuracy calculation 
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• Comparison Measure — Comparison measure for accuracy calculation

• Editable — Yes or No

For a formula measure, the following properties are displayed:

• Name — Long name for the measure

• Transformation — Formula

• Source — Shared or Personal

To view measure properties:
1. Access Oracle Demand Planning as a Demand Planner or Demand Plan Manager.

2. In the navigation list, identify the measure whose information you want to view.

Note: To search for a measure, click the right mouse button on the 
Measures folder in the navigation list and choose Find from the 
popup menu. Then enter a name or name fragment. Alternatively, 
you can choose the Find button on the navigation toolbar.

3. Click the right mouse button on the measure object and choose Properties from the 
popup menu.

Deleting Measures
When you longer need access to a measure, you can delete it. 

Note: Before you delete a measure, ensure that there are no saved 
objects that reference it. If you fail to do this, warning messages and 
errors can occur when you work with reports, graphs, worksheets, or 
alerts that contain the deleted measure. If your role is Demand Plan 
Manager, also ensure that planners do not have saved objects that 
reference the measure.

To delete a measure:
1. Access Oracle Demand Planning as a Demand Planner or Demand Plan Manager.

2. In the Navigation list, identify the measure that you want to delete.

Note: To search for a measure, click the right mouse button on the 
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Measures folder in the navigation list and choose Find from the 
popup menu. Alternatively, you can choose the Find button on the 
navigation toolbar.

3. Click the measure object and choose the Delete button on the navigation toolbar.

4. Alternatively, you can click the right mouse button on the measure and choose 
Delete from the popup menu.

Result: You will be prompted to confirm the deletion.

Importing Data into a Measure from a Flat File
An import feature enables you "read" data from a flat file into a measure. You might use
this feature to bring in data for a customer forecast that is in an ASCII file. You might 
also use this feature to integrate data from internal collaborators such as Sales or 
Marketing that has been converted to comma delimited (CSV) format.

General requirements for import file
Any file from which you import data must meet the following general requirements: 

• Data for each dimension must be consistent in terms of level. For example, time 
values must all be in days, or all in weeks, or all in months. You cannot import 
some time values in days and others in weeks or months.

• Data must be within the time range of the measure that you define for the data.

• Data must have a consistent unit of measure (quantity or amount) and must not be 
a negative number.

• Data must have a display format that is consistent with the language setting for the 
browser. 

Format requirements for import file
The first record of an import file is the template record. The template record defines the 
format for all of the records that follow. The required format for the template record is 
as follows:

• delimiter space delimiter first dimension name delimiter second dimension name 
delimiter third dimension name delimiter (if the data model has four dimensions) 
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fourth dimension name (if the data model has four dimensions) end delimiter

Format requirements for all records after the template record are as follows:

• value of the first dimension delimiter value of the second dimension delimiter value
of the third dimension delimiter value of the fourth dimension (if the data model 
has four dimensions) delimiter (if the data model has four dimensions) quantity or 
amount value delimiter (if optional comment is included) optional comment (not 
supported in this release)

Restrictions on Character Usage
There are certain characters that must not appear in import files. They are the following:

• Single quote 

• Back slash

Also, the following rules apply for import files:

• You may not use any alphanumeric character used in data or dimension names (0-9,
a-z, A-Z) as a delimiter.

• If you are importing decimal values, you can not use the decimal separator.

• If you are importing values with a thousands separator, you can not use the 
thousands separator.

• You can not use ',' or '.' as a separator.

To import data from a flat file into a measure:
1. Access Oracle Demand Planning as a Demand Planner or Demand Plan Manager.

2. Create a stored measure and ensure that the measure is editable. You will use this 
measure to "hold" the data from the flat file. 

For example, you might create a measure that is a copy of another measure. 

3. Ensure that the data in the import file meets requirements. For more information, 
see "General requirements for import file", page 17-65 and "Format requirements for
import file", page 17-65.

4. On the navigation toolbar, choose the Tools button.

5. From the submenu, choose Import Data.

Result: The File to Import dialog box opens.
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6. In the File to Import dialog box, browse to the flat file from which you want to 
import data and choose Open. 

Result: the Select Measure dialog box opens. 

7. In the Select Measure dialog box, select the measure that you created in Step 2 and 
proceed as follows:

• Choose Quantity if the file contains values for quantity.

• Choose Amount if the file contains values for amount. 

8. Choose OK to import the file.

Result: The import process begins. If there are minor errors, the Import Errors 
dialog box opens, with a description of the problems. You can choose to terminate 
the import or to continue. If the file format does not meet requirements, an error 
message appears and data is not imported.

Example: Import file
The excerpt below is from a sample import file with four dimensions. Additional 
seeded dimensions could include the following:

• Sales Channel 

• Sales Representative

• User Defined Dimension1

• User Defined Dimension2

:: ::Time::Product::Ship to Location::Geography

31-MAR-2003::CM25287::Boston Manufacturing::Vision-Boston::104

30-MAR-2003::CM25287::Boston Manufacturing::Vision-Boston::105

29-MAR-2003::CM25287::Boston Manufacturing::Vision-Boston::106

28-MAR-2003::CM25287::Boston Manufacturing::Vision-Boston::107

27-MAR-2003::CM25287::Boston Manufacturing::Vision-Boston::108

26-MAR-2003::CM25287::Boston Manufacturing::Vision-Boston::109

25-MAR-2003::CM25287::Boston Manufacturing::Vision-Boston::100
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24-MAR-2003::CM25287::Boston Manufacturing::Vision-Boston::101

23-MAR-2003::CM25287::Boston Manufacturing::Vision-Boston::102

22-MAR-2003::CM25287::Boston Manufacturing::Vision-Boston::103

21-MAR-2003::CM25287::Boston Manufacturing::Vision-Boston::104

20-MAR-2003::CM25287::Boston Manufacturing::Vision-Boston::105

19-MAR-2003::CM25287::Boston Manufacturing::Vision-Boston::106

18-MAR-2003::CM25287::Boston Manufacturing::Vision-Boston::107

17-MAR-2003::CM25287::Boston Manufacturing::Vision-Boston::108

16-MAR-2003::CM25287::Boston Manufacturing::Vision-Boston::109

15-MAR-2003::CM25287::Boston Manufacturing::Vision-Boston::100

14-MAR-2003::CM25287::Boston Manufacturing::Vision-Boston::101

13-MAR-2003::CM25287::Boston Manufacturing::Vision-Boston::102

12-MAR-2003::CM25287::Boston Manufacturing::Vision-Boston::103

11-MAR-2003::CM25287::Boston Manufacturing::Vision-Boston::104

10-MAR-2003::CM25287::Boston Manufacturing::Vision-Boston::105

09-MAR-2003::CM25287::Boston Manufacturing::Vision-Boston::106

08-MAR-2003::CM25287::Boston Manufacturing::Vision-Boston::107

07-MAR-2003::CM25287::Boston Manufacturing::Vision-Boston::108

06-MAR-2003::CM25287::Boston Manufacturing::Vision-Boston::109

05-MAR-2003::CM25287::Boston Manufacturing::Vision-Boston::100
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18
Working with Events

This chapter covers the following topics:

• About Events

• Creating Promotion Events

• Creating Product Introduction Events

• Creating Product Phase out Events

• Modifying Events

• Viewing Event Properties

• Deleting Events

• Applying Events to Measures

• Using the Events Calendar

About Events
Events are factors such as promotions, product introductions, and product phase outs 
that are expected to have a quantifiable impact on demand. You can apply events to 
forecasts to model the effect on demand. 

You can view existing events, define new events, edit events, delete events, and apply 
event factors to measures. 

Note: Events are downloaded with four user dimensions: geography, 
product, time, and organization. Collapsed dimensions like demand 
class are downloaded as a hierarchy of one of the user dimensions (like 
geography). Although the event works with the collapsed dimension, 
the collapsed dimension name is not shown as the event qualification in
the shared database.
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Working with events as Demand Plan Manager
If your responsibility is Demand Plan Manager, you work with events in the shared 
database. When you create a new event, the event exists in the shared database. You 
have access to the event, but it will only become available to planners when the 
Demand Plan Administrator runs a distribution. All events will be available to planners
when a full distribution runs; only events associated with distributed measures will be 
available when a quick distribution runs. 

Working with events as Demand Planner
If your responsibility is Demand Planner, you work with events in your personal 
database. You can use events that have been distributed to you. You can also create new
events, to which only you have access.

Creating Promotion Events
A promotion is an event that is expected to impact demand for an existing product. You
characterize a promotion as mandatory or optional. A mandatory promotion is always 
applied, whether or not other promotions have been applied. An optional promotion is 
applied only when there is there is no other optional promotion for the same portion of 
the data (product and other dimension values).

To create a promotion event:
1. Access Oracle Demand Planning as a Demand Planner or Demand Plan Manager.

2. On the Navigation toolbar, choose the New button. 

3. Choose New Event from the popup menu. 

Alternatively, you can click the right mouse button on the Events folder in the 
Navigation list. Then choose New Event from the popup menu. 

If you see the Event Wizard - Introduction page, choose Next to continue.

Note: To suppress the display of this page in the future, clear the 
Show this page next time box before you continue. 

Result: The Event Wizard - Name page opens.

4. Complete the Event Wizard - Name page.

1. Enter a name for the event, up to 70 characters long.
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2. Choose Promotion as the event type.

3. In the date boxes for Event Range, specify the starting date and the ending date
for the promotion. Select the part of the date (month, day, or year) that you 
want to change and then click the arrow to increase or decrease the value.

4. Choose Next to continue.

Result: The Event Wizard - Type page opens.

5. Complete the Event Wizard - Type page.

1. Select the promotion type. The promotion type determines the circumstances in
which the event will be applied to a measure. 

• Optional Promotion — The event will be applied only when no other 
optional promotions for the same portion of the data (product and other 
dimensions) have been applied. 

• Mandatory Promotion — The event will always be applied for the specified
portion of the data.

2. Choose Next to continue.

Result: The Event Wizard - Group page opens.

6. Use the Event Wizard - Group page to specify a grouping option for the event. You 
can use groups to organize similar types of events into event folders in the 
Navigation list. 

1. Choose one of the following grouping options:

• Do not group — The event is not in any group. It will be displayed as an 
independent event object in the Navigation list. This is the default for a new
event.

• Create new event group — The event is in a new group. Enter a name for 
the group, up to 70 characters long. The event will be displayed in an event 
folder in the Navigation list. The folder will have the name that you enter 
for the group.

• Use existing event group — The event will be displayed in the group 
folder that you choose. (If no event groups have been defined, this option 
will not be available.)

Note: You can group a mandatory promotion with other 
mandatory promotions and an optional promotion with 
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other optional promotions. However, you cannot put a 
mandatory promotion and an optional promotion in the 
same group.

2. Choose Next to continue.

Result: The Event Wizard - Priority page opens.

7. Use the Event Wizard - Priority page to specify the priority for the event when 
another event of the same type is applied to the same measure. The priority will be 
evaluated relative to the priorities of other events. 

1. Examine the Promotion/Priority grid to view the priority settings for other 
events. 

2. Using the slider, set a priority for the new event. 

For mandatory promotions, the priority setting determines the order in which 
the events will be applied.

For example, if two mandatory promotions are defined for the same time 
period, one at the All Product level with a 10% modification factor (priority 1) 
and the second for Product A with a 20% modification factor (priority 2), the 
result would be a lift of 10% for all products except for Product A, which would
have a 20% lift on top of the 10% lift.

For optional promotions, the priority setting determines the order in which 
multiple promotions will be applied when there is an overlap. 

For example, suppose that a soda vendor has a 10% discount on cans in North 
America (priority 1), and a 5% worldwide discount on all products (priority 2). 
This means that North American buyers will get 10% off cans, and 5% off other 
products, while consumers in the rest of the world will still get 5% off 
everything. 

Note: If you set the same priority for two events, then Oracle 
Demand Planning will assign the priority to the event that was 
created first. 

3. Choose Next to continue.

Result: The Event Wizard - Properties page opens.

8. Use the Event Wizard - Properties page to specify the product to which the 
promotion applies and set optional qualifying values. Proceed as follows:

1. Select a product:
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• Click the ellipsis button next to the top box.

Result: The Dimension Value Selector dialog box opens, listing the products 
in the hierarchy displayed in the Organize by box. 

• You can change the hierarchy in the Organize by box to view values in 
another product hierarchy.

• Select a product from the list. To apply the event to all products, choose All 
Products. You can use the Find button to search for a specific product.

Note: If you want to apply the event to multiple products, 
you can define similar events for the products and group 
the events together.

2. You can qualify the event by values in dimensions other than Product. For 
example, you might limit the event to a specific geography. Proceed as follows:

• In the Dimension column of the Dimension/Value grid, highlight the 
dimension for which you want to set qualifying values and choose Edit. 

Result: The Dimension Value Selector dialog box opens. The list displays 
values for the hierarchy in the Organize by box. 

• You can select an alternate hierarchy and view its values.

• Choose a value and choose OK. 

Result: You are returned to the Properties page.

Note: To change a qualifying value, highlight it and choose 
Edit. To delete a qualifying value, highlight it and choose 
Delete. 

3. To select a qualifying value for another dimension, repeat the procedure 
described above.

4. Choose Next to continue.

Result: The Event Wizard - Action page opens.

9. Use the Event Wizard - Action page to specify the effect that the promotion event 
will have when it is applied to a measure. 

1. In the Quantities box, specify the effect of the event on quantity. Choose one of 
the following options:
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• No effect — The event will have no effect on quantity.

• Increase value by — The event will increase quantity by a number or 
percentage that you specify.

• Decrease value by — The event will decrease quantity by a number or 
percentage that you specify.

• Set to absolute value — The event will set quantity to a number that you 
specify.

2. If you chose Increase value by, Decrease value by, or Set to absolute value, 
enter a number. For Increase value by and Decrease value by, check the 
percent box to indicate that the number is a percentage.

Result: The Example box shows the effect that your choice will have on a 
quantity of 1000.

3. In the Price box, specify the effect of the event on price. Choose one of the 
following options:

• No effect — The event will have no effect on price.

• Increase value by — The event will increase price by a number or 
percentage that you specify.

• Decrease value by — The event will decrease price by a number or 
percentage that you specify.

• Set to absolute value — The event will set price to a figure that you specify.

4. If you chose Increase value by, Decrease value by, or Set to absolute value, 
enter a number. For Increase value by or Decrease value by, check the percent 
box to indicate that the number is a percentage. 

Result: The Example box shows the effect that your choice will have on a price 
of $1000.

5. Choose Next to continue.

Result: The Event Wizard - Summary page opens, showing the choices that you 
have made.

10. Choose Finish to save the event.

Distinguishing Promotional Demand from Regular Demand
After promotional sales history has been collected into Demand Planning, it is possible 
to compute the baseline demand history by subtracting promotional demand from total 
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demand. 

Deriving this measure provides a useful basis for generating an undistorted, accurate 
baseline demand forecast upon which proposed promotional lifts by brands, territories, 
and sales channels can be applied. 

This process can prevent excess inventory or stock outs. The normal forecasts of 
booking or shipment histories may not be sufficient if a reduction in future promotions 
causes excess inventory, or an increase in future promotions causes stock-outs.

Promotional History
The System Administrator uses the Custom Stream Collection form to select 
Promotional History. Oracle Demand Planning has promotional history pertaining to 
the following:

• Discounts

• Price Break Headers (Such as a 5% discount on orders of more than 50 tons)

• Promotional Goods

The sales history that drives the identification of the data stream will either be booking 
history or shipping history.

Note: Promotional History is described in the chapter on Data 
Collection .

Differentiating Promotional and Regular Demand
Differentiating promotional from regular demand is a process that begins outside 
Oracle Demand Planning.

1. Sales orders from customers' ERP systems provide source data; promotional 
discounts and adjustments are applied and weighed in Oracle Advanced Pricing.

2. The next step is to bring promotional history into Oracle Demand Planning.

3. Promotional history is treated as a data stream in the Demand Planning Server. 

• The Demand Planning System Administrator uses the Input Parameters tab in 
the Demand Plans form.

• The Administrator can build the input parameter by using various 
combinations of booking or shipping histories.

• The demand plan is built.

4. If your enterprise has a forecasting process based on historical sales, it is very useful
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to evaluate demand for product sales by using promotional history to create an 
analysis. The general steps for this analysis are:

1. Analyze the promotional history and forecast it.

2. The demand planner will use this plan with promotional history to analyze 
promotional sales, and then to forecast them. The object is to forecast 
promotional lifts, and then compare them to the baseline forecasts.

3. Once the demand plan is built, a demand planner can use it to analyze and 
forecast promotional history and then can publish the forecast for use in supply
planning. First however, several measures must be created for use as analytical 
tools, as described below.

5. Create a formula measure for baseline sales. The methodology for creating formula 
measures, page 17-57 is discussed in the chapter on working with measures. The 
current formula is a difference measure created by subtracting promotional history 
from booking history.

6. Create a formula measure for historical promotional lifts. This is a ratio measure, 
expressed as a percentage, which is created by dividing promotional history 
booking by baseline sales.

7. Use the Measure Wizard to forecast baseline sales. The process of creating a forecast
measure, page 17-5 is described in the chapter on working with measures.

8. Open a Demand Planning worksheet that displays the three measures described 
above (baseline sales, promotional lifts, and baseline forecast) in a configuration 
that enables you to estimate future promotional lifts and apply them to the baseline 
forecast. Two approaches are described below.

• Create events with the Events Wizard, page 18-2 that represent appropriate 
modification factors for promotional lift. Then rerun the forecast, using the 
Events page of the Measure Wizard to apply the events to the existing forecast 
measure.

• Increase the baseline forecast by applying the appropriate percentages 
manually. This can be done in a the demand planning worksheet by using the 
data modification tools, page 11-14.

Creating Product Introduction Events
A product introduction is an event for a product that does not have any historical or 
forecast data, but for which you anticipate that sales will be similar to some product or 
products that have a known history or forecast. You characterize a product introduction
as a lifecycle event or a supersession event. For a lifecycle event, the historical sales data 
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for one or more base products is used as the basis of demand for the new product. For a 
supersession event, the forecast for one or more base products is used to determine 
demand for the new product. You can also indicate whether the event is expected to 
cannibalize sales for one or more existing products.

To create a product introduction event:
1. Access Oracle Demand Planning as a Demand Planner or Demand Plan Manager.

2. On the Navigation toolbar, choose the New button.

3. Choose New Event from the popup menu. 

Alternatively, you can click the right mouse button on the Events folder in the 
Navigation list. Then choose New Event from the popup menu. 

If you see the Event Wizard -- Introduction page, choose Next to continue.

Note: To suppress the display of this page in the future, clear the 
Show this page next time box before you continue. 

Result: The Event Wizard - Name page opens.

4. Complete the Event Wizard - Name page.

1. Enter a name for the event, up to 70 characters long.

2. Choose Product Introduction as the event type.

3. In the date boxes for Event Range, specify the starting date and the ending date
for the product introduction. Select the part of the date (month, day, or year) 
that you want to change and click the arrow to increase or decrease the value.

4. Choose Next to continue.

Result: The Event Wizard - Type page opens.

5. Complete the Event Wizard - Type page.

1. Select the product introduction type. The product introduction type determines 
the basis for predicting demand for the new product. Choose one of the 
following:

• Lifecycle— Uses the history for a specified base product to derive demand 
for the new product. 
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• Supersession — Uses the forecast for a specified base product to predict 
demand for the new product.

There are two radio buttons beneath the Supersession choice. These are 
described below.

Based on the individual histories of base products — These introductions 
assume that a forecast for the new product can be based solely on the 
history of the base product.

Based on combined histories of new and base products — These 
introductions assume that a forecast for the new product must be based on 
a combination of data for new and base products.

2. Choose Next to continue.

Result: The Event Wizard - Group page opens.

6. Use the Event Wizard - Group page to specify a grouping option for the event. You 
can use groups to organize similar types of events into event folders in the 
Navigation list. 

1. Choose one of the following grouping options:

• Do not group — The event is not in any group. The event will be displayed 
as an independent event object in the Navigation list. This is the default for 
a new event.

• Create new event group — The event is in a new group. Enter a name for 
the group, up to 70 characters long. The event will be displayed in an event 
folder in the Navigation list. The folder will have the name that you enter 
for the group.

• Use existing event group — The event will be displayed in the group 
folder that you choose. (If no event groups have been defined, this option 
will not be available.)

Note: You can group a lifecycle product introduction with 
other lifecycle product introductions and a supersession 
product introduction with other supercsession 
introductions. However, you cannot put a lifecycle product
introduction and a supersession product introduction in 
the same group.

2. Choose Next to continue.

Result: The Event Wizard - Properties page opens.
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7. Use the Event Wizard - Properties page to specify the product to which the product 
introduction event applies and set optional qualifying values. Proceed as follows:

1. Select a product:

• Click the Ellipsis button next to the top box.

Result: The Dimension Value Selector opens, listing available products. 

• Choose a product from the list. You can use the Find button to search for a 
specific product.

Note: If you want to apply the event to multiple products, 
you can define similar events for these products and group 
the events together.

2. You can qualify the event by values in dimensions other than Product. For 
example, you might limit the event to a specific geography. Proceed as follows:

• In the Dimension column of the Dimension/Value grid, highlight the 
dimension for which you want to set qualifying values and choose Edit. 

Result: The Dimension Value Selector dialog box opens. The list displays 
values for the hierarchy in the Organize by box. 

• You can select an alternate hierarchy and view its values.

• Select a value and choose OK. 

Result: You are returned to the Properties page.

Note: To change a qualifying value, highlight it and choose 
Edit. To delete a qualifying value, highlight it and choose 
Delete.

3. To select a qualifying value for another dimension, repeat the procedure 
described above.

4. Choose Next to continue.

Result: The Event Wizard - Action page opens.

8. Use the Event Wizard - Action page to specify the effect that the product 
introduction event will have when it is applied to a measure.

Note: The action that you specify on this page will be applied on top
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of the weight that you will assign to the base product's history (for a
lifecycle event) or forecast (for a supersession event) in Step 8. 

1. In the Quantities box, specify the effect of the event on quantity. Choose one of 
the following options:

• No effect — The event will have no effect on quantity.

• Increase value by — The event will increase quantity by a number or 
percentage that you specify.

• Decrease value by — The event will decrease quantity by a number or 
percentage that you specify.

Result: The Example box shows the effect that your choice will have on a 
quantity of 1000.

2. If you chose Increase value by or Decrease value by, enter a number. Check 
the percent box to indicate that the number is a percentage.

3. Choose Next to continue.

Result: The Event Wizard - Base Products page opens.

9. Use the Event Wizard - Base Products page to or products that will be used to 
predict demand for the new product. If you chose Lifecycle in an earlier step, then 
Oracle Demand Planning will base the calculation on the product's history. If you 
chose Supersession, then Oracle Demand Planning will base the calculation on data
from whichever choice you make among the two Supersession options.

The Based on individual histories of base products option uses the historical 
demand of the products you kept from the Base Products step. The Based on 
combined histories of new and base products option takes advantage of the 
feature that enables you to transfer the history of a superseded service part to the 
new product that replaces it. You can then create forecast of a item based on the 
history of the superseded item, then Oracle Demand Planning will base the 
calculation on the product's forecast. 

1. Choose Add.

Result: The Dimension Value Selector dialog box opens showing available 
products.

2. Select a product from the list and choose OK.

Result: The Dimension Value Selector dialog box closes. The product that you 
chose is displayed in the grid.
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3. In the Weight (%) column, enter a number that specifies the percentage of the 
product's forecast (for a supersession event) or history (for a lifecycle event) to 
consider when calculating demand for the new product. The default is 100.

Examples: If 0.0 applies no weight to the product's forecast or history; 50.0 
applies 50% of the value to the product's forecast or history; 100.0 applies the 
full value of the forecast or history; 150.0 applies 150% of the value of the 
forecast or history.

4. You can enter dates in the History Start and History End columns. When you 
click in a blank history cell, Demand Planning enters the current date and a 
spinner that enables you to scroll forward or backward in time.

5. If you do not enter information in some columns in this step, Demand Planning 
will attempt to provide intelligent defaults.

6. You can qualify the forecast or history for the base product by values in 
dimensions other than Product. For example, you might limit the forecast or 
history by geography. Proceed as follows:

• Highlight the column for the dimension for which you want to set 
qualifying values and choose Edit. 

Result: The Dimension Value Selector dialog box opens. The list displays 
values for the current hierarchy in the Organize by box. 

• You can select an alternate hierarchy and view its values.

• Select a value and choose OK. 

Note: To change a qualifying value, highlight it and choose 
Edit. To delete a qualifying value, highlight it and choose 
Delete.

7. When your selections are complete, choose OK.

Result: The Event Wizard - Cannibalized Products page opens.

10. If you expect that demand for the new product will decrease demand for one or 
more existing products, use the Event Wizard - Cannibalized Products page to specify
the affected products and quantify the impact. 

1. Choose Add.

Result: The Dimension Value Selector dialog box opens.

2. Select a product from the list and choose OK. You can use the Find button to 
search for a specific product.
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Result: The Dimension Value Selector dialog box closes. The product that you 
chose is displayed in the grid.

3. In the Modification Type column, select a choice from among Decrease by 
Percentage and Decrease by Percentage of New Item.

.

4. In the Decrease (%) column, enter a number that specifies the percentage that 
demand for this product is expected to decrease within a specified time frame. 

Note: The decrease percentage will be applied to the new 
product and the result subtracted from the quantity for the 
"cannibalized" product.

5. In the From and To columns, select the start and end dates for the decrease. 

6. To add another cannibalized product, repeat the earlier steps.

7. Choose Next to continue.

Result: The Event Wizard - Summary page opens, showing the choices that you 
have made.

11. Choose Finish to save the event.

New Product Introduction Event Allocation
Oracle Demand Planning enables managers and planners to plan new product 
introductions based on the life cycle of base products. Base products are first modified 
in such a way that the allocation of new product demands is restricted to the base 
products' customers and markets. For example, if you introduce a new product and 
allocate its demand based on a base product that sells to 15 out of your customer base of
2000, the new product's forecast will be reflect demand only for those 15 customers.

The Benefits of New Product Introduction Event Allocation
Restricting the new product demand allocation as described above has two distinct 
advantages: 

• It allows a new product to be introduced for only the geographic regions, sales 
channels, and customers that apply to the base products.

• It provides more accurate allocation of new product demand across regions, sales 
channels, and customers.
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Aggregation Rules for New Product Introduction Allocation
The aggregation rules for base products in a new product introduction are sometimes 
different from the base products. Several different methods, described below, are used 
to remedy problems that may arise from this situation.

In the forecast measure for Lifecycle events, data at the application levels for the new 
product are a weighted combination of data for base products at specified dimension 
levels, for corresponding history periods in the historical measure. 

The copied data value are allocated down non-time, non-product dimensions based on 
the historical data of the base products in the specified regions and history period.

In the forecast measure for Supersession events, which are based on forecast instead of 
history, data at the application levels for the new product are a weighted combination 
of the data for the base products at specified dimension levels. 

The copied data values are allocated down non-time, non-product dimensions based on
data of the base products in the specified regions. There is no shift in the time 
dimension.

Using New Product Introduction Allocation
To use New Product Introduction Allocation, use the steps described in the procedure 
for Creating Product Introduction Events., page 18-8 When you get to the Properties Page
of the Event Wizard, perform the actions described below. 

1. Next to the box labeled Choose the product to which this event will apply, click 
the Ellipsis button to select a product value from the Dimension Value Selector dialog 
box.

2. In the Dimension/Value grid, you can specify a qualifying value that will limit the 
event to a particular geography. If the Value cell for the Geography dimension is 
blank, the default value, All Geographies is used.

3. Select the Value cell for Geography and choose Edit. You access the Dimension Value 
Selector dialog box for the geography dimension, where you can select a geography 
value. If there is another dimension in the grid, such as Ship from Location, you can 
select a qualifying value for that dimension as well. 

The Delete button removes the displayed value from the cell you have selected.

4. Click Next to proceed to the Action step of the Event Wizard. Continue creating 
your new product introduction event.

5. When you select the base product in the Base Products step, the following will be 
true for the product you selected at the beginning of the Base Products step:

• The new product introduction event will limit the introduction to the geographic 
regions that apply to the base product.
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• The new product's forecast will be allocated based on the history of the base 
product instead of All Products.

Creating Product Phase out Events
A product phase out is an event for an existing product for which sales are expected to 
become flat or be reduced to zero.

A single phase out event models a linear decrease in which demand for the product 
decreases evenly over the event time period. To model a situation in which demand 
decreases in a non-linear fashion, you can define multiple phase out events for the same
product and group the events together. For example, you can use multiple events to 
handle a situation in which demand is expected to decline 10% in October, 20% in 
November, and 30% in December.

To create a product phase out event:
1. Access Oracle Demand Planning as a Demand Planner or Demand Plan Manager.

2. On the Navigation toolbar, choose the New button.

3. Choose New Event from the popup menu. 

Alternatively, you can click the right mouse button on the Events folder in the 
Navigation list. Then choose New Event from the popup menu. 

If you see the Event Wizard - Introduction page, choose Next to continue.

Note: To suppress the display of this page in the future, clear the 
Show this page next time box before you continue. 

Result: The Event Wizard - Name page opens.

4. Complete the Event Wizard - Name page.

1. Enter a name for the event, up to 70 characters long.

2. Choose Product Phase out as the event type.

3. In the date boxes for Event Range, specify the starting date and the ending date
for the product phase out. Select the part of the date (month, day, or year) that 
you want to change and click the arrow to increase or decrease the value.

4. Choose Next to continue.
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Result: The Event Wizard - Group page opens.

5. Use the Event Wizard - Group page to specify a grouping option for the event. You 
can use groups to organize similar types of events into event folders in the 
Navigation list. 

1. Choose one of the following grouping options:

• Do not group — The event is not in any group. The event will be displayed 
as an independent event object in the Navigation list. This is the default for 
a new event.

• Create new event group — The event is in a new group. Enter a name for 
the group, up to 70 characters long. The event will be displayed in an event 
folder in the Navigation list. The folder will have the name that you enter 
for the group.

• Use existing event group — The event will be displayed in the group 
folder that you choose. (If no event groups have been defined, this option 
will not be available.)

Result: The Event Wizard - Properties page opens.

6. Use the Event Wizard - Properties page to specify the product to which the product 
phase out event applies and set optional qualifying values. 

1. Select a product:

• Click the ellipsis button next to the top box.

Result: The Dimension Value Selector opens, listing the products in the 
hierarchy displayed in the Organize by box. 

• You can change the hierarchy in the Organize by box and view values in 
another product hierarchy.

• Choose a product from the list. To apply the event to all products, choose 
All Products. You can use the Find button to search for a specific product.

2. You can qualify the event by values in dimensions other than Product. For 
example, you might limit it by geography. Proceed as follows:

• Highlight the column for the dimension for which you want to set 
qualifying values and choose Edit. 

Result: The Dimension Value Selector dialog box opens. The list displays 
values for the current hierarchy in the Organize by box. 
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• You can select an alternate hierarchy and view its values.

• Select a value and choose OK. 

Note: To change a qualifying value, highlight it and choose 
Edit. To delete a qualifying value, highlight it and choose 
Delete.

3. Choose Next to continue.

Result: The Event Wizard - Action page opens.

7. Use the Event Wizard - Action page to specify how the product phase out event will
decrease quantity when it is applied to a measure. 

1. In the Quantities box, enter a number. Check the percent box to indicate that 
the number is a percentage.

Result: The Example box shows the effect that your choice will have on a 
quantity of 1000.

2. Choose Next to continue.

Result: The Event Wizard - Summary page opens, showing the choices that you 
have made.

8. Choose Finish to save the event.

Modifying Events
When you want to change some aspect of an event, you can edit the event. 

If your role is Demand Plan Manager, the modified event will be made available to 
planners when a distribution runs. All events will be available when a full distribution 
runs; only events applied to distributed measures will be available when a quick 
distribution runs. 

To edit an event:
1. Access Oracle Demand Planning as a Demand Planner or Demand Plan Manager.

2. In the Navigation list, identify the event that you want to change.

Note: To search for an event, click the right mouse button on the 
Events folder in the Navigation list and choose Find from the 
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popup menu. Then enter a name or name fragment. Alternatively, 
you can choose the Find button on the Navigation toolbar.

3. Select the event and choose Edit. 

Result: A tabbed page opens. 

4. Use the tabs, the Next button, and the Back button to move through the event 
definition to make your changes. You can also change the event name. 

Note: You cannot change the event type.

5. Choose Finish to save the event.

Viewing Event Properties
In the Navigation list, you can view the following information about events:

• Name

• Start Date

• End Date

• Event Type

To view event properties:
1. Access Oracle Demand Planning as a Demand Planner or Demand Plan Manager.

2. In the Navigation list, identify the event whose information you want to view.

Note: To search for an event, click the right mouse button on the 
Events folder in the Navigation list and choose Find from the 
popup menu. Then enter a name or name fragment. Alternatively, 
you can choose the Find button on the Navigation toolbar.

3. Click the right mouse button on the event object and choose Properties from the 
popup menu.

Deleting Events
When you no longer want to maintain an event, you can delete the event.
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Note: If you delete an event as a Demand Plan Manager, planners will 
lose access to the event the next time that a full distribution runs. Before
deleting, ensure that planners do not maintain measures that reference 
the event.

To delete an event:
1. Access Oracle Demand Planning as a Demand Planner or Demand Plan Manager.

2. In the Navigation list, identify the event that you want to delete. 

3. Highlight the event and choose Delete.

Result:You are prompted to confirm the deletion.

4. Choose OK.

Applying Events to Measures
As you define a measure, you have the option to apply one or more events, event 
groups, or a combination of events and groups to the measure. 

If you are working as a Demand Plan Manager and apply an event to a measure before a 
distribution runs, then the distributed measure will include the event factor.

If you apply an event after a distribution runs, the measure will not include the event 
factor until the measure is repopulated. Similarly, if you modify an event that has been 
applied to a measure after distribution, the modification will not take effect until the 
measure is repopulated. 

For information about the effect of events on measures, see "Effect of Events on 
Measures", page A-5.

Using the Events Calendar
The Events Calendar enables you to view information about events that are currently 
associated with your demand plan. You can view events by month and by week. You 
can also view events that have been associated with specific measures. This can be 
useful when you are defining a stored measure or working with a measure that has an 
event component. 

Viewing a monthly display of events
You use the Events Calendar to view a monthly display of events.
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To view events by month:
1. Access Oracle Demand Planning as a Demand Planner or Demand Plan Manager.

2. On the Navigation list toolbar, choose the Tools button.

3. From the submenu, choose Events Calendar.

Result: The Events Calendar display is opened.

The Month tab displays event information for the current month. 

4. Ensure that the View events list button is active. 

5. Choose Previous to go back one month. Choose Next to go forward one month.

6. To view more information about a specific event, proceed as follows: 

1. Choose the event in the calendar.

Result: The selected event is highlighted in the right frame. 

2. Double-click the event.

Result: The Event Wizard opens, where you can view (and optionally edit) the 
event definition. 

7. To expand the calendar display, disable the View events list button.

Result:The right frame closes and the calendar display enlarges.
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Example: Display of events by month
You can view the events for a selected month in the Events Calendar. In this example, 
the View Events list option is enabled. The left frame displays the daily events for the 
month. The right frame displays all events that have been associated with the demand 
plan.
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Viewing events by year
You can use the Events Calendar to view a yearly display of events.

To view events by year:
1. Access Oracle Demand Planning as a Demand Planner or Demand Plan Manager.

2. On the Navigation list toolbar, choose the Tools button. 

3. From the submenu, choose Events Calendar.

Result: The Events Calendar opens. The Month tab displays event information for 
the current month. 

4. Make the Year tab active. 

Result:The calendar frame on the left displays the events by year.

5. In the Number of years box, choose the number of years for which to display 
events.
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Result: Each event that falls within the selected time period displays as a colored 
horizontal bar beneath the appropriate year. The event time span is indicated by the
placement of the bar.

6. Ensure that the View events list button is active. 

7. Choose Previous to go back one year. Choose Next to go forward one year.

8. To view more information about an event, proceed as follows: 

1. Choose the event in the calendar.

Result: The selected event is highlighted in the right frame. 

2. Double click the event.

Result: The Event Wizard opens, where you can view (and optionally edit) the 
event definition. 

9. To expand the calendar display, disable the View events list button.

Result:The right frame closes and the calendar display enlarges.
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Example: Events calendar for year
In the Events Calendar, you can view the events for a selected year too. In this example, 
the View Events list option has been disabled so that only the calendar displays.
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Viewing events for a measure
You can use the Events Calendar to view all of the events that are related to a specific 
measure.

To view the events for a measure:
1. Access Oracle Demand Planning as a Demand Planner or Demand Plan Manager.

2. On the Navigation list toolbar, choose the Tools button.

3. From the submenu, choose Events Calendar.

Result: The Events Calendar opens. The Month tab displays event information for 
the current month. 

4. Ensure that the View events list button is enabled.

Result: The right frame displays all events that are linked to the demand plan.

5. Choose the Filter Events by Measure button.
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6. Result:The Choose a Measure dialog box opens. The list shows measures that have 
been defined for the demand plan. These might be Planning Server measures or 
measures in the shared database. If your responsibility is Demand Planner, they 
might be measures that you have defined.

7. Select a measure from the list and choose OK.

Result:The right panel now displays only those events that have been linked to the 
selected measure. The measure name appears at the bottom of the frame.

8. To view more information about the event, double-click it.

Result: The Event Wizard opens, where you can view (and optionally edit) the 
event definition. 
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19
Working with Custom Aggregates

This chapter covers the following topics:

• About Custom Aggregates

• Defining Custom Aggregates

• Applying Custom Aggregates to Open Documents

• Editing Custom Aggregates

• Renaming Custom Aggregates

• Viewing Custom Aggregate Properties

• Deleting Custom Aggregates

About Custom Aggregates
A custom aggregate is a single dimension value that combines multiple values for a 
dimension. When you work as a Demand Planner or Demand Plan Manager, you can 
create custom aggregates and use them in worksheets, reports, and graphs. For 
example, you might define a custom aggregate that combines the values for five 
products into a single value. You might also define a custom aggregate that adds the 
values of four products and subtracts the value of a fifth product. This might be useful 
if you were creating a what-if simulation and wanted to see the effect that phasing out 
one of the products would have on your key value drivers. Note: Custom aggregates 
are independent of any hierarchy. If you are selecting values from a specific hierarchy, 
then custom aggregates will not be available. 

Defining Custom Aggregates
You define a custom aggregate by naming the aggregate and selecting its member 
values. You can also specify how a specific member will be processed within the 
aggregate. 
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To define a custom aggregate:
1. Access Oracle Demand Planning as a Demand Planner or Demand Plan Manager.

2. On the Navigation toolbar, choose the New button.

3. Choose New Custom Aggregate from the popup menu. 

Alternatively, you can click the right mouse button on the Custom Aggregates 
folder in the Navigation list, or the Custom Aggregates folder for a specific 
dimension. Then choose New Custom Aggregate from the popup menu. 

Result: If you use the right-click technique on the Custom Aggregates folder, the 
Custom Aggregates dialog box opens, displaying a default dimension. 

If you use the right-click technique on a specific Custom Aggregates folder, the 
Custom Aggregates dialog box opens, displaying the selected dimension.

4. If you have not already done so, in the Dimension box, select the dimension for the 
custom aggregate. 

5. In the name boxes, enter a short name and a long name for the custom aggregate. 

The short name can be up to 16 characters long. The long name can be up to 70 
characters long.

6. Choose the Selector button to access the Select Data dialog box and select the values 
that will comprise the custom aggregate. 

You can choose values from a list. You can also use the buttons on the Data 
Selection toolbar to choose values by specific criteria. For more information about 
selecting values, see Selector Undo Redo., page 22-2

7. If this is a Time aggregate, you can define derived aggregates for prior time periods.
You can choose one or both of the following:

• Year Ago — Creates a custom aggregate for the same time period in the 
previous year. For example, if you define a custom aggregate whose members 
are two months (November and December) of the current year, choosing Year 
Ago will also create a custom aggregate for November and December of the 
previous year. The name of the year ago aggregate will be Mytime Year Ago, 
where Mytime is the name that you entered for the custom aggregate.

• Prior Period — Creates a custom aggregate for the previous time segment. For 
example, if you define a custom aggregate whose members are two months 
(November and December) of the current year, choosing Prior Period will also 
define a custom aggregate for September and October of the current year. The 
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name of the prior period aggregate will be Mytime Previous Period, where 
Mytime is the name that you entered for the custom aggregate.

Note: Year Ago and Prior Period custom aggregates will be 
displayed in the Selector when you select dimension values. 
However, objects for these derived aggregates will not appear 
in the Navigation list.

8. When your selections are complete, choose OK. 

Result: You are returned to the New Custom Aggregate dialog box. The Values list 
displays the values that you chose. A plus sign (+) next to a value indicates that the 
value is additive. 

9. To subtract a value from the aggregate, click the plus sign next to that value. 

Result: A minus sign (-) appears next to the value, indicating that it is subtractive.

Note: Time aggregates for Year Ago and Prior Period require 
positive member values. If you try to include a subtractive value in 
the aggregate definition, the system will create the custom 
aggregate, but will not create Year Ago and Prior Period 
aggregates.

10. Choose OK to save the custom aggregate.

Result: The custom aggregate object appears in the Custom Aggregates folder for 
the dimension in the navigation list. 

Note: If you are working with a data slice, you cannot base your 
custom aggregate on "all organizations" or other qualifying dimension 
values at the highest levels unless your planning assignment includes 
"all organizations". Otherwise, your custom aggregate will appear as 
"invalid".

Example: Custom aggregate definition
You can create a custom aggregate for High End Products, that includes three values in 
the Product dimension. The plus sign (+) indicates that the values will be added.

Applying Custom Aggregates to Open Documents
You can apply a custom aggregate directly to an open report, graph, or worksheet. 
Applying a custom aggregate adds the aggregate value to the current values for the 
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dimension in the document. 

Methods for applying custom aggregates to ad hoc reports, ad hoc graphs, and 
worksheets

You can use the following methods to apply a custom aggregate to an ad hoc report, ad 
hoc graph, or worksheet:

• You can select a saved custom aggregate in the navigation list and use a right 
mouse button command to apply it to the open document.

• As you define a new custom aggregate or modify a saved custom aggregate 
definition, you can apply it directly to an open document.

To apply a saved custom aggregate to an open ad hoc report, ad hoc graph, or worksheet:
1. In the Navigation list, identify the custom aggregate that you want to use. 

Note:  To search for a custom aggregate in the navigation list, click 
the right mouse button on the Custom Aggregates folder, choose 
Find Custom Aggregates, and enter a name or name fragment. 
Alternatively, you can choose the Find button on the Navigation 
toolbar.

2. Ensure that the open document includes the dimension to which the custom 
aggregate refers. 

3. Click the right mouse button the custom aggregate object and choose Apply to 
Open Report, Apply to Open Graph, or Apply to Open Worksheet.

Result: The document displays the custom aggregate as the last selection for the 
specified dimension. 

To apply a new or modified custom aggregate definition to an open ad hoc report, ad hoc graph, or worksheet:
As you define or modify the custom aggregate, choose Apply to Open Report,Apply to
Open Graph, or Apply to Open Worksheet in the New Custom Aggregate or Edit 
Custom Aggregate dialog box. When you choose OK, Oracle Demand Planning will 
add the custom aggregate to the specified document. 

Example: Applying a new custom aggregate definition to an open document
For example, when an ad hoc report is open in the workspace, you can apply a new 
custom aggregate definition to the report.
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Editing Custom Aggregates
You can change the name or definition of a custom aggregate. 

To modify a custom aggregate:
1. Access Oracle Demand Planning as a Demand Planner or Demand Plan Manager.

2. In the Navigation list, identify the custom aggregate that you want to modify.

Note: To search for a custom aggregate in the navigation list, click 
the right mouse button on the Custom Aggregates folder or the 
Custom Aggregates folder for a specific dimension, choose Find 
Custom Aggregates, and enter a name or name fragment. 
Alternatively, you can choose the Find button on the navigation 
toolbar. 

3. Double-click the custom aggregate object. 

Alternatively, you can click the right mouse button on the custom aggregate object 
and choose Edit from the popup menu. 

Result: A dialog box opens, showing the object's name and definition.

4. You can change the object's name and make new dimension selections.

5. Choose OK to save your changes.

Renaming Custom Aggregates
You can give a new name to a saved custom aggregate. 

Note: Renaming a Time aggregate that has derived aggregates for Year 
Ago or Prior Period also renames the derived aggregates.

To rename a custom aggregate:
1. Access Oracle Demand Planning as a Demand Planner or Demand Plan Manager.

2. In the Navigation list, identify the custom aggregate that you want to rename.

Note: To search for a custom aggregate in the navigation list, click 
the right mouse button on the Custom Aggregates folder or the 
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Custom Aggregates folder for a specific dimension, choose Find 
Custom Aggregates, and enter a name or name fragment. 
Alternatively, you can choose the Find button on the navigation 
toolbar. 

3. Click the right mouse button the custom aggregate object and choose Rename from 
the popup menu.

4. Enter the new name. 

Viewing Custom Aggregate Properties
You can view the following properties of a custom aggregate:

• Description

• Name

• Created 

• Modified

• Class

To view the properties of a custom aggregate:
1. Access Oracle Demand Planning as a Demand Planner or Demand Plan Manager.

2. In the Navigation list, identify the custom aggregate whose properties you want to 
view.

Note: To search for a custom aggregate, click the right mouse 
button on the Custom Aggregates folder or the custom aggregates 
folder for the dimension in the navigation list and choose Find from
the popup menu. Then enter a name or name fragment. 
Alternatively, you can choose the Find button on the navigation 
toolbar.

3. Click the right mouse button the custom aggregate object and choose Properties 
from the popup menu.
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Deleting Custom Aggregates
When you no longer need a custom aggregate, you can delete it. Deleting a custom 
aggregate permanently removes it from the navigation list and the selection list of 
dimension values.

You can delete an individual custom aggregate. You can also delete multiple custom 
aggregates in the same dimension. Deleting a custom time aggregate that has derived 
aggregates for year ago or prior period also deletes the derived aggregates. 

Note: Before you delete a custom aggregate, ensure that there are no 
saved objects that reference it. Failure to do so can cause warning and 
errors to occur when you work with ad hoc reports, ad hoc graphs, 
worksheets, or alerts that contain the deleted custom aggregate.

To delete a custom aggregate:
1. Access Oracle Demand Planning as a Demand Planner or Demand Plan Manager.

2. In the navigation list, identify the custom aggregate that you want to delete.

3. Select the custom aggregate object and choose the Delete button on the Navigation 
toolbar.

4. Alternatively, you can click the right mouse button on the custom aggregate object 
and choose Delete from the popup menu.

Result: You will be prompted to confirm the deletion.

To delete multiple custom aggregates:
1. Access Oracle Demand Planning as a Demand Planner or Demand Plan Manager.

2. In the Navigation list, open the folder that contains the custom aggregates that you 
want to delete.

Note: You can only delete custom aggregates that are in the same dimension folder.

3. Scroll to an object, press the CTRL key and simultaneously click the object.

Result:The object is highlighted.

4. Repeat the previous step for each custom aggregate that you want to delete.
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5. After you make your final selection, click the right mouse button and choose Delete
from the popup menu. 

Result:You are prompted to confirm the deletion.



Working with Saved Selections    20-1

20
Working with Saved Selections

This chapter covers the following topics:

• About Saved Selections

• Defining Saved Selections

• Applying Saved Selections to Open Documents

• Editing Saved Selections

• Renaming Saved Selections

• Viewing Saved Selection Properties

• Deleting Saved Selections

About Saved Selections
A saved selection is a set of dimension values that you select once, save, and reuse in 
multiple documents. When you work as a Demand Planner or Demand Plan Manager, 
saved selections enable you to quickly retrieve a group of values without repeating the 
steps that you followed to select them. 

You can apply a saved selection to an open ad hoc report, ad hoc graph, or worksheet. 
You can also choose a saved selection when you change the settings script for a 
predefined report. 

Defining Saved Selections
When you define a saved selection, you name the selection, specify the dimension for 
the saved selection, and select the component dimension values. You also specify 
whether to save the members of the selection (for example, Geography 1, Geography 2, 
and Geography 3) or the selection steps(for example, "the top three geographies based 
on Booking History Quantity for products x, y, and z during Q1"). 
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Defining a saved selection 
You can define a saved selection from the Navigation list. You can also define a saved 
selection on the fly when you select data for a document.

To define a saved selection from the navigation list:
1. Access Oracle Demand Planning as a Demand Planner or Demand Plan Manager.

2. On the Navigation toolbar, choose the New button, 

3. and choose New Saved Selection from the popup menu. 

Alternatively, you can click the right mouse button on the Saved Selections folder in
the Navigation list or the Saved Selections folder for a specific dimension. Then 
choose New Saved Selection from the popup menu. 

Result: The New Saved Selection dialog box opens. If you used the right-click 
technique on the Saved Selections folder, the New Saved Selections dialog box 
displays a default dimension, which you can change. If you used the right-click 
technique on a Saved Selections folder for a specific dimension, the Saved Selections 
dialog box displays the selected dimension.

4. In the Name box, enter a name for the saved selection. The name can be up to 70 
characters long.

5. The Dimension box displays a default dimension. If this is not the dimension for 
which you want to define a saved selection, select an alternate dimension.

6. Choose the Selector button. 

7. Result: The Select Data dialog box opens.

8. Choose the values that will comprise the saved selection. 

You can select individual values. You can also use the buttons on the Data Selection
toolbar to select values by specific criteria. 

9. When your value selections are complete, choose OK. 

Result: You are returned to the New Saved Selection dialog box. The Selections box 
displays the member values that you chose.

10. In the Options box, choose the option that specifies how you want the values to be 
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saved: 

• Save steps — Saves the script that drives the selection criteria, rather than the 
actual values. Choose this option when you anticipate applying the same 
criteria repeatedly over a long period of time, but expect that the values that 
comprise the selection might change. 

• Save members — Saves the actual dimension values. A member selection is 
always comprised of the same values, regardless of when the selection is 
applied. Choose this option when you want to examine data for the same 
dimension values on an ongoing basis. 

Note: If you used the drag and drop method or a right mouse 
function to sort values for the selection, then you will not be 
able to save steps.

11. In the Description box, you can enter optional text to identify the saved selection.

12. Choose OK to save the selection.

Result: The saved selection object appears in the Saved Selections folder for the 
dimension in the Navigation list.

To define a saved selection while working in a document:
1. With an ad hoc report, ad hoc graph, or worksheet open in the workspace, choose 

the Select Data button on the Document toolbar.

2. From the drop-down list, select a dimension.

Result: The Select Data dialog box opens, displaying values for the dimension.

3. Choose the values that will comprise the saved selection.

You can select individual values. You can also use the buttons on the Data Selection
toolbar to select values by specific criteria. 

4. When your selections are complete, choose the Save Current Selection button on 
the toolbar. 

5. Result: The Save a Selection for Dimensiondialog box opens.
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6. In the Save a Selection for Dimension dialog box, enter information for the saved 
selection as follows:

1. In the Save current selection as box, enter a name for the saved selection. The 
name can be up to 70 characters long.

2. In the Description box, you can enter optional text to describe the components 
of the saved selection.

3. Specify how to save the selection: 

• Save steps — Saves the script that drives the selection criteria, rather than 
the actual values. Choose this option when you anticipate applying the 
same criteria repeatedly over a long period of time, but expect that the 
values that comprise the selection might change. 

• Save members — Saves the actual dimension values. A member selection is
always comprised of the same values, regardless of when the selection is 
applied. Choose this option when you want to examine data for the same 
dimension values on an ongoing basis. 

For more information about these options, see "Defining Saved Selections", 
page 20-1.

Note: If you used the drag and drop method or a right 
mouse function to sort values for the selection, then you 
will not be able to save steps.

7. Choose OK to save the selection.

Result: The saved selection object will appear in the Saved Selections folder for the 
dimension in the Navigation list.

Example: Saved selection definition
After you define a saved selection from the Navigation list, the New Saved Selection 
dialog box displays the saved selection. For example, you provide a selection of product
values to be saved as steps. You can also provide a descriptive name and enter optional 
text that further describes the saved selection.

Applying Saved Selections to Open Documents
You can apply a saved selection to an open ad hoc report, ad hoc graph, or worksheet. 
Applying a saved selection to a document replaces the current values for the dimension 
with the values in the saved selection.
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Methods for applying saved selections to open documents
You can use the following methods to apply a saved selection directly to an open ad hoc
report, ad hoc graph, or worksheet:

• You can choose a previously saved selection in the Navigation list and use a right 
mouse button command to apply it to an open document.

• You can use the Apply Saved Selection tool in the Select Data dialog box and 
choose a previously saved selection to apply.

• As you define new saved selection or modify a saved selection, you can apply it to 
an open document.

To apply a saved selection of values to an open document:
1. With the document open in the workspace, identify the saved selection that you 

want to use. 

Note: To search for a saved selection, click the right mouse button 
on the Saved Selections folder or the Saved Selections folder for a 
dimension in the Navigation list and choose Find from the popup 
menu. Then enter a name or name fragment. Alternatively, you can
choose the Find button on the Navigation toolbar. 

2. Ensure that the open document includes the dimension to which the saved selection
refers. 

3. Click the right mouse button on the saved selection object. From the popup menu, 
choose Apply to Open Report, Apply to Open Graph, or Apply to Open 
Worksheet.

Result:The saved selection replaces the current values for the dimension in the 
document.

To use a data selection tool to apply a saved selection to a document:
1. With the document open in the workspace, choose the Apply Saved Selection 

button on the Data Selection toolbar. 

2. Result: A list of dimensions for which one or more saved selections have been 
defined appears.
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3. Select a dimension.

Result: The Apply Saved Selection dialog box opens. The Available box lists the 
saved selections for the dimension that you chose. 

4. Choose a saved selection from the list.

5. You can choose Preview to preview the values that will be selected as a result of 
your choice.

6. Choose OK to apply the saved selection. 

Result:The saved selection replaces the current values for the dimension in the 
document.

To apply a new or modified saved selection definition to an open document:
As you create or modify a saved selection, choose Apply to Open Report, or Apply to 
Open Graph in the New Saved Selection or Edit Saved Selection dialog box. When you 
choose OK, Oracle Demand Planning will apply the saved selection to the specified 
document.

Editing Saved Selections
You can change the name or definition of a saved selection.

To edit a saved selection:
1. Access Oracle Demand Planning as a Demand Planner or Demand Plan Manager.

2. In the Navigation list, identify the saved selection that you want to modify.

Note: To search for a saved selection, click the right mouse button 
on the Saved Selections folder or the Saved Selections folder for a 
dimension in the Navigation list and choose Find from the popup 
menu. Then enter a name or name fragment. Alternatively, you can
choose the Find button on the Navigation toolbar. 

3. Double-click the saved selection object.

Alternatively, you can click the right mouse button on the saved selection object 
and choose Edit from the popup menu. 

Result: A dialog box opens, showing the object's name and definition.

4. You can change the name, dimension value selections, and method for saving 
(Steps or Members).
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5. Choose OK to save your changes.

Renaming Saved Selections
You can rename a saved selection. 

To rename a saved selection:
1. Access Oracle Demand Planning as a Demand Planner or Demand Plan Manager.

2. In the Navigation list, identify the saved selection that you want to rename.

3. Click the right mouse button on the saved selection object and choose Rename from
the popup menu.

4. Enter the new name, up to 70 characters long.

Viewing Saved Selection Properties
You can view the following properties of a saved selection:

• Name

• Created 

• Modified

• Class

To view the properties of a saved selection:
1. Access Oracle Demand Planning as a Demand Planner or Demand Plan Manager.

2. In the Navigation list, identify the saved selection whose properties you want to 
view. 

3. Click the right mouse button on the saved selection and choose Properties from the 
popup menu.

Deleting Saved Selections
When you no longer need to have access to a saved selection, you can delete it. Deleting
a saved selection permanently removes it from the Navigation list.

You can delete an individual saved selection. You can also delete multiple saved 
selections in the same dimension.
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Note: Before you delete a saved selection, ensure that there are no 
saved objects that reference it. Failure to do so can cause warning and 
errors to occur when you work with ad hoc reports, ad hoc graphs, 
worksheets, or alerts that contain the deleted saved selection.

To delete a saved selection:
1. Access Oracle Demand Planning as a Demand Planner or Demand Plan Manager.

2. In the Navigation list, identify the saved selection that you want to delete.

Note: To search for a saved selection, click the right mouse button 
on the Saved Selections folder or the Saved Selections folder for a 
dimension in the Navigation list and choose Find from the popup 
menu. Then enter a name or name fragment. Alternatively, you can
choose the Find button on the Navigation toolbar.

3. Select the saved selection object and choose the Delete button on the Navigation 
toolbar.

4. Alternatively, you can click the right mouse button on the saved selection object 
and choose Delete from the popup menu.

Result: You will be prompted to confirm the deletion.

To delete multiple saved selections:
1. Access Oracle Demand Planning as a Demand Planner or Demand Plan Manager.

2. In the Navigation list, open the folder that contains the saved selections that you 
want to delete.

You can only delete saved selections that are in the same dimension folder.

3. Scroll to an object, press the CTRL key and simultaneously click the object.

Result:The object is highlighted.

4. Repeat the previous step for each saved selection that you want to delete.

5. After you make your final selection, click the right mouse button and choose Delete
from the popup menu. 

Result:You will be prompted to confirm the deletion
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21
Working with Document Folders

This chapter covers the following topics:

• About Folders

• Creating Folders

• Adding Documents to Folders

• Moving Documents Between Folders

• Copying Documents to Folders

• Changing the Order of Documents in Folders

• Deleting Documents from Folders

• Renaming Folders

• Viewing Folder Properties

• Deleting Folders

About Folders
Folders organize the objects with which you work in Oracle Demand Planning. When 
you work as a demand planner or demand plan manager, you can save objects in 
folders and move or copy objects of the same type between folders.

Display of folders
The folders that you create to manage your documents appear as objects in the 
Navigation List under the main Documents folder. 

Types of Folders
Folders are displayed in the Navigation List. 

• The Documents folder holds all documents that have not been designated for a 
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particular folder. This includes worksheets, reports, and graphs. The document 
type, when the Documents folder is expanded, can be ascertained from the icon to 
the left of the document's name.

• You can create your own folders to hold documents of all types. Folders for 
Predefined Reports, if they are a part of your Demand Planning configuration, appear
beneath the Documents folder. There is a folder for each type of predefined report, 
such as Comparison, Distribution, and Exception.

• The Measures folder appears next in sequence in the Navigation List. More 
information about the Measures folder appears below.

• There are additional folders for Events, Custom Aggregates, Saved Selections, Alerts, 
and Scenarios. The Custom Aggregates and Saved Selections folders have subfolders for
each of the dimensions in the demand plan to which objects are assigned according 
to their dimensionality.

The Measures Folder
Demand Planning has a Measures folder underneath which there are preseeded folders 
to help you organize the measures in your demand plan. These folders ensure that 
measures can be identified and found easily.

Oracle Demand Planning automatically assigns forecast, accuracy, and history 
measures to folders of their respective types. Any forecast or accuracy measure created 
by an administrator or distributed to a planner is assigned to the appropriate folder on 
startup. In addition, if a planning manager or a planner creates a forecast or accuracy 
measure, the measure will immediately be assigned to the proper folder 

This chapter discusses document folders; if you want more information on the folders in 
which measures are stored, see the topic called The Measures Folder , page 17-4 in the 
chapter on working with measures in Oracle Demand Planning.

Creating Folders
You can create a new folder. 

To create a new folder:
1. Access Oracle Demand Planning as a Demand Planner or Demand Plan Manager.

2. On the navigation toolbar, choose the New button.

3. Then choose New Measure Folder or New Document Folder from the submenu.
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Result: Depending upon which command you select, you will either see the New 
Measure Folder dialog box or the New Document Folder dialog box.

4. Enter a name for the folder and choose OK. The long name can be up to 70 
characters long. 

Result: The folder object appears in the Navigation List.

Adding Documents to Folders
When you save an ad hoc report, ad hoc graph, or worksheet, you have the option to 
add it to a folder that you have previously created. 

If you choose (None), the document will be saved in the main Documents folder. 

Moving Documents Between Folders
To better organize your documents, you can move documents from one folder to 
another as follows:

• You can use the drag and drop method. 

• You can use popup menu commands.

Note: You can move documents between folders, but it is important
to note that a document that resides in the Documents folder can 
reside in no other folder at the same time. This means that if you 
move a document into the Documents folder, any other copies of 
that document that are stored in another folder will be removed.

To move a document from one folder to another using the drag and drop method:
1. Access Oracle Demand Planning as a Demand Planner or Demand Plan Manager.

2. In the navigation list, identify the document that you want to move. 

3. Click the document and, while holding the mouse button down, drag the document
to the new folder. 

4. Release the mouse button to drop the document on the selected folder.

Result:The document appears as an object within the folder.

To move a document from one folder to another using popup menu commands:
1. Access Oracle Demand Planning as a Demand Planner or Demand Plan Manager.
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2. In the Navigation list, identify the document that you want to move. 

3. Click the right mouse button on the document. 

Result:A popup menu appears. 

4. From the popup menu, choose Cut.

5. Scroll to the folder into which you want to place the document and click the right 
mouse button on it. 

Result: A popup menu appears. 

6. From the popup menu, choose Paste.

Result:The document appears as an object within the folder.

To move a document from one folder to another using keyboard shortcuts:
1. Access Oracle Demand Planning as a Demand Planner or Demand Plan Manager.

2. In the Navigation list, identify the document that you want to move. 

3. Click the document and press CTRL + X.

4. Scroll to the folder into which you want to place the document and click it.

5. Press  CTRL + V.

Result:The document appears as an object within the folder.

Copying Documents to Folders
You can copy documents from one folder to another as follows: 

• You can use the drag and drop method. 

• You can use popup menu commands.

• You can use keyboard shortcuts.

Note: You can copy documents between folders, but it is important 
to note that a document that resides in the Documents folder can 
reside in no other folder at the same time. This means that if you 
copy a document into the Documents folder, any other copies of 
that document that are stored in your another folder will be 
removed.
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To copy a document from one folder to another using the drag and drop method:
1. Access Oracle Demand Planning as a Demand Planner or Demand Plan Manager.

2. In the Navigation list, identify the document that you want to copy. 

3. Click the document, press the CTRL key and, while holding the mouse button 
down, drag the document to the target folder. 

4. Release the mouse button to drop the document on the selected folder. 

Result: The document appears as an object within the folder.

To copy a document from one folder to another using popup menu commands:
1. Access Oracle Demand Planning as a Demand Planner or Demand Plan Manager.

2. In the Navigation list, identify the document that you want to copy.

3. Click the right mouse button on the document. 

Result: A popup menu appears. 

4. From the popup menu, choose Copy.

5. Scroll to the folder into which you want to place the copy and click the right mouse 
button on it. 

Result: A popup menu appears. 

6. From the popup menu, choose Paste.

Result: The document appears as an object within the folder.

To copy a document from one folder to another using keyboard shortcuts:
1. Access Oracle Demand Planning as a Demand Planner or Demand Plan Manager.

2. In the Navigation list, identify the document that you want to copy.

3. Click the document and press CTRL + C

.

4. Scroll to the folder into which you want to place the document and click it.

5. Press CTRL + V.

Result: The document appears as an object within the folder.
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Changing the Order of Documents in Folders
You can change the order of documents in a folder by dragging one or more documents
from the current position to a new position. 

To change the order of documents in a folder:
1. Access Oracle Demand Planning as a Demand Planner or Demand Plan Manager.

2. In the Navigation list, open the folder that contains the documents that you want to 
reorder. 

3. Scroll to a document, press the CTRL key and simultaneously click the document 
object.

Result:The document is highlighted.

4. Repeat the previous step for each document that you want to move.

5. Drag the selection to the new location in the folder. As you move the object or 
objects, a black bar appears to help you identify the new position. 

6. When the black bar is below the desired location, release the selection.

Deleting Documents from Folders
You can delete a document from a folder. 

Note: If there is a copy of the document in another folder, that version 
will not be removed.

To delete a document from a folder:
1. Access Oracle Demand Planning as a Demand Planner or Demand Plan Manager.

2. In the Navigation list, identify the folder that contains the document that you want 
to delete. 

3. Click the document object and click the Delete button on the navigation toolbar.

4. Alternatively, you can click the right mouse button on the document in the 
navigation list and choose Delete from the popup menu.
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Result:You will be prompted to confirm the deletion.

Renaming Folders
You can give a new name to a folder.

To rename a folder:
1. Access Oracle Demand Planning as a Demand Planner or Demand Plan Manager.

2. In the Navigation list, identify the folder that you want to rename.

3. Click the right mouse button on the folder object and choose Rename from the 
popup menu

4. Enter the new name, up to 70 characters long. 

Viewing Folder Properties
You can view the properties of a folder.

To view the properties of a folder:
1. In the Navigation list, identify the folder whose properties you want to view.

2. Click the right mouse button on the folder object and choose Properties from the 
popup menu.

Result: The following information is displayed:

• Name

• Created 

• Modified

• Class 

Deleting Folders
When you no longer need to maintain a folder, you can delete it. Deleting a folder 
permanently removes it from the navigation list.

Note: Deleting a folder deletes all the documents that the folder 
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contains. If there is a version of a document in another folder, that 
version will not be deleted.

To delete a folder:
1. Access Oracle Demand Planning as a Demand Planner or Demand Plan Manager.

2. In the Navigation list, identify the folder that you want to delete.

3. Select the folder object and choose the Delete button on the navigation toolbar.

4. Alternatively, you can click the right mouse button on the folder object and choose 
Delete from the popup menu.

Result: You will be prompted to confirm the deletion. 
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22
Selecting Data 

This chapter covers the following topics:

• About Selecting Data

• Selecting Values From a List

• Selecting Values by Level

• Selecting Values by Family Relationship

• Selecting Values by Attribute

• Selecting Values that Match a Character String

• Selecting Values that Meet a Value Condition

• Selecting Values that Meet a Measure Condition

• Selecting Top and Bottom Values

• Selecting Time Values by Range

• Sorting Selected Values

• Saving Value Selections

About Selecting Data
When you work as a Demand Planner or Demand Plan Manager, you select data for 
documents, custom aggregates, and saved selections. You can choose values from a list, 
use tools to establish selection criteria, or combine list and tool operations. 

Data selection tools
Choose the Select Data tool on a Document toolbar or when you are working with a 
saved selection or custom aggregate definition. 
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When you open the Select Data dialog box opens, the Selector toolbar appears. The 
toolbar buttons enable you to perform the listed below.

• Apply Saved Selection - Apply a previous saved selection of values to an open ad 
hoc report, ad hoc graph, or worksheet.

• Save Current Selection  - Save selected values as a custom saved selection.

• Choose Values by Level - Select values at a specified level in a hierarchy.

• Choose Values by Family - Select values that have a specified family relationship.

• Choose Values by Attribute - Select values that share specific attributes.

• Choose Matching Values - Select values that match one or more character strings.

• Choose Values Meeting Values Condition - Select values based on the way in 
which values in one measure compare to the values in another measure.

• Choose Top/Bottom Values - Select the largest and smallest values.

• Choose Values by Range - Select values that match or fall within specified dates

• Sort - Sort selected values.

• Undo - Undo previous step

• Redo - Restore previous step.

Selector Undo and Redo Buttons 
When you work as a Demand Planner or Demand Plan Manager, you select data for 
documents, custom aggregates, and saved selections. You can choose values from a list, 
use tools to establish selection criteria, or combine list and tool operations. 

Using Undo and Redo
In addition to the buttons for the Selector tools, the toolbar in the Select Data dialog box 
includes buttons for Undo and Redo. 

These command buttons are especially useful when you are building a complex list of 
dimension values to use in a report, graph, or worksheet.

The symbols on the buttons are a back facing arrow for Undo, and a front facing arrow 
for Redo.

In the Selector toolbar, the Undo button is enabled after a selection is made. When you 
choose Undo you restore the selection to the values that were chosen in the previous 
step. 
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If you are involved in a process involving multiple steps, you can continue clicking 
Undo to restore the selection to the values from earlier steps. Each click of the button, in
essence, moves you backwards one step in the procedure.

Checking Redo restores the selection to the values that were available before Undo was 
clicked.

Selecting Values From a List
You can choose a dimension and select one or more values from a list of values for that 
dimension. 

To select values from a list:
1. Do one of the following: 

• If you are working in an open document, choose the Select Data button on the 
Document toolbar and choose a dimension from the popup menu.

• If you are working within a custom aggregate or a saved selection definition, 
choose a dimension in the Dimension box and choose the Selector button.

Result: The Select Data dialog box opens. The dimension that you chose appears
in the Select values for box. 

2. If the current dimension includes one or more hierarchies, in the Organize by box, 
you can select the hierarchy that you want to work with.

Result: The values in the Available box might change depending on which hierarchy
you choose.

3. Move values between the Available and Selected boxes until the Selected box contains 
the dimension values that you want. 

For information about searching for values, expanding the value list, and adding 
values to and removing values from the Selected box, see "Techniques for selecting 
values from a list", page 22-4. 

4. You can order values in the Selected box according to how you want your selections 
to appear. 

For more information, see "Sorting Selected Values", page 22-24.

5. Choose OK to apply your selections.

Result: If you are selecting values for a document, the values that you chose are 
displayed in the document. If you are selecting values for a custom aggregate, the 
values appear in the Members list. If you are selecting values for a saved selection, 
the values appear in the Selections list.
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Techniques for selecting values from a list

Searching for values in the Available box
You can use the Find button to search for a value by name. The Find button is located 
under the Available box. It resembles a pair of binoculars.

If you selected a hierarchy in the Organize by box, the system will search only within 
that hierarchy. If you did not select a hierarchy, the system will search the values in all 
hierarchies.

Expanding and collapsing values in the Available box
You can view data at various levels by expanding and collapsing aggregate dimension 
values. For example, if the list displays a geography that includes lower level values, 
you can expand the list to show component geographies. You can subsequently collapse
the list to reaggregate the display. 

An aggregate value is preceded by a plus sign (+), indicating that it can be expanded. 

An expanded value is preceded by a minus sign (-), indicating that it can be collapsed. 
Choose the plus sign to expand a value. Choose the minus sign to collapse a value. You 
can also use the Expand All and Collapse All buttons to expand or collapse all values. 
These buttons are located under the Available box, next to the Find Value button. The 
Expand All and Collapse All buttons resemble large plus and minus symbols. 

Adding values to the Selected box
You can add one or more values in the Available box to the Selected box as follows: 

• To add a single value, double-click the value

or

Highlight the value and choose the single arrow button that points to the Selected 
box.

• To add multiple nonsequential values, press and hold the CTRL key, choose each 
value that you want to add, and then choose the single arrow button that points to 
the Selected box.

To add multiple sequential values, select the first value that you want to add, press 
and hold the SHIFT key, select the last value that you want to add, and then choose
the single arrow button that points to the Selected box. You can also select the 
values to add by clicking and dragging the mouse. 
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• To add all values, choose the double arrow button that points to the Selected box.

Removing values from the Selected box
You can remove values from the Selected box as follows: 

• To remove a single value, double-click the value 

or

Highlight the value and choose the single arrow button that points to the Available 
box.

• To remove multiple nonsequential values, press and hold the CTRL key, choose 
each value that you want to remove, and then choose the single arrow button that 
points to the Available box.

To remove multiple sequential values, select the first value that you want to 
remove, press and hold the SHIFT key, select the last value that you want to 
remove, and then choose the single arrow button that points to the Available box. 
You can also select the values to remove by clicking and dragging the mouse. 

• To remove all values, choose the double arrow button that points to the Available 
box.

• You can also choose the values that you want to remove, click the right mouse 
button, and choose Remove from the popup menu.

Example: Selecting values from a list
The Select Data dialog box displays the selections made for the product dimensions. For 
example, if the user selects four values in the Product dimension, then the choices would
appear in the Selected box. 
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Selecting Values by Level
When you are working with a hierarchical dimension, you can limit selections to values 
at a particular level of the hierarchy. For example, in a Geography dimension you might
select values at the Customer level.

To select values by level:
1. Do one of the following: 

• If you are working in an open document, choose the Select Data button on the 
Document toolbar and choose a dimension from the popup menu.

• If you are working within a custom aggregate or a saved selection definition, 
choose a dimension in the Dimension box and choose the Selector button.

Result: The Select Data dialog box opens. The dimension that you chose appears
in the Select values for box. 

2. In the Organize by box, select the hierarchy that you want to work with.

Result: The values in the Available box might change depending on which hierarchy
you choose.

3. Choose the Choose Values By Level button on the toolbar.
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4. Result: The Choose Values By Level  dialog box opens for the dimension with which 
you have chosen to work.

5. In the Action box, specify how you want the new values to affect the values in the 
Selected box of the Select Data dialog box:

• To replace any values that are already in the Selected box with just the values 
that you specify in this dialog box, choose Select.

• To add the new values that you specify in this dialog box to any values that are 
already in the Selected box, choose Add.

• To retain only the values already in the Selected box that match the values that 
you specify in this dialog box, choose Keep.

• To remove the values that you specify in this dialog box from the values that 
are already in the Selected box, choose Remove.

6. In the Level box, select one or more levels. 

7. You can choose Preview to preview the values that will be selected as a result of 
your choices.

8. You can order the values in the Selected box according to how you want your 
selections to appear. 

For more information, see "Sorting Selected Values", page 22-24.

9. Choose OK to apply your selections. 

Result:The Select Data dialog box reopens. The values that you chose are displayed 
in the Selected box.

The  Choose Values By Levell dialog box displays the values you selected by level. For 
example, if you select geography values at the Region and District levels, the selected 
values would be displayed in the above mentioned dialog box.

Selecting Values by Family Relationship
When you are working with a hierarchical dimension, you can select values according 
to their familial relationship with other values in the hierarchy. For example, in a 
Geography dimension you might select descendants of Massachusetts and New York.
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To select values by family:
1. Do one of the following: 

• If you are working in an open document, choose the Select Data button on the 
Document toolbar and select a dimension from the popup menu.

• If you are working within a custom aggregate or a saved selection definition, 
choose a dimension in the Dimension box and choose the Selector button.

Result: The Select Data dialog box opens. The dimension that you chose appears
in the Select values for box. 

2. In the Organize by box, select the hierarchy with which you want to work,

Result: The values in the Available box might change depending on which hierarchy
you choose.

3. Choose the Choose Values By Family button on the toolbar.

4. Result: The Choose Values by Family dialog box opens for the dimension that you 
have chosen.

5. In the Action box, specify how you want the new values to affect the values in the 
Selected box of the Select Data dialog box, as follows:

• To replace any values that are already in the Selected box with just the values 
that you specify in this dialog box, choose Select.

• To add the new values that you specify in this dialog box to any values that are 
already in the Selected box, choose Add.

• To retain only the values already in the Selected box that match the values that 
you specify in this dialog box, choose Keep.

• To remove the values that you specify in this dialog box from the values that 
are already in the Selected box, choose Remove.

6. In the family of box, select the value whose family members you want to choose. 

You can accept the default value or choose the Ellipsis button to access a dialog box 
where you can select one or more alternate values. 

7. In the operator box, select the term that determines how the value or values that 
you select in the next step will relate to the values that you chose in the previous 
step. You can choose at the level (the default), or you can select using the 
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relationship.

8. In the relationship type box, select one or more relationships that will determine 
how the selected values are related to the value you chose in the previous step. 

9. You can choose Preview to preview the values that will be selected as a result of 
your choices.

10. You can order the values in the Selected box according to how you want your 
selections to appear. 

For more information, see "Sorting Selected Values", page 22-24.

11. Choose OK to apply your selections.

Result:The Select Data dialog box reopens. The values that you chose are displayed 
in the Selected box.

For example, if the user selects Self and Immediate Children as the relationship for 
selecting product values, they would be displayed in the Choose Values by Family Values 
dialog box.

Selecting Values by Attribute
You can select dimension values that share related characteristics. For example, in a 
Product dimension you might select item level attributes such as color. Or, you might 
select items which have been identified with an attribute that marks them as a key value
driver.

Note: In order to select data by attribute, the attributes must have been 
defined for the dimension in the Demand Planning Server. If the 
Attribute tool is unavailable when you are selecting data for a 
dimension, then you can assume that there are no attributes for that 
dimension.

To select values by attribute:
1. Do one of the following: 

• If you are working in an open document, choose the Select Data button on the 
Document toolbar and choose a dimension from the popup menu.

• If you are working within a custom aggregate or saved selection definition, 
choose a dimension in the Dimension box and choose the Selector button.

Result: The Select Data dialog box opens. The dimension that you chose appears
in the Select values for box. 
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2. If the current dimension includes one or more hierarchies, in the Organize by box 
you can select the hierarchy that you want to work with.

Result: The values in the Available box might change depending on which hierarchy
you choose.

3. Choose the Choose Values By Attribute button on the toolbar.

4. Result: The Choose Values by Attribute Values dialog box opens.

5. In the Action box, specify how you want the new values that you are selecting to 
affect the values in the Selected box of the Select Data dialog box, as follows:

• To replace any values that are already in the Selected box with just the values 
that you specify in this dialog box, choose Select.

• To add the new values that you specify in this dialog box to any values that are 
already in the Selected box, choose Add.

• To retain only the values already in the Selected box that match the values that 
you specify in this dialog box, choose Keep.

• To remove the values that you specify in this dialog box from the values that 
are already in the Selected box, choose Remove.

6. If you selected a hierarchy in the Organize by box, the Level box contains levels for 
that hierarchy. Select one or more levels at which you want to choose values. Use 
CTRL + click or SHIFT + click to select multiple levels.

7. In the where box, select an attribute. 

8. In the is box, select one or more values for the attribute. Use CTRL + click or SHIFT
+ click to select multiple values.

9. You can choose Preview to preview the values that will be selected as a result of 
your choices.

10. Choose OK. 

Result: The Select Data dialog box reopens. The values that you chose are displayed 
in the Selected box.

11. You can order values in the Selected box according to how you want your selections 
to appear. 

For more information, "Sorting Selected Values", page 22-24.
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Using Attributes to Select Values in a Scope
Oracle Demand Planning supports a planning process that is collaborative, meaning 
that many demand planners can view common slices of demand data. 

Only one demand planner, however, has edit responsibility for each slice of data. 
Planners have an Assignment scope and a View scope. View scope items are not 
editable, although there are situations when View scope items can be automatically 
included in a slice when Assignment scope items are dependent on them. 

When a full distribution process to planners is complete, attributes are created or are 
updated as necessary if they already exist. An attribute named Scope is created for each 
dimension in the plan. Each dimension value in each dimension will have a value for 
the attribute, the possible values being Assignment and View. 

These attributes can be used in the Selector (Select Data dialog box) to select only 
dimension values that are in your Assignment (edit) scope.

Procedure: to Select Values in Your Assignment Scope
1. With a worksheet open, click the Selector button on the Document toolbar to access 

the Select Data dialog box.

2. Choose a dimension with which to work, such as Product.

3. Click the Choose Values by Attribute button to access the Choose Values by Attribute
dialog box.

4. Select an action in the Action box. To see the values in your Assignment scope, for 
example, you could use Select.

5. In the Levels box, select a level in the dimension hierarchy. If you wanted to see the 
types of product values in your scope, for example, you could select Product 
Category.

6. In the Relation box, select Scope.

7. In the Attributes box, select Assignment.

8. If you choose the Preview button, you will be able to display all the product 
categories that are in your Assignment scope.

9. If you choose OK, you will return to the Select Data dialog box, where the product 
categories will be listed in the Selected box.
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Selecting Values that Match a Character String
You can select dimension values that contain, begin with, end with, or exactly match 
one or more character strings. For example, in a Product dimension you might select 
products that contain the characters "mini" and "maxi."

To select values that match a character string:
1. Do one of the following: 

• If you are working in an open document, choose the Select Data button on the 
Document toolbar and choose a dimension from the popup menu.

• If you are working within a custom aggregate or a saved selection definition, 
choose a dimension in the Dimension box and choose the Selector button.

Result:  The Select Data dialog box opens. The dimension that you chose 
appears in the Select values for box. 

2. If the current dimension includes one or more hierarchies, in the Organize by box 
you can select the hierarchy that you want to work with.

Result: The values in the Available box might change depending on which hierarchy
you choose.

3. Choose the Choose Matching Values button on the toolbar.

4. Result: The Choose Matching Values dialog box opens for the dimension that you 
have chosen.

5. In the Action box, specify how you want the new values that you are selecting to 
affect the values in the Selected box of the Select Data dialog box, as follows:

• To replace any values that are already in the Selected box with just the values 
that you specify in this dialog box, choose Select.

• To add the new values that you specify in this dialog box to any values that are 
already in the Selected box, choose Add.

• To retain only the values already in the Selected box that match the values that 
you specify in this dialog box, choose Keep.

• To remove the values that you specify in this dialog box from the values that 
are already in the Selected box, choose Remove.
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6. If you selected a hierarchy in the Organize by box, the Level box contains levels for 
that hierarchy. Select one or more levels at which you want to choose values. 

7. In the that box, select the term that specifies how the values must match the 
characters that you will enter. You can choose terms such as contain, start with, 
end with, or are identical.

8. In the lines box, select the option that specifies how you want Oracle Demand 
Planning to search for matching values:

• any of the lines — Retrieves dimension values that match any of the entries in 
the values to match box. This is equivalent to the boolean OR operator.

• all of the lines — Retrieves dimension values that match all of the entries in the
values to match box. This is equivalent to the boolean AND operator. This 
option is available only when the option in the lines box is contains.

9. In the values to match box, enter one or more alphanumeric strings that you want to 
match. Use separate lines to enter multiple values.

10. You can limit the match to values with a specific type of dimension label. 

For all dimensions, you can select Long Name or DimValue. For a custom measure,
you can also select Short Name.

11. If the values must also match the case in the characters box, select Match case.

12. You can choose Preview to preview the values that will be selected as a result of 
your choices.

13. You can order the values in the Selected box according to how you want your 
selections to appear. 

For more information, see "Sorting Selected Values", page 22-24.

14. Choose OK to apply your selections. 

Result:The Select Data dialog box reopens. The values that match your 
specifications are displayed in the Selected box.

Selecting Values that Meet a Value Condition
You can select dimension values that relate to a numeric value in a specific way. For 
example, in a Geography dimension you might select geographies where Booking 
History, Quantity for a selected product and time period exceeds a specified amount.
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To select values that meet a value condition:
1. Do one of the following: 

• If you are working in an open document, choose the Select Data button on the 
Document toolbar and choose a dimension from the popup menu.

• If you are working within a custom aggregate or a saved selection definition, 
choose a dimension in the Dimension box and choose the Selector button.

Result: The Select Data dialog box opens. The dimension that you chose appears
in the Select values for box. 

2. If the current dimension includes one or more hierarchies, in the Organize by box, 
you can select the hierarchy that you want to work with.

Result: The values in the Available box might change depending on which hierarchy
you choose.

3. Choose the Choose Values Meeting Value Condition button on the toolbar.

4. Result:The Choose Choose Values Meeting Value Condition dialog box opens for the 
dimension that you chose in Step 1. 

5. In the Action box, specify how you want the new values that you are selecting to 
affect the values in the Selected box of the Select Data dialog box, as follows:

• To replace any values that are already in the Selected box with just the values 
that you specify in this dialog box, choose Select.

• To add the new values that you specify in this dialog box to any values that are 
already in the Selected box, choose Add.

• To retain only the values already in the Selected box that match the values that 
you specify in this dialog box, choose Keep.

• To remove the values that you specify in this dialog box from the values that 
are already in the Selected box, choose Remove.

6. If you selected a hierarchy in the Organize by box, the list box contains levels for 
that hierarchy. Select one or more levels at which you want to choose values. 

7. In the measure box, select the measure on which to base the condition. 

You can accept the default measure that appears in the box, or choose the Ellipsis 
button to access a dialog box where you can select an alternate measure.
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8. In the operator box, choose the operator that specifies how the data values for the 
measure that you selected in Step 6 must relate to a value. 

9. In the value box, enter a numerical value to which the values in the measure will be 
compared. If you chose the between or outside operator, you must specify two 
values.

10. The Dimensions box displays default qualifying dimension values for the 
comparison. 

You can accept the default values that appear in the box, or you can select an 
alternate qualifying value for a dimension. To select an alternate value, highlight 
the dimension whose value you want to change and choose the Dimension Values 
button. 

11. You can specify additional conditions for the comparison as follows: 

• To exclude missing values from the values that you are selecting, choose 
Exclude missing values.

• To exclude zero values from the values that you are selecting for a numeric 
measure, choose Exclude zero values.

12. To exclude zero values from the values that you are selecting, choose Exclude zero 
values.

13. You can choose Preview to preview the values that will be selected as a result of 
your choices.

14. You can order the values in the Selected box according to how you want your 
selections to appear. 

For more information, see "Sorting Selected Values", page 22-24.

15. Choose OK to apply your selections. 

Result:The Select Data dialog box reopens. The values that you chose are displayed 
in the Selected box.

Example: Selecting values that meet a value condition
The Choose Values Meeting Value Condition dialog box helps you to select values based on
criteria. For example, you can select all products where Shipping History, Quantity is 
greater than 1,000,000 for all geographies in January, 2002 for all organizations and ship 
from locations.
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Selecting Values that Meet a Measure Condition
You can select values based on the way in which the values in one measure compare to 
the values in another measure. For example, in a Geography dimension you might 
select geographies where Sales Forecast, Quantity is 10% greater than Booking History, 
Quantity for a specified product and time period.

To select values that meet a measure condition:
1. Do one of the following: 

• If you are working in an open document, choose the Select Data button on the 
Document toolbar and choose a dimension from the popup menu.

• If you are working within a custom aggregate or a saved selection definition, 
choose a dimension in the Dimension box and choose the Selector button.
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Result: The Select Data dialog box opens. The dimension that you chose appears
in the Select values for box. 

2. If the dimension includes one or more hierarchies, you can select a hierarchy in the 
Organize by box. 

Result: The values in the Available box might change depending on which hierarchy
you choose.

3. Choose the Choose Values Meeting Measure Condition button on the toolbar.

4. Result:The Choose Values Meeting Measure Condition dialog box opens for the 
dimension that you selected in Step 1.

5. In the Action box, specify how you want the new values that you are selecting to 
affect the values in the Selected box of the Select Data dialog box, as follows:

• To replace any values that are already in the Selected box with just the values 
that you specify in this dialog box, choose Select.

• To add the new values that you specify in this dialog box to any values that are 
already in the Selected box, choose Add.

• To retain only the values already in the Selected box that match the values that 
you specify in this dialog box, choose Keep.

• To remove the values that you specify in this dialog box from the values that 
are already in the Selected box, choose Remove.

6. If you selected a hierarchy in the Organize by box, the Level box contains levels for 
that hierarchy. Select one or more levels at which you want to choose values. 

7. In the first measure box, select the measure on which to base the condition. 

You can accept the default measure that appears in the box, or choose the Ellipsis 
button to access a dialog box where you can select an alternate measure.

8. In the where box, choose an operator that specifies how the data values in the 
measure that you selected in Step 6 must relate to a comparison measure.

You can choose is equal to, is not equal to, is greater than, is greater than or equal 
to, is less than, is less than or equal to, is between, or is not between. 

9. In the Comparison box, select the measure whose values will be compared to those of
the measure in the measure box. 
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You can accept the default measure that appears in the box, or choose the Ellipsis 
button to access a dialog box where you can select an alternate measure.

10. To include an additive or subtractive value in the comparison, proceed as follows:

1. If you choose less than or greater than in Step 7, select plus or minus. If you 
chose within or not within in Step 7, plus or minus is the only selection.

2. In the value box, enter the value to be added or subtracted when the measure 
values are compared. 

3. If the value is a percentage, choose percent. 

11. The Dimensions box displays default qualifying dimension values for the 
comparison. 

You can accept the default values that appear in the box, or you can select an 
alternate qualifying value for a dimension. To select an alternate value, highlight 
the dimension whose value you want to change and choose the Dimension Values 
button. 

12. You can specify additional conditions for the comparison as follows:

• To exclude missing values from the values that you are selecting, choose 
Exclude missing values.

• To exclude zero values from the values that you are selecting, choose Exclude 
zero values.

13. You can choose Preview to preview the values that will be selected as a result of 
your choices.

14. You can order the values in the Selected box according to how you want your 
selections to appear. 

For more information, see "Sorting Selected Values", page 22-24.

15. Choose OK to apply your selections. 

Result:The Select Data dialog box reopens. The values that you chose are displayed 
in the Selected box.

Example: Selecting values that meet a measure condition
The Choose Values Meeting Measure Condition dialog box allows you to select values 
based on measure conditions. For example, you can select products where Revised 
Forecast, Quantity is greater than Baseline Forecast, Quantity plus 10% in January 2002 
for the Americas in all organizations. 
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Selecting Top and Bottom Values
You can specify a number or percentage of values that you want to select from the top, 
bottom, or top and bottom values for a measure. For example, in a Product dimension 
you might select the top ten products based on Booking History, Quantity for a 
specified geography and time period.

To select values top and bottom values:
1. Do one of the following: 

• If you are working in an open document, choose the Select Data button on the 
Document toolbar and choose a dimension from the popup menu.

• If you are working within a custom aggregate or a saved selection definition, 
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choose a dimension in the Dimension box and choose the Selector button.

Result: The Select Data dialog box opens. The dimension that you chose appears
in the Select values for box. 

2. If the dimension includes one or more hierarchies, in the Organize by box you can 
select the hierarchy that you want to work with.

Result: The values in the Available box might change depending on which hierarchy
you choose.

3. Choose the Choose Top/Bottom Values button on the toolbar.

4. Result: The Select Top/BottomValues dialog box opens for the dimension that you 
chose in Step 1.

5. In the Action box, specify how you want the new values that you are selecting to 
affect the values in the Selected box of the Select Data dialog box, as follows:

• To replace any values that are already in the Selected box with just the values 
that you specify in this dialog box, choose Select.

• To add the new values that you specify in this dialog box to any values that are 
already in the Selected box, choose Add.

• To retain only the values already in the Selected box that match the values that 
you specify in this dialog box, choose Keep.

• To remove the values that you specify in this dialog box from the values that 
are already in the Selected box, choose Remove.

6. If you selected a hierarchy in the Organize by box, the Level box contains a list of 
levels for that hierarchy. Select one or more levels at which you want to choose 
values. 

7. In the measure box, specify the measure for which you want to select values. 

You can accept the default measure that appears in the box, or choose the Ellipsis 
button to access a dialog box where you can select an alternate measure.

8. To include top values in your selection, in the top box, enter the number or 
percentage of top values to select. To indicate that the value that you entered is a 
percentage, choose percent.

9. To include bottom values in your selection, in the bottom box specify the number or 
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percentage of bottom values to select. To indicate that the value that you entered is 
a percentage, choose percent. 

10. The Dimensions box displays default qualifying dimension values for the 
top/bottom selections. 

You can accept the default values that appear in the box, or you can select an 
alternate qualifying value for a dimension. To select an alternate value, highlight 
the dimension whose value you want to change and choose the Dimension Values 
button. 

11. To exclude missing values from the values that you are selecting, choose Exclude 
missing values. To exclude zero values, choose Exclude zero values.

12. You can choose Preview to preview the values that will be selected as a result of 
your choices.

13. You can order the values in the Selected box according to how you want your 
selections to appear. 

For more information, see "Sorting Selected Values", page 22-24.

14. Choose OK to apply your selections.

Result:The Select Data dialog box reopens. The values that you chose are displayed 
in the Selected box.

Example: Selecting top and bottom values
The Choose Top/Bottom Values dialog box allows you to select top and bottom values 
based on specific criteria. For example, you can select the top 10% of product items, 
based on Shipping History, Quantity for the Americas in January for all organizations. 
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Selecting Time Values by Range
When selecting values for the time dimension, you can specify a time range within 
which to limit value selections. For example, you might choose time values from 
January 2002 through June 2002 at the month level.

To select time values by range:
1. Do one of the following: 

• If you are working in an open document, choose the Select Data button on the 
Document toolbar and choose a dimension from the popup menu.

• If you are working within a custom aggregate or a saved selection definition, 
choose a dimension in the Dimension box and choose the Selector button.

Result: The Select Data dialog box opens. Time appears in the Select values for 
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box. 

2. If the Time dimension includes one or more hierarchies, in the Organize by box you
can select the hierarchy that you want to work with.

Result:The values in the Available box might change depending on which hierarchy 
you choose.

3. Choose the Choose Values by Range button on the toolbar.

4. Result: The Choose Time By Range dialog box opens.

5. In the Action box, specify how you want the new values that you are selecting to 
affect the values in the Selected box of the Select Data dialog box, as follows:

• To replace any values that are already in the Selected box with just the values 
that you specify in this dialog box, choose Select.

• To add the new values that you specify in this dialog box to any values that are 
already in the Selected box, choose Add.

• To retain only the values already in the Selected box that match the values that 
you specify in this dialog box, choose Keep.

• To remove the values that you specify in this dialog box from the values that 
are already in the Selected box, choose Remove.

6. In the Interval box, choose one of the following: 

• a range of — Selects all time values between and including a starting value and 
an ending value at a level that you choose.

• the latest — Selects a number of latest time values at a level that you choose. 

• the next — Selects a number of future time values at a level that you choose.

7. If you selected a range of in Step 5, proceed as follows:

1. In the Level box, choose the level at which to select time values.

2. In the from box, specify the beginning of the time range. 

You can accept the default value or choose the Ellipsis button to access a dialog 
box, where you can select an alternate value. 
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3. In the to box, specify the end of the time range. Alternatively, you can choose to
latest value to extend the range to the latest time period at the level you 
specified in the Level box. 

You can accept the default value or choose the Ellipsis button to access a dialog 
box, where you can select an alternate value. 

8. If you selected the latest in Step 5, proceed as follows: 

1. In the value box, enter the number of time periods for which you want to select 
the latest values.

2. In the Level box, choose the level at which to select time values.

9. If you selected the next in Step 5, proceed as follows:

1. In the value box, enter the number of periods for which you want to select the 
future time values.

2. In the Level box, choose the level at which to select time values.

10. You can choose Preview to preview the values that will be selected as a result of 
your choices.

11. You can order the values in the Selected box according to how you want your 
selections to appear. 

For more information, see "Sorting Selected Values", page 22-24.

12. Choose OK to apply your selections.

Result:The Select Data dialog box reopens. The values that you chose are displayed 
in the Selected box.

Example: Selecting time values by range
The Choose Time By Range dialog box allows you to select time values by a specific 
range. For example, you can select a range of time values at the quarter level.

Sorting Selected Values
Once you have selected values, you can arrange them in the Selected box in the order in 
which you want them to appear. You can use the following techniques to sort values:

• Use the Sort tool on the Data Selection toolbar to specify sorting criteria.

• Drag and drop values to specific positions.
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• Click the right mouse button and select an option for changing the relative position 
of a value or values. 

To use the Sort tool to sort values:
1. Choose the Sort button on the Data Selection toolbar. 

2. Select a sort option. Depending on the dimension and whether you selected a 
hierarchy when you chose the values, the following options are available:

• name — Sorts values in alphabetical by name. You can choose A to Z or Z to A. 

• data value — Sorts values numerically based on a specified measure and 
qualifying dimension values for that measure. You can choose high to low or 
low to high. 

• hierarchy — Sorts values based on their position in a hierarchy. Values are 
grouped by family. You can choose top to bottom or bottom to top. 

• level — Sorts values based on level. All values at a given level are displayed. 
You can choose top to bottom or bottom to top. 

• time — For the time dimension, sorts values by time period. You can choose 
earliest to latest or latest to earliest. 

3. You can choose Preview to preview the results of the sort. 

4. Choose OK to apply your selections.

Result:The Select Data dialog box reopens. The selected values are sorted according 
to your specifications.

To use drag and drop to order values:
1. Choose one or more values and drag them to a new position. 

As you move the selection, a black bar appears to help you identify the current 
position. 

2. When the black bar is under the desired location, release the selection.

To use a right mouse button function to order values:
1. In the Selected box, click the right mouse button on the value whose position you 
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want to change. 

Result: A popup menu appears, listing options for changing the value's position. 
The options vary depending on the current position of the value.

2. Choose the option that specifies how you want to position the value: 

• To place the selected value first in the list, choose Move to top.

• To place the selected value last in the list, choose Move to bottom.

• To place the selected value below another value in the list, choose Move below,
choose the target value, and then choose OK.

You can also choose Remove to remove the selected value from the selected list.

Saving Value Selections
A saved selection is a set of dimension values that you save to use again in other 
documents. Saved selections are useful when you want to quickly retrieve a group of 
values without repeating the steps that you followed to select them. Selections that are 
saved as steps) also provide the ability to dynamically update your analyses. 

Once you define a saved selection, you can replace the dimension values in an open ad 
hoc report, ad hoc graph, worksheet, or predefined report with the saved selection. 

The following procedure describes how to create a saved selection when you the 
process of selecting values for a dimension.

To save selected values as a saved selection:
1. Choose the values that will comprise the saved selection.

You can select individual values. You can also use the buttons on the Data Selection
toolbar to select values by specific criteria.

2. When your selections are complete, choose the Save Current Selection button on 
the toolbar. 

3. Result: The Save a Selection for Dimension dialog box opens.

4. In the Save a Selection for Save a Selection for Dimension dialog box, enter information 
for the saved selection as follows:

1. In the Save current selection as box, enter a name for the saved selection, up to 
70 characters long.
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2. In the Description box, you can enter optional text to describe the components 
of the saved selection.

3. Specify how to save the selection: 

• Save steps — Saves the script that drives the selection criteria, rather than 
the actual values. Select this option when you anticipate applying the same 
criteria repeatedly over a long period of time, but expect that the values 
that comprise the selection might change. 

• Save members — Saves the actual dimension values. A member selection is
always comprised of the same values, regardless of when the selection is 
applied. Select this option when you want to examine data for the same 
dimension values on an ongoing basis. 

For more information about these options, see "Defining Saved Selections", 
page 20-1.

Note: If you used the drag and drop method or a right 
mouse button function to sort values for the selection, you 
will not be able to save steps.

5. Choose OK to save the selection.

Result: The saved selection will be appear as an object in the Saved Selections folder
for the dimension. 
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23
Sharing Data 

This chapter covers the following topics:

• About Sharing Data

• Sending Measures

• Notifications About Collaboration Measures

• Receiving Measures

• Viewing Collaboration History

About Sharing Data
Oracle Demand Planning provides tools that enable planners and the Demand Plan 
Manager to share their most current data before providing final submissions to the 
shared database. Users share data by sending and receiving measures, or portions of 
measures, that contain the data.

Sharing is established through planner assignments
The extent to which planners can share data is established in Demand Plan 
Administration, where the administrator defines planner assignments. Assignments 
specify the data values that planners are responsible for forecasting and the scope of the
data that they can view. 

Collaborative relationships are established when the administrator gives planners 
viewing rights to data that other planners are responsible for forecasting. 

If dependent demand has been enabled in the Demand Planning Server and model bills 
of material have been brought into Demand Planning, assignments must also take 
account of product and model relationships. For example, if one planner is responsible 
for options while another is responsible for their parent model, the parent model should
be in the view scope of the first planner and in the edit scope of the second planner.



23-2    Oracle Demand Planning Implementation and User's Guide

Sharing is limited to assignment scopes
The data that a planner can share with others is limited to the values that he or she is 
responsible for forecasting. Only that portion of the data will be updated in other 
planners' views and in the shared database. Data is shared at the lowest available 
allocation level, as specified in the Demand Planning Server for the data stream on 
which the measure is based. 

Note: To view the lowest available allocation level for a measure, click 
the right mouse button on the measure object in the Navigation list and 
view its properties.

Demand Planner: Sharing data
When you work as a planner you can share data for a stored, shared measure. A stored 
measure is permanently stored in the database, as opposed to a formula measure which 
is calculated on the fly. A shared measure is one that has been distributed to you, as 
opposed to a measure that you created in your personal database. 

You might want to share a measure when you have changed its values. Note that when 
editing a shared measure, you should avoid locking cells at aggregate levels as it is 
possible for a locked cell to be modified if a measure is received that affects the cell. 

Note: Only the data values that you are responsible for forecasting and 
related comments will be shared. If you change the measure definition 
(for example, apply an event factor), the resulting values will be shared 
but the definition will not.

Demand Plan Manager: Sharing Data
When you work as a Demand Plan Manager, you can share data for stored, shared 
measures. You might want to share a measure when you have changed its values. You 
can also share updates to input parameters that have been previously distributed to 
planners. For example, if you know that new data for an input parameter has recently 
been downloaded and a distribution has been run, you might want to share the 
measure with your planner community. This will enable planners to quickly view the 
latest version of the data. 

Note: You cannot share, immediately, a measure that you have just 
defined. Before you can share the measure, it must be populated in the 
shared database, included in planners' assignments, and distributed to 
planners.
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Sharing Demand Planning Objects
Demand plan managers and planners create personal objects within their workspaces 
that are normally inaccessible to other users. 

These personal objects can include any or all of the items listed below:

• custom aggregates

• documents (worksheets, reports, graphs)

• folders

• saved dimension selections.

Oracle Demand Planning provides the Share Objects dialog box as a means for users to 
share, update, and delete objects.

Why Managers and Planners Share Objects
After a plan has been initially populated, the planning manager may define documents, 
saved selections, and custom aggregates that could be useful to planners.

In the planning manager's role, checking the Share related objects box in the Shared 
Objects dialog box enables you to make custom aggregates and saved selections 
automatically available to each planner who has access to a plan for which these objects 
are defined and shared. 

Sharing related objects is helpful when other shared objects that planners use contain 
references to these objects.

Ownership of Shared Objects
Objects shared by managers and planners retain a linkage to the originator and cannot 
be updated or overwritten by anyone except the originator.

The creator or originator of a shared object can remove it from the shared workspace. 
The original, private copy of the object, however, is not affected. 

Characteristics of Shared Objects
Several important characteristics of shared objects are listed below.

• Shared documents can be viewed, manipulated, and saved as new documents with 
different names. 

• Shared custom aggregates and shared saved selections can be viewed, but their 
definitions cannot be modified nor saved under new names.

• Shared documents can be viewed, manipulated, and saved as new documents with 
different names.
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Additional rules that govern the behavior of shared objects in the Navigation List: 

For demand plan managers:

• Objects created and shared by plan managers cannot be updated or overwritten by 
anyone except the object's originator.

For managers and planners:

• Objects that have been shared by either planning managers or demand planners are
identified in the Navigation List by icons that indicate sharing. The icon for a 
shared object looks like the normal icon for that type of object, but has a 'hand' 
attached. 

• The originator of a shared object still sees a personal, unshared copy in the 
Navigation List.

• If the originator of a shared object deletes the personal copy, the shared copy 
remains in the Navigation list in place of the personal object.

• You cannot overwrite a shared object by saving a personal object with of the same 
type with the same name.

Shared objects are validated during synchronization at session startup. Objects that 
cannot be corrected for a user's assignment are marked as invalid. This may occur, for 
example, if the objects to which a shared object is linked become unavailable.

Ifi a document has been shared and its selection definition contains aggregates that 
have not been shared, for example, Demand Planning drops the aggregates from the 
selection.

Using the Shared Objects Dialog Box
Follow the steps below to access the Share Objects dialog box and share objects with 
other demand planners.

1. Choose the Tools button on the Navigation List.

2. Select the Share command from the Tools submenu.

3. Select an object type from the Share submenu, which displays the choices 
Documents, Document Folders, Custom Aggregates, and Saved Selections. When 
the dialog box opens, it will display objects of the selected type.

4. The Share Objects dialog box displays a list of personal objects of the selected type in
the Personal Objects box. Select the objects you want to share.

5. Move objects into the Shared Objects box by clicking on the Share (arrow) button.

6. Check the Share Related Objects box if you want to also share all objects 
referenced by the personal objects that you have selected for sharing. The checkbox 
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is selected by default. 

7. The shared objects are displayed in two columns – one for the name of the object 
and one for the originator or owner. The shared object list contains all objects that 
have been shared by the current user as well as all the objects that have been shared
by other users. 

8. Deleting shared objects differs according to your responsibility (role), as described 
below.

• As a planning manager, you can enable the Delete button by selecting an item 
in the Shared Objects box. Deleting the object will delete the shared copy, if 
you are not the owner, or the original copy, if you are the owner. This means 
that you can also delete the shared copies of your object in this way

• As a demand planner, you can only enable the Delete button by selecting an 
object of which you are the originator. You delete the object and its shared 
copies by doing this.

9. Use the drop down list in the Object Type box to change the display according to 
object type. 

Once the sharing process is completed, Oracle Demand Planning updates the 
shared object list with all objects that have been successfully shared. 

If you rename an object elsewhere and then reshare it in the Share Objects dialog 
box, the dialog treats the previously shared object as the same object, and 
automatically updates the name of the shared object to match the renamed personal
object.

10. Choose the Close button to close the dialog box

Sending Measures
In order to share data with others, you "send" the measure or measures that contain the 
data. You can choose to send all of the data for a measure or you can limit the data to 
specific geographies, products, and time periods. 

Note: Oracle recommends that you send only those measures or 
portions of measures that need to be updated. For example, if you 
know that a specific area of the data cube has been modified, then you 
should only send that area. This will make both sending and receiving 
more efficient.



23-6    Oracle Demand Planning Implementation and User's Guide

To send measures:
1. Access Oracle Demand Planning as a Demand Planner or Demand Plan Manager.

2. On the Navigation toolbar, choose the Tools button. 

3. Choose Collaboration from the submenu and then choose Send.

Result: The Send Measures dialog box opens. 

4. In the Select Measure to Send box, the Available box displays measures that you 
can send. Select measures to send as follows:

• To select a single measure, double-click its name in the Available box

or

• Highlight it and choose the single arrow button that points to the Selected box.

• To select multiple nonsequential measures, press and hold the CTRL key, 
choose each measure that you want to add, and then choose the single arrow 
button that points to the Selected box.

• To select multiple sequential measures, select the first measure that you want to
add, press and hold the SHIFT key, select the measure that you want to add, 
and then choose the single arrow button that points to the Selected box. You can 
also select the events to add by clicking and dragging the mouse. 

• To select all measures, choose the double arrow button that points to the 
Selected box.

5. To send all values that you are responsible for forecasting, in the Send Options box,
choose Send entire assignment scope of measure.

6. To limit the data to specific values that you are responsible for forecasting, choose 
Send selected values of measures and choose the portion of the measure to send as
follows:

1. In the Dimension/Level grid, choose a dimension and select a level. This level 
will apply for this dimension to all measures that you send.

Note: The level that you set determines the selection list for 
dimension values. It does not affect the level at which the data 
will actually be sent. This is always the lowest available 
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allocation level for the measure. To view the lowest available 
allocation level for a measure, click the right mouse button on 
the measure object in the navigation list and view its 
properties.

2. Repeat the previous step for each dimension.

Result: The Edit button becomes active.

3. Choose Edit. 

Result: The Select Data dialog box opens for the first dimension. The values that 
you see are filtered by the level that you chose earlier. Proceed as follows: 

• Choose values for the dimension by moving values between the Available 
box and Selected box until the Selected box displays the values that you want
to keep for the current dimension. 

• Repeat the previous steps for the next dimension.

• Choose OK to save the current selections. 

Result: You are returned to the Send Measures dialog box. 

Note: The OK button is only enabled when you have 
selected values for all dimensions.

7. Choose OK to send measures.

Example: Sending Measures
You can send the entire assignment scope of a single measure.
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Notifications About Collaboration Measures
Each planner whose view scope includes a measure that you send will receive a 
message that collaboration measures are ready to be received. The message will be 
displayed in their Notifications list. 

Receiving Measures
A message appears in your Notifications list when there are measures that are ready to 
be received. 

Note: Oracle recommends that you choose to receive only those 
measures that you currently need for your analyses. When data is 
received, it must be imported and aggregated, which can be time 
consuming. The more measures that you receive, the more time the 
process will take.



Sharing Data     23-9

To receive measures:
1. Access Oracle Demand Planning as a Demand Planner or Demand Plan Manager.

2. Click the notification.

Alternatively, you can choose the Tools button on the Navigation toolbar 

3. and choose Collaboration and then Receive.

Result: The Receive Measures dialog box opens. 

4. In the Receive Measures dialog box, the Available measures box displays measures 
that you can receive. Choose measures to receive as follows:

• To select a single measure, double-click its name in the Available box

or

• Highlight it and choose the single arrow button that points to the Selected box.

• To select multiple nonsequential measures, press and hold the CTRL key, 
choose each measure that you want to add, and then choose the single arrow 
button that points to the Selected box.

• To select multiple sequential measures, select the first measure that you want to
add, press and hold the SHIFT key, select the measure that you want to add, 
and then choose the single arrow button that points to the Selected box. You can 
also select the events to add by clicking and dragging the mouse. 

• To select all measures, choose the double arrow button that points to the 
Selected box.

5. Choose OK to receive measures. 

Viewing Collaboration History
The Collaboration History log enables you to view and sort information about actions 
that are related to data sharing. 

The Collaboration History Log provides the following information:

• Action — The action that occurred.

• Send — The measure was sent.
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• Receive — The measure was received.

• Download — The measure was downloaded from the Demand Planning 
Server.

• Distribution — The measure was distributed.

• Measure — The name of a measure affected by the action.

• Timestamp — The date on which the action occurred.

• Assignment — For an action initiated by a planner, this is the name of the planner's 
assignment. For an action initiated by the Demand Plan Manager, this is "Planning 
Manager"; for an action initiated by the Demand Planning System Administrator, 
this is "Administrator."

• User — For an action initiated by a planner, this is the user ID of the individual who
initiated the action. For an administrator, this is "Demand Plan Administrator." For 
a Demand Plan Manager, this is "Demand Plan Manager."

To view collaboration history:
1. Access the Demand Planning Administration page.

2. In the Navigation list, choose Collaboration History.

To sort collaboration history:
Note: By default, collaboration history is sorted by date. 

With the Collaboration History page open, choose the label of the column by which you
want to sort the list.

Example: Collaboration history
For example, you can sort the Collaboration History log by assignment name, by 
choosing the Assignment column label.
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24
Selecting Measures to Submit or Upload

This chapter covers the following topics:

• About Scenarios 

• Demand Planner: Selecting Measures to Submit 

• Demand Plan Manager: Selecting Measures to Upload 

• Automating the Submissions Process

• Viewing Scenario Properties

About Scenarios 
A scenario is a repository for maintaining, archiving, and viewing the forecasts that are 
submitted for a demand plan. Scenarios are defined in the Demand Planning Server and
linked to demand plans. A plan might have one scenario or multiple scenarios. For 
example a plan with multiple scenarios might include an "optimistic" scenario, a 
"pessimistic" scenario, and a "realistic" scenario.

If your responsibility is Demand Planner, you can select a measure to submit as your 
final forecast for each scenario. If Oracle Demand Planning is integrated with Oracle 
Inventory Optimization (IO), you can also select a measure of statistical accuracy to 
submit with the forecast. Selecting a measure to submit marks the data for consolidation
in the shared database where it will be reviewed by the Demand Plan Manager. 

If your responsibility is Demand Plan Manager, you can select a measure to upload as 
the final forecast for each scenario. If Oracle Demand Planning is integrated with Oracle
Inventory Optimization (IO), you can also select a measure of statistical accuracy to 
upload with the forecast. Selecting a measure to upload marks the data for writing to 
the Demand Planning Server. You also have the option to initiate the process that runs 
the upload.



24-2    Oracle Demand Planning Implementation and User's Guide

Demand Planner: Selecting Measures to Submit 
When you are satisfied with your forecast for a scenario, you can choose the measure 
that contains the forecast data and mark it for submission to the shared database. 

Selecting measures to submit is not mandatory. If you do not select a specific measure to 
submit for a scenario, then Oracle Demand Planning will use the default submissions 
measure for the portion of the data that you are responsible for forecasting.

Note that when you select a measure to submit, you are choosing to submit all data for 
all dimensions of the measure; that is, data for all time periods, all geographies, all 
locations, and all products. 

If you select the wrong measure, if you discover that a measure that you previously 
selected does not include the correct values, or if the Demand Plan Manager requests 
that you edit your data, you can resubmit the same measure or an alternate measure. 
Your selections are valid until data collection is terminated.

When data collection runs, data will be submitted at the lowest available level for the 
values in your assignment scope. When the data is collected into the shared database 
during the data collection process, it will be aggregated up using the aggregation 
method of the submissions measure in the shared database. Thus, formula measures or 
measures that have non-standard aggregation methods may show different results at 
aggregate levels in the shared database.

How data is submitted for dependent demand
If you submit a measure that has a dependent association with other products, then the 
current values for the related planning percentages will be automatically submitted 
with the measure. If you have edited data for dependent demand or planning 
percentages, ensure that the appropriate planning percentage object is associated with 
the measure that you submit. For example, if you used the Planning Percentages 
worksheet to modify planning percentages for MyPlanningPercentage which is 
associated with MyMeasure but then you do not submit MyMeasure or another measure 
associated with MyPlanningPercentage, the submission will use the existing planning 
percentage object.

Before you proceed: Check scenario time horizon and output level
When the submission runs, Oracle Demand Planning runs a validation check to ensure 
that at least one Time dimension value has data at the top level for all other dimensions.
If the measure is NA (unavailable) for all time values at the specified output level for 
the scenario, then a warning message will appear.

For example, if a scenario has been defined in the Demand Planning Server with a time 
horizon range of 01/01/2003 through 12/31/2003 and an output level of Month for the 
Time dimension, the validation will ensure that at least one Time value in the measure 
selected for submission has data for the top level for all other dimensions. Even if there 
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is only data for one out of the twelve months, the submission will succeed. However, if 
none of the twelve months has data, then a warning message will appear. 

Before you select a measure to submit for a scenario, you might want to check the time 
horizon and output level that are defined for the scenario in the Demand Planning 
Server. This can help you to avoid an unsuccessful submission. To see scenario time 
horizon and output levels, you can check the properties of the scenario. For more 
information, see "Viewing Scenario Properties", page 24-11.

Selecting measures to submit
To select a measure to submit for a scenario, you choose the measure from the list of 
available measures. If the scenario for requires an accuracy measure, you can also 
choose an accuracy measure. 

To submit a measure for a scenario:
1. Access Oracle Demand Planning as a Demand Planner.

2. On the Navigation toolbar, choose the Tools button. 

3. From the submenu, choose Submit Measures.

Result: The Submit Measures dialog box opens, displaying submission information 
for each scenario in the demand plan. If a measure has not yet been submitted for a 
scenario, the Measure to Submit column shows the default submissions measure 
for the scenario if a default measure has been set; otherwise, it shows "None." If a 
measure has previously been submitted for the scenario, the Previously Submitted 
column displays the name of this measure; otherwise it displays "None."

4. To select an alternate measure (or to select a measure if "None" is the current 
selection), in the Measure to Submit column, choose the measure that you want to 
submit.

Note: Do not select a measure that has been limited by a qualifying 
value such as a single geography. If you do so, then the qualifying 
value will be used to generate uploaded values for all dimension 
values at this level. 

5. If an accuracy measure is required for the scenario, you can select a measure from 
the Accuracy Measure column. It will display all measures that are not 
dimensioned by Time, including those you have created, either by creating a 
formula, or by calculating a new one based on other accuracy measures. 

6. To select a measure to submit a measure for another scenario, repeat Steps 4 and 5.
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Note: It is not necessary to select measures for all scenarios at the 
same time. However, if you have previously selected a measure for 
one scenario and you are satisfied with your choice, choose "None" 
as the measure to submit for that scenario when you select a 
measure to submit for another scenario.

7. Choose OK.

Example: Selecting measures to submit
For example, the planner can select measures to submit for two scenarios. The planner 
can also submit accuracy measures for one of the scenarios.

Demand Plan Manager: Selecting Measures to Upload 
As a Demand Plan Manager, you review and edit the consolidated forecast for each 
scenario after the Collect Data from Planners stage runs. When you are satisfied with 
the final forecast numbers for a scenario, you can select the measure that contains the 
data for uploading to the Demand Planning Server. You also have the option to run the 
upload immediately.

Selecting measures to upload is not mandatory. If you do not select a measure to upload 
for a scenario, then Oracle Demand Planning will upload the consolidated submissions 
measure along with related objects such as accuracy measure and planning percentages 
for that scenario when the Upload to Planning Server stage runs. The system will name 
the forecast and assign a version number. If the measure has been previously uploaded, 
it will increment the version. 

You will want to select a measure to upload for a scenario in the following 
circumstances:

• You want to explicitly specify which measure will be written back to the Demand 



Selecting Measures to Submit or Upload    24-5

Planning Server for the scenario. You do not want to write back the consolidated 
submissions measure.

• You want to overwrite a previous submission. 

• You want to use the use the option to upload selections immediately. You do not 
want to wait until the administrator runs the upload.

Note that when you select a measure to upload, you are choosing to upload all data for 
all dimensions in the forecast. You are uploading quantity and amount for all time 
periods, all geographies, all locations, and all products. 

What data is uploaded for dependent demand
If you upload a measure that has a dependent association with other products, then the 
planning percentages that are associated with the measure will be automatically 
uploaded with the measure. Therefore it is important to choose a measure that is 
associated with the consolidated planning percentage object. 

Uploading a version or overwriting a forecast 
Oracle Demand Planning maintains multiple versions of a measure. Thus, you might 
have Optimistic Scenario Version #1, uploaded on February 1, 2003, Optimistic Scenario
Version #2, uploaded on March 1, 2003, and so forth.

The first time that you upload a measure for a scenario, the system stamps the forecast 
with the current date and assigns it a version number of 1. The next time that you 
attempt to upload a measure for the same scenario, the system default is to stamp the 
measure with the new date and increment the version number. 

However, in certain cases, you might want to overwrite the measure rather than upload 
a new version. For example, if you uploaded a submission measure on February 1 and 
suddenly heard about an upcoming sales promotion that will have a major impact on 
sales, you might want planners to rework and resubmit their forecasts. In this case, you 
could then upload the consolidated submission measure and overwrite the February 1 
forecast rather than submit a new forecast version.

Before you proceed: Check scenario time horizon and output level
When the upload runs, Oracle Demand Planning performs a validation check to ensure 
that at least one time dimension value has data at the top level for all other dimensions. 
If the measure is NA (unavailable) for all Time dimension values at the specified output
level for the scenario, then a warning message will appear.

For example, if a scenario has been defined in the Planning Server with a time horizon 
range of 01/01/2003 through 12/31/2003 and an output level of Month for the Time 
dimension, the validation will ensure that at least one Time value in the measure 
selected for submission has data for the top level for all other dimensions. Even if there 
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is only data for one out of the twelve months, the submission will succeed. However, if 
none of the twelve months has data, then a warning message will appear. 

Before you select a measure to upload for a scenario, you might want to check the time 
horizon and output level that are defined for the scenario in the Planning Server. This 
can help you to avoid an unsuccessful upload. 

To see scenario time horizon and output levels, you can check the properties of the 
scenario. For more information, see "Viewing Scenario Properties", page 24-11.

Selecting measures to upload
To select a measure to upload for a scenario, you choose the measure from the list of 
available measures. If the scenario requires an accuracy measure, you can also choose 
an accuracy measure. You also have the option to run the stage that uploads data from 
the shared database to the Demand Planning Server. 

To select measures to upload for a scenario:
1. Access Oracle Demand Planning as a Demand Plan Manager.

2. On the Navigation toolbar, choose the Tools button. 

3. From the submenu, choose Select Upload Measure. 

Result: The Select Upload Measure dialog box opens. If a measure has not yet been 
uploaded for a scenario, the Measure to Upload column shows the consolidated 
submissions measure as the default measure to upload for the scenario. If a 
measure has previously been uploaded for the scenario, the Previously Submitted 
column displays the name of this measure.

4. To select an alternate measure, in the Measure to Upload column choose the 
measure that you want to upload.

Note: Do not select a measure that has been limited by a qualifying 
value such as a single geography. If you do so, then the qualifying 
value will be used to generate uploaded values for all dimension 
values at this level. 

5. The Forecast Name column displays a default name. You can accept this 
information, or you can take one of the following actions:

• Type a new name in the Forecast Name box, up to 70 characters long.

• Click in the column to view a list of forecast names and select a name from the 
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list (overwrite the forecast).

6. If an accuracy measure is required for the scenario, the Type column displays the 
type of accuracy statistic specified for the scenario in the Demand Planning Server. 
The Accuracy Measure column displays the default accuracy measure for the 
scenario. You can choose an alternate measure. 

7. Repeat Steps 4 through 6 for each scenario for which you want to select a measure 
to upload.

Note: If there are multiple scenarios in the demand plan, it is not 
necessary to select measures to upload for all scenarios at the same 
time. However, if you have previously uploaded a measure for one 
scenario and you are satisfied with the data, choose "None" as the 
measure to upload for that scenario when you upload the final 
forecast for another scenario.

8. Choose OK. 

To run the upload immediately:
1. In the Select Upload Measure dialog box, check the Upload Measures to Planning 

Server Now box.

2. Choose OK.

Note: Consult with the Demand Planning System Administrator 
before you choose this option. Running the upload might duplicate 
an automated program or an administrative action.

Example: Selecting measures to upload
The Demand Plan Manager can select measures to upload for two scenarios. The 
manager can also upload an accuracy measure for one of the scenarios. He or she may 
not choose to run the upload immediately, though.
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Automating the Submissions Process
You can collect and consolidate forecasts submitted by demand planners into the same 
measure in every planning cycle. Reusing the same submissions measure allows you to 
automate the demand planning process.

Introduction
Once a demand plan is built, the System Administrator runs the five stages in the 
planning cycle. During that cycle, after the data is downloaded and measures 
populated, the Distribute to Planners stage distributes data in the shared database to 
authorized demand planners. Submissions measures are created during theDistribute 
to Assignments stage.

The Benefits of Automatic Submissions
During each distribution, a new submission measure is created for each scenario. The 
number of submission measures can increase dramatically over time, depending upon 
the number of scenarios and how often they are distributed.

For example, if you create three scenarios and then, for whatever reason, redistribute 
twice, you have three distributions of three scenarios, producing 9 submission 
measures.

The proliferation of submission measures does provide a useful purpose by enabling 
the Demand Planning Manager to keep track of data changes and forecast versions. 

The downside of the proliferation of submission measures is that record-keeping 
problems and resource allocation shortages may eventually result.
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Administrator Options for Configuring Submissions Measures
Your System Administrator has the option of reusing submission measures. The 
Administrator may stipulate that the submission measure created during the first 
Distribute to Assignments stage will be used with every subsequent redistribution.

Your Demand Planning System Administrator has the options described below.

• To allow users to create only one set of Submission measures -- one for each 
scenario. (Measures are reused automatically.)

• To allow users to create new sets of Submission measures with each Distribute to 
Assignments process. (Measures not reused.)

• To allow users to switch from reusable to non-reusable Submission measures and 
vice versa.

The System Administrator sets the appropriate option for the creation of Submission 
measures by using a checkbox in the Scenarios page.
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Procedure: Setting Up Automatic Submissions Measures
The procedure described below enables the use of a submission measure that is used 
with every redistribution.

1. In the System Administrator's interface, select Scenarios from the Navigation List.

2. Go to the Scenarios page. This page has columns for scenarios and corresponding 
default measures.

• The Do not create new submissions measure every planning cycle box is 
available and unchecked.

• The Apply button is disabled.

3. Check the box to create a reusable submissions measures.

When the box is checked, the Apply button is enabled.

4. Choose Apply.

5. Further consequences of using or not using the Do not create new submissions 
measure every planning cycle box are discussed below.

• If the you leave the checkbox blank, a new set of Submission measures will be 
created with each Distribute to Assignments process.

• If Submission measures have already been created and the System 
Administrator chooses Do not create new submissions measure every 
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planning cycle, the most-recently created Submission measures are used 
automatically. The conditions below also apply.

• No new Submission measures will be created. 

• Existing sets of submission measures (previous versions) remain in the 
system; they are not automatically be deleted.

• If Do not create new submissions measure every planning cycle is checked 
before the first "Distribute to Assignments" process and has never been 
changed , only one set of Submission measures will exist, with one Submission 
measure per scenario.

• If this checkbox is unchecked after being checked, new sets of Submission 
measures are added to existing list after each Distribute to Assignments 
process.

Viewing Scenario Properties
Before you submit or upload measures, you might want to view the properties of a 
scenario. The following information is available. 

• Name

• Horizon Range

• Default Measure Association

• Submitted Measure (if a measure for this scenario has been previously 
submitted)

• Uploaded Measure (if a measure for this scenario has been previously 
uploaded) 

• Output Levels

• Accuracy Measure Type (if an accuracy measure has been associated with the 
scenario in the Demand Planning Server)

To view scenario properties:
1. Access Oracle Demand Planning as a Demand Planner or Planning Manager.

2. In the Navigation list, locate the scenario whose properties you want to view.

3. Click the right mouse button on the object and choose Properties from the popup 
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menu.
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25
Working with Alerts and Notifications

This chapter covers the following topics:

• About Alerts

• Defining Alerts

• Modifying Alerts

• Disabling Alerts

• Enabling Alerts

• Manually Running Alerts

• Renaming Alerts

• Viewing Alert Properties

• Deleting Alerts

• Working with Notifications

About Alerts
An alert is an exception condition that generates a message to specified users when the 
condition has been met. When the alert runs, it generates an electronic mail message to 
each recipient for whom the exception condition is true.

If your role is Demand Planner, you might define an alert to warn yourself when a 
product or group of products have unacceptable margins for a specified time period. If 
your role is Demand Plan Manager, you might define an alert to warn planners when 
their forecasts over- or under- predict actuals.

Note: In order to generate alert messages, E-mail messaging must be set
up and enabled in Oracle Workflow. In order for you to receive E-mail 
alerts, your Preferences must be set to receive Workflow messages via 
E-mail.
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How alerts are displayed
The Alerts folder in the Navigation list displays all alerts that you have defined.

Your Notifications list displays only those alerts that meet all of the following criteria:

• You defined the alert.

• The alert has run.

• The exception condition has been met.

Example: Display of alerts and notifications
Consider an example, where the user has defined two alerts, both of which are 
displayed in the Alerts folder in the Navigation list. One of the alerts is also displayed 
in the Notifications list, indicating that the alert has run and the exception condition has
been met. The Notifications list also displays a message that there are collaboration 
measures ready to be received.
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Defining Alerts
You create an alert by defining the exception condition that will trigger the E-mail 
message. You also specify when and how the alert will run. 

You can select one of the following as the basis for the exception: 

• Value — Sets up a comparison between a measure and a numeric value or range of 
values. 

• Measure — Sets up a comparison between two measures. 

Defining an alert based on a value exception
An alert that is based on a value exception compares a measure to a numeric value or 
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range of values. For example, you might use the Value option to alert yourself or other 
users when a forecast difference measure (a custom measure defined as forecast less 
actuals) is less than or greater than a specific number.

To define an alert that compares a measure with a numeric value or range of values:
1. Access Oracle Demand Planning as a Demand Planner or Demand Plan Manager.

2. On the Navigation toolbar, choose the New button.

3. and choose New Alert from the popup menu. 

Alternatively, you can click the right mouse button on the Alerts folder in the 
Navigation list and choose New Alert from the popup menu. 

Result: The Alert Wizard - Exception page opens. 

4. In the Alert Wizard - Exception page, define exception criteria as follows:

1. In the Select box, choose the dimension to which the exception condition 
applies. 

2. In the within box, click the arrow to display the hierarchies for the dimension. 
Select a hierarchy and then select a level within the hierarchy. 

3. In the condition box, select Value.

4. In the measure box, select the measure on which to base the exception condition.

You can accept the default measure or choose the Ellipsis button to access the 
Dimension Value Selector dialog box, where you can select an alternate measure.

5. In the operator box, select the operator that identifies how data values will 
compare to a specified value. You can select one of the following terms:

• less than

• less than or equal to 

• equal to

• not equal to

• greater than or equal to

• greater than
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• between

• outside

6. Complete the value box (or boxes) as follows:

• If the operator is other than between or outside, enter a number that is to 
be compared to the values of the selected measure. 

• If the operator is between or outside, enter the top and bottom of the value 
range that is to be compared to the values of the selected measure.

5. Choose Next to continue.

Result: The Alert Wizard - Dimension Selections page opens.

6. The Alert Wizard - Dimension Selections page displays dimension value selections 
that further define the exception condition. You can accept the defaults, or make 
new selections. Proceed as follows:

1. Select a dimension and choose the Selector button. 

Result: The Select Data dialog box opens, displaying the current values that are 
selected for the dimension.

2. Move values between the Available and Selected boxes until the Selected box 
contains the dimension values that you want to use. Choose OK to return to the
Alert Wizard - Dimensions Selections page.

3. Repeat the steps above for each dimension for which you want to change 
values.

Note: For the exception dimension, you can only refine the 
selection by removing values.

7. Choose Next to continue. 

Result: The Alert Wizard - Notification Type and Content page opens.

8. In the Alert Wizard - Notification Type and Content page, proceed as follows: 

1. In the Available box, select the users who will receive E-mail containing the alert
notification when the exception condition has been met. 

The Selected box displays your choices.

2. In the Priority box, specify a priority: Low or High.
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3. The Subject box displays default text for the alert name. You can enter a new 
name, up to 70 characters long.

4. The Message box displays default text for the E-mail message. This is the text 
that will appear at the top of the E-mail notification. You can edit the text. 

5. Specify how you want the E-mail message to display: 

• Select HTML Report to display the E-mail message as a report.

• Clear HTML Report to limit the E-mail to the text that you entered in the 
Message box.

9. Choose Next to continue. 

Result: The Alert Wizard - Set Execution Times page opens.

10. The Enable Alert box is checked, indicating that the alert is active. Specify when to 
execute the exception conditions (run the alert) as follows: 

• To execute the exception conditions now, choose Immediately.

• To execute the exception conditions when the Distribute to Planners batch 
runs, choose On Database Update.

• To execute the exception conditions now and each time that the database is 
updated, choose both Immediately and On Database Update.

Note: You can opt not to specify an execution option. Instead, 
you can disable the Enable Alert box and run the alert 
manually as described in the section "Manually Running 
Alerts", page 25-13.

11. Choose Finish to create the alert.

Result: The alert object appears in the Alerts folder in the Navigation list. 

Example: Alert definition based on value exception
Consider an example, where the user defines a value exception that will be met when 
the Booking History - Booked Items, Quantity for the specified products is greater than 
200,000. 
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Defining an alert based on a measure exception
An alert based on a measure exception compares the values for one measure to the 
values of another measure. For example, you might use the measure exception to alert 
yourself or other users when a forecast for a specified time period exceeds the customer 
forecast by a specified percentage.

To define an alert based on a measure exception:
1. Access Oracle Demand Planning as a Demand Planner or Demand Plan Manager.

2. On the Navigation toolbar, choose the New button, 

3. and choose New Alert from the popup menu. 
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Alternatively, you can click the right mouse button on the Alerts folder in the 
Navigation list and choose New Alert from the popup menu. 

Result: The Alert Wizard - Exception page opens. 

4. In the Select box of the Alert Wizard - Exception page, define the exception condition 
for the alert as follows: 

1. In the Select box, choose the dimension to which the exception applies.

2. In the within box, click the arrow to display the hierarchies for the dimension. 
Select a hierarchy and then select a level within the hierarchy.

3. In the condition box, select Measure.

4. In the first measure box, select the measure on which to base the exception 
condition. 

You can accept the default measure or choose the Ellipsis button to access the 
Dimension Value Selector dialog box, where you can select an alternate measure.

5. In the operator box, select the operator that identifies how the measure that you 
chose earlier will relate to a comparison measure. You can select one of the 
following terms:

• less than

• greater than

• within

• not within

6. In the measure box, select a comparison measure. 

You can accept the default value or choose the Ellipsis button to access the 
Dimension Value Selector dialog box, where you can choose an alternate measure.

7. You can specify a numeric or percentage value to consider when comparing the
measures. To do this, proceed as follows: 

• If the operator is less than or greater than, choose plus or minus. If the 
operator is within or not within, plus or minus is the only selection. 

• In the value box, enter a numeric value.

• If the value is a percentage, choose percent.

5. Choose Next to continue.
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Result: The Alert Wizard - Dimension Selections page opens.

6. The Alert Wizard - Dimension Selections page displays dimension value selections 
that further define the exception condition. You can accept the defaults, or make 
new selections. Proceed as follows:

1. Select a dimension and choose the Selector button. 

Result: The Select Data dialog box opens, displaying the values that are 
currently selected for the dimension.

2. Move values between the Available and Selected boxes until the Selected box 
contains the dimension values that you want. Choose OK to return to the Alert 
Wizard - Dimensions Selections page.

7. Choose Next to continue. 

Result: The Alert Wizard - Notification Type and Content page opens.

8. In the Alert Wizard - Notification Type and Contentpage, proceed as follows: 

1. In the Available box, select the users who will receive E-mail containing the alert
when the exception condition has been met. The Selected box displays your 
choices.

2. In the Priority box, specify a priority: Low or High.

3. The Subject box displays default text for the alert name. You can enter a new 
name, up to 70 characters long.

4. The Message box displays default text for the E-mail message. This is the text 
that will appear at the top of the E-mail notification. You can edit the text. 

5. Specify how you want the E-mail message to display: 

• Select HTML Report to display the E-mail message as a report.

• Clear HTML Report to limit the E-mail to the text that you entered in the 
Message box.

9. Choose Next to continue. 

Result: The Alert Wizard - Set Execution Times page opens. 

10. The Enable Alert box is checked, indicating that the alert is active. Specify when to 
execute the exception conditions (run the alert) as follows: 

• To execute the exception conditions now, choose Immediately.
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• To execute the exception conditions when the Distribute to Planners stage 
runs, choose On Database Update.

• To execute the exception conditions now and each time that a distribution runs, 
choose both Immediately and On Database Update.

Note: You can opt not to specify an execution option. Instead, 
you can disable the Enable Alert box and manually run the 
alert as described in the section "Manually Running Alerts", 
page 25-13.

11. Choose Finish to create the alert. 

Result: The alert object appears in the Alerts folder in the Navigation list. 

Example: Alert definition based on measure exception
Consider an example, where the user defines a measure exception condition that will be
met when Revised Forecast, Quantity is greater than Booking History - Booked Items, 
Quantity plus 10%. 
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Modifying Alerts
You can change the definition of a saved alert. 

Note: If you edit the exception definition or the dimension selections, 
you do not have the option to specify when to run the alert. The alert 
will automatically run after you apply your changes.

To change the definition of an alert:
1. Access Oracle Demand Planning as a Demand Planner or Demand Plan Manager.

Note: To search for an alert, click the right mouse button on the 
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Alerts folder in the Navigation list and choose Find Alerts from the
popup menu. Then enter a name or name fragment. Alternatively, 
you can choose the Find button on the Navigation toolbar.

2. In the Navigation list, double-click the alert.

Alternatively, you can click the right mouse button on the alert object and choose 
Edit from the popup menu. 

Result: The Alert Wizard starts. The Alert Wizard - Exception page opens. 

3. Use the tabs, the Next button, and the Back button to move through the alert 
definition and change its attributes. You can also change the alert name. 

4. To save the alert definition, choose Finish.

Disabling Alerts
You can disable a saved alert. Disabling an alert makes its conditions inactive. The alert 
object remains on the Navigation list.

To disable an alert: 
1. Access Oracle Demand Planning as a Demand Planner or Demand Plan Manager.

2. In the Navigation list, identify the alert that you want to disable.

Note: To search for an alert, click the right mouse button on the 
Alerts folder in the Navigation list and choose Find Alerts from the
popup menu. Then enter a name or name fragment. Alternatively, 
you can choose the Find button on the Navigation toolbar.

3. Use one of the following techniques to make the alert inactive:

• Click the right mouse button on the alert and choose Disable from the popup 
menu. 

or

• Open the alert, choose the Execution Times tab and clear the Enable Alert box.

Enabling Alerts
You can enable an alert that has been disabled. Enabling an alert activates the alert 
conditions again.
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To enable an alert that has been disabled:
1. Access Oracle Demand Planning as a Demand Planner or Demand Plan Manager.

2. Identify the alert that you want to enable. 

Note: To search for an alert, click the right mouse button on the 
Alerts folder in the Navigation list and choose Find Alerts from the
popup menu. Then enter a name or name fragment. Alternatively, 
you can choose the Find button on the Navigation toolbar.

3. Use one of the following techniques to enable the alert:

• Click the right mouse button on the alert object and choose Enable from the 
popup menu. 

or

• Open the alert, choose the Execution Times tab and check the Enable Alert box.

Manually Running Alerts
You can manually run an active alert.

To manually run an alert: 
1. Access Oracle Demand Planning as a Demand Planner or Demand Plan Manager.

2. Identify the alert that you want to run.

Note: To search for an alert, click the right mouse button on the 
Alerts folder in the Navigation list and choose Find Alerts from the
popup menu. Then enter a name or name fragment. Alternatively, 
you can choose the Find button on the Navigation toolbar.

3. In the Navigation list, click the right mouse button on the alert object and choose 
Run from the popup menu. 

Renaming Alerts
You can give a new name to an alert.
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To rename an alert:
1. Access Oracle Demand Planning as a Demand Planner or Demand Plan Manager.

Note: To search for an alert, click the right mouse button on the 
Alerts folder in the Navigation list and choose Find Alerts from the
popup menu. Then enter a name or name fragment. Alternatively, 
you can choose the Find button on the Navigation toolbar.

2. In the Navigation list, click the right mouse button on the alert object and choose 
Rename from the popup menu.

3. Enter the new name, up to 70 characters long.

Viewing Alert Properties
You can view the properties of a saved alert.

To view the properties of an alert:
1. Access Oracle Demand Planning as a Demand Planner or Demand Plan Manager.

Note: To search for an alert, click the right mouse button on the 
Alerts folder in the Navigation list and choose Find from the popup
menu. Alternatively, you can choose the Find button on the 
Navigation toolbar.

2. In the Navigation list, click the right mouse button on the alert object and choose 
Properties from the popup menu. 

Result: The following information is displayed:

• Description

• Active

• Priority

• Exception Dimension

• Class

• Execute
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Deleting Alerts
When you no longer need to maintain an alert you can delete it. 

To delete an alert: 
1. Access Oracle Demand Planning as a Demand Planner or Demand Plan Manager.

2. In the Navigation list, identify the alert that you want to delete.

Note: To search for an alert, click the right mouse button on the 
Alerts folder in the Navigation list and choose Find Alerts from the
popup menu. Then enter a name or name fragment. Alternatively, 
you can choose the Find button on the Navigation toolbar.

3. Select the alert object and choose the Delete button on the Navigation toolbar.

4. Alternatively, you can click the right mouse button on the alert object and choose 
Delete from the popup menu.

Result: You will be prompted to confirm the deletion.

Working with Notifications
Your Notifications list displays messages that have been generated by Oracle 
Workflow. You might see two types of notifications:

• When there is an alert for your attention, a notification concerning the alert is 
displayed. 

• If another planner or the Demand Plan Manager has sent data that is within the 
scope of your assignment, a notification that collaboration measures are ready to 
receive is displayed. 

You can work with notifications as follows:

• Open a notification 

• Delete a notification

• View the properties of a notification (alert only)
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Opening a notification
Open a notification when you want to access the information that it contains. If you 
open an alert notification, you can print the results. When you open a collaboration 
notification, you can opt to receive the data. 

To open a notification: 
1. Access Oracle Demand Planning as a Demand Planner or Demand Plan Manager.

2. In the Notifications list, double-click the notification that you want to open.

Alternatively, you can click the right mouse button on the notification and choose 
View from the popup menu. 

Deleting a notification
When you no longer need to maintain a notification, you can delete it from the list.

To delete a notification: 
1. Access Oracle Demand Planning as a Demand Planner or Demand Plan Manager.

2. In the Notifications list, click the right mouse button on the notification and choose 
Delete from the popup menu.

Viewing notification properties
You can view the properties of a notification that has been generated by an alert.

To view the properties of a notification:
1. Access Oracle Demand Planning as a Demand Planner or Demand Plan Manager.

2. In the Notifications list, click the right mouse button on the notification and choose 
Properties from the popup menu.

Result: The following information is displayed: 

• Description

• Priority
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26
Advanced Topics

This chapter covers the following topics:

• Customizing Demand Planning hierarchies

• Multiple Step UOM Conversion

• Using Sales Forecasts and Opportunities

• Forecasting for Service Parts

• Line of Business-Specific Demand Plans

• Forecast by Demand Class

Customizing Demand Planning hierarchies
Oracle Demand Planning supports nine dimensions: product, time, geography, ship 
from location, sales channel, sales representative, demand class, user defined dimension
1, and user defined dimension 2. Hierarchies and levels for the first seven dimensions 
are preseeded, while they need to be defined for the two user defined dimensions. 

This whole Oracle Demand Planning structure consisting of dimensions, hierarchies, 
and levels is very flexible and can be easily altered. The steps to exploit this flexibility 
are presented in this section. The first feature pertains to the one time setup related 
changes in the basic Oracle Demand Planning structure. The second feature relates to 
the ongoing and routine changes.

For details about the preseeded dimensions, hierarchies, and levels, see: Setup Demand 
Planning Dimensions, page 2-7 and Setup Demand Planning Hierarchies, page 2-9.

Manipulating hierarchies
Every business is structured differently and it may be required to match the respective 
business processes while implementing Oracle Demand Planning. During the normal 
course of business also, it is often necessary to restructure the hierarchies. Such 
restructuring may include changing the names of levels or hierarchies, or defining new 
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hierarchies.

• The names of the levels and hierarchies can be changed using a simple user 
interface. For example, the levels Ship-to-Location and Region may need to be 
renamed as Customer Store and Distribution Center respectively, while the 
geography hierarchy may need to be called Customer Geography. This can be done 
from the Demand Planning Levels or Demand Planning Hierarchies forms, which 
can be accessed respectively from the Levels or Hierarchies menu under Setup for 
the Demand Planning System Administrator responsibility. To change the names of
any level or hierarchy, open the corresponding window, select the level or 
hierarchy, and enter the new name. 

• The existing and preseeded levels can be manipulated to define a new hierarchy. 
For example, the geography hierarchy, one of the three preseeded hierarchies of the 
geography dimension consists of the following levels:

Ship-to-Location - Region - Country - Area - All Geography

A new hierarchy can be defined where Ship to Location rolls up to Country and 
Country rolls up to All Geography. 

When the six dimensions with preseeded levels and hierarchies are not adequate, two 
user defined dimensions can be used. When the preseeded levels and hierarchies are 
not adequate, new levels and hierarchies can be defined. 

To define a new Hierarchy using the existing levels:
For this example, My Geo Hierarchy is the name of the new hierarchy to be represented 
as: Ship to Location - Country - All Geography.

1. Choose the Demand Planning System Administrator responsibility.

2. To open the Demand Planning Hierarchies window, select Setup > Hierarchies from
the Navigator.
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3. Add a new record to enter a new hierarchy by completing these fields: Name, 
Description, and Dimension.

Field Value

Name My Geo Hierarchy

Description Test New Hierarchy

Dimension Geography

4. To open the Demand Planning Hierarchy Levels window, select Setup > Hierarchy 
Levels from the Navigator.
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5. Enter a new record. As an example, you can complete the fields with the following 
information: 

• Select My Geo Hierarchy for the Hierarchy column.

• Select Country for the Level column.

• Select All Geography for the Parent Level column.

• Enter MSD_SR_COUNT_ALL_V for the Relationship View column. Any view 
name on the same pattern can be specified.

• Enter the same values in all the remaining columns as already specified for 
existing hierarchies.

6. Repeat steps 5 through 10 to enter the second relationship. Enter the second 
relationship from Ship to Location to country as shown above (the row below the 
highlighted entry). For example:

Field Value

Hierarchy My Geo Hierarchy

Level Ship to Location

Parent Level Country
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Field Value

Relationship View MSD_SR_SHIPTO_COUNT_V

Level ID Column LEVEL_VALUE_PK

The Relationship Views entered in the previous steps are the source views that steer
the aggregation of levels collected from the source applications. For any new set of 
relationship between levels, these relationship views, which are source views, must 
be defined.

The SQL commands that create one of the new views, 
MSD_SR_SHIPTO_COUNT_V is presented below to impart some understanding of
the view's definition. The purpose for this view is to map the values and primary 
keys of levels and parent levels to the source data. For example, the following table 
shows what will be achieved by creating this view:

Level Level Value Primary Key 
for Level Value

Parent Level 
Value

Primary Key 
for Parent 
Level Value

1 Detroit 101 United States 1001

2 East Bay 102 United States 1001

3 San Jose 103 United States 1001

The following section contains the SQL commands that created this view:

MSD_SR_SHIPTO_COUNT_V

• CREATE OR REPLACE VIEW MSD_SR_SHIPTO_COUNTRY_V 

(level_value_pk, level_value, parent_value_pk, parent_value, attribute1, attribute2, 
attribute3, attribute4, attribute5) 

AS SELECT 

/* Uses the following for the values and primary keys of Levels and Parent Levels */

/* Maps to line 2 above. null corresponds to attributes. prs and pra are aliases */

prs.site_use_id, rac.customer_name || '-' || prs.location, pra.country, pra.country, 
null, null, null, null, null 

FROM 

/* Table names */
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ra_site_uses_all prs, ra_customers rac, ra_addresses_all pra 

WHERE 

pra.address_id = prs.address_id and pra.customer_id = rac.customer_id and 
prs.site_use_code = 'SHIP_TO' 

UNION 

SELECT 

/* This takes care of the null values, if any for ship to location */

msd_sr_util.get_null_pk, msd_sr_util.get_null_desc, 
to_char(msd_sr_util.get_null_pk), msd_sr_util.get_null_desc, null, null, null, null, 
null 

FROM dual

To define new Levels and Hierarchies:
The process of defining new levels and creating hierarchies using these new levels is 
described below for user defined dimension 1. The same process is applicable for user 
defined dimension 2 and other regular dimensions such as product, geography, ship 
from location, sales channel, and sales representative. Assume that the user defined 
dimension 1 should be set up such that it consists of two user defined hierarchies:

• User defined hierarchy 1 is where user defined level 1 rolls up to user defined level 
2

• User defined hierarchy 2 is where user defined level 1 rolls up to user defined level 
2; and user defined level 2 rolls up to user defined level 3

• Choose the Demand Planning System Administrator responsibility.

• To open the Demand Planning Levels window, select Setup > Levels in the 
Navigator.



Advanced Topics    26-7

• Enter the three new records for the new Levels (UD Level 1, UD Level 2, and UD 
Level 3) as follows, then save the records. For example:

Field Value

Name Record 1: UD Level 1, Record 2: UD Level 2,
Record 3: UD Level 3

Description Record 1: User Defined Level 1, Record 2: 
User Defined Level 2, Record 3: User 
Defined Level 3

Dimension User Defined Dimension 1

Level Type Record 1: Bottom, Record 2: Intermediate, 
Record 3: Top

• In the Dimension column, associate these levels to the User defined Dimension 1 by 
selecting the Dimension name from the list of values. 

• In the Level Type column, select the appropriate level type from the list of values. 
The choices are Bottom, Intermediate, and Top. 

There can only be one bottom and one top level, while any numbers of intermediate
levels are possible within one Dimension. UD Level 2 is the only intermediate level 
in this example.
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• Close the Demand Planning Levels window.

• In the Navigator, select Setup > Hierarchies.

The Demand Planning Hierarchies window appears. For details, see: To define a 
new Hierarchy using the existing levels, page 26-2.

• Enter the two new records for the new hierarchies, UD Hierarchy 1 and UD 
Hierarchy 1 as follows and save the records:

Field Value

Name Record 1: UD hierarchy 1, Record 2: UD 
hierarchy 2

Description Record 1: Hierarchy 1 for User Defined 
Dimension 1, Record 2: Hierarchy 2 for User
Defined Dimension 1

Dimension User Defined Dimension 1

• Select Hierarchy Levels.

The Demand Planning Hierarchy Levels window appears.

• Associate the hierarchy levels with the user defined hierarchies as follows:

Field Values

Hierarchy UD hierarchy 1, UD Hierarchy 2, UD 
Hierarchy 3

Level UD Level 1, UD Level 2, UD Level 3

Parent Level UD Level 3, US Level 2, UD Level 3

Relationship View MSD_SR_UL1_UL3_V, 
MSD_SR_UL1_UL2_V, 
MSD_SR_UL2_UL3_V

Level ID Column LEVEL_VALUE_PK (for all three rows)

• Define the Relationship Views. 
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For details, see: To define a new Hierarchy using the existing levels, page 26-2.

Manipulating the level values and associations
Level values, such as, Western distribution center and southwest distribution center, for
a level can be viewed and changed after collecting them from the sources applications. 
The routine business changes in the level value associations can also be accomplished. 
Forecasts for the lower levels can roll up to the corresponding higher levels. For 
example, consider the reassignment of a particular customer site (AU Dodge - CDET) 
from the Michigan sales region to the Ohio sales region. Forecasts for AU Dodge - 
CDET need to roll up under the Ohio sales region instead of the Michigan sales region.

To change Level Value associations:
1. Choose the Demand Planning System Administrator responsibility.

2. To open the Find Level Values window, select Dimension Values > Level Values in 
the Navigator.

3. Enter the Dimension, Hierarchy, and Level of the child level value in the Find Level
Values window.

4. Select Find. The Level Values window is populated with all the values of the 
selected hierarchy level.
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5. Select the appropriate value on the Level Values window and select Associations.

The Level Associations window appears.

6. You can change the Parent Level Value from the list of values.

7. Select OK.

Or you can go directly to the Level Associations window with the following steps:

1. To open the Find Level Associations window, select Dimension Values > Level 
Associations in the Navigator.
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2. In the Find Level Associations window, enter the Dimension, and other details such
as Level Name that will take you to the Level Associations you want to change.

3. Select Find. The Level Associations window is populated based on the selections 
you made in the Find window.

Multiple Step UOM Conversion
In Oracle Demand Planning, the forecast for an item is presented in its primary unit of 
measure (UOM). When the forecasts of several items are rolled up to a higher level, 
such as product category in the product hierarchy, the forecast numbers are converted 
from the base units of measure to a common unit of measure that has been selected by 
the user for the demand plan. Without such conversion, the rolled up numbers would 
be meaningless, since a single aggregate number could include quantities in different 
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units of measure. The conversion can be accomplished whether the demand plan unit of
measure belongs to the same or different UOM class for the various items. The UOM 
conversions across UOM classes are based on items. With this feature, the available 
conversion factors are analyzed and used by the system.

Some examples of units of measure are: gallon, quart, inch, yard, kilogram, case, box, 
unit, acre, cubic foot, and each. For example, a single unit of a product. Some examples 
of UOM class are: length, mass, volume, and package. Different units of measure can 
belong to different UOM classes. Feet belong to the length class, and pounds belong to 
the weight class. Conversion between two units of measure is done using a conversion 
factor or coefficient.

Two and three step UOM conversions
When a direct conversion from a given item's unit of measure to the demand plan unit 
of measure is not available, Oracle Demand Planning does a two-step or three-step 
conversion. 

A two-step conversion is a conversion from one unit of measure to the base unit of 
measure of the UOM class, then from that base unit of measure to a final unit of 
measure. So, a two-step conversion involves the use of two different conversion factors. 
For example, when the item specific unit of measure of widgets is boxes and the plan 
unit of measure is kilograms, the boxes of widgets is converted to the base unit of 
measure of each (one unit), and is then converted to kilograms.

A three-step conversion is an interclass conversion between a unit of measure A in class
1 to a unit of measure B in class 2, where neither unit of measure A nor unit of measure 
B is the base unit of measure of its class. The conversion path is:

1. From unit of measure A to the base unit of measure of class 1.

2. From the base unit of measure of class 1 to the base unit of measure of class 2.

3. From the base unit of measure of class 2 to unit of measure B.

Analyze the available UOM conversion factors
To perform a multiple step UOM conversion, the available conversion factors are 
searched in the following order:

• 1-step item-specific conversion or direct conversion

• 2-step item-specific conversion

• 3-step item-specific conversion

• 1-step non-item-specific conversion

• 2-step non-item-specific conversion
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• 3-step non-item-specific conversion

These conversion factors are analyzed and a conversion path is determined. The 
required steps are identified for each item separately. If none of the above is found, the 
conversion factor defaults to 1.

Aggregate the forecast by appropriate UOM conversions
The diverse units of measure of various items are converted to one demand plan unit of 
measure to roll up the forecast numbers along the product hierarchy. This is 
accomplished using the appropriate conversion factors for the conversion path, such as, 
steps. The user is able to create and view the forecasts that include items whose units of 
measure are of UOM classes that are different from the UOM class of the demand plan, 
and items whose conversion coefficients are item dependent. The actuals (for example, 
bookings and shipments) are also rolled up the hierarchy in the same manner.

Example 1 How conversions are accomplished
In the following example, Quantity is one UOM class. Each and Dozen are the different 
units of measure while Each is the base unit of measure of Quantity UOM class. Weight 
is yet another UOM class. Pound and Kilogram are the different units of measure while 
Pound is the base unit of measure of Weight UOM class. The following table shows 
item dependent UOM conversions across these two UOM classes:

From UOM 
Class

From UOM To UOM 
Class

To UOM Item Conversion 
Rate

Quantity Each Weight Pound Motor casing 2

Quantity Each Weight Pound Head casing 1.5

This table shows UOM conversions within the same UOM class:

From UOM 
Class

From UOM To UOM 
Class

To UOM Item Conversion 
Rate

Quantity Dozen Quantity Each All 12

Weight Pound Weight Kilogram All 0.4536

In Oracle Demand Planning, the unit of measure has been selected as Kilogram and the 
primary unit of measure for the two items: Motor Casing and Head Casing, is Dozen. 
The forecast generated by Oracle Demand Planning for the two items: Motor Casing 
and Head Casing, is 1000 and 2000 respectively for August, 2002.

For the August, 2002 forecast for the Casing product category, to which these items 
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belong, the conversion steps are:

• Dozen to each

• Each to pound

• Pound to kilogram

The Motor Casing forecast conversion calculation is 1000 * 12 * 2 * 0.4536 = 10886.4 kg. 

The Head Casing forecast conversion calculation is 2000 * 12 * 1.5 * 0.4536 = 16329.6 kg. 

The forecast for the Casing product category is 10886.4 + 16329.6 = 27216 kg, and 
appears in Oracle Demand Planning as 27216 kg.

To apply UOM conversions:
Two things must be done for UOM conversions to take effect:

1. You must collect UOM conversion data from the source instance. 

For details, see: To collect Currency Conversion or UOM Conversion data:, page 4-9
. 

A quick summary of the steps you need to perform are:

1. Choose the Demand Planning System Administrator responsibility. 

2. Use the following navigation to open the Collection Utility window and 
Parameters window:

In the Navigator, select Collections > Collect from Oracle Systems > UOM 
Conversion.



Advanced Topics    26-15

3. Select an instance.

4. Select OK.

5. Submit the request.

2. You must specify a base unit of measure for the demand plan. 

For details, see: About defining a Demand Plan, page 7-1.

Using Sales Forecasts and Opportunities
Sales organizations can identify potential opportunities from their contacts and leads 
with the customers, and a portion of these opportunities end up as firm customer 
orders. These sales opportunities with varying degrees of probabilities of success are 
used to forecast sales. Demand analysts can compare sales forecasts with history based 
statistical forecasts and other forecasts such as manufacturing forecasts. Analysts may 
also use portions of the sales forecasts in their final forecasts.

You can use the sales forecast from Oracle Sales Online in Oracle Demand Planning. 
Out-of-the-box collections enable you to bring into your demand plan best case sales 
forecast, most probable sales forecast, worst case sales forecast, weighted sales pipeline 
based on win probability, and best case sales pipeline numbers for the specified time 
period. You can specify the sales forecasts that you want to bring into Oracle Demand 
Planning. 

Sales representatives and sales managers estimate the sales forecasts on opportunity 
and product category worksheets for their part of assignments. These worksheets 
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present the summary of sales opportunities by customers and interest types, 
respectively. The sales forecast numbers on these worksheets can be modified and 
saved. After completing their estimation of future sales, the sales representatives and 
managers submit these worksheets through Oracle Sales Online. You can choose to 
collect sales forecast data into Oracle Demand Planning for any time period from any of
these worksheets. The sales forecasts are compared to statistical manufacturing and 
customer forecasts in Oracle Demand Planning. The comparative trends as well as the 
upside and downside misses are used to estimate the true picture of future demand. 
Once agreed and approved, the resulting consensus forecast is used for planning 
operations. 

Oracle Sales Online supports a hierarchical reporting structure of sales representatives 
and managers and sales groups.

Sales forecast data enters Oracle Demand Planning for not only the top level sales group
that was collected, but also for the next level sales groups if the top level sales groups 
have not submitted the sales forecast. In Oracle Demand Planning, you can also allocate
the data based on some other data stream that has data at desired levels, such as 
Booking History.

Sales information can be brought in from Oracle Sales Online as well as other external 
customer relationship management applications. Data mapping information is 
provided so that sales opportunity data from external sources can be brought into the 
Demand Planning Server.

In Oracle Demand Planning, there are two ways to get sales information:

• Sales forecasts. The detailed steps are below. Oracle Demand Planning provides 
out-of-the-box collection programs to collect sales forecasts from Oracle Sales 
Online.

• Sales opportunities. The detailed steps are below. Oracle Demand Planning does 
not provide any out-of-the-box collection programs, and the data should be 
uploaded via flat files.

Sales forecasts
There are five seeded data streams to hold the five types of sales forecasts: Sales 
Forecast - Best Case, Sales Forecast - Worst Case, Sales Forecast - Probable Case, Sales 
Forecast - Pipeline, and Sales Forecast - Weighted Pipeline. The forecast data can be 
brought at following levels: All Sales Representatives for the top most sales group only, 
All Sales Channels, and All Organizations. The dimension levels for Product, 
Geography, and Time dimensions are kept flexible to match the levels allowed in the 
Oracle Sales Online worksheets. 

You can also use flexible data streams to store both the parent and child data. The 
history of the dependent demand and of the model should be in the same data stream, 
either booking history or a custom data stream, for the system to calculate the planning 
percent. 
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During data collection from Oracle Sales Online, you specify a stream designator to 
identify the collected set of data. For example; if you name the collected data as 
Q1Q2-FY03, the five data streams holding just that set of data will become: Sales 
Forecast - Best Case: Q1Q2-FY03, Sales Forecast - Worst Case: Q1Q2-FY03, Sales 
Forecast - Probable Case: Q1Q2-FY03, Sales Forecast - Pipeline: Q1Q2-FY03, and Sales 
Forecast - Weighted Pipeline: Q1Q2-FY03.

The dimension levels at which the sales forecasts are used in Oracle Demand Planning 
depend on the type of worksheet used in Oracle Sales Online. The dimension level 
mapping to sales forecasts is flexible only for three dimensions: Geography, Product, 
and Time. Flexibility refers to the ability to accept sales forecasts at different levels in 
different collection runs. However, the dimension level has to be the same for a set of 
collected data. The seeded collection programs in Oracle Demand Planning determine 
the dimension level, depending on the selection of a data source from the following 
choices:

• Product Category Worksheet: sales forecasts for a interest type summed across all 
the inventory organizations, customers, sales channels, and sales representatives.

• Forecast Worksheet for submitted forecasts: sales forecasts summed across all the 
inventory organizations, products, customers, sales channels, and sales 
representatives.

To collect sales forecasts from Oracle Sales Online:
The two prerequisites to collecting sales forecasts from Oracle Sales Online are:

• You must collect and use the appropriate fiscal calendar in Oracle Demand 
Planning. The fiscal calendar used in the demand plan should be the same calendar 
as used in Oracle Sales Online. 

For details, see: Lowest Time Levels for the demand plan, page 7-7 and To collect 
Calendars (Time Data), page 4-16.

1. Choose the Demand Planning System Administrator responsibility.

2. In Navigator, select Collections > Collect From Oracle Systems > Sales Forecast.

The Sales Forecast Collection window appears.

For details, see: To collect Sales Forecast data from Oracle Sales Online to the 
Demand Planning Server, page 4-10.

3. Complete the collection parameters:

• Start Date and End Date: specify a date range for which you want to collect 
sales forecast numbers.

• Forecast Category: an interest type can roll up to two or more forecast 
categories. In such situations, you should specify a forecast category to avoid 
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double counting. You need to know and specify the exact forecast category. If 
this field is left blank, sales forecast numbers for all the forecast categories are 
brought over to Oracle Demand Planning. 

• Bucket Type: for sales forecasts (at various time levels such as, fiscal month and 
fiscal quarter). You must select a bucket type from the list of fiscal calendar 
level values. Typically, all the sales representatives will use only one type of 
bucket, such as fiscal month or fiscal quarter, to forecast sales and you should 
specify that bucket only.

• Source of Collection: you must select the type of worksheet from where the 
seeded collection programs in Oracle Demand Planning will bring the data. For 
example, Product Category Worksheet, or Forecast Worksheet. 

If you have set up your data collections to be a two-step process by setting the profile 
option, MSD: ONE-step collection to No, you need to pull the sales forecast data from 
the Demand Planning staging tables to the fact tables. 

1. Choose the Demand Planning System Administrator responsibility.

2. In Navigator, (to pull sales forecasts) select Collections > Pull Data > Sales Forecast. 

Upgrade Considerations for Integrating with Oracle Sales Online
Currently you have two options in Oracle Sales Online:

1. Oracle Sales Online (ASF): Oracle Demand Planning does not collect interest types. 
Instead, top-level product categories from default Product Catalog hierarchy are 
collected as interest types into the existing "Interest Type" hierarchy. Product 
category forecast is translated to top level product category.

2. Oracle Sales Online (ASN): 

1. Oracle Demand Planning does not collect interest types. Instead, top-level 
product categories from default Product Catalog hierarchy are collected as 
interest types into the existing "Interest Type" hierarchy. Product category 
forecast is translated to top level product category.

2. Oracle Demand Planning does not collect data based on opportunity 
worksheet, as this worksheet cannot be created in Oracle Sales Online.

For details about the Oracle Sales Online, see: Oracle Sales Online User's Guide.

To use Sales Forecasts in Oracle Demand Planning:
1. Choose Demand Plans. Use the Find Demand Plan window to select a demand 

plan. 

2. From the Demand Plans window, select the Input Parameters tab. You can include 
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the collected sales forecast numbers into your demand plan by selecting them as 
input parameters.

For details about Input Parameters, see: Input Parameters, page 7-15.

3. Complete the demand planning cycle by running the Demand Planning Engine 
batch processes, as necessary. For details, see: Workflow Processes Within the 
Demand Planning Cycle, page B-2.

4. Compare sales forecasts to other forecasts in a worksheet. For details, see: 
Arranging and Viewing Data in Worksheets, page 11-11.

You can convert the sales dollars to sales volume using a specified price list and 
compare the sales forecast to statistical, manufacturing, and customer forecasts. You 
may combine the two forecasts using formula measures functionality in Oracle Demand
Planning, or modify a forecast by manual edits.

You can display and manipulate data in a demand plan using multiple time hierarchies.
You can bring sales forecast at month or quarter level in fiscal calendar, and view the 
forecasts at week or period levels in manufacturing calendar. Generally, the sales 
forecasts and manufacturing forecasts are expressed in different calendars and product 
categories. Oracle Demand Planning will do appropriate conversions to facilitate their 
comparison. 

The sales forecast numbers will be allocated down from fiscal quarter or month levels to
the day level and aggregated up to the hierarchies on other calendars. For example, 
manufacturing weeks and periods in manufacturing calendar.

Sales opportunities
Once the sales opportunity data is in the demand planning server, the Sales 
Opportunity data stream can be used as an input parameter for a demand plan in 
Oracle Demand Planning the same way as described above for Sales Forecasts. Demand
planners can then use this valuable information for forecast analysis and update.
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To import sales opportunities:
Since Oracle Demand Planning does not provide any collection programs, the sales 
opportunity data needs to be loaded into the Oracle Demand Planning staging tables 
via flat files.

The following diagram is a Data Model that shows how sales opportunity information 
is imported:
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• MSD_CS_DEFINITIONS: stores the definition of data streams. Currently it has only
one row seeded for Sales Opportunity.

• MSD_CS_DEFINITIONS_TL: stores the translations for the 
MSD_CS_DEFINITIONS table.

• MSD_CS_DATA: is a fact table that stores the data, such as Sales Opportunity, for 
data streams. Customer should upload data in this table for Sales Opportunity.

For details on how to collect sales information from Oracle Sales Online, see: To collect 
Sales Forecast data from Oracle Sales Online to the Demand Planning Server, page 4-10.

Sales opportunity mappings
After populating the data, the customer can use the view 
MSD_OPPORTUNITY_DATA_V to verify that populated rows are valid. Records that 
have valid information are visible via this view. The following table explains the 
mapping for MSD_CS_DATA table columns for populating Sales Opportunity data:

Column Name Comments

CS_DATA_ID Unique Key, Use MSD_CS_DATA_S sequence
to generate unique key.

CS_DEFINITION_ID This is the associated Custom Definition ID of 
Sales Opportunity. Fetch it using following 
SQL statement. Select cs_definition_id from 
msd_cs_definitions where name = 
'MSD_SALES_OPPORTUNITY'.

ATTRIBUTE_1 Instance.



26-22    Oracle Demand Planning Implementation and User's Guide

Column Name Comments

ATTRIBUTE_2 Product Dimension Level ID.

ATTRIBUTE_3 Source Primary Key of Product Level.

ATTRIBUTE_6 Geography Dimension Level ID.

ATTRIBUTE_7 Source Primary Key of Geography Level.

ATTRIBUTE_10 Organization Dimension Level ID.

ATTRIBUTE_11 Source Primary Key of Organization Level.

ATTRIBUTE_14 Customer Level ID.

ATTRIBUTE_15 Source Primary Key for Customer.

ATTRIBUTE_18 Sales Rep Dimension Level ID.

ATTRIBUTE_19 Source Sales Rep PK.

ATTRIBUTE_22 Sales Channel Dimension Level ID.

ATTRIBUTE_23 Source Sales Channel PK.

ATTRIBUTE_34 Time Level ID (FND Lookup - 
MSD_PERIOD_TYPE).

ATTRIBUTE_41 Quantity.

ATTRIBUTE_42 Amount.

ATTRIBUTE_43 End Date. Store in YYYY/MM/DD format.

All dimension data is mandatory. For dimensions that are not used, please use the top 
dimension level as a dummy value. For example, if the Sales Channel dimension is not 
used, then use Level ID 33 (for example, All Sales Channel). The primary key value for 
the dimension should be set to -777. This corresponds to a preseeded level value of 
OTHER, which is present for all preseeded dimension levels in Oracle Demand 
Planning. 



Advanced Topics    26-23

To find the level ID for a particular dimension level:
1. Choose the Demand Planning System Administrator responsibility.

2. To open the Demand Planning Levels form, select Setup > Levels in the Navigator.

3. Select the Dimension level you would like to examine.

4. To open the Examine Field and Variable Values form, select Diagnostics > Examine 
from the Help menu.

5. In Block, select LEVELS.

6. In Field, type LEVEL_ID.

7. Press the Tab key.

The value for the LEVEL_ID appears in the Value field.

8. Select OK.

Forecasting for Service Parts
Service parts forecasting allows you to forecast service parts demand based on:

1. Maintenance schedule of products.

2. Usage (consumption history) of service parts to repair products.

Forecasting based on Maintenance Schedules
Oracle Demand Planning is integrated with Oracle Complex Maintenance, Repair and 
Overhaul to provide consumables material planning capability for fleet maintenance 
operators. Example of fleet maintenance operators include companies in the aerospace 
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and defense industries. Oracle Demand Planning considers consumables requirements 
for near-term and longer-term scheduled (routine or planned) maintenance as well as 
unscheduled (non-routine and unplanned) maintenance. The near-term schedule is for 
maintenance that has been scheduled and sourced to a specific repair facility, and the 
longer-term schedule is based on maintenance plan. For details about Oracle Complex 
Maintenance, Repair and Overhaul and the unit maintenance plan, see: Oracle Complex 
Maintenance, Repair and Overhaul User's Guide.

Oracle Demand Planning collects material requirements from Complex Maintenance, 
Repair, and Overhaul based on the consumption or usage of service parts. It collects the 
future material requirements from scheduled visits and unit maintenance plans, and the
history of routine and non-routine material requirements. The collected data are 
available as separate data streams in Oracle Demand Planning. 

To collect complex maintenance, repair and overhaul data into demand planning:
1. Choose the Demand Planning System Administrator responsibility.

2. In the Navigator, select Collections > Collect from Oracle Systems, and select on of 
the four data collection programs for streams for complex maintenance, repair, and 
overhaul data: 

3. Material usage history - Unplanned maintenance

4. Material requirements - Planned maintenance

5. Material usage history - Planned maintenance

6. Material requirements - Scheduled visits

For details on these data streams, see: Input Parameters, page 7-15.

The table below shows the default data stream definitions for the Oracle Demand 
Planning Complex Maintenance, Repair, and Overhaul.

Level/ Data Stream Product Ship From Time

Material 
Requirements - 
Planned 
Maintenance

Item All Organizations Day

Material 
Requirements - 
Scheduled Visits

Item Organization Day



Advanced Topics    26-25

Level/ Data Stream Product Ship From Time

Material Usage 
History - Planned 
Maintenance

Item Organization Day

Material Usage 
History - Unplanned
Maintenance

Item Organization Day

7. The Custom Stream Collection window appears. For details on how to complete 
this window, see: Procedure for Collecting Data, page 4-3.

8. Select Submit. Or select Submit and Schedule.

9. Select OK.

Once the data is collected, you can set up your demand plan and complete your 
planning cycle activities to create two separate forecasts:

• Based on the material requirements from a unit maintenance plan in Oracle 
Complex Maintenance, Repair, and Overhaul. This forecast is based on the material 
requirements - planned maintenance data collection.

• Forecast of material requirements for unscheduled maintenance by statistically 
forecasting Material Usage History - Unplanned Maintenance data stream. Based 
on the forecast generated by Oracle Demand Planning. This is a statistical forecast 
based on the material usage history - unplanned maintenance.

These two forecasts can then be fed as separate forecast scenarios to Oracle Advanced 
Supply Chain Planning. Alternatively, the two forecasts can be added to form an 
integrated forecast of material requirements and then fed as a single forecast scenario to
Oracle Advanced Supply Chain Planning. 

The forecasts can also be fed to Oracle Inventory Optimization in the same manner. In 
addition, forecast errors can be fed to Oracle Inventory Optimization. The forecast 
errors of the material requirements for unscheduled maintenance are created during the
statistical forecasting, but the forecast errors of material requirements for scheduled 
maintenance need to be created by comparing the prior period forecast versions to the 
actuals.

To forecast complex maintenance, repair, and overhaul data in Oracle Demand Planning:
1. Build or select your desired demand plan. For details about how to setup your 

demand plan, see: Procedure to define a Demand Plan, page 7-2.
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In the Demand Plans window Input Parameters tab, include the input parameters 
you want to be used in forecasting. For details about Input Parameters, see: Input 
Parameters, page 7-15.

2. Run the stages of the demand planning cycle (as necessary), including populating 
the forecast measure. 

For details, see: About the Stages in the Planning Cycle, page 8-2. And for details on
how to populate measures, see: Populating Measures (Stage 2), page 8-8.

3. Compare the forecast to reference data. For example, you can use the Material 
Requirements - Scheduled Visits data to adjust the Material Requirements - Planned
Maintenance forecast in a worksheet. 

4. Adjust and edit the forecast. For details, see: (LINK TO DPE CHAPTER).

5. Publish forecast(s) to Oracle Inventory Optimization and/or Oracle Advanced 
Supply Chain Planning. For details, see: Publishing Forecast Data Back to the 
Source, page 8-24.

Oracle Inventory Optimization generates optimal time-phased safety stock 
recommendations for all maintenance facilities and warehouses based on specified 
service level and budget constraints.

Oracle Advanced Supply Chain Planning separately collects the material 
requirements for scheduled visits and uses it as committed sales order demand to 
consume the material forecasts published by Oracle Demand Planning. Oracle 
Advanced Supply Chain Planning then generates recommendations for moving or 
procuring material based on the consumed forecast and safety stock demands.

Usage Forecasting
Usage forecasting of service parts is applicable to service organizations when the 
historical usage or consumption history of the service parts is available and is adequate 
to estimate future demand. Service parts usage can occur when a product is repaired at 
the customer site (field service) or at the repair depot when a product is returned for 
repair. For field service, a field service engineer is assigned to carry out necessary 
repairs at the customer's site. After repairs are done, she completes the service part 
usage and return transactions via a debrief process. For depot repairs, a repair order 
and non-standard discrete repair jobs are created. For details about field service, see: 
Oracle Field Service User Guide. For details about depot repair, see: Oracle Depot Repair 
User Guide.

To forecast for service parts:
1. Collect service parts usage history. 

For details, see: To collect Service Parts Usage History:, page 4-28 for the 
consumption of service parts used. You collect service parts usage history from 
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Oracle Field Service as well as from Oracle Depot Repair.

2. Define supersession events in Oracle Demand Planning. For details about 
supersession events, see: Life cycle and supersession based new product 
introductions, page 6-16.

Supersession events allow you to transfer the consumption history of the 
superseded service parts to the up-item. You can then create a forecast of the new 
item based on the combined histories of the new item and the superseded items. 
You can also read supersede item-relationships into Oracle Demand Planning, and 
automate the process of modeling supersessions and creating forecasts for new 
items. 

3. Define your demand plan, adding the input parameters and events you need. For 
details about defining your demand plan, see: Procedure to define a Demand Plan., 
page 7-2

4. Create your desired forecast based on the collected data for service parts usage 
history. For details on forecasting methods, see: Creating Forecast Measures, page 
17-5.

5. The service parts usage history is forecast by directly projecting the part usage 
history. Generally during the maturity phase of product life cycle, the historical 
usage or consumption history of service parts is adequate to estimate future 
demand. The assumption in usage forecasting is that the consumption of a service 
part summed across different products eliminates the need to consider its 
consumption patterns by the age and operation of individual products.

6. Apply the service part supersession events. For details about applying events to 
your forecast, see: Applying Events to Measures, page 18-20.

7. Modify your forecast to arrive at final service parts demand.

8. Now you can publish your service parts demand forecast to Oracle Inventory 
Optimization or Oracle Advanced Supply Chain Planning. Your forecast is used in 
Oracle Advanced Supply Chain Planning as supply schedule to estimate the supply
of service parts. For details about the supply plan, see: Oracle Advanced Supply Chain
Planning Implementation and User's Guide

Example
With usage forecasting, the service parts forecast demand is based on the direct 
projection of the service parts usage history. You collect into Oracle Demand Planning 
the usage history of service parts from Oracle Field Service and/or Oracle Depot Repair. 
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Lifter 234 Dec 2002 Jan 2003 Feb 2003 Mar 2003 Apr 2003 May 2003

Usage 
history

300 300 200      

Then your output from Oracle Demand Planning is a forecast of service parts.

Lifter 234 Dec 2002 Jan 2003 Feb 2003 Mar 2003 Apr 2003 May 2003

Projected 
usage

      250 300 250

The demand planning forecast methods for usage forecasting recognize both the 
intermittent nature of service parts usage patterns and the possibility that outliers, such 
as spiked periods of usage, could be present in the usage history patterns. 

For example, the automatic best-fit forecast method runs algorithm to find out the best 
forecasting method for a history profile. This eliminates the need to perform manual 
simulations. For intermittent demand forecasting and for detecting outliers, Oracle 
Demand Planning employs Moving Period Total data adjustments. The service parts for
which the results of best-fit forecast method are not satisfactory can be re-forecast using 
other forecast methods.

Both long-term and short-term forecasts can be created in Oracle Demand Planning 
with no restriction on the number of history or forecast periods. Also, your forecast 
numbers can be specified and edited on a worksheet.

Once your forecasts are created, forecast accuracy can be calculated and tracked. You 
can define alerts to notify planners on the basis of tracking signals or control limits. For 
details about alerts, see: Defining Alerts, page 25-3.

Line of Business-Specific Demand Plans
You may specify separate demand plans for different lines of business such that 
planners and planning managers can just look at the demand data pertaining to their 
respective line of business. The forecast for each line of business is fed into a global 
demand plan that represents the entire demand space to consolidate the lines of 
business forecasts into one corporate-wide forecast.

A line of business specific demand plan refers to limiting the scope of a demand plan to 
include only those level values, such as items, organizations, customers' ship to 
locations, and sales representatives, that pertain to that line of business. A line of 
business specific demand plan allows for the creation of a demand plan per line of 
business, such that the planners and managers for a line of business can view the 
demand data specific to their line of business.
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There are a few ways to do this:

1. Restrict the demand plan scope to only those items for which data exist in a data 
stream. All the other level values are automatically filtered based on the items in 
scope. Thus, all the parent level values, including product families, product 
categories, or custom product groups in those product dimension hierarchies are 
included in the demand plan. Also, all the organizations for which the items are 
enabled are included in the demand plan. And all the parent level values, such as 
business groups, legal entities, and operating units of those organizations are 
included in the demand plan.

For example, let's say there is a sales history data stream that contains data for 
Printer-XT and Printer-AB in the Newark distribution center organization. If 
Printer-AB is enabled in the Detroit distribution center organization, then the 
Detroit distribution center organization is also included in the line of business 
demand plan, but the planners will see the values NA (no data) for the sales history 
pertaining to the Detroit distribution center organization. If other data streams of 
this demand plan have data corresponding to the Detroit distribution center 
organization, then the planners will be able to see that data.

2. Restrict the demand plan scope to a level value in the ship from location dimension 
or to a level value in the product dimension. All the other level values are 
automatically filtered based on the selected level value. Specifically:

• If you restrict the demand plan scope to a business group in ship from location 
dimension, then all the legal entities, operating units, and organizations of the 
business group are included in the demand plan. All the items and their parent 
level values that are enabled for the organizations of the business group are 
included in the demand plan. 

• If you restrict the demand plan scope to a product group in the product 
dimension, then all the items of the product group are included in the demand 
plan. All the organizations for which the items are enabled and all the parent 
level values of those organizations are included in the demand plan. 

3. You can restrict by both 1 (items in a data stream) and 2 (level values). If you scope 
the demand plan by both 1 and 2, then only those items that are allowed by both 
the methods are included in the demand plan. However, the organizations are 
restricted only by method 2 (level values).

You can also automatically scope by other dimensions based on operating units. For
example, you can scope by:

• Sales representative dimension, which includes sales representatives that 
belong to the selected operating units. 

• Geography dimension, which includes ship to locations that belong to the 
selected operating units. 
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• If sales representative or geography dimensions are included in the line of 
business demand plan, then the sales representatives and ship to locations for 
these dimensions are restricted to the line of business depending on the 
operating units in scope. 

All the parent level values of the sales representatives and ship to locations are 
also included in the demand plan. Limiting the demand plan scope has no 
impact on the other four dimensions: sales channel, demand class, user defined 
dimension 1, and user defined dimension 2. All the level values for these 
dimensions are always included in the demand plan.

Note: Users can optionally stripe by Ship From Location 
dimension even when the Ship From Location is not a 
dimension in the demand plan. This may be useful if you want 
to create different demand plans for different lines of business, 
but you do not explode your forecast and you do not want to 
see the organization dimension in the demand plan.

You can include new products in the demand plan by using the new product 
introduction events. The new products are automatically included in the demand plan 
if the base products are in scope. 

If you are calculating dependent demand based on model bills of material, the items in 
the scope must include all the models, option classes, and options on a model bill.

To be able to use this feature, you must:

1. Ensure that the demand planning hierarchies align to lines of business. Since the 
demand plan scope can be restricted only to one level value in ship from location or
product dimension, you may need to customize demand planning hierarchies to 
align them to your lines of business. 

For example, if your line of business covers two or more product categories, you 
will add another level, such as product line, above the product category in the 
product category hierarchy so that the product categories of the line of business roll 
up to one product line.

2. Ensure that the required relationships are available in Oracle Demand Planning. 
The Lines of Business-specific demand plan's functionality is dependent on the 
following three relationships:

• Item-Organization

• Sales Representative-Operating unit

• Ship-to-Location-Operating unit

These relationships can be set up in the source E-Business suite instance and are
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automatically collected into Oracle Demand Planning during the level values 
collection based on the setup. You use the level values collection program to 
collect these three relationships into Oracle Demand Planning. 

For data sources other than Oracle ERP, these relationships can be loaded via 
flat files using legacy integration feature of demand planning. If a relationship 
is not provided, all the level values corresponding to the missing relationship 
are included in the demand plan. For example, if the Sales 
Representative-Operating unit relationship is missing, all the Sales 
Representatives will be included in the demand plan. 

Note: If an item is assigned to a new organization between 
planning cycles, you must completely refresh the existing plan 
to reflect the change in relationship.

To use lines of business specific demand plans:
1. Verify or enable the items in the organization of line of business. If you choose to 

restrict the demand plan scope, it always applies to both items and organizations 
based on the items that are enabled in the organizations of your line of business. 

2. Set up the profile option MO: Default Operating Unit before specifying the ship to 
and the sales rep.

Level values for sales representative and geography dimensions are restricted 
depending on the operating units to which they are associated. 

The sales representatives and ship to locations that were defined after setting this 
profile, are automatically associated to the operating unit selected for this profile. 

3. Specify the demand plan scope.

For details, see: Scope, page 7-44. 

You can specify the scope by: 

• Restricting by line of business. This refers to method 2 explained above. The 
demand plan is scoped by a level value in the ship from location dimension or 
product dimension. The levels and level values available for selection are 
independent of the product or organization dimensions/hierarchies included in 
the demand plan.

• Restricting to items based on the data stream. This refers to method 1 explained 
above. The demand plan is scoped by items in a data stream. The data streams 
available for selection are not limited to those which are included as demand 
plan input parameters.

Once this demand plan is built in the demand planning engine, the scope 



26-32    Oracle Demand Planning Implementation and User's Guide

cannot be changed until the demand plan data is completely purged and the 
demand plan rebuilt.

Also remember that the demand plan dimensions should be selected to align 
with the demand plan scope. Specifically,

• Product dimension is mandatory and must be included in the demand 
plan. It will always be striped per the scope of the demand plan.

• Ship from location dimension will always be striped per the scope of the 
demand plan, even if not included in the demand plan.

• Sales representative and geography dimensions will be striped, only if 
these dimensions are included in the demand plan.

When the user stripes a demand plan with organizations that have no 
relationships to the ship to locations, the sales reps, or the products, then all
level values will be included in the stripe. 

• Selecting one or more internal organizations whose sales orders you want to 
consider in scope. This refers to method 2 explained above. All internal sales 
orders for the specified destination organizations will be included. This allows 
lines of business that run demand plans and fulfill demands from internal 
organizations to recognize the history of those demands, and create forecasts.

4. Create and upload the line of business forecast. 

After defining the scope of the demand plan in the planning server, line of 
business-specific demand planning process is run in the demand planning engine to
arrive at the final line of business forecast. Then this is uploaded to the Planning 
Server. 

For details, see: About Measures, page 17-1.

If you need to consolidate the Lines of Business-specific forecasts into a 
corporate-wide forecast, you should feed the Lines of Business forecasts into a 
separate global demand plan after the forecasts are uploaded to planning server. A 
global demand plan is a demand plan where the scope is not restricted to a Line of 
Business.

Forecast by Demand Class
Forecast by demand class allows you to analyze and forecast sales history by different 
demand classes in Oracle Demand Planning . Then the demand planning forecast can 
be fed to Oracle Advanced Supply Chain Planning and consumed there by demand 
classes. Oracle Demand Planning can publish forecasts to Oracle Advanced Supply 
Chain Planning at demand class level and receive supply plans/constrained forecasts 
from Oracle Advanced Supply Chain Planning at demand class level. 
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A demand class may represent a particular grouping of customers, type of demand, or 
different sources of demand. You use demand class to segregate demand and supply 
into independent groups. This allows for tracking and consuming by group and allow 
you to flexibly model business processes.

Forecasting by demand class can also be used to analyze demand by segments, such as 
existing and emerging market segments. Forecast by demand class also allows you to 
manage and analyze demand for different types of customers or for different market 
segments by modeling the customer type and market segments as demand classes.

Data analysis and forecasting by demand classes is possible in Oracle Demand Planning
only when the demand class is recorded in sales orders. You associate sales orders with 
demand class in Oracle Order Management. For details, see: Oracle Order Management 
User's Guide. The Oracle Demand Planning forecasts can be published to either Oracle 
Advanced Supply Chain Planning or e-Business source instance for consumption by 
sales orders scheduled to be shipped on or after the forecast horizon start date for the 
same demand class. The following combinations are possible:

• Data analysis by Demand Class in Oracle Demand Planning and forecast 
consumption by Demand Class in Oracle Advanced Supply Chain Planning 

• Data analysis by Demand Class in Oracle Demand Planning and forecast 
consumption by Demand Class in the Source (Oracle e-Business Suite Instance). 

The forecast output level must be demand class to publish and consume forecasts by 
demand classes to Oracle Advanced Supply Chain Planning and e-Business source 
instance. 

The forecast consumption process has not changed.

Sales orders that have an associated specific demand class consume either the forecasts 
with matching demand class or the forecast that do not have any demand class. Sales 
order demand without demand class consume either the forecasts with the 
organization's default demand class or the forecast that do not have any demand class. 
If the forecast consumption process does not find forecasts with associated demand 
class, it consumes forecasts without demand class. When there is no demand class is 
associated to a sales order, then Oracle Demand Planning created a level value called 
'Other' in the new demand class dimension. The forecasts with the demand class 'Other'
are treated as forecasts without demand class in Oracle Advanced Supply Chain 
Planning. 

Forecast consumption by demand class in Oracle Advanced Supply Chain Planning is 
allowed for organization-specific and global forecasts as long as the forecast scenario 
has been uploaded from Oracle Demand Planning at demand class level. 

For details, see: Oracle Advanced Supply Chain Planning Implementation and User's Guide. 

The Demand Class dimension has only two hierarchical levels: Demand Class is the 
lowest level and All Demand Classes is the highest level. You can run promotions and 
new products by demand class. You can also vary prices by demand class. Sales history 
and forecasts are displayed by demand classes and are aggregated to All Demand 
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Classes. 

If there is no demand class is associated to a sales order line, then Oracle Demand 
Planning designates a pseudo demand class 'Other' to that sales order line. All the 
'Other' sales order lines for a SKU will be aggregated within the selected bucket.

For example, if you are under a contract with some of your customers to supply goods 
at a specified rate, quantity, price, or quality. The customers order some material under 
that contract and the sales are recorded as 'contract' sales. The customers may also order
the same material over the contract quantity. This extra sales is recorded as 'spot' sales 
and may not need the extra finishing process required in the contract. 

In this scenario, the forecast by demand class process will be to first define two demand 
classes, Contract and Spot. Once you record the sales history by these demand classes, 
you can analyze the sales history using the demand class dimension. You need to 
forecast by demand class to deduce specific trends and growth curves. Then you can 
apportion the forecast per your business objectives. For example, you may want to 
always meet your contract demand and in spite of the relative higher upward trend for 
spot demand, you may want to apportion a higher percentage to the contract demand. 

You should restrict the forecast consumption by the sales orders of the same demand 
class in Oracle Advanced Supply Chain Planning so that the 'contract' forecast is not 
eaten away by the 'spot' sales orders and that you can plan supplies per the extra 
finishing process. Finally, you can promise orders against the supplies with the same 
demand class in Oracle Global Order Promising.

How to collect and analyze sales order data by demand class:
Pre-steps outside of Oracle Demand Planning
Define new demand classes as necessary:
1. Choose Manufacturing and Distribution Manager responsibility. 

2. Select Supply Chain Planning > Setup > Demand Class.

Record Sales Orders by Demand Classes:
1. Choose Manufacturing and Distribution Manager responsibility.

2. Select Order Management > Orders, Returns > Sales Orders.

3. Create a new sales order and lines, specifying item, quantity, etc.

4. Select Shipping tab.

5. Select Folder > Show Folder > Demand Class.

The demand class field will appear on the sales order lines screen.

6. Select a demand class for order lines as appropriate.

It is not necessary to specify demand class for every sales order line. If no demand 
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class is associated to a sales order line, Oracle Demand Planning will designate a 
pseudo demand class, 'Other' to that sales order line.

Steps inside of Oracle Demand Planning
Collect level values and planning data into Oracle Demand Planning:
1. Choose Demand Planning System Administrator. 

2. Select Collections > Collect from Oracle Systems > Level Values. 

Demand classes are collected as a part of level values collection. 

3. Select Dimension Values > Level Values > View Hierarchy Planning Data by 
demand class. 

After collecting level values you can view demand class hierarchy and level values. 

4. Choose Demand Planning System Administrator. 

5. Select Collections > Collect from Oracle Systems > Booking Data, Shipment Data, 
Order Backlog, or Promotional History. 

Various collection programs can bring data in by demand class from ERP systems. 

Define a Demand Plan:
1. Choose Demand Planning System Administrator. 

2. Select Demand Plan.

Define a Scenario Output Level:
1. Choose Demand Planning System Administrator.

2. Select Demand Plan > Scenarios Tab.

3. Select a scenario and click Output Levels. 

In order to consume the forecast by demand class in Oracle Advanced Supply 
Chain Planning, the scenario output level must be set to 'Demand Class'.

Perform Demand Planning Cycle:
1. Build the demand plan in Demand Planning Engine. 

2. Analyze the sales history and other data and create a forecast.

3. Demand planners manipulate the forecast and submit. 

4. Demand managers finalize forecast and upload to planning server.

Forecast consumption by demand class in Oracle Advanced Supply Chain Planning is 
allowed for both organization-specific and global forecasts as long as the forecast 
scenario has been uploaded from Oracle Demand Planning at the demand class level. 
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To select forecast scenario and consumption level in Oracle Advanced Supply Chain 
Planning plan options:

1. Choose Advanced Supply Chain Planner responsibility. 

2. Select Supply Chain Plan > Options > Organization Tab.

3. Select an organization-specific forecast under Demand Schedule/Name field or a 
global forecast under Global Demand Schedule/Name field. 

4. Select a Ship to Consumption Level. 

The list of values for consumption levels will depend on the forecast scenario 
output levels from Oracle Demand Planning. For example, the forecast scenario in 
the above screen shot was uploaded from Oracle Demand Planning at Item, 
Customer, and Demand Class Level. 

View consumption by Demand Class details in Oracle Advanced Supply Chain Planning:
1. Choose Advanced Supply Chain Planner responsibility.

2. Select Supply Chain Plan > Workbench.

3. Select the desired organization, plan, or item. Open the Supply/Demand window.

4. Select a forecast line. Select the right mouse option: Consumption Details.
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A
Reference: Stored Measure Options

This appendix covers the following topics:

• Forecast Methods

• Measure Property: Unit of Measure Association

• Effect of Events on Measures

Forecast Methods
The forecast method specifies the statistical method used to generate the forecast. 

Oracle Demand Planning offers an Automatic forecast method whereby the forecasting 
engine determines the best statistical forecasting method to use based on the historical 
performance of each algorithm and the application of decision rules.

You can also choose one of the following statistical forecasting methods: 

• Linear regression

• Polynomial regression

• Exponential fit

• Logarithmic fit

• Asymptotic fit

• Exponential Asymptotic fit

• Single Exponential Smoothing

• Double Exponential Smoothing

• Holt-Winters
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• Croston's Method

Advanced statistical parameters
When you select a forecasting method, you have the option to specify values for 
advanced statistical parameters. This enables you to manually fine-tune the forecast.

Setting advanced parameters is discretionary. If you are using the Automatic method, 
the forecasting engine sets parameters for the selected forecast method when it runs the 
forecast. If you are using a method other than Automatic, the forecasting engine uses 
the defaults for parameters that are relevant to the selected method.

The following section lists the advanced statistical parameters in alphabetic order and 
briefly describes each one. The actual parameters that you see depend on the forecast 
method that you chose. 

Alpha 
For the three methods of the exponential smoothing family (Single Exponential 
Smoothing, Double Exponential Smoothing, and Holt-Winters), specifies the relative 
weighting to give to recent changes in mean value. 

• Alpha Max — The minimum value is 0.0; the maximum value is 1.0; the default is 
.3.

• Alpha Min (available for Double Exponential Smoothing and Holt-Winters) — The 
minimum value is 0.0; the maximum value is 1.0; the default is 1.0.

• Alpha Step (available for Holt-Winters) — The incremental value used to go from 
Alpha Min to Alpha Max. The minimum value is 0.05; the maximum value is 0.2; 
the default is 0.1. The value that you enter must evenly divide the difference 
between Alpha Max and Alpha Min.

Beta 
For the double exponential smoothing and Holt-Winters forecasting methods, specifies 
the relative weighting to give to recent changes in trend. 

• Beta Max — The minimum value is 0.0; the maximum value is 1.0; the default is .3.

• Beta Min — The minimum value is 0.0; the maximum value is 1.0; the default is 1.0.

• Beta Step — The incremental value used to go from Beta Min to Beta Max. The 
minimum value is 0.05; the maximum value is 0.2; the default is 0.1. The value that 
you enter must evenly divide the difference between Beta Max and Beta Min.

Cyclical Decay
For the Automatic, linear and non-linear regression forecast methods, indicates how 
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trends that are calculated based on history will be considered as the forecast time 
horizon increases. This parameter is useful when the history is large and some cyclical 
component has been identified.

The parameter value indicates how seriously deviations from baseline activity are 
considered: a higher value implies slower decay while a lower value implies faster 
decay for cyclical components. Note that for less history (for example, less than about 
1.5 to 2 years) and in the absence of cyclical activity, this parameter might not have any 
effect on the calculated forecasts.

• Cyclical Decay Max — The minimum value is 0.2; the maximum value is 1.0; the 
default is 1.0.

• Cyclical Decay Min — The minimum value is 0.2 the maximum value is 1.0; the 
default is 0.2.

The difference between the maximum value and the minimum value must be evenly 
divisible by 4. 

Data Filters 
You can turn a seasonal or aggregate data filter on or off. You can choose one of the 
following options:

• No seasonal filter — This is the default.

• Seasonal filter — Accounts for seasonal patterns in the data.

• Moving periodic total filter — An "aggregation" filter that handles sporadic or 
intermittent time series data. This is available for all methods except Holt-Winters.

Gamma 
For the Holt-Winters forecasting method, specifies the relative weighting to give to 
recent changes in seasonality. 

• Gamma Max — The minimum value is 0.0; the maximum value is 1.0; the default is 
.3.

• Gamma Min — The minimum value is 0.0; the maximum value is 1.0; the default is 
1.0.

• Gamma Step — The incremental value used to go from Gamma Min to Gamma 
Max. The minimum value is 0.05; the maximum value is 0.2; the default is 0.1. The 
value that you enter must evenly divide the difference between Gamma Max and 
Gamma Min.

Min/Max Bounds
For all forecasting methods, specifies upper and lower bounds on forecast numbers as a 
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factor or multiple of the historical values. 

• Minimum Forecast Factor — Sets lower bounds on forecast numbers. The default is
0.

• Maximum Forecast Factor — Sets upper bounds on forecast numbers. The default 
is 100.

Over adjustment of forecasts within periods
For all forecasting methods, specifies whether to prevent over-adjustment to the data by
using average, rather than the individual, values of a period. For example, using this 
parameter for a forecast at the day level would allocate the forecast to all valid days in a
weeks rather than forecasting individually at the day level.

Smoothing 
For all forecasting methods, historical data is smoothed by averaging data with the time
series. You can set the following smoothing parameters:

• Median smoothing window — Specifies the length of the median smoothing 
period. Larger values result in smoother forecasts. Depending on the nature of the 
data, a window size that is too small might be unable to filter outliers while a 
window size that is too large might miss data patterns. The minimum value is 1; the
maximum value is 27; the default is 3. The time period is based on the 
level/calendar and history start date.

• Do you want to fit the data on smoothed series? — Specifies whether you want to 
turn the median smoothing filter on or off. The default is off.

• Do you want to interpolate for missing values? — Specifies whether you want 
smooth the data by interpolating for missing values. This is useful for handling 
occasional missing values in the time series. The default is no.

Trend decay 
For the Automatic, Double Exponential Smoothing and Holt-Winters methods, specifies
parameters that determine how large trends detected from recent data affect the 
forecast.

• Trend Min — The minimum value is 0.0; the maximum value is 1.0; the default is 
0.4. 

• Trend Max — The minimum value is 0.0; the maximum value is 0.8; the default is 
0.8.

• Trend Step — The incremental value used to go from Trend Min to Trend Max. The
minimum value is 0.05; the maximum value is 0.2; the default is 0.2. The value that 
you enter must evenly divide the difference between Min and Max.
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• Trend Dampening for erratic data — (Active if you chose "Moving Periodic Total 
Filter" as the data option for Data Filters) Specifies whether to apply trend 
dampening to erratic data. 

Verification Window Size
For all forecasting methods, provides a ratio that specifies the portion of the data used 
in the verification phase. This ratio is used to calculate forecast accuracy statistics 
(MAD, MAPE, and RMSE). For the Automatic method, this ratio is also used to verify 
the best-fit method. Increasing the size means that the forecasting engine will use a 
larger portion of the most recent data; decreasing the size means that it will use a 
smaller portion of the data. The minimum value is 1/26; the maximum value is 1/2; the 
default is 1/3.

Measure Property: Unit of Measure Association
When you enable the Apply Unit of Measure (UOM)  when aggregating data property 
for a measure, Oracle Demand Planning uses the Unit of Measure (UOM) for leaf level 
product items when aggregating product values to higher levels. For example, suppose 
that the base Unit of Measure (UOM) for the plan is "Each." If product A has a UOM of 
DZ (dozen) and a value of 10, and product B has a UOM of Each and a value of 20, then 
they would be aggregated to a higher level using the UOM conversion of 1 DZ = 12 
Each, so 10*12 + 20*1 = 120 + 20 = 140.

You would almost always want to associate UOM's with a new measure, because for 
volume amounts, it makes the most sense to have them aggregate up this way. 

An example of when you might not want to aggregate would be for something like a 
"Population" stream, for which the UOM's would not make sense.

The Base UOM for the plan is defined in the Demand Planning Server; however, the 
UOM for specific products may be unavailable or the conversion rates between the leaf 
products' UOM and the Base UOM for the plan may be unavailable. In these cases, the 
conversion rates will default to 1, so it will act like a flat aggregate from the leaf level of 
Product to higher levels. (In the previous example, it would just mean 10 + 20 = 30 if no 
conversion rates were available.)

Effect of Events on Measures
When you apply events to a stored measure, Oracle Demand Planning applies the factor
specified in the Action phase of the event definition process. 

For all event types, events are applied at the day level for Time, values are allocated to 
the leaf level of the hierarchies, and then aggregated up. 

When viewing events and their effects, ensure you are looking at the day level for Time.
If you have qualified your event, then ensure that you select the qualified dimension 
value at the level you selected. When viewing events from other levels you will see an 
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aggregated or allocated value which may not match what you expect to see.

Effect of a promotion event on a measure
When you associate a promotion event with a measure, Oracle Demand Planning 
applies the lift value (for each intersection, New Value = Existing Value + Lift) or the lift 
percent (for each intersection, New Value = Existing Value * [1 + {Lift/100}]) of the 
absolute lift (for each intersection, New Value = Lift). 

Effect of a product introduction event on a measure
When you associate a product introduction event with a measure, Oracle Demand 
Planning calculates the effect of the event as follows:

• For a lifecycle event: Forecast for new product = Sum over all specified base 
products (specified weights applied to each base product * History for base 
product, with optional lag). Cannibalizations take away from the specified product 
a specified fraction of the forecast for the newly introduced product. 

• For a supercession event: Forecast for new product = Sum over all specified base 
products (specified weights applied to each product * Forecast for that base 
product). 

Effect of a product phase out event on a measure
When you associate a product phase out event with a measure, Oracle Demand 
Planning calculates the effect of the event as linear decay rate, with specified start and 
end dates and the factor of the start day's forecast remaining at the end day. The end 
day's value is the factor times the start day's value; values between start and end are 
linearly interpreted. 

Effect of multiple events on a measure
When a measure is associated with multiple events, Oracle Demand Planning applies 
the events in the following order:

1. New product introductions

2. Product phase outs

3. Optional promotion events

4. Mandatory promotion events

Optional events are calculated before mandatory events for the following reason: 
Assume that you are a store retailer, who offers a storewide 10% discount on Saturdays.
The discount is a mandatory event — it happens to all transactions on that day. A 
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customer comes in with a $50 voucher. The voucher is an optional event which may not 
happen for each transaction. The storewide discount is always taken before the voucher 
is used. In addition, its unlikely that the vendor would allow a customer to use two 
optional events for one transaction. For example, you couldn't use a $50 voucher and a 
voucher for 50% off anything at the same time.
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B
How Demand Planning Uses Oracle 

Workflow 

This appendix covers the following topics:

• Overview of Workflow

• Prerequisites for Using Workflow with Oracle Demand Planning 

• Workflow Processes Within the Demand Planning Cycle

Overview of Workflow
Oracle Demand Planning has extensive batch and background processing needs. Its 
repetitive processing is organized as a well-defined business workflow. Demand 
Planning uses Oracle Workflow to govern application process flows and notify the user 
community of processing status.

The Demand Planning Server, via Oracle Workflow, executes tasks and receives 
responses from the OLAPI Server. This interface enables Workflow to call functions in 
the Oracle environment and connect to Express Server to run tasks.

Through the use of concurrent programs, Workflow activities, and APIs, concurrent 
requests automatically start Workflow background engines that correspond to specific 
Demand Planning Workflow processes. 

Each request monitors a specific process and runs an engine until the process has 
completed — at which point the request ends. 

The flow is initiated from the Oracle Demand Planning Administrator's user interface. 
The user interface calls the OLAPI Engine which, in turn, starts a predetermined Oracle 
Workflow process. This Workflow process then takes control and, when needed, 
attaches to the OLAPI Server by using the Workflow function activities.
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Prerequisites for Using Workflow with Oracle Demand Planning 
In order to use Workflow in conjunction with Demand Planning, Oracle Workflow 
must be installed, configured, and tested. 

If you want to generate E-mail alerts to users, E-mail must be configured for Workflow. 

Workflow Processes Within the Demand Planning Cycle
The demand planning cycle is made up of five stages, each of which initiates a specific 
Workflow process to govern the task that is performed during that stage. The five 
stages are as follows:

• Downloading data from the Demand Planning Server

• Populating measures (also runs forecasts)

• Distributing data and measures to demand planners

• Collecting and consolidating data from demand planners

• Uploading the consolidated data to the Demand Planning Server

Stage 1 Workflow process: Download data from Planning Server
This activity connects to the OLAPI Server, and begins to download data from the 
Demand Planning Server.

Upon successful completion of the download, Workflow sends a notification to the 
administrator. If an issue is detected by the OLAPI Server, then the "No" transition is 
taken by Workflow and a notification sent to the administrator. 

The following illustration shows the Workflow process that runs to complete the Stage 
1 task.
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Stage 2 Workflow process: Populate Measures
During this stage Workflow interacts with the OLAPI Server to:

1. Run statistical forecasts.

2. Populate each measure that has been defined. 

3. Notify the planning administrator of the outcome of the task.

The following illustration shows the Workflow process that runs to complete the Stage 
2 task.
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Stage 3 Workflow process: Distribute to planners
During this stage Workflow interacts with the OLAPI Server to:

1. Find all assignments defined for planners.

2. Build and distribute a personal slice of data for each user having a demand planner 
assignment. 

3. Start a separate Workflow process to build each assignment and notify that user 
when their personal database is ready.

4. Notify the planning administrator of the outcome of the task when all assignments 
are built.

The following illustration shows the Workflow process that runs to complete the Stage 
3 task.

Stage 4 Workflow process: Collect data from planners
There are two ways to collect data from planners. You can run the "standard" collection 
process, which is (the default when you click the Applybutton, or you can check the box
Collect Available Submissions Now, which runs the Collect Submission Now process. 
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Standard collection process
When you run the standard collection, the following tasks are accomplished:

1. When all data has been submitted by the planners, it is collected and consolidated, 
and the process ends.

2. If the Date to End Collection Period is reached, all available submissions are collected 
and consolidated.

3. If reminder messages were requested, they will be sent when enabled. 

The following illustration shows the Workflow process that runs the standard collection
process for the Stage 4 task.
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Collect Available Submissions Now
Collect Available Submissions Now is used to do an early collection of available 
submissions during the standard cycle. It is independent of the standard collection (the 
competitive nature of the two processes is managed by the system). 

If you apply the Collect Available Submissions option, the following tasks are 
accomplished:

1. The Workflow process Collect Submission Now runs. This will not cycle. It will just 
look for any submitted assignments for that plan, collect and consolidate them, and 
then end. It will notify the administrator of the outcome.

2. The status for collected assignments will be set to collected and this process will then
end. 

The following illustration shows the Workflow process that runs when you choose 
Collect Available Submissions Now.
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Scenarios for the standard collection process
The standard data collection process can follow several different paths. The three most 
common scenarios are described and illustrated following.

In the first scenario all data is submitted before the collection process is initiated. The 
Workflow status activity detects this and transitions to data collection and 
consolidation. No wait is involved. Immediately after the consolidation, a notification is
sent indicating success.

The following illustration details the flow of activities when data is submitted before the
collection process is initiated. 
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In the second scenario, not all data has been submitted when the Collect Data process is 
initiated. In this case, the Workflow process transitions through its activities to the 
Compare Date activity. If the end date for the collection period has not been reached, 
Workflow moves on to the Wait activity, where it pauses for the duration of the waiting 
period. It then moves on to the next activity, which checks the status of submitted data 
to verify whether all demand planners have submitted their data. If they have all 
submitted data, then the first scenario above will be followed. Otherwise, the flow will 
cycle.

Workflow will cycle through this set of activities until all demand planners have 
submitted their data, or until the data collection period end date is reached. When the 
data collection period end date is reached (whether all data has been submitted or not), 
Workflow sends a special notification to the Demand Planning System Administrator, 
and Workflow control is passed to the collection and consolidation activities.

The following illustration details the flow of activities when not all data has been 
submitted before the collection process is initiated.
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The third scenario functions similarly to the second, but includes an additional 
Workflow activity which sends a reminder to demand planners who have not 
submitted their data for collection. 

The Demand Plan Administration page enables you to specify the number of days prior
to the data collection end date when Workflow will begin to send reminder messages, 
once per day, to demand planners who have not yet submitted their data.

The following illustration details the flow of activities when not all data is submitted 
before the collection process is initiated and reminder messages are sent to planners.
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Stage 5 Workflow process: Uploading measures to the Planning Server
In this final stage, the final forecast is published back to the Demand Planning Server. 

When this process is complete, Workflow notifies the Demand Planning System 
Administrator that the demand planning cycle has been completed.

The following illustration shows the flow of Workflow activities.
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C
Profile Options

This appendix covers the following topics:

• Demand Planning Profile Options

• Main Planning Profile Options

Demand Planning Profile Options
MSD: AW Tablespace

This profile controls where analytic workspaces are created and stored. New plans are 
created in the specified tablespace; existing plans remain in the tablespace specified at 
the time of their creation. Changing the tablespace profile has no effect on existing data.

Note: To migrate an old plan to a new tablespace, first change the 
profile, then recreate the plan.

MSD: Calculate Planning Percentage

This profile option controls the behavior of the planning percentage calculations. For 
example, it controls whether the planning percentages can be calculated from the sales 
history of options. This profile can prevent expensive calculations when the user does 
not want to calculate planning percentages and just wants to use the existing planning 
percentages specified in the enterprise resource planning source to explode the forecast.

MSD: Category Set Name

This profile option is used to select one category set during the data collection process. 
If the user value is left blank, then all categories will be selected for data collection. 
Valid values are limited to valid category set names.

MSD: Client Debugging 

This profile allows you to enable debugging tools and is primarily for technical use.

MSD: Conversion Type
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This profile option determines what conversion rates are collected from the General 
Ledger rates table. Valid values are limited to valid conversion rates.

MSD: Currency Code

This profile option designates the base currency used in Oracle Demand Planning. All 
revenues are calculated and displayed in this base currency. Valid values are limited to 
the currency list of values.

MSD: Customer Attribute

This is a source profile option used to selectively bring the customer names into Oracle 
Demand Planning to improve system performance. This profile holds the descriptive 
flexfield column name that is used to indicate if a customer in the Customers table will 
be used by Oracle Demand Planning. Only those customers in the Geography 
dimension that have this flexfield populated will be collected. This profile option value 
is one of the attribute columns of the RA_CUSTOMERS entity, which indicates whether 
or not the customer will be used for demand planning purposes. In the customers table, 
you need to reflect this in a descriptive field. All of the source views for the geography 
dimension that use the RA_CUSTOMERS entity filter using this attribute column. If the 
profile option is not provided, then no filtering will occur. If the profile option is 
provided, then only the entities in the geography dimension that have the attribute in 
the RA_CUSTOMERS entity specified as Yes will be collected. To set up Key 
Customers, go to the Customer setup screen in Oracle Applications. Select the relevant 
customer and set an available flexfield column to Yes. For example, if you use 
attribute10, then you need to use this information in MSD profile option setup, too. Also
in the source instance set up the following information for profile option value 
MSD_CUSTOMER_ATTRIBUTE: list of values from ATTRIBUTE1 to ATTRIBUTE15.

MSD: Enabled Organization for Item Collections

This profile option specifies how Oracle Demand Planning collects Product Family and 
Product Category relationships. Valid values are:

• All Enabled Demand Planning Organizations: Product Family and Product 
Category relationships are collected from all enabled demand planning 
organizations.

• Demand Planning Master Organization: Product Family and Product Category 
relationships are only collected from the master organization.

MSD: Master Organization

This profile option is used to select a master organization, if there are multiple master 
organizations. The item attributes pertaining to the selected master organization are 
used by Oracle Demand Planning. 

MSD: OLAP Directory Alias

This profile stores the directory alias name where the files are located. It will be read 
during login and used during all file-based operations. This profile option can only be 
set at the site level.
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MSD: OLAP Initial Page Pool

This profile specifies an initial minimum memory for planning and manager sessions 
and can be optimized for individual users. A value of 4 to 6MB is generally adequate. 
The default value is olap_page_pool_size.

MSD: OLAP Maximum Page Pool

This profile specifies a maximum memory footprint for planning and manager sessions 
requiring additional memory resources, such as forecast creation. Oracle Demand 
Planning reserves the amount of memory specified by this profile, and relinquishes it 
when the operation is complete.

MSD: OLAP Workflow Page Pool

This profile specifies the memory footprint for workflow initiated Oracle Demand 
Planning sessions. The default value is 64MB.

MSD: One Step Collection

This profile option controls the number of steps in the data collection process. Valid 
values are:

• Yes: indicating that the collection programs should take the data directly into the 
Fact Tables in a single step. 

• No: allows for the default two step collection process. In the first step, the collection 
programs take the data in to the Staging Tables where the data can be consolidated 
and cleansed by the user, if required. In the second step, the pull concurrent 
programs carry the data over to the Fact Tables from the Staging Tables. Both set of 
tables exist on the Demand Planning Server. The default value is No. 

MSD: Two-Level Planning

This profile allows you to forecast demand at product family level on the basis of sales 
histories of member items. You can collect all the product family members and their 
sales histories regardless of the forecast control as long as the product family forecast 
control is 'Consume' or 'Consume & Derive' and the planning method for product 
family and members is not set to 'Not Planned'. 

This is achieved by setting the profile value to: Collect all family members and their 
sales histories. The default profile value, Exclude family members with forecast control 
'None' enforces the existing behavior that is, only 'Consume' or 'Consume & Derive' 
product family members are collected.

MSD: Use Classic Even Allocation

This profile allows you to determine the allocation method used when an allocation 
basis does not exist. You can allocate evenly down the time dimension and use "first" 
allocation for other dimensions when an allocation basis is not available. Valid values 
are:

• No, use first allocation.
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This value allocates to first child at each level. This is the default value.

• No, use first allocation for all dimensions except Time. 

This value allocates to first child at each non-time level and allocates evenly to time.

• Yes, use even allocation.

This value allocates evenly to every child. You should not use this value unless you 
have a genuine functional need.

Note: If you plan to use the MSD: Use Classic Even Allocation profile 
value feature, do the following:

• Query MSD: Use Classic Even Allocation in the profiles form.

• Set the value to No, use first allocation for all dimensions except 
Time.

Main Planning Profile Options
For a complete list of all of the planning profile options, see: the Profile Options 
appendix in the Oracle Advanced Planning and Scheduling Implementation and User's Guide.
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Glossary

A

ABC classification

A method of classifying items in decreasing order of importance, such as annual dollar 
volume or your company's transaction history.

absolute error

Magnitude of forecast errors, actual less forecast values, without regard to sign.

accuracy measure

In Oracle Demand Planning, a statistical data element that estimates the accuracy of a 
comparison between two measures. Accuracy measures include MAD, MAPE, and 
RMSE.

See also Mean Absolute Deviation (MAD), Mean Absolute Percent Error (MAPE), and Root 
Mean Square Error (RMSE).

across

The column position in a Demand Planning report or worksheet. Columns go across the
page. See also column.

activity log

Demand Planning feature that enables planners to view a record of system activities. 

ad hoc analysis

In Oracle Demand Planning, the process of analyzing data using a report or graph for 
which you specify the dimensions, dimension values, and layout. While viewing an ad 
hoc analysis, you can drill up or down on aggregate values. See also graph, report.

adjustment

In Oracle Demand Planning, refers to the manual modification of forecast values to 
account for outliers or incorrect measurements. You can adjust a single value or a range 
of values. You can enter comments regarding the adjustments. 
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aggregate

In Oracle Demand Planning, a predefined grouping of values along a hierarchy, or a 
user-defined grouping of values. For example, a predefined aggregate for Geography 
might total territories by city, state, region, and country. A user-defined aggregate for 
Geography might combine values for three cities that are of interest to the user. See also 
custom aggregate.

aggregate forecast

For a forecast variable such as demand, adding the contributions of child levels to 
obtain a single forecast value for the parent level. 

aggregation

In Oracle Demand Planning, the consolidation of data for lower level dimension values 
into parent values. Data is often collected at the lowest available level of detail and is 
aggregated into higher level totals for analysis. For example, units sold in various cities 
might be aggregated into total units sold for all cities in a region. The aggregation rule 
might be "add," in which case the values are added, or there might be an alternate 
aggregation rule such as "average." 

aggregation level

In Oracle Demand Planning, the position in a dimension hierarchy at which data can be 
viewed or manipulated. For example, aggregation levels for a Geography dimension 
might include City, County, State, Region, and so forth.

alert

In Oracle Demand Planning, a set of exception conditions that generates a notification 
to specified individuals when the conditions are met. 

agreement

A contract with a customer that serves as the basis for work authorization. An 
agreement may represent a legally binding contract, such as a purchase order, or a 
verbal authorization. An agreement sets the terms of payment for invoices generated 
against the agreement, and affect whether there are limits to the amount of revenue you
can accrue or bill against the agreement. An agreement can fund the work of one or 
more projects.

An arrangement with a customer that sets business terms for sales orders in advance. 
Oracle Order Management lets you assign pricing, accounting, invoicing and payment 
terms to an agreement. You can assign discounts to agreements that are automatically 
applied. You can refer to an agreement when you enter an order for a particular 
customer, and have relevant default values automatically fill in the order using 
standard value rule sets. see customer family agreement, generic agreement.
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agreement, contract, price list 

The standard transactions can have a reference to a contract number. This code may be 
used as a key to find a document containing the item's price. The appropriate Oracle 
document can be used in the PO change process to determine the source for the item's 
price. Full use of this document within the PO Change transaction needs to be 
reviewed.

agreement type

A classification for agreements. Reference agreement types in defining discounts or 
automatic note rules, classify your agreements to control selection of agreements during
order entry, and for reporting purposes.

ahead

Quantities were delivered in advance of the customer's anticipated delivery date, or an 
over shipment in quantities occurred. The supplier must control this situation in such a 
way that he will not manufacture or deliver these quantities again. See: Behind.

AIAG

Automotive Industry Action Group, an organization which publishes combined EDI 
implementation requirements for the major automotive industry manufacturers and 
suppliers.

alert

A specific condition defined in Oracle Alert that checks your database and performs 
actions based on the information it finds there.

alert action

In Oracle Quality, an electronic mail message, operating system script, SQL script, or 
concurrent program request that is invoked when specified action rule conditions are 
met.

alert input

A parameter that determines the exact definition of an alert condition. You can set the 
input to different values depending upon when and to whom you are sending the alert. 
For example, an alert testing for users to change their passwords uses the number of 
days between password changes as an input. Oracle Alert does not require inputs when
you define an alert. 

alert output

A value that changes based on the outcome at the time Oracle Alert checks the alert 
condition. Oracle Alert uses outputs in the message sent to the alert recipient, although 
you do not have to display all outputs in the alert message. 
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ALL_TAB_COLUMNS 

A standard Oracle Database Table, maintained by the database, that contains the 
definition of every Column in every Table and View.

ALL_VIEWS 

A standard Oracle Database Table, maintained by the database, that contains the 
definition of every View. Item Type is a high level grouping of Processes. Item Types 
are identified by name (e.g. ORDER) and are used to group other entities (like activities 
and messages) according to the type of business transaction or document they work 
with. Access to Item Types may be constrained by setting the R/W/X role privileges.

allocation

In Oracle Demand Planning, the process of changing child nodes values based on the 
change in the parent node, according to an algorithm. The algorithm might assign fixed,
often equal, weights to each child, with the weights summing to unity.

agreement

A contract with a customer that serves as the basis for work authorization. An 
agreement may represent a legally binding contract, such as a purchase order, or a 
verbal authorization. An agreement sets the terms of payment for invoices generated 
against the agreement, and affect whether there are limits to the amount of revenue you
can accrue or bill against the agreement. An agreement can fund the work of one or 
more projects.

An arrangement with a customer that sets business terms for sales orders in advance. 
Oracle Order Management lets you assign pricing, accounting, invoicing and payment 
terms to an agreement. You can assign discounts to agreements that are automatically 
applied. You can refer to an agreement when you enter an order for a particular 
customer, and have relevant default values automatically fill in the order using 
standard value rule sets. see customer family agreement, generic agreement.

agreement, contract, price list 

The standard transactions can have a reference to a contract number. This code may be 
used as a key to find a document containing the item's price. The appropriate Oracle 
document can be used in the PO change process to determine the source for the item's 
price. Full use of this document within the PO Change transaction needs to be 
reviewed.

agreement type

A classification for agreements. Reference agreement types in defining discounts or 
automatic note rules, classify your agreements to control selection of agreements during
order entry, and for reporting purposes.
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ahead

Quantities were delivered in advance of the customer's anticipated delivery date, or an 
over shipment in quantities occurred. The supplier must control this situation in such a 
way that he will not manufacture or deliver these quantities again. See: Behind.

AIAG

Automotive Industry Action Group, an organization which publishes combined EDI 
implementation requirements for the major automotive industry manufacturers and 
suppliers.

alert

A specific condition defined in Oracle Alert that checks your database and performs 
actions based on the information it finds there.

alert action

In Oracle Quality, an electronic mail message, operating system script, SQL script, or 
concurrent program request that is invoked when specified action rule conditions are 
met.

alert input

A parameter that determines the exact definition of an alert condition. You can set the 
input to different values depending upon when and to whom you are sending the alert. 
For example, an alert testing for users to change their passwords uses the number of 
days between password changes as an input. Oracle Alert does not require inputs when
you define an alert. 

alert output

A value that changes based on the outcome at the time Oracle Alert checks the alert 
condition. Oracle Alert uses outputs in the message sent to the alert recipient, although 
you do not have to display all outputs in the alert message. 

ALL_TAB_COLUMNS 

A standard Oracle Database Table, maintained by the database, that contains the 
definition of every Column in every Table and View.

ALL_VIEWS 

A standard Oracle Database Table, maintained by the database, that contains the 
definition of every View. Item Type is a high level grouping of Processes. Item Types 
are identified by name (e.g. ORDER) and are used to group other entities (like activities 
and messages) according to the type of business transaction or document they work 
with. Access to Item Types may be constrained by setting the R/W/X role privileges.
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allocation floor

See lowest allocation level.

alpha

In Oracle Demand Planning, a parameter used by the three forecasting methods of the 
exponential smoothing family: single, double, and Holt-Winters. This is the "level," or 
baseline, parameter.

alpha smoothing factor

A value between 0 and 1 used in statistical forecasting calculations for smoothing 
demand fluctuations. Inventory uses the factor to determine how much weight to give 
to current demand when calculating a forecast.

anomalies

Outliers and other non-standard patterns in historical data. 

APS

Acronym for Advanced Planning and Scheduling, a suite of Oracle products.

assembly

An item that has a bill of material. You can purchase or manufacture an assembly item. 
See also Bill of Material.

assignment

In Oracle Demand Planning, the slice of data (measures and other dimension values) 
that a demand planner is responsible for forecasting and submitting to the shared 
database. Can also include data that the planner can view but not submit. 

See also assignment scope, view scope.

assignment scope

In Oracle Demand Planning, the portion of the data (measures and other dimension 
values) that a demand planner is responsible for submitting to the shared database.

automatic method

See best fit forecast.

B

base model

The model item from which a configuration item was created.
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best fit forecast

The best performing method of the statistical forecasting models, based on historical 
data. 

beta

Parameter used by two forecasting methods of the exponential smoothing type: double 
and Holt-Winters. It is referred to as the "trend" parameter because it controls the 
estimate of the trend.

Bill of Material (BOM) 

A list of component items associated with a parent item and information about how 
each item relates to the parent item. Oracle Manufacturing supports standard, model, 
option class, and planning bills. The item information on a bill depends on the item type
and bill type. The most common type of bill is a standard bill of material. A standard 
bill of material lists the components associated with a product or subassembly. It 
specifies the required quantity for each component plus other information to control 
work in process, material planning, and other Oracle Manufacturing functions. Also 
known as product structures.

bias

An error in the mean value of a forecast when compared to the actual data. Bias could 
apply to the entire data or to a segment of the data.

BOM item type

An item classification that determines the items you can use as components in a bill of 
material. BOM Item types include standard, model, option class, and planning items.

C

calendar

A system to handle consistency for time-varying data. Oracle Demand Planning usually
uses a Manufacturing calendar, where production is divided into four week periods. 

calibration

The process of estimating model parameters from historical data in statistical 
forecasting models. Alternatively known as training.

cannibalization

The phenomena, often observed during the introduction of new products, in which one 
product takes the market share of another related product. 
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causal analysis

The process of forecast generation that uses known or calculated relations between a 
dependent variable, such as demand, and one or more factors that affect the dependent 
variable, such as weather, product promotion, and discounts.

cell protection

In Oracle Demand Planning, locking a cell so that its data cannot be modified until the 
protection is removed.

child

In Oracle Demand Planning, a dimension value at the level immediately below a 
particular value in a hierarchy. Values of children are included in the calculation that 
produces the aggregated total for a parent. A dimension value might be a child for more
than one parent if the dimension has more than one hierarchy. See also hierarchy.

collaborative forecasting

In Oracle Demand Planning, forecast generated by consultation among, or 
consolidation of, individual forecasts issued by organizations that are linked to each 
other in the supply chain such as suppliers, manufacturers, customers, retailers and 
manufacturers. 

column

An Oracle Demand Planning report or worksheet has three components for displaying 
multi-dimensional data: column, row, and page. The column component separates data 
for the dimension values that run across the report. See also across.

competitive event

Event that could potentially compete with other events in terms of its effect on product 
demand. In Oracle Demand Planning, only the competitive event with the highest 
priority is applied in any particular area. 

component demand

Demand passed down from a parent assembly to a component.

component item

An item associated with a parent item on a bill of material.

composite

In the Analytical Workspace used by Oracle Demand Planning, a dimension-like object 
that is derived from one or more base dimensions. Each member of the composite is a 
combination of members from each base dimension. Composite values are created 
automatically when data is assigned to a variable that uses the composite, thus reducing
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the number of NA values that would be stored on disk

confidence bounds or limits

The maximum and minimum level of variation expected for demand. These bounds are 
usually dictated by the uncertainty associated with the forecasts and represent the 
degree of confidence in the forecast values. For statistical forecasts, these correspond to 
the range with which a forecast value is expected to lie with some probability.

configuration

A product a customer orders by choosing a base model and a list of options. It can be 
shipped as individual pieces as a set (kit) or as an assembly (configuration item). 

configuration bill of material

The bill of material for a configuration item.

configuration item

The item that corresponds to a base model and a specific list of options. Bills of Material
creates a configuration item for assemble-to-order models.

configure-to-order

An environment where you enter customer orders by choosing a base model and then 
selecting options from a list of choices.

consensus forecast

Forecast generation by consultation among or consolidation of individual forecasts 
issued by different groups within an organization.

consolidation

The process of merging multiple forecasts for related, but not identical quantities. The 
forecasts can originate from multiple sources such as sales forecasts for different items, 
management forecasts for individual products, two managers forecasting sales for two 
different regions, or statistical forecasts for different commodities. Forecasts might also 
originate from a single source such as sales forecasts of different products from one 
salesperson.

constrained forecast

Unconstrained forecasts are generated from historical data or by individuals without 
regard to limitations. For example, a retailer with no knowledge of manufacturing 
capability or a manufacturer without knowledge might generate an unconstrained 
forecast. When an unconstrained forecast is appropriately modified based on 
knowledge of constraints, it is known as a constrained forecast. See also unconstrained 
forecast.
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correlation

The relation between two or more variables, expressed as a number between -1 (perfect 
negative relation) and +1 (perfect positive correlation). The number 0 implies no 
relation.

correlation of events

See event correlation.

cross-correlation

The relation between a variable and the lagged values of another variable, expressed as 
a number between -1 (perfect negative relation) and +1 (perfect positive correlation). 
The number 0 implies no relation.

currency

The units of demand for that are used during data visualization, manipulation, and 
forecasting. In Oracle Demand Planning, currency is referred to as measures. See also 
measure.

custom aggregate

In Oracle Demand Planning, a single value that planners and the Demand Plan 
Manager can create to combine multiple values from one dimension into a single value. 
For example, a planner might create a custom aggregate that consists of three 
geographies rolled up into a single geography value. Custom aggregates appear on the 
user's selection list of dimension values.

cyclical decay

A parameter for linear and nonlinear regression that is useful if the length of the history
is large and some cyclical component has been identified. The parameter value indicates
how seriously deviations from baseline activity are considered: a higher value implies 
slower decay while a lower value implies faster decay for cyclical components. The 
allowable range is from 0.2 to 1.0. Since the algorithm searches for the best value of the 
parameter within the specified range, the recommendation is to leave the default 
values. Note that for less history (for example, less than about 1.5 to 2 years) and in the 
absence of cyclical activity, this parameter might not have any effect on the calculated 
forecasts.

D

data element

A variable or set of variables that store data values. Alternatively, a place holder for 
data storage or viewing such as a cell or set of highlighted cells.
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decimal precision 

Number of digits after the decimal point that will be displayed (with rounding).

demand plan

In Oracle Demand Planning, an overall forecast of demand and possibly plans for 
integration with a supply chain. This consists of all available information from the 
OLAPI Server including measures, baseline forecasts, conversion tables, scenarios, and 
event information.

dependent demand

Products for which forecasts are generated as a percentage or fractional rate of a related 
product. The rates might be obtained from history, from user input, or from the 
Planning Bill of Materials (BOM). For example, the blade of a turbine or the moon roof 
of a car illustrate dependent demand. See also independent demand, planning percent.

dependent variable

In regression or modeling, a variable that is expressed as a function of another variable, 
or explained in terms of another variable.

differencing

The process of obtaining difference values at any give time. Difference values are the 
current value less the value at a given lag.

dimension

In Oracle Demand Planning, a list of categories for data. A dimension acts as an index 
for identifying the values of a variable. Examples of dimensions are Product, 
Geography, and Time.

dimension value

In Oracle Demand Planning, an element in the list that makes up a dimension. For 
example, dimension values in the Geography dimension might include Boston, 
Chicago, and New York.

disaggregate

The inverse of aggregation; spreading down or allocating data values at higher nodes to
the lower nodes.

distribution

In Oracle Demand Planning a term used to refer to the process by which specific slices 
data are allocated to planners, based on their assignments.
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document

In Oracle Demand Planning a collective term used to refer to a report, graph, or 
worksheet. See also report, graph, worksheet.

down

The row position in a report or worksheet. Rows go down the page. See also row.

drill

In Demand Planning, to navigate up and down through the levels of aggregation in a 
dimension that has a hierarchy. When selecting dimension values or viewing data, you 
can expand or collapse a hierarchy by drilling down or up in it. Drilling down expands 
the view to include child values that are associated with parent values in the dimension 
hierarchy. Drilling up collapses the list of descendant values associated with a parent 
value in the dimension hierarchy.

E

error bars

Error range that forecast values are expected to exhibit with some degree of confidence. 

estimation

Defining or determining a model or the parameters thereof. 

event

In Oracle Demand Planning, any occurrence that is expected to impact the sales or 
demand forecast. For example, promotions, price reductions, product phase outs, and 
product introductions might be events. 

event model

A technique that attempts to numerically capture the effect of an event on product 
demand at any aggregation level.

event correlation

The relation among events, such as a product introduction event and the corresponding
cannibalization of a related product.

exception report

In Oracle Demand Planning, an ad hoc report that displays data associated with 
dimension values that are exceptions to planner-defined cutoff values. The criteria is 
applied to each page of data. For example, an exception report might identify customers
whose orders have dropped by more a certain amount compared to the same period 
last year. 
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exponential smoothing

A class of statistic forecasting techniques in which the forecasts are obtained as simple 
linear weights of the actual value and the forecast value at previous time steps, or 
through some variation of this rule. The linear weights are the model parameters which 
are determined through calibration from historical data. Demand Planning offers three 
exponential smoothing methods: single, double, and triple (referred to as "Holt-Winter's
"). 

F

filtering

In statistics, smoothing the data values by removing high frequency components. 
Filtering aids in the identification of underlying longer term trends and seasonality in 
the data that have some forecast-ability.

final assembly order

A discrete job created from a configuration or an assemble to order item and linked to a 
sales order. Also known as final assembly schedule.

forecast error

Each forecast that Demand Planning generates includes an estimate of the forecast 
error. The types of errors computed are Mean Absolute Percent Error (MAPE), Mean 
Square Error (MSE), and Mean Absolute Deviation (MAD). See also Mean Absolute 
Percent Error (MAPE), Mean Square Error (MSE), Mean Absolute Deviation (MAD)

forecast reconciliation

See reconciliation.

forecasting methods

Refers to the statistical methods that you can use to generate forecasts in Oracle 
Demand Planning. These are Linear Regression, Polynomial Regression, Exponential 
Fit, Logarithmic Fit, Asymptotic fit, Exponential Asymptotic Fit, Single Exponential 
Smoothing, Double Exponential Smoothing, and Holt-Winters. As an alternative to 
selecting a specific method, you can allow the system to automatically determine the 
best-fit method.

formula measure

In Oracle Demand Planning, a formula that uses existing values in the database to 
calculate data on the fly. For example, you might create a formula measure that applies 
a weight to a forecast measure. A formula measure is not stored in the database, has no 
unit of measure association, and its values are never editable. See also measure.
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frequency

The inverse of the time period at which the historical or forecast data are expected to 
repeat their past behavior. Seasonal or periodic data exhibit a low frequency component
corresponding to their period. Purely random data that contain no substantial 
information usually exhibit high frequency.

frequency domain analysis

Analyzing time series data by first transforming it to the frequency domain, or by 
determining the time series components as a function of frequency. Estimates of the 
frequency components of a time series is often achieved through smoothed 
periodograms, using Fourier analysis. Frequency domain analysis often provides a 
better estimate for seasonal or periodic cyclicity in the data than time domain analysis. 
Demand Planning uses frequency domain analysis to calculate signal to noise ratios for 
outlier detection; however, this analysis is not visible to the planner and results are not 
reported directly.

G

gamma

A parameter used by Holt-Winters, a forecasting method in the exponential smoothing 
family. This is the seasonal parameter. 

Geneva

Refers to Roadmap Geneva Forecasting™ from Roadmap Technologies. Geneva is the 
forecasting engine that is used in Oracle Demand Planning for statistical forecast 
generation. 

geography dimension

In Oracle Demand Planning, a category of data that denotes geographical area. For 
example, the Geography dimension might include values such as "Eastern US," "
Massachusetts," and "Boston." See also dimension.

graph

An Oracle Demand Planning document that enables you to visualize and manipulate 
multi-dimensional data in graphical format. Types of graphs include area, bar, line, 
bar-line, pie, 3D, and scatter graphs.

H

hierarchy

In Oracle Demand Planning, a means of organizing and structuring data within a 
dimension. A hierarchy exists when values within a dimension are arranged in levels, 
with each level representing the aggregated total of the data from the below. For 
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example, a Geography dimension might have a hierarchy that includes levels for 
Account, City, State, and Region. See also aggregation, level.

I

independence

See independent variable.

independent demand

Products for which demand forecasts are generated from their own data, which could 
be in the form of historical demand, causal factors, third party information, and so 
forth. For example, forecasts for finished goods such as cars and computers illustrate 
independent demand. See also independent demand.

independent variable

If a variable does not depend on another variable or set of variables in any way, then 
the first variable is said to be independent of the second. In regression, independent 
variable are those that cannot be expressed in terms of another variable. Note that 
independence implies no correlation between variables; however, the converse is not 
necessarily true.

input errors

Errors in measurement or data entry of variables that are used as inputs in the 
forecasting or planning process. Input error can be due to human or instrument error.

intermittent demand

Refers to sporadic demand patterns observed for certain products over certain time 
horizons. These types of demand are characterized by sudden surges followed by 
periods of zero or very low demand. Special modeling efforts might be required to 
handle these situations if the products constitute a significant proportion of the total 
sales.

introduction

See product introduction event.

item

Anything you make, purchase, or sell, including components, subassemblies, finished 
products, or supplies. Oracle Manufacturing also uses items to represent planning items
that you can forecast, standard lines that you can include on invoices, and option 
classes you can use to group options in model and option class bills.

L
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level

In Oracle Demand Planning, a position in a dimension hierarchy. Each level above the 
base level represents the aggregated total of the data from the level below. For example 
a Geography dimension might have ascending levels such as Customer, City, State, and
Region. Within a dimension hierarchy, a dimension value at one level has a family 
relationship with the dimension values at the levels above and below that level. See also
aggregation, hierarchy.

life cycle

The period over which a product stays in the market or is operationally produced by 
the manufacturer. A product's lifecycle events include the following: 

• Born — A new product

• Young — A recently introduced product

• Old — A mature product

• Dead — A product whose functionality is no longer required as a result of new 
technology

likelihood

The probability of occurrence. The likelihood of a given model is the probability of the 
assumed model and the estimated parameters approximating reality.

linear models

A class of linear formulations that approximate the future behavior of a variable in 
terms of its own current and past values, or the current and past values of independent 
variables. The term implies that the model expresses the forecasts or the dependent 
variable as a linear function of the independent variables.

linear regression

A forecasting method in which a linear relationship () is fitted to the data, where a and 
be are parameters estimated from history.

lowest allocation level

In Oracle Demand Planning, a setting in the OLAPI Server that determines the lowest 
level of each dimension to which data will be allocated for a measure. 

M

MAD

See Mean Absolute Deviation (MAD).
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mandatory event

An event whose effects will be felt independently of other events that might occur. In 
Oracle Demand Planning, a priority is associated with such an event to determine the 
precedence of occurrence. This priority is necessary as the demand modification adds a 
specific number or uses an uplift factor, and operator precedence becomes important. 

MAPE

See Mean Absolute Percent Error (MAPE).

make-to-order

An environment where customers order unique configurations that must be 
manufactured using multiple discrete jobs and/or final assembly orders where the 
product from one discrete job is required as a component on another discrete job. Oracle
Manufacturing does not provide special support for this environment beyond the 
support it provides for assemble-to-order manufacturing.

mandatory component

A component in a bill that is not optional. Bills of Material distinguishes required 
components from options in model and option class bills of material. Mandatory 
components in pick-to-order model bills are often referred to as included items, 
especially if they are shippable.

Mean Absolute Deviation (MAD)

A performance metric for evaluating forecast accuracy, where N is the total number of 
observations, the summation is for all N observations, Y represents the observed data at
any time, and Z is the corresponding forecast data.

Mean Absolute Percent Error (MAPE)

A performance metric for evaluating forecast accuracy. where N is the total number of 
observations, the summation is for all N observations, Y represents the observed data at
any time, and Z is the corresponding forecast data.

Mean Squared Error (MSE)

A performance metric for evaluating forecast accuracy. , where N is the total number of 
observations, the summation is for all N observations, Y represents the observed data at
any time, and Z is the corresponding forecast data.

measure

In Oracle Demand Planning, a data variable that is a placeholder for storing or 
calculating data values for all levels of all dimensions. See also stored measure and 
formula measure.
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measurement errors

The expected errors or standard deviation errors that are associated with the measured 
or input values. For example, errors during a transaction are measurement errors.

metric

See performance metric.

middle-out

A method of allocating forecasts generated at a middle level of a hierarchy to the higher
levels through aggregation and to lower levels through allocation.

model 

An abstract, often statistical or mathematical, representation of reality. Used to 
approximate the complex process of demand generation, forecast generation, and 
answer what-if queries. 

model bill of material

A bill of material for a model item. A model bill lists option classes and options 
available when you place an order for the model item. 

model item

An item whose bill of material lists options and option classes available when you place
an order for the model item.

moving average

A smoothing or forecasting technique where the smoothed or forecast value at a point is
determined by the average, or weighted average for weighted moving average, of 
adjacent values in time. The window size used for computing the average is often a 
parameter that must be specified. For smoothing, both lagged and lead values can be 
used; for forecast, only past values can be used.

moving median

A smoothing or forecast technique where the smoothed or forecast value at a point is 
determined by the median of adjacent values in time. The window size used for 
computing the median is often a parameter that must be specified. It is used in Demand
Planning to detect and filter outliers from historical data during statistical forecast 
generation. However, this analysis is hidden from the planner and results are not 
directly reported.

MSE

See Mean Squared Error.
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MRP

Seematerial requirements planning.

multidimensional

In Oracle Demand Planning, refers to accessing data through multiple dimensions that 
can be arranged and organized according to a planner's requirements.

N

new product introduction

See product introduction event.

noise

In statistics, random variations in data caused by small changes in unaccountable 
factors, such as measurement error and lack of perfect repeatability during data 
generation. Loosely used to denote unexplained variances that are associated with 
demand that could be caused by individual human factors and are not expected to 
reoccur.

nonlinear regression

A class of statistical forecasting methods in which a linear relationship is fitted to a 
transformation of the original data. Demand Planning offers five non-linear regression 
methods: asymptotic fit, exponential fit, exponential asymptotic fit, logarithmic fit, and 
polynomial regression.

O

ODP

Abbreviation for Oracle Demand Planning.

OLAP

Abbreviation for Online Analytical Processing.

option

An optional item component in an option class or model bill of material. 

option class

A group of related option items. An option class is orderable only within a model. An 
option class can also contain included items.

option class bill of material

A bill of material for an option class item that contains a list of related options. 
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option class item

An item whose bill of material contains a list of related options.

Oracle Workflow

The Oracle Workflow engine sequences the processes of demand planning. It is also 
used to schedule jobs and notify planners of certain events or exceptions.

outlier

A data value that is unusually large or small, usually caused by events that are not 
expected to reoccur and must be removed from the historical data when generating 
statistical forecasts.

outlier detection and filtering

The process of detecting and removing outliers from historical data for purposes of 
statistical forecast generation. The statistical forecasting techniques in Demand Planning
automatically filter outliers through one of two methods: moving median in the "time 
domain" and signal to noise ratio in the "frequency domain." During the forecast 
generation process, the best method is automatically selected.

P

page

In an Oracle Demand Planning document, the page component separates data for the 
dimension values that appear as pages. 

parameter

Adjustable variable in a forecasting model, the values of which must be adjusted from 
historical data through a process called calibration or training. 

parameter estimation

See calibration. 

parent 

In a hierarchical relationship in Oracle Demand Planning, the immediately superior 
level or node. For example in a Geography dimension, Eastern U.S. might be the parent 
of Massachusetts.

pareto analysis

A method for forecast model selection based on the type of item in stock. Items are 
divided into the following categories:

• A — Comprising 1 to 20% of all items but representing 80% of the total value, 
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forecast in a controlled environment with non-adaptive forecasting models and 
significant monitoring.

• B — Comprising 20 to 30% of all items worth 15 to 20% of sales, forecast using short
term adaptive models.

• C — Comprising 50 to 70% of all items and 5 to 10% of the value for which forecasts
cannot provide significant ROI.

percolation

The process of modifying the values of parent nodes and successive nodes at the top of 
a hierarchy to reflect changes in the values of child nodes.

performance metric

A quantity that measures the performance of forecast values by comparing with actual 
data, for example, root mean square error.

period type

The temporal granularity, such as weeks or months, at which the effects of an event are 
likely to be felt.

periodicity

See seasonality.

personal database 

In Oracle Demand Planning, the database to which a demand planner has modification 
rights. A demand planner works in his or her personal database and submits final 
forecasts to the shared database.

phase out

See product phase out event.

planning bill of material

A bill of material for a planning item that contains a list of items and planning 
percentages. You can use a planning bill to facilitate master scheduling and/or material 
planning. The total output of a planning bill of material is not limited to 100% (it can 
exceed this number by any amount).

planning percent

A component usage percentage that facilitates planning for optional components on 
model and option class bills, and all components on planning bills.
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point value

The value of a variable defined at any one point, such as at a given level of aggregation, 
for specified hierarchies of each dimension.

predefined reports

In Oracle Demand Planning, a set of preformatted reports that target specific issues. 
There are predefined reports for forecast accuracy, trend analysis, comparison, 
distribution, growth, quota, and ranking. 

price list

A list containing the base selling price per unit for a group of items, item categories or 
service offered. All prices in a price list are for the same currency.

product dimension

In Oracle Demand Planning, a category of data that denotes a product or group of 
products. For example, you might have product dimension values such as "sporting 
goods" and "rackets." See also dimension.

product introduction event

An event in which a new product is introduced. Oracle Demand Planning calculates the
forecast based on the history or forecast, depending on the model type, of one or a 
linear combination of many model products using the spread model of a spread model 
product, which might be the same as the model product. 

product phase out event

An event in which an existing product is allowed to die. In Oracle Demand Planning, a 
product phase out event is modeled as linear decay in demand. 

promotion event

An event that represents the introduction of special schemes, incentives, or advertising 
to promote the demand and sale of a particular product. In Oracle Demand Planning, a 
promotion is defined as a standard event. 

R

recalculate

In Oracle Demand Planning, refers to calculating forecast values at selected points 
based on modified or new planner inputs, while keeping other forecast parameters the 
same as before.

reconciliation

Forecasts issued at higher levels of aggregation must be propagated to the lower levels 
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through a top down technique. However, this process must not interfere with the 
numbers at the lower level, which could be generated from another forecast or for 
which some actual data might be available. In Demand Planning, reconciliation refers to
the process of propagating forecast information from higher to lower levels without loss
of information at the lower levels.

reforecast

Generate new forecast values for a selected data range, using modified history, a new 
history date range, or a different forecast method. A reforecast might also take into 
account effects such as promotions and new product introductions that had not been 
accounted for in a previous forecast.

regression

In statistics, a technique for determining the mathematical relation and the associated 
uncertainties between dependent variables, such as demand; independent variables, 
such as past demand; and other factors, such as price, promotions and discounts, 
through linear or nonlinear models. The form of the model could be dictated 
beforehand, or it could be dictated by the data. 

report

A tabular presentation of multidimensional data. Demand Planning supports ad hoc 
reporting and also includes a set of predefined reports.

residual

Remainder. The residual of a forecasting process refers to the forecast error or the 
remaining variability that cannot be explained by the forecasting process.

responsibility

Determines the data, windows, menus, reports, and concurrent programs you can 
access in Oracle Applications. It is linked directly to a data group. Several users can 
share the same responsibility, and a single user can have multiple responsibilities.

RMSE

See Root Mean Squared Error

ROI on forecast

Return of Investment on forecast. Compares the revenue saved by issuing accurate 
forecast for n units of an item with the cost of gathering the data and issuing the 
forecast.

role

See responsibility.
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Root Mean Squared Error (RMSE)

A number that summarizes the overall error and reflects the variability in the data. The 
individual errors are squared, added together, dividing by the number of individual 
errors, and then square rooted. A large RMSE indicates high fluctuations in differences 
between actual sales or shipments to corresponding forecast data.

row

An Oracle Demand Planning report has three components for displaying 
multidimensional data: column, row, and page. The row component separates data for 
the dimension values that run down the report. See also down.

S

safety stock

Amount of inventory set aside to cover shortages. Depends on the forecast uncertainties
and past performance. 

scenario

In Oracle Demand Planning, forecasts can be generated from multiple sources such as 
sales, management, marketing, budget, constrained, and unconstrained. Forecasts from 
each source can also differ in scope, certainty, expectation (for example, optimist versus 
pessimistic), aggregation level, time horizon, attributes, and so forth. Each unique 
situation or function represents a scenario. Scenarios are set up and associated with a 
demand plan in the OLAPI Server. Planners submit a forecast for each scenario in the 
demand plan. 

seasonality

Repetitive pattern from year to year with demand for some periods considerably higher
than others.

shared database

In Oracle Demand Planning, the database that stores consolidated data for a demand 
plan. Planners submit forecasts from their personal databases to the shared database; 
the Demand Plan Manager reviews data in the shared database before uploading the 
data to the OLAPI Server.

signal to noise ratio

In time series, the ratio of the strength of the underlying signal, which is thought to 
generate the data, and the noise, which is thought to corrupt the data. This is a 
frequency domain tool used in Demand Planning for outlier detection. See also noise.

sporadic demand

See intermittent demand.
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spread model

The method for allocating data using top-down, bottom-up, or middle-out strategies. 
This could be done using specified weights, or weights that are calculated from history 
or forecasts.

standard event

In Oracle Demand Planning, any event other than product introduction or product 
phase out. These are characterized by event category, event type, priority, modification 
type, and uplift factor. The modifications are either additions or subtractions of 
numbers, or a factor of the demand of the product under consideration. 

statistical forecast

Historical data are used to generate statistical forecasts in Oracle Demand Planning. The
resultant forecasts include an estimate of the forecast error. 

submit

In Oracle Demand Planning, refers to the action that a planner takes when he or she 
selects a forecast to commit to the shared database. Planners work on forecasts in their 
personal databases. Once a forecast is selected for submission, the data are moved from 
the personal database to a consolidated measure in the shared database.

supply chain planning

The development and maintenance of multi-organizational distribution and 
manufacturing plans across a global supply chain.

T

time dimension

In Oracle Demand Planning, a dimension whose values represent time periods. For 
example, values in the time dimension could include the following: 

• Years such as "2003" and "2004"

• Quarters such as "Quarter 1 - 2003" and "Quarter 2 - 2003"

• Months such as "February 2003" and "March 2003"

time domain analysis

Analysis of time dependent quantities using the actual values in time as independent 
variables. Temporal qualifiers such as time elapsed from some start date, might also be 
used as independent variables.
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time series

A set of time-stamped data, such as demand data by the day. 

time series analysis

Statistical analysis of time series data to determine statistical and other properties, and 
to often generate forecasts.

top-down

A method of allocating forecasts generated at the highest level of a hierarchy to the 
lower levels through allocation by a specified spreading rule.

tracking

The process of monitoring demand, historical data, accuracy of historical data, previous
forecasts, and the past performance of forecasts. 

trend

A characteristic that measures the inclination of time varying, demand, or other data 
values, to move up or down in an approximate straight line. While trend usually 
implies linear trend, it is loosely used to indicate other characteristics of data such as 
variation from mean, periodicity, or nonlinearity.

trend analysis

The process of analyzing data to yield trend estimates.

U

uncertainty

The degree of belief associated with a forecast. Uncertainty is useful to understand the 
expected skill of each forecast, and is an essential input for issuing composite forecasts. 
Uncertainty is measured and reported in terms of one of the following: 

• the expected standard deviation of the forecast errors

• the expected upper and lower bonds on the forecasts

• the probability of the forecast being accurate

unconstrained forecast

Forecast that is generated from historical data or by individuals without regard to 
limitations. For example, a retailer with no knowledge of manufacturing capability or a 
manufacturer without knowledge of customer demand might generate an 
unconstrained forecast. See also constrained forecast.
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uplift factor

For a standard event, the factor by which the existing demand must be increased or 
decreased. 

upload

In Oracle Demand Planning, refers to the action that a Demand Plan Manager takes 
when he or she commits a final forecast to the OLAPI Server. 

V

variable

In Oracle Demand, a quantity that acts as a placeholder for a single datum or group of 
data. Demand for a particular product in a specific region is an example of a variable. 
See also measure.

variance

In statistics, the square of the standard deviation. In Demand Planning, variance is 
loosely used to denote the forecast errors.

variant

In Oracle Demand Planning, a forecast version and related what-if analyses that 
planners can create. 

view

See multidimensional.

view scope

In Oracle Demand Planning, refers to the portion of the data that a demand planner can 
view. 

verification

The process of determining forecast performance using data that was not used during 
the forecast process.

what-if analysis

A mechanism that enables planners to formulate ad hoc queries that represent 
hypothetical but realistic situations.

workflow

See Oracle Workflow.
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worksheet

An Oracle Demand Planning document that enables planners to view and modify data. 
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A
accuracy measures

creating, 17-7, 17-54
submitting, 24-3
uploading, 24-7

Activity log, 10-7
ad hoc graphs

adding footnote, 15-10
adding subtitle, 15-10
adding title, 15-10
adding to folders, 21-3
applying custom aggregates to, 15-7, 19-3
applying saved selections to, 15-7
changing document type, 15-8
changing layout, 15-7
closing, 15-18
creating, 15-4
deleting, 15-19
description, 15-1
drilling in, 15-9
exporting data from, 15-16
formatting, 15-9
formatting legend, 15-11
formatting tick labels, 15-11
opening, 15-5
printing, 15-12
renaming, 15-18
saving, 15-14
selecting data for, 15-6
toolbar, 15-2
types, 15-3

viewing properties, 15-18
ad hoc reports

adding footnote, 14-21
adding subtitle, 14-21
adding title, 14-21
adding to folders, 21-3
applying custom aggregates to, 14-5, 19-3
applying saved selections to, 14-5, 20-4
changing to graph, 14-8
closing, 14-39
color coding, 14-26
copying data from, 14-35
creating, 14-2
deleting, 14-40
description, 14-1
drilling in, 14-8
exporting data from, 14-37
format options, 14-17
formatting based on data conditions, 14-26
formatting fonts and colors, 14-19
formatting general elements, 14-17
formatting numbers, 14-24
formatting selected rows and columns, 11-35, 
11-35, 14-23, 14-25, 14-25
opening, 14-4
printing, 14-32
renaming, 14-39
saving, 14-34, 14-34, 15-14
selecting data for, 14-4
setting row and column size, 14-19
stoplight formatting, 14-26
toolbar, 14-2
viewing events, 14-16
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viewing properties, 14-39
adjusting data. See modifying data, 11-14
adjustments

applying, 17-40
Aged Accuracy document, 16-5
Aggregation and Allocation Functions, 3-15
aggregation methods, stored measures, 17-11, 17-
26, 17-38, 17-39, 17-48, 17-48
aggregation settings, 17-44
alerts

defining, 25-3
deleting, 25-15
description, 25-1
disabling, 25-12
enabling, 25-12, 25-12
example, 25-6
modifying, 25-11
properties, 25-14
renaming, 25-13
running manually, 25-13

aligning
text for title, subtitle, and footnote, 11-33, 14-
22, 15-10
text in ad hoc reports, 14-19, 14-23
text in worksheets, 11-29

allocate demand, 7-17
allocation floor. See allocation level, lowest, 9-6
allocation level, lowest, 9-6, 9-6, 17-8, 17-21, 17-63
, 17-63, 23-7
allocation methods, stored measures, 17-47
allocation settings, 17-44
archiving demand plans, 8-40
assignment scope, 9-13, 9-16
assignment scopes, 11-15
Assignment Set, 2-3
assignments for planners

assignment scope, 9-16, 23-1
creating, 9-16
deleting, 9-23
editing, 9-20
finding overlapping values, 9-22
view scope, 9-16, 23-1

attributes
to select values in a scope, 22-11

Audit Fact, 5-2, 5-3
Audit Fact Data Report, 5-3
Audit Fact report, 5-3

audit statements, 5-10
automatic forecasting method, A-1
automatic measure recalculation, 17-20
automating batch processes, 8-14
autosizing, 11-30, 14-19
Available box

in Selector, 22-3, 22-4, 22-4

B
backcast

data, 17-16
setting up, 17-17

Base Products, 6-21
batch log, 8-19
batch processes

automating, 8-14
borders, applying to ad hoc reports, 11-35, 11-35, 
14-23, 14-25, 14-25
buttons

on ad hoc graph toolbar, 15-2
on ad hoc report toolbar, 14-2
on navigation toolbar, 10-3
on Planning Percentages worksheet toolbar, 
13-4
on predefined report toolbar, 16-2
on worksheet toolbar, 11-3

C
Cannibalized Products, 6-22
chaotic data, 3-12
child values, in Planning Percentages worksheet, 
13-7
closing documents, 11-41, 14-39, 15-18, 16-18
Code, 2-9
collaboration

See also sharing data, sending data, receiving 
data

collaboration, 23-1
setting up for assignments for planners, 9-13

collaboration history
viewing as Demand Planner or Demand Plan 
Manager, 9-35, 23-9
viewing in Demand Plan Administration, 9-35

collect data from planners, 8-11, B-4
Collect Filter Condition, 3-7, 3-31
Collection Method, 2-6



Index-3

color coding
defining rules, 14-27
deleting rules, 14-32
description, 14-26
modifying rules, 14-31
options, 14-26

colors and fonts
in ad hoc reports, 11-35, 11-35, 14-19, 14-23, 14-
25, 14-25
in worksheets, 11-14, 11-29, 13-16

Column mappings, 3-2
column sizing

in ad hoc reports, 14-19
in predefined reports, 16-13
in worksheets, 11-30

combination forecast measures
creating, 17-21

comment reason codes, defining, 9-27
comments

display format in worksheet, 11-32
entering in Planning Percentages worksheet, 
13-19
entering in worksheet, 11-23
persistence, 9-27

comparative analysis, 7-17
Comparison Accuracy document, 16-3
Comparison document, 16-7
Complete Refresh, 3-19
complete refresh for download, 8-6
conditional formatting. See color coding, 14-26
Conflict Resolution, 6-3
Contract Purchases, 3-21
control file, 3-26
copying

data to clipboard, 11-20, 13-18, 13-18, 14-35, 
16-15
data to measure, 11-22
data to product, 11-22
documents to folders, 21-4

copy measures
aggregation settings, 17-44
allocation settings, 17-44

copy multiple measure
use Attribute tool, 17-53

Create Data Files, 4-42
creating

ad hoc graphs, 15-4

ad hoc reports, 14-2
alerts, 25-3
combination forecast measures, 17-21
custom aggregates, 19-1
folders, 21-2
measures, 17-5, 17-35, 17-44, 17-54, 17-57
saved selections, 20-2, 22-26
worksheets, 11-4

CSV export, 11-39, 13-24, 14-37, 15-16, 16-17
Currency, 2-3
Currency Conversion, 4-9
custom aggregates

applying to open documents, 19-3
defining, 19-1
deleting, 19-7
example, 19-3
modifying, 19-5
prior period, 19-2
properties, 19-6
renaming, 19-5
year ago, 19-2

Custom Data collection program, 3-21
Custom Data Stream definition identifier, 3-19
custom data streams, 3-19

validating, 5-3
custom data streams. See stored measures, 9-23
customer forecast, 3-14

D
data

collecting from planners, 8-11
copying to clipboard, 11-20, 13-18, 14-35, 16-15
copying to measure, 11-22
copying to product, 11-22
decreasing, 11-16
distributing, 8-10
editing in Planning Percentages worksheet, 
13-15
editing in worksheets, 11-14
exporting from documents, 11-39, 13-24, 14-37,
15-16, 16-17
filling, 11-16
forecasting in worksheets, 11-18
formatting, 11-26, 14-17, 14-26
importing from flat files, 17-65
increasing, 11-16
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recalculating, 11-22, 11-24, 11-37, 13-21
receiving, 23-8
resetting, 11-25
saving, 11-14, 11-37, 13-16, 13-21
sending, 23-5
sharing, 23-1
submitting, 24-2
uploading, 24-4

data change flags, 11-14, 11-32, 13-16
data driven formatting. See color coding, 14-26
Data Model, 26-20
Data Pull, 3-21
data streams, 3-4, 3-19, 3-20, 3-22, 5-3, 26-21
decimal places, specifying for stored measures, 
17-15, 17-31, 17-43, 17-52, 17-57, 17-57
decreasing data, 11-16
default document layout, 11-8
default measures, associating with scenarios, 9-
25
Define-Advanced, 3-3, 3-3, 3-7, 3-14, 3-16
Define-Basic, 3-3, 3-3, 3-9, 3-9
Define Column Dimension Attributes, 3-16
Define Data Usage, 3-12, 3-20, 3-22
defining

demand plan hierarchies, 7-13
demand plans, 7-2
demand plan scenarios, 7-32

defining demand planning hierarchy levels, 2-16
defining demand planning levels, 2-14
defining demand plan scenarios, 7-32
deleting

ad hoc graphs, 15-19
ad hoc reports, 14-40
alerts, 25-15
assignments for planners, 9-23
color coding rules, 14-32
custom aggregates, 19-7
documents from folders, 21-6
events, 18-19
folders, 21-7
measures as Demand Planner or Demand Plan
Manager, 17-64
multiple documents, 11-43, 14-40, 15-19
saved selections, 20-7
worksheets, 11-42

Demand Class, 8-26
Demand Plan Administration

batch log, 9-34
selecting predefined reports, 9-29
setting comment reason codes, 9-27
setting default measures for scenarios, 9-25
working with events, 9-10
working with measures, 9-3

demand plan hierarchies
customizing in Planning Server, 26-1
defining in Planning Server, 7-13

Demand Plan Manager, 1-6, 1-7, 11-14, 13-16, 18-
2, 24-1
Demand Planner, 1-6, 1-7, 11-14, 13-16, 18-2, 24-1
Demand Planning

data model and architecture, 3-3
description, 1-1
key features, 1-1

Demand Planning Administration page, 8-3
demand planning dimensions

defining, 2-8
demand planning hierarchy levels

defining, 2-16
demand planning levels

defining, 2-14
Demand Planning page (for Demand Planner or 
Demand Plan Manager), 10-1
Demand Planning Server. See Planning Server, 8-
1
Demand Planning System Administrator, 1-6, 1-6
demand plans, defining, 7-2
demand plan scenarios

defining, 7-32
demand plan scenarios, defining, 7-32
Demand Plan Viewer, 1-6, 1-7
demand priority, 7-2

associating with a scenario, 7-35
setting input parameters, 7-21

dependent demand, 9-13, 11-14, 13-1, 13-5
Dimension, 3-13
dimension data, 26-22
dimension labels tab, 11-27
Dimension Level, 3-9
Dimension Level Primary Key, 3-13
dimensions

defining in Planning Server, 2-8
setting up in Planning Server, 2-7

dimensions, description, 11-9, 14-5, 15-6
dimension value labels, 15-10
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dimension values
description, 11-9, 14-5, 15-6
labels in reports, 14-18
selecting, 22-1

disabling alerts, 25-12
display formats in worksheets, 11-14, 13-16
displaying labels, 11-26
display item descriptions

for graph formatting, 15-10
distribute to planners, 8-10, 25-6, B-4
document folders. See folders, 21-1
document layout

default, 11-8
default for graphs, 15-6
default for reports, 14-4

documents
applying custom aggregates to, 19-3
applying saved selections to, 20-4
default, 14-34, 15-14
deleting multiple, 11-43, 14-40, 15-19
saving, 14-34, 15-14
See also ad hoc reports, ad hoc graphs, 
worksheets, predefined reports

documents, 10-6
document type, changing, 14-8, 15-8
document workspace, 10-6
download data from Planning Server, 8-4, B-2
drag and drop

adjusting columns and rows, 16-13
changing ad hoc report layout, 14-7
changing worksheet layout, 11-12
sorting dimension values, 22-25

drilling
enabling or disabling, 11-29, 14-18
in ad hoc graphs, 15-9
in ad hoc reports, 14-8
in Planning Percentages worksheet, 13-7
in predefined report, 16-12
in worksheets, 11-12

E
editable cells, display format, 11-32
editable property, for measures, 17-12, 17-27, 17-
49
editing

alert definitions, 25-11

assignments for planners, 9-20
custom aggregate definitions, 19-5
data in worksheets, 11-14
events as Demand Planner or Demand Plan 
Manager, 18-18
events in Demand Plan Administration, 9-11
measures in Demand Plan Administration, 9-4
Planning Percentages worksheet, 13-17
saved selection definitions, 20-6
See also modifying

editing, 9-4
effectivity dates, 13-16
enabling alerts, 25-12
error, 3-30
error detail, 3-30
events

applying to measures, 9-12, 17-42, 17-51, 18-20
deleting as Demand Planner or Demand Plan 
Manager, 18-19
description, 6-1, 9-9, 18-1
effect on measures, A-5
grouping, 18-3, 18-10, 18-17
modifying as Demand Planner or Demand 
Plan Manager, 18-18
modifying in Demand Plan Administration, 9-
11
new product introductions with 
cannibalization, 6-16
promotions, 6-15
See also promotions, product introductions, 
product phaseouts

events, 9-9
viewing for a measure, 11-13, 14-16, 18-26
viewing properties as Demand Planner or 
Demand Plan Manager, 18-19

events calendar
filtering by measure, 18-26
viewing from ad hoc reports, 14-16
viewing from worksheet, 11-13

Examine Field and Variable Values, 26-23
exception reports, 14-9
exception then ranking reports, 14-9
exporting data from documents, 11-39, 13-24, 14-
37, 15-16, 16-17

F
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fact table, 3-22, 4-42, 26-21
Fact Validation, 5-4
files, importing data from, 17-65
filling data, 11-16
filtering events by measure, 11-13, 14-16
Fixed Levels, 3-12
Flat File Loader Program, 4-47
flat files

integrating legacy data, 4-42
flat files, importing data from, 17-65
flexible data streams, 3-2, 3-13, 3-21, 3-21, 3-26
folder

Measures, 17-4
folders

copying documents to, 21-4
creating, 21-2
deleting, 21-7
deleting documents from, 21-6
description, 21-1
properties, 21-7
renaming, 21-7

folder types, 21-1
fonts

setting for ad hoc reports, 11-35, 11-35, 14-19, 
14-23, 14-25, 14-25
setting for worksheets, 11-29

footnotes
for ad hoc graphs, 15-10
for ad hoc reports, 14-21
for worksheets, 11-33

Forecast documents, 16-3
forecasting data in worksheet cells, 11-18
forecast measures

creating, 17-5
forecast allocation method, 17-8, 17-21
forecast methods, A-1
See also stored measures

forecast measures, 9-3, 17-2
forecast methods, A-1
forecasts, submitting. See submitting measures, 
24-2
forecasts, uploading. See uploading measures, 
24-4
forecasts. See forecast measures, 9-3, 17-2
Forecast Set, 8-26
forecast versions, 24-5
formatting

ad hoc graphs, 15-9
ad hoc reports, 14-17
formula measures, 17-60
stored measures, 17-15, 17-30, 17-43, 17-52
worksheets, 11-26, 14-17

formula measures
description, 17-3
formatting, 17-60

fractional quantities
rounding for measures, 17-19

fractions
rounding, 17-19

From APS to Source, 2-3
From Source to APS, 2-3
full distribution, 8-10, 9-3, 9-10, 9-10
full download, 8-5

G
GMT Difference, 2-3
graphs. See ad hoc graphs, 15-1
gridlines, displaying, 11-29, 14-18
grouping events, 18-3, 18-10, 18-17

H
help. See online help, 8-4, 9-2, 10-9
hierarchies. See demand plan hierarchies, 7-13, 7-
26, 7-32, 7-40, 7-41, 7-43, 7-44, 7-46
Hierarchy Level Values Viewer, 4-40
Hierarchy Name, 2-17
history, collaborative

viewing as planner or planning manager, 23-9
viewing in Demand Plan Administration, 9-35

history-based statistical forecasts, 26-15
HTM export, 11-39, 13-24, 14-37, 15-16, 16-17

I
importing

sales information, 26-15
importing data from flat files, 17-65
Increasing/Decreasing Demand document, 16-8
increasing data, 11-16
incremental refresh, 8-5
indent by level, 11-28, 14-18
input parameters, 9-2
Input Parameters, 26-18, 26-26
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Instance, 2-5, 8-25
Instance Code, 2-2
Instance Type, 2-2
intelligent rounding, 17-19
invalid characters

for import files, 17-66
Inventory Optimization (IO), 17-54, 24-1
item descriptions, 11-26

in reports, 14-18

L
lag measure, formula, 17-58
layout

ad hoc graphs, 15-7
default document, 11-8
worksheets, 11-11

lead measure, formula, 17-58
legacy integration, 4-42
legacy integration control file formats, 4-48
legend, formatting in ad hoc graph, 15-11
Level

as criterion for selecting values, 22-6
Level ID, 3-13
Level Name, 2-17
level value associations, 26-9
Level Value Audit, 5-2, 5-7
Level Value Column, 2-18
level value data collection, 5-7
level values, 4-40, 26-9
Level Values collection, 4-14
Life cycle, 6-16
lifecycle product introduction, 18-8
Limitations, 8-35
Linear and Nonlinear Phase Outs, 6-23
locked cells

display format in worksheet, 11-32
in Planning Percentages worksheet, 13-18
in worksheets, 11-22

locked data
overwriting, 17-40

locks
transferring, 17-40

logging in
as Demand Planner or Demand Plan Manager,
10-1
as Demand Planning System Administrator, 8-

3
lowest allocation level See allocation level, 
lowest, 17-8, 17-21

M
mandatory promotion, 18-2
Mandatory promotion, 6-15
Manufacturing Forecasts, 4-10
Master Demand Schedule, 8-24
measure recalculation

automatic, 17-20
measures

associating with scenarios, 9-23
copying data to, 11-22
copy multiple, 17-44
creating combination forecast, 17-21
creating in Demand Plan Administration, 9-3
deleting as Demand Planner or Demand Plan 
Manager, 17-64
description, 11-9, 14-5, 15-6, 17-1
editable in worksheets, 17-40
editing as Demand Planner or Demand Plan 
Manager, 17-61
editing in Demand Plan Administration, 9-4
effect of events, A-5
filtering events by, 11-13, 14-16
folders for, 21-2
importing data into, 17-65
modifying in Demand Plan Administration, 9-
4
populating, 8-8
properties, 17-62
rebuilding in Demand Plan Administration, 9-
5
receiving, 23-8
renaming, 17-62
See also stored measures, formula measures

measures, 17-1
selecting for submission, 24-2
selecting for upload, 24-4
sending, 23-5

modifying
alerts, 25-11
custom aggregates, 19-5
data in worksheets, 11-14, 13-15
saved selections, 20-6
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See also editing
modifying, 9-4

moving documents between folders, 21-3
MSD_DIMENSIONS Lookups window, 2-8
MSD_SR_SHIPTO_COUNT_V, 26-5
MSD-Conversion Type

profile options, C-1
MSD-Currency Code

profile options, C-2
MSD-Customer Attribute

profile options, C-2
MSD-Enabled Organization for Item Collections

profile options, C-2
MSD-Master Organization

profile options, C-2
MSD-One Step Collection

profile options, C-3
multi-document interface, 10-7

N
NA values, 11-10, 11-15, 11-28, 14-6, 14-18
navigation list (for Demand Planner and 
Demand Plan Manager)

description, 10-2
tools, 10-3

net change, 8-5
New

alert, 25-3
custom aggregate, 19-1
event, 18-2
graph, 15-4
measure, 17-5, 17-21, 17-35, 17-45, 17-55, 17-57
report, 14-2
saved selection, 20-2
worksheet, 11-4

New Product Introduction
event allocation, 18-14

new product introduction allocation
procedure for using, 18-15

new product introductions, 6-17
new product introductions and cannibalization, 
6-16
notifications

deleting, 25-16
generated by sending measures, 23-5
opening, 25-16

properties, 25-16
NPI Event Allocation

aggregation rules, 18-15
benefits of, 18-14

number formats
applying to rows and columns, 11-33, 14-24
for measures, 17-15, 17-30, 17-43, 17-52, 17-56

Number of Workers, 2-5

O
objects

sharing, 23-3
Online Analytical Processing, 1-3

administering sessions, 8-22
online help, 8-4, 9-2, 10-9
open documents

refreshing, 11-7
opening documents, 11-7, 14-4, 15-5, 16-9
optional promotion, 18-2
Options tab, 7-42
Oracle Advanced Supply Chain Planning, 8-14
Oracle Demand Planning. See Demand Planning,
1-1
Oracle Workflow. See Workflow, B-1

P
pages, changing, 11-13, 14-9, 15-9, 16-12
Parent Level Name, 2-17
Parent Value Column, 2-18
parent values, adding to Planning Percentages 
worksheet, 13-7
pasting data into worksheets, 11-19, 13-18, 13-18
Percentage Share document, 16-8
persistent forecast scenarios, 8-35
planned production, 7-17
planner assignments. See assignments for 
planners, 9-13
planning percentages

calculation, 13-10
submitting, 24-2
uploading, 24-5

Planning Percentages worksheet
adding parents, 13-7
closing, 13-27
copying data from, 13-18
description, 13-1
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display formats, 13-16
editing cells, 13-17
entering comments, 13-19
exporting data from, 13-24
locked cells, 13-18
modifying data in, 13-15
opening, 11-14, 13-4
printing, 13-22
saving data, 13-21
selecting data for, 13-5
viewing children, 13-7

Planning Server, 3-13
downloading data from, 8-4
uploading scenarios to, 8-14

Planning Server view, 3-8, 3-22
Planning View Column, 3-13
populate measures, 8-8, B-3
predefined reports

Aged Accuracy document, 16-5
changing pages, 16-12
closing, 16-18
Comparison Accuracy document, 16-3
Comparison document, 16-7
copying data from, 16-15, 16-16
default settings, 9-30
description, 16-1
drilling in, 16-12
exporting data from, 16-17
Increasing/Decreasing Demand document, 16-
8
opening, 16-9
overview, 9-29
Percentage Share document, 16-8
printing, 16-13, 16-13, 16-15
Ranking document, 16-8
selecting, 9-31
sizing columns and rows, 16-13, 16-13
toolbar, 16-2
Top/Bottom Ranking document, 16-9
Trend document, 9-33, 16-9
viewing as graphs, 16-12

Pre-Processor for Oracle Demand Planning, 4-47
preseeded streams, 3-4, 26-22
Price Modification Type, 6-6
Price Modification Value, 6-6
Pricing data collection, 4-18
primary keys, 5-6

primary key value, 26-22
printing

ad hoc graphs, 15-12
ad hoc reports, 14-32
multiple documents, 11-37, 14-34, 15-14, 16-15
Planning Percentages worksheet, 13-22
predefined reports, 16-13
worksheets, 11-35

prior period, 19-2
product category, 3-14
Product Dimension, 3-9
product introductions, creating, 18-8
product labels, 11-26
product phase outs, 6-23
products, copying data to, 11-22
profile options

MSD-Category Set Name, C-1
promotional demand

distinguish from regular demand, 18-6
promotions, 6-15
promotions, creating, 18-2
properties

viewing for ad hoc graphs, 15-18
viewing for ad hoc reports, 14-39
viewing for alerts, 25-14
viewing for custom aggregates, 19-6
viewing for events as a Demand Planner or 
Demand Plan Manager, 18-19
viewing for folders, 21-7
viewing for measures as Demand Planner or 
Demand Plan Manager, 17-62
viewing for measures in Demand Plan 
Administration, 9-5
viewing for notifications, 25-16
viewing for saved selections, 20-7
viewing for worksheets, 11-42

protecting cells. See locked cells, 11-22
Publishable, 7-45
Publish Forecast, 8-24, 8-27
pull program, 3-19, 3-30
Purge All Previously Collected Data, 2-5

Q
quick distribution, 8-10, 9-3, 9-10, 9-10
quick download, 8-5
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R
Ranking documents, 16-8
ranking reports, 14-9
read-only cells, display format in worksheet, 11-
32
rebuilding measures, 9-5
recalculate data

control on Measure Wizard Summary step, 11-
25

recalculating data, 11-22, 11-24, 11-37, 13-20, 13-
21

automatically, 11-25
recalculating measures

Summary page , 17-20
receiving measures, 23-8
red flag, 9-23
Redo command

for Selector, 22-2
Relationship View, 2-18
Relationship Views, 26-8
renaming

custom aggregates, 19-5
documents, 11-41, 14-39, 15-18
folders, 21-7
measures, 17-62
saved selections, 20-7

reports. See ad hoc reports, predefined reports, 
14-1
resetting data, 11-25, 13-20
restoring demand plans, 8-40
Retaining old level values, 8-34
rounding

quantities, 17-43
rules, 17-19

rounding control, 7-43
row sizing

in ad hoc reports, 14-19
in predefined reports, 16-13
in worksheets, 11-30

running alerts, 25-9, 25-13

S
sales forecasts, 26-15
sales information, importing, 26-15
sales opportunity, 26-21

saved selections
applying to open documents, 11-10, 16-11, 20-
4
defining, 20-2, 22-26
deleting, 20-7
description, 20-1
modifying, 20-6
properties, 20-7
renaming, 20-7
selecting values for, 22-26

saving
ad hoc graphs, 15-14
ad hoc reports, 14-34, 14-34, 15-14
data, 11-14, 11-37, 13-16, 13-21
See also saved selections

saving, 20-1
worksheets, 11-37

scaling to print, 11-36, 13-23, 14-33, 16-14
scenarios

associating with a default measure, 9-25
defining, 7-32
description, 9-23
selecting measures to submit for, 24-1
selecting measures to upload for, 24-4
setting demand priority, 7-21, 7-35
understanding demand priority, 7-2
uploading to Planning Server, 8-14
viewing properties as Demand Planner or 
Demand Plan Manager, 24-11
viewing properties in Demand Plan 
Administration, 9-26

scope
assignment-specific, 9-19
use attributes to select values in, 22-11

scopes
automatic maintenance, 9-18

seasonal factors, 17-18
setting up, 17-19

Selected box
in Selector, 22-3, 22-4

selecting data, 22-1
selecting values

by family relationship, 22-7
by level, 22-6
from a list, 22-3

sending data, 23-5
settings for predefined reports, 16-10
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setting up a demand plan
defining demand planning hierarchy levels, 2-
16
defining demand planning levels, 2-14

Shared Objects dialog box
using, 23-4

Share Objects dialog box, 23-3
sharing data, 23-1, 25-2
Single Step Collection, 3-19
sizing columns and rows, 11-30, 14-19, 16-13
smoothed history, 17-18

setting up, 17-18
sorting values, 22-25, 22-26
Source of Data, 3-7, 3-17
Source View, 3-7
SQL*Loader, 3-22, 3-26, 3-29
stages, running for demand plan, 8-2
stages in planning cycle

collect data from planners, 8-11
distribute to planners, 8-10
download data from Planning Server, 8-4
populate measures, 8-8
upload scenarios to Planning Server, 8-14

staging tables, 3-16, 3-19, 3-19, 3-21, 3-22, 4-7, 4-12
, 4-30, 4-35, 4-38, 4-42
Staging Tables, 2-23
statistical forecast, running for worksheet cells, 
11-18
stcsdata.ctl control file, 3-26
stoplight formatting, 14-26
stored measures

aggregation options, 17-11, 17-26, 17-38, 17-39, 
17-48, 17-48
allocation methods, 17-47
allocation options for new data, 17-10, 17-21, 
17-37
applying events to, A-5
copy options, 17-36
description, 9-3, 17-2
editable property, 17-12, 17-27
forecast allocation methods, 17-8, 17-21
formatting, 17-15, 17-30, 17-43, 17-52
impact on system performance, 17-3

Stream Identifier, 3-14
submitting measures, 24-2
subtitles

for ad hoc graphs, 15-10

for ad hoc reports, 14-22
for worksheets, 11-33

supersession, 6-16
supersession product introduction, 18-8
synchronizing documents, 11-7
system information, 8-4, 9-2, 10-9

T
tick labels, formatting in ad hoc graphs, 15-11
Time data collection, 4-16
Time Dimension, 3-13
Timeout (Minutes), 2-5
titles

for ad hoc graphs, 15-10
for ad hoc reports, 14-21
for worksheets, 11-33, 11-33

toolbars
ad hoc graphs, 15-2
ad hoc reports, 14-2
data selection, 22-1
navigation list, 10-3
Planning Percentages worksheet, 13-4
predefined reports, 16-2
worksheets, 11-3

Top/Bottom Ranking document, 16-9
top dimension level, 26-22
transformation, 9-6, 9-6, 9-7, 17-62, 17-63
Trend document, 9-33, 16-9
TXT export, 11-39, 14-37, 15-16, 16-17

U
unavailable data. See NA values, zero values, 11-
28, 14-18
unconstrained forecasts, 7-17
Undo command

for Selector, 22-2
unit of measure, 17-12, 17-40, 17-49, A-5
Unit of Measure conversion, 4-9, 26-12
unlocking cells

in Planning Percentages worksheets, 13-18
in worksheets, 11-22

update, refresh mode for download, 8-6
uploading measures, 24-4
upload scenarios to Planning Server, 8-14, 24-1, 
B-10
User Dimensions, 7-1
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V
Validate Data, 3-19
valid characters

for import files, 17-66
value hierarchy relationships

criterion for selection, 22-7
version information, 8-4, 9-2, 10-9
versions. See forecast versions, 24-5
view scope, 9-13, 9-16
view scopes, 11-15

W
Workflow

automating batch processes, 8-14
description, B-1
maintaining settings, 9-33
processes, B-2

worksheets
adding footnote, 11-33
adding subtitle, 11-33
adding title, 11-33
adding to folders, 21-3
applying custom aggregates to, 19-3
closing, 11-41
copying data from, 11-19, 13-18
creating, 11-4
deleting, 11-42
display formats, 11-14, 13-16
drilling in, 11-12
entering comments, 11-23, 13-19
example, 11-1
exporting data from, 11-39
formatting, 11-26
formatting numbers, 11-33
layout, 11-11
locked cells, 11-22
modifying data in, 11-14, 11-16
opening, 11-7
pasting data into, 11-19, 13-18
printing, 11-35
recalculating data, 11-24
renaming, 11-41
resetting data, 11-25
saving, 11-37
saving data, 11-38

See also Planning Percentages worksheet
worksheets, 11-1

selecting data for, 11-9
sizing columns and rows, 11-30
toolbar, 11-3
viewing properties, 11-42

Y
year ago, 19-2

Z
zero values, 11-10, 11-15, 11-28, 14-6, 14-18
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